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Welcome to This Guide

This guide describes how to use Service Health components to monitor 
critical applications and business processes, and how to use Service Health 
Administration to customize how your business environment is monitored.

This chapter includes:

➤ How This Guide Is Organized on page 17

➤ Who Should Read This Guide on page 18

➤ How Do I Find the Information That I Need? on page 19

➤ Additional Online Resources on page 21

➤ Documentation Updates on page 22

How This Guide Is Organized

The guide contains the following parts:

 Part I Components and Reports

Describes how to use the Service Health application components to 
monitor critical applications and business processes. This includes the 
following components: Alerts, Business Impact, Changes and Incidents, 
Custom Image, Geographical Map, Health Indicators, Hierarchy, KPIs, 
Neighborhood Map, Top View, and Topology Map.

You can generate and display reports on monitored elements using the CI 
Status application.

You can also display Service Health data outside of Business Service 
Management on a mobile device.
17
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 Part II View Management

Describes how to customize the way Service Health monitors business 
processes and infrastructure elements, within specific views. 

This includes customizing KPI and HI definitions on specific CIs, creating 
local impact and global views, and configuring CI status alerts.

 Part III Assignments

Describes how to manage the assignments that define how KPIs, HIs, and 
context menus are assigned to CIs.

 Part IV Repositories

Describes how to manage the templates for the key performance 
indicators (KPIs), health indicators (HIs), business rules, and context 
menus available in Service Health.

 Part V APIs

Describes the Service Health Database Query API and the Service Health 
Rules API.

Who Should Read This Guide

This guide is intended for the following users of HP Business Service 
Management:

➤ HP Business Service Management administrators

➤ HP Business Service Management platform administrators

➤ HP Business Service Management application administrators

➤ HP Business Service Management data collector administrators

➤ HP Business Service Management end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with HP Business Service 
Management and enterprise monitoring and management concepts.
18
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How Do I Find the Information That I Need?

This guide is part of the HP Business Service Management Documentation 
Library. This Documentation Library provides a single-point of access for all 
Business Service Management documentation.

You can access the Documentation Library by doing the following:

➤ In Business Service Management, select Help > Documentation Library.

➤ From a Business Service Management Gateway Server machine, select 
Start > Programs > HP Business Service Management > Documentation.

Topic Types
Within this guide, each subject area is organized into topics. A topic 
contains a distinct module of information for a subject. The topics are 
generally classified according to the type of information they contain.

This structure is designed to create easier access to specific information by 
dividing the documentation into the different types of information you 
may need at different times. 
19
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Three main topic types are in use: Concepts, Tasks, and Reference. The topic 
types are differentiated visually using icons.

Topic Type Description Usage

Concepts Background, descriptive, or 
conceptual information. 

Learn general information 
about what a feature does.

Tasks Instructional Tasks. Step-by-
step guidance to help you 
work with the application and 
accomplish your goals. Some 
task steps include examples, 
using sample data. 

Task steps can be with or 
without numbering:

➤ Numbered steps. Tasks that 
are performed by following 
each step in consecutive 
order.

➤ Non-numbered steps. A list 
of self-contained operations 
that you can perform in any 
order.

➤ Learn about the overall 
workflow of a task.

➤ Follow the steps listed in 
a numbered task to 
complete a task.

➤ Perform independent 
operations by 
completing steps in a 
non-numbered task.

Use-case Scenario Tasks. 
Examples of how to perform a 
task for a specific situation.

Learn how a task could be 
performed in a realistic 
scenario.
20
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Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on 
the HP Software Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & Knowledge Base. The 
URL for this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

Reference General Reference. Detailed 
lists and explanations of 
reference-oriented material.

Look up a specific piece of 
reference information 
relevant to a particular 
context.

User Interface Reference. 
Specialized reference topics 
that describe a particular user 
interface in detail. Selecting 
Help on this page from the 
Help menu in the product 
generally open the user 
interface topics.

Look up specific 
information about what to 
enter or how to use one or 
more specific user interface 
elements, such as a 
window, dialog box, or 
wizard.

Troubleshooting 
and Limitations

Troubleshooting and 
Limitations. Specialized 
reference topics that describe 
commonly encountered 
problems and their solutions, 
and list limitations of a feature 
or product area.

Increase your awareness of 
important issues before 
working with a feature, or 
if you encounter usability 
problems in the software. 

Topic Type Description Usage
21
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To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Documentation Updates

HP Software is continually updating its product documentation with new 
information.

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to the HP Software Product Manuals Web site 
(http://h20230.www2.hp.com/selfsolve/manuals).
22
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1
Introducing Service Health 

This chapter includes:

Concepts

➤ Service Health Overview on page 27

➤ Monitoring your Environment Using the Service Health Application 
on page 30

➤ Service Health Administration on page 34

➤ How Service Health Works on page 35

➤ View Topology on page 37

➤ Health Indicators, KPIs, and KPI Domains on page 39

➤ Understanding KPI Status on page 43

➤ KPI Status Colors and Definitions on page 45

➤ KPI Trend and History on page 48

➤ Local Impact Views on page 49

➤ Service Health Application Components in the Service Report on page 51

➤ About Menu Options on page 51

Tasks

➤ How to Monitor Your Environment Using Service Health on page 52

➤ How to Use Service Health - Use-Case Scenario on page 55

➤ How to Open Pages and Components in Service Health on page 60

➤ How to Display Data in Service Health - Prerequisites on page 63

➤ How to Customize Calculations in Service Health on page 65
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➤ How to Manage a New CIT in Service Health - Workflow Scenario 
on page 67

➤ How to Customize Service Health Display on page 69

➤ How to View Sample Details on page 73

➤ How to View the Business Impact Report on page 74

➤ How to Find Visible and Hidden Child CIs on page 78

➤ How to Drill Down to SiteScope from a CI or Health Indicator on page 79

Reference

➤ Service Health User Interface on page 80

➤ KPI Icons in Service Health on page 96

➤ Service Health Menu Options on page 98

Troubleshooting Service Health - General Topics on page 113
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Concepts

Service Health Overview

Service Health enables you to monitor the availability and performance of 
the revenue-generating applications and services in your organization.

This section includes the following topics:

➤ "Collecting and Aggregating Data" on page 27

➤ "Prioritizing IT Operations and Maximizing Business Results" on page 28

➤ "Viewing Information from Service Health Together With Other BSM 
Application Components" on page 29

➤ "Viewing BSM Information in an External Portal" on page 29

Collecting and Aggregating Data
Service Health uses data collected by HP Business Service Management 
monitoring components, such as Business Process Monitor and SiteScope, as 
well as data collected from external monitoring tools. BSM collects metrics 
about end-user experience from a range of environments, including ERP, 
CRM, Web, and Citrix, and about system performance from a range of back-
end infrastructure components, including web servers, J2EE applications, 
databases, and network and storage devices.

The collected and aggregated data is used by the Service Health health 
indicators (HIs) and key performance indicators (KPIs) to provide 
quantifiable measurements that help you monitor how well your business is 
achieving objectives. The KPIs and HIs provide real-time assessment of the 
present state of your business and processes, enable you to track critical 
performance variables over time, and help you assess the business impact of 
problems in the system.
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At the top level, Service Health provides an integrated view of critical 
applications and business processes; from there, you can drill down to the 
underlying IT infrastructure associated with these critical business processes. 
This drill-down view can be laid out in any number of ways, such as by data 
centers, by technology clusters, by geographical locations, and so on.

Prioritizing IT Operations and Maximizing Business 
Results
Service Health helps you to prioritize IT operations and maximize business 
results by:

➤ Presenting global system component data organized into a logical and 
relevant framework.

➤ Providing integrated, scalable, cross-application views that reflect the 
health of mission-critical services and applications in real time. This 
enables IT operations teams to continuously manage the health of 
mission-critical services and applications from one central location.

➤ Providing a common view of how IT operations are meeting line-of-
business goals. This enables better communication between the teams, 
and the alignment of management and IT operations around customer-
centric values.

➤ Providing the ability to assess actual customer impact, so that IT teams 
can prioritize response according to business impact and optimize 
resource utilization to meet critical business objectives. The end result is 
better quality of service for your end users.

➤ Providing a big-picture perspective, enabling you to see how a 
performance issue affects the availability of any part of your business and 
to quantify the business impact of a potential failure.

➤ Providing operational-level service level management reporting. Service 
Health uses Service Level Management data to provide an indication of 
whether an SLA is in breach of contract, or might be in breach in the near 
future.
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Viewing Information from Service Health Together With 
Other BSM Application Components
In BSM 9.x, the Service Health workspace uses Web 2.0 customization to 
enable you to combine information from Service Health and other BSM 
components on the same page.

The workspace is comprised of pages, each of which appears as a tab on your 
screen. A page contains one or more components, each of which is 
displayed as a pane within the page.

You can use Service Health as a stand-alone application (select Application > 
Service Health), or combine Service Health components with components 
from other applications, as described in "How to Open Pages and 
Components in Service Health" on page 60.

These components can interact with one another, so that (for example) if 
you select a CI in a Service Health component, information on this CI can 
be displayed in a component from another application, such as End User 
Management or Operations Management.

For a list of components that are available by default, see "Available 
Components" in Using MyBSM.

Viewing BSM Information in an External Portal
You can use the BSM menu command Admin > Link to This Page to generate 
a link which can be copied to an external portal in order to view BSM 
information. For details, see "Linking to a Specific Page" in Platform 
Administration. 

Select the Embedded link checkbox in the Link to this page window. The 
generated URL can be used in a third-party portal, so that only the specific 
page is displayed, and not the entire BSM application and menus.
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Note: In a third-party portal, only one Service Health or MyBSM page can be 
embedded in each portal page. If you need to see more information, create a 
page which uses tabbed components. For details, see "How to Create Your 
MyBSM Workspace" in Using MyBSM.

Monitoring your Environment Using the Service Health 
Application

You monitor your environment in the Service Health application using the 
Service Health pages and components. When you open the Service Health 
application, various default pages open automatically; some of these pages 
contain a single component, while others include a number of components.

Note: The default pages cannot be modified. For details on creating custom 
pages, see "How to Open Pages and Components in Service Health" on 
page 60.

This section includes the following topics:

➤ "Default Service Health Pages" on page 31

➤ "Additional Service Health Application Components" on page 33

➤ "Using Pages and Components in Service Health" on page 33
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Default Service Health Pages
To access the Service Health pages, select Application > Service Health. The 
following are the default Service Health pages:

➤ Custom Image. Displays icons representing CIs in the view on a custom 
image. Select CIs in the View Selector to display them within the custom 
image. For details, see "Custom Image Component User Interface" on 
page 218.

➤ Geographical Map. Displays an association between geographical 
locations and status indicators within a geographical map. Select one or 
more CIs in the View Selector to display them within the geographical 
map. For details, see "Geographical Map" on page 189.

➤ Top View. Displays the CIs within a view in a hierarchical, top-down 
graphic. For details, see "Top View" on page 147.

➤ Topology Map. Display an interactive topological map of CIs in a view, 
according to the CI links defined in the Run-time Service Model. 
Topology Map display links between CIs, and enables you to view CIs 
divided into layers or groups. For details, see "Topology Map" on 
page 165.

➤ 360° View. Displays comprehensive data in one central location regarding 
a view, and selected CIs. Select a view to display its CIs in the Hierarchy 
component. Select a CI in the Hierarchy component to display CI details, 
and click the CI detail links to open the Business Impact, Health 
Indicators, Alerts, and Changes and Incidents components. 
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The following table describes the components that can be accessed from 
the 360° View:

360° View Components
(A-Z)

Description

Alerts Displays the CI status alerts triggered by the selected 
CI. For details, see "Alerts Component Overview" on 
page 232.

Business Impact Displays the business CIs and SLAs that are affected 
by the selected CI. In addition, each CI’s business 
impact is calculated on a scale from zero to 5, 
showing how much of an affect the CI has on the 
business CIs and SLAs in your monitored 
environment. For details, see "Business Impact 
Component Overview" on page 226.

Changes and Incidents Displays the incidents opened for the selected CI, as 
well as requests for change and actual changes made 
to the CI. For details, see "Changes and Incidents 
Component Overview" on page 233.

Health Indicators Displays details regarding the health indicators that 
are used to calculate and set the current status of a 
selected CI. For details, see "Health Indicator 
Component Overview" on page 228.

For an introduction to health indicators see "Health 
Indicators and KPIs - Overview" on page 115.

Hierarchy Displays a hierarchy of CIs in a view, the KPIs 
assigned to each CI, and their KPI statuses. 

You can select a CI in the Hierarchy component to 
display CI details, and click the CI detail links to 
open the Business Impact, Health Indicators, Alerts, 
and Changes and Incidents components. For 
details, see "Hierarchy Component Overview" on 
page 224.
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Additional Service Health Application Components
In addition to monitoring your environment using the default pages, you 
can also create custom pages to suit your needs. For details, see "How to 
Open Pages and Components in Service Health" on page 60.

Custom pages can include any of the components that are used in the 
default pages, as well as the following additional components:

Using Pages and Components in Service Health
Each page is displayed as a tab within the Service Health application. A page 
can contain one or more application components. 

The default pages contain predefined components; you can also create pages 
as described in "How to Open Pages and Components in Service Health" on 
page 60.

Component (A-Z) Description

KPIs Displays KPI status over time for a selected CI. For 
details, see "KPIs Component Overview" on 
page 280.

Neighborhood Map Displays an interactive hierarchical graphic showing 
a CI’s immediate neighborhood CIs, according to 
the TQL defined for the CIT in Operations 
Management Administration > View Mapping.

For details, see "Neighborhood Map" on page 313.

Reports Displays the Service Health reports: KPIs 
Distribution Over Time, KPIs Over Time, KPIs 
Summary, KPIs Trend, and CI Alert Report. 

For details, see "CI Status Reports User Interface" on 
page 340.
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Service Health Administration

Service Health administration includes view-specific administration tasks, 
and cross-view administration tasks which affect all views. To access the 
Service Health administration tabs, select Admin > Service Health.

This section includes the following topics:

➤ "View-Specific Administration" on page 34

➤ "Cross-View Administration" on page 35

View-Specific Administration
You can use Service Health administration to configure the following 
settings within a specific view:

➤ CI Indicators. You can attach new KPIs and health indicators to CIs, and 
edit the KPIs and HIs attached to CIs. The KPIs and HIs are displayed in 
Service Health components to help you monitor how well the business is 
achieving its objectives, and assess the business impact of problems in 
your system. For details, see "CI Indicators Tab" on page 453.

➤ View Builder. The View Builder enables you to create or edit global views 
and local impact views. Within a global view, when you assign a KPI or HI 
to a CI your changes are reflected in all views which contain the CI. A 
local impact view is independent of other views, so that definitions on a 
CI within a local impact view have no effect on other views. For details, 
see "View Builder - Creating Global Views and Local Impact Views" on 
page 379.

➤ Custom Image. You can define a custom image to represent a view, and 
then place CIs within that image. The Custom Image component in 
Service Health will then display this view with real-time CI status icons, 
in the context of this background image. For details, see "Custom Image 
Administration" on page 489.

➤ CI Status Alerts. You can configure the CI status alert mechanism, which 
sends alert messages to pre-defined recipients, and executes actions 
defined for the alert. Alerts can be sent regarding specific KPIs or CIs, 
based on a pre-defined status change. For details, see "Administer CI 
Status Alerts" on page 499.
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Cross-View Administration
Service Health administration also enables you to configure settings across 
views, using the following:

➤ Repositories. The repositories provide template definitions for KPIs, HIs, 
and the business rules used to calculate these indicators. Many of these 
definitions can be customized as required by your organization. For 
details, see "Repositories Overview" on page 631.

➤ Assignments. When a new CI is added to your monitored system, the 
assignment mechanism automatically assigns the appropriate KPIs and 
HIs to the CI, as well as rules, rule parameters, and context menus. For 
details about modifying KPI and HI assignments, see "Indicator 
Assignments and Propagation" on page 557.

How Service Health Works

Business Service Management offers an extensive range of monitoring tools, 
which measure performance and availability of multiple hardware and 
software technologies such as servers, databases, J2EE applications, and 
network devices.

The physical and logical entities in your system such as hardware, software, 
services, business processes, and so on, are represented in Service Health by 
configuration items (CIs). The CIs are stored in the Run-time Service Model, 
and organized into hierarchical format based on the interdependencies in 
your organization’s IT environment. 

A view can also include logical CIs that represent your business services, 
applications, LOBs, or any other type of business-related grouping. These 
CIs get their statuses from the underlying monitored CIs within the view.

The assignment mechanism assigns KPIs and health indicators to each CI, 
showing current operational status or business impact over time.
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Status propagates according to the relationships between the CIs and 
according to the impact direction from the monitored CIs, through parent 
CIs, and up to the highest CI. KPI status on CIs is based on an aggregation of 
HI statuses, and other KPI statuses (the calculation method used for this 
aggregation varies, according to the KPI’s business logic). For details about 
the propagation, see "Assignment and Propagation Overview" on page 558.

You can view a subsection of CIs in different views in Service Health. Each 
view provides a different aspect of your organization’s IT universe, enabling 
you to focus on the IT area that is of interest.

Data sources send data on varying schedules. Service Health checks for new 
data every 5 seconds by default and updates its display accordingly, so that 
the information displayed in Service Health represents the real-time 
availability and performance of your organization's infrastructure 
components and business processes.

This section also contains the following topics:

➤ "Monitoring Performance Problems" on page 36

➤ "Monitoring Service Level Agreements With the PNR KPI" on page 37

Monitoring Performance Problems
When a KPI on a CI shows a performance problem (for example, Availability 
is low), you can drill down to the source of the problem, view reports, and 
track problem handling. You can use Service Health to view additional 
information offered by the monitoring domain (for example, using the BPM 
Triage Report), display performance graphs by Performance Manager, or 
view external HP products such as Release Control (for planned changes), 
HP Service Manager (for incidents).
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Monitoring Service Level Agreements With the PNR KPI
Service Level Management enables you to verify that service level 
agreements that were signed with internal and external customers are met.

In Service Health, you can view a Point of No Return KPI that is calculated 
based on SLA data. This gives you advanced warning of any potential 
breaches of contract, and you can act proactively to fix a problem before the 
SLA is breached. For details, see "PNR (Point of No Return) KPI Calculation" 
on page 422.

View Topology

The CIs and relationships discovered by the various CI-generating tools that 
operate within Business Service Management, are stored in the Run-time 
Service Model (RTSM).

The service views displayed in Service Health are built from CIs contained in 
the RTSM. These CIs are mapped together to build views that meet your 
business requirements and objectives, and monitor what is important to 
you. For a detailed explanation of how views are built, see "Working with 
Views in IT Universe Manager" in the Modeling Guide.

Note: User access to Service Health views is limited by the viewing 
permissions specified for the user. If you cannot see a view, contact your 
administrator. For details, see "Permissions Overview" in Platform 
Administration.

Certain views defined in the RTSM are not available by default in Service 
Health or Service Level Management, because these applications filter for a 
view bundle named service health. To display a view that is not visible in 
Service Health or Service Level Management, open the view in the RTSM 
administration or in the Service Health View Builder, and assign the view to 
the service health bundle.
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This section contains the following topics:

➤ "Impact Modeling" on page 38

➤ "CIs in Views" on page 38

➤ "CIs and Infrastructure Changes" on page 39

Impact Modeling
In Service Health, views show the topology of the CIs that were selected in 
the RTSM as being part of the view definition. The views also display the 
status of the KPIs attached to the CIs in the view.

A KPI’s status is propagated from a child CI to a parent CI according to the 
propagation definition, when the parent CI and the child CI are linked by 
either an Impacted By (Directly) or an Impacted By (Potentially) calculated 
relationship. For details about these relationships, see "Impact Modeling 
Overview" in the Modeling Guide.

Each view has a specific set of CIs, and a topology that provides a hierarchy 
of CIs. Each CI has only one instance in the RTSM. Different views can look 
at the same CI. 

Details on specific views are provided in subject-related documentation; for 
example EUM views are detailed in "Predefined Views for End User 
Management" in Using End User Management.

CIs in Views
The view structure typically includes a hierarchy of monitored CIs, grouped 
into logical groups that represent different domains, technologies, 
application, and services.

You can use the CI hierarchies created in the predefined monitoring views as 
the building blocks for defining your own customized views.
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Service Health also enables you to create or edit global and local impact 
views. Within a global view, when you assign a KPI or HI to a CI or modify 
indicator definitions, your changes are reflected in all views which contain 
the CI. A local impact view is independent of other views, so that indicator 
definitions on a CI within a local impact view have no effect on other views. 
For details, see "View Builder Overview" on page 380.

CIs and Infrastructure Changes
When changes are made to your organization’s infrastructure, they are 
detected by the discovery component that exists in each of the monitoring 
tools. Service Health checks every 10 seconds (by default) for configuration 
changes received from the external sources. The structure and content of the 
CI hierarchies are then automatically updated and displayed within Service 
Health.

In addition, changes made within HP Business Service Management, by 
changing the configuration in End User Management Administration or 
manually updating CIs in RTSM Administration, are also automatically 
deployed to Service Health.

Health Indicators, KPIs, and KPI Domains

BSM contains an array of default monitoring capabilities to collect 
information on various aspects of your system. When you install BSM, out-
of-the-box content packs contain the necessary definitions to automatically 
monitor the health of each of your domains. Without needing initial 
configuration, BSM contains data regarding which health measurements are 
relevant to your monitored environment.

Within Service Health, Key Performance Indicators (KPIs) and health 
indicators (HIs) are automatically assigned to the CIs representing your 
business and processes, to help you monitor in real-time how well your 
business is achieving its objectives. The statuses and values of these 
indicators enable you to assess the business impact of problems in the 
system. 
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For further details, see "Health Indicators and KPIs - Overview" on page 115.

This section contains the following topics:

➤ "Health Indicators" on page 40

➤ "KPIs (Key Performance Indicators)" on page 41

➤ "KPI Domains, CITs, and Indicators" on page 41

Health Indicators
Health indicators (HIs) provide fine-grained measurements on the CIs that 
represent your monitored applications and business services. Some HIs 
provides business metrics such as backlog and volume, while others monitor 
various aspects of performance and availability such as CPU load or disk 
space.

There are two types of data sources that can contribute to an HI’s status and 
value: events, and metrics. Some data collectors such as SiteScope send 
events to Service Health (for example, CPU load exceeded threshold), while 
other such as Real User Monitor send samples containing metrics (for 
example, response time = 6 milliseconds).

When an event is sent to Service Health, it is sent with an ETI (event type 
indicator). The ETI includes a name and a state, for example 
CPU_Load:exceeded. Using HI definitions in the indicator repository, 
Service Health translates the ETI state into one of the standard Service 
Health statuses (Critical, Major, Minor, and so on).

Metric-based HIs apply calculation rules to the samples generated by the 
data collectors, to create a calculated HI value. For example, Business Process 
Insight can collect several response time samples over a 15 minute period. A 
calculation rule will calculate the average of all those samples, and set the 
HI’s status and value accordingly.

The indicator repository enables you to define that when the status of a 
specific metric-based HI changes, an event is generated. This event then 
appears in the Event Browser, showing that the HI status has changed.
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KPIs (Key Performance Indicators)
KPIs are high-level indicators of CI performance and availability, which 
apply calculation rules to the data provided by HIs to determine CI status. 
KPIs can be calculated using statuses of HIs, KPIs, or a combination of these. 
For example, you can specify a rule that sets the severity of the KPI to the 
worst severity status of any assigned HI, or to the average severity status of 
all child KPIs. 

The value that results from the calculation is used to set a severity level for 
the KPI based on the KPI definitions; KPI severity can be normal, warning, 
minor, major, or critical. The resulting measurement for the KPI is translated 
into a color-coded status indicator displayed in Service Health, where the 
color represents a more desirable or less desirable condition for the KPI.

You can define a KPI to only use specific HIs that are of interest to you. For 
example, the BPI Backlog KPI has two HIs: Backlog Value and Backlog 
Count. If you are interested only in the financial aspects, you can set the KPI 
to only include the Backlog Value HI in its calculation.

Note: In Business Service Management versions earlier than 9.0, KPIs were 
calculated for monitor CIs (also known as leaf CIs). From version 9.0, HIs are 
calculated directly on monitored CIs, and KPIs are calculated either based on 
HIs, or based on other KPIs, as described above.

KPI Domains, CITs, and Indicators
Domains are groups of KPIs that monitor similar functions; for example, the 
Network domain contains the Network Availability and Network 
Performance KPIs, while the Business Health and Business Impact KPIs are 
assigned to the Business domain.
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The following diagram illustrates the relationship between KPI domains, 
CITs, and indicators. Note that this diagram shows typical indicators for 
each domain. For the full list of indicators on each CIT, access the indicator 
repository.

In this example, you can see that the Business domain includes KPIs and HIs 
that monitor Business Service and Business Process CITs. The data collector 
monitoring these CIs is Business Process Insight. The HIs monitored for 
these CITs include Number of Failures, BP Step Backlog, and Value of 
Payments. These HIs are used to calculate the following KPIs: Delays, Value, 
Volume, and Backlog.
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Understanding KPI Status

For each CI, the Service Health Hierarchy component displays real-time 
status in one or more KPI columns in the view. For details, see "Hierarchy 
Component Overview" on page 224.

This section contains the following topics:

➤ "KPI Icons: Status, Trend and History" on page 43

➤ "KPI Calculation Rule" on page 44

➤ "KPI Tooltip" on page 44

KPI Icons: Status, Trend and History
Each KPI can include three icons: Status, Trend, and History.

A color-coded icon is displayed for each KPI in a view, representing the KPI’s 
status. In addition to the main status icon for a KPI, the KPI column can 
contain additional icons showing trend and history for the CI under that 
KPI. 
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The status of a KPI in Service Health provides an indication of how well a 
business process or system is meeting your business objectives. Based on 
traffic light colors (with additions), the Service Health shows you whether 
the KPI measurement is meeting the objective requirements (green), is 
critically failing (red), or is at some business risk level between the two 
(aqua, yellow, orange). For more details on thresholds, see "KPI and HI 
Thresholds" on page 401. 

For details on KPI status colors, see "KPI Status Colors and Definitions" on 
page 45. For details on Trend and History, see "KPI Trend and History" on 
page 48.

KPI Calculation Rule
The status of each KPI is calculated using a business rule, which is applied 
on selected HIs, and on KPIs of child CIs. A different business rule may be 
used for a parent CI and a child CI with the same KPI attached. The business 
rules are defined for the KPI in Service Health Administration. For details on 
the rules, see "List of Calculation Rules in Service Health" on page 740.

KPI Tooltip 
The Details tooltip for each status icon provides additional information 
regarding the following: the calculation method in use for the KPI, the KPI 
status, the time and date when the status was changed to its current value, 
as well as additional information depending on the CI and the KPI.
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Tip: If the status of a KPI indicates a problem on a CI, you can access the 
Health Indicator component to see if there are problematic HIs on the CI 
itself, or look at the KPIs calculation rule (for example Worst Status) to 
understand the root of the problem.

If the KPI is on a higher-level logical CI, you can also use the CI’s menu 
commands to drill down to the source of the problem. For details, see 
"Service Health Menu Options" on page 98.

KPI Status Colors and Definitions

The following shows the main status levels that are used to show status for 
KPIs in Service Health:

Icon Description Status Name
Numerical 
Code

Definition

Red circle with 
"X"

Critical 0 The measurement calculated for the KPI 
fell within the value range for the 
Critical threshold.

Orange triangle 
with exclamation 
mark

Major 5 The measurement calculated for the KPI 
fell within the value range for the Major 
threshold.

Yellow triangle 
with exclamation 
mark

Minor 10 The measurement calculated for the KPI 
fell within the value range for the Minor 
threshold.

Aqua triangle 
with exclamation 
mark

Warning 15 The measurement calculated for the KPI 
fell within the value range for the 
Warning threshold.

Green circle with 
check mark

OK 20 The measurement calculated for the KPI 
fell within the value range for the OK 
threshold.
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Dark blue circle 
with lowercase i

Informational -1 The KPI has a value and no status. The 
reason is that the KPI’s thresholds have 
not yet been specified. For details on 
setting the thresholds, see "How to 
Define Thresholds for KPIs and HIs" on 
page 433.

Light blue circle 
with question 
mark

Not up to 
date (Decay)

-2 The following cases might be the cause 
of the KPI’s status:

➤ The KPI has passed a timeout period 
during which no new information 
has been received.

The default timeout period is 15 
minutes, and the default decay status 
color is light blue.

➤ No performance measurement data 
has yet been received for this KPI. 
This may be the case if no 
measurements have been taken for 
the CI in the period since starting 
Service Health or Business Process 
Monitor.

Brown octagon 
with white 
square

Stopped -3 The corresponding 
profile/group/monitor for the CI is 
currently disabled. 

When the stopped period finishes, the 
status icon changes to Not up to Date 
until data is received for the CI.

Icon Description Status Name
Numerical 
Code

Definition
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The numerical code is used in HP Business Service Management files to 
perform calculation instead of the corresponding status.

The color displayed for a CI icon in Service Health represents a summary of 
interim status values for a predefined duration (the default duration value is 
generally 300 seconds). The calculation of status values is an ongoing 
process, using samples collected every 60 seconds (default granularity 
value), thus the interim status may actually change several times over the 
duration without causing any change in the color of the icon. For example, 
if the icon for a transaction is red at the beginning of a duration, and during 
the duration the interim status changes from red to green and back to red, at 
the end of the duration the icon is still red.

To change the color of the icons used at each status level, you can customize 
some of the icons, or complete sets of icons. For details, see "How to Change 
the KPI Status Icons" on page 441.

White circle with 
gray outline and 
gray back slash

Downtime -4 The corresponding 
profile/group/monitor for the CI is 
currently disabled. 

When the downtime period finishes, 
the status icon changes to Not up to 
Date until data is received for the CI.

Note: HIs do not have Downtime status.

Gray with white 
center

Not 
applicable for 
this CI

N/A This KPI is not applicable for the CI.

Icon Description Status Name
Numerical 
Code

Definition



Chapter 1 • Introducing Service Health

48

KPI Trend and History

The following status levels are used to show historical and trend status for 
monitored CIs in the Service Health Hierarchy component:

➤ Trend Status

The trend status has three positions: up, down, and no change. It shows 
the trend of the real-time status.

➤ History Status

The history status can display the worst status or the average status over a 
time period. 

Icon Description Status Status Definition

Red 
downward 
arrow

Downward 
trend

Real-time status shows a downward 
trend.

Blue double-
sided arrow

Stable trend Real-time status shows a stable 
trend.

Green 
upward 
arrow

Upward trend Real-time status shows an upward 
trend.

Icon Description Status Status Definition

Small green 
circle with 
checkmark

Historical OK All performance measurements fell 
within the OK threshold level over a 
time period up to the present.

Small yellow 
triangle with 
exclamation 
mark

Historical Minor At least one performance 
measurement fell within the Minor 
threshold level, but no 
measurements fell within the Major 
threshold level, over a time period 
up to the present.
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Note: When a CI has no history or trend data (for example, the CI status is 
uninitialized or stopped) or when history or trend data is not relevant for 
the CI’s KPI, the history or trend icons are not displayed.

For details on how trend and history are calculated, see "KPI Trend and 
History Calculation" on page 408. 

Local Impact Views

The default views within Business Service Management are global views. 
Within a global view, when you modify KPI or health indicator definitions 
on a CI, your changes are reflected in all views which contain the CI, across 
Business Service Management.

Small orange 
triangle with 
exclamation 
mark

Historical Major At least one performance 
measurement fell within the Major 
threshold level, but no 
measurements fell within the 
Warning threshold level, over a 
time period up to the present.

Small aqua 
triangle with 
exclamation 
mark

Historical 
Warning

At least one performance 
measurement fell within the 
Warning threshold level, but no 
measurements fell within the 
Critical threshold level, over a time 
period up to the present.

Small red 
with "X"

Historical 
Critical

At least one performance 
measurement fell within the Critical 
threshold level, over a time period 
up to the present.

Icon Description Status Status Definition
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Service Health Administration includes a View Builder, which enables you to 
create local impact views, which are independent of all other views. When 
you modify indicator definitions on a CI within a local impact view, this has 
no effect on this CI in all other views.

For details on creating views, see "View Builder Overview" on page 380.

Local Impact Views
Local impact views operate on a WYSIWYG (what you see is what you get) 
principle. For example, suppose you have a global view which contains a 
number of CIs representing business transactions, and you are only 
interested in the data coming from two or three significant transactions. 
You can create a local impact view based on the global view, remove the less 
important transactions from the local impact view, and the calculations 
within the view are performed using only those transactions that are visible 
within the view.

In contrast, within a global view you can hide CIs from being displayed, but 
calculations within the view are performed using all of the CIs that exist in 
the view, including those that are hidden from display.

Configuring Breakdowns
Some data collectors collect information based on many dimensions 
(application, transaction, location, and so on), but Service Health generally 
displays aggregated data of the CIs.

Within local impact views, you can configure data breakdowns on CIs, so 
that data is displayed according to a particular dimension.

For example, if you want to monitor application performance in different 
locations, you can define a breakdown by location to calculate KPIs in 
smaller granularity. When an application by location breakdown is defined, 
each application contains group CIs representing the locations where 
transactions are running. KPIs are then calculated separately for each 
location.

Breakdowns are only available in local impact views. For details on how to 
define breakdowns, see "How to Configure Breakdowns" on page 444.
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Service Health Application Components in the Service 
Report 

You can build Service reports based on data from data sources from the 
Service Health application. You can add Service reports as components in 
MyBSM or in Report Manager. After you have added Service reports to the 
Report Manager, you can add the reports as Custom report components to 
benefit from all the Custom report capabilities. For details, see "Service 
Report Overview" or "Report Manager Overview" in Reports.

About Menu Options

Within Service Health you can access context menu options for a CI by 
right-clicking on the CI, or by clicking the gray arrow  button to the right of 
the CI in some application components.

Depending on the selected view and selected CI, you can, among other 
possibilities, drill down to other HP Business Service Management 
applications or to SiteScope, or open standalone reports or views. For 
example, you can view a trend report on the End User Management page, 
including measurement data for the CI over a specified time period.

The menu options that are displayed depend on the selected view and the 
selected CI. They can be a subset of the available options. 

For details on the options, see "Service Health Menu Options" on page 98.

For advanced information on the various menu options, see "Context Menu 
Repository" on page 891.
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Tasks

How to Monitor Your Environment Using Service Health

You can display different aspects of the data collected in BSM regarding the 
health of the infrastructure elements and business processes in your 
monitored environment, using the Service Health application components.

The following sections describe how you can display different types of data 
using the Service Health application components.

Some components are contained within the out-of-the-box Service Health 
pages, while others can be added to pages as needed. For details on how to 
work with the Service Health pages and components, see "How to Open 
Pages and Components in Service Health" on page 60.

Note: If you cannot see data in your Service Health components, refer to 
"How to Display Data in Service Health - Prerequisites" on page 63.

The following steps are optional, and can be performed in any order:

➤ "Display information on the CIs in an active view, using components on 
the 360° View page" on page 53

➤ "Display a visual representation of CIs and their statuses in a hierarchical 
image, using the Top View component" on page 54

➤ "Display a visual representation of CIs and their statuses in an interactive 
graphic representation, using the Topology Map component" on page 54

➤ "Display an association between geographical locations and CI status 
indicators" on page 54

➤ "Display icons representing the view’s CIs on a custom image" on page 54

➤ "Display the parent CIs and child CIs of a selected CI, in an interactive 
hierarchical graphic" on page 55
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➤ "Display KPI over time data" on page 55

➤ "View the CI status reports" on page 55

Display information on the CIs in an active view, using 
components on the 360° View page

You can use application components within the 360° View page to display 
various types of information on your monitored CIs. The 360° View page is 
one of the default pages in Service Health, and it enables you to do the 
following:

➤ To display the hierarchy of the CIs in a view, and the real-time status of 
each of the KPIs assigned to these CIs, select Applications > Service Health 
> 360° View > Hierarchy. You can also filter the display to only show CIs 
with KPIs of a specific status, or specific CI types. For user interface 
details, see "Hierarchy Component User Interface" on page 258.

➤ To display business CIs and SLAs impacted by CIs in the active view, select 
Applications > Service Health > 360° View > Hierarchy. Select a CI, and 
click Business Impact. For user interface details, see "Business Impact 
Component User Interface" on page 268.

➤ To display details regarding the health indicators assigned to a CI, their 
associated KPIs, and their values and statuses, select Applications > Service 
Health > 360° View > Hierarchy. Select a CI, and click Indicators. For user 
interface details, see "Health Indicator Component User Interface" on 
page 271.

➤ To display CI status alerts triggered by CIs in the active view, select 
Applications > Service Health > 360° View > Hierarchy. Select a CI, and 
click Alerts. For user interface details, see "Alerts Component User 
Interface" on page 274.

➤ Display requests for change and actual changes made to CIs, and 
incidents opened for CIs. Select Applications > Service Health > 360° View 
> Hierarchy. Select a CI, and click one of the following: Actual Changes, 
Planned Changes, or Incidents. For user interface details, see "Changes 
and Incidents Component User Interface" on page 276.
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Display a visual representation of CIs and their statuses in a 
hierarchical image, using the Top View component

Select Applications > Service Health > Top View; the Top View page is one of 
the default pages in Service Health. For user interface details, see "Top View 
Component User Interface" on page 162.

Display a visual representation of CIs and their statuses in an 
interactive graphic representation, using the Topology Map 
component

Select Applications > Service Health > Topology Map; the Topology Map 
page is one of the default pages in Service Health. Topology Map enables 
you to arrange CIs in groups (either divided by CIT or by similar 
applications), or in functional layers. For user interface details, see"Topology 
Map Component" on page 176.

Display an association between geographical locations and CI 
status indicators

Select Applications > Service Health > Geographical Map; the Geographical 
Map page is one of the default pages in Service Health. For details, see "How 
to Display and Customize a View in Geographical Map" on page 194.

Display icons representing the view’s CIs on a custom image

Select Applications > Service Health > Custom Image; the Custom Image 
page is one of the default pages in Service Health. For details, see "How to 
Display a View in a Custom Image" on page 216.
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Display the parent CIs and child CIs of a selected CI, in an 
interactive hierarchical graphic

The Neighborhood Map component is a Service Health application 
component that is not opened by default. To display a Neighborhood Map, 
add this component to a page, as described in "How to Open Pages and 
Components in Service Health" on page 60.

Display KPI over time data

The KPI component, which displays KPI over time status and federated KPI 
values for CIs, is a Service Health application component that is not opened 
by default. To display the KPI component, add this component to a page, as 
described in "How to Open Pages and Components in Service Health" on 
page 60.

View the CI status reports

Select Applications > CI Status, and select one of the following reports: KPIs 
Distribution Over Time, KPIs Over Time, KPIs Summary, KPIs Trend reports, 
and CI Status Alerts. For details, see "CI Status Reports User Interface" on 
page 340.

How to Use Service Health - Use-Case Scenario 

This use-case scenario describes how Sarah, an application owner at ACME 
Savings and Loan, uses Service Health to identify a problem in ACME’s 
online banking division, and quickly pinpoint its source.

This scenario includes the following:

➤ "A problem is detected in the online banking division" on page 56

➤ "The KPIs tab shows that the problem is not new" on page 57

➤ "The Health Indicators tab shows more details about the problem" on 
page 58

➤ "A likely solution is found using the Changes and Incidents tab" on 
page 59
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 1 A problem is detected in the online banking division

Sarah has created a page based on the 360° View to monitor the CIs that 
represent ACME’s online banking application. In her page, she puts the 
Hierarchy component in the upper area, and the following components 
in tabs in the lower area: Business Impact, KPIs, Health Indicators, and 
Changes and Incidents.

In the Hierarchy component, she sees that the Application Availability 
KPI of the Online Banking CI has a problematic status.

Sarah then looks at the Business Impact tab to decide what priority to 
assign the problem. She sees that this CI has an impact on an SLA which 
is currently breached; this tells her that the problem should be assigned a 
high priority.
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 2 The KPIs tab shows that the problem is not new

Sarah wants to see if the problem with this CI is new, or if it is ongoing. 
She looks at the KPIs tab to see the status of the problematic KPI over the 
past day. 

She sees that during the last 24 hours, the status of this KPI has been 
Critical during a significant part of the day.
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 3 The Health Indicators tab shows more details about the 
problem

Sarah knows that some KPIs are calculated based on health indicator 
values, and she wants to drill down and see which HIs are related to the 
problematic KPI. 

She opens the Health Indicators tab, and sees that this KPI is based on two 
HIs; one of which, Real User Sessions Availability, is Critical. This gives 
her another indication about the importance of the problem.
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 4 A likely solution is found using the Changes and Incidents 
tab

Sarah now wants to see if anything has recently changed relating to the 
Online Banking application, which might explain its poor availability. 
She looks at the Changes and Incidents tab, and sees that two changes 
have been recently logged regarding this CI.

In the Hierarchy component, Sarah sees that the online banking 
application which had utilized one virtual server was switched to another 
server. Sarah concludes that the changes to these virtual machines 
probably caused the problem with application availability, and she can 
now open a ticket to the specific user who authorized these changes.
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How to Open Pages and Components in Service Health

The Service Health workspace enables you to view default Service Health 
pages, and to create new pages containing components from Service Health 
and other applications. Each page is displayed as a tab within the 
workspace. For a list of default Service Health pages and components, see 
"Monitoring your Environment Using the Service Health Application" on 
page 30.

The Service Health workspace and the MyBSM workspace both enable you 
to manage pages and components in the same way. The following section 
provides a brief explanation of how to open pages and components within 
Service Health. For more details on how to use your workspace to manage 
pages and components, see "How to Create Your MyBSM Workspace" in 
Using MyBSM.

For user interface details, see "Service Health Workspace" on page 81.

Note: By default, up to 10 pages can be open at the same time. If you have 
multiple pages open, up to 5 pages are refreshed automatically; any 
additional open pages are refreshed when you select them. To modify these 
limits, see "How to Modify the Maximum Number of Pages" in Using MyBSM.

The following tasks are optional, and can be performed in any order.

➤ "Open a page" on page 61

➤ "Configure the layout of a new page (optional)" on page 61

➤ "Add application components to a page" on page 61

➤ "Set up communication (wiring) between components" on page 62

➤ "Add an external component to the component gallery" on page 62

➤ "Modify categories of pages and components" on page 62

➤ "Access online help for a component" on page 62
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Open a page

Service Health contains the following out-of-the-box pages: 360° View, 
Custom Image, Geographical Map, Top View, and Topology Map.

➤ To open a page that is not open in your workspace, select the page from 
the Page Selector dropdown list. This is on the Page Management toolbar, 
in the upper right area of your workspace. This list contains the most 
recently opened pages.

➤ To open a page that is not in the dropdown list, click the Page Gallery 
button on the Page Management toolbar.

➤ To create a new page, click the New Page button on the Page 
Management toolbar.

Configure the layout of a new page (optional)

When you create a page, you can configure how the components will be 
arranged on the page. You can define each layout as horizontal 
(components are displayed side by side), vertical (components are displayed 
one above the other), or in tabbed areas.

Use the layout tools in the upper left area of a blank layout to define the 
layout of a new page. For user interface details, see "Layout Tools" on 
page 83.

Add application components to a page

To add an application component to a page, open a page and click the 
Components button on the Page Management toolbar. Select a component, 
and drag it to an area on the page.

Tip: If the target area is hidden by the Component Gallery dialog box, click 
the dialog box title bar and drag it to another location on your screen.
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Add an external component to the component gallery

You can add any URL as a component within Service Health. Open a page, 
and click the Components button on the Page Management toolbar. 

Click the Add External Component button, and define the component as 
described in "How to Create an External Component" in Using MyBSM. The 
new component is added to the Component Gallery, and can then be added 
to any page.

Set up communication (wiring) between components

After you place components on a page, you can define how components 
react to one another; for example, when you select a CI in one component, 
the other components will display information relevant for that CI.

Default pages have wiring predefined; you can also modify default wiring 
definitions. For details, see "How to Set Up Wiring Between Components" in 
Using MyBSM. 

Modify categories of pages and components

The Page Gallery and the Components Gallery contain default categories to 
help you organize pages and components. You can add categories, edit or 
delete user-defined categories, and add or remove pages and components 
from categories.

For details, see "How to Modify the Maximum Number of Pages" in Using 
MyBSM.

Access online help for a component

To access online help regarding a BSM component, click the Component 
Menu button on the component toolbar, and select Help. For user interface 
details, see "Component Toolbar" on page 85.
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How to Display Data in Service Health - Prerequisites

To display data in Service Health, you must have data sources set up to 
collect data from your monitored CIs, and you must set up views. BSM 
collects data about end-users, business processes, and systems, and displays 
the data in topologies (views) relevant to your organization.

The following tasks are optional, and can be performed in any order.

➤ "Deploy monitors" on page 63

➤ "Discover your IT environment" on page 63

➤ "Define views" on page 64

➤ "Integrate with other applications" on page 64

Deploy monitors

Depending on your environment, you can deploy monitors to collect 
performance and availability data, using any of the BSM monitoring 
solutions. 

For example, SiteScope monitors collect network and system data which is 
displayed in the system-related views. Business Process and Real User 
Monitor profiles and monitors collect performance data, which is displayed 
in the End-User views.

For details, refer to the documentation of the relevant monitoring solutions.

Discover your IT environment

Each of the monitoring solutions perform automatic discovery of various 
aspects of your monitored environment. You can also collect information 
about your system by running Data Flow Management to enable you to 
discover the IT infrastructure resources and their interdependencies, such as 
applications, databases, network devices, servers, and so on.

Each discovered IT resource is delivered to, and stored in, the Run-time 
Service Model, where the resource is represented as a managed configuration 
item (CI). For details, refer to the RTSM Data Flow Management Guide.
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Define views

The IT Universe model in the RTSM can be very large, holding thousands of 
configuration items (CIs). A view enables you to build a subset of the overall 
IT Universe model, containing only those CIs relating to a specific area of 
interest. Some views are automatically created when you use standard 
SiteScope, Business Process Monitor, and Real User Monitor profiles and 
monitors. 

You can define your own views to display only the information that is 
relevant to your organization’s business needs. For details, see "Working 
with Views in IT Universe Manager" in the Modeling Guide.

You can also create and modify views from within Service Health 
Administration. For details, see "How to Create or Edit Views Using View 
Builder" on page 384.

Integrate with other applications

You can enrich your Service Health data by integrating BSM with other 
applications. For details, see "Business Service Management Integration with 
Other Applications" in Solutions and Integrations.
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How to Customize Calculations in Service Health

You can customize the way HP Business Service Management calculates 
information in Service Health. This customization can be done on different 
levels:

➤ Within the repositories you can modify the templates or building blocks 
of Service Health calculation.

➤ Within assignment administration, you can modify the automatic KPI 
and HI assignments and propagations.

➤ Within a specific view, you can modify KPI and HI settings on one or 
more CI instances.

The following tasks are optional, and can be performed in any order.

➤ "Modify template definitions for KPIs, HIs, business rules, and context 
menus in the repositories" on page 65

➤ "Modify automatic indicator assignments and propagations across views" 
on page 66

➤ "Customize KPI and HI definitions within a specific view" on page 66

Modify template definitions for KPIs, HIs, business rules, and 
context menus in the repositories

The repositories provide template definitions for KPIs, HIs, business rules, 
and context menus, used across views. Many of these definitions can be 
customized as required by your organization. You can create or modify 
templates for indicators, rules, and context menus, and create new rules 
using the Rules API.

To customize templates, select Admin > Service Health > Repositories.

➤ For details on customizing KPI templates, see "How to Customize a KPI 
Template in the Repository" on page 653.

➤ For details on customizing HI templates, see "How to Create or Edit an ETI 
or HI Template in the Indicator Repository" on page 689.

➤ For details on customizing calculation rule templates, see "How to 
Customize a Business Rule Template in the Repository" on page 724.
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➤ For details on creating rules, see "Creating Rules with the Rules API" on 
page 957.

➤ For details on customizing context menu templates, see "How to 
Customize a Context Menu Template in the Repository" on page 893.

Modify automatic indicator assignments and propagations 
across views

CIs associated with default data sources generally have default KPIs and HIs. 
For example, Business Process Monitor, Real User Monitor, and SiteScope CIs 
that you configure in End User Management Administration or System 
Availability Management Administration, all have default KPIs and HIs.

When a new CI is added to the RTSM, the assignment mechanism is 
automatically triggered. This mechanism assigns the appropriate KPIs, HIs, 
and context menus to the CI, based on the CI’s CI type (CIT). To customize 
assignments, select Admin > Service Health > Assignments. For details on 
customizing assignments, see "How to Define a KPI or HI Assignment" on 
page 574.

By default, when a KPI is assigned to a CI the KPI is automatically 
propagated to the CI's parents. Propagation rules enable you to define 
exceptions to the default KPI propagation, and to propagate other KPIs, the 
same KPI using a different rule, or no KPIs. For details about customizing KPI 
propagation, see "How to Define a KPI Propagation Rule" on page 577.

Customize KPI and HI definitions within a specific view

You can manually attach KPIs and HIs to CIs in a view, and edit definitions 
of KPIs and HIs attached to specific CIs.

To manually change indictor definitions in a view, Admin > Service Health > 
CI Indicators. For details, see "CI Indicators Tab" on page 453.
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How to Manage a New CIT in Service Health - Workflow 
Scenario

In the following scenario, John (a BSM administrator) has added a new CI 
type to his monitored system. He is now configuring how Service Health 
monitors this CIT.

Note: This scenario provides a high-level workflow to illustrate various 
aspects of Service Health customization. Many of the steps are optional, and 
can be performed in a different order.

 1 John creates new indicator templates for his CIT.

John uses the repositories to create a new KPI, HI, business rule, and 
context menu relevant for the new CIT. These indicators will then be 
assigned to all CIs with the new CIT, and will be calculated using the new 
rule; the CIs will have the menu options John defines in the repository for 
the CIT. For details, see:

➤ KPI. "How to Customize a KPI Template in the Repository" on 
page 653.

➤ HI. "How to Create or Edit an ETI or HI Template in the Indicator 
Repository" on page 689.

➤ Business rule. "How to Customize a Business Rule Template in the 
Repository" on page 724.

➤ Context menu. "How to Customize a Context Menu Template in the 
Repository" on page 893.

 2 He then modifies KPI and HI assignments.

Within the Assignments tab, John now performs two types of tasks:

➤ He creates assignments for the new CIT so that relevant predefined 
KPIs and HIs are automatically assigned to all CIs with this CIT.

➤ He also edits existing assignments on other CITs, so that they are 
assigned with the new KPI and HI he created in the repository.
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For details on customizing assignments, see "How to Define a KPI or HI 
Assignment" on page 574.

 3 John creates a local impact view with a breakdown.

The new CIT will be displayed in a number of existing views, but John 
also wants to create a view which will include the new CIT, and calculate 
its indicator values based on a breakdown by location.

John creates a local impact view where the CIT’s indicators are calculated 
differently than in the global views, and he creates a breakdown in this 
view so the CIT is displayed by location.

For details, see:

➤ Local impact view. "Local Impact View Calculation" on page 382.

➤ Breakdowns. "How to Configure Breakdowns" on page 444.

 4 Finally, John modifies KPI and HI definitions on CI instances.

Within the CI Indicators tab, John opens a view, and selects specific CI 
instances within that view. He then manually edits definitions of the KPIs 
and HIs that are attached to those CIs. For details, see "CI Indicators Tab" 
on page 453.
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How to Customize Service Health Display

You can customize the way information is displayed in Service Health. The 
following tasks are optional, and can be performed in any order.

➤ "Create or modify global views or local impact views" on page 69

➤ "Create a custom image to represent your monitored environment" on 
page 70

➤ "Configure CI status alerts for a view" on page 70

➤ "Modify the maximum length of CI names" on page 70

➤ "Modify the maximum number of CIs to be displayed in Service Health" 
on page 71

➤ "Modify the Service Health tabs refresh rate" on page 71

➤ "Customize tooltips and icons" on page 72

➤ "Customize the timestamp" on page 73

Create or modify global views or local impact views

The View Builder enables you to create or edit global views and local impact 
views. Within a global view, when you assign a KPI or HI to a CI your 
changes are reflected in all views which contain the CI. 

A local impact view is independent of other views, so that indicator 
definitions on a CI within a local impact view have no effect on other views. 

To create or modify global views or local impact views, access Admin > 
Service Health > View Builder. For details, see "How to Create or Edit Views 
Using View Builder" on page 384.
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Create a custom image to represent your monitored 
environment

You can define a custom image to represent a view, and then place CIs 
within that image. The Custom Image component in Service Health will 
then display this view with real-time CI status icons, in the context of this 
background image. The custom image can be useful for representing data 
centers, geographical distribution of IT resources, and so on.

To create a custom image, access Admin > Service Health > Custom Image. 
For details, see "How to Assign a Custom Image to a View" on page 491.

Configure CI status alerts for a view

You can configure the CI status alert mechanism, which sends alert 
messages to pre-defined recipients, and executes actions defined for the 
alert. Alerts can be sent regarding specific KPIs or CIs, based on a pre-defined 
status change. 

To configure CI status alerts, access Admin > Service Health > CI Status 
Alerts. For details, see "How to Create a CI Status Alert Scheme and Attach it 
to a CI" on page 503.

Modify the maximum length of CI names

To change the default length (40 characters) of the CI name, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, choose 
Applications, select Service Health Application, and in the Service Health 
Application - Service Health Layout Properties table, modify the CI name 
maximum character length entry. When the CI name is longer than this 
value, it is shortened in the display and a tooltip displays the complete 
name. 
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Modify the maximum number of CIs to be displayed in Service 
Health

To change the default number of CIs that can be displayed in a view, select 
Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Service Health Application, and in the Service 
Health Application - Service Health Layout Properties table, modify the 
Displayed CI limit entry. Default is 3000.

Note: This limit is independent of the number of CIs actually displayed by a 
filter. The limit is the number of CIs that can be in a view.

Modify the Service Health tabs refresh rate

When you open a Service Health tab for a view tree with a large 
infrastructure, you may experience a short delay while Service Health builds 
the view.

The Hierarchy, Top View, and Topology Map tabs are refreshed every 30 
seconds. If no change is made to the view, the display remains the same. If 
changes have been made to a view, or if CIs have been deleted from the 
view, that view’s information in the tab is automatically reloaded after 30 
seconds and displays the changes. 

While reloading, the following message is displayed in the top right corner 
of the screen: The model has changed. Reloading... After reloading is 
complete, the following message is displayed in the top right corner of the 
screen: <Component> has been updated with model changes. Last Update 
in the bottom left corner of the screen indicates the last time an update of 
the top view was reloaded. 

The refresh rate of the view can be modified. Click the Component Menu 
button on the component toolbar, select Preferences, and change the 
refresh rate as needed.
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Tip: Within the Top View, Topology Map, and Hierarchy components, if 
there have been major changes in the model and new CIs are discovered 
over an extended period of time, every 5 seconds the view is rebuilt. This 
stops when all the CIs are discovered. To prevent this, change the refresh 
rate to a higher value (for example, every 5 minutes). However, note that 
statuses are not updated until the next refresh occurs.

Customize tooltips and icons

You can customize some aspects of the user interface.

➤ Modify Tooltip Colors. By default, the tooltip body color is white, and the 
border color is blue. To change the default colors, edit the entry CI Tooltip 
Body Color Property or CI Tooltip Border Color Property in the Service 
Health Application - Tooltip Properties table.

➤ Modify Tooltip Font Size. The size of the fonts in tooltips is 8 by default. 
To change the default font size, edit the Top View Tooltip font size entry 
in the Service Health Application - Tooltip Properties table.

➤ Modifying Tooltip Colors for Specific KPIs. A KPI tooltip border and 
header have a default color that you can modify, per KPI. For details, see 
the KPI Parameters Area in "New KPI/Edit KPI Dialog Box" on page 668.

➤ Specifying a Different Icon Set. A different icon is used for each KPI status. 
You can replace the KPI status icons displayed in the Service Health 
application components, as well as the Trend and History icons. For 
details, see "How to Change the KPI Status Icons" on page 441.

Note: The following formats are supported for custom icons: .png, .jpg and 
.gif.
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Customize the timestamp

Service Health uses the timestamp of the database machine hosting the BSM 
database. The times displayed in the tooltips reflect the time zone setting on 
that computer. If you customize the time zone setting in BSM using the 
Admin > Personal Settings > User Account option, then the customized time 
zone is also used in Service Health.

How to View Sample Details

If required, you can set up Service Health to provide data from the last 
sample that arrived for a monitored CI. This data is viewed in the Sample 
Details dialog box for the CI. The Sample Details dialog box displays all of 
the parameters for the CI, and provides the values of the parameters at the 
last update. 

This task includes the following steps:

➤ "Set up display of last sample details" on page 73

➤ "Display the last sample information" on page 73

 1 Set up display of last sample details

You can define an individual rule attached to an HI, or all calculation 
rules, to save the last sample details in memory. 

For details, see "How to Set Up Rules to Display the Last Sample Details" 
on page 734.

 2 Display the last sample information

Right-click a CI to open its context menus, and select Show > HIs. Within 
the Health Indicator component, click an HI’s status link to open the 
Sample Details dialog box.

For user interface details, see "Sample Details Page" on page 90. 
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How to View the Business Impact Report

The Business Impact report displays information about how a CI impacts 
the Business Services and SLAs it belongs to. Data about the affected 
Business Service, Application, and Business Process CIs includes KPI data, 
over-time data, and SLA data. For example, if a host CI has critical status, 
you can use the report to display the status of the Business Service CIs to 
which the host CI is attached.

This task includes the following steps:

➤ "Access the Business Impact report for a CI" on page 74

➤ "Modify the default KPIs and rules used to display data in Business 
Impact" on page 75

➤ "Open a Business Impact report URL using direct login" on page 76

➤ "Send a Business Impact report URL with the login page" on page 77

 1 Access the Business Impact report for a CI

To view the Business Impact report for a CI, right-click the CI and select 
the Show Business Impact option. For user interface details, see "Business 
Impact Report" on page 92.

Example:

The following Business Impact report lists the Business Service CIs 
impacted by the DefaultClient_SanityPBPM_1 CI. It also indicates, in the 
Business Details area, the status of the KPIs, the current and forecasting 
statuses of the SLAs that include the Business CI selected in the Business 
CIs Summary table. 
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 2 Modify the default KPIs and rules used to display data in 
Business Impact

The system derives the parameters needed to get the data displayed in 
Business Impact from default KPIs and rules. For example, from the 
Number of Open Incidents Rule the system derives the state and severity 
of tickets to be counted in the over time number of open incidents. 

If you change the KPI or rule to be used in the Business Impact report, you 
must configure the new KPI ID in Infrastructure Settings.
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To modify the settings, select Admin > Platform > Setup and Maintenance 
> Infrastructure Settings, choose Applications, select Service Health 
Application, and locate the relevant entries in the Service Health 
Application - Business Impact table. Modify the value of the following 
parameters:

➤ Number of Open Incidents KPI. Sets the Id number of the KPI that 
defines open incidents in the report. The default is 2600 for the Open 
Incidents KPI.

➤ Number of Open Incidents Rule. Sets the Id number of the rule that 
defines open incidents in the report. The default is 2600 for the Open 
Incidents rule.

 3 Open a Business Impact report URL using direct login

You can send a Business Impact report to a recipient using one of the 
following options:

➤ An XML file containing all the relevant data for generating the report 
in any application. The information included in the report can then be 
used by another application, like Release Control or HP operation 
applications (Network Node Manager, Service Desk, and so on). 

Use the following URL:
http://<server_name>/<HP_BSM_web_application_context_name 
(usually topaz)>/TopazSiteServlet?createSession=true
&requestType=login&directLogin=true&directLoginEncrypted=true
&userlogin=<user_name>&userpassword=<password>
&applicationId=bam&customerId=<customer_id>
& portlet_url=/service-impact/main/xml.do?ciId=<CI_id> 

➤ A URL that accesses the HTML report. 

Use the following URL:
http://<server_name>/<HP_BSM_web_application_context_name 
(usually topaz)>/TopazSiteServlet?createSession=true
&requestType=login&directLogin=true&directLoginEncrypted=true
&userlogin=<user_name>&userpassword=<password>
&applicationId=bam&customerId=<customer_id>
&portlet_url=/service-impact/main/page.do?ciId=<CI_id> 
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The following parameters are used in the URLs:

➤ <user_name> and <password> are the HP Business Service 
Management user name and password and must be encrypted 
according to what HP Business Service Management is using.

➤ <customer_id> is the code of the customer. 

➤ <CI_id> is the internal identifier of the CI. To see a CI’s ID, right-
click a CI within the Service Health application and select Show > 
Properties. The value of the property Cmdb ID is the internal ID.

 4 Send a Business Impact report URL with the login page

You can send a Business Impact report to a recipient using the following 
options:

➤ An XML file containing all the relevant data for generating the report 
in any application. The information included in the report can then be 
used by another application, like Release Control or HP operation 
applications (Network Node Manager, Service Desk, and so on). 

Use the following URL, to display the login page: 
http://<server_name>/<HP_BSM_web_application_context_name 
(usually topaz)>/login.jsp?portlet_url=/service-
impact/main/xml.do?ciId=<CI_id>

➤ A URL that accesses the HTML report, included in an alert notification. 
For example, if an alert assigned to a host CI is triggered and the alert 
includes the URL of the Business Impact report for the host CI, the user 
can view information about the impact of the host CI on the Business 
Service CI. For details, see "How to Create a CI Status Alert Scheme and 
Attach it to a CI" on page 503.

Use the following URL, to display the login page: 
http://<server_name>/<HP_BSM_web_application_context_name 
(usually topaz)>/login.jsp?portlet_url=/service-
impact/main/page.do?ciId=<CI_id>

The URL displays the login page and, after you enter the user name and 
password information, opens the report.
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How to Find Visible and Hidden Child CIs

A CI’s child CIs can be specified as included (visible) or excluded (hidden) in 
a specific view. The status of any child CI, visible or hidden, has an impact 
on the status of its parent CI in any view where the parent CI appears. For 
details on including or excluding child CIs, see the Hide CIs from View 
option in "Perspective-based View Editor" in the Modeling Guide.

Within Service Health, right-click a CI and select the Find Visible and 
Hidden Child CIs option, to show the visible and hidden child CIs that 
appear in the RTSM. Note that hidden child CIs are only displayed if they 
have KPIs.

For details, see "Find Visible and Hidden Child CIs Dialog Box". 

Note: This option is not relevant in local impact views, where excluded CIs 
by definition do not influence the visible CIs.

For example, you might have the situation where, in a specific view, the 
Application Availability KPI’s status of the parent CI’s is Critical while the 
Application Availability KPI’s status of the CI’s child CIs are OK. When this 
happens, you would like to know what caused the status of the Application 
Availability KPI to be Critical. 

Use the Find Visible and Hidden Child CIs option to list all of the child CIs of 
the selected CI in the RTSM. After the list of child CIs is displayed, you can 
search for the views the child CI belongs to and then display the child CIs 
details in the specific view.
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The Find Visible and Hidden Child CIs page displays the following 
information:

➤ The name of the selected CI, whose child CIs you want to list, the CI’s 
KPIs, and their status in the current view.

➤ A list of the child CIs (visible and hidden) that appear in the RTSM, their 
KPIs and their status. In the Visible column, a checkmark indicates that 
the child CI is visible in the view and an X indicates that the child is 
hidden in the view.

How to Drill Down to SiteScope from a CI or Health 
Indicator

When SiteScope monitors are used to set the status of a CI, you can drill 
down from the CI (or from a health indicator on the CI) to a SiteScope 
monitor that contributes to the health indicator’s status. 

 1 Access menu commands from a CI in a component such as Top View, or 
from an HI in the Health Indicator component, and select Go to 
SiteScope.

The Drilldown to SiteScope dialog box displays the following hierarchy:

➤ The root level shows health indicators.

➤ The level below the root shows the SiteScopes that have monitors 
contributing to the health indicator.

➤ The lowest level shows the SiteScope monitors that contribute to the 
health indicator.

For user interface details, see "Drilldown to SiteScope Dialog Box" on 
page 95. 

 2 Select a SiteScope monitor, and click Drilldown. SiteScope opens to the 
parent group of the selected monitor.
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Service Health User Interface
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Service Health Workspace

The Service Health workspace enables you to view default Service Health 
pages, and to create new pages containing components from Service Health 
and other applications. Each page is displayed as a tab within the 
workspace.

The Service Health workspace and the MyBSM workspace both enable you 
to manage pages and components in the same way. The following section 
provides a brief explanation of the Service Health workspace user interface. 
For details on how to use your workspace to manage pages and components, 
see "How to Create Your MyBSM Workspace" in Using MyBSM.

To access Select Applications > Service Health

Important 
information

➤ This help topic appears if you create a non-default 
page and access Help > Help on this page in the BSM 
menu bar.

➤ Components from different applications can be 
added to pages within Service Health. For 
descriptions of these components, see "Available 
Components" in Using MyBSM.

Relevant tasks "How to Open Pages and Components in Service 
Health" on page 60

See also For a list of default Service Health pages and 
components, see "Monitoring your Environment Using 
the Service Health Application" on page 30.
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Page Management Toolbar
The Page Management toolbar on the upper right of the workspace, enables 
you to create pages, add components to pages, and define how components 
interact between one another.

User interface elements are described below:

UI Element Description

<Page Selector> Select a page from this dropdown list to open the page 
in your workspace. The list contains the pages that are 
defined in the page gallery.

If you start typing a page name in this box, the list is 
narrowed.

Refresh. Refresh the page.

Save or Save As. Save the current page to the page 
gallery. A dialog box enables you to name the page, 
give the page a description, and select a category for 
the page.

The description appears as a tooltip for the page, 
within the page gallery.

Page Gallery. Open the page gallery. The page gallery 
contains default pages, as well as pages you have saved. 
You can then edit page definitions, or open pages.

New Page. Create a new page.

After opening a new page you can configure its layout, 
add components to the page, and define wiring 
between the components. For task details, see "How to 
Open Pages and Components in Service Health" on 
page 60.

Edit Page Layout. Modify the layout of an existing 
page. Use the Layout tools in the top left corner of each 
layout to modify the layout areas.
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Layout Tools
When a layout is empty, the layout tools on the upper left area enable you 
to define the layout. Icons in the center of the layout indicate the type of 
layout: horizontal, vertical, or tabbed.

User interface elements are described below:

Components. Open the component gallery, which 
contains default components, as well as components 
you have added. You can then edit component 
definitions, or add components to a page.

Page Wiring. Define the wiring between components; 
this determines how components interact with one 
another.

Start/Stop Slideshow. Start a slideshow of open pages. 
A dialog box enables you to define how often the pages 
are rotated. Pages are refreshed before they are 
displayed.

If a slideshow is running, click this button to stop the 
slideshow.

UI Element Description

Layout Tools

Remove Layout. Remove a layout from the page.

Add Component. Open the component gallery. You 
can then double-click a component to place it in the 
layout area.

Split. Divide a vertical layout into two layouts, one 
above the other.

Split. Divide a horizontal layout into two layouts, side 
by side.

UI Element Description
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Switch to Horizontal. Change the layout from vertical 
or tabbed to horizontal. Components placed in this 
area will be added side by side.

Switch to Vertical. Change the layout from horizontal 
or tabbed to vertical. Components placed in this area 
will be added one above the other.

Switch to Tabs. Change the layout from vertical or 
horizontal, to a tab layout. Components placed in this 
area will be added as tabs.

Layout Icons

<Horizontal layout>. This icon in the center of a layout 
indicates that the layout is horizontal. Components 
placed in this area will be added side by side.

<Vertical layout>. This icon in the center of a layout 
indicates that the layout is vertical. Components 
placed in this area will be added one above the other.

<Tabbed layout>. This icon in the center of a layout 
indicates that the layout is horizontal. Components 
placed in this area will be added as tabs.

UI Element Description
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Component Toolbar
The component toolbar on the upper right of each component enables you 
to administer the component.

User interface elements are described below:

UI Element Description

Open one of the following:

➤ Preferences. Enables you to rename a component, 
and customize refresh rates.

➤ Wiring. Enables you to customize how this 
component interacts with the other components on 
the page.

➤ Refresh. Manually refresh the component.

➤ Help. Access help on the component.

Note: Depending on the component, some of these 
options may not be available.

Define filtering for the component, when a component 
supports internal filtering.

Display the component in a separate popup window.

Note: The popup window that opens does not support 
wiring.

Temporarily collapse a component (the button on the 
left is for horizontal components; the button on the 
right is for vertical components).

Restore a collapsed component (the button on the left 
is for horizontal components; the button on the right 
is for vertical components).

Note: When you collapse a horizontal layout, it 
collapses into a narrow stripe. Click the stripe to restore 
the component.

In a vertical or horizontal layout, click to close a 
component and remove it from the page.

In a tabbed layout each tab has a button which closes 
the tab; the main close button removes the layout.
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Find Visible and Hidden Child CIs Dialog Box

This dialog box enables you to list the selected CI’s child CIs that appear in 
the RTSM (visible and hidden).

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In Service Health components, right-click a CI and 
select the Find Visible and Hidden Child CIs option.

Important 
information

➤ A CI’s child CIs can be specified as included (visible) 
or excluded (hidden) in a specific view. The status of 
any child CI, visible or hidden, has an impact on the 
status of its parent CI in any view where the parent 
CI appears. For details on including or excluding 
child CIs, see the Hide CIs from View option in 
"Perspective-based View Editor"in the Modeling 
Guide.

➤ Hidden child CIs are only displayed if they have 
KPIs.

➤ This option is not relevant in local impact views, 
where excluded CIs by definition do not influence 
the visible CIs.

Relevant tasks "How to Find Visible and Hidden Child CIs" on page 78

UI Element (A-Z) Description

<KPI> The name of the child CI’s KPI and its status.

<Top part of page> Displays the name of the selected CI, whose child CIs 
you want to list, the CI’s KPIs, and their status in the 
current view.

Name The name of the child CIs (visible and hidden) that 
appear in the RTSM.

Visible A checkmark indicates that the child CI is visible in the 
view.

An X indicates that the child is hidden in the view.
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View Selector

The View Selector component presents the elements in the view. When you 
select a view in the View Selector, the configuration items (CIs) contained in 
the view are displayed in a hierarchical tree format according to the 
relationships defined between the CIs.

The interaction between the View Selector component and the information 
presented in the other components on a page varies, according to the 
context. For example, the Geographical Map page by default contains both 
the View Selector and the Geographical Map component. When you select a 
CI or multiple CIs in the View Selector, they are selected in the Geographical 
Map.

Some components such as Top View or Topology Map have built-in view 
selectors, but you may want to add the View Selector component to a page 
with one of these components, for ease of navigation within a complex 
view.

To access Some pages in Application > Service Health (such as 
Geographical Map) include the View Selector by default.

You can also add the View Selector component to a page 
where you have another component for which you want 
to select views or CIs, such as Reports.
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Browse Views Tab

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

The View Selector includes the Browse Views and the 
Search CIs tabs.

➤ In Browse Views you can search for and display a 
view, and browse through the view to locate a 
particular CI. You can also perform operations for the 
CI from a context menu.

➤ In Search CIs you can search for one or more CIs in 
the views or the RTSM by name or by CI type.

Unavailable Views and CIs: The View list in the View 
Selector may not display all views in the RTSM, or it may 
not display the contents of a view, because it includes:

➤ Only the views for which you have the necessary 
permissions. To set permissions, select Admin > 
Platform > Users and Permissions, select a user or a 
group and select Permissions. For more information, 
see "How to Assign Permissions" in Platform 
Administration.

➤ Only the views that are assigned to the application. 

➤ Inactive views (appear in red) that cannot be selected. 

➤ Out-of-the-box views for which you do not have a 
license. These views do not contain CIs. For 
information about the out-of-the-box views, see 
"Predefined Folders and Views" in the Modeling Guide.

UI Element (A-Z) Description

<CIs> The CIs contained in the currently selected view.
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Search CIs Tab

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

<Tooltip> Hold the cursor over a CI to display a tooltip with the 
relevant CI type.

<View> The View box displays the currently selected view. To 
select a view to display, click the down arrow on the 
right side of the View box; this displays an abridged list 
of views, containing the most recently accessed views. 
Click the arrow at the bottom of the list to scroll 
through the entire list. 

Alternatively, place the cursor in the list and begin 
typing the view name. If the first few letters that you 
type match an existing entry, the view name is 
completed. If the names of several views begin with 
those letters, all matching views are displayed in the list.

UI Element (A-Z) Description

<Context sensitive 
menu options>

The View Selector shortcut menu contains different 
options in each of the pages in which it appears. 

For details, see "Service Health Menu Options" on 
page 98. 

<Search results> After you run the search, the results are listed in the 
lower part of the View Selector component. The results 
are shown in two columns:

➤ Name. Contains the name of the CI.

➤ Type. Contains the CI type of the CI.

If the CI or view name is abbreviated, resize the table 
columns. You can sort the search results by clicking the 
appropriate heading.

Name To search for a CI by name, enter the name of the CI for 
which to search.

UI Element (A-Z) Description
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Sample Details Page

This page enables you to display data from the last sample that arrived for a 
monitored CI; this includes all of the parameters for the CI, and the 
parameter values at the last update.

Search Performs the search.

Type To search for CIs by CI type, enter the CI type for which 
to search.

To access In Service Health components, right-click a CI to open 
its context menus, and select Show > HIs. Within the 
Health Indicator component, click an HI’s status link 
to open the Sample Details dialog box.

Important 
information

To view the Sample Details dialog box for CIs, you 
must configure Service Health to save the last sample 
for the CI. You can configure this per rule (so that you 
only see sample details for a monitored CI with that 
HI), or for all rules. For details, see "How to Set Up 
Rules to Display the Last Sample Details" on page 734.

Note: Storing last sample details may require use of a 
large amount of memory, slowing down Service Health 
performance.

Relevant tasks "How to View Sample Details" on page 73

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Sample Message area Displays the details for the CI (according to the KPI) at 
the last update. 

Note: The Sample Details dialog box is not 
automatically refreshed when there is a new update for 
the CI. You can refresh by right-clicking in the dialog 
box (outside of the Sample Message panel) and 
selecting Refresh, or by closing and reopening the 
dialog box.

Sample Source area Contains parameters providing information on the KPI 
(in the KPI name field) for which the event details are 
relevant, the date and time of the last update to the CI, 
and the CI status at that update.
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Business Impact Report

This report displays information about the Business CIs impacted by the 
selected CI.

Business Services Summary Area

User interface elements are described below:

To access In Service Health components, right-click the relevant 
CI and select Show Business Impact.

Important 
information

➤ If there are no Business CIs attached to the CI, the 
report is empty.

➤ You can hide KPIs so they do not appear in the 
report. To hide KPIs, select Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Service Health 
Application, and locate the KPIs to hide in the 
report entry in the Service Health Application - 
Business Impact table and add the KPI numbers 
separated by a comma. 

For example, to remove the Performance and 
Availability KPIs, enter 6,7. Removing KPIs has an 
impact on the value/status of the CIs to which those 
KPIs are assigned.

Relevant tasks "How to View the Business Impact Report" on page 74

UI Element (A-Z) Description

Current Status The worst status of the KPI assigned to the selected 
Business CI.

Name The name of the Business CI impacted by the selected 
CI.

Click one of the Business CI in the list to display KPIs 
and SLA details in the <service> Service Details area. 
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Over Time Status 
Week to Date

The average status of the KPI over a predefined time 
period (the default is week to date).

To modify the predefined time period, select Admin > 
Platform > Setup and Maintenance > Infrastructure 
Settings, choose Applications, select Service Health 
Application, and locate the Default Over-Time Period 
entry in the Service Health Application - Business 
Impact table and modify the entry value.

SLAs Current Status The worst status of all the SLAs where the Business CI is 
included. 

If the SLA Current Status is No Data and the SLAs table 
below the main table indicates: No information, the 
Business CI is not included in any SLA.

If the SLA Current Status is No Data and the SLAs table 
below the main table indicates: No Data, the Business 
CI is included in the SLA and the SLA worst status is No 
Data.

SLAs Forecasting The worst expected status of the SLAs where the 
Business CI is included. 

If the SLA Forecasting Status is No Data and the SLAs 
table below the main table indicates: No information, 
the Business CI is not included in any SLA.

If the SLA Forecasting Status is No Data and the SLAs 
table below the main table indicates: No Data, the 
Business CI is included in the SLA and the SLA 
Forecasting worst status is No Data.

UI Element (A-Z) Description
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Service Details Area

The area includes the KPI and the SLAs tables.

KPI Table

User interface elements are described below:

SLAs Table

User interface elements are described below:

UI Element (A-Z) Description

Current Status The current status of the KPI assigned to the selected 
Business CI, as it appears in Service Health.

KPI The list of KPIs attached to the selected Business CI.

Over Time Status The status of the KPI over a predefined time period, as 
it appears in the KPI Over TIme Report in Service 
Health.

UI Element (A-Z) Description

Current Status The current status of the SLA.

Customer The customer related to the SLA.

Expected Breach 
Date

The expected breach date of the SLA.

Forecasting Status The expected status of the SLA, based on extrapolation. 
For additional information, see "Business Services 
Summary Area" on page 92.

SLAs The list of SLAs where the selected Business CI is 
included. For additional information, see "Business 
Services Summary Area" on page 92.
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Drilldown to SiteScope Dialog Box

This dialog box enables you to drill down from a CI or health indicator to a 
specific SiteScope monitor which is contributing to an HI’s status.

User interface elements are described below:

To access ➤ In a component displaying CIs (such as Top View or 
Topology Map), access a CI’s menu commands and 
select Go to SiteScope.

➤ In the Health Indicator component, access an HI’s 
menu commands and select Go to SiteScope.

Important 
information

➤ In the System Monitors View, if you select Go to 
SiteScope from a monitored CI, SiteScope opens to 
the monitor’s parent group. If you select this from a 
group CI, SiteScope opens directly to the group.

➤ If you select Go to SiteScope from a CI or health 
indicator that has only one monitor contributing to 
health indicator status, SiteScope opens directly to 
the parent group of the relevant monitor.

Relevant tasks "How to Drill Down to SiteScope from a CI or Health 
Indicator" on page 79

UI Element (A-Z) Description

<Health Indicator, 
SiteScope, and 
Monitor Hierarchy>

➤ The root level shows health indicators. If you open 
the dialog box for a CI, one or more HIs that 
contribute to the CI’s status are listed. If you open 
the dialog box for an HI, this HI appears as the root.

➤ The level below the root shows the SiteScopes that 
have monitors that contribute to the HI.

➤ The lowest level shows the SiteScope monitors that 
contribute to the HI.

Drilldown Select a SiteScope monitor in the displayed hierarchy, 
and click Drilldown to open SiteScope. SiteScope opens 
to the parent group of the selected monitor. For details 
on working with SiteScope, see Using SiteScope in the 
SiteScope Help.
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KPI Icons in Service Health

A CI can have the following KPI icons (shown with OK status):

Icon Description

All other KPIs

Application Availability KPI

Application Performance KPI

Backlog KPI

Business Impact KPI

Delays KPI

Duration KPI

Exceptions KPI

Failures KPI

Network Availability

OT Impact KPI

PNR KPI

RT Impact KPI

Security KPI

Siebel
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Tip: You can customize the set of icons used in Service Health. For details, 
see "How to Change the KPI Status Icons" on page 441.

Siebel Errors

Siebel Sessions

Throughput KPI

Value KPI

Volume KPI

Icon Description
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Service Health Menu Options

The default menu options displayed in Service Health tabs depend on the 
selected view and the selected CI. They can be a subset of the options 
described in this section. For more information, see "About Menu Options" 
on page 51. 

The default menu options are grouped into the following categories:

➤ "Drill to Diagnostics" on page 98

➤ "Go To" on page 99

➤ "Invoke" on page 102

➤ "Operations" on page 102

➤ "Reports" on page 103

➤ "SAP Alert Acknowledgement" on page 109

➤ "Show" on page 109

Drill to Diagnostics
These menu actions enable you to open specific pages in the HP Diagnostics 
application filtered by the selected CI. This option is displayed only if you 
have HP Diagnostics installed. For more information, see the HP Diagnostics 
User’s Guide.

The following menu actions are available:

Context Menu Action Description

Any Users Transaction 
Paths View

Drills down to the Transactions - Business Transactions Paths view.

Any Users 
Transactions View

Drills down to the Transactions - Business Transactions view.

Diagnostics 
Agent/J2EE Server 
Summary View

Drills down to the Probes view.
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Go To
These menu actions enable you to go to specific locations in various 
applications related to the selected CI. The following menu actions are 
available:

Diagnostics Probe 
Group Summary View

Drills down to the Probe Group Summary view.

Host Summary View Drills down to the Hosts view.

Oracle Server 
Summary View

Drills down to the Oracle Database - Oracle Probes view.

SAP R3 Summary View Drills down to the SAP - ABAP SAP Probes view.

SQL Server Instance 
Summary View

Drills down to the SQL Server Database - SQL Server Probes view.

SQL Server Summary 
View

Drills down to the SQL Server Database - SQL Server Probes view.

Synthetic Users 
Transactions Layers 
View

Drills down to the Transactions - Synthetic Transactions Layers view.

Synthetic Users 
Transactions View

Drills down to the Transactions - Synthetic Transactions view.

WMQ Server 
Summary View

Drills down to the MQ - Queue Managers view.

Context Menu Action Description

Application Health 
Tab

Opens the Health page in the Business Process Insight application. For 
details, see "BPI Application Health User Interface" in Using Business 
Process Insight.

Go to Service Health 
Analyzer

If you have Service Health Analyzer installed, this option enables you to 
drill down directly to the Anomaly Highlights page for the selected CI.

For details, see Anomaly Highlights Page documentation in Using Service 
Health Analyzer.

Context Menu Action Description
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Go to Service Health 
Console

Opens the Service Health 360 View page. For details, see "360° View" on 
page 257.

Go to SiteScope This option enables you to drill down to SiteScope directly from 
SiteScope CIs and their health indicators.

In the System Monitors View, if you select Go to SiteScope from a 
monitor CI, SiteScope opens directly to the monitor's parent group. If 
you select this from a group CI, SiteScope opens directly to the group.

In other views, this opens the Drilldown to SiteScope dialog box. This 
enables you to select a SiteScope monitor, and then open the monitor’s 
parent group in SiteScope. For details, see "Drilldown to SiteScope Dialog 
Box" on page 95.

For details on working with SiteScope, see Using SiteScope in the SiteScope 
Help.

Locate CI in View Displays the Search pane where you can specify the CI you want to 
locate. For details about the search feature, see "How to Search for CIs in 
Search Mode" in the Modeling Guide.

Siebel Processes This option is available for Siebel Application Server, Siebel Component 
Group, and Siebel Component CIs. 

This option opens the Task Diagnostics Tool filtered by:

➤ The selected site, and server for Siebel Application CIs.

➤ The selected site, server, and selected Component Group CI for 
Component Group CIs.

➤ The selected site, server, selected Component Group CI, and 
Component CI for Component Group CIs.

For details on the Siebel Task Diagnostics Tool, see "Siebel Views" in 
Solutions and Integrations.

For details on the Siebel CIs, see "Default CITs in the Siebel View" in 
Solutions and Integrations.

For details on the Process Diagnostics Tool, see "Siebel Views" in Solutions 
and Integrations.

Context Menu Action Description
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Siebel running tasks This option is for Siebel Application Server, Siebel Component Group, 
and Siebel Component CIs. 

Opens a separate page with the Task Diagnostics Tool filtered by:

➤ The selected site, server, Running status, and Session type for Siebel 
Application CIs.

➤ The selected site, server, selected Component Group CI, Running 
status, and Session type for Component Group CIs.

➤ The selected site, server, selected Component Group CI, selected 
Component CI, Running status, and Session type for Component CIs.

For details on the Siebel CIs, see "Default CITs in the Siebel View" in 
Solutions and Integrations.

For details on the Siebel Task Diagnostics Tool, see "Siebel Views" in 
Solutions and Integrations.

Siebel tasks in error This option is for Siebel Application Server, Siebel Component Group, 
and Siebel Component CIs. 

Opens a separate page with the Task Diagnostics Tool filtered by:

➤ The selected site, server, and Exited with Error status for Siebel 
Application CIs.

➤ The selected site, server, selected Component Group CI, and Exited 
with Error status for Component Group CIs.

➤ The selected site, server, selected Component Group CI, selected 
Component CI, and Exited with Error status for Component CIs.

For details on the Siebel CIs, see "Default CITs in the Siebel View" in 
Solutions and Integrations.

For details on the Siebel Task Diagnostics Tool, see "Siebel Views" in 
Solutions and Integrations.

Siebel Database 
Breakdown

This option is for the Siebel Site, Siebel Application, and Siebel Enterprise 
CIs.

Opens the Database Breakdown tab in BSM for Siebel to enable you to 
create and analyze database logs that record the SQL activity between 
Siebel components and the Siebel database. 

For details, see "Siebel Views" in Solutions and Integrations.

Context Menu Action Description
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Invoke
This menu is available for all CIs whose CI type is mapped to an HP 
Operations Orchestration (OO) run book. The following menu action is 
available:

Operations
This menu enables you to perform actions related to the selected entity. The 
following menu actions are available (depending on your context):

Siebel SARM This option is for the Siebel Site, Siebel Application, and Siebel Enterprise 
CIs.

Opens the SARM - User Trace Breakdown tab in BSM for Siebel to enable 
you to create and record the SQL activity in each monitored Siebel site. 

For details, see "Siebel Views" in Solutions and Integrations.

Context Menu Action Description

Invoke Run Books Opens the Related Run Books page in a new window, where you can view 
the mapped run books and invoke them in OO. For details on integrating 
Business Service Management with OO, see "HP Operations 
Orchestration Integration Overview" in Solutions and Integrations.

Note: To invoke run books from the Related Run Books page, you must 
have the necessary permissions for OO in Business Service Management. 
To access the Permissions page, select Admin > Platform > Users and 
Permissions. For details on this topic, see "Permissions Overview" in 
Platform Administration.

Context Menu Action Description

Acknowledgment 
Details 

Enables you to view the details of the current acknowledgment or the 
acknowledgment history of the CI. For details, see "Acknowledgment 
History and Details Dialog Box" on page 332.

Context Menu Action Description
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Reports
This option is available for all CIs. This menu lists options that enable you 
to access all types of reports that display information about the selected CI.

Collaborate If you are working with the HP Enterprise Collaboration (EC) application, 
this menu command opens EC with the selected CI as the context of the 
conversation. For details on EC, contact your HP representative.

Note:

➤ To enable this BSM > EC integration, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose Foundations > 
Enterprise Collaboration, and enter the URL of the EC server.

➤ This collaboration requires that BSM and EC use the same SSO token. 
To modify the token in BSM, select Admin > Platform > Users and 
Permissions > Authentication Management, and edit the Token 
Creation Key.

Delete Opens the Delete Folder dialog box in the Modeling Studio, to enable you 
to delete a folder. For details, see "Modeling Studio User Interface" in the 
Modeling Guide.

Delete CI Opens a dialog box to confirm that you want to delete the relevant CI in 
IT Universe Manager.

New Folder Opens the New Folder dialog box in the Modeling Studio, to enable you 
to create a new folder. For details, see "Modeling Studio User Interface" in 
the Modeling Guide.

Rename Folder Opens the Rename Folder dialog box to enable you to rename a folder. 
For details, see "Modeling Studio User Interface" in the Modeling Guide.

Reset Health Indicator Restores the selected HI to its default state and value. For details, see 
"Health Indicator Component Overview" on page 228.

Set/Unset 
Acknowledgment 

Enables you to set or unset acknowledgment of a problem on a CI. For 
details, see "Acknowledgments Details Dialog Box" on page 333.

Context Menu Action Description



Chapter 1 • Introducing Service Health

104

The following menu actions are available:

Context Menu Action Description

Aggregate 
Transaction Topology

Opens the Aggregated Topology report in the Transaction Management 
application.

Application Summary Opens the application summary report for the selected CI. For details, see 
"Application Summary Report" in Using End User Management.

BPI Monitors Over 
Time

This option is available for all BPI Duration, Value, or Custom Monitor 
CIs.

Opens the BPI Monitors Over Time report. For details, see "BPI Monitors 
Over Time Report" in Using Business Process Insight.

BPM Application 
Health

Opens the application health report filtered for synthetic user data, and 
filtered for the parent application. For details, see "Application Health 
Report" in Using End User Management.

BPM Performance 
Analysis

Opens the performance analysis report filtered for synthetic user data, 
and filtered for the selected transaction. For details, see "Performance 
Analysis Report" in Using End User Management.

BPM Triage for 
Application

Opens the triage report filtered for synthetic user data, and filtered for 
the selected application. For details, see "Triage Report" in Using End User 
Management.

BPM Triage for 
Transaction

Opens the triage report filtered for synthetic user data, and filtered for 
the selected transaction. For details, see "Triage Report" in Using End User 
Management.

Business Process Over 
Time Report

This option is available for all BPI Business Process Step Monitor or BPI 
Business Process Monitor CIs.

Opens the Business Process Over Time report. For details, see "Business 
Process Over Time Report" in Using Business Process Insight.

Change Report This option is available for all CIs whose properties have changed. 

Opens the Change report for the CI. The Change report displays 
information about the changes made to the properties of CIs for all CIs 
that were assigned to keep this information.

For details, see "CI Change Report" in Reports.

CI Impact Report Opens the Related Change Request report in Service Health.
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Configuration Item 
Status Alerts

This option is for all CIs. 

Opens the Configuration Item Status Alerts report for the CI. The 
Configuration Item Status Alerts report lists all of the alerts that occurred 
in the specified period of time.

For details on the report, see "CI Status Alerts Reports" on page 285.

Diagnostics Web 
Service Topology 

This option is for Web Service CIs. 

Opens the Diagnostics Service Topology view for the selected Web Service 
CI, for the past half hour. For details on the report, see the HP Diagnostics 
User’s Guide.

End User Summary This option is for Real User Monitor-specific CIs. 

Opens the End User Summary report. The End User Summary report 
displays data for specific end users configured for Real User Monitor in 
End User Management Administration. 

For details, see "RUM End User Group Summary Report" in Using End User 
Management.

Event Log Report Moves to the Event Log report in End User Management. The Event Log 
report displays a log of the occurrences of a specific event type for a 
selected time frame. For details, see "Event Log" in Using End User 
Management.

Infrastructure 
Summary

Opens the infrastructure summary report filtered for the selected 
application. For details, see "RUM Application Infrastructure Summary 
Report" in Using End User Management.

KPIs Over Time Report This option is for all CIs. 

Opens the KPIs Over Time report for the CI. The KPIs Over Time report 
shows the status or value, over time, of selected CIs and KPIs that are 
accessible from the Service Health application.

For details on the report, see "KPIs Over Time Report".

Location Summary Opens the location summary report filtered for the selected location. For 
details, see "Location Summary Report" in Using End User Management.

Performance Matrix 
for Application

Opens the BPM performance matrix report filtered for the selected 
application. For details, see "BPM Performance Over Time Report" in 
Using End User Management.

Context Menu Action Description
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Performance Matrix 
for Transaction

Opens the BPM performance matrix report filtered for the selected 
transaction. For details, see "BPM Performance Over Time Report" in 
Using End User Management.

RUM Performance 
Analysis

Opens the performance analysis report filtered for real user data, and 
filtered for the selected transaction. For details, see "Performance Analysis 
Report" in Using End User Management.

RUM Triage for 
Application

Opens the triage report filtered for real user data, and filtered for the 
selected application. For details, see "Triage Report" in Using End User 
Management.

RUM Triage for 
Transaction

Opens the triage report filtered for real user data, and filtered for the 
selected transaction. For details, see "Triage Report" in Using End User 
Management.

SAP Transaction 
Changes

This option is for SAP-specific CIs. 

Opens the SAP Transaction Changes report. The SAP Transaction 
Changes report displays the SAP transactions and SAP transports and the 
impact of transports on each transaction. 

For details on the report, see "SAP Transaction Changes Report" in 
Solutions and Integrations.

For details on the SAP System view, see "SAP Systems View" in Solutions 
and Integrations.

SAP Transport 
Changes

This option is for SAP-specific CIs. 

Opens the SAP Transport Changes report. The SAP Transport Changes 
report displays the changes inside the Transport and the impact on the 
SAP transaction. 

For details on the report, see "Application Management for SAP User 
Interface" in Solutions and Integrations.

For details on the SAP System view, see "SAP Systems View" in Solutions 
and Integrations.

Context Menu Action Description
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Session Analyzer This option is for Real User Monitor-specific CIs. 

Opens the Session Analyzer report. The Session Analyzer report displays 
session data for specific applications configured for Real User Monitor in 
End User Management Administration. 

For details, see "RUM Session Analyzer Report" in Using End User 
Management.

Show Impacting SAP 
Transports 

This option is available for SAP-specific Transaction and group CIs.

For Transaction CIs, enables you to display all of the selected CIs and 
their child CIs that were affected by any SAP Transport CIs. For details, 
see "Show Impacting SAP Transports Report" in Solutions and Integrations.

Groups CIs represent the following CIs: SAP System, and SAP Application 
Component.

Show Impacting SAP 
Transports 
Transactions

Enables you to display the transactions that are impacting the selected 
CI.

Show SAP Transport 
Impact

This option is available for SAP-specific Transport CIs. 

Enables you to display all SAP transactions that are impacted by the 
selected transport. For details, see "Show Impacting SAP Transport 
Transactions Report" in Solutions and Integrations.

SiteScope Cross-
Performance

This option is for SiteScope Profile, SiteScope Group, and SiteScope 
Monitor CIs.

Opens the Cross-Performance report. For details, see "Cross-Performance 
Report" in Using System Availability Management.

SiteScope Quick 
Report

This option is for SiteScope Group and SiteScope Monitor CIs.

Opens SiteScope Quick Report. For details, see Using SiteScope in the 
SiteScope Help.

SiteScope Server 
Centric Report

This option is for Windows Resource Monitor and Unix Resource 
Monitor CIs under specific conditions described in the report description.

Opens SiteScope Server Centric Report. For details, see Using SiteScope in 
the SiteScope Help.

Context Menu Action Description
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Systinet Web Service 
Data

This option is for Business Unit CIs, Web Service CIs, and Web Service 
Operation CIs, when there is an integration between HP Business Service 
Management and HP SOA Systinet. 

Opens the HP SOA Systinet application, focused on the relevant Web 
service. For details, see the HP SOA Systinet documentation.

For details on the integration with HP SOA Systinet, see "Integration of 
HP SOA Systinet" in Solutions and Integrations.

Tier Summary Opens the RUM tier summary report filtered for the selected application. 
For details, see "RUM Tier Summary Report" in Using End User 
Management.

Transaction Over Time This option is available for TV Monitor CIs.

Opens the Transaction Over Time report. For details, see "Transaction 
Over Time Report" in Using Transaction Management.

Transaction Summary Opens the Transaction Summary report relevant for the CI. For details, 
see "Transaction Summary Report" in Using Transaction Management.

Transaction Tracking Opens the Transaction Tracking report in the Transaction Management 
application. For details, see "Transaction Tracking Report" in Using 
Transaction Management.

Trend Opens the trend report for the CI. Trend reports enable you to compare 
multiple measurements from several profiles. 

This menu command enables you to compare data collected by Business 
Process Monitor only. You can use the User Reports application to 
generate trend reports from other data collectors. For details, see "Trend 
Reports" in Reports. 

Triage Opens the Triage report. The Triage report displays transaction data for 
Business Process Monitor, and Real User Monitor profiles for the past day. 

For details, see "Triage Report" in Using End User Management.

Triage Raw Data Opens the Triage Raw Data report. For details about the report, see "Triage 
Raw Data Report" in Using End User Management.

Context Menu Action Description
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SAP Alert Acknowledgement
These actions are for SAP Alerts. The following menu actions are available:

Show
This menu enables you to access various details related to the selected CI. 
The following menu actions are available:

Context Menu Action Description

Complete Alert Activates a URL call to the relevant SAP system and completes the 
selected SAP alert.

<Common menu 
actions>

For details on KPIs Over Time Report, Change Report, and Configuration 
Item Status Alerts, see "Reports" on page 103.

For details on Service Impact, Path to Root, Problematic Subtree, Errors, 
Properties, and Find Visible and Child CIs, see "Show" on page 109.

For details on Invoke Run Books, see "Invoke" on page 102.

Context Menu Action Description

Errors Opens the Service Health Hierarchy component, filtered for CIs in Error 
status. For details, see "Hierarchy Component Overview" on page 224.

Expand more levels Note: This option is only available in Top View.

Opens a number of levels (7 by default) below the selected level of the 
Top View tree.
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Expand to problem Note: This option is only available in Top View.

Collapses the branches where CIs do not have Critical or Major statuses.

Example: 

In the End User Monitors view, Cust_1_BPM_1 is red. 

Right-click Cust_1_BPM_1 and select the Expand to problem option to 
get more information about the problem by displaying lower levels of the 
view and by collapsing non-problematic branches.  

Find Visible and 
Hidden Child CIs

This option is available for all CIs. 

Returns all of the visible and hidden child CIs of the selected CI as they 
appear in the RTSM.

For details, see "How to Find Visible and Hidden Child CIs" on page 78.

HIs Opens the Service Health Health Indicators component, showing the HIs 
related to the selected CI. For details, see "Health Indicator Component 
Overview" on page 228.

HP Service Manager A context menu option available from EMS Monitor CIs under Business 
Service CIs, to open the HP Service Manager application.

Context Menu Action Description
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Operation Manager This option is available for HP Operations Manager-related CIs in Service 
Health and Service Level Management views.

It enables you to access the HP Operations Manager application.

For details on this topic, see "HP Operations Manager" in Solutions and 
Integrations.

Path to Root This option is available for all CIs. 

Opens a Top View page that displays the path from the selected CI to the 
root CI. For example:

Context Menu Action Description
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Problematic Subtree This option is available for all CIs. 

Opens a popup with the same capabilities as the Top View tab. The 
popup displays all of the child CIs with Critical, Major, or Minor status 
and enables you to find the problematic child CI that causes the selected 
parent CI to have a status other than OK. It is enabled only for CIs that 
have at least one KPI with a status other than OK.

Example: The QTWeb medium CI has the following children:

Select the Problematic Subtree option for the CI to display the following 
children:

Properties This option is available for all CIs. 

Opens the CI Properties dialog box which displays details on the CI.

Service Impact Opens the Business Impact report that displays the impact of the current 
CI on the services that depend on that CI. If there are no services 
attached to the CI, the report is empty. For details, see "Business Impact 
Report" on page 92.

Show Business 
Activity Over Time 
Report

Opens the Business Activity Over Time report in the Business Process 
Insight application.

Show Contributing 
Events

Shows which events contributed to the HI’s status and value.

Context Menu Action Description
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Troubleshooting Service Health - General Topics

This section describes general troubleshooting for Service Health.

Service Health pages and components are missing

If you modified databases on a running BSM deployment, Service Health 
will no longer contain any pages and components. To restore pages and 
components:

 1 Open the following directory: <Gateway server root 
directory>\conf\uimashup\import. This contains two directories: 
\loaded, and \toload.

 2 Copy the contents of the \loaded directory into the \toload directory.

 3 Restart BSM.

Show Related CIs Performs a search for related CIs; for details see "How to Search for CIs in 
Search Mode" in the Modeling Guide.

Show Top View Opens the Service Health Top View in a popup window, with the view's 
tree centered on the selected CI.

Context Menu Action Description
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2
Health Indicators and KPIs - Overview

This chapter includes:

Concepts

➤ Introduction to Health Indicators on page 116

➤ Terminology Related to HIs and KPIs on page 117

➤ The Service Health Calculation Flow on page 118

➤ Health Indicator Definitions on page 119

➤ Integrating the Event and Metric Channels on page 122

➤ Configuring Health Indicators on page 125

Tasks

➤ How to Map an ETI to an HI - Use-Case Scenario on page 127

➤ How to Create an HI and Trigger an Event When its Status Changes - Use-
Case Scenario on page 135

➤ How to Create an Event Based on CI Status Changes - Use-Case Scenario 
on page 138

➤ How to Monitor a Specific Windows Server with Both Operations 
Manager and SiteScope - Use-Case Scenario on page 140

➤ How to Customize an HI Monitored by SiteScope - Use-Case Scenario 
on page 142
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Concepts

Introduction to Health Indicators

Service Health enables IT staff such as service managers and application 
support to monitor the organization's business services and application 
health, in order to help them understand the impact of problems and act to 
restore service operation as fast as possible.

Service Health uses health indicators (HIs) to consolidate between two 
legacy modes of operations: event management, and application 
management.

IT operations are usually organized into two separate groups: 

➤ Operations bridge operators act upon events; events are received in a 
central event console, which focuses primarily on system problems.

➤ Applications support specialists act upon end-user availability or 
performance problems with applications. Application support staff can 
use one of the Service Health real-time components (Top View, 360° View, 
Custom Image, and so on) to monitor application health, or they can be 
notified about problems by email alerts or ticket assignments. 

By unifying these two monolithic approaches - event management and 
application management, BSM now offers IT operations a single pane of 
glass covering both the system and end user aspects in a unified method.

BSM translates information from system events into Service Health 
resources, and displays them in the different Service Health views. In 
addition, BSM sends events to the event browser when thresholds of end-
user monitored applications are breached. 

The consolidation of the event subsystem and the Service Health subsystems 
is realized by usage of HIs - shared entities that creates a common 
terminology between event management and application management.
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An HI represents a certain measurement of the monitored CI. It may be CPU 
load for a computer, Real user performance for a login page, or Value of 
business process transactions that are under risk.

Terminology Related to HIs and KPIs

The following table describes the basic terms related to HIs and KPIs.

Concept Description

Event An event contains data which includes monitoring 
information about a CI, according to the rule which triggers 
the event. The event includes the CI name, the measurement 
name (specified as the event type indicator) and the 
measurement’s severity.

Metric sample A sample includes metrics reported for one or more 
measurements of a monitored CI. To extract information 
from the sample, the BSM Service Health engine executes 
some logic (in Java or Groovy) upon the sample string.

ETI (event type 
indicator)

The ETI is a field in the event that indicates the problem 
type, and its descriptive severity. The ETI structure includes 
the ETI name and ETI state (for example: System Restart: 
occurred, or CPU Load: Abnormal).

HI (health 
indicator)

An HI describes the health of a specific measurement (similar 
to an ETI), but it also affects the Service Health calculation for 
the monitored CI.

HI business rule An HI calculation rule or business rule is code written in Java 
or Groovy; it extracts metric data from a sample, performs 
business logic on the metric, and assigns it to the relevant HI. 
The rule provides a status (for example Critical) that 
represents the metric's severity.

KPI (key 
performance 
indicator) 

A KPI is a higher level indicator than an HI, and it represents 
an aspect of domain health such as System Performance, 
System Availability, Application Performance, Application 
Availability, and so on.
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The Service Health Calculation Flow

The following section describes the Service Health data calculation flow.

KPI business rule A KPI rule determines how HI statuses are aggregated to 
calculate KPI status (worst, best, average, and so on).

KPI calculation 
scope

The scope defines the type of resources that contribute to KPI 
calculation: HIs and KPIs on child CIs, HIs only, or KPIs on 
child CIs only.

Concept Description
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 1 BSM monitoring applications such as Operations Manager (HPOM), BPM, 
RUM, and so on, provide full coverage for monitoring the IT world.  Each 
monitoring application sends values or statuses of the monitored CI as an 
event or metric sample.

➤ Events. HPOM, SiteScope, NNMi and 3rd party tools (using the BSM 
integration adapter) send their data in the form of events.

➤ Metrics. BPM, RUM, TransactionVision, and BPI send their data as 
metric samples.

 2 Any measurement within an event or sample is mapped to an HI, as 
follows:

➤ Events channel. An HI is created according to the ETI field in the event 
structure.

➤ Metric samples channel. An HI is created according to a business rule 
logic that applies to the CI. 

 3 After the information from the events or samples is transformed to the 
relevant HI status, KPIs that are associated with the HI are calculated 
based on the KPI rule, and the KPI's calculation scope definition.

Note: Not all HIs contribute to a KPI's status.

All definitions required for performing the above logic are provided out of 
the box as part of the BSM product content. You can also create or modify 
HIs, KPIs, or calculation rules to suit your particular needs.

Health Indicator Definitions

The following section describes HIs in further detail; for an overview see 
"Introduction to Health Indicators" on page 116.

This section includes the following topics:

➤ "CI types and HIs" on page 120

➤ "HIs and their data sources" on page 120
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➤ "HI attributes" on page 121

➤ "HI state and status" on page 121

➤ "HIs generating events" on page 121

➤ "Service Health and SLM default rules" on page 121

➤ "ETI mapping rules" on page 122

➤ "HIs and ETIs" on page 122

CI types and HIs
An HI describes a certain measurement of a CI, and is associated with a 
specific CI type. For example, the Windows CI type will have HIs such as 
CPU Load and Memory Utilization, and the Business Transaction CI type 
will have Real user performance and Volume HIs.

A CI type may inherit HIs from its parent CI type; for example HIs assigned 
to the Database CI type also apply to the Oracle or DB2 CI types, and are 
applied to any Oracle and DB2 database CI.

HIs and their data sources 
HIs can be created by events, or by samples and rules. The first type of HI is 
created when an event carries an ETI that matches the HI definition, while 
the second type of HI is created as part of the Service Health HI assignment 
mechanism.

HIs which are fed by events do not require a rule to define how they are 
calculated, and no assignment or view-level configuration can change their 
calculation logic; they are simply assigned their state by their corresponding 
ETIs.

Some HIs are fed by both events and samples; these will carry a rule attribute 
which is used when generated by samples.

An HI can be generated by multiple monitoring domains; for example 
Network Latency can be fed by both an HPOM agent and by the RUM 
engine. 
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HI attributes 
HIs are defined in the Indicator Repository. In addition to general attributes 
such as name and description, for each HI you can define if the HI is 
applicable for SLM and/or Service Health. This offers the flexibility to have 
dedicated HIs for each application; by default all HIs are set to be calculated 
for both applications.

HI state and status
An HI's severity is represented by a combination of state and a status. The 
state contains descriptive information of the value or the situation (for 
example overloaded or much higher than normal). The status represent the 
severity in the typical Service Health levels: OK, Warning, Minor, Major, 
Critical.

Each state is mapped to a status; one status can be translated into more than 
one state. For example, the states overloaded and much higher than normal 
can both be mapped to Major severity. If there is more than one state 
mapped to a given severity, you can specify which state is used by default. 

ETIs use states to describe the problem severity, whereas business rules use 
status to display metric-based HI severity. When HIs are fed by ETIs, Service 
Health translates ETI state to HI status for further calculation of KPI status. 
When HIs are generated due to threshold violations based on measurements 
in metric samples, the severity determined by the rule is translated to the 
HI's state.

HIs generating events 
Within the HI definition, you can determine whether HI status changes for 
metric-based HIs trigger an event to the event browser, to notify the 
operator about threshold violations. This is typically used for end user 
experience issues.

Service Health and SLM default rules
The attributes for default rules define the default business rule used to 
calculate metric-based HIs.
121



Chapter 2 • Health Indicators and KPIs - Overview
ETI mapping rules
This defines HI to ETI mapping by defining a filter on the event attributes. 

If an event does not contain an ETI attribute specifying a severity from 
HPOM, you can define indicator mapping rules to set indicator states. For 
details, see "How to Map an ETI to an HI - Use-Case Scenario" on page 127.

HIs and ETIs
HIs correlate to ETIs according to common names. The ETI is used as a 
reference to create the related HI in Service Health (for the first event 
carrying the ETI), and it assigns the HI state according to the ETI state. A 
CPU Load HI is fed by events carrying the CPU Load ETI. 

ETIs that do not have corresponding HIs are not processed by the Service 
Health engine, and only appear in the event browser.

An HI's status is independent of the event lifecycle; for example a CPU load 
HI remains Critical even if the event that was triggered for the problem was 
closed by the operator.

Integrating the Event and Metric Channels

Agent-based and agentless monitoring domains (HPOM, SiteScope, BPM, 
and so on) send information on monitored CIs using events or samples. The 
following section describes how this data is integrated, depending on the 
type of data sent by the data collector.

This section includes the following topics:

➤ "Metric Sample Workflow" on page 123

➤ "Event Workflow" on page 124
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Metric Sample Workflow
Each metric sample is processed by the Metric Processing engine. This 
engine extracts a value from the sample using a dedicated business rule, 
according to the sample type. 
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Each value is compared against a set of objectives.

 1 If the calculation shows that the HIs status has changed, an event is fired 
to the Events channel (for example, if the Transaction real user 
availability HI becomes Critical and the HI is configured in the Indicators 
repository to generate events).  The HI is translated to an ETI in the event, 
and other fields in the CMA (common event model) are set according to 
the definition of the HI in the repository.

 2 If the metric processing engine did not encounter a status change, the 
new value is reported to the Service Health logic engine to be reflected in 
the relevant HI information. For example, assuming Transaction real user 
availability is considered critical if the value is less than 70%, and the 
value changes from 68% to 66%, no event is fired but the new value 
(66%) is displayed in the relevant HI in Service Health. 

Event Workflow 
Each event that is reported to BSM is processed by the event processing 
engine, which activates event-related logic such as CI resolution, de-
duplication, and so on. 

 1 The Service Health logic component translates the ETI to an HI, creates an 
HI if it is not yet present in the system, and maps the HI state to its status. 
At this stage the HI instance is ready to be used for further calculation.

 2 The KPI engine calculates the KPI status based on the status change in the 
HI, according to the KPI business rule and calculation scope. 

 3 The information that has been processed (events, HIs, and KPIs) is 
displayed in the consolidated operation workspace. 
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Configuring Health Indicators

HI configuration in Service Health administration is done in the 
repositories, assignment definitions, and view management tabs.

This section includes the following topics:

➤ "Repositories" on page 125

➤ "Assignments" on page 125

➤ "View Management > CI Indicators" on page 126

Repositories
The repositories includes the meta-data definitions for Service Health 
calculations, such as indicator types, KPI types, and rules. If you need to 
create a new KPI or HI in BSM, its definition must be added to the relevant 
repository.

For more information about working with the repositories, see "Repositories 
Overview" on page 631.

Assignments 
The assignments contain automatic rules that create the KPI and HIs 
instances that are associated with any new CI, when a CI is discovered and 
reported by any of the monitoring applications or by the RTSM discovery.

➤ HI assignment rules are required for HIs that are fed by metric samples. 
The mechanism of creating HIs fed by events is data driven, meaning the 
HI instance is created by the first event that affects the HI. The 
mechanism for HIs fed by metrics is configuration driven, meaning the HI 
instances must be created in advance. 

➤ KPI assignment rules are required for all HI types; these rules determine 
the logic of the KPI based on the CI's HIs, and/or child CI’s KPIs.
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Within the assignments, the Monitored by attribute enables you to set 
different assignment rules for the same HI or KPI according to the 
monitoring application. For example, you may want to calculate the 
Application Availability KPI using the Worst Status Rule if the data is 
monitored by BPM, and using the Average Status Rule if the data is 
monitored by RUM.

For more information about Assignment configuration, see "Indicator 
Assignments and Propagation" on page 557.

View Management > CI Indicators 
You can define specific HIs and KPIs at the view level for specific CIs, using 
the CI Indicators tab. You can choose one or more CIs and adjust their list of 
assigned HIs, change business rules, change KPI calculation logic by 
removing or adding HIs, and change the KPI rule or calculation scope. For 
details, see "How to Assign KPIs and HIs to CIs" on page 428.
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Tasks

How to Map an ETI to an HI - Use-Case Scenario

The purpose of this use-case scenario is to configure an ETI in HPOM so that 
it is mapped to an HI, which then contributes to the System Availability 
KPI’s status in Service Health.

For this example, the monitored data relates to the Printer Spooler on 
Windows servers. This ETI has two statuses: Down (Printer Spooler service is 
stopped), and Up (Printer Spooler service is running).

Based on this ETI, a new HI is configured in Service Health. This new HI is 
then related to the System Availability KPI. This configuration must be 
applied to any Windows server CI, using the KPI assignments.

Before you begin this scenario, servers must be defined in HPOM, and the 
relevant SPI must be running on those servers.
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To map an ETI to an HI:

 1 Open HPOM and select the Windows spooler policy.

 2 Create your own folder, and copy this policy to your folder.
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 3 Open the policy and edit the ETI. Select the Rules tab and click Modify.

 4 Select the Actions tab and click Modify.
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 5 Select the Start Actions tab and click Message.

 6 Select the CMAs tab and click Add.

 7 In the CMA Properties dialog box, select EventTypeIndicator, and enter 
the relevant values (use the ETI name and value shown below).
130



Health Indicators and KPIs - Overview
 8 Click OK to close the CMA Properties dialog box, and click OK to close 
the Outgoing Message dialog box. Select the End Actions tab in the 
Threshold Level… dialog box.

 9 Select the CMAs tab and click Add.

 10 In the CMA Properties dialog box, select EventTypeIndicator, and enter 
the relevant values (use the ETI name and value shown below).
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 11 Within Service Health Administration, open the Indicators Repository. 
Select the Windows CI type and create a new HI.

 12 Enter general information; add the states that you have defined in the 
ETI’s CMA configuration, and map each state to a status: Up (Normal), 
Down (Critical). Since this HI is fed only by events, there is no need to 
define a rule.

 13 In order for this HI to contribute to the System Availability KPI status of 
Windows servers, you need to create a KPI assignment. Within Service 
Health Administration, open the KPI Assignments tab.
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 14 Select the Windows CI type, and open the Windows Mapping assignment. 
Edit the KPI configuration for System Availability.
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 15 Add the Spooler Service HI to the related Health Indicators list.

The System Availability KPI is now assigned to all Windows servers. Among 
the HIs contributing to its status is the Spooler Service HI.
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How to Create an HI and Trigger an Event When its 
Status Changes - Use-Case Scenario

This use-case scenario shows how to create a new HI for business transaction 
CIs, and trigger an event every time the HI’s status changes. The event is 
then assigned automatically to EUM administrators.

The following prerequisites must be filled:

➤ The application must be monitored by RUM.

➤ A rule must retrieve a new metric from business transactions monitored 
by RUM; for this example we will monitor SSL handshake time.

➤ The event browser license is required.
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To create an HI and trigger events when its status changes

 1 Within Service Health Administration, open the Indicators Repository. 
Select the Business Transaction CI type.

 2 Create a new HI called SSL Handshake Time. Define its general properties 
and three statuses: Normal, Warning and Critical. Select the rule that will 
extract the SSL handshake time.
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 3 Select the Generate Events check box, and click Configure Events.

 4 Within the Event Configuration dialog box, in the General > Category 
field, type EUM Events, and save.

 5 Within Operations Management Administration, select Tune Operations 
Management > User Groups Assignments.

 6 Create an new rule called EUM Events. Create a filter called EUM Events 
which filters for the EUM Events category (this is the category of the 
events triggered by the HI’s status change).
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 7 Select the EUM Administrators user group to receive event notifications.

When the SSL Handshake Time HI changes status, an event is triggered, and 
it is sent to the EUM administrators.

How to Create an Event Based on CI Status Changes - 
Use-Case Scenario

This use-case scenario shows how to generate events based on CI status 
changes. This use-case can be beneficial for an application manager who 
receives CI status alerts when the application's status gets worse. However, 
during the night he is not available, and he wants the operator to be 
notified when the application’s status changes.

 1 Within Service Health Administration, select CI Status Alerts, and click 
Open Template Repository Manager.

 2 Duplicate the CI status alert open default template, and save it as CI 
status alert during non-working hours.
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 3 In the Custom Attributes area, click New Key. Drag and drop the Alert 
trigger time attribute, and set the values for non-working hours shown 
below.

 4 Select the relevant view and CI, and create an alert with the required 
attributes. In the Action page, click New Event Generation, and select the 
CI status alert during non-working hours event template.

When the CI’s status changes during non-working hours and an alert is 
generated, the alert is now sent to the operator and not to the application 
manager.
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How to Monitor a Specific Windows Server with Both 
Operations Manager and SiteScope - Use-Case Scenario

This use-case scenario shows how to monitor a Windows server with both 
HPOM (agent-based monitoring) and SiteScope (agentless monitoring). 
HPOM will monitor the Printer Spooler service on the server, and SiteScope 
will monitor its availability; both of these HIs will then contribute to the 
System Availability KPI.

 1 Within Service Health Administration, open the Indicators Repository 
and select the Windows CI type.

 2 Create a new HI called Ping Windows Servers, and map the Ping monitor 
to this HI.

 3 For the same CI type, create a new HI called Printer Spooler, which will be 
monitored by HPOM. For details, see "How to Map an ETI to an HI - Use-
Case Scenario" on page 127.
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 4 In System Availability Management Administration, open the Summary 
tab. Select the related SiteScope installation, and create the Ping monitor 
under the desired group.

 5 Within Service Health Administration, open the CI Indicators tab. Select a 
view that contains the relevant Windows server; for example you can 
open the System Hardware Monitoring view.

 6 Add the System Availability KPI to the CI. Define it as calculated based on 
HIs, and add the two HIs you created earlier to the Related HIs list.
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 7 Select a business rule (for example Worst Status Rule) and save.

The System Availability KPI on this CI is now calculated based on the HIs 
generated by HPOM, and by SiteScope.

Note: You can apply this to all Windows-type CIs using the Service Health 
KPI assignments.

How to Customize an HI Monitored by SiteScope - Use-
Case Scenario

This use-case scenario shows how to associate a custom HI with a SiteScope 
monitor. This use-case helps you enrich the default HI content provided by 
SiteScope with additional metrics monitored by SiteScope.

 1 Within Service Health Administration, open the Indicators Repository. 
Select the Computer CI type.

 2 Create a new HI named Special Computer CPU, and set its states to 
Critical, Minor, and OK. Select SiteScope Worst Status Rule as its default 
rule.
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 3 Within Service Health Administration, open the KPI Assignments tab. 
Select the Computer CI type, and clone the SiteScope related KPIs 
assignments. 

 4 Open the cloned assignment for editing. Add the System Performance 
KPI to the KPI configuration, and define it as calculated based on the new 
HI.

 5 Within System Availability Management Administration, open the 
Metrics and Indicators tab.

 6 Select the CPU monitor in order to map it to the Special Computer CPU 
HI.

 7 Click New Assignment. In the Metric Pattern field, enter the following 
string: /utilization.*/.
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 8 Select the Computer CIT, and select Special Computer CPU from the list 
of HIs.
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 9 Within the Summary tab, create a CPU monitor on the SiteScope server. 
In the monitor’s Properties > Threshold Settings area, define the 
indicator’s states and severities. When you finish, run the monitor.

 10 Within the Service Health application, open Top View. Select the System 
Hardware Monitoring view, and verify that the monitored CI has the 
correct HI, and the correct HI value and color.

Tip: You can now change the HI, and modify its thresholds. Within 
SiteScope, open the CPU monitor’s Properties > HP Integration Settings, 
and choose a different HI. You can then redefine the HI’s values in the 
Threshold Settings area. You will see the new HI, with its status based on the 
new thresholds, within the Service Health application.
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3
Top View

This chapter includes:

Concepts

➤ Top View Overview on page 148

Tasks

➤ How to Customize the Top View Display on page 151

➤ How to Access an External Application from Top View on page 159

Reference

➤ Top View Component User Interface on page 162
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Concepts

Top View Overview

Top View enables you to see the business availability of your system 
components at a glance. The CI bars in the component provide a visual 
representation of real-time IT performance metrics mapped onto business 
applications, based on the hierarchy tree structure defined for each view. 
The connecting lines between the bars define the relationships between the 
CIs. For a detailed description of Top View, see "Top View Component User 
Interface" on page 162. 
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By presenting an integrated, single view of essential applications and 
business processes, Top View provides you with an overall perspective on 
the health of your business services, and enables you to instantly assess how 
a performance issue impacts the availability of any part of your business. 
Each CI in the active view is color coded to indicate the worst status held by 
the CI’s KPIs.

This section also includes the following topics:

➤ "Interactive Map" on page 149

➤ "Understanding the Colors and the Icons" on page 149

➤ "Virtual Containers" on page 150

Interactive Map
The Top View component presents an interactive map of the CIs that can be 
intuitively manipulated using the mouse, enabling you to drill down to 
specific branches of the tree and to focus on particular business areas or 
problem areas.

By default, the Top View component displays four levels of CIs. The rest of 
the CIs are collapsed. You can expand CIs from the fourth level and see their 
child CIs.

The lines connecting the bars represent the branches of the tree. The bars 
and lines can be manipulated to change the amount of information 
displayed and the overall layout of the diagram, as described in "Top View 
Component User Interface" on page 162.

Understanding the Colors and the Icons
Each CI contained in the view is displayed as a bar, color-coded according to 
the current worst operational status for that CI. For details on color coding, 
see "KPI Status Colors and Definitions" on page 45.
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The icons displayed under a CI bar identify the relevant KPIs for the CI. 
These icons are also color coded to indicate the status of that KPI. 

Note: The root CI does not display KPI icons because it is a container and 
not a real CI.

For a list of the KPIs used in Service Health, see "List of Service Health KPIs" 
on page 656.

Virtual Containers
Virtual container CIs are displayed in Top View in regular CI bars, but their 
names appear between brackets. The bar is color-coded according to the 
current worst operational status for the group CI’s children CIs. You cannot 
right-click the bar to display context menu options.
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Tasks

How to Customize the Top View Display

To customize Top View display, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings:

➤ Select Applications.

➤ Select Service Health Application.

➤ In the Service Health Application - Top View Properties area, modify the 
entries as described in the following sections.

The following steps are optional and can be performed in any order:

➤ "Customize the layout of the hierarchy in Top View" on page 152

➤ "Modify the default refresh rate of Top View" on page 155

➤ "Change the text color in Top View bars" on page 155

➤ "Change fonts in Top View" on page 155

➤ "Change the caption font size in Top View" on page 155

➤ "Modify the number of CIs displayed in Top View" on page 155

➤ "Specify the maximum length of the line between two CIs" on page 156

➤ "Change the number of CI levels displayed in Top View" on page 156

➤ "Change the number of CI Levels that can be expanded in Top View" on 
page 156

➤ "Hide or display the view bar in Top View when the view has a single root 
CI" on page 157

➤ "Change the color of the CI bar in Top View when the CI status is OK" on 
page 157

➤ "Customize the background image for Top View" on page 158
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➤ "Customize Top View tooltips" on page 158

➤ "Set up the Top View debugging mechanism" on page 159

Customize the layout of the hierarchy in Top View

You can customize the layout of the hierarchy in the Top View component. 
By default, the parent CI is displayed above the child CIs and the child CIs 
are close to the bottom part of the Top View component.

To customize the layout of the hierarchy, locate the Top View Graph Layout 
entry in the Service Health Application - Top View Properties table. Select 
the type of layout (listed below in alphabetical order).

Type of Layout Description

BOTTOM Default. The parent CI is above the child CIs and is 
centered on the component. 
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LEFT The child CIs are to the left of the parent CI and the 
parent CI is centered on the component. 

RADIAL The second level of the tree is distributed around 
the parent and the parent is centered on the 
component.

Type of Layout Description
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RIGHT The child CIs are to the right of the parent CI and 
the parent CI is centered on the component. 

TOP The parent CI is under the child CIs and is centered 
on the component. 

Type of Layout Description
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Modify the default refresh rate of Top View

The default refresh rate for Top View is 5 seconds. To modify the refresh rate, 
click the Preferences button in the component toolbar (in the upper right 
area of the component) and enter the new refresh rate. 

Change the text color in Top View bars

You can improve readability or customize Top View by changing the color of 
the text in Top View bars. 

Locate the Top View Text Color Property entry in the Service Health 
Application - Top View Properties table. Enter the appropriate color in the 
Value box, using the #RRGGBB format. Default is white (#FFFFFF). 

You must close all browser instances for the change to take effect.

Change fonts in Top View

To change the font displayed in Top View for all locales, locate the Top View 
Font Name entry in the Service Health Application - Top View Properties 
table. Enter the appropriate font name in the Value box.

You must close all browser instances for the change to take effect.

Change the caption font size in Top View

By default the size of the fonts used for Top View CI names (in the bars) is 9.

To change the default size, enter the required value in the Top View caption 
font size entry in the Service Health Application - Top View Properties table.

The change is immediate.

Modify the number of CIs displayed in Top View

The maximum number of CIs displayed in Top View is 3000 by default.

To change the default value, edit the Maximum number of nodes entry in 
the Service Health Application - Top View Properties table. 

The change is immediate.
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Specify the maximum length of the line between two CIs 

The default percentage by which you can extend the line between two CIs is 
1.5.

To modify the default percentage, edit the Top View Line Extension 
Percentage entry in the Service Health Application - Top View Properties 
table. This change is performed during the next log in. 

Change the number of CI levels displayed in Top View

By default, the Top View component displays four levels of CIs. The rest of 
the CIs are collapsed. You can then expand a CI at the fourth level and see 
its children.

To modify the number of levels displayed when you open the Top View 
component, edit the Top View Number of Levels entry in the Service Health 
Application - Top View Properties table. Valid values are 2 to 100. This 
change is performed during the next log in. If you select 2, the name of the 
view and the top level CIs are displayed.

Change the number of CI Levels that can be expanded in Top 
View

To change the default setting (7) for the number of levels of CIs that are 
displayed when you select the Expand more levels context menu item, edit 
the Top View expand levels entry in the Service Health Application - Top 
View Properties table. Valid values are 2 to 12. This change is performed 
during the next log in.
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Hide or display the view bar in Top View when the view has a 
single root CI

You can select to hide or display the view bar in the Top View component, 
when the view has a single root CI. 

To hide or display the view bar in Top View when the view has a single root 
CI, locate the Hide view bar in Top View entry in the Top View Properties 
table. Set the parameter to:

➤ true. The view bar is not displayed as the root of the hierarchy, the root of 
the hierarchy is the single root CI. 

➤ false. The view bar is the root of the hierarchy. 

Change the color of the CI bar in Top View when the CI status is 
OK

You can modify the default green color (#78B24A) of the CI bar when the CI 
status is OK to another color or a different green. 

To modify the color, edit the Top View Green Color Property entry in the 
Service Health Application - Top View Properties table. 
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Customize the background image for Top View

To change the background color or add a background image to the Top View 
component or to the NOC standalone page, locate the following in the 
Service Health Application - Top View table:

➤ Top View Background Color Property. Modify the default value to change 
the color of the Top View component background or of the NOC 
standalone page background. For example, you can display the Top View 
component with a black background (#000000). You must close all 
browser instances for the change to take effect.

➤ Top View Background Image. Enter the name of the image you want to 
use as a background image for the Top View component or the NOC 
standalone page and put the appropriate image in the following location: 
<Gateway server root directory>/AppServer/webapps/site.war/bam/

You must close all browser instances for the change to take effect.

Customize Top View tooltips

You can:

➤ Limit the number of lines displayed in the tooltip

If the tooltip includes more lines than the default number of lines, 
More... is displayed on the last line.

To change the default number of lines (8) displayed in the tooltip, edit the 
Max lines in tooltip entry in the Service Health Application - Top View 
Properties table.

➤ Display the weight information in the tooltip

You can add the weight of a CI’s KPIs to the CI’s tooltip for any CI in Top 
View. 

Locate the Show weight property in tooltip entry in the Service Health 
Application - Top View Properties table, and modify the value to true. 
Default is false (weight is hidden).
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Note: 

➤ Using this option might affect the performance since additional TQLs are 
required to get this information.

➤ Adding a weight to a CI is explained in "Insert Relationship Dialog Box" 
in the Modeling Guide.

Set up the Top View debugging mechanism

To debug Top View, set the debug mode. Log messages are printed to the 
Java console.

To debug Top View, set the Top View Debug entry in the Service Health 
Application - Top View Properties table to true. Default is false.

How to Access an External Application from Top View

You can configure Service Health Top View so that a user can open an 
external application from the right-click menu. 

This task includes the following steps:

➤ "Specify the URL of the external application" on page 160

➤ "Attach the Open in New Window context menu item to the Top View 
context menu" on page 161

➤ "Result" on page 161
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 1 Specify the URL of the external application

The Open in New Window option calls the specified URL in another 
window and supplies it with the values of the parameters you specified in 
the URL. The URL page uses the values of the parameters to display what 
is necessary. 

To specify the URL of the external application, select Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, choose Applications, 
select Service Health Application, and locate the Top View URL to Open 
entry in the Top View Properties table. Enter the appropriate URL:

➤ Enter the URL of the application.

➤ Enter a dynamic URL that can be used, for example, to integrate 
external tools with BSM.

Use the following syntax (HTTP GET format):

Use only the parameters you need in any combination. For details 
about the parameters, see "Dynamic URL Parameters" on page 897.

For example:
http://<URL>?nodeName=NODE.NAME&nodeParentId=NODE.PARENTI
D
adds the CI name and the ID of the parent CI to the URL.

➤ To reset the URL to the default (empty), click Restore Default.

Note: 

➤ The change takes place immediately.

➤ You must disable your browser’s pop-up blockers to open a window 
with the external application.

http://<URL>?nodeName=NODE.NAME&nodeId=NODE.ID
&nodeStatus=NODE.STATUS&nodeParentId=NODE.PARENTID
&nodeChildId=NODE.CHILDIDS
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 2 Attach the Open in New Window context menu item to the 
Top View context menu

By default, the Open in New Window option does not appear in the 
context menus in Top View. To enable it you must assign it to the Top 
View context menu.

 a Select Admin > Service Health > Repositories > Context Menus, and 
open the Top View context menu for editing. 

 b Select the Show group, click Add Action, and select Open in a new 
window. Save your change.

 3 Result

The Open in New Window option is added to the right-click menu 
available in Top View.
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Reference

Top View Component User Interface

This component enables you to see the business availability of your system 
components at a glance. The CI bars in the component provide a visual 
representation of real-time IT performance metrics mapped onto business 
applications, based on the hierarchy tree structure defined for each view. 
The connecting lines between the bars define the relationships between the 
CIs.

To access Select Applications > Service Health > Top View, then 
select a view from the list in the upper left corner of the 
component.

Important 
information

➤ Click anywhere in the component to change the 
emphasis of the graphic.

➤ Click and drag anywhere in the component to move 
and rotate the graphic around that point.

➤ Increase or reduce the gap between each branch by 
holding down the ALT button on the keyboard and 
dragging the relevant bar.

➤ When you open the Top View component, it 
displays by default the active view at the root level, 
centered around the view name bar. Any 
manipulation you do to the graphic is not saved; if 
you move to another component, then when you 
return to Top View, the graphic reverts to the default 
display format.

Relevant tasks "How to Customize the Top View Display" on page 151

See also "Top View Overview" on page 148
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

<CIs> When you select a view, Top View displays the selected 
view bar centered in the tree with all its root CIs 
expanded. 

➤ Expand and collapse the branches of a subtree by 
clicking the expand (+) or collapse (-) symbols, 
displayed in the bottom right corner of the bar. 

➤ When branches are too long to fit on the screen, Top 
View displays lines emerging from the bar, to 
indicate the number of branches and leaves that are 
hidden. Click the end of one of these lines to display 
the hidden branch.

Hold the cursor over a bar to display the following:

➤ The bar is outlined.

➤ If the CI has a long name, the bar expands to display 
the full name.

➤ When you hold the cursor over a CI a tooltip shows 
the CI name and CI type.

➤ When you hold the cursor over a KPI icon, a tooltip 
provides status and performance data for the KPI.

<KPIs and their 
statuses/values>

For each CI, Service Health displays the CI’s KPIs and 
their real-time status as a color-coded icon. For details, 
see "KPI Status Colors and Definitions" on page 45.

<right-click menu 
options>

Right-click a CI bar to list the available menu options. 
For details, see "Service Health Menu Options" on 
page 98.
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Last Update Displays when the information in the component was 
last updated.

To manually update the information in the 
component, click the Refresh icon.

UI Element (A-Z) Description
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Topology Map

This chapter includes:

Concepts

➤ Topology Map Overview on page 166

➤ Topology Map in View or Graph Display on page 168

➤ Plain Mode, Group Mode, and Layer Mode on page 168

➤ Default Layers in Topology Map on page 170

Tasks

➤ How to Customize Topology Map Display on page 171

Reference

➤ Topology Map User Interface on page 176
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Concepts

Topology Map Overview

Topology Map provides you with an interactive graphic representation of 
CIs in a view, enabling you to see the business availability of your system 
components at a glance. The CI bars in the map provide a visual 
representation of real-time IT performance metrics mapped onto business 
applications, based on the hierarchy structure defined for each view. 
Connecting lines between the bars represent the relationships between the 
CIs. 

By presenting an integrated, single view of essential applications and 
business processes, Topology Map provides you with an overall perspective 
on the health of your business services, and enables you to quickly assess 
how a performance issue impacts the availability of any part of your 
business.

The structure of CIs in a Topology Map can be defined according to view 
folding, or according to the CI definitions in the Run-time Service Model 
(RTSM). For details, see "Topology Map in View or Graph Display" on 
page 168.

Topology Map enables you to arrange CIs in groups (either divided by CIT or 
by similar applications), or in functional layers. For details, see "Plain Mode, 
Group Mode, and Layer Mode" on page 168.
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For a detailed description of the Topology Map user interface, see "Topology 
Map Component" on page 176.

This section also includes the following topics:

➤ "Interactive Map of CIs" on page 167

➤ "Understanding the Colors and the Icons" on page 167

➤ "Annotation" on page 168

Interactive Map of CIs
Topology Map presents an interactive map of CIs that can be easily 
manipulated, enabling you to focus on particular business areas or trouble 
spots.

Lines between the CI bars represent links between CIs, and show the CI 
hierarchy in the selected view. The CI bars and lines can be manipulated to 
change the amount of information displayed and the overall layout of the 
map, as described in "How to Customize Topology Map Display" on 
page 171.

Understanding the Colors and the Icons
Each CI in the view is displayed as a bar, with a color-coded icon overlaid on 
top of the CIT icon indicating the current worst operational status for that 
CI. For details on color coding, see "KPI Status Colors and Definitions" on 
page 45.

The icons displayed below the name of the CI identify the relevant KPIs for 
the CI. These icons are also color coded to indicate the status of that KPI.
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Annotation
Within Topology Map, you can click the Capture Result and Add 
Annotations button on the toolbar to access the annotation tool. You can 
use annotation to create and save a snapshot of the image you are viewing, 
and highlight important areas of the image. For details, see "Annotation 
Tool Dialog Box" on page 183.

Topology Map in View or Graph Display

The basic structure of the CIs in a Topology Map can be defined in one of 
two ways: 

➤ View Display. This shows the topology of the view based on the View 
Folding, with a single root node, and child CIs that have no recursive 
loops. Such loops are resolved by copying CIs, so that a CI can appear a 
few times in a view.

The view display follows the Impact model, so all the links between CIs 
are either Impact (Dependency) or Impact (Containment). By default, link 
labels are not shown in view display.

➤ Graph Display. This shows the topology of the view as defined in the 
RTSM, without View Folding. The links between the CIs represent their 
physical links as they appear in the RTSM. By default, Topology Map 
shows link labels in the graph display.

Plain Mode, Group Mode, and Layer Mode

You can view CIs in Topology Map in one of three modes:

➤ Plain mode. In plain mode, the graphic display of CIs does not include 
groups or layers.

➤ Group mode. In group mode, the Topology Map graphic display can 
include groups of CIs. CIs can be automatically grouped either by CIT, or 
based on their Classification attribute in the RTSM. For example, when 
CIs are grouped by Classification attributes, CIs related to SAP or Siebel 
are included in a group named ERP.
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You can also create user-defined groups, and move CIs into and out of 
groups, to fill your organizational needs.

In group mode, a status icon shows the worst status of all CIs in the 
group, as follows:

➤ Layer mode. In layer mode CIs are divided into functional layers, such as 
Business Enablement, Infrastructure, or Software. CIs are assigned to the 
layers based on their Layer attribute in the RTSM. For example, in layer 
mode the Application Resource and Application System CITs are assigned 
to the Software layer, based on their Layer attribute. 

In layer mode you can move CIs in and out of layers. You can also create 
additional layers using the Layer attribute in RTSM administration. For 
details on each of the default layers, see "Default Layers in Topology Map" 
on page 170.

Groups are only available in group mode; layers are only visible in layer 
mode.

Note: If you create a new layer, click the Restore Default View button to 
display the layer properly in Topology Map.
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Default Layers in Topology Map

Within the layer mode, CIs are assigned to default layers based on their CIT 
attributes within the RTSM. The following section describes each of the 
layers that are defined out-of-the-box.

➤ Business Enablement. This layer contains business services, processes, and 
activities. These include both business services which a business provides 
to another business (or one organization provides to another within a 
business), and IT services which an IT organization provides to support 
business services or IT operations. 

A Business Service typically has an associated end-user or customer, a 
business application, and a service level agreement. Examples include 
payment processing, backup and recovery, and self-service help desk.

➤ Application and Services. This layer contains applications and their core 
components, not including elements that are deployable. An application 
is a set of components which supports a business activity, which is seen as 
a whole, and is known by a specific name. 

The Application and Services layer also includes business transactions, as 
well as infrastructure services that support business services and processes. 
Examples include voice and network services, database services, backup 
and restore services, desktop services, and Windows administration 
services.

➤ Software. This layer includes individual installations of software 
elements. These are executables that can be deployed, or are deployed, on 
a logical system.

➤ Infrastructure. This layer includes logical systems such as virtualization 
and clustering, and physical systems such as storage devices, network 
devices, and servers.

➤ Facilities. This layer includes locations, sites, buildings, rooms, racks, and 
so on.
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Tasks

How to Customize Topology Map Display

You can customize the Topology Map display using the following options:

➤ "Select a view to be displayed in Topology Map" on page 171

➤ "Switch between view or graph display" on page 172

➤ "Organize Topology Map in plain, group, or layer mode" on page 172

➤ "Resize the display or navigate within Topology Map" on page 172

➤ "Display minimal information or detailed information for each CI" on 
page 173

➤ "Display links between CIs" on page 173

➤ "Hide CIs or restore hidden CIs" on page 173

➤ "Move CIs or groups" on page 174

➤ "Create or delete a group" on page 174

➤ "Modify a group" on page 174

➤ "Rearrange layers" on page 175

➤ "Restore Topology Map to its default settings" on page 175

Note: Customizing the Topology Map display (hiding CIs, moving CIs in 
and out of layers, and so on) has no effect at all on the RTSM topology; your 
customizations only influence how CIs are displayed in this component.

Select a view to be displayed in Topology Map

To select a view from within Topology Map, choose a view from the view 
selector drop-down list on the top left area of the toolbar.
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Switch between view or graph display

In View display, Topology Map shows the topology of the view based on the 
Impact model. In Graph Display, Topology Map shows the topology of the 
view as defined in the RTSM (without View Folding).

To switch from one display to another, click the View/Graph Display button 
in the Topology Map toolbar.

Organize Topology Map in plain, group, or layer mode

Topology Map can be displayed in three modes: 

➤ Plain Mode. Each CI stands on its own, not as part of a group or layer.

➤ Group Mode. CIs are grouped by similar applications (for example ERP). 
In group mode you can create groups, add or remove CIs from groups, 
and delete groups. In group mode, a status icon shows the worst status of 
all CIs in the group.

➤ Layer Mode. CIs are divided into functional layers (for example Business 
Enablement, Infrastructure, or Software). In layer mode you can move CIs 
in and out of the default layers, but you cannot rename or delete a layer.

To switch from one mode to another, select a mode from the drop-down list 
in the Topology Map toolbar.

Resize the display or navigate within Topology Map

Some CIs may have a large Topology Map, based on the number of parent 
and child CIs to which they are connected. You can use the following 
buttons in the toolbar to help you navigate within the Topology Map 
display:

➤ Fit to screen. Click to fit the image to the pane, either by expanding it or 
by reducing it.

➤ Interactive Zoom Click to activate Zoom mode. In Zoom mode, click 
within Topology Map and drag up or down (or use your mouse wheel) to 
zoom in and out of the image.

➤ Pan. Click this button, then click within Topology Map and drag the 
image to move it.
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➤ Display Minimap. Click to display the full Topology Map in a small 
window (minimap), which is overlaid on top of the standard Topology 
Map image.

A highlighted area within the minimap image shows which part of the 
Topology Map is displayed in the larger image. You can resize or move 
this highlighted area to focus on the part of Topology Map which is of 
interest to you. To close the minimap window, click within the larger 
image.

Display minimal information or detailed information for each 
CI

Topology Map can be displayed either in minimal presentation, which 
displays only CI icons and worst statuses, or in detailed presentation, which 
displays CI names and KPI statuses. To switch between minimal and detailed 
presentation, click the Toggle Presentation Type button in the Topology 
Map toolbar.

Display links between CIs

Topology Map can display arrows between CIs that are linked, as well as link 
labels showing the relationship between two CIs (for example, Contains or 
Depends on).

➤ To see links, select Display Options > Show Links in the Topology Map 
toolbar.

➤ To see link labels, select Display Options > Show Link Labels. Note that if 
the Show links option is de-selected, this option is disabled.

Hide CIs or restore hidden CIs

Topology Map enables you to hide CIs from your display, and to restore 
hidden CIs. Note that calculations performed within a view do include any 
hidden CIs.

➤ To hide CIs or groups, select them and click Hide Selection in the 
Topology Map toolbar.

➤ To restore hidden CIs, click Restore Hidden in the Topology Map toolbar. 
All previously hidden items are restored.
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Move CIs or groups

To move CIs or groups you must be in Selection mode. To activate Selection 
mode, click the Select button in the Topology Map toolbar.

Click one or more CIs or groups and drag them to a new location. If your 
Topology Map displays links between CIs, the arrows attached to these CIs 
will be moved as well.

Create or delete a group

In group mode, perform the following:

➤ To create a group, select one or more CIs and click the New Group button 
in the Topology Map toolbar. The selected CIs are now contained within a 
new group container.

➤ To delete a group, select the group and click the Delete Group button in 
the Topology Map toolbar. The CIs are now located in their original 
locations.

Modify a group

To modify a group you must be in Selection mode. To activate Selection 
mode, click the Select button in the Topology Map toolbar.

➤ To rename a group, double-click the group name and type a new name for 
the group.

➤ To add CIs to a group or remove CIs from a group, drag them into the 
group or out of the group.

➤ To nest one group within another, drag one group inside another group.

➤ To collapse or expand a group, click the Collapse or Expand icons in the 
upper right corner of the group container.
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Rearrange layers

In layer mode, if you have moved CIs in and out of layers and want to 
neatly organize your display, click Rearrange Layers to rearrange the display 
so that the CIs and their links are neatly organized.

If you have moved CIs in and out of layers, this action does not restore them 
to their original layers. If you have emptied a layer of all its CIs, this action 
removes the layer.

Restore Topology Map to its default settings

To restore a Topology Map to its original settings without customizations, 
click Restore Default View.
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Reference

Topology Map User Interface

This section includes:

 ➤ Topology Map Component on page 176

 ➤ Annotation Tool Dialog Box on page 183

Topology Map Component

Topology Map enables you to assess the business availability of your system 
components at a glance, using an interactive graphic representation of the 
CIs in a view. In group mode, CIs are grouped according to CIT, or in groups 
of similar applications (for example ERP). In layer mode CIs are divided into 
layers, enabling you to focus attention on the layer which interests you the 
most (for example Business Enablement, Infrastructure, or Software).

To access Select Applications > Service Health > Topology Map

Important 
information

Topology Map can be used as an independent 
component using its built-in view selector, or together 
with another component which selects views such as 
Model Explorer.

Relevant tasks "How to Customize Topology Map Display" on 
page 171

See also "Topology Map Overview" on page 166



Chapter 4 • Topology Map

177

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Topology Map Toolbar

UI Element Description

<View Selector> Select a view from the dropdown list to display the 
view in Topology Map.

Select. In Select mode, you can select CIs or groups to 
perform actions on the selected elements. For details, 
see "How to Customize Topology Map Display" on 
page 171.

Interactive Zoom. In Zoom mode, click within 
Topology Map and drag up or down (or use your mouse 
wheel) to zoom in and out of the image.

Pan. In Pan mode, if your Topology Map image is 
scrollable you can click and drag the image to move it. 
(If the entire image fits within your screen this feature 
has no effect.)

Fit to screen. Click to fit the graph to the pane, either 
by expanding it or by reducing it. Relative proportions 
of the image are maintained.

Toggle Presentation Type. Click to switch between 
minimal view, which displays only CI icons and worst 
statuses, and detailed view, which also displays CI 
names and KPI statuses.

Click to open a dropdown list of display options. You 
can select or de-select each of the following options:

➤ Show links. If you select this option, Topology Map 
displays arrows between CIs that are linked.

➤ Show link labels.If you select this option, Topology 
Map displays each link together with its link type 
(for example, Contains or Depends on). If the Show 
links option is de-selected, this option is disabled.
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Click to select between the following display modes:

➤ Plain Mode. Each CIs is displayed standing on its 
own, not in a layer or group.

➤ Group Mode. Topology Map displays related lower-
level CIs in groups; for example, within the 
Application System hierarchy, CIs related to SAP or 
Siebel are grouped within ERP. 

In group mode you can create groups, add or remove 
CIs from groups, and delete groups, as described in 
"How to Customize Topology Map Display" on 
page 171. In group mode, a status icon shows the 
worst status of all CIs in the group.

➤ Layer Mode. Topology Map displays related higher-
level CIs in layers; for example, Business Element 
CIs are displayed in the Business Enablement layer, 
while Node and Node Element CIs are displayed in 
the Infrastructure layer. 

For details, see "Plain Mode, Group Mode, and Layer 
Mode" on page 168.

Hide Selection. Click to hide selected CIs or groups 
from the display. Note that hidden CIs are still 
included in view calculations.

Restore Hidden. Click to restore any hidden CIs or 
groups to Topology Map.

New Group. In group mode, perform one of the 
following:

➤ Click the New Group button to create a new (empty) 
group; you can then drag CIs into this new group.

➤ Select one or more CIs, then click the New Group 
button to create a group which contains these CIs.

This button is only active in group mode.

UI Element Description
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Delete Group. Select a group and click the Delete 
Group button to delete the group container.

If the deleted group was nested within another group, 
the CIs are moved to the parent group; if the deleted 
group was not nested, the CIs are moved to their 
original location in the view hierarchy.

This button is only active in group mode.

Rearrange Layers. In layer mode, click to rearrange the 
graphic display so that the CIs and their links are 
neatly organized. This is useful if you have moved CIs 
in and out of layers, and want to neatly rearrange the 
display.

Note that if you have moved CIs in and out of layers, 
this action does not restore them to their original 
layers.

This button is only active in layer mode.

Restore Default View. Click to restore Topology Map to 
its original, pre-customization settings.

Note: If you create a new layer, click Restore Default 
View to display the layer properly in Topology Map.

View Display/Graph 
Display

Select one of the following ways to build a Topology 
Map:

➤ View Display. This shows the topology of the view 
based on View Folding, using the Impact model, 
with a single root node, and child CIs that have no 
recursive loops.

➤ Graph Display. This shows the topology of the view 
as defined in the RTSM, without View Folding. The 
links between the CIs represent their physical links 
as they appear in the RTSM.

UI Element Description
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Display Minimap. Click to display the Topology Map 
image in a small window (minimap), which is overlaid 
on top of the standard Topology Map.

Drag the magnifying glass icon within the minimap to 
focus Topology Map to show the area which is of 
interest to you. You can move the minimap by clicking 
and dragging its header bar. To close the minimap 
window, click within the larger Topology Map image.

Capture Result and Add Annotations. Click to open the 
Annotation Tool, which creates a snapshot of the 
Topology Map and enables you to annotate the 
snapshot to highlight important areas. The tool 
enables you to draw in the snapshot, or add lines or 
text to the image. For details, see "Annotation Tool 
Dialog Box" on page 183.

UI Element Description
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Topology Map Display

UI Element (A-Z) Description

<CI nodes> Each CI in the selected view is displayed as a bar within 
Topology Map, which contains the following elements:

➤ The left side of the bar shows an icon indicating the 
CI’s CI type, as represented in the RTSM.

➤ CI aggregated status is overlaid on top of the CIT 
icon.

➤ If Topology Map is in detailed view, the CI name and 
KPI statuses are also displayed.

Tooltips: The tooltip for a CI shows the CI name and CI 
type. The tooltip for a KPI shows status and 
performance data for the KPI:

CI and KPI status are displayed as color-coded icons. 
For details, see "KPI Status Colors and Definitions" on 
page 45.

For details on customizing display settings, see "How to 
Customize Topology Map Display" on page 171.

<groups of CIs> In group mode, groups of related CIs are displayed 
within a border. Some CIs are assigned to groups by 
default; you can also create groups to fit your needs. 

You can add or remove CIs from a group, collapse or 
expand a group, move a group, and edit the group 
name.

For details on these options, see "How to Customize 
Topology Map Display" on page 171.
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<layers of CIs> In layer mode, high-level CIs are displayed within 
layers that are divided by functionality, such as 
Business Enablement or Infrastructure. Each layer is 
shown in a separate shaded area, labeled by the layer 
name. 

Layers cannot be renamed or deleted; CIs can be 
removed from layers, or added to them.

<links between CIs> In the list of Display options, if you select Show links, 
Topology Map displays arrows between CIs that are 
linked within the RTSM.

If you also select the Show link labels option, Topology 
Map also displays the link type (for example, Contains 
or Depends on).

Note: If a CI outside a group links to a number of CIs 
inside a group, when the group is collapsed no link 
label is shown; when the group is expanded link labels 
are shown for each link.

<minimap image> If you click the Display Minimap button, the Topology 
Map image appears in a small window (minimap), 
overlaid on top of the standard Topology Map.

The highlighted area shows which part of the Topology 
Map is displayed in the larger image. Resize or move 
the highlighted area to focus on the part of Topology 
Map which is of interest to you.

<right-click menu 
options>

Right-click a CI bar to list the available menu options. 
For details, see "Service Health Menu Options" on 
page 98.

Last Update Displays when the information in the component was 
last updated.

To manually update the information in the 
component, click the Refresh icon.

UI Element (A-Z) Description
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Annotation Tool Dialog Box

This page enables you to annotate a snapshot of the topology map you are 
viewing, to highlight important areas. 

The annotation tool is identical in the Topology Map and Neighborhood 
Map components.

To access Click the Annotate button on the topology map or 
neighborhood map toolbar.

Important 
information

➤ The annotation options are located on the left side of 
the annotation window.

➤ When saving the annotation: 

➤ The snapshot is saved in .png format.

➤ You cannot select the New Folder icon  when 
saving in the My Documents directory or any of its 
subdirectories.
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Annotation Options
The elements that enable you to annotate your snapshot.

User interface elements are described below:

UI Element (A–Z) Description

Pan Tool. Click to navigate the snapshot.

Select Tool. Click and drag to select a specific area of the 
snapshot.

Shape Tool. Click and drag to add a shape to the 
snapshot. Clicking the shape tool button enables the 
following shape buttons:

➤  Rectangle. Click and drag to mark an area of the 
snapshot with a rectangle.

➤  Filled Rectangle. Click and drag to mark an area 
of the snapshot with a filled rectangle.

➤  Oval. Click and drag to mark an area of the 
snapshot with an oval.

➤  Filled Oval. Click and drag to mark an area of the 
snapshot with a filled oval.

➤  Rounded Rectangle. Click and drag to mark an 
area of the snapshot with a round rectangle. 

➤  Filled Rounded Rectangle. Click and drag to mark 
an area of the snapshot with a filled round rectangle. 

Customization. After selecting this button, you can 
customize your line appearance through the following 
parts of the interface:

➤ Line Type. Choose the type of line you want to add. 
Options include:

➤ Solid Line

➤ Jagged Line

➤ Line Width. Select the width of the line, in pixels, in 
the annotation.
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Line Tool. Click and drag to enable the line tool, which 
marks the selected area of the snapshot with a line. 

Customization. After selecting this button, you can 
customize your line appearance through the following 
parts of the interface:

➤ Line Style. Choose the style of line you want to add. 
Options include: 

➤ Regular line

➤ Line with endpoints

➤ Line with arrows

➤ Line Type. Choose the type of line you want to add. 
Options include:

➤ Solid Line

➤ Jagged Line

➤ Line Width. Select the width of the line, in pixels, in 
the annotation. 

Text Tool. Click and drag to open a box where you can 
add text to the snapshot.

Example: Add the syntax: This is the problematic 
transaction above a line marking an area of the snapshot.

UI Element (A–Z) Description
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Menu Bar
Displays the elements which enable you to perform selected actions on your 
snapshot. 

Border and Fill Colors Select the relevant square to choose the color of the 
border and fill of your annotations. The available squares 
are:

➤ Upper Square. Click to choose the color of lines, as 
generated by the line tool and displayed in unfilled 
shapes. 

➤ Lower Square. Click to choose the color to fill shapes.

Clicking either of the squares generates a dialog box with 
the following tabs where you choose the color:

➤ Swatches 

➤ HSB

➤ RGB

Opacity Slide the opacity bar to choose the darkness level of the 
selected shape line, text line, or shape color in the 
annotation. 

Note: 

➤ A higher opacity percentage means that the selection 
appears darker. A lower opacity percentage means that 
the selection appears lighter.

➤ This field is enabled when either the shape tool, line 
tool, or text tool button is selected.

Important 
information

The menu bar contains elements which enable you to:

➤ Change the appearance of the snapshot.

➤ Save or print the snapshot.

➤ Customize the appearance of text annotated onto your 
snapshot. These elements are enabled only when the 
Text Tool button  is selected.

UI Element (A–Z) Description



Chapter 4 • Topology Map

187

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A–Z) Description

Save. Saves the snapshot on your local machine.

Note: 

➤ The snapshot is saved in .png format.

➤ You cannot select the New Folder icon  when 
saving in the My Documents directory or any of its 
subdirectories. 

Select All. Selects all of the annotations added to your 
snapshot.

Clear Selected. Clears all annotations.

Undo. Rolls back the most recent action performed on 
the snapshot.

Redo. Cancels the roll back of the most recent action 
performed on the snapshot.

Zoom In. Brings the snapshot view closer.

Zoom Out. Sets the snapshot view further away.

Restore original size. Restores the snapshot to its original 
size.

Print. Prints the snapshot.

Help. Displays online documentation help for the page 
you are currently viewing.

The following fields are enabled when selecting the Text Tool button :

Bold. Makes the text bold.

Italic. Italicizes the text. 
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Underline. Underlines the text. 

Anti-aliasing. Adjusts the pixel reading of text or 
annotation lines so that they appear smoother. 

<Font Family> Select the font for the text in the report.

<Font Size> Select the size of the font in the report. 

UI Element (A–Z) Description
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5
Geographical Map

This chapter includes:

Concepts

➤ Geographical Maps on page 190

Tasks

➤ How to Display and Customize a View in Geographical Map on page 194

➤ How to Display a Geographical Map With Google Earth on page 198

➤ How to Customize Virtual Earth on page 201

➤ How to Customize the Maps Applet on page 203

Reference

➤ Geographical Map Component User Interface on page 205
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Concepts

Geographical Maps

In Service Health, you can associate a geographical map with a view. If you 
have specified geographical locations for the view’s CIs, real-time status 
indicators representing the CIs statuses are displayed on the map at those 
locations. For details on the geographical map user interface, see 
"Geographical Map Component User Interface" on page 205.

If you have an Internet connection, geographical maps are displayed by 
default using Virtual Earth. For details, see "Understanding Virtual Earth" on 
page 192. 

If you do not have an Internet connection, geographical maps can be 
displayed using a Maps applet. For details, see "Understanding the Maps 
Applet" on page 193.

Note: The Virtual Earth map is only available in English and cannot be 
translated. For localization, use the Maps applet. The Maps Applet does not 
display the names of cities or countries.

Tip: If you need a zoom level of a specific area that is not available in the 
Geographical Map, create a picture of the map and use the Custom Image 
feature instead.

This section also includes the following topics:

➤ "Location Status Information" on page 191

➤ "Understanding Google Earth" on page 191
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➤ "Understanding Virtual Earth" on page 192

➤ "Understanding the Maps Applet" on page 193

Location Status Information
The map displays color-coded status indicators that represent the worst KPI 
status for all CIs attached to the location at each geographical location. The 
color coding is the same as for other icons in Service Health. For more 
information about color coding, see "KPI Status Colors and Definitions" on 
page 45.

You can specify the CI location when you define a new CI or when you edit 
a CI’s properties. For details, see "Configuration Item Properties Dialog Box" 
in the Modeling Guide. If you do not specify a geographical location for at 
least one CI in the view, the Geographical Map tab displays only the map.

Each status indicator in the map can represent one or more CIs from the 
view with the same location. If you select a CI in Model Explorer, the 
geographical map is redisplayed automatically and shows only the selected 
CI and the CI’s children status indicators if a location is specified for them. 
If you select another view, the geographical map reloads automatically to 
show the view’s CI status indicators in the appropriate locations.

If you search for a specific CI in Model Explorer and you click the result of 
the search, the geographical map is not automatically redisplayed. The map 
is redisplayed only when you go back to browser mode. It shows only the 
selected CI and the CI’s children status indicators if a location is specified for 
them.

Understanding Google Earth

Note to HP Software-as-a-Service users: This feature is not available when 
working with HP Software-as-a-Service.

You can also view the geographical map information in a three-dimensional 
map, using the Google Earth application.
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Understanding Virtual Earth
If you have an Internet connection you can display the geographical map 
using Microsoft MSN Virtual Earth. HP Business Service Management 
integrates Virtual Earth online mapping functionality, available over MSN, 
to enable you to use the geographical map of a view. If the view’s CIs are 
assigned geographical locations, real-time status indicators are displayed on 
the map at those geographical locations. 

Virtual Earth geographical maps are based on Microsoft Network (MSN) 
technology and use dynamic HTML. 

The Virtual Earth geographical map presents a flat geopolitical view of the 
planet where you can display the country borders, the geographical features, 
or both.

When you magnify the view, the main cities appear for the part of the map 
that is displayed on the screen.
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Understanding the Maps Applet
The Maps applet presents a flat geopolitical view of the planet. 

You can use the Maps applet to display the geographical map of a view. The 
map displays the worst status at each geographical location and detailed 
information about the CI’s KPIs.  
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Tasks

How to Display and Customize a View in Geographical 
Map

This section describes the processes to view real-time status indicators in a 
geographical map, and gives examples.

This task includes the following steps:

➤ "Setup requirements for the Map applet" on page 194

➤ "Assign a geographical location to the appropriate CIs" on page 195

➤ "Select the display technology" on page 195

➤ "Assign a geographical map to a view" on page 196

➤ "Refine the geographical map" on page 197

➤ "Save changes" on page 197

 1 Setup requirements for the Map applet

The Maps applet requires that Sun JRE plug-in 1.6.0_x (latest version 
recommended) be installed on the client machine.

The city names use UTF8 format. If HP Business Service Management is 
working with a Microsoft SQL Server, or an Oracle Server that is not 
configured for UTF8 support, non-English characters (for example, é) are 
displayed as empty square brackets [ ].
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 2 Assign a geographical location to the appropriate CIs

To view the real-time status indicators corresponding to a view’s CI on the 
map, you must assign a geographical location to the relevant CIs in the 
view.

Note: This step is not required for CIs where location (longitude and 
latitude) and KPIs are already defined. For example, in the End User 
Locations view where a Real User Monitor Agent is running, locations are 
already assigned to the CIs.

Select Admin > RTSM Administration > Modeling > It Universe Manager. 
Select a CI in the topology map or Model Explorer. From the CI’s menu 
commands, choose Relate to CI. In Model Explorer, open the Locations 
view and select the location to which the CI will be assigned. Click the 
Relationship button, select the Membership link, and click Save.

 3 Select the display technology

You can display a geographical map using Virtual Earth, a Maps applet, or 
Google Earth.

 a Select Admin > Platform > Setup and Maintenance > Infrastructure 
Settings.

 b Select Applications.

 c Select Service Health Applications.

 d In the Service Health Application - Maps Management Properties 
table, perform the following (depending on which display you want to 
use):

➤ Virtual Earth. If you have an Internet connection, use Virtual Earth 
to display the geographical map. Locate the Use Virtual Earth entry, 
and set the property value to true. This is the default.

➤ Maps Applet. If you do not have Internet access, use the Maps 
applet to display the geographical map. Locate the Use Virtual Earth 
entry, and set the property value to false.
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➤ Google Earth. If you have Internet access, you can use Google Earth 
to display the geographical map. By default, the Export to Google 
Earth button appears in the Geographical Map component. To 
remove this button, locate the Enable Export to Google Earth 
button entry and set the property value to false (the default is true).

Note to HP Software-as-a-Service users: The Export to Google Earth 
button is not available when working with HP Software-as-a-Service.

 4 Assign a geographical map to a view

Assign a map to a view by selecting a view in the Geographical Map and 
saving the map.

To assign a geographical map to a view, open the Geographical Map 
component. By default, this opens together with the View Selector 
component. Select the appropriate view in the View Selector, and click 
Save.

If you assigned geographical location to a view’s CIs, the corresponding 
status indicators are displayed on the map as soon as you assign a map to 
the view. 

Note: To remove CI icons from the map, you must delete their 
geographical location.
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Example:

A map shows the status of the jpetstore CI in the Cayman Islands.  

 5 Refine the geographical map

You can also refine the geographical display depending on the type of 
display you have selected. You can:

➤ Adjust the geographical map using the elements described for each 
type of map. For details, see "Geographical Maps" on page 190.

➤ Customize the map. For details on Virtual Earth, see "How to 
Customize Virtual Earth" on page 201. For details on the Map Applet, 
see "How to Customize the Maps Applet" on page 203.

 6 Save changes

When you finish adjusting the map to fit your needs, click the Save 
button. The map is then saved for this view based on the adjustments you 
have made.
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How to Display a Geographical Map With Google Earth 

Note to HP Software-as-a-Service users: This feature is not available when 
working with HP Software-as-a-Service.

You can view the geographical map information in a three-dimensional map 
using the Google Earth feature. This section describes the processes to view 
status indicators in Google Earth.

This task includes the following steps:

➤ "Select the Appropriate Display Technology" on page 198

➤ "Import Location Status into Google Earth" on page 198

➤ "Set the Refresh Rate for the View" on page 200

➤ "View Indicators by Status" on page 200

 1 Select the Appropriate Display Technology

To use Google Earth you must select the appropriate display technology. 
For details, see "Select the display technology" on page 195.

 2 Import Location Status into Google Earth

You can import the location status information shown in the 
geographical map for the current view into a local Google Earth 
application. After importing the information, Google Earth displays all 
the CI status indicators in the appropriate geographical locations.

To list all the views you create in the same folder, create a new folder (for 
example, an HP Business Service Management folder) in the Places folder 
in Google Earth, and then add to that folder all the views you create. 

You can create a view in Google Earth by creating a network link using 
the view’s URL. This creates a container folder and a sub-folder.
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To import location status into Google Earth: 

 a If you have not already installed Google Earth on your local computer, 
open the Google Earth site (http://earth.google.com/) and download the 
application.

 b Click the View in Google Earth button. Follow the instructions in the 
Integration with Google Earth page.

 c Open the Google Earth application.

 d Click the My Places directory in the Places area.

 e If this is the first time you are creating a view in Google Earth, in the 
Create In area, click New Folder and enter HP Business Service 
Management to create a new folder called HP Business Service 
Management.

If the HP Business Service Management folder already exists in the 
Create In area tree, select the folder.

 f Select Add > Network Link. 

 g The Google Earth - New Network Link dialog box opens.

 h Enter the view name in the Name box.

 i Paste the URL displayed in the Integration with Google Earth page to 
the Location box.

Note: This URL creates a container folder called by the name you 
specified in the Name box, and a sub-folder called by the name of the 
view.

 j Click OK to close the New Network Link dialog box. 

The Google Earth page displays the HP Business Service Management 
folder in the Places area. 

 k Open the HP Business Service Management directory to list the views 
you have added.
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 3 Set the Refresh Rate for the View

You can set the refresh rate of the view sub-folder.

To set the refresh rate for the view: 

 a Right-click the view sub-folder.

 b Select Properties.

 c Click the Refresh tab.

 d In the Time-Based Refresh area, select Periodically from the When list 
and select 1 minute in the Time. 

 e Click OK.

 4 View Indicators by Status

You can filter the status indicators that are displayed in Google Earth to 
include specific statuses.

To view the indicators by status:

 a In the Places area, expand the HP Business Service Management 
folder.

 b Select the view you want to display. The folder displays the list of 
statuses of the CIs in the view.

 c Select one or more of statuses. Only the CIs with the selected statuses 
are displayed in Google Earth.
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How to Customize Virtual Earth

You can customize a Virtual Earth map using the following options. All the 
steps in this task are optional and can be performed in any order.

This task includes the following:

➤ "Adjust the Virtual Earth Map" on page 201

➤ "Specify the Size of the Indicators" on page 201

➤ "Specify the Statuses to Be Displayed" on page 202

➤ "Specify the Time Delay" on page 202

Adjust the Virtual Earth Map

You can zoom or shift the Virtual Earth map so that it shows the 
information you require. For details, see "Geographical Map Component 
User Interface" on page 205.

Specify the Size of the Indicators

You can modify the default size (19 pixels) of the indicators that are 
displayed on the Virtual Earth map.

To modify the size of the indicators, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Service 
Health Applications, and enter the indicator size (in pixels) in the Indicator 
size in Virtual Earth entry in the Service Health Application - Maps 
Management Properties table. 
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Specify the Statuses to Be Displayed

You can select the statuses you want to display in the Virtual Earth map.

To specify the statuses to be displayed, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Service 
Health Applications, and locate the Ignore gray statuses entry in the Service 
Health Application - Maps Management Properties table. Select one of the 
following options:

➤ ALL. Locations with gray statuses (downtime, stopped, no data and 
uninitialized) are not displayed on the map. 

➤ NO. Locations with gray status are displayed on the map.

Specify the Time Delay

You can modify the default time delay between the completion of new 
location download from the server and the display of the information by 
Virtual Earth (in seconds). Use larger values if user has slower connection.

To modify the time delay, select Admin > Platform > Setup and Maintenance 
> Infrastructure Settings, click Applications, select Service Health 
Applications, and locate the Wait after getting data entry in the Service 
Health Application - Maps Management Properties table. Enter the delay (in 
seconds). The default is 4. 
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How to Customize the Maps Applet

You can customize the Maps applet using the following options. All the 
steps in the task are optional and can be performed in any order.

This task includes the following:

➤ "Adjust the Maps Applet" on page 203

➤ "Specify the Map Refresh Rate" on page 203

➤ "Specify the Maximum Number of CIs Displayed in a Location’s Tooltip" 
on page 203

Adjust the Maps Applet

You can adjust the Maps applet so that it shows the required information. 
For details, see "Geographical Map Component User Interface" on page 205.

Specify the Map Refresh Rate

You can modify the map refresh rate. The default is 30 seconds. To modify 
the map refresh rate, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings:

➤ Select Applications.

➤ Select Service Health Applications.

➤ In the Service Health Application - Maps Management Properties table, 
locate the Maps Applet Refresh Rate entry. Change the refresh rate as 
needed.

Specify the Maximum Number of CIs Displayed in a Location’s 
Tooltip

You can specify the maximum number of CIs that can be displayed in the 
tooltip for a location in the Geographical Map. The default is 10. 

Keep in mind that the CIs are displayed in the Caused by section in the 
tooltip, so do not specify more than can be accommodated.
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To modify the maximum number of CIs displayed in a location’s tooltip, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings:

➤ Select Applications.

➤ Select Service Health Applications.

➤ In the Service Health Application - Maps Management Properties table, 
locate the Maximum CIs in tooltip for location entry. Enter the new 
maximum.
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Reference

Geographical Map Component User Interface

This component enables you to display real-time status indicators on a 
geographical map, with the view's CIs at the geographical locations they 
were assigned. The status indicator shows the worst status of the CIs at the 
geographical location. You can also access detailed information about the 
CI’s KPIs. 

To access Select Applications > Service Health > Geographical 
Map

Important 
information

The geographical map display can be rendered using:

➤ Virtual Earth. For details, see "Geographical Map in 
Virtual Earth" on page 206.

➤ A Maps applet. For details, see "Geographical Map in 
the Map Applet" on page 209.

➤ Google Earth. For details, see "Geographical Map in 
Google Earth" on page 211.

For details on choosing these displays, see "Select the 
display technology" on page 195.

Relevant tasks "How to Display and Customize a View in 
Geographical Map" on page 194

See also "Geographical Maps" on page 190
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Geographical Map in Virtual Earth

If you have an Internet connection, the geographical map is displayed by 
default using Microsoft MSN Virtual Earth (Version 4.0). Virtual Earth 
presents a flat geopolitical view of the planet where you can display only the 
country borders, only the geographical features, or both. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

See also "Understanding Virtual Earth" on page 192

UI Element (A-Z) Description

Click to zoom out completely.

Click to save changes to the geographical map display.

If you made changes to your map which you do not 
want to save, click to revert to the last saved version of 
the map.

Click to open the geographical map for the view using 
Google Earth.
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Enable you to zoom in and out to enlarge or shrink the 
map. 

Click to shift the center of the map to the nearest CI.

Click to zoom out completely.

<Adjustments> Click the map and drag to move the map in the 
window.

Double-click the map to zoom in.

<Status of a location> The geographical map of the view displays the worst 
status at each geographical location. 

The color coding is the same as for other icons in 
Service Health. For more information about color 
coding, see "KPI Status Colors and Definitions" on 
page 45. 

<Tooltip> Move the cursor above a status icon to display the 
location tooltip that provides the worst status for all 
KPIs associated with the location. A KPI is associated 
with a location if that KPI is assigned to at least one of 
the CIs attached to the location. 

The tooltip includes the following information:

➤ KPI Name. The name of the KPI. The color of the 
header indicates the worst status of the KPI.

➤ Location. The name of the location (country, city, 
and state, if applicable).

➤ Status. The status of the KPI.

➤ Held status since. The time and date when the KPI 
status changed to the current status.

➤ Caused by. The names of the CIs where the problem 
occurred.

UI Element (A-Z) Description



Chapter 5 • Geographical Map

208

Last Update Displays when the information in the component was 
last updated.

To manually update the information in the 
component, click the Refresh icon.

Road/Aerial/Bird’s 
Eye/Hybrid/Labels

Click:

➤ Road to display the map with the country borders.

➤ Aerial to display the map with the topographical 
features.

➤ Bird’s Eye (inactive)

➤ Hybrid to display the map with both the country 
borders and the topographical features.

➤ Labels to remove all labeling on the map other than 
CI status indicators.

Search Use this feature to perform a search in Microsoft MSN 
Virtual Earth (outside of HP Business Service 
Management). 

UI Element (A-Z) Description
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Geographical Map in the Map Applet 

If you do not have an Internet connection, the Geographical Map page 
displays a Maps applet graphic. The Map applet presents a flat geopolitical 
view of the planet. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

See also "Understanding the Maps Applet" on page 193

UI Element (A-Z) Description

Click to zoom out completely.

Click to save changes to the geographical map display.
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If you made changes to your map which you do not 
want to save, click to revert to the last saved version of 
the map.

Click to open the geographical map for the view using 
Google Earth.

 Enable you to zoom in and out to enlarge or shrink the 
map.

<Adjustments> Click the area that interests you. The map shifts to 
make the location you clicked the new center of the 
map.

<Status of a location> The geographical map of the view displays the worst 
status at each geographical location. 

The color coding is the same as for other icons in 
Service Health. For more information about color 
coding, see "KPI Status Colors and Definitions" on 
page 45.

<Tooltip> Move the cursor above a status icon to display the 
location tooltip that provides the worst status for all 
KPIs associated with the location. A KPI is associated 
with a location if that KPI is assigned to at least one of 
the CIs attached to the location. 

The tooltip includes the following information:

➤ KPI Name. The name of the KPI. The color of the 
header indicates the worst status of the KPI.

➤ Location. The name of the location (country, city, 
and state, if applicable).

➤ Status. The status of the KPI.

➤ Held status since. The time and date when the KPI 
status changed to the current status.

➤ Caused by. The names of the CIs where the problem 
occurred.

UI Element (A-Z) Description
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Geographical Map in Google Earth

Displays the worst status at each geographical location and detailed 
information about the CI’s KPIs. Google Earth presents a three-dimensional 
view of the planet. When you magnify the view, the main cities appear for 
the part of the map that is displayed on the screen.

Important 
information

Note to HP Software-as-a-Service: This feature is not 
available when working with HP Software-as-a-Service.

See also "Understanding Google Earth" on page 191

"How to Display a Geographical Map With Google 
Earth" on page 198
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

<Places area> Select the view and filter the CIs you want to display.

<Status of a location> The geographical map of the view displays the worst 
status at each geographical location. 

The map presents color-coded status indicators that 
represent the worst status at each geographical 
location. The color coding is the same as for other 
icons in Service Health. For more information about 
color coding, see "KPI Status Colors and Definitions" on 
page 45.

<Tooltip> Move the cursor above a status icon to display the 
location tooltip that provides the worst status for all 
KPIs associated with the location. A KPI is associated 
with a location if that KPI is assigned to at least one of 
the CIs attached to the location. 

The tooltip includes the following information:

➤ KPI Name. The name of the KPI. The color of the 
header indicates the worst status of the KPI.

➤ Location. The name of the location (country, city, 
and state, if applicable).

➤ Status. The status of the KPI.

➤ Held status since. The time and date when the KPI 
status changed to the current status.

➤ Caused by. The names of the CIs where the problem 
occurred.

<Zoom and direction 
tools>

Enables you to zoom in or out of the current display.
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6
Custom Image

This chapter includes:

Concepts

➤ Custom Image - Overview on page 214

Tasks

➤ How to Display a View in a Custom Image on page 216

Reference

➤ Custom Image Component User Interface on page 218
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Concepts

Custom Image - Overview

The Custom Image component enables you to associate a view’s CIs 
represented by real-time status indicators with a custom image that 
describes the real world that your view represents. The graphical 
representation of a view used by your organization can be a logical network 
diagram, business logic, or any other graphic image.

For example, you can associate a graph representing your company’s 
network with real-time data coming from different parts of the network.

One custom image can be defined for each view. The image shown is the 
one defined for the active view. When you select a different view, the 
corresponding image is automatically displayed. If you do not define a 
custom image for a view, users accessing the Custom Image component see a 
message stating that there is no defined image for the view.
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Working With Custom Images
You work with Custom Images in two stages:

 1 Within Service Health Administration, you associate an image with a 
view, and specify where each CI is located in the image. For details, see 
"Custom Image Administration" on page 489.

 2 You can then access the Custom Image application component, and see 
the CI statuses in the view, within your custom image. For details on the 
custom image user interface, see "Custom Image Component User 
Interface" on page 218.

Note: When a CI is removed from the IT universe model, the corresponding 
CI icon (in Service Health Administration) and the corresponding status 
indicators (in Service Health) are automatically removed from the relevant 
custom images.
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Tasks

How to Display a View in a Custom Image

Within Service Health Administration, assign a custom image to a view, and 
add CIs to the image, as described in "How to Assign a Custom Image to a 
View" on page 491.

After you have created a custom image, display it in the Service Health 
Custom Image component. Open the view for which you defined a custom 
image, and monitor the CI’s status in the appropriate location in the 
diagram.

Example – View a Custom Image

A custom image display the status of each element in the network:
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Example – Different Styles of Images

Other examples of custom images can be:
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Reference

Custom Image Component User Interface

This component enables you to display a custom image for a selected view 
including the view's CIs represented by real-time status indicators and a 
background custom image. 

The custom image is defined in Service Health Administration. For details, 
see "Custom Image Administration" on page 489.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Select Applications > Service Health > Custom Image

Relevant tasks "How to Display a View in a Custom Image" on 
page 216

See also "Custom Image - Overview" on page 214

<status indicator> The status indicator indicates the worst status (worst of 
all KPIs) of the CI. The status indicator can be a 
standard status icon, or a CI type icon with status 
colors, as defined for the custom image.

For details on the statuses, see "KPI Status Colors and 
Definitions" on page 45.
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<Tooltip> Move the cursor above the status icon of the CI to 
display additional information about each KPI 
attached to the CI in a separate section. The tooltip 
associated with a CI status indicator displays 
information about each KPI attached to the CI in a 
separate section. The color of each section represents 
the color of the corresponding KPI’s status. For details 
on the colors, see "KPI Status Colors and Definitions" 
on page 45.

The tooltip can display any of the following 
information, depending on the KPI:

➤ the header of each section displays Details followed 
by the name of the KPI.

➤ CI name. The name of the CI.

➤ Status. The status of the KPI.

➤ Held status since. The date and time when the status 
changed to the current status.

➤ Historical worst. The tooltip of the historical status 
of the CI. For details, see "KPI Trend and History 
Calculation" on page 408.
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7
360° View

This chapter includes:

Concepts

➤ 360° View Overview on page 223

➤ Hierarchy Component Overview on page 224

➤ Business Impact Component Overview on page 226

➤ Business Impact Rating Calculation on page 226

➤ Health Indicator Component Overview on page 228

➤ Understanding the Health Indicator Tooltips on page 229

➤ Alerts Component Overview on page 232

➤ Changes and Incidents Component Overview on page 233

Tasks

➤ How to Customize the Hierarchy Component on page 234

➤ How to Set Up Sound Notification When KPIs in Hierarchy are Critical 
on page 237

➤ How to Create a Quick Hierarchy Filter on page 239

➤ How to Create an Advanced Hierarchy Filter on page 240

➤ How to Manage Advanced Hierarchy Filters on page 243

➤ How to Customize the Business Impact Component on page 245

➤ How to Modify Which CITs are Displayed in the Business Impact 
Component on page 247

➤ How to Modify Which CI Relationships are Displayed in the Business 
Impact Component on page 248
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➤ How to Customize the Business Impact Rating Calculation Method 
on page 248

➤ How to Work with the Health Indicator Component on page 252

➤ How to Customize the Alerts Component on page 254

➤ How to Customize the Changes and Incidents Component on page 255

Reference

➤ 360° View User Interface on page 256
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Concepts

360° View Overview

The 360° View page contains the Hierarchy component which provides KPI 
data regarding the CIs in a selected view. If you select a CI within the 
Hierarchy component you can see its detail links; when you click the detail 
links, you can access additional components which provide comprehensive 
data regarding the CI.

The following components can be accessed from the 360° View page:

➤ Hierarchy. Displays a hierarchy of CIs in a view, the KPIs assigned to each 
CI, and their KPI statuses. For details, see "Hierarchy Component 
Overview" on page 224.

➤ Business Impact. Displays business CIs and SLAs that are impacted by the 
CI selected in the active view. In addition, an icon shows how much of an 
impact the CI has on monitored business CIs and SLAs. For details, see 
"Business Impact Component Overview" on page 226.

➤ Health Indicators. Displays details regarding the health indicators (HIs) 
that are used to calculate and set the status of the CI selected in the active 
view. For details, see "Health Indicator Component Overview" on 
page 228.

➤ Alerts. Displays CI status alerts triggered by the CI selected in the active 
view. For details, see "Alerts Component Overview" on page 232.

➤ Changes and Incidents. Displays incidents opened for the CI selected in 
the active view, as well as requests for change and actual changes made to 
the CI. For details, see "Changes and Incidents Component Overview" on 
page 233.
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Hierarchy Component Overview

The Hierarchy component displays a hierarchy of CIs in a view, the KPIs 
assigned to each CI, and their KPI statuses. When you select a CI in the 
Hierarchy component, its CI details are displayed. You can then click the 
detail links to display additional information regarding the selected CI.

For customization options, see "How to Customize the Hierarchy 
Component" on page 234. 

For user interface details, see "Hierarchy Component User Interface" on 
page 258.

This section also includes the following topics:

➤ "Hierarchy Columns" on page 224

➤ "Filtering CIs in the Hierarchy Display" on page 225

➤ "Drilling Down to CI Details" on page 225

Hierarchy Columns
The Status column shows the worst status held by each CI’s KPIs.

The Business Impact column shows each CI’s business impact, using a rating 
from zero (no impact) to 5 (high impact). The rating shows how much of an 
impact the CI has on the business CIs and SLAs in your monitored 
environment. For details, see "Business Impact Rating Calculation" on 
page 226.

The KPI columns display KPI status for each CI; when you select a CI its KPI 
trend and history are also displayed. For details, see "KPI Trend and History 
Calculation" on page 408.

Within the Hierarchy component, KPIs are sorted by domains. Domains are 
groups of KPIs that monitor similar functions; for example the Network 
domain contains the Network Availability and Network Performance KPI. 
You can display all KPIs, the worst KPI in a domain, or only show domains 
that are of interest to you. For details see "KPI Domains" on page 411.
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You can also acknowledge problems on CIs in the Hierarchy component, to 
help you keep a record of when a problem was acknowledged and by which 
user. For details, see "Acknowledge Problems" on page 327.

Filtering CIs in the Hierarchy Display
You can also use the Hierarchy filter to focus on operational status of 
specific segments of your business. If you activate a filter, the component 
displays only those CIs which have at least one KPI with the status specified 
in the filter. For details, see "How to Create a Quick Hierarchy Filter" on 
page 239 and "How to Create an Advanced Hierarchy Filter" on page 240.

Drilling Down to CI Details
When you select a CI in the Hierarchy component, CI details are displayed. 
You can click detail links to access the following information about the 
selected CI:

➤ Business Impact. Displays business CIs and SLAs that are impacted by the 
CI selected in the active view. For details, see "Business Impact 
Component Overview" on page 226.

➤ Health Indicators. Displays details regarding the health indicators (HIs) 
that are used to calculate and set the status of the CI selected in the active 
view. For details, see "Health Indicator Component Overview" on 
page 228.

➤ Alerts. Displays CI status alerts triggered by the CI selected in the active 
view. For details, see "Alerts Component Overview" on page 232.

➤ Changes and Incidents. Displays incidents opened for the CI selected in 
the active view, as well as requests for change and actual changes made to 
the CI. For details, see "Changes and Incidents Component Overview" on 
page 233.
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Business Impact Component Overview

The Business Impact component enables you to see the business CIs and 
SLAs that are impacted by the CI selected in the active view.

In addition, a bar icon indicates each CI’s business impact, using a rating 
from zero (no impact) to 5 (high impact). This rating shows how much of an 
impact the CI has on the business CIs and SLAs in your monitored 
environment, helping you to prioritize your tasks when problems are 
detected. For details on this rating, see "Business Impact Rating Calculation" 
on page 226.

The following impacted CI types are monitored by default: Business 
Services, Business Processes, and Applications. For details on how to 
customize business impact information, see "How to Customize the Business 
Impact Component" on page 245.

From this component you can also access the selected CI’s corresponding 
Business Impact Report. For details, see "Business Impact Report" on page 92.

For user interface details, see "Business Impact Component User Interface" 
on page 268.

Business Impact Rating Calculation

Within the Business Impact component, a bar icon indicates each CI’s 
business impact, using a rating from zero (no impact) to 5 (high impact).

Within the monitored environment represented by the RTSM, a CI can 
impact business entities and SLAs, either via a direct Impact link to them, or 
if one of the CI's ancestors is a business entity or SLA. If a CI impacts 
another CI, all its descendants also impact the CI.
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How the Business Impact Rating is Calculated
The business impact rating can be calculated based on the following metrics:

➤ The criticality of the impacted business CIs, as defined by the Criticality 
attribute on these CIs.

➤ The number of business services impacted by the CI.

➤ The number of SLAs impacted by the CI.

By default, the rating is calculated based on the average of each of these 
metrics. For example, if the individual ratings (criticality, number of 
business CIs, and number of SLAs) are 2,3, and 4, the business impact rating 
of the CI is 3.

If you choose to only use the criticality factor, the impact is calculated as 
follows: Within the RTSM, each business CI can have a BusinessCriticality 
attribute defined, with a value of 1-5. If a CI has an impact on one or more 
CIs that have this attribute defined, the CI’s business impact rating is the 
highest criticality of the CIs that it impacts.

For example, if CI-a has Impact links to CI-b and CI-c, and these two CIs 
have a criticality of 1 and 3 respectively, the business impact rating for CI-a 
displayed in the Business Impact component is 3, based on the highest 
criticality of the CIs that it impacts.

You can also choose to calculate the rating based on the number of 
impacted business entities or SLAs. For example, if you choose SLAs only, 
the rating is based on the number of SLAs a CI impacts, divided by the 
number of SLAs in the RTSM. This is then translated to a rating of 1-5. For 
example, if a CI impacts 2 SLAs out of 10 SLAs in the model, (20% of the 
SLAs), this translates to a rating of 1 (out of 5) on the business impact rating 
scale.
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Customizing the Business Impact Rating
You can customize how the business impact rating is calculated by:

➤ Including or excluding any of the above metrics (criticality, number of 
business CIs, or SLAs) in the calculation.

➤ Calculating criticality based on average criticality, or highest criticality 
(default).

➤ Assigning each metric a specific weight; for example you can make one of 
the metrics more significant in the calculation than the others.

➤ Assigning thresholds to the metrics that count business entities and SLAs, 
so that instead of calculating based on simple average, different values are 
used.

For example, if you choose to calculate the rating based on the number of 
impacted SLAs, and a CI impacts 2 SLAs out of 10 SLAs in the model, the 
CI has a rating of 1 (out of 5) on the rating scale.

However, you can define custom thresholds so that if a specific number of 
CIs or SLAs are impacted by a CI, this is mapped to a specific rating (for 
example, 5 CIs can be mapped to a rating of 3), helping you to define the 
rating system to fit your needs.

These customizations are defined within an XML file in the infrastructure 
settings, as described in "How to Customize the Business Impact Rating 
Calculation Method" on page 248.

Health Indicator Component Overview

The Health Indicator component displays details regarding the health 
indicators that are used to calculate and set the current status of a selected 
CI. Each health indicator’s status and value are displayed. The component 
displays the health indicators grouped by two categories: health indicators 
that are used to calculate KPIs, and health indicators that are not used in 
any KPI calculation. 

For an introduction to health indicators, see "Health Indicators and KPIs - 
Overview" on page 115.
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Within Service Health, you can access the Health Indicator component via 
the Show > HIs menu command from a CI.

➤ For details on working with the Health Indicator component, see "How to 
Work with the Health Indicator Component" on page 252. 

➤ For details on the Health Indicator component user interface, see "Health 
Indicator Component User Interface" on page 271.

Note: When a metric-based HI generates an event, the Health Indicator 
component and the Event Console show the same date and time for the HI’s 
status change. If this HI also generates a change in a KPI, the KPI shows this 
date and time for the KPI change as well.

When an event-based HI is created, the HI and Event Console display the 
same date and time. However, if the HI generates a change in a KPI, the KPI 
shows a delay of a few seconds until it is updated with the data from the HI.

Understanding the Health Indicator Tooltips

The content and structure of an HI’s tooltip depends on the its data source:

➤ Metric-based HI. When an HI is based on sample data, the HI tooltip 
fields correspond to the business rule which calculates the HI. For details 
on the tooltips for each rule, see "List of Calculation Rules in Service 
Health" on page 740.

➤ Event-based HI. When an HI is based on events, the tooltip shows 
information on the specific event which contributed to the HI’s latest 
status change. For details, see "Event-Based HI Tooltip Fields" on page 273.

When an HI is impacted by several events (for example in CIs monitored 
by SiteScope), the tooltip displays general information regarding the 
events and their severities. The Affected By field shows a list of the 
measurements which influenced the HI. When an HI is in OK status, no 
event data is displayed. The tooltip shows the events which have the 
same status as the HI itself.
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Note: If you restart the Business Logic Engine, the data in the tooltip is reset.

This section also includes the following topics:

➤ "Examples of HI tooltips impacted by several events" on page 230

➤ "Rule parameters influencing the HI tooltip" on page 232

Examples of HI tooltips impacted by several events
In the following image, two SiteScope monitors are monitoring disk 
utilization on two disks, on a single server. The System Performance KPI is 
fed by the Host Disk Utilization HI, which is fed by both of these monitors. 
(The image focuses on the relevant areas.)
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In this example, the HI is critical, and one of the two events feeding the HI 
is critical. The tooltip shows 1 out of 1 influencing events, meaning one of 
the events which influences this HI has the same status as the HI.

In the following image, the severity of the monitor that had been Critical 
has changed to Minor:

The HI changes to Minor as well. Since both of the events feeding the HI are 
Minor, the tooltip shows 2 out of 2 influencing events.

In the above examples, the subcategory of the events feeding the HI is 
percent full; this subcategory is displayed in the tooltip for each influencing 
event.
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Rule parameters influencing the HI tooltip
Event-based HIs are calculated by the Generic Health Indicator Sub-
component rule. By default, this rule uses the following rule parameters 
which influence the tooltip’s behavior; modifying these defaults increases 
memory usage.

➤ clearNormalStatuses. By default, events with Normal status are not 
included in event-based HI calculation.

➤ reportNormalStatusesEvents. By default, events with Normal status are 
not displayed in event-based HI tooltips. Note that if the setting of 
clearNormalStatuses is false, the setting of reportNormalStatusesEvents is 
ignored.

➤ maxNumOfDisplayedEvents. By default, up to 8 events can be displayed 
in an event-based HI tooltip. As a result, if there are 10 events which 
influence an HI, by default the HI’s tooltip will list 8 out of 10 influencing 
events.

Alerts Component Overview

The Alerts component enables you to see the CI status alerts triggered by the 
CI selected in the active view. 

To view information on the action taken following the alert, you can access 
the selected CI’s Status Alerts Report directly from this component. For 
details, see "CI Status Alerts Reports" on page 285.

For customization options, see "How to Customize the Alerts Component" 
on page 254. 

For user interface details, see "Alerts Component User Interface" on 
page 274.
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Changes and Incidents Component Overview

This component enables you to see the incidents opened for the CI selected 
in the active view, as well as requests for change and actual changes made to 
the CI.

The following information is displayed:

➤ Incidents and Requests for Change. Information on incidents and 
requests for change is collected from RTSM Federation Adapters. 
Federation adapters may be set up within HP Business Service 
Management (such as the out-of-the-box adapter History Data Source), or 
outside HP Business Service Management (such as Release Control or 
HP Service Manager). 

For details on setting up federation, see "Federation Framework Overview" 
in the RTSM Developer Reference Guide. For details on the integration with 
HP Service Manager, see "How to Integrate HP Service Manager  with 
Business Service Management Components" in Solutions and Integrations.

➤ Actual Changes. Information on actual changes is collected for CIs on the 
local machine, directly from the RTSM. The types of changes displayed 
are History Attribute Change, and History Relation Change. 

Attribute changes are displayed for each attribute marked as Change 
Monitored. For details, see "Add/Edit Attribute Dialog Box" in the 
Modeling Guide. 

Relationship changes are displayed if a relationship has been defined with 
a TRACK_LINK_CHANGES qualifier. For details, see "Qualifiers Page" in the 
Modeling Guide.

For customization options, see "How to Customize the Changes and 
Incidents Component" on page 255. 

For user interface details, see "Changes and Incidents Component User 
Interface" on page 276.
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Tasks

How to Customize the Hierarchy Component

You can customize the Hierarchy component using the following options:

➤ "Select a view for display" on page 234

➤ "Filter which CIs are displayed" on page 234

➤ "Display filtered CIs in a hierarchy or list format" on page 235

➤ "Select specific KPIs and CI acknowledgement for display" on page 235

➤ "Display all KPIs or group KPIs by domains" on page 236

➤ "Personalize the Hierarchy component per user" on page 236

➤ "Modify the refresh rate" on page 236

➤ "Modify the number of levels displayed in the Hierarchy component" on 
page 237

➤ "Display children collapsed in the Hierarchy component" on page 237

Select a view for display

The Hierarchy component has a built-in view selector.

Select a view from the view selector to display KPI data for the CIs in the 
view.

Filter which CIs are displayed

The Hierarchy component has a filter mechanism that enables you to 
display only those CIs that have at least one KPI in a given status. You can 
create a quick filter based on KPI status, or an advanced filter based on 
statuses of specific KPIs, and CI types.

For details, see "How to Create a Quick Hierarchy Filter" on page 239, and 
see "How to Create an Advanced Hierarchy Filter" on page 240.
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Display filtered CIs in a hierarchy or list format

When filtering is active, you can choose to display the CIs that fill the filter 
conditions within a hierarchical structure (in the context of their parent 
CIs), or in a list format (without displaying their parent CIs).

Click the Filter Hierarchial Mode button to display the CIs within a 
hierarchical structure, or click the Filter Flat Mode button to display the CIs 
that fill the filter conditions in a list format.

Select specific KPIs and CI acknowledgement for display

By default, each of the KPIs in the view is displayed in a separate column. To 
remove KPIs from the display, click the Select Columns button. In the Select 
Columns dialog box, use the arrows to add or remove KPIs from the display.

This can be done for the Acknowledgement column as well; for details, see 
"How to Acknowledge Performance Problems" on page 329.

Tip: This type of KPI selection is only for the Hierarchy display. To remove a 
KPI from all Service Health components, access Service Health 
Administration > View Builder. Right-click a view in the View Selector, and 
select Properties. In the popup window, deselect the KPI in the Include in 
View list. For details, see "How to Add or Remove KPIs Within a View" on 
page 386.
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Display all KPIs or group KPIs by domains

Within the Hierarchy display, KPIs are grouped by domains; for example, 
the Application domain contains the Application Performance KPI and 
Application Availability KPI. For details, see "KPI Domains" on page 411.

You can view the status of all of the KPIs separately, or you can collapse a 
domain to view the worst status of all the KPIs in the domain. To collapse or 
expand a domain, click the - and + signs next to the domain name.

Personalize the Hierarchy component per user

The following changes can be made in the Hierarchy component and are 
saved for future sessions (per user, per component):

➤ column order

➤ column width

➤ visible/hidden columns

➤ collapsed/expanded KPI domains

➤ collapsed/expanded CIs

➤ sound on/off (if sound mode is set to True; see "How to Set Up Sound 
Notification When KPIs in Hierarchy are Critical" on page 237.)

If you make changes in a user-defined page, click Save to retain the changes 
in the current session. To save your settings in future sessions, click Logout 
when you are ready to exit the browser. (If you close the browser without 
logging out, your changes are not saved.)

Modify the refresh rate

By default, the Hierarchy component is refreshed every 5 seconds. 

If you are using the Hierarchy component outside the 360° View, you can 
modify the refresh rate using the Preferences button in the component 
toolbar (in the upper right area of the component).

In the 360° View you cannot modify the refresh rate.
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Modify the number of levels displayed in the Hierarchy 
component

By default, the Hierarchy component displays two levels of hierarchy 
display. For example, when you select a view, the component displays the 
view name (as the hierarchy root), and its top-level CIs. When you drill 
down from a selected CI, the selected CI is displayed as the root, and its 
child CIs are also shown.

To modify the number of levels that can be displayed in the Hierarchy 
component, drill down to the following: Admin > Platform > Setup and 
Maintenance > Infrastructure Settings > Applications, and select Service 
Health Application.

Locate the Business Console - Number of display levels entry in the Service 
Health Layout Properties table. You can select a value between 1 and 4. If 
you specify 1, the child CIs are displayed but cannot be expanded.

Display children collapsed in the Hierarchy component

To display child CIs collapsed rather than expanded (by default), drill down 
to the following: Admin > Platform > Setup and Maintenance > 
Infrastructure Settings > Applications, and select Service Health Application. 

In the Service Health Application - Service Health Layout Properties table, 
change the value of the Hierarchy - Default state property to collapsed.

How to Set Up Sound Notification When KPIs in 
Hierarchy are Critical

You can set up Service Health to play an alert sound when the status of a KPI 
changes to Critical in the Hierarchy component.

When a view is loaded for the first time, no sound is played for the KPIs that 
are loaded at Critical status.
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When the sound is switched on, a sound alert is played when a KPI in the 
view changes status to Critical (red). The Critical status icon flashes until 
you roll your mouse over it. If a CI in a hidden part of the view has changed 
to Critical but does not change the status of any of the CIs in the currently 
displayed branches, no sound is heard.

This task includes the following steps:

➤ "Permanently enable or disable sound notification" on page 238

➤ "Temporarily mute or restore sound notification" on page 238

➤ "Modify the alert sound" on page 238

Permanently enable or disable sound notification

Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Service Health Application, and locate the Sound 
Notification entry in the Service Health Application - Sound Notification 
table. Modify the value to true to enable the sound notification or to false to 
disable it. The change takes effect immediately.

Temporarily mute or restore sound notification

You can temporarily turn the sound option on or off using the Sound On/Off 
button in the Hierarchy toolbar. For details, see "Changes and Incidents 
Component User Interface" on page 276.

Modify the alert sound

The alert sound is an mp3 file downloaded by the browser. 

To use another alert sound for Service Health, if you have administrative 
permissions, access <Gateway server root directory>\AppServer\ 
webapps\site.war\static\dash\sounds and replace the ding.mp3 file with 
your own .mp3 file (you must rename your file ding.mp3). The change takes 
effect after you clear your browser cache.
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How to Create a Quick Hierarchy Filter

The Hierarchy component has a quick filter mechanism that enables you to 
display only those CIs that have at least one KPI in a given status. This 
creates a temporary filter that persists until you log off, until you change the 
selection of statuses, or until you select another filter. The filter returns all of 
the CIs in the view which fill the filter conditions.

➤ To temporarily display only those CIs whose KPIs have specific statuses, 
click the Filter button in the Hierarchy toolbar, select one or more statuses 
in the filter bar that opens, and click Filter.

➤ To disable filtering, click the Remove Filter button.

Tip: You can also create a more complex filter, which enables you to filter 
statuses of specific KPIs and CI types, and to create permanent filters. For 
details, see "How to Create an Advanced Hierarchy Filter" on page 240.

Example:

Without filtering, the Hierarchy component includes all KPI statuses.
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To temporarily display only those CIs whose KPIs have Minor statuses, click 
the Filter button, select the Minor status icon in the filter bar, and click 
Filter.

The Hierarchy display now includes only those CIs whose KPIs have Minor 
status.

How to Create an Advanced Hierarchy Filter

Advanced filters enable you to focus on specific problematic areas by 
filtering CIs according to specific KPI statuses, using either temporary or 
permanent filters. For example, the predefined Show Errors filter displays 
only those CIs which have one or more KPIs in Critical status.

You can also create an advanced filter which combines filtering according to 
both KPI status, and CI type. For example, you can create a filter that only 
shows hosts (Node CIT) with one or more KPIs in Critical status.

The filter returns all of the CIs in the view which fill the filter conditions.

 1 To create a temporary advanced filter, click the Filter button in the 
Hierarchy toolbar, and then click Advanced in the filter bar.

To create a permanent advanced filter, click the Favorite Filters Menu 
button, and then click New.
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 2 In the Status Selection pane, select check boxes for each KPI status that 
you want to include in the filter.

 3 (Optional) In the Type Selection pane, select a CI type to filter which CIs 
will appear in the Hierarchy display. 

If you select a higher-level CIT, its descendant CITs are included in the 
filter as well.

 4 To activate a temporary filter, click Filter.

To activate a filter and save its settings, click Filter and Save.

For details on how to work with advanced filters, see "How to Manage 
Advanced Hierarchy Filters" on page 243.

For user interface details, see "Defining/Editing Filters Dialog Box" on 
page 265.
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Example:

The Worst Hosts filter shown below is created to display only those CIs 
whose CIT is Node, with at least one KPI in Critical status.
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How to Manage Advanced Hierarchy Filters

The Favorite Filters list in the Hierarchy component toolbar contains 
predefined filters (labeled global:) and any additional advanced filters that 
you create and save. The currently active filter is displayed in the Favorite 
Filters box. If no filter is currently active, this box displays the text [Select 
Filter].

For details on how to create an advanced filter, see "How to Create an 
Advanced Hierarchy Filter" on page 240.

For user interface details, see "Defining/Editing Filters Dialog Box" on 
page 265.

You can perform the following actions to manage advanced filters:

➤ "Change the active filter" on page 243

➤ "Create a temporary advanced filter" on page 243

➤ "Create a permanent advanced filter" on page 243

➤ "Clone and edit a filter" on page 244

➤ "Edit or delete a custom filter" on page 244

Change the active filter

To change the active filter, select a different filter from the Favorite Filters 
box.

Create a temporary advanced filter

To create a temporary advanced filter, click the Filter button in the 
Hierarchy toolbar, and then click Advanced in the filter bar. After defining 
the filter, click Filter.

Create a permanent advanced filter

To create a permanent advanced filter, click the Favorite Filters Menu 
button, and then click New. After defining the filter, click Filter and Save.



Chapter 7 • 360° View

244

Clone and edit a filter

To use an existing filter as the basis for a new filter, select the filter name in 
the Favorite Filters box. Click the Favorite Filters Menu button, and then 
click Clone. Give the new filter a relevant name, and modify its settings as 
needed.

Edit or delete a custom filter

To edit or delete a custom filter, select the filter name in the Favorite Filters 
box. Click the Favorite Filters Menu button, and then click Edit or Delete. 

Predefined filters cannot be edited or deleted.

➤ To disable a temporary filter, click the Remove Filter button. 

➤ To disable a permanent filter, select [Select Filter] in the Favorite Filters 
box.
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How to Customize the Business Impact Component

You can customize the Business Impact component using the following 
options:

➤ "Select CIs for display in the Business Impact component" on page 245

➤ "Modify duration settings" on page 245

➤ "Modify refresh rates" on page 246

➤ "Modify which CITs and CI relationships are monitored by the Business 
Impact component" on page 246

➤ "Customize how the business impact rating is calculated" on page 246

Select CIs for display in the Business Impact component

If your workspace contains a component where you can select CIs (such as 
Model Explorer, Top View, Topology Map, or Hierarchy), and also contains 
the Business Impact component, you can select a CI to display its business 
impact. For details, see "Service Health Workspace" on page 81.

If you want to use the Business Impact component independent of other 
components, you can select a CI from within the component itself. Click 
the Filter button in the Business Impact component toolbar, and then click 
Configuration Items. Open a view within the Configuration Items dialog 
box, and select a CI to display its business impact data.

Modify duration settings

By default, the Business Impact component displays data for the previous 
week. You can change this setting to previous week, day, or hour (up to the 
current time).

➤ If you are using the Business Impact component outside of the 360° View 
page, click the Filter button in the component toolbar (in the upper right 
area of the component), and enter the new duration setting.

➤ If you are drilling down to Business Impact from the Hierarchy 
component, click the Filter button in the Hierarchy component toolbar 
and enter the new duration setting. This setting is shared by all of the 
Hierarchy CI detail drill-downs.
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Modify refresh rates

By default, the component is refreshed every five minutes. To modify this 
refresh rate, click the Preferences button in the component toolbar (in the 
upper right area of the component) and enter the new refresh rate.

Modify which CITs and CI relationships are monitored by the 
Business Impact component

By default, the Business Impact component can show the following CI types 
(CITs), if they have an Impact relationship with the selected CI: Business 
Services, Business Processes, and Applications.

These settings can be modified, as described in "How to Modify Which CITs 
are Displayed in the Business Impact Component" on page 247, and "How 
to Modify Which CI Relationships are Displayed in the Business Impact 
Component" on page 248.

Customize how the business impact rating is calculated

By default, the business impact rating is based on the criticality of impacted 
business CIs. This rating can also be calculated based on the number of 
impacted business CIs and SLAs; you can also assign each metric relative 
weights and thresholds. For details, see "How to Customize the Business 
Impact Rating Calculation Method" on page 248.
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How to Modify Which CITs are Displayed in the Business 
Impact Component

By default, the Business Impact component can show the following CI types 
(CITs), if they are have an Impact relationship with the selected CI: Business 
Services, Business Processes, and Applications.

The following section describes how to modify which CITs can be displayed 
in the Business Impact component.

Note: If you make changes using the following procedure, these changes are 
also reflected in the Business Impact Report. For example, if you add a CIT 
to be displayed in the Business Impact component, this CIT also appears in 
the Business Impact Report. For details on this report, see "Business Impact 
Report" on page 92.

 1 Select Admin > RTSM Administration > Modeling Studio. In the Resources 
tab, select Queries, and open the SearchForBusinessImpact query.

Within this query, the ITU_Triggered node represents the CI selected in a 
view, and the Business_Impacted node represents the CITs which can be 
impacted by this CI.

 2 Right-click the Business_Impacted node and select Node Element 
Properties to open the Node Element Properties dialog box. 

Within the Attribute tab, modify the query to add or remove CITs. When 
modifying the query, use an Or relationship between CIs, rather than an 
And relationship. For details, see "How to Define a TQL Query" in the 
Modeling Guide.

Note: Do not change the name of the SearchForBusinessImpact query, or 
the name of the ITU_Triggered node.
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How to Modify Which CI Relationships are Displayed in 
the Business Impact Component

By default, the Business Impact component can show the following CI types 
(CITs), if they are have an Impact relationship with the selected CI: Business 
Services, Business Processes, and Applications.

The following section describes how to modify which relationships are 
displayed in this component.

Note: If you make changes using the following procedure, these changes are 
also reflected in the Business Impact Report. For example, if you add a CIT 
to be displayed in the Business Impact component, this CIT also appears in 
the Business Impact Report. For details on this report, see "Business Impact 
Report" on page 92.

 1 Select Admin > RTSM Administration > Modeling Studio. In the Resources 
tab, select Queries, and open the SearchForBusinessImpact query.

 2 Right-click the Virtual Compound relationship and select Edit Compound 
Relationship. Within the Edit Compound Relationship dialog box, modify 
the relationships monitored by the query. For details, see "Compound 
Relationship" in the Modeling Guide.

How to Customize the Business Impact Rating 
Calculation Method

By default, the business impact rating is based on the average of three 
metrics: criticality, number of business CIs, and number of SLAs. For an 
overview of this rating system, see "Business Impact Rating Calculation" on 
page 226.

To customize how the business impact rating is calculated, access the 
following: Admin > Platform > Setup and Maintenance > Infrastructure 
Settings > Applications > Business Impact Service.
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Open the Configuration XML file for editing. Within the XML file, each 
section beginning with metric id defines one of the calculation options, as 
follows:

➤ metric id="BasedOnNumOfBusinessEntities". This defines the parameters 
used to calculate CI impact, based on the number of business CIs that a CI 
impacts.

➤ metric id="BasedOnNumOfSLAs". This defines the parameters used to 
calculate CI impact, based on the number of SLAs that a CI impacts.

➤ metric id="BasedOnCriticality". This defines the parameters used to 
calculate CI impact, based on the criticality of the business CIs that a CI 
impacts.

You can perform the following customizations to modify how the ratings 
are calculated:

➤ "Define which metrics are used in the calculation" on page 249

➤ "Calculate based on highest degree of criticality or on average criticality" 
on page 250

➤ "Define relative weights for each of the metrics used in the calculation" on 
page 250

➤ "Assign thresholds to the metrics that count impacted business CIs and 
SLAs" on page 251

Define which metrics are used in the calculation

Within one of the lines beginning with metric id, locate the string 
weight="<value>". If this value is zero, the metric is not used in calculating 
the rating; if this value is 1, the factor is used to calculate the rating.

For example, by default: metric id="BasedOnNumOfSLAs" 
class="com.hp.am.bac.bis.evaluators.calculators.CalculatorBasedOnNumOfSL
As" weight="1">. This means that the number of SLAs that a CI impacts is 
included in the business impact rating.

Modify these weights to include (1) or exclude (0) specific metrics in the 
calculation.
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Calculate based on highest degree of criticality or on average 
criticality

By default, the business impact rating is based on the highest degree of 
criticality of the impacted business CIs. You can modify which rule is used 
to calculate the rating based on criticality, and use average criticality 
instead.

Locate the line beginning with metric id="BasedOnCriticality" ruleId="1". 
The string ruleId="1" defines that the highest degree of criticality is used to 
calculate the rating. 

To calculate the rating based on the average criticality of business CIs that 
are impacted by the CI, modify this to ruleId="3".

Define relative weights for each of the metrics used in the 
calculation

If you include more than one metric in the calculation, you can assign 
relative weights to each metric.

Within one of the lines beginning with metric id, locate the string 
weight="<value>". This value defines the relative weight of each metric in 
the overall calculation, so that if you define the weight of one metric as 1, 
and of another metric as 2, the first metric defines 1/3 of the overall rating 
and the second metric defines 2/3 of the overall rating.

For example, suppose you define that ratings are based on criticality with a 
weight of 5, and on the number of SLAs with a weight of 2. If a given CI’s 
rating based on criticality alone would be 4, and based on SLAs alone would 
be 1, the overall rating is calculated as (4x5) + (1x2) / 7 = 3.14. The business 
impact rating is therefore 3 (medium).



Chapter 7 • 360° View

251

Assign thresholds to the metrics that count impacted business 
CIs and SLAs

By default, if you choose to calculate the rating based on the number of 
impacted business CIs or SLAs, the rating is based on the percentage of 
impacted CIs from the total number of relevant CIs in your environment. 
For example, if a CI impacts 2 SLAs out of 10 SLAs in the model, the CI has a 
rating of 1 (or 20% on the rating scale of 1 to 5).

You can define custom thresholds so that if a specific number of CIs or SLAs 
are impacted by a CI, this is mapped to a specific rating, as follows:

 1 Within the XML file, locate the metric for which you want to define 
thresholds, either in the section headed metric 
id="BasedOnNumOfBusinessEntities" (based on the number of business 
CIs that a CI impacts), or in metric id="BasedOnNumOfSLAs" (based on 
the number of SLAs that a CI impacts).

 2 Within the area headed <thresholds>, define thresholds according to the 
following format:

<threshold value="<number of impacted CIs>" valueMapping="<rating 
percentage mapped to this threshold value>" />

For example, suppose you define thresholds as follows:

- <thresholds>
- <!-- 
<threshold value="1" valueMapping="20" />
<threshold value="2" valueMapping="40" />
<threshold value="3" valueMapping="60" />
<threshold otherwise="80" />
--> 
</thresholds>

This means that if a CI impacts one CI, its business impact is mapped to 
20%, giving it a rating of 1 (out of 5). If this CI impacts 2 or 3 CIs, it rating is 
2 or 3 respectively. If the CI impacts more than 3 CIs, it is mapped to 80%, 
with a rating of 4.

Note that this mapping defines the business impact rating, independent of 
the total number of business CIs or SLAs in your environment.
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How to Work with the Health Indicator Component

The following tasks can be used to work with the Health Indicator 
component. 

➤ "Select CIs for display in the Health Indicator component" on page 252

➤ "Reset an HI’s state to default" on page 252

➤ "Access HI menu commands in the Health Indicator component" on 
page 253

Note: For an introduction to health indicators and KPIs, see "Health 
Indicators and KPIs - Overview" on page 115.

Select CIs for display in the Health Indicator component

If your workspace contains a component where you can select CIs (such as 
Model Explorer, Top View, Topology Map, or Hierarchy), and also contains 
the Health Indicator component, you can select a CI to display its related 
health indicators. For details, see "Service Health Workspace" on page 81.

If you want to use the Health Indicator component independent of other 
components, you can select a CI from within the component itself. Click 
the Filter button in the Health Indicator component toolbar, and then click 
Configuration Items. Open a view within the Configuration Items dialog 
box, and select a CI to display its health indicator data.

Reset an HI’s state to default

In some workflows, you might have an HI showing that a problem has 
occurred, but when you deal with the problem you might want to reset the 
HI’s state to Normal (default).

To reset an HI to its default state, access the menu command on an HI and 
select Operations > Reset Health Indicator. The HI’s default state is restored 
immediately, and the new status is reflected in the component when it is 
next refreshed.
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The Reset Health Indicator menu command is generally used for event-
based HIs, and not for metric-based HIs.

HIs cannot be reset to default within local impact views.

Tip: You can also reset HIs to default outside of BSM, using the Reset HIs API. 
For details, see "Reset Health Indicator State" on page 992.

Access HI menu commands in the Health Indicator component

You can drill down from the Health Indicator component to the following:

➤ If you are working with SiteScope, you can drill down from a SiteScope HI 
to a SiteScope monitor that contributes to the health indicator’s status. 
From the HI’s menu commands, select Go To > Go to SiteScope. For 
details, see "How to Drill Down to SiteScope from a CI or Health 
Indicator" on page 79.

➤ If you have a license for the Event Browser, you can drill down from an HI 
to the corresponding event in the Event Browser. From the HI’s menu 
commands, select Show > Show Contributing Events.
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How to Customize the Alerts Component

You can customize general settings of the Alerts component using the 
following options:

Select CIs for display in the Alerts component

If your workspace contains a component where you can select CIs (such as 
Model Explorer, Top View, Topology Map, or Hierarchy), and also contains 
the Alerts component, you can select a CI to display its related alerts. For 
details, see "Service Health Workspace" on page 81.

If you want to use the Alerts component independent of other components, 
you can select a CI from within the component itself. Click the Filter button 
in the Alerts component toolbar, and then click Configuration Items. Open 
a view within the Configuration Items dialog box, and select a CI to display 
its alerts data.

Modify duration settings

By default, the Alerts component displays data for the previous day. You can 
change this setting to previous week, day, or hour (up to the current time).

➤ If you are using the Alerts component outside of the 360° View page, click 
the Filter button in the component toolbar (in the upper right area of the 
component), and enter the new duration setting.

➤ If you are drilling down to Alerts from the Hierarchy component, click 
the Filter button in the Hierarchy component toolbar and enter the new 
duration setting. This setting is shared by all of the Hierarchy CI detail 
drill-downs.

Modify refresh rates

By default, the component is refreshed every five minutes. To modify this 
refresh rate, click the Preferences button in the component toolbar (in the 
upper right area of the component) and enter the new refresh rate.
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How to Customize the Changes and Incidents 
Component

You can customize the Changes and Incidents component using the 
following options:

Select CIs for display in the Changes and Incidents component

If your workspace contains a component where you can select CIs (such as 
Model Explorer, Top View, Topology Map, or Hierarchy), and also contains 
the Changes and Incidents component, you can select a CI to display its 
related changes and incidents data. For details, see "Service Health 
Workspace" on page 81.

If you want to use the Changes and Incidents component independent of 
other components, you can select a CI from within the component itself. 
Click the Filter button in the Changes and Incidents component toolbar, 
and then click Configuration Items. Open a view within the Configuration 
Items dialog box, and select a CI to display its changes and incidents data.

Modify duration settings

By default, the Changes and Incidents component displays data for the 
previous week. You can change this setting to previous week, day, or hour 
(up to the current time).

➤ If you are using the Changes and Incidents component outside of the 
360° View page, click the Filter button in the component toolbar (in the 
upper right area of the component), and enter the new duration setting.

➤ If you are drilling down to Changes and Incidents from the Hierarchy 
component, click the Filter button in the Hierarchy component toolbar 
and enter the new duration setting. This setting is shared by all of the 
Hierarchy CI detail drill-downs.

Modify refresh rates

By default, the component is refreshed every five minutes. To modify this 
refresh rate, click the Preferences button in the component toolbar (in the 
upper right area of the component) and enter the new refresh rate.
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Reference

360° View User Interface

This section describes:

 ➤ 360° View on page 257

 ➤ Hierarchy Component User Interface on page 258

 ➤ Defining/Editing Filters Dialog Box on page 265

 ➤ Business Impact Component User Interface on page 268

 ➤ Health Indicator Component User Interface on page 271

 ➤ Event-Based HI Tooltip Fields on page 273

 ➤ Alerts Component User Interface on page 274

 ➤ Changes and Incidents Component User Interface on page 276
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360° View 

The 360° View page contains the Hierarchy component which provides KPI 
data regarding the CIs in a selected view. If you select a CI you can see its 
detail links; when you click the detail links, you can access additional 
components which provide comprehensive data regarding the CI.

User interface elements are described below:

To access Select Application > Service Health > 360° View

UI Element Description

Hierarchy Displays a hierarchy of CIs in a view, the KPIs assigned 
to each CI, and their KPI statuses. For details, see 
"Hierarchy Component User Interface" on page 258.

Business Impact Displays business CIs and SLAs that are impacted by 
the CI selected in the active view. In addition, an icon 
shows how much of an impact the CI has on 
monitored business CIs and SLAs. For details, see 
"Business Impact Component User Interface" on 
page 268.

Health Indicators Displays details regarding the health indicators (HIs) 
that are used to calculate and set the status of the CI 
selected in the active view. For details, see "Health 
Indicator Component User Interface" on page 271.

Alerts Displays CI status alerts triggered by the CI selected in 
the active view. For details, see "Alerts Component User 
Interface" on page 274.

Changes and 
Incidents

Displays incidents opened for the CI selected in the 
active view, as well as requests for change and actual 
changes made to the CI. For details, see "Changes and 
Incidents Component User Interface" on page 276.
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Hierarchy Component User Interface

The Hierarchy component displays the hierarchy of the CIs in a view, and 
the real-time status of each of the KPIs assigned to the CIs. KPIs are grouped 
into domains; you can collapse a domain and display the worst status of all 
the KPIs in a domain. You can also filter the display to only show CIs with 
KPIs of a specific status, or specific CI types.

When you select a CI in the Hierarchy component, CI details are displayed. 
You can then click the detail links to display additional information 
regarding the selected CI.

Hierarchy Toolbar

The toolbar enables you to customize how data is displayed in the Hierarchy 
table, and to create filters that define which KPIs are displayed.

User interface elements are described below:

To access Select Applications > Service Health > 360° View.

Note: There are also default pages in MyBSM which 
contain this component. You can also create your own 
pages and include this component; for details see 
"Service Health Workspace" on page 81.

Related task "How to Customize the Hierarchy Component" on 
page 234

See also ➤ "How to Create a Quick Hierarchy Filter" on 
page 239

➤ "How to Create an Advanced Hierarchy Filter" on 
page 240

UI Element Description

<View Selector> Select a view from the dropdown list to display 
information on the CIs in the view.
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Menu. Select one of the following options:

➤  Expand Available Levels/Collapse All. Click 
to expand or collapse the CIs displayed in the 
Hierarchy component.

These buttons are enabled when one or more of the 
currently displayed CIs can be expanded or 
collapsed.

➤  Drill Down. Select a CI and click to drill down to 
its child CIs. This button is only enabled when a CI 
is selected.

➤  Up One Level. Click to display the parent CI of 
the CI currently displayed in the Hierarchy 
component.

This button is only enabled when the currently 
displayed CI has a parent CI.

➤  Select Columns. Click to open the Select 
Columns dialog box, which enables you to select 
which KPIs are displayed.

Use the arrows to add or remove KPIs from the 
display.

Filter. Click to open the filter bar, which enables you to 
only display CIs with at least one KPI of a given status 
(for example, only display CIs with at least one KPI 
with Critical status).

When the Filter button has a yellow and red border, a 
filter is currently active.

Remove Filter. If a filter is active, click to cancel 
filtering and show all KPI statuses for all CIs.

UI Element Description
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<Filter Bar> After you press the Filter button, this bar appears 
directly below the Hierarchy toolbar.

Select a combination of KPI statuses, to only display 
CIs which have at least one KPI with a given status.

The filter bar includes the following buttons:

➤ Filter. After selecting statuses, click to activate 
filtering.

➤ Clear. Click to de-select all of the statuses.

➤ Advanced. Click to create an advanced filter. This 
enables you to filter specific KPIs or CI types, and to 
create a permanent filter. For details, see 
"Defining/Editing Filters Dialog Box" on page 265.

Note: The filter created using the filter bar is a 
temporary filter that persists until you log off, until 
you change its selection of statuses, or until you select 
another filter. 

<Favorite Filters List> This list contains the predefined filters, and the filters 
you have created using the Advanced Filter.

➤ Select a filter to apply it to the Hierarchy display.

➤ To edit, clone, or delete a filter, select the filter from 
this list, then click the Favorite Filters Menu button.

Note: The prefix of each filter indicates its type: global 
(predefined), public, and private. For details, see 
"Visibility Levels" on page 267.

Predefined filters are useful in displaying commonly 
required information; they cannot be modified or 
deleted. For details, see "Predefined Filters" on 
page 264.

UI Element Description
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Hierarchy Table Columns

User interface elements are described below as they appear in the UI 
(unlabeled elements are shown in angle brackets):

Favorite Filters Menu. This opens a drop-down menu, 
which enables you to perform the following actions:

➤ To create an advanced filter, click New.

➤ To edit or delete a filter, select the filter from the 
Favorite Filters list, and click Edit or Delete.

Note that predefined filters cannot be modified or 
deleted.

➤ To clone a filter, select the filter from the Favorite 
Filters list, and click Clone.

For details on defining advanced filters, see 
"Defining/Editing Filters Dialog Box" on page 265.

Filter Hierarchial Mode. When filtering is active, click 
to display the CIs that fill the filter conditions within a 
hierarchical structure, in the context of their parent 
CIs.

Filter Flat Mode. When filtering is active, click to 
display the CIs that fill the filter conditions in a non-
hierarchical, list format, without displaying their 
parent CIs.

Sound On/Off. You can set up Service Health to issue 
an alert sound when the status of a KPI changes to 
Critical.

Click to toggle the sound on or off.

UI Element Description

Name This column displays the CIs in the selected view in a 
hierarchical structure. You can select a CI and click the 
Drill-down button to drill down to its child CIs.

Status Displays the worst KPI status for the CI.

UI Element Description
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Business Impact This bar indicates the CI’s business impact, using a 
rating from zero (no impact) to 5 (high impact). The 
rating shows how much of an impact the CI has on the 
business CIs and SLAs in your monitored environment.

By default, the rating is based on the criticality of 
impacted business CIs. Within the RTSM, each CI can 
have a Criticality attribute defined, with a value of 1-5. 
If a CI has an impact on one or more CIs which have 
this attribute defined, the CI’s business impact rating is 
the worst criticality of the CIs that it impacts.

You can customize which metrics are used to calculate 
this rating. For details, see "Business Impact Rating 
Calculation" on page 226.

<KPIs> Each of the KPI columns displays the status and value 
of a specific KPI, for each of the CIs displayed in the 
table.

<KPI Domains> KPIs are grouped by domains. For example, the 
Application domain contains the Application 
Performance and Application Availability KPIs. For 
details, see "KPI Domains" on page 411.

You can view all the KPIs in a domain, or you can 
collapse a domain to view the worst status of all the 
KPIs in the domain.

Ack Set or unset acknowledgement for a CI by clicking an 
icon in this column; a check mark  indicates that 
acknowledgement has been set. For details, see "How to 
Acknowledge Performance Problems" on page 329.

UI Element Description
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Hierarchy Table Rows

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element Description

<CI name> Each row in the table shows the KPI statuses of a given 
CI.

Click the down arrow next to a CI name to access the 
menu options for the CI. Available options depend on 
the type of CI and the context menu defined for the 
CI. If no context menu is defined for the CI, the menu 
arrow is not displayed. If one of the menu options is 
not supported for the selected CI, that option is 
disabled. For details on the menu options, see "Service 
Health Menu Options" on page 98.

<KPI status/value> Displays text or an icon indicating the current status or 
value of the KPI. For an explanation of the color coding 
for status icons, see "KPI Status Colors and Definitions" 
on page 45. 

Tooltip:

➤ Status. The status of the CI (calculated according to 
one of the status calculation methods). It may also 
display:

➤ Not up to date. For decayed CIs, indicating that 
the CI has passed its timeout period. (For a 
SiteScope CI, this status is displayed after a 
SiteScope monitor is disabled.)

➤ Stopped. When a Business Process profile is 
stopped.

➤ Business Rule. The name of the rule that calculates 
the KPI status or value.

➤ Held Status Since. The date and time since which 
this CI has held its current operational status.
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Predefined Filters

The predefined filters are:

<KPI History> When you select a CI, the history status icon displays 
either the worst status or the average status for the KPI 
during a specified time period. For details, see "KPI 
Trend and History Calculation" on page 408.

Tooltip:

➤ History Type. The type of history (worst status or 
average status) used when calculating history status.

➤ Historical Event. The worst or average status of the 
KPI in the selected time period.

<KPI Trend> When you select a CI, the trend status icon shows the 
trend in real-time status for the KPI, using three 
directions: up, down, and no change. For details, see 
"KPI Trend and History Calculation" on page 408.

Tooltip:

➤ Trend. The trend of the KPI in the selected time 
period.

Predefined Filter Name Description

global: Show Errors Displays the CIs whose KPIs have a Critical status.

global: Show Errors and 
Warnings

Displays the CIs whose KPIs have a Minor, Major, or 
Critical status.

global: Show PNR Displays, for all CI types, only the CIs whose PNR 
KPI has an OK, Warning, Minor, Major, Critical, or 
No Data status.

UI Element Description
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Defining/Editing Filters Dialog Box

This dialog box enable you to define new filters or customize existing filters.

User interface elements are described below:

To access Select Application > Service Health > 360° View > 
Hierarchy.

In the Hierarchy component, click Filter to open the 
filter bar and then click Advanced, or click the Favorite 
Filters Menu button.

Important 
information

The Favorite Filters Menu button enables you to 
perform the following actions:

➤ To create an advanced filter, click New.

➤ To edit or delete a filter, select the filter from the 
Favorite Filters list, and click Edit or Delete.

Predefined filters (labeled global) cannot be 
modified or deleted.

➤ To clone a filter, select the filter from the Favorite 
Filters list, and click Clone.

Note: If more than one user is logged in at the same 
time using the same user name (for example, admin), 
then every time one of the users saves a change to the 
filters, the associated filters file is updated with a copy 
of that user’s filters.

Relevant tasks "How to Create an Advanced Hierarchy Filter" on 
page 240

UI Element (A-Z) Description

Invert Selection. Click to select or deselect one of the 
statuses, for all the KPIs.

<Status check boxes> Select the check box for each KPI status that you want 
to include in the filter. The Hierarchy display shows all 
the CIs that have at least one KPI that fills the filter 
criteria.
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Cancel Click to exit the Defining/Editing Filters dialog box 
without saving changes.

Filter Click to apply the filter (without saving filter settings).

Filter and Save Click to apply the filter, and save your changes to the 
filter.

Filter Name Type the name of the filter you are creating.

Type Selection This displays a CI type hierarchy, which you can use to 
filter specific CI types. Select a CI type to only display 
CIs of this type in the Hierarchy display.

The CI type filtering is combined with the Status 
filtering. For example, suppose you select critical status 
for all KPIs in the Status Selection pane, and the 
Business Element CIT in the Type Selection pane. The 
Hierarchy display will only show CIs of this CIT (and 
its descendant CITs), which have at least one KPI in 
critical status.

Note: If you select a higher-level CIT, all its descendant 
CITs are included in the filter as well.

Visibility Select the required visibility option:

➤ Private to create a private filter.

➤ Public to create a public filter.

Note: Visibility is displayed only to the administrator 
or to a user with the appropriate permissions.

Different levels of visibility are available. For details, 
see "Visibility Levels" on page 267.

UI Element (A-Z) Description
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Visibility Levels

The visibility levels you can select when defining a filter include:

Visibility Level Filter Description

Global Global filters are predefined and built-in. They are 
available for all customer users. They cannot be 
modified. You can use them as templates to build 
public or private active filters. Their names have the 
following syntax: global:<name>. For a list of global 
active filters, see "Predefined Filters" on page 264.

Public Administrators or users with the appropriate 
permissions can build public active filters. Those 
filters are available for all users at the specific 
customer. You can use the global active filters as 
templates to build public active filters. Their names 
have the following syntax: public:<name>.

Private Users can build their own private active filters. 
Those filters are available only to the user who 
created them. You can use the global and public 
active filters as templates to build private active 
filters. Their names have the following syntax: 
private:<name>.

For each user name used when logging on to 
HP Business Service Management, Service Health 
creates an associated filters file. When you log on to 
HP Business Service Management using a specific 
user name, you can only view and modify the filters 
contained in the associated filters file. The file is 
updated with the filter modifications made by each 
user who logs in under this user name, so any 
changes you make to the filters may overwrite 
modifications made by previous users.
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Business Impact Component User Interface

This component displays current and over-time KPI status for business CIs 
impacted by the CI selected in the active view. The over-time data is 
aggregated according to status.

If you have configured SLAs, this component also shows status details of any 
SLAs impacted by the selected CI. Impacted SLAs can only appear if a Service 
Level Management license has been installed.

To access Select Applications > Service Health > 360° View > 
Hierarchy. Select a CI, and click Business Impact.

Note: You can also create your own pages and include 
this component; for details see "Service Health 
Workspace" on page 81.

Related task "How to Customize the Business Impact Component" 
on page 245

See also "How to Customize the Business Impact Rating 
Calculation Method" on page 248
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User interface elements are described below:

Business Impact Rating Area

Impacted Businesses Area

UI Element (A-Z) Description

Business Impact 
(Low to High)

This bar indicates the CI’s business impact, using a 
rating from zero (no impact) to 5 (high impact). The 
rating shows how much of an impact the CI has on the 
business CIs and SLAs in your monitored environment.

By default, the rating is based on the criticality of 
impacted business CIs. Within the RTSM, each CI can 
have a Criticality attribute defined, with a value of 1-5. 
If a CI has an impact on one or more CIs which have 
this attribute defined, the CI’s business impact rating is 
the worst criticality of the CIs that it impacts.

You can customize which metrics are used to calculate 
this rating. For details, see "Business Impact Rating 
Calculation" on page 226.

UI Element (A-Z) Description

Current Status The worst status of the KPI assigned to the impacted 
CI.

Name The name of the impacted CI.

You can click a CI to access its corresponding Business 
Impact Report. For details, see "Business Impact Report" 
on page 92.

Past 
<Hour/Day/Week>

The status of the impacted CI over a predefined time 
period (default: Past week).

To modify the predefined time period, see "How to 
Customize the Business Impact Component" on 
page 245.

Tooltip: The tooltip displays a text string containing 
the name of the status, and the percentage of time that 
the KPI held this status.
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Impacted SLAs Area

Type CI type of the impacted CI.

Note: By default the available CITs are Business 
Services, Business Processes, and Applications. To 
modify the default types, see "How to Modify Which 
CITs are Displayed in the Business Impact Component" 
on page 247.

UI Element (A-Z) Description

Base forecast on: Time frame used by the Expected Breach Date column 
(default: Week).

Current Status The current status of the impacted SLA.

Customer The customer related to the impacted SLA.

Expected Breach 
Date

The expected breach date of the impacted SLA.

Forecasting Status The expected status of the impacted SLA, based on 
extrapolation. For details, see "Status Forecast for SLAs" 
in Using Service Level Management.

Give forecasting for: Time frame used by the Forecasting Status column 
(default: end of Month).

SLAs The list of SLAs where the selected CI is included.

SLA status for: Time frame used by the Current Status column 
(default: Month to date).

UI Element (A-Z) Description
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Health Indicator Component User Interface

The Health Indicator component displays details regarding the health 
indicators that are used to calculate and set the current status of a selected 
CI. For an introduction to health indicators, see "Health Indicators and KPIs 
- Overview" on page 115.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Select Applications > Service Health > 360° View > 
Hierarchy. Select a CI, and click Indicators.

To view HI details from another Service Health 
component, select a CI, then select the Show > HIs 
menu command.

Note: You can also create your own pages and include 
this component; for details see "Service Health 
Workspace" on page 81.

Important 
information

Health indicators that are used in calculating multiple 
KPIs are listed multiple times, under each of the KPIs to 
which they contribute.

UI Element (A-Z) Description

<CI name> Name of the CI to which the displayed health 
indicators are assigned.

Click the arrow next to a CI name to access the menu 
options for that CI. Available options depend on the 
type of CI and the context menu defined for the CI. For 
details, see "Service Health Menu Options" on page 98.

Click the arrow next to an HI name to access the menu 
options for that HI. For details, see "How to Work with 
the Health Indicator Component" on page 252.

Reset columns width. Click to restore the width of the 
columns in the table to the default widths.

Select columns. Click to select the columns you want 
to display in the table.
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Health Indicator Display name of the health indicator.

For details on HI tooltips, see "Understanding the 
Health Indicator Tooltips" on page 229.

Health Indicators 
Contributing to KPIs

List of the health indicators that are assigned to the 
selected CI, and are used to calculate KPIs for the CI.

Health Indicators Not 
Contributing to KPIs

List of the health indicators that are assigned to the 
selected CI, but are not used to calculate any KPIs.

KPI Name of the KPI which uses the health indicator in 
calculating its status, and current KPI status displayed 
by a status icon.

The tooltip displays the status of the KPI, its 
calculation rule, the date when its status last changed, 
and additional tooltip parameters depending on the 
rule of selected KPI.

Last Status Change Time stamp indicating the last time the current status 
was updated.

State Current status of the health indicator. The state is a 
text label, such as Success or Failed, and the status 
assigned to this state is displayed by a status icon.

The tooltip displays the state of the health indicator, its 
calculation rule, the date when its status last changed, 
and additional information depending on the rule used 
to calculate the HI.

Trend Arrows pointing up, down, or up and down to indicate 
the trend of the health indicator since the last update:

 — Positive 

 — Neutral

 — Negative

HI trend is generated by comparing the previous status 
of the HI with the current status of the HI.

UI Element (A-Z) Description
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Event-Based HI Tooltip Fields

When a health indicator is fed by events, its tooltip can contain the 
following fields by default. 

If custom attributes are defined in OMi, these are displayed as well.

Value Current value of the health indicator.

This is only displayed when applicable for the health 
indicator (for example, response time). When an HI 
does not have a value (for example if it is event-based), 
this displays a dash (-).

Tooltip Field Description

Assigned User Name of the user responsible for solving the event's 
underlying problem.

Category Name of the logical group to which the event belongs, 
(for example, Database, Security, or Network).

Event Type Indicator Display name of the event type indicator (ETI) used to 
calculate the status reported by the selected event and 
the current value, (for example, Web application 
state:Slow).

Lifecycle State Point in the event lifecycle that the selected event has 
reached: Open, In Progress, Resolved, or Closed.

Priority The priority assigned to the selected event (for example, 
Low, Medium, or High).

Severity Severity assigned to the selected event.

Time State Changed Date and time when the last lifecycle state change took 
place.

Time Received The time when the event was received on the 
management server.

UI Element (A-Z) Description
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Alerts Component User Interface

This component displays a log of the CI status alerts that were triggered 
during the past hour, for the CI selected in the active view.

Title Brief description of the nature of the selected event.

Type String used to organize different types of events within 
an event category or subcategory (for example, users or 
applications, accounts, and security).

Subcategory Name of the logical subgroup (category) to which the 
event belongs; for example, Oracle (database), Accounts 
(security), or Routers (network).

Solution Text field used to document solutions to help operators 
solve the problem indicated by the event.

Description Optional information about the original event, in 
addition to the event's original title and the text captured 
from the event source.

To access Select Applications > Service Health > 360° View > 
Hierarchy. Select a CI, and click Alerts.

Note: You can also create your own pages and include 
this component; for details see "Service Health 
Workspace" on page 81.

Important 
information

By default, alerts are shown for the past day. To modify 
this setting, see "How to Customize the Alerts 
Component" on page 254.

Tooltip Field Description
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User interface elements are described below:

UI Element (A-Z) Description

Click the down arrow next to a CI name to access the 
menu options for that CI. Available options depend on 
the type of CI and the context menu defined for the 
CI. For details on the menu options, see "Service Health 
Menu Options" on page 98.

<CI name> Displays the name of the CI selected in the active view.

Alert Description Description of the status change that triggered the 
alert.

Alert Name The name of the alert.

Alert Time The time and date when the alert was triggered. The 
format is: dd/mm/yy hh:mm GMT[<offset>].

Alerts Over Time 
report

Click to access the selected CI’s Status Alerts Report, 
which includes information on the action taken 
following the alert.

For details, see "Configuration Item Status Alerts 
Report" on page 309.

KPI The KPI that triggered the alert.

Status The status which the KPI entered when the alert was 
issued, represented by a status icon. 

For details about the icons, see "KPI Status Colors and 
Definitions" on page 45.
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Changes and Incidents Component User Interface

The Changes and Incidents component shows incidents opened for the CI 
selected in the active view, requests for change for the CI, and actual 
changes made to the CI.

User interface elements are described below:

Actual Changes area

To access Select Applications > Service Health > 360° View > 
Hierarchy. Select a CI, and click one of the following: 
Actual Changes, Planned Changes, or Incidents.

Note: You can also create your own pages and include 
this component; for details see "Service Health 
Workspace" on page 81.

Important 
information

By default, data is also displayed for the child CIs 
which have an Impact relationship with the selected 
CI. If you deselect the Show data for child CIs check 
box, data is only shown for the selected CI. 

By default, actual changes and incidents are shown for 
the past week. The requests for change area shows the 
changes planned during the previous week, and those 
that are planned for the coming week. To modify these 
settings, see "How to Customize the Changes and 
Incidents Component" on page 255.

UI Element (A-Z) Description

Attribute The name of the CI attribute that was changed.

Change Type The type of change that occurred.

Changer Description of the user or event that modified the CI’s 
property (for example, user name or Discovery).

CI Name The name of the CI that was changed.

Date The date and time at which the change occurred.

New Value The new value of the CI attribute.
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Incidents area

Requests for Change area

Old Value The previous value of the CI attribute (before the 
change).

Related CI If the change involves a changed relationship between 
CIs, this field shows the name of the CI whose 
relationship with the selected CI was changed.

UI Element (A-Z) Description

CI Name The name of the CI that triggered the incident.

Closing Time The date and time at which the incident was closed.

Description Description of the incident.

ID Incident ID, as it appears in the source application (for 
example, within HP Service Manager).

Opening Time The date and time at which the incident was opened.

Origin The source of the incident.

Severity The severity of the incident as it appears in the source 
application (for example, within HP Service Manager).

Status The status of the incident as it appears in the source 
application.

Update Time The date and time at which the incident was updated.

UI Element (A-Z) Description

If you have resized columns, click to restore all the 
columns to their original width.

Click to open a dialog box which enables you to select 
which columns are displayed in the table.

CI Name The name of the CI for which the change is planned.

UI Element (A-Z) Description
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Contact Person The name of the contact person regarding the change.

ID Change request ID, as it appears in the source 
application (such as Release Control).

Impact Severity The degree of impact of the change, as it appears in the 
source application (such as Release Control).

Opened By The name of the person who opened the change 
request.

Planned End Date The time at which the change is scheduled to end.

Planned Start Date The time at which the change is scheduled to start.

Risk The degree of risk of the change, as it appears in the 
source application.

Status The status of the planned change, as it appears in the 
source application.

Summary A description of the planned change.

UI Element (A-Z) Description
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8
KPIs Component

This chapter includes:

Concepts

➤ KPIs Component Overview on page 280

Tasks

➤ How to Customize the KPIs Component on page 281

Reference

➤ KPIs Component User Interface on page 282
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Concepts

KPIs Component Overview

The KPIs component enables you to see KPI status over time for the CI 
selected in the active view. This requires that KPI data over time be saved for 
the CI, using the Service Health Administration > CI Indicators > Save KPI 
Data Over Time setting. For details, see "Persistent Data and Historical Data" 
on page 411.

In addition, if you have configured federation adapters to collect KPI values 
for this CI from outside HP Business Service Management, this component 
also displays the federated KPI’s status, last status change, and the source of 
the federated KPI. For details on setting up federation, see "Federation 
Framework Overview" in the RTSM Developer Reference Guide.

The following image shows an example of this component displaying 
information on external KPIs. (In this example, Service Health KPI data over 
time was not saved.)

For user interface details, see "KPIs Component User Interface" on page 282.
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Tasks

How to Customize the KPIs Component

You can customize general settings of the KPIs component using the 
following options:

Modify duration settings

By default, the KPIs component displays data for the previous week. You can 
change this setting to previous week, day, or hour (up to the current time).

To modify, click the Filter button in the component toolbar (in the upper 
right area of the component), and enter the new duration setting.

Modify refresh rates

By default, the component is refreshed every five minutes. To modify this 
refresh rate, click the Preferences button in the component toolbar (in the 
upper right area of the component) and enter the new refresh rate.
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Reference

KPIs Component User Interface

This component displays KPI status over time for the CI selected in the 
active view. 

If you have configured federation adapters to collect KPI values for this CI 
from outside BSM, the External KPIs area displays information about these 
federated KPIs. For details on setting up federation, see "Federation 
Framework Overview" in the RTSM Developer Reference Guide.

User interface elements are described below:

Service Health KPIs Area

To access Add this component to a user-defined page; for details 
see "Service Health Workspace" on page 81.

Related task "How to Customize the KPIs Component" on page 281.

UI Element (A-Z) Description

KPI The list of KPIs attached to the selected CI.

Past 
<Hour/Day/Week>

The status of the KPI over a predefined time period 
(default: Past week). 

To modify the predefined time period, see "How to 
Customize the KPIs Component" on page 281.

Tooltip:

The tooltip displays a text string containing the name 
of the status, the amount of time the KPI held this 
status during the time frame, and the percentage of 
time that the KPI held this status.

Status duration can be given in hours, minutes, and 
seconds (for example, 01:10:48) or in days and hours 
(for example, 30 days, 9 hours).
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External KPIs Area

UI Element (A-Z) Description

Additional 
Information

Description of the KPI. This is taken from the KPI’s 
Additional Information attribute; if this attribute is 
blank no information appears.

Last Status Changes The date and time from when this KPI has held its 
current operational status.

Name The name of the KPI which is assigned to the selected 
CI.

Source The source outside HP Business Service Management, 
from which the federation adapter retrieved the KPI.

Status The current status of the KPI assigned to the selected 
CI.
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9
CI Status Alerts Reports

This chapter includes:

Concepts

➤ CI Status Alert Reports Overview on page 286

Tasks

➤ How to View the Triggered CI Status Alerts and Notifications on page 287

Reference

➤ Message Examples on page 289

➤ CI Status Alert Reports User Interface on page 293
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Concepts

CI Status Alert Reports Overview

CI Status alerts are triggered by a pre-defined status change for the selected 
CI.

In the Alerts application, the CI Status Alert report provides information 
about the CI Status alerts that were triggered in the past. For user interface 
details, see "Configuration Item Status Alerts Report" on page 309.

Any changes you make to the alert schemes for a CI—adding new alert 
schemes, deleting alert schemes, or editing alert scheme properties— is 
propagated to any view that includes the CI.

In the CI Status alert administration, you can create and manage one or 
more alert schemes for a CI, using the Alert Wizard. In each alert scheme, 
you define a unique set of alert properties. For user interface details, see 
"Create New Alert Wizard" on page 516.

When an alert is triggered, it sends a predefined notification (using email, 
SMS, or Pager) to a predefined recipient, and may trigger a predefined action 
(exe file, URL, SMNP trap, or other). 

Whenever a notification is sent, information related to the notification is 
logged into the profile database. You can view the log in the Alert report. For 
details, see "Audit Log" on page 538.
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Tasks

How to View the Triggered CI Status Alerts and 
Notifications

You can view information about the CI Status alerts that were triggered in 
the CI Status Alerts report and in the CI Status Alert Notifications report. 
Recipients can view the alert details in the emails, SMS messages, or Pager 
messages that are sent to them when the alert is triggered.

This task includes the following steps:

➤ "View the CI Status Alerts report" on page 287

➤ "View the CI Status Alert Notifications report" on page 287

➤ "View the CI Status Alert details in email, SMS, or pager messages" on 
page 288

 1 View the CI Status Alerts report

To display alert information, select Applications > CI Status > Reports > CI 
Status Alerts report.

The report is a log of CI Status alerts that occurred in the specified period 
of time. For user interface details, see "Configuration Item Status Alerts 
Report" on page 309.

An alert is also attached to the CI in any view where the CI is included.

 2 View the CI Status Alert Notifications report

To display detailed alert information, access the Configuration Item 
Status Alerts page, and click the Details button for the relevant alert to 
open the Configuration Item Status Alert Notifications report. For user 
interface details, see "Configuration Item Status Alert Notifications 
Report" on page 295. 
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The Configuration Item Status Alert Notifications report includes details 
on the alert, the notification, the notification message, and the type of 
message followed by the text of the message.

HTML is encoded in the report. The text of the email received by the 
recipient is decoded and is similar to the Pager message text. For more 
information on the different formats available to send emails or pager 
messages, see "Message Examples" on page 289.

You can also see whether the event corresponding to the alert in the 
Operation Manager (OM) was created (when the integration with HP 
Operation Manager is enabled).

 3 View the CI Status Alert details in email, SMS, or pager 
messages

Recipients can view the CI Status alert details in the emails, SMS 
messages, or Pager messages that are sent to them when the alert is 
triggered.

For details, see "Message Examples" on page 289.
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Reference

Message Examples 

The syntax used in the Notification Message area of an alert notification, is a 
subset of a long or short HTML template or long or short text template. For 
details on the contents of the messages, see "Configuration Item Status Alert 
Notifications Report" on page 295. 

This section provides examples of such messages.

The email messages that the user receives depend on the format you select 
in the Email Message Template, SMS Template, or Pager Template list.

Example of a Long HTML Email, SMS, or Pager Message
From: HP_BSM_Notification_Manager@illabmail01.devlab.ad

Date: 04/06/10 11:31:24

To: johnd@lab.lab

Subject: bpm1 on Local Impact View: private_monitors Status improved. 
Status is Major (Reported by HP Business Service Management)

bpm1 on Local Impact View: private_monitors Status improved. Status is 
Major.

Status Change Time: 5/20/10 8:59 AM (Eastern 
Daylight Time) -0400

KPI Name: Application Availability

KPI is Calculated By: Health indicators and child KPIs

Calculation Value is: N/A

Previous Status: Critical

Time Since Condition 
Threshold Met:

N/A
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Health indicators information:

The alert was triggered for the following CI:

The CI impacts the following Business Services:

The CI does not impact any Business Processes.

The CI does not impact any Applications.

Over Time Report: 

Business Impact Report: 

Click to display the CI details in the HP BSMobile application (only for iPhone)

For more details log into HP Business Service Management

Alert Name: private

Alert Description:

Local Impact View: private_monitors

Health Indicator 
Name

Health Indicator 
Status

Health Indicator 
Value

ETI Name

HI1 Major 1.0 dollars -

HI 2 Major 1.0 pounds -

Name: bpm1

CI Type: Business Application

Service2

Service3
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Example of a Long Text Email, SMS, or Pager Message
From: HP_BSM_Notification_Manager@illabmail01.devlab.ad

Date: 04/06/10 11:31:24

To: johnd@lab.lab

Subject: bpm1 on Local Impact View: private_monitors Status improved. 
Status is Major (Reported by HP Business Service Management)

bpm1 on Local Impact View: private_monitors Status improved. Status is 
Major.

Status Change Time: 5/20/10 8:59 AM (Eastern Daylight Time) -0400 

KPI Name: Application Availability

KPI is Calculated By: Health indicators and child KPIs

Calculation Value is: N/A

Previous Status: Critical

Time Since Condition Threshold Met: N/A

Alert Name: private

Alert Description: 

Local Impact View: private_monitors

Health indicators information:

The alert was triggered for the following CI:

Name: bpm1

Health Indicator 
Name

Health Indicator 
Status

Health Indicator 
Value

ETI Name

HI1 Major 1.0 dollars -

HI 2 Major 1.0 pounds -
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CI Type: Business Application

The CI impacts the following Business Services:

Service2

Service3

The CI does not impact any Business Processes.

The CI does not impact any Applications.

Over Time Report 
http://<gateway_machine_name>/topaz/TopazSiteServlet?createSession=tru
e&requestType=login&directLogin=true&userlogin=&userpassword=&custo
merId=1&selectedMenuItemId=kpis_over_time&applicationId=bam&helpC
ontextId=bam&helpTopicId=kpis_over_time&filter.reportType=statuses_rep
ort&openedVTFrame=false&autoGenerate=true&filter.timeBarBean.view=cu
stom&filter.timeBarBean.from=1286157948671&filter.timeBarBean.to=1286
161548671&populateAnyway=true&filter.selectedVTIds=78ef8643bf78b75a
0d922c1890e9bd1f&filter.viewId=&filter.translateVTIdsToCmdbIds=false&fi
lter.fromDashboard=true

Business Impact Report 
http://<gateway_machine_name>/topaz/TopazSiteServlet?createSession=tru
e&requestType=login&directLogin=true&userlogin=&userpassword=&custo
merId=1&portlet_url=/service-
impact/main/page.do?ciId=78ef8643bf78b75a0d922c1890e9bd1f&viewNa
me=

Click to display the CI details in the HP BSMobile application (only for iPhone)
<hp_bsmobile_application_on_iphone>:///?viewName=CI%20Alerts%20Vie
w&ciName=bpm1,ciId=1;;78ef8643bf78b75a0d922c1890e9bd1f&

For more details log into HP Business Service Management

Example of a Short HTML Email, SMS, or Pager Message 
From: HP_BSM_Notification_Manager@illabmail01.devlab.ad

Date: 04/06/10 11:31:24

To: johnd@lab.lab
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Subject: bpm1 on Local Impact View: private_monitors Status improved. 
Status is Major (Reported by HP Business Service Management)

bpm1 on Local Impact View: private_monitors Status improved. Status is 
Major.
For more details log into HP Business Service Management

Example of a Short Text Email, SMS, or Pager Message 

From: HP_BSM_Notification_Manager@illabmail01.devlab.ad

Date: 04/06/10 11:31:24

To: johnd@lab.lab

Subject: bpm1 on Local Impact View: private_monitors Status improved. Status 
is Major (Reported by HP Business Service Management)

bpm1 on Local Impact View: private_monitors Status improved. Status is Major.
For more details log into HP Business Service Management

CI Status Alert Reports User Interface

This section describes:

 ➤ Configuration Items Dialog Box on page 294

 ➤ Configuration Item Status Alert Notifications Report on page 295

 ➤ Configuration Item Status Alerts Report on page 309

 ➤ KPIs Dialog Box on page 312



Chapter 9 • CI Status Alerts Reports

294

Configuration Items Dialog Box

This dialog box enables you to select the CIs to be included in the CI Status 
Alerts report, for the duration of a Web session. The report provides 
information based on the selected CIs.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In the CI Status Alerts report, click Configuration Items 
in the reports settings area.

Relevant tasks "How to View the Triggered CI Status Alerts and 
Notifications" on page 287

UI Element (A-Z) Description

<View tree> Displays the CIs that belong to the selected view. Select 
the required CIs.

Browse The default mode for the Configuration Items dialog 
box, enabling you to select a view and CIs.

Search Moves to Search mode, where you can search for CIs. 
For details, see "CI Selector Overview" in the Modeling 
Guide.

View Select the relevant view from the dropdown list (start 
typing in the view name to filter the list), or click the 
ellipsis button to open the Select View dialog box, 
where you can select a view from the view folders tree.

Note: Only the CIs selected in the currently displayed 
view are saved for the report filter when you click OK. 
If you select another view before clicking OK, all 
previous CI selections are discarded.
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Configuration Item Status Alert Notifications Report

This report enables you to display detailed alert information.

The following is an example of the Configuration Item Status Alert 
Notifications report. 
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Alert Details Area

User interface elements are described below:

To access Select:

➤ Applications > Service Health > 360° View > 
Hierarchy. Select a CI, click Alerts, and click the 
Details button.

➤ Applications > CI Status > CI Status Alerts report.

Relevant tasks "How to View the Triggered CI Status Alerts and 
Notifications" on page 287

UI Element Description

Time The time when the alert was triggered.

Condition The condition that caused the alert to be triggered.

Status The current status of the alert.

Previous Status The previous status of the KPI.

Alert Name The name of the alert.

Configuration Item The name of the CI to which the alert is attached.

KPI The name of the KPI whose change of status triggered 
the alert.

Alert Description The description of the alert.

Alert Action The action that has been assigned to the alert.
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Action Notifications Area

User interface elements are described below:

Message Notifications Area

User interface elements are described below:

UI Element (A-Z) Description

Command The action that was executed: 

➤ For executables: the command line

➤ For URLs: the URLs

➤ For SNMP traps: Send SNMP trap to <address>

➤ For Open incidents in HP ServiceCenter: Open 
incident

➤ For Open event in HP Operations Manager (OM)

Status The status of the action: 

➤ Pass when the action has been performed.

➤ Fail when the action failed.

Type The type of action notification: Executable, URL, SNMP 
trap, OM, or Service Center.

UI Element (A-Z) Description

Recipients The names of the recipients who receive the 
notification that the alert has been triggered and that 
the alert scheme has been executed.

Status The status of the message: 

➤ Pass. When the message has been sent.

➤ Fail. When the message was not sent.

Type The type of message notification: email, SMS message, 
or Pager message.
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Notification Messages Area

This area displays details about the notification message and the email 
message sent to the recipients when the alert was triggered. Depending on 
the definition of the CI Status alert, the report may display only a subset of 
these fields. The following sections detail each area of the message 
separately.

For detailed examples of the message syntax and examples of the message 
for different message formats, see "Message Examples" on page 289.

Notification Messages Area: First Section

➤ Format for a Long or Short HTML Template:

➤ For a CI in a Global View:

ci_name status has changed to/remained/has improved. 
Status is current_status.

Status Change Time: trigger_time

KPI Name: kpi_name

KPI is Calculated 
By/Assigned Health 
Indicators/KPIs 
assigned to child CI: 

relevant health indicators, KPIs, or 
both

Calculation Value is: KPI_value

Previous Status: previous_status

Time Since Condition 
Threshold Met:

time-period + time since end of 
time-period

Alert Name: alert_name

Alert Description: alert_description

Local Impact View N/A
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➤ For a CI in a Local Impact View:

ci_name on local impact view: view_name
status changed to/was/improved.
Status is current_status.

Status Change Time: trigger_time

KPI Name: kpi_name

KPI is Calculated 
By/Assigned Health 
Indicators/KPIs 
assigned to child CI:

relevant_health_indicators or 
relevant_KPIs

Calculation Value is: KPI_value

Previous Status: previous_status

Time Since Condition 
Threshold Met:

time-period + time since end of 
time-period

Alert Name: alert_name

Alert Description: alert_description

Local Impact View name_of_local_impact_view
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➤ Format for a Long or Short Text Template: 

➤ For a CI in a Global View:

➤ For a CI in a Local Impact View:

ci_name status has changed to/remained/has improved. 
Status is current_status.
Status Change Time: trigger_time
KPI Name: kpi_name
KPI is Calculated By/Assigned Health Indicators/KPIs assigned to child CI: 
relevant_health_indicators or relevant_KPIs
Calculation Value is: KPI_value
Previous Status: previous_status
Time Since Condition Threshold Met: time-period + time since end of time-
period
Alert Name: alert_name
Alert Description: alert_description
Local Impact View: N/A

ci_name on local impact view: view_name 
status changed to/was/improved. 
Status is current_status.
Status Change Time: trigger_time
KPI Name: kpi_name
KPI is Calculated By/Assigned Health Indicators/KPIs assigned to child CI: 
relevant_health_indicators or relevant_KPIs
Calculation Value is: KPI_value
Previous Status: previous_status
Time Since Condition Threshold Met: time-period + time since end of time-
period
Alert Name: alert_name
Alert Description: alert_description
Local Impact View: name_of_local_impact_view
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

ci_name on local 
impact view: 
view_name 

status changed 
to/was/improved. 

Status is 
current_status.

<ci-name>. The name of the CI whose change of status 
triggered the alert.

<condition>. The condition that triggered the alert. For 
example: Status improved.

<current-status>. The new status of the CI.

<view_name>. The name of the local impact view.

Alert Description The description of the alert.

Alert Name The name of the alert.

KPI is Calculated 
By/Assigned Health 
Indicators/KPIs 
assigned to child CI

Relevant health indicators, KPIs, or both.

KPI Name The name of the KPI whose status changes triggered 
the alert.

Calculation Value is The value of the KPI only for KPIs that do have values; 
otherwise the parameter displays: N/A.

Local Impact View If the alert is assigned to a CI that is part of a Local 
Impact View, the field displays the name of that view.

Status Change Time The time and date when the alert was triggered. The 
format is: dd/mm/yy hh:mm AM/PM (<region>) <offset>. 
For example: 5/20/10 8:59 AM (Eastern Daylight Time) -
0400.

Time Since Condition 
Threshold Met

The time that has passed since the condition that 
triggered the alert occurred, in minutes. 
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Notification Messages Area: Second Section

➤ Format for a Long HTML Template:

➤ Format for a Long Text Template: 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

ETI Name The name of the Event Type Indicator.

Health Indicator 
Name

The name of the health indicator.

Health Indicator 
Status

The status of the health indicator

Health Indicator 
Value

The value of the health indicator.

Health indicators information:

Health Indicator 
Name

Health Indicator 
Status

Health Indicator 
Value

ETI Name

health indicator 
name

health indicator 
status

health indicator 
value

ETI name

Health indicators information:

Health Indicator Name health indicator name

Health Indicator Status health indicator status

Health Indicator Value health indicator value

ETI Name ETI name
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Notification Messages Area: Third Section

➤ Format for a Long HTML Template: 

➤ Format for a Long Text Template:

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

CI Type The type of the CI whose change of status triggered the 
alert.

Name The name of the CI whose change of status triggered 
the alert.

The alert was 
triggered for the 
following CIs

Provides the details of the CI that triggered the alert:

➤ CI Type. The display name of the CI type.

➤ Name. The code name of the CI.

The alert was triggered for the following CI:

Name ci_type

CI Type ci_name

The alert was triggered for the following CI:

Name ci_type

CI Type ci_name
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Notification Messages Area: Fourth Section

➤ Format for a Long HTML Template: 

➤ Format for a Long Text Template:

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Due to a large 
number of alerts at 
current time, impact 
calculations were not 
performed

This message is displayed when a large number of alerts 
was issued, and in this case the CI impacts the 
following Applications, the CI impacts the following 
Business Processes, and the CI impacts the following 
Business Service sections are not displayed in the 
report.

The CI impacts the following Business Services/Business 
Processes/Applications:

The CI does not impact any Business Services/Business 
Processes/Applications

business_services/business
_processes/applications

business_services/business
_processes/applications

The CI impacts the following Business Services/Business 
Processes/Applications:

business_services/business_processes/applications

business_services/business_processes/applications

The CI does not impact any Business Services/Business 
Processes/Applications
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Notification Messages Area: Fifth Section

➤ Format for a Long HTML Template:

The CI does not 
impact any Business 
Service/Business 
Process/Application

Displayed when the CI has no impact on any Business 
Service/Business Process/Application CIs.

The CI impacts the 
following 
Applications

Lists the Application CIs impacted by the CI.

The CI impacts the 
following Business 
Processes

Lists the Business Process CIs impacted by the CI.

The CI impacts the 
following Business 
Services

Lists the Business Service CIs impacted by the CI.

UI Element (A-Z) Description

Over Time Report

Business Impact Report

Click to display the CI details in the HP BSMobile application (only for iPhone)

For more details log into <url>
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➤ Format for a Long Text Template:

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Business Impact 
Report

Click to open the Business Impact report for the 
selected CI. This link only works in a browser.

For user interface details, see "Business Impact Report" 
on page 92.

Over Time Report: 
http://<machine_name>/topaz/TopazSiteServlet?createSession=true&reques
tType=login&directLogin=true&userlogin=&userpassword=&customerId=1
&selectedMenuItemId=kpis_over_time&applicationId=bam&helpContextId
=bam&helpTopicId=kpis_over_time&filter.reportType=statuses_report&ope
nedVTFrame=false&autoGenerate=true&filter.timeBarBean.view=custom&fi
lter.timeBarBean.from=1286157948671&filter.timeBarBean.to=1286161548
671&populateAnyway=true&filter.selectedVTIds=78ef8643bf78b75a0d922c
1890e9bd1f&filter.viewId=&filter.translateVTIdsToCmdbIds=false&filter.fro
mDashboard=true

Business Impact Report: 
http://<machine_name>/topaz/TopazSiteServlet?createSession=true&reques
tType=login&directLogin=true&userlogin=&userpassword=&customerId=1
&portlet_url=/service-
impact/main/page.do?ciId=78ef8643bf78b75a0d922c1890e9bd1f&viewNa
me=

Click to display the CI details in the HP BSMobile application (only for iPhone) 
<hp_bsmobile_application_on_iphone>:///?viewName=CI%20Alerts%20Vi
ew&ciName=bpm1,ciId=1;;78ef8643bf78b75a0d922c1890e9bd1f&

For more details log into HP Business Service Management

For more details log into <url>
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Additional Parameters

The additional parameters are:

Click to display the CI 
details in the HP 
BSMobile application 
(only for iPhone)

Click the link to open the selected CI in the iPhone 
application. This link only works when you have 
HP BSMobile installed on your iPhone. For details, see 
"The BSMobile iPhone Application" on page 369.

For more details log 
into url

Click the link to the URL of the HP Business Service 
Management Data Processing Server to open the 
application where the CI Status alert was triggered.

Over Time Report Click to open the KPIs Over Time report for the 
triggering KPI for a period of one day. If the relevant CI 
is part of a local impact view, the report is opened with 
the relevant local impact view selected in its filter. 

For user interface details, see "KPIs Over Time Report" 
on page 347.

CI Type Parameter

Business Unit Contact information. The business unit contact 
information.

Host ➤ IP. The IP number of the host.

➤ Vendor. The name of the vendor.

➤ Operating system. The type of operating system.

Siebel Application Server ➤ Version. The Siebel version that is in use.

➤ Language. The language that is in use.

SAP Application Server ➤ Version. The SAP version that is in use.

➤ IP. The IP number that is in use.

➤ Port. The number of the port that is in use.

UI Element (A-Z) Description
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Database ➤ Type. The type of database.

➤ Version. The version that is in use.

➤ Port. The number of the port that is in use.

Service ➤ Service Operating Status. The status of the 
operating system·

➤ Service Description. A description of the service.

CI Type Parameter
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Configuration Item Status Alerts Report

This report enables you to list all of the alerts that occurred in the specified 
period of time.

The following is an example of the Configuration Item Status Alerts report. 

To access Select:

➤ Applications > CI Status > CI Status Alerts

➤ Applications > Service Health > 360° View, left-click 
a CI, and select Reports > Configuration Item Status 
Alerts in the context menu.

Relevant tasks "How to View the Triggered CI Status Alerts and 
Notifications" on page 287
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Report Settings

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

<Common report 
elements>

See "Common Report and Page Elements" in Reports.

Configuration Items Lists the CIs that are included in the report.

To select CIs, click the Configuration Items link. For 
details, see "Configuration Items Dialog Box" on 
page 341.

KPIs Lists the KPIs that are included in the report.

To select KPIs, click the KPIs link. For details, see "KPIs 
Dialog Box" on page 342.
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Table Area

User interface elements are described below:

UI Element (A-Z) Description

Details. Opens the Configuration Item Status Alert 
Notification report for the selected alert, where you can 
see the alert notification details. For details, see 
"Configuration Item Status Alert Notifications Report" 
on page 295.

Alert Action The action that is triggered by the alert.

Note: Open an incident in Operations Manager 
indicates that the alert should have opened an incident 
in Operations Manager when the alert was triggered 
and communication with OM was established. For 
details about establishing communication with OM, 
see "How to Configure BSM Alerts to Forward an Event 
When the Alert is Triggered" in Solutions and 
Integrations. 

To see whether the incident was opened in Operations 
Manager, click the Detail button to go to the alert 
notification report. 

Alert Name The name of the alert.

Configuration Item The name of the CI the alert is attached to.

KPI  The name of the KPI.

Status The current status of the KPIs represented by a status 
icon. The change from previous status to current status 
triggers the alerts.

For details about the statuses, see "KPI Status Colors 
and Definitions" on page 45.

Time The time and date when the alert was triggered. The 
format is: dd/mm/yy hh:mm AM/PM (<region>) <offset>. 
For example: 5/20/10 8:59 AM (Eastern Daylight Time) -
0400.
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KPIs Dialog Box

This dialog box enables you to select the KPIs to be included in a CI Status 
Alerts report, for the duration of a Web session. The report provides 
information based on the selected KPIs.

User interface elements are described below:

To access In the CI Status Alerts report, click KPIs in the reports 
settings area.

Relevant tasks "How to View the Triggered CI Status Alerts and 
Notifications" on page 287

UI Element (A-Z) Description

KPIs Lists the KPIs that are attached to the selected CIs. 
Availability and Performance are listed first, then all 
other KPIs in alphabetical order.

Select the check boxes for the required KPIs.
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10
Neighborhood Map

This chapter includes:

Concepts

➤ Neighborhood Map Overview on page 314

Tasks

➤ How to Display and Customize the Neighborhood Map on page 317

Reference

➤ Neighborhood Map User Interface on page 321
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Concepts

Neighborhood Map Overview

Neighborhood Map displays the parent CIs and child CIs of a selected CI, in 
an interactive graphic. The CI bars in the map provide a visual 
representation of real-time IT performance metrics mapped onto business 
applications. Connecting lines between the bars represent the relationships 
between the CIs.

Links between the CIs are shown as defined in the RTSM, without View 
Folding. These links represent physical links, as they appear in the RTSM. 
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Tip: The Neighborhood Map is particularly useful if, for example, you want 
to explore the source of a problem which may come from a CI outside your 
monitored view.

Each CI in the view is displayed as a bar, with a color-coded icon overlaid on 
top of the CIT icon indicating the current worst operational status for that 
CI. The icons displayed below the name of the CI identify the relevant KPIs 
for the CI. These icons are also color coded to indicate the status of that KPI. 
For details on color coding, see "KPI Status Colors and Definitions" on 
page 45.
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The display of CI bars and links between CIs can be manipulated to change 
the amount of information displayed and the overall layout of the map, as 
described in "How to Display and Customize the Neighborhood Map" on 
page 317.

For UI details, see "Neighborhood Map User Interface" on page 321.

Plain Mode and Layer Mode
You can view CIs in Neighborhood Map in one of two modes:

➤ Plain mode. In plain mode, each CI is displayed on its own.

➤ Layer mode. In layer mode CIs are divided into functional layers, such as 
Business Enablement, Infrastructure, or Software. CIs are assigned to the 
layers based on their Layer attribute in the RTSM. For example, in layer 
mode the Application Resource and Application System CITs are assigned 
to the Software layer, based on their Layer attribute. 

In layer mode you can move CIs in and out of layers. You can also create 
additional layers using the Layer attribute in RTSM administration. 

The layers in Neighborhood Map are identical to the layers in Topology 
Map; for details on each of the default layers, see "Default Layers in 
Topology Map" on page 170.

Annotation
Within Neighborhood Map, you can click the Capture Result and Add 
Annotations button on the toolbar to access the annotation tool. You can 
use annotation to create and save a snapshot of the image you are viewing, 
and highlight important areas of the image. 

The annotation tool is identical in Neighborhood Map and Topology Map. 
For details on the tool, see "Annotation Tool Dialog Box" on page 183.
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Tasks

How to Display and Customize the Neighborhood Map

Create a page containing both Neighborhood Map and a component where 
CIs can be selected, such as View Selector or Top View. Select a CI to show its 
neighboring CIs in Neighborhood Map.

You can customize Neighborhood Map using the following options:

➤ "Move CIs within Neighborhood Map" on page 318

➤ "Change focus from one CI to another" on page 318

➤ "Organize Neighborhood Map in plain or layer mode" on page 318

➤ "Resize the display or navigate within Neighborhood Map" on page 319

➤ "Display minimal information or detailed information for each CI" on 
page 319

➤ "Display links between CIs" on page 320

➤ "Refresh the CI topology" on page 320

➤ "Modify the number of child and parent CI levels shown in 
Neighborhood Map" on page 320

Note: Customizing the Neighborhood Map display has no effect at all on 
the RTSM topology; your customizations only influence how CIs are 
displayed in this component.
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Move CIs within Neighborhood Map

To move CIs you must be in Selection mode. To activate Selection mode, 
click the Select button in the Neighborhood Map toolbar.

Click one or more CIs and drag them to a new location. If your 
Neighborhood Map displays links between CIs, the arrows attached to these 
CIs will be moved as well.

Change focus from one CI to another

When you select a CI, Neighborhood Map shows that CI with a highlighted 
border, together with its parent and child CIs. To change Neighborhood 
Map’s focus from the selected CI to a different CI, select the CI which you 
want to focus on, and click the Refocus button in the Neighborhood Map 
toolbar. You can also double-click a CI to change focus to that CI.

After you change focus, Neighborhood Map will highlight the CI which you 
are now focusing on, together with its parent and child CIs.

Organize Neighborhood Map in plain or layer mode

Neighborhood Map can be displayed in two modes:

➤ Plain Mode. Each CI stands on its own, not as part of a layer.

➤ Layer Mode. CIs are divided into functional layers (for example Business 
Enablement, Infrastructure, or Software). In layer mode you can move CIs 
in and out of the default layers, but you cannot rename or delete a layer.

To switch from one mode to another, select a mode from the drop-down list 
in the Neighborhood Map toolbar.
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Resize the display or navigate within Neighborhood Map

Some CIs may have a large Neighborhood Map, based on the number of 
parent and child CIs to which they are connected. You can use the following 
buttons in the toolbar to help you navigate within the Neighborhood Map 
display:

➤ Fit to screen. Click to fit the image to the pane, either by expanding it or 
by reducing it.

➤ Interactive Zoom Click to activate Zoom mode. In Zoom mode, click 
within Neighborhood Map and drag up or down to zoom in and out of 
the image.

➤ Pan. Click this button, then click within Neighborhood Map and drag the 
image to move it.

➤ Display Minimap. Click to display the Neighborhood Map image in a 
small window (minimap), which is overlaid on top of the standard 
Neighborhood Map. 

A highlighted area within the minimap image shows which part of the 
Neighborhood Map is displayed in the larger image. You can resize or 
move this highlighted area to focus on the part of Neighborhood Map 
which is of interest to you. To close the minimap window, click within 
the larger image.

Display minimal information or detailed information for each 
CI

Neighborhood Map can be displayed either in minimal presentation, which 
displays only CI icons and worst statuses, or in detailed presentation, which 
displays CI names and KPI statuses. To switch between minimal and detailed 
presentation, click the Toggle Presentation Type button in the 
Neighborhood Map toolbar.
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Display links between CIs

Neighborhood Map can display arrows between CIs that are linked, as well 
as link labels showing the relationship between two CIs (for example, 
Containment or Ownership).

➤ To see links, select Display Options > Show Links in the Neighborhood 
Map toolbar.

➤ To see link labels, select Display Options > Show Link Labels. Note that if 
the Show links option is de-selected, this option is disabled.

Refresh the CI topology

To enhance performance, Neighborhood Map does not reflect changes made 
to the CI topology within the RTSM.

If you have made changes to CI topology in the RTSM, click Refresh to 
update the CI topology display.

Modify the number of child and parent CI levels shown in 
Neighborhood Map

By default, when a CI is selected, Neighborhood Map shows two levels of its 
parent CIs and two levels of its child CIs. In other words, Neighborhood 
Map shows the selected CI in the context of its parent CIs and their parent 
CIs, as well as its child CIs and their child CIs.

You can modify this setting to display one, two, or three levels of CIs, using 
the following infrastructure setting: Admin > Platform > Setup and 
Maintenance > Infrastructure Settings > Applications > Service Health 
Application. Locate the Neighborhood map depth entry in the Service 
Health Application - Service Health Layout Properties table, and modify as 
required.
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Reference

Neighborhood Map User Interface

Neighborhood Map displays the parent CIs and child CIs of a selected CI, in 
an interactive graphic. The links between the CIs are shown as defined in 
the RTSM, without View Folding; links between the CIs represent their 
physical links as they appear in the RTSM. CIs can be displayed within 
Neighborhood Map divided into layers, enabling you to focus attention on 
the layer which interests you the most (for example Business Enablement, 
Infrastructure, or Software).

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Neighborhood Map Toolbar

To access Select Applications > Service Health > Neighborhood 
Map

Important 
information

Neighborhood Map is used together with another 
component which enables you to select a CI, such as 
View Selector or Top View.

Relevant tasks "How to Display and Customize the Neighborhood 
Map" on page 317

See also "Neighborhood Map Overview" on page 314

UI Element (A-Z) Description

Refresh. To enhance performance, Neighborhood Map 
does not reflect changes made to the CI topology 
within the RTSM. If you have made changes to CI 
topology in the RTSM, click Refresh to update the CI 
topology display.
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Refocus. To change Neighborhood Map’s focus from 
the selected CI to a different CI, select a CI and click 
Refocus.

Neighborhood Map changes focus to highlight the 
selected CI, and shows its parent and child CIs.

Select. In Select mode, you can select CIs or groups to 
perform actions on the selected elements. For details, 
see "How to Display and Customize the Neighborhood 
Map" on page 317.

Interactive Zoom. In Zoom mode, click within 
Neighborhood Map and drag up or down to zoom in 
and out of the image.

Pan. In Pan mode, if your Neighborhood Map image is 
scrollable you can click and drag the image to move it. 
(If the entire image fits within your screen this feature 
has no effect.)

Fit to screen. Click to fit the graph to the pane, either 
by expanding it or by reducing it. Relative proportions 
of the image are maintained.

Toggle Presentation Type. Click to switch between 
minimal view, which displays only CI icons and worst 
statuses, and detailed view, which also displays CI 
names and KPI statuses.

Click to open a dropdown list of display options. You 
can select or de-select each of the following options:

➤ Show links. If you select this option, Neighborhood 
Map displays arrows between CIs that are linked.

➤ Show link labels.If you select this option, 
Neighborhood Map displays each link together with 
its link type (for example, Containment or 
Ownership). If the Show links option is de-selected, 
this option is disabled.

UI Element (A-Z) Description
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Click to select between the following display modes:

➤ Plain Mode. Each CIs is displayed standing on its 
own.

➤ Layer Mode. Neighborhood Map displays related 
higher-level CIs in layers; for example, Business 
Element CIs are displayed in the Business 
Enablement layer, while Node and Node Element 
CIs are displayed in the Infrastructure layer. 

For details, see "Neighborhood Map Overview" on 
page 314.

Display Minimap. Click to display the Neighborhood 
Map image in a small window (minimap), which is 
overlaid on top of the standard Neighborhood Map.

A highlighted area within the minimap image shows 
which part of the Neighborhood Map is displayed in 
the larger image. You can resize or move this 
highlighted area to focus on the part of Neighborhood 
Map which is of interest to you. To close the minimap 
window, click within the larger image.

Capture Result and Add Annotations. Click to open the 
Annotation Tool, which creates a snapshot of the 
Neighborhood Map and enables you to annotate the 
snapshot to highlight important areas. The tool 
enables you to draw in the snapshot, or add lines or 
text to the image. For details, see "Annotation Tool 
Dialog Box" on page 183.

UI Element (A-Z) Description
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Neighborhood Map Display

UI Element (A-Z) Description

<CI nodes> Each CI in the selected view is displayed as a bar within 
Neighborhood Map, which contains the following 
elements:

➤ The left side of the bar shows an icon indicating the 
CI’s CI type, as represented in the RTSM.

➤ CI aggregated status is overlaid on top of the CIT 
icon.

➤ If Neighborhood Map is in detailed view, the CI 
name and KPI statuses are also displayed.

Tooltips: The tooltip for a CI shows the CI name and CI 
type. The tooltip for a KPI shows status and 
performance data for the KPI:

CI and KPI status are displayed as color-coded icons. 
For details, see "KPI Status Colors and Definitions" on 
page 45.

For details on customizing display settings, see "How to 
Display and Customize the Neighborhood Map" on 
page 317.

<layers of CIs> In layer mode, high-level CIs are displayed within 
layers that are divided by functionality, such as 
Business Enablement or Infrastructure. Each layer is 
shown in a separate shaded area, labeled by the layer 
name. 

Layers cannot be renamed or deleted; CIs can be 
removed from layers, or added to them.
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<links between CIs> In the list of Display options, if you select Show links, 
Neighborhood Map displays arrows between CIs that 
are linked within the RTSM.

If you also select the Show link labels option, 
Neighborhood Map also displays the link type (for 
example, Containment or Ownership).

<minimap image> If you click the Display Minimap button, the 
Neighborhood Map image appears in a small window 
(minimap), overlaid on top of the standard 
Neighborhood Map.

The highlighted area shows which part of the 
Neighborhood Map is displayed in the larger image. 
Resize or move the highlighted area to focus on the 
part of Neighborhood Map which is of interest to you.

Last Update Displays when the information in the component was 
last updated.

To manually update CI statuses, click the Refresh icon.

UI Element (A-Z) Description
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11
Acknowledge Problems

This chapter includes:

Concepts

➤ Acknowledging Performance Problems Overview on page 328

Tasks

➤ How to Acknowledge Performance Problems on page 329

Reference

➤ Acknowledge Problems User Interface on page 332
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Acknowledging Performance Problems Overview

The Acknowledgment utility enables you to track performance problems 
identified in your system and network infrastructure by keeping a record of 
when the problem was acknowledged and by which user. 

For details on how to perform the task, see "How to Acknowledge 
Performance Problems" on page 329.

Note: Acknowledgement is linked to a CI and not to a view. If you clone a 
global view and create a local impact view with different indicator 
definitions, a KPI may have Critical status in the local impact view and OK 
status in the global view. When you add acknowledgement to the CI which 
has a Critical KPI in the local impact view, this acknowledgment is visible in 
the global view, even though the KPI has OK status there.
328
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How to Acknowledge Performance Problems

This section describes how to acknowledge a problem in Service Health.

This task includes the following steps:

➤ "Acknowledge a problem" on page 329

➤ "View a problem’s history" on page 330

➤ "Display/hide the acknowledgement column in the Hierarchy component 
– optional" on page 331

 1 Acknowledge a problem

You can acknowledge a problem in the following ways:

➤ Hierarchy. In the Hierarchy component, set or unset acknowledgement 
for a CI by clicking the icon  in the Ack column; a check mark 
indicates that acknowledgement has been set. For user interface 
details, see "Acknowledgments Details Dialog Box" on page 333.

➤ CI context menus. In components which contain context menus on 
CIs, you can use the following CI context menus to work with 
acknowledgement: Operations > Set/Unset Acknowledgement, and 
Operations > Acknowledgement Details.

➤ Top View. In Top View, the acknowledgement icon  is displayed for CIs 
which have been acknowledged, with a tooltip containing details.
329
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 2 View a problem’s history

After a problem CI is acknowledged, or the acknowledged status is 
cleared, you can view the CI’s history in the Acknowledgment History 
and Details dialog box.

A tooltip for the Ack icon displays the current status of the CI’s 
acknowledgment. 

To view the details of the current acknowledgment or the 
acknowledgment history of the CI, access a CI’s menu commands and 
select Operations > Acknowledgment Details. You can then select one of 
the following options:

➤ Acknowledgment details. Displays the details of the currently opened 
acknowledgment.

➤ CI history. Displays the details of all of the acknowledgments over 
time.

In the following example, the CI history shows that a problem was 
acknowledged on a CI at 12:16, and marked as resolved at 12:21.
330
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The Acknowledgment details box displays the date and time when the 
acknowledgment status was modified, the name of the user who modified 
the status, and the type of action that was performed. For user interface 
details, see "Acknowledgment History and Details Dialog Box" on 
page 332.

You can add information about the actions you are going to perform to 
solve the problem in the Add details box, and then click Add to add the 
information you entered to the acknowledgment history.

 3 Display/hide the acknowledgement column in the Hierarchy 
component – optional

By default, the acknowledgement column (Ack) is displayed in the 
Hierarchy component. The column can be hidden by users with 
administrative permissions. To hide/display the Ack column, select Admin 
> Platform > Setup and Maintenance > Infrastructure Settings:

➤ Select Applications.

➤ Select Service Health Application.

➤ In the Service Health Layout Properties area, locate Show CI 
Acknowledgment column. Change the value to false (hide the Ack 
column), or true (display the Ack column). The change takes effect 
immediately. 

Note: When you hide the Ack column, the Acknowledgment-related 
context menu options remain available. For details, see "Service Health 
Menu Options" on page 98.
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Acknowledge Problems User Interface

This section includes:

 ➤ Acknowledgment History and Details Dialog Box on page 332

 ➤ Acknowledgments Details Dialog Box on page 333

Acknowledgment History and Details Dialog Box

This dialog box enables you to view the details of the current 
acknowledgment or the acknowledgment history of the CI.

User interface elements are described below:

To access Access menu commands for a CI and select Operations > 
Acknowledgment details. 

Relevant tasks "How to Acknowledge Performance Problems" on page 329

UI Element (A-Z) Description

Acknowledgment 
details

Select to display the details of the currently opened 
acknowledgment in the Acknowledgment details box. 

Action The type of action that was performed:

➤ Clear. When the acknowledgment history was 
cleared.

➤ Unset. When the acknowledgment was unset.

➤ Info. Details were added to the acknowledgment 
without changing the acknowledgment status.

➤ Open. When the acknowledgment was set.

➤ Edit. When details were added to the 
acknowledgment.
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Acknowledgments Details Dialog Box

This dialog box enables you to set or unset a CI acknowledgment.

Add Click the Add button to add the contents of the Add 
details box to the acknowledgment history.

Add details Add information about the actions you are going to 
perform to solve the problem. You can add information 
whether the acknowledgment is Open or Closed.

CI history Select to display the details of all of the 
acknowledgments over time in the Acknowledgment 
details box.

Clear Click the Clear button to clear the acknowledgment 
history.

Date The date and time when the acknowledgment status 
was modified.

Message Displays the status of the acknowledgment or the 
information that was entered in the Add details box.

User The name of the user who modified the status.

To access ➤ Access menu commands for a CI, and select 
Operations > Set/Unset Acknowledgment.

➤ Click the Ack icon to the right of a CI.

Important 
information

The Ack icon is enabled only if there is at least one KPI 
defined for the CI.

A tooltip for the Ack icon displays the current status of 
the CI’s acknowledgment.

The dialog box is a toggle dialog box. If you have 
acknowledged the CI, the top line in the dialog box is: 
The acknowledgment will be unset. If you have not 
acknowledged the CI, the top line in the dialog box 
displays: The acknowledgment will be set.

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Add details Add information about the actions you are going to 
perform to solve the problem. You can add information 
whether the acknowledgment is Open or Closed.

OK Click the OK button to set or unset the acknowledgment 
depending on the previous status of the dialog box.
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12
CI Status Reports 

This chapter includes:

Concepts

➤ CI Status Reports Overview on page 336

Tasks

➤ How to View KPIs Over Time Information on page 338

Reference

➤ CI Status Reports User Interface on page 340

Troubleshooting the Reports on page 365
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Concepts

CI Status Reports Overview

CI Status reports enable you to view and analyze performance data collected 
by BSM data collectors and stored in the BSM database. 

The CI Status reports are:

➤ KPIs Summary. Displays a summary of KPI status distribution over time 
for each selected KPI. For details, see "KPIs Summary Report" on page 358.

➤ KPIs Trend. Displays the trend for changes in KPI status over time, for 
selected statuses. For details, see "KPIs Trend Report" on page 361.

➤ KPIs Distribution Over Time. Displays KPI status distribution over time for 
selected statuses. For details, see "KPIs Distribution Over Time Report" on 
page 343.

➤ KPIs Over Time. Displays the status or value, over time, of selected CIs and 
KPIs that are accessible from the Service Health application. For details, 
see "KPIs Over Time Report" on page 347.

➤ CI Status Alert. Provides information about the CI Status alerts that were 
triggered in the past. For user interface details, see "Configuration Item 
Status Alerts Report" on page 309.

You can print the generated report, send the report by email, open the 
report in different formats, publish the report in different formats, or save 
the report to the report repository. For details, see "Working in Reports - 
Overview" in Reports.
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Generating KPI Summary, Trend, and Distribution Over 
Time Reports
The KPI Summary, KPI Trend, and KPI Distribution Over Time reports are 
available for CIs that fill the following conditions:

 1 By default, these reports can only be generated for CIs which have the 
Store KPI History For Over Time Reports attribute value of true in RTSM. 
You can enable or disable this ability within RTSM administration, using 
the Store KPI History For Over Time Reports attribute on each CIT.

 2 To save status changes for a KPI for over time reports, the KPI must be 
attached to a CI whose Save KPI data over time for the selected CIs 
option has been selected. For details, see "CI Data Pane > CI Properties 
Tab" on page 460. 

This option is selected by default for logical CIs, and for CIs that are 
important for problem isolation, such as Business Application, Business 
Process, Business Service, and Host.

 3 If you also want to save data on actual measurements for KPIs (and not 
just status changes), you must activate the saveValuesToPersistency global 
parameter in the Business Rule Repository. For details, see "Persistent Data 
and Historical Data" on page 411. 

Note: 

➤ Data is displayed in a report starting from the point that data was 
collected for the selected CIs. For example, if you set the report to show 
data every week for the past month, but data was collected only for the 
past two weeks, the report shows data starting from two weeks ago to the 
present date.

➤ HP Business Service Management records in a reports log errors that 
occur when generating reports. The reports log can also include the 
following activities: creating a new report, generating a report, modifying 
the report filters, drilling down in reports, and so on. For details on the 
reports log, see "Reports Log" in Reports.
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Tasks

How to View KPIs Over Time Information

The steps below describe the process used to set up to view KPIs over time 
information in Service Health.

This task includes the following steps:

➤ "Save KPI status information for the KPIs Over Time reports" on page 338

➤ "Access KPIs Over Time reports" on page 338

➤ "Drill down to HP Diagnostics" on page 339

➤ "Access KPIs Distribution Over Time report" on page 339

➤ "Access the KPIs Summary report" on page 339

➤ "Access the KPIs Trend report" on page 339

 1 Save KPI status information for the KPIs Over Time reports

Persistent data is used to produce KPIs Over Time reports with status 
information, as described in "KPIs Over Time Report" on page 347. Set the 
Save KPI data over time for this CI option to save the calculated 
measurement for each of the CI KPIs, at 15 minute intervals (default 
value). This is done by activating the saveValuesToPersistency global 
attribute in the Business Rule Repository. For concept details, see 
"Persistent Data and Historical Data" on page 411.

This option is selected, by default, for Business Services, Applications, 
Business Processes and others. This option is not available for Monitor 
type CIs.

 2 Access KPIs Over Time reports

You can access the KPIs Over Time reports from different locations in 
HP Business Service Management.

For user interface details, see "KPIs Over Time Report" on page 347.
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Note: The context menu includes the KPIs Over Time Report option for 
all CIs, but the report displays data only for CIs whose KPIs are persistent. 
For details, see "Persistent Data and Historical Data" on page 411.

 3 Drill down to HP Diagnostics 

If HP Diagnostics integrates with HP Business Service Management, you 
can drill down to HP Diagnostics views from the KPIs Over Time report for 
Business Transaction CIs in the End User Monitors views, and for the 
Diagnostics Probe Group, and Diagnostics Probe CIs in the Diagnostics 
View. For user interface details, see "KPIs Over Time Report" on page 347.

 4 Access KPIs Distribution Over Time report

KPIs Distribution Over Time report enables you to analyze KPI trend by 
viewing KPI status distribution over time for selected statuses. For user 
interface details, see "KPIs Distribution Over Time Report" on page 343.

 5 Access the KPIs Summary report

KPIs Summary report enables you to view a summary of KPI status 
distribution over time for each selected KPI. For user interface details, see 
"KPIs Summary Report" on page 358.

 6 Access the KPIs Trend report

KPIs Trend report enables you to analyze the trend for changes in KPI 
status over time, for selected statuses. For user interface details, see "KPIs 
Trend Report" on page 361.
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Reference

CI Status Reports User Interface

This section includes (in alphabetical order):

 ➤ Configuration Items Dialog Box on page 341

 ➤ KPIs Dialog Box on page 342

 ➤ KPIs Distribution Over Time Report on page 343

 ➤ KPIs Over Time Report on page 347

 ➤ KPIs Summary Report on page 358

 ➤ KPIs Trend Report on page 361

 ➤ Statuses Dialog Box on page 365
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Configuration Items Dialog Box

This dialog box enables you to select the CIs to be included in a Service 
Health report, for the duration of a Web session. The report provides 
information based on the selected CIs.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In a Service Health report, click Configuration Items in 
the reports settings area.

Important 
information

Only CIs that meet the following criteria are available 
for selection:

➤ CIs with attached KPIs.

➤ CIs that are flagged to save KPI data over time 
(historical data).

➤ CIs whose CIT attributes in RTSM have the Store KPI 
History For Over Time Reports attribute value of 
true.

For details, see "Persistent Data and Historical Data" on 
page 411.

UI Element (A-Z) Description

<View tree> Displays the CIs in the selected view. Select the check 
boxes for the required CIs.

Browse The default mode for the Configuration Items dialog 
box, enabling you to select a view and CIs.
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KPIs Dialog Box

This dialog box enables you to select the KPIs to be included in a Service 
Health report, for the duration of a Web session. The report provides 
information based on the selected KPIs.

User interface elements are described below:

Search Click the Search link to move to Search mode, where 
you can search for CIs. For details, see "How to Search 
for CIs in Search Mode" in the Modeling Guide.

View Select the relevant view from the dropdown list (start 
typing in the view name to filter the list), or click the 
ellipsis button to open the Select View dialog box, 
where you can select a view from the view folders tree.

Note: Only the CIs selected in the currently displayed 
view are saved for the report filter when you click OK. 
If you select another view before clicking OK, all 
previous CI selections are discarded.

To access In a Service Health report, click KPIs in the reports 
settings area.

Important 
information

You must define at least one CI for the report before 
you can select KPIs.

UI Element (A-Z) Description

KPIs Lists the KPIs that are attached to the selected CIs. 
Application Availability and Application Performance 
are listed first, then all other KPIs in alphabetical order.

Select the check boxes for the required KPIs.

UI Element (A-Z) Description
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KPIs Distribution Over Time Report

This report displays KPI status distribution over time for selected statuses.
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Report Settings

To access Select Applications > CI Status > KPIs Distribution Over 
Time

Important 
information

This report is produced only for certain CIs with 
historical KPI data. For details, see "Configuration 
Items Dialog Box" on page 341.

See also "Configuration Items Dialog Box" on page 341

UI Element (A-Z) Description

<Common report 
settings>

See "Common Report and Page Elements" in Reports.

Configuration Items Displays the name of the selected CI for the report, and 
if more than one CI is selected, indicates the number of 
CIs that the report is based on. For example, 
Filtered (4) means that four CIs are selected for 
inclusion in the report.

Click the Configuration Items link to open the 
Configuration Items dialog box where you can select 
CIs.
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KPIs Indicates the number of KPIs that are included in the 
report, and the total number of KPIs that are attached 
to the selected CIs separated by a slash; for example, 
Filtered (1/3). 

All is displayed when all available KPIs are selected.

Click the KPIs link to open the KPIs dialog box where 
you can select KPIs.

Default value: All KPIs are selected automatically.

Statuses Indicates the number of statuses that are included in 
the report and the 7 possible statuses separated by a 
slash; for example, Filtered (5/7).

Click the Statuses link to open the Statuses dialog box 
where you can select statuses.

Default value: All statuses that are defined as 
non-critical are selected, and All Non-Critical Statuses 
is displayed. For details, see "Statuses Dialog Box" on 
page 365.

UI Element (A-Z) Description
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Report Content

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element Description

<Bar chart> Each KPI instance for each CI is displayed in a separate 
bar chart (as long as there is relevant data for the KPI 
on that CI). Each chart shows status distribution (in 
percentage) for the KPI over the selected time frame. 

<Bar> Each bar in a chart represents a time interval, 
according to the granularity selected for the report. For 
example, if the selected granularity is every 1 week, 
then each bar represents a week during the overall time 
frame. The legend for the x-axis shows the time 
interval for each bar.

Each bar is divided into colored status sections, 
according to the statuses selected for inclusion in the 
report, so that each section represents the percentage 
of time that the status was held by the KPI during that 
time interval.

Tooltip: Hold the pointer over a bar section to display a 
tooltip containing the following information:

➤ Status. The name of the status represented by the 
section.

➤ Status Duration. Amount of time that the KPI held 
this status during the time interval. This can be 
given in hours, minutes, and seconds (for example, 
01:10:48) or in days and hours (for example, 30 
days, 9 hours).

➤ Status Percentage. Percentage of the time interval 
that the KPI held this status. 
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KPIs Over Time Report

This report enables you to view the status or the value, over time, of selected 
KPIs and CIs, in table or graph format.

For example, when you encounter a problem with a specific CI while 
viewing the Service Health, and the Application Performance and 
Application Availability KPIs are attached to that CI, you can view the KPIs 
Over Time report of that CI’s Application Performance and Application 
Availability. You can also receive a daily report showing all CIs statuses in the 
past day.

To access Select Applications > CI Status > KPIs Over Time. The 
report is also available from the context menu of CIs in 
Service Health.
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Important 
information

The report displays the status or value of each CI and 
each instance of the attached KPIs. For example, when 
you select one CI with the Application Availability and 
Application Performance KPIs, and another CI with the 
Application Availability KPI the report has only three 
rows.

➤ You can:

➤ Add this report to a custom report. For details, see 
"Customizing Reports" in Reports. 

➤ Schedule when to run the report. For details, see 
"Report Schedule Manager Main Page" in Platform 
Administration.

➤ The report provides KPI information for higher level 
CIs such as Business Services, Application, and 
Business Processes CIs. To obtain similar 
information about monitored CIs, see "CI Status 
Reports User Interface" in Using End User 
Management, or "Trend Reports" in Reports.

➤ The context menu of all CIs except monitor CIs 
includes the KPIs Over Time Report option. 

➤ The report displays data only for CIs with persistent 
KPIs. For details, see "Persistent Data and Historical 
Data" on page 411.

➤ There is no limit to the number of lines that can be 
displayed in the table. If displaying the table slows 
performance, limit the time period or the number of 
CIs and KPIs to be displayed.

➤ If a CI has no valid child CIs, the drill to children 
option is disabled. If a CI has no valid parent CI, the 
drill to parent option is disabled.

Relevant tasks "How to View KPIs Over Time Information" on 
page 338
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Report Settings

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

<Common report 
settings>

See "Common Report and Page Elements" in Reports.

Configuration Items Indicates the number of CIs that are included in the 
report. For example, Filtered (4) means that four CIs 
are selected for inclusion in the report.

To select CIs, click the Configuration Items link. For 
details, see "Configuration Items Dialog Box" on 
page 341.

KPIs Indicates the number of KPIs that are included in the 
report, and the total number of KPIs that are defined 
for the selected CIs separated by a slash, for example, 
Filtered (1/3). 
All is displayed when all available KPIs are selected.

To select KPIs, click the KPIs link. For details, see "KPIs 
Dialog Box" on page 342.

Default value: When you select one or more CIs and 
the Application Performance and Application 
Availability KPIs are assigned to those CIs, the KPIs are 
automatically selected.
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KPIs Over Time Report with Status Data

The following is an example of the KPI Over Time report with status data. 

Report type Select:

➤ Statuses. To display the status information in the 
report. For details, see "KPIs Over Time Report with 
Status Data" on page 350. The KPIs Over Time report 
with status data displays only the status of the 
selected KPIs for the selected CIs. Those KPIs may 
also have values in the RTSM but the report does not 
show the values. 

➤ Values. To display the value information in the 
report. For details, see "KPIs Over Time Report with 
Value Data" on page 355. The KPIs Over Time report 
with values data displays only the value of the 
selected KPIs for the selected CIs. Those KPIs may 
also have statuses in the RTSM but the report does 
not show the statuses. 

UI Element (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

The report displays data only for CIs whose KPIs are 
persistent. For details, see "Persistent Data and 
Historical Data" on page 411.

Ensure that the Save KPI data over time for this CI 
option has been selected for the CI. For details, see "CI 
Indicators Tab" on page 453.

Note: The statuses are shown over time, starting with 
the event and ending with the next event. 

The report displays only the status of the relevant KPIs. 
Those KPIs may also have values in the RTSM but the 
status report does not show those values.

UI Element (A-Z) Description

Click to display status information about the children 
that contribute to the status of the selected CI’s KPI.

Note: Drilling down to the level of the monitored CIs 
is unavailable as there is no calculated status for those 
CIs and only raw data is available. To obtain similar 
information about the KPIs of monitored CIs, see 
"Status Reports User Interface" in Using End User 
Management, or "Trend Reports" in Reports.

If the selected CI and KPI do not have influencing 
children, then the report displays the message: No 
influencing children found.
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Click to display status information about the parents of 
the CI whose status is influenced by the status of the 
selected CI’s KPI. A CI may have more than one parent 
but the parent CIs that are displayed in the report are 
the parent CIs that are part of the view.

Note: You can drill up to influenced parents only when 
the CIs have persistent data.

If the selected CI and KPI do not have influenced 
parents, then the report displays the message: No 
influenced parents found.

<Drill down> This capability is available only in graph format.

Click any time segment in the graph time footer to drill 
down (zoom) on all of the CI and KPI information for 
that period of time. The time segment you zoom on is 
split into four equal parts that can also be zoomed until 
each time segment is one minute long.

The From date and time of the segment you select 
becomes the From date and time of the whole time 
footer and the To date and time of the segment you 
select become the To date and time of the whole time 
footer.

Example: If the time period you selected is from 7/13/05 
8:51 AM till 7/13/05 4:44 PM, the time footer is split 
into four equal segments. If you drill down on the first 
segment of the time footer, the From date and time of 
that segment is 7/13/05 8:51 AM, and its To date and 
time is what is indicated under the second tick of the 
time footer: 7/13/05 11:29 AM. The drilled down report 
time From and To fields display those dates and times, 
and the time footer of the report displays this period of 
time split into four equal parts: (11:29-8:51)/4=39 mn. 
The first part starts at 8:51 AM, and ends at 
8:51+:39=9:30, the second part starts at 9:30 and ends 
at 9:30+:39=10:09, and so on.

UI Element (A-Z) Description
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<Drill down to 
Diagnostics>

If HP Diagnostics is enabled, you can drill down to 
HP Diagnostics views from the KPIs Over Time report. 

To access the drill down options, click the down arrow 
to the right of a Business Transaction CIs in the 

End User Monitors View, and of the Diagnostics Probe 
Group, and Diagnostics Probe CIs in the Diagnostics 
View and select one of the options. For information 
about the available options, see "Drill Down to 
HP Diagnostics" on page 356.

The context menu options that are available from the 
KPIs Over Time report are a subset of the Drill to 
Diagnostics options available in Service Health. For 
details, see "Drill Down to HP Diagnostics" on 
page 356.

<Tooltip> Move the cursor above the graph to display more 
information about the KPI. The background of the 
tooltip reflects the color of the status calculated by the 
rule attached to the KPI and according to the KPI’s 
objectives. 

The tooltip displays the name of the KPI in the tooltip 
title and the following information:

➤ Configuration Item. The name of the CI to which 
the current KPI is assigned.

➤ Status. The status of the KPI.

➤ Start Time. The time when an event occurred, 
starting the sampling period for that event.

➤ End Time. The time when a new event occurred, 
ending the sampling period of the previous event.

➤ Duration. The duration of the sampling period.

Configuration Item The name of the selected configuration item.

Duration Note: This field appears only when the report is in 
table format.

The duration of the sampling period.

UI Element (A-Z) Description
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End Time Note: This field appears only when the report is in 
table format.

The time when a new event occurred, ending the 
sampling period of the previous event.

KPI The name of the KPI. 

Start Time Note: This field appears only when the report is in 
table format.

The time when an event occurred, starting the 
sampling period for that event.

Status When the report is in table format, Status displays the 
status of each KPI of each CI, according to the selected 
granularity, during the selected time period.

When the report is in graph format, Status displays the 
status of the KPI as a background color during the 
selected time period. A tooltip is available for each cell 
in the graph (see <Tooltip> for details).

UI Element (A-Z) Description
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KPIs Over Time Report with Value Data

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

<Graph> Displays the value of the KPI assigned to a specific CI at 
the specified time (indicated by a colored line).

When you select two KPIs and more than one CI, each 
pair of KPIs is displayed in a separate graph. The left y-
axis displays the scale of the first KPI and the right 
y-axis displays the scale of the second KPI.

When you select one KPI, the Y-axis displays the scale 
for the KPI, a line displays the value of the KPI over 
time, and faint colored horizontal lines show the KPI 
objectives (the colors correspond to the objective 
colors of the KPI).

A legend lists the name of the CI, the name of the KPI 
and the color used to represent the KPI value.
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Drill Down to HP Diagnostics 

The following table displays the Diagnostics drill down options for CIs in 
KPIs Over Time reports:

<Time period> This field appears only in table format.

Each column represents a time segment corresponding 
to the selected granularity of the selected time period. 
The table displays the value of the KPI in the time 
segment.

<Tooltip> This field appears only in graph format.

Move the pointer over any dot in the graph to display 
the value of the KPI at this point.

Configuration Item This field appears only in table format.

The name of the selected configuration item.

KPI This field appears only in table format.

The name of the KPI. Each selected KPI is displayed in a 
separate line.

CI Type Diagnostics Drilldown Options

Diagnostics Probe Group ➤ Summary View (Probe Group Summary)

➤ Layers View (Load)

Diagnostics Probe ➤ Summary View (Probe Summary)

➤ Layers View (Load)

Business Transaction ➤ Transactions View

➤ Layers View

UI Element (A-Z) Description
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The HP Diagnostics views accessed with the context menu options that are 
available from the KPIs Over Time report are as follows:

HP Diagnostics Views Description

Summary View Note: This option is available for all Diagnostics 
Probe CIs. This option is displayed only if you have 
Diagnostics installed. 

Opens the Probe Summary View in the 
HP Diagnostics application, for the probe group and 
for the time frame specified in the View box in the 
KPIs Over Time report. 

For more information about Diagnostics, see the 
HP Diagnostics User’s Guide.

Layers View Note: This option is available for all Business 
Process Monitor, and Diagnostics Probe CIs. This 
option is displayed only if you have Diagnostics 
installed. 

The Layers (Load) view displays the performance 
metrics for the Diagnostics layers where processing 
has taken place in your application, for the 
transaction that corresponds to the Business Process 
Monitor CI or for the selected Probe CI and for the 
time frame specified in the View box in the KPIs 
Over Time report. 

For more information about Diagnostics, see the 
HP Diagnostics User’s Guide.

Transactions View Note: This option is available for all Business 
Transaction CI. This option is displayed only if you 
have Diagnostics installed. 

The Transactions view displays performance metrics 
for the transactions that are being executed by your 
applications, with the transaction corresponding to 
the Business Transaction CI highlighted, and for the 
time frame specified in the View box in the KPIs 
Over Time report. For more information about 
Diagnostics, see the HP Diagnostics User’s Guide.
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KPIs Summary Report

This report displays a summary of KPI status distribution over time for each 
selected KPI.

To access Select Applications > CI Status > KPIs Summary

Important 
information

This report is produced only for certain CIs with 
historical KPI data. For details, see "Configuration 
Items Dialog Box" on page 341.

See also "Configuration Items Dialog Box" on page 341
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Report Settings

UI Element (A-Z) Description

<Common report 
settings>

See "Common Report and Page Elements" in Reports.

Configuration Items Displays the name of the selected CI for the report, and 
if more than one CI is selected, the number of CIs that 
the report is based on. For example, Filtered (4) means 
that four CIs are selected for inclusion in the report.

Click the Configuration Items link to open the 
Configuration Items dialog box where you can select 
CIs.

KPIs Indicates the number of KPIs that are included in the 
report, and the total number of KPIs that are attached 
to the selected CIs separated by a slash; for example, 
Filtered (1/3). 

All is displayed when all available KPIs are selected.

Click the KPIs link to open the KPIs dialog box where 
you can select KPIs.

Default value: If the Application KPI is attached to any 
of the selected CIs, this KPI is selected automatically.
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Report Content

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element Description

<Pie chart> Each pie chart represents a KPI instance (name 
displayed at the top) for a CI (name displayed on the 
left), and summarizes the statuses for the KPI over the 
selected time frame (as long as there is relevant data for 
the KPI on that CI). 

Each pie chart is divided into colored status slices, so 
that each slice represents the percentage of time that a 
particular status was held by the KPI. 

Tooltip: Hold the pointer over a pie slice to display a 
tooltip containing the following information:

➤ Status. The name of the status represented by the 
slice.

➤ Status Duration. The amount of time that the KPI 
held this status during the time frame. This can be 
given in hours, minutes, and seconds (for example, 
01:10:48) or in days and hours (for example, 30 
days, 9 hours).

➤ Status Percentage. The percentage of the time that 
the KPI held this status

Functionality: Right-click a pie for animation 
functionality. For more information, see "Adobe Flash 
Player in Reports" in Reports.
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KPIs Trend Report

This report displays the trend for changes in KPI status over time, for 
selected statuses.

To access Select Applications > CI Status > KPIs Trend

Important 
information

➤ This report is produced only for certain CIs with 
historical KPI data. For details, see "Configuration 
Items Dialog Box" on page 341.

➤ Data is displayed in the report starting from the 
point that data was collected for the selected CIs. For 
example, if you set the report to show data every 
week for the past month, but data was collected 
only for the past two weeks, the report shows data 
from two weeks ago to the present date.

See also "Configuration Items Dialog Box" on page 341
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Report Settings

UI Element (A-Z) Description

<Common report 
settings>

See "Common Report and Page Elements" in Reports.

Configuration Items Displays the name of the selected CI for the report, and 
if more than one is selected, indicates the number of 
CIs that the report is based on. For example, 
Filtered (4) means that four CIs are selected for 
inclusion in the report.

Click the Configuration Items link to open the 
Configuration Items dialog box where you can select 
CIs.

Group by Select a radio button to determine how the data is 
organized:

➤ CIs. A separate chart is displayed for each CI, 
containing trend data for all relevant KPIs.

➤ KPIs. A separate chart is displayed for each KPI, 
containing trend data for all relevant CIs.
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Report Content

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

KPIs Indicates the number of KPIs that are included in the 
report, and the total number of KPIs that are attached 
to the selected CIs separated by a slash; for example, 
Filtered (1/3).

All is displayed when all available KPIs are selected.

Click the KPIs link to open the KPIs dialog box where 
you can select KPIs.

Default value: If the Application KPI is attached to any 
of the selected CIs, this KPI is selected automatically.

Statuses Indicates the number of statuses that are included in 
the report, and the seven possible statuses separated by 
a slash; for example, Filtered (5/7).

Click the Statuses link to open the Statuses dialog box 
where you can select statuses.

Default value: All statuses that are defined as 
non-critical are selected, and All Non-Critical Statuses 
is displayed. For details, see "Statuses Dialog Box" on 
page 365.

UI Element (A-Z) Description

<Chart in report> A separate chart is displayed for each included CI, or 
for each included KPI, depending on the Group by 
filter selection. Each chart shows status trend (in 
percentage) over time, within the selected time frame 
(as long as there is relevant data for the KPI on that CI).

UI Element (A-Z) Description
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<Line on chart> Each line on the chart represents the status trend for a 
specific KPI on a specific CI, based on a compilation of 
all statuses selected in the Statuses filter. A legend is 
given to distinguish each KPI or CI.

The points for the line are plotted at the intervals 
defined by the report granularity (the legend for the 
x-axis shows the time interval for each point), so that 
each point represents a period of time during the 
overall time frame.

Each point shows the percentage of time that the KPI 
held all included statuses during that time interval. For 
example, if the KPI had OK status for 10% of the time 
interval, and Warning status for 20%, and both of these 
statuses are included in the Statuses filter, then both 
periods are included in the total percentage (adding 
30% to the total).

Tooltip: Hold the pointer over a point on the line to 
display a tooltip containing the following information:

➤ Status Duration. The total time that the KPI held the 
included statuses during the time interval. This can 
be given in hours, minutes, and seconds (for 
example, 01:10:48) or in days and hours (for 
example, 30 days, 9 hours).

➤ Status Percentage. Percentage of the time interval 
that the KPI held the included statuses. 

Note: When one line is on top of another, the 
information is the same for both lines.

UI Element (A-Z) Description
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Statuses Dialog Box

This dialog box enables you to select the KPI statuses to be included in a 
Service Health report, for the duration of a Web session. The report provides 
information based on the selected statuses.

Troubleshooting the Reports

HP Business Service Management records, in a reports log, errors that occur 
when generating reports. The reports log can also include information about 
the following activities: creating a new report, generating a report, 
modifying the report filters, drilling down in reports, and so on. For details 
on the reports log, see "Reports Log" in Reports.

To access In a Service Health report, click Statuses in the reports 
settings area.

Important 
information

➤ You must define at least one CI for the report before 
you can select statuses. 

➤ When you first select the CIs for the report or open 
the report, the default status selection is 
automatically applied. The default selection is for all 
statuses that are defined as non-critical, meaning all 
statuses other than Critical.

You can modify the definition of non-critical 
statuses in the Infrastructure Settings page:
Select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select 
Service Health Application, and locate the Default 
Non-Critical Statuses entry in the Business Report 
Properties table. Modify the value to include or 
exclude the required statuses.



Chapter 12 • CI Status Reports

366



367

13
Service Health on a Mobile Device

This chapter includes:

Concepts

➤ Service Health on a Mobile Device Overview on page 368

➤ The BSMobile iPhone Application on page 369

Tasks

➤ How to View Data on a Mobile Device on page 371

Reference

➤ Mobile Device User Interface on page 373
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Concepts

Service Health on a Mobile Device Overview

You can display the operational status of components of your business using 
mobile devices with a browser that supports standard HTML. 

Note: When using the Legacy Mobile Console to communicate with BSM, 
use secure communication (https). If you use unsecured communication 
(http), authentication credentials (user and password) are transmitted to 
BSM using clear text. Note that this is only related to the Legacy Mobile 
Console, and is not relevant for the BSMobile iPhone application.

The configuration items (CIs) are shown in layers where each parent CI is a 
link to the layer of its children CIs. The status of the CI’s Key Performance 
Indicators (KPIs) is displayed on the right of the screen. For details, see "How 
to View Data on a Mobile Device" on page 371, and "Mobile Device User 
Interface" on page 373.

Note: For information on viewing Service Health information on an iPhone, 
iPad, or iPod Touch, see "The BSMobile iPhone Application" on page 369.
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The BSMobile iPhone Application

The BSMobile iPhone application is a free download that enables you to 
keep track of your monitored CIs while away from your computer, using 
iPhone, iPad, or iPod Touch.

BSMobile enables you to:

➤ Track real time CI statuses; you can monitor views with a UI similar to the 
Hierarchy or Top View components, or you can create a quick access CI 
Watch List.

➤ See full KPI details, and filter CIs by status.

➤ Find the root cause problematic CI or KPI.

➤ Email or send an SMS to a CI’s owner with details regarding the 
problematic CI.

➤ Receive alerts to your iOS device from BSM with a quick link to the 
BSMobile application. Note that this requires choosing the iPhone alert 
template in the alerts configuration; for details, see "How to Create a CI 
Status Alert Scheme and Attach it to a CI" on page 503.
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To start using BSMobile, access the Apple AppStore from your iOS device 
(iPod/iPhone/iPad), or download the application from 
http://itunes.apple.com/us/app/hp-bsmobile/id383025746?mt=8.

Note: BSMobile uses the BAMOpenAPI; for additional information on APIs 
see "Service Health External APIs" on page 983.
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Tasks

How to View Data on a Mobile Device

You can display a view’s data on a mobile device using the steps described in 
this section. 

This task includes the following steps:

➤ "Prerequisites" on page 371

➤ "Access the server URL" on page 372

➤ "Change display characteristics – optional" on page 372

➤ "Navigate to the view and display the data" on page 372

 1 Prerequisites

Ensure that the server you want to access is open to Internet.

Ensure that the browser of the mobile device you want to use supports 
standard HTML.
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 2 Access the server URL

Enter the following URL in your mobile device: 
http://<HP Business Service Management 
server>/<HP_BSM_web_application_context_name (usually 
topaz)>/mobileConsole.do

Tip: 

➤ In the mobile device, you can add the URL to your Favorites at any 
stage (login, view, or drill down). Depending on the stage, clicking the 
Back button might not access higher hierarchy levels or the view 
selection page.

➤ You must click Refresh to refresh the display as the refresh feature is 
not automatic and the data becomes obsolete.

 3 Change display characteristics – optional

The display characteristics of the mobile console are controlled by an XSL 
file. To modify any aspect of the display using non-Latin characters (for 
example, displaying the view and button names: Back and Refresh), 
contact HP Software Support for help in writing an XSL to support this 
feature.

Note: The characters used for KPI names depend on the user’s locale and 
not on the browser’s locale.

 4 Navigate to the view and display the data

Enter the appropriate information in the login screen, and select a view. 
For user interface details, see "Mobile Device User Interface" on page 373.
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Mobile Device User Interface

This page enables you to display a view on a mobile device. 

To access Enter the appropriate information in the login screen, 
and select a view. 

Important 
information

➤ When more than a few KPIs are attached to the CI 
(depending on the device's screen resolution), the 
display becomes scrollable.

➤ Long CI names are wrapped. 

Note: Only the first four letters of the KPI names are 
displayed in the view. You might have to clone or 
rename some of the KPIs if their first four letters are the 
same; for example SAP and SAP Alert KPIs. All the 
feature’s visual aspects are controlled by the following 
XSL file:
\AppServer\webapps\site.war\mobile\dash\
console.xsl

You can modify the XSL file so the mobile device can 
display longer labels. Contact HP Software Support for 
help in writing an XSL to support that feature.

This XSL file transforms the XML returned from 
HP Business Service Management server to the mobile-
like HTML file that is displayed on the mobile device.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks "How to View Data on a Mobile Device" on page 371

UI Element (A-Z) Description

<KPI> The status of the KPIs attached to the CIs. For details 
on the displayed status, see "KPI Status Colors and 
Definitions" on page 45.

Note: Only the first four letters of the KPI names are 
displayed on the mobile device. You may want to 
rename the KPIs if their first four letters are the same; 
for example SAP and SAP Alert KPIs.

You can rename KPIs in the KPIs Repository (Admin > 
Service Health > Repositories > KPIs).

Tooltip: Click an icon to display the relevant tooltip. To 
hide the tooltip, click anywhere else in the page or wait 
5 seconds. 

The tooltip displays the name of the CI, the status of 
the KPI, the rule used to calculate the status, and the 
date when the status changed, and additional 
information depending on the type of KPI. For 
example, Avg. response time displays the value for the 
Performance KPI, Average for displays over how long 
the average was calculated, Minor and OK are the 
objectives of the Performance KPI (the objective). 

Back Click Back to go back to the login page.
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Name The name of the CIs in the view.

Note: To drill down to a child CI, move the cursor to 
the CI, and click.

Refresh Click Refresh to refresh the view.

View The name of the view you selected in the login page.

UI Element (A-Z) Description
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View Builder - Creating Global Views and 
Local Impact Views

This chapter includes:

Concepts

➤ View Builder Overview on page 380

➤ Local Impact View Calculation on page 382

Tasks

➤ How to Create or Edit Views Using View Builder on page 384

➤ How to Add or Remove KPIs Within a View on page 386

Reference

➤ View Builder User Interface on page 389
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Concepts

View Builder Overview

The View Builder enables you to create or modify views directly within 
Service Health Administration. You can create or modify pattern views, 
template based views, and perspective based views, as well as templates and 
perspectives. For details on each of these formats, see "View Formats" in the 
Modeling Guide.

For each view, the View Builder enables you to define which KPIs are 
displayed in the view, and which are included in CI calculations.

Within Service Health Administration, you can use the View Builder to 
create or edit two types of views: global views, and local impact views.

This section includes the following:

➤ "Global Views" on page 380

➤ "Local Impact Views" on page 381

Global Views
The default views within Business Service Management are global views. 
Within a global view, when you modify KPI or health indicator definitions 
on a CI, your changes are reflected in all views which contain the CI, across 
Business Service Management.

In a global view, KPIs are calculated based on the view topology in the 
RTSM. For example, suppose you have a CI with 2 child CIs, and the parent 
CI has a KPI that is also found on both of the child CIs. The KPI on the 
parent CI is calculated based on the KPIs on both of the children, even if 
one of the children is hidden in the view. For details on hidden children, see 
"How to Find Visible and Hidden Child CIs" on page 78.
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Local Impact Views
View Builder enables you to also create local impact views, which are 
independent of all other views. When you modify indicator definitions on a 
CI within a local impact view, this has no effect on this CI in all other views. 

For example, if you modify a rule parameter for an indicator on a CI in a 
local impact view, the CI in all other views will not have this parameter 
modified. In contrast, if you modify an indicator on a CI in a global view, 
the indicator is modified on this CI in all other views as well.

Local impact views operate on a WYSIWYG (what you see is what you get) 
principle. For example, suppose you have a global view which contains a 
number of CIs representing business transactions, and you are only 
interested in the data coming from two or three significant transactions. 
You can create a local impact view based on the global view, remove the less 
important transactions from the local impact view, and the calculations 
within the view are performed using only those transactions that are visible 
within the view.

In contrast, within a global view you can hide CIs from being displayed, but 
calculations within the view are performed using all of the CIs that exist in 
the view, including those that are hidden from display.

For more details on local impact views, see "Local Impact View Calculation" 
on page 382.

Note: You can create up to 100 local impact views. Each local impact view 
can contain up to 1000 CIs. To modify these limits, contact HP Support.
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Local Impact View Calculation

Local impact views are independent of other views; when you modify 
indicator definitions on a CI in a local impact view, this has no effect on the 
CI in other views. The following section describes various aspects of local 
impact view calculation.

This section includes the following:

➤ "Breakdowns" on page 382

➤ "HI and KPI Calculations in Local Impact Views" on page 382

➤ "Creating or Deleting Indicators in a Local Impact View" on page 383

Breakdowns
Some data collectors collect information based on many dimensions 
(application, transaction, location, and so on), but KPIs are calculated and 
displayed within Service Health according to a specific dimension. For 
example, if BPM is monitoring a transaction which runs from three different 
locations, Service Health displays the average time of all three locations.

Within local impact views, you can configure data breakdowns on CIs, so 
that data on their child CIs is broken down according to a particular 
dimension. For example, if you want to monitor transaction performance in 
specific locations, you can define a breakdown by location to calculate KPIs 
in smaller granularity.

Breakdowns are only available in local impact views. For details on how to 
configure breakdowns, see "How to Configure Breakdowns" on page 444.

HI and KPI Calculations in Local Impact Views

➤ When you create a local impact view, HI and KPI statuses and values are 
copied from the model, and are identical to the statuses and values of 
these indicators in global views.

The Last Status Change setting for HIs in a local impact view reflects the 
time the view is created, until the next time statuses are updated. 

Trend and History data for indicators are not copied from the model, but 
are calculated from when the view is created. 



Chapter 14 • View Builder - Creating Global Views and Local Impact Views

383

➤ When you create a local impact view based on another local impact view 
(using the Save As option), the new view copies statuses and values from 
the model, and not from the original local impact view.

➤ KPI calculation within a local impact view (as in a global view) is based on 
the Impact links between the CIs in the view, and not based on the View 
Folding. For example, suppose CI1 has a child CI (CI2) defined via an 
Impact link, and these CIs are inverted within a view so that CI2 appears 
to be the parent and CI1 appears to be the child. Their KPIs are calculated 
according to the Impact link, and not according to their appearance in 
the view (View Folding), so CI1 is still the parent CI when calculating 
KPIs.

➤ If a CI is removed from a local impact view (for example if hidden from 
the view, or excluded by pattern conditions), any customized indicator 
definitions on the CI are deleted. If the CI is restored to the view, its 
default indicator settings are restored.

Creating or Deleting Indicators in a Local Impact View
The following functionalities in local impact views differ from global views:

➤ HIs and KPIs cannot be deleted from a local impact view. You can remove 
an HI from a KPI’s calculation, but you cannot delete it from the view.

➤ Since event-based HIs are not configurable, you cannot create a new 
event-based HI in a local impact view.
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Tasks

How to Create or Edit Views Using View Builder

This section describes the main tasks used to create or edit views using View 
Builder.

This section includes the following:

➤ "Manage folders in View Selector" on page 384

➤ "Edit or delete an existing view" on page 384

➤ "Clone and edit an existing view" on page 385

➤ "Create a view, template, or perspective" on page 385

Manage folders in View Selector

Within View Builder, the View Selector pane enables you to organize views 
within folders as follows:

➤ To add a folder at the top level of the hierarchy, select the Root folder, and 
click Create a New Folder.

➤ To add a folder within an existing folder, select the existing folder and 
click Create a New Folder.

➤ To delete a folder, select it and click Delete. A folder can only be deleted if 
the user has delete and edit permissions for all the views within the folder.

Edit or delete an existing view

To edit a view, select the view in the View Selector pane, and edit its details 
in the panes on the right side of the View Builder. For user interface details, 
see "View Builder Tab" on page 389.

To delete a view, select the view in the View Selector pane and click Delete.
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Note: Within the view selector, you can only see those views for which you 
have edit permissions.

Clone and edit an existing view

You can clone an existing view to create a view that is based on the original 
view. For example, if you have a global view which you want to customize 
but still leave the global view intact, you can clone the global view and save 
it as a local view. You can then make changes to the CIs and indicators on 
the local view, without having an effect on other views.

To clone a view and open the copy for editing, select a view, and click the 
Save As button. Note the following:

➤ If you are cloning a global view, you can create a global view or a local 
impact view based on the original view.

➤ If you are cloning a local impact view, you can only create another local 
impact view based on the original local impact view.

Create a view, template, or perspective

To create a view, template, or perspective, click the New Local Impact View 
or New Global View button, and select the type of view you want to create.

➤ For an overview of local impact views and global views, see "View Builder 
Overview" on page 380.

➤ For details on pattern views, template based views, and perspective based 
views, see "View Formats" in the Modeling Guide.

➤ For details on templates and perspectives, see "Templates and 
Perspectives" and "Predefined Folders and Views" in the Modeling Guide.

When you create a view, template, or perspective within View Builder, you 
use the RTSM Modeling Studio interface.
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For details on how to define each type of view, refer to the following 
sections:

How to Add or Remove KPIs Within a View

The View Properties dialog box displays a list of KPIs that are assigned 
within a selected view, and enables you to define whether each KPI is 
included in the view, included in the CI status calculation, or both. You can 
also view each KPI’s user mode (Business, Operation, or both). The following 
section describes how to display KPI properties for a view, and how to 
modify these properties.

Tip: The user mode columns (Business User and Operations User) are read-
only, and are determined by the KPI’s settings within the KPI repository. For 
details on changing user mode settings for a KPI, see "How to Set Up User 
Mode Functionality" on page 439.

This section includes the following:

➤ "Display KPI properties for a view" on page 387

➤ "Modify which KPIs are included in the view" on page 387

➤ "Modify which KPIs are included in CI calculation" on page 388

Pattern View "How to Create a Pattern View" in the Modeling Guide

Template-Based View "How to Create a Template Based View" in the 
Modeling Guide

Perspective-Based 
View

"How to Build a Perspective-based View Based on a 
Model" in the Modeling Guide

Template "How to Create a Template" in the Modeling Guide

Perspective "How to Create a Perspective" in the Modeling Guide
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Display KPI properties for a view

In the View Selector pane, select a view and click the View Properties 
button. The View Properties dialog displays a detailed list of the KPIs in the 
selected view; for user interface details, see "View Properties Dialog Box" on 
page 393.

Modify which KPIs are included in the view

The Include in View column in the View Properties dialog box defines which 
KPIs are included in the view. By default all KPIs are included; to remove a 
KPI, deselect the check-box corresponding to the KPI.

Tip: You can use this to remove the Unassigned Events KPI and the 
Unresolved Events KPI, if they are not relevant to your monitored system.

For example, suppose you create a view for a business service, but you are 
interested only in the infrastructure data. In this case, you can de-select the 
Application domain KPIs, and you will not see these KPIs in the Service 
Health components.

Note: The End User Monitors perspective and the System Monitors Only 
perspective define which KPIs are included in views that are based on these 
perspectives. Although KPIs can be manually excluded from a view using 
the View Properties dialog box, if the view perspectives are modified, the KPI 
exclusion list is reset according to the applied perspectives.
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Modify which KPIs are included in CI calculation

The Include in CI Status column in the View Properties dialog box defines 
which KPIs are included in the CI status calculation based on all KPIs on the 
CI. By default all KPIs are included; to remove a KPI, clear the check-box 
corresponding to the KPI.

For example, suppose you want the status of the CIs in Top View to be set 
based only on infrastructure KPIs since they are important to you, but you 
still want to see the Application domain KPIs. In this case, you can de-select 
the Application domain KPIs, and they will not be used to set CI status in 
Top View.
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View Builder User Interface

This section includes:

 ➤ View Builder Tab on page 389

 ➤ View Properties Dialog Box on page 393

View Builder Tab

The View Builder enables you to create or modify views, templates, and 
perspectives using Service Health Administration.

You can define two types of views using View Builder: global views and local 
impact views. For details on global and local impact views, see "View Builder 
Overview" on page 380.

To access Select Admin > Service Health > View Builder

Important 
information

View Builder uses the RTSM Modeling Studio interface. 
For details, see "Modeling Studio Overview" in the 
Modeling Guide.

➤ For details on pattern views, template based views, 
and perspective based views, see "View Formats" in 
the Modeling Guide.

➤ For details on templates and perspectives, see 
"Templates and Perspectives" in the Modeling 
Guide.

Relevant tasks "How to Create or Edit Views Using View Builder" on 
page 384
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View Selector Pane

The left side of the View Builder contains the View Selector pane, which 
displays a hierarchy of views, and folders which contain views. You can add, 
edit, or remove a view, or display view properties.

User interface elements are described below:

UI Element (A-Z) Description

New Folder. Click to create a new folder, in which you 
can create views.

New Local Impact View. Click to create a new local 
impact view. Use the drop-down selection to create one 
of the following:

➤ Pattern view

➤ Template-Based view

➤ Perspective-Based view

New Global View. Click to create a new global view. 
Use the drop-down selection to create one of the 
following:

➤ Pattern view

➤ Template-Based view

➤ Perspective-Based view

➤ Template

➤ Perspective
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Save As. Select a view, and click to create a copy of the 
view. If you are cloning a global view, you can create a 
global view or a local impact view based on the original 
view. If you are cloning a local impact view, you can 
only create another local impact view based on the 
original local impact view.

Note: 

➤ For templates, the save as global view option is 
labeled "Save template as..."

➤ For perspectives the save as global view option is 
labeled "Save perspective as..."

➤ For perspectives and templates (which cannot be 
saved as local impact views), the "Save as local 
impact view" option is disabled.

View Properties. Select a view, and click to display its 
properties. For details, see "View Properties Dialog Box" 
on page 393.

Delete. Select a folder or view, and click to delete.

A folder can only be deleted if the user has delete and 
edit permissions for all the views within the folder.

Expand All. Click to display all the views and folders in 
the hierarchy.

Collapse All. Click to display only the highest level 
views and folders in the hierarchy.

Refresh. Click to refresh the display.

<Folder> A folder can contain views, or other folders. Folders 
help you organize views.

<View> Each view is displayed with an icon indicating the type 
of view. To edit a view, select the view and edit its 
details in the panes on the right side of View Builder.

You can only see those views for which you have edit 
permissions.

UI Element (A-Z) Description
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<Additional Panes>

The right side of the View Builder displays additional panes depending on 
your actions within the View Selector pane, as follows:

Selecting a Folder When you select a folder in View Selector, the right 
pane displays an introduction to View Builder, and 
provides links to actions that you can take.

When you select the Local Impact Views folder in View 
Selector, you can create local impact views only; from 
all other folders you can create local impact and global 
views.

Creating a Pattern 
View, Template, or 
Perspective

When you create or edit a pattern view, or when you 
create a template or perspective, the following panes 
appear:

➤ CI Types

➤ Query Definition

➤ Hierarchy

➤ Advanced Tabs

The CI Types pane corresponds to the CI Types tab in 
the left pane of Modeling Studio. You can use this pane 
to drag CI types into the Query Definition pane. For 
user interface details on the CI Types pane, see "Left 
Pane" in the Modeling Guide.

The other panes are components of the Pattern View 
Editor in Modeling Studio. For user interface details on 
these panes, see "Pattern View Editor" in the Modeling 
Guide.
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View Properties Dialog Box

This dialog box displays the KPIs in the selected view, and enables you to 
select whether each KPI is included in the view, included in the CI status 
calculation, or both. Each KPI’s user mode (Business or Operation) is also 
displayed.

Creating a 
Perspective-Based 
View

When you create or edit a perspective-based view, the 
following panes appear:

➤ CI Selector

➤ Content

➤ Perspective

➤ View Results

The CI Selector pane corresponds to the CI Selector tab 
in the left pane of Modeling Studio. You can use this 
pane to drag CIs into the Content pane. For user 
interface details on the CI Selector pane, see "Left Pane" 
in the Modeling Guide. 

The other panes are components of the Perspective-
Based View Editor in Modeling Studio. For user 
interface details on these panes, see "Perspective-based 
View Editor" in the Modeling Guide.

Creating a Template-
Based View

When you create a template-based view, the Template-
based View Wizard opens. For user interface details, see 
"Template-based View Wizard" in the Modeling Guide.

To access In View Builder, select a view in the View Selector 
pane, and click the View Properties button.

Relevant tasks "How to Add or Remove KPIs Within a View" on 
page 386
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User interface elements are described below:

UI Element (A-Z) Description

Business User A check mark indicates that the KPI is defined for the 
Business user mode. For details on user mode, see "KPIs 
for User Modes" on page 412.

Domain The KPI’s domain, as defined in the KPI repository. For 
details, see "KPI Domains" on page 411.

Include in CI Status When this option is selected, the KPI is used in 
calculating CI status, when CI status is calculated using 
all the CI’s KPIs.

To exclude a KPI from CI calculation, de-select this 
option for the KPI.

Note: The Include in CI Status option is automatically 
cleared when the Include in View option is cleared.

Include in View When this option is selected, the KPI is displayed in 
Service Health views and tooltips, and the KPI is used 
in calculating the CI’s status.

To exclude a KPI from views and tooltips and from CI 
calculation, de-select this option for the KPI.

Note: The Include in CI Status option is automatically 
cleared when the Include in View option is cleared.

KPI The name of the KPI.

Operations User A check mark indicates that the KPI is defined for the 
Operations user mode. For details on user mode, see 
"KPIs for User Modes" on page 412.
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➤ How to Assign KPIs and HIs to CIs on page 428

➤ How to Edit KPI or HI Properties on page 431

➤ How to Define Thresholds for KPIs and HIs on page 433

➤ How to Define Selectors for HIs on page 435

➤ How to Set Up User Mode Functionality on page 439

➤ How to Change the KPI Status Icons on page 441
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➤ How to Attach a PNR KPI to a CI on page 448



Chapter 15 • Configuring KPIs and Health Indicators

396

Reference

➤ CI Indicators User Interface on page 452



Chapter 15 • Configuring KPIs and Health Indicators

397

Concepts

KPI and HI Calculation

Each CI has KPIs and HIs (health indicators) that define what is monitored 
for that specific CI. The status and value of these indicators show how well 
the CI is performing. The following sections describe how KPIs and HIs are 
assigned to CIs, and how these indicators are calculated.

➤ "How KPIs and HIs are Attached to CIs" on page 397

➤ "HI and KPI Definitions" on page 398

➤ "How HIs and KPIs are Calculated" on page 399

➤ "About Business Rules" on page 399

➤ "Notes and Limitations for KPIs and HIs" on page 400

Note: For an introduction to health indicators and KPIs, see "Health 
Indicators and KPIs - Overview" on page 115.

How KPIs and HIs are Attached to CIs
A KPI or HI can be attached to a CI in one of the following ways:

➤ Assignment. KPIs and HIs may be assigned to a CI as part of the CI 
creation. CIs are automatically assigned default KPIs and HIs according to 
the nature of the CI, using the Assignment mechanism. You can edit an 
HI assignment or a KPI assignment to define additional indicators that 
you want added to the CIs.

For more information on HI and KPI assignments and how they define 
the default indicators, see "Assignments" on page 558.

➤ Propagation. KPIs may be attached to a CI as a result of propagation from 
child CIs. Most KPIs propagate up through the hierarchy, so that parent 
CIs have the same KPIs as all their child CIs.



Chapter 15 • Configuring KPIs and Health Indicators

398

Each KPI added by propagation has its own business rule and properties. 
For example, the Application Availability KPI for a child CI may use the 
Worst Child Rule (taking the worst status of all the HIs on the CI), while 
the same KPI for the parent CI (added by propagation from the child CI) 
may use the Percentage Rule.

For more information on the propagation mechanism and how it defines 
the default KPIs, see "Propagation Rules" on page 563.

➤ Manual Administration. KPIs and HIs can be manually attached to a CI in 
the Service Health Administration CI Indicators tab. You may want to 
attach new KPIs and HIs to a CI, in addition to the default/propagated 
KPIs, to broaden the information displayed on the CI. For example, you 
can add an OT Impact KPI to assess the ongoing cost of an application 
that is not available.

You can also use the CI Indicators tab to edit KPIs and HIs that are 
assigned to a CI, and remove KPIs and HIs from a CI. For details, see "CI 
Indicators Tab" on page 453.

HI and KPI Definitions
HP Business Service Management provides a selection of predefined KPIs 
and HIs to work with Service Health. HI and KPI definitions come from 
content providers that send information to HP Business Service 
Management, such as Business Process Insight or Real User Monitor. These 
content packs contain the default parameters for each HI and KPI.

HI and KPI definitions generally include the following:

➤ The business rule which calculates status and value of the HI and KPI. 
(Event-based HIs do not use business rules.)

➤ The calculation source: HIs are calculated from monitored CI data 
samples; KPIs are calculated based on HIs, other KPIs, or both. For 
example, a KPI’s metrics might be generated from HIs on child CIs (for 
example, when using the Summary of Values rule), or from other KPIs 
attached to the same CI (for example, when using the Impact Over Time 
rule).
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➤ The thresholds (objective values) that the HI and KPI measurement is 
compared against; and the status (color) allocated to the HI and KPI based 
on the defined thresholds.

➤ Where and how to display the status indicator for the HI and KPI in 
Service Health, and where to store KPI measurements.

How HIs and KPIs are Calculated
HIs and KPIs are calculated as follows: 

➤ Some HIs get their status directly from events. In this case, an event is 
sent to the BSM event manager, and the event manager assigns the 
corresponding HI its status based on the event definitions.

➤ Other HIs are metric-based; a data collector sends a data sample related to 
a monitored CI to the Business Logic Engine. The Business Logic Engine 
identifies the sample using the HI selector, as relevant for a specific 
monitored CI. Based on the HI definitions, the Business Logic Engine uses 
a business rule to calculate the HI status and value for the monitored CI.

➤ After an HI is calculated, the Business Logic Engine calculates the KPIs 
which are based on this HI, using the KPI business rule definitions. If this 
calculation causes a change in the status of a KPI, the Business Logic 
Engine recalculates the corresponding KPI of each parent CI, using the 
new status information. If the new measurement causes a change in the 
status for that KPI, the new status is again passed up the hierarchy to the 
corresponding KPI instances for the parent CIs, and so on.

Note: Some monitoring solutions include a value for the HI along with its 
status, while others only set the HI’s status.

About Business Rules
Metric-based HIs and KPIs always have an associated business rule that 
defines how the indicator is calculated. These rules are defined in the 
Business Rule Repository, where you can edit predefined rules, or create 
customized rules. For details, see "List of Calculation Rules in Service Health" 
on page 740.
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Some rules are specific to a particular KPI or HI, while others can be used for 
a variety of indicators. In the Indicator and KPI Repositories, each indicator 
has a defined default rule, and a list of rules that can be used with that 
indicator. HIs are calculated using rules for metrics from monitored CIs, 
while KPIs are calculated using group rules.

Notes and Limitations for KPIs and HIs

➤ Any change you make to the KPIs and HIs for a CI—adding new 
indicators, deleting indicators, or editing indicator properties—are seen in 
any view that includes the CI.

➤ There are no restrictions on the type of KPI that can be attached to a CI. 
HIs and business rules are restricted to specific CI types by their 
definitions in the repositories. You must ensure that you select KPIs, HIs, 
and business rules that are appropriate for the CI type.

➤ KPIs added to a CI as part of an SLA definition in Service Level 
Management Administration have no relevance to the Service Health KPIs 
and do not appear in the CI Indicators tab. Conversely, KPIs added to a CI 
in the CI Indicators tab have no relevance for the CI when it is included 
in an SLA, and do not appear for the CI in Service Level Management.

➤ Deleting a KPI may impact other KPIs that are dependent on the deleted 
KPI. For example, OT Impact is calculated based on the status of another 
KPI, such as Application Availability; in this case, deleting the Application 
Availability KPI would prevent calculation of OT Impact. 

➤ Unlike KPIs, HIs do not have Downtime status. HI behavior is dependent 
on the centralized Downtime configuration setting: If samples are sent for 
the HI, its status continues to be updated even if the related KPI is in 
downtime. If no samples are sent, the HI will enter No Data status when 
the No Data Timeout has passed.
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KPI and HI Thresholds

KPI and HI (health indicator) thresholds define the standards for allocating 
business status to the indicators. The following sections describe thresholds 
and how to define them for an indicator.

➤ "About Status and Thresholds" on page 401

➤ "Defining Logical Thresholds" on page 404

➤ "Excluding Statuses" on page 405

➤ "Units of Measurement for Thresholds" on page 406

About Status and Thresholds
The status displayed for a KPI or HI in Service Health provides an indication 
of how well a business process or system is meeting your business objectives. 
Based on traffic light colors (with some additional colors), the Service Health 
shows you if the KPI or HI measurement is acceptable (green), critically 
failing (red), or is at some business risk level between the two. 

Five statuses are available in Service Health for active status, each 
representing a different level of business performance. Depending on the CI 
and indicator types, active status may be represented in Service Health using 
from two to all five of these status levels:

➤ OK (green)

➤ Warning (aqua)

➤ Minor (yellow)

➤ Major (orange)

➤ Critical (red)

Assigning Statuses to HIs and KPIs

Some HIs take their status directly from an event (event-based HIs), while 
others use Service Health or Service Level Management business rules to 
calculate status (metric-based HIs). 
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Definitions of HIs are contained in the Indicator Repository. Event-based 
HIs map an event's state to the corresponding HI's severity. For example, 
suppose you create an HI called CPU Load for an event named CPULoad, 
and you assign this HI a severity of Critical if the event’s state is High. In this 
case, the HI’s status is Critical when such an event occurs (event = CPULoad, 
state = High). For further details, see "Indicator Repository Overview" on 
page 682.

Metric-based HIs and KPIs use business rules to calculate their status, as 
follows:

➤ A business rule calculates a measurement for the KPI or HI.

➤ The calculated measurement is compared with defined threshold values. 

➤ The KPI or HI is assigned a status according to where the measurement 
falls within the threshold levels. For example, if a KPI measurement of 
50% falls within the definition of the Minor threshold, the KPI is assigned 
Minor status (yellow).

Note: If an HI has no thresholds defined, its status is Informational. For 
example, if you are monitoring Business Process Insight, and the Backlog HI 
has a calculated value of $1000, this indicator has Informational status 
unless you set thresholds to define whether this value is OK, Minor, and so 
on.

The threshold values used for each KPI or HI can originate from various 
sources:

➤ The business rule definitions in the Business Rule Repository provide 
default threshold values for every rule that uses thresholds. The business 
rules generally define different threshold values for each of the five 
statuses used in Service Health. You can define new default threshold 
values for a business rule, as described in "New Rule/Edit Rule Dialog Box" 
on page 871.

➤ The Assignment mechanism may specify specific threshold values to be 
used with the business rule for a KPI or HI. These values override the 
values from the Business Rule Repository. 
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➤ The Assignment mechanism may specify reference values for the 
threshold parameters, so that the threshold values are taken from the 
threshold values defined in End User Management Administration. These 
values override the values from the Business Rule Repository.

➤ You can modify the threshold values for an individual KPI or HI in the 
Service Health Administration CI Indicators tab, while adding or editing a 
KPI or HI. The new values override values from the Assignment 
mechanism or from the business rule. For details, see "CI Indicators Tab" 
on page 453. 

HIs on SiteScope Monitor CIs

For HIs on SiteScope monitor CIs, status is based on the status received from 
SiteScope (calculated according to the thresholds defined in SiteScope). 
Three status levels are used in Service Health: 

➤ OK (green) in Service Health corresponds to Good or OK status in 
SiteScope

➤ Minor (yellow) in Service Health corresponds to Warning status in 
SiteScope

➤ Critical (red) in Service Health corresponds to Error status in SiteScope

The SiteScope status definitions cannot be changed in Service Health, so the 
business rules for HIs on SiteScope monitors do not include threshold 
values.

BTM (Business Transaction Management) CIs 

For BTM CIs (from Business Process Monitor, Real User Monitor, Business 
Process Insight, and TransactionVision), HI and KPI status is calculated by 
comparing the indicator measurement with threshold values.

For the BTM CIs, you can edit these threshold values in the CI Indicators tab 
to use as many of the status levels as you require, as described in "Defining 
Logical Thresholds" on page 404.
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Note: KPIs and HIs created for CIs by the Assignment mechanism templates, 
frequently have threshold values that differ from the default ones used by 
the business rule. However, when editing one of these indicators in the CI 
Indicators tab, if you select a different rule and then revert to the original 
rule, the original threshold values are replaced with the rule default values.

Defining Logical Thresholds
The thresholds values for a KPI or HI should cover the whole spectrum of 
possible active measurements for that indicator, which correspond to the 
OK, Critical, Major, Minor, and Warning statuses. The thresholds do not 
include the indicator values corresponding to the No Data, Downtime, 
Stopped, and Informational statuses. 

The KPI or HI measurement is evaluated against each threshold level, 
starting from OK (green), and continuing (in order) to Critical (red). This 
process stops at the first threshold level into which the measurement fits. 

For example, suppose you set thresholds of OK < 8 seconds and Minor < 12 
seconds. If the value is 9 seconds, it does not match the OK threshold but it 
does match the Minor threshold, so the indicator’s status is Minor.

To define where the boundaries of each threshold level falls, each threshold 
from OK to Major is associated with an Operator. (The Critical threshold 
definition is always Otherwise, meaning that this status is applied to all 
measurements that fall beyond the Major threshold limit.) You can select 
the operator that matches your requirements; the same operator is applied 
to all threshold levels.

The available operators are:

> 
>=
<
<=
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You must ensure that the thresholds contain logical values (according to the 
data type) and are correctly ordered, and that the operator is logical for the 
order. 

Excluding Statuses
Not all the statuses need be used for a KPI; for example, the OT Impact KPI 
by default uses only OK (green) and Critical (red) status. 

When the threshold value for a status is left blank, Service Health ignores 
that status during KPI status calculation. For example, an HI for a 
transaction may have the following thresholds defined (taken from the 
threshold settings for the transaction in End User Management 
Administration):

In this case, if the measurement for the HI does not fall into the OK 
threshold level, then Warning is skipped and the measurement is evaluated 
against the Minor threshold level. If it does not fall into that level, Major is 
also skipped, and the HI is assigned Critical status.

Tip: If you want to exclude statuses when editing the threshold values for a 
KPI or HI, it is recommended that you use this method.
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Units of Measurement for Thresholds
The threshold use a unit of measurement, shown after the threshold value 
box:

The unit is part of the business rule definition, and indicates the format of 
the calculated measurement. This format may reflect the units used by the 
incoming data (for example, milliseconds for performance time data), or it 
may be a new format applied as a result of the business rule calculations (for 
example, dollars for a financial loss calculation). If required, the default unit 
for a rule can be changed in the rule definition (as described in "New 
Rule/Edit Rule Dialog Box" on page 871).

Selectors for Metric-Based HIs

HP Business Service Management receives real-time data from data samples 
for monitored CIs, sent by external systems. The data samples contain 
information collected by a monitoring system (either HP or third-party), 
and are supplied to HP Business Service Management over the bus.

When a monitored CI has a metric-based HI (health indicator) assigned, the 
HI properties include a selector. A selector is a filter definition that defines 
which samples are relevant for the HI calculation. 
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The Business Logic Engine filters the data samples arriving on the bus using 
selectors. The selector identifies and catches the data that is relevant for 
each CI and its HIs. The HI’s business rule is applied to those data samples 
which pass the selector filtering. Different selectors can be used by different 
HIs (with corresponding rules), enabling the use of different samples for 
each HI. 

For a task that shows how to define selectors, see "How to Define Selectors 
for HIs" on page 435.

Selectors can be defined in the following ways:

HI Assignments
You can create or customize an HI assignment rule for each CI type. An 
assignment rule includes a condition and a task. The condition describes 
specific characteristics of a CI. The task describes the HIs, rules, rule 
parameters, thresholds, and selectors that are to be assigned automatically 
to the CI when the condition occurs, if the assignment is running. For 
details, see "Add/Edit Health Indicator Assignments for CI Type Dialog Box" 
on page 612.

EMS
The mechanism used to integrate EMS (Enterprise Management Systems) 
software into HP Business Service Management includes an assignment rule 
mechanism. The assignment rule mechanism is triggered when a specific CI 
attribute is updated. An assignment rule includes a condition and a task. 
The condition describes specific characteristics of a CI. The task describes 
the HIs, KPIs, rules, rule parameters, thresholds, and selectors that are 
assigned automatically to the CI when the condition occurs, if the 
assignment is running. This task description includes a selector. For details, 
see "Edit Integration Dialog Box" in Solutions and Integrations.

HI Definitions in Service Health
If required, you can edit the default HI selectors using the Service Health 
Admin > CI Indicators tab. You can attach new HIs to a CI, assign rules, and 
manually define HI selectors. For more information about defining selectors, 
see "How to Define Selectors for HIs" on page 435.
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KPI Trend and History Calculation

Each KPI can include three icons: Status, Trend, and History.

For information about status, see "Understanding KPI Status" on page 43 
and "KPI Status Colors and Definitions" on page 45.

The way the trend and history status is determined is described in the 
following sections:

➤ "History Calculation" on page 409

➤ "Trend Calculation" on page 410

➤ "Modifying the Trend and History Status Calculations" on page 410
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History Calculation
The history status icon displays either the worst status or the average status 
for the CI’s KPI during a specified time period. 

The calculation method for history status is determined by the value set for 
the HistoryType parameter (one of the global parameters in the Business 
Rule Repository, described in "Global Parameters Dialog Box" on page 880). 
The possible calculation methods are Worst (default value) or Average. 
Whichever calculation method is used, only status scores that have meaning 
(scores 0 to 20—the non-gray icons) are taken into consideration.

➤ Worst. Takes the worst status over the period of time specified in the 
HistorySize parameter (also one of the global parameters).

For example: if HistorySize is one hour (default value) and the KPI’s values 
for the last hour are: 10, 10, 5, 0, -2, 20, the worst status is 0, so the 
history icon is red.

➤ Average. Takes the average status over the period of time specified in the 
HistorySize parameter (Simple Moving Average). The calculation result is 
rounded to the nearest of the following values: 0, 5, 10, 15, or 20. 

For example: if HistorySize is one hour and the KPI’s values for the last 
hour are: 10, 10, 5, 0, -2, 20, the Average status is 10 (rounded from 
(10+10+5+0+20)/5=9), so the history icon is yellow.
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Trend Calculation
The trend status icon shows the trend in real-time status for the CI KPI, 
using three directions: up, down, and no change.

Trend analysis is performed by comparing the Simple Moving Average 
(SMA) value for a long window with the SMA for a short window. If the 
short window SMA is higher than the long window SMA, the trend is 
considered to be up. If the long window SMA is higher, the trend is 
considered to be down. The SMA is calculated only on status scores that 
have meaning (scores 0 to 20—the non-gray icons).

➤ Long window SMA. Based on the mean status of a KPI over the period of 
time specified in the HistorySize parameter (default = 1 hour), one of the 
global parameters in the Business Rule Repository, described in "List of 
Calculation Rules in Service Health" on page 740.

➤ Short window SMA. Based on the mean status of a KPI over the period of 
time defined by (TrendRate * HistorySize). The TrendRate parameter 
(default = 0.3) represents the time rate between the long and short 
window, and is defined in the hidden parameters described in "Modifying 
the Trend and History Status Calculations" on page 410.

Modifying the Trend and History Status Calculations
You can modify the way the trend and history statuses are calculated and 
displayed, by editing certain rule parameters. A rule parameter can be set as 
follows:

➤ As part of the global rule parameters that apply to all rules and affect all 
CIs. For details on editing global parameters, see "Global Parameters 
Dialog Box" on page 880.

➤ Directly for a rule, so that it affects all CIs that use this rule. For details on 
editing rule parameters, see "New Rule/Edit Rule Dialog Box" on page 871.

Some parameters for trend and history statuses are predefined and can be 
viewed and edited in the Business Rule Repository page; others are hidden, 
but can be manually added on the Repositories tab if you want to override 
the parameter default value. 
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KPI Domains

Domains are groups of KPIs that monitor similar functions; KPIs are 
assigned to domains within the KPI repository. For example, the Network 
domain contains the Network Availability and Network Performance KPIs, 
while the Business Health and Business Impact KPIs are assigned to the 
Business domain. For details, see "Health Indicators, KPIs, and KPI Domains" 
on page 39.

Within the Service Health Hierarchy component you can filter according to 
domains, enabling you to view KPIs that are of particular interest to you. A 
network administrator may choose to only display the KPIs in the Network 
and System domains, while another user may choose to view the KPIs in the 
Application and Business domains. For details on the Hierarchy component, 
see "Hierarchy Component Overview" on page 224.

Within the KPI repository you can create a domain to suit your 
organization’s needs. For example, an SAP administrator may edit the SAP 
and SAP Alert KPIs in the repository and assign them to a new domain 
named MySAP. The Hierarchy component will then display these KPIs under 
the MySAP domain, and the SAP administrator can filter to view these KPIs 
only.

Persistent Data and Historical Data

To save status changes for a KPI (persistent data), the KPI must be attached 
to a CI whose Save KPI data over time for this CI option has been selected. 
For details, see "CI Indicators Tab" on page 453. 

The option is selected by default for logical CIs, and for CIs that are 
important for problem isolation, such as Business Application, Business 
Process, Business Service, and Host.

When this option is selected, all status changes are saved. If you also want to 
save data on actual measurements for KPIs, you must activate the 
saveValuesToPersistency global parameter in the Business Rule Repository. 
You can also change the default interval by modifying the value of the 
saveValuesToPersistencyInterval option. For details, see "How to Save 
Measurements Data" on page 736.
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If you select the Save KPI data over time for this CI option, and also activate 
the saveValuesToPersistency global parameter, the following information is 
stored in the database:

➤ Every status change for each KPI

➤ The current calculated value for each KPI, read at regular time intervals 
(the default time interval is 15 minutes)

Tip: Saving historical data for long periods of time or for many CIs and KPIs 
should be used with care; using this option can require a lot of database disk 
space and affect overall performance. When you no longer require data to 
be saved for a CI, clear the Save KPI data over time for this CI check box for 
that CI. Alternatively, make sure to define purging by the Partition Manager 
according to your retention policy. For details, see "Database 
Administration" in Platform Administration.

This capability is used in the Service Health reports. For details, see "CI 
Status Reports" on page 335.

KPIs for User Modes

HP Business Service Management provides the option to define Service 
Health KPIs for two different user types (modes): operations and business. 
This option enables the creation of two versions of a single KPI, where each 
KPI version is geared towards the particular viewing requirements of one of 
the user types. Each user type sees the appropriate version of the KPI in the 
Service Health views.

For example: You might want to create two versions of the Application 
Availability KPI, so that the Application Availability KPI for an operations 
user shows Critical status (red) when transaction availability is below 30%, 
and the Application Availability KPI for a business user shows Critical status 
when transaction availability is below 20%.

For details, see "How to Set Up User Mode Functionality" on page 439.
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Breakdowns

Some data collectors collect measurements based on many dimensions 
(application, transaction, location, and so on), but KPIs are calculated and 
displayed within Service Health according to a specific dimension. For 
example, if Business Process Monitor collects measurements of a 
transaction’s response time from three different locations, Service Health 
displays the average time of all three without distinguishing between them.

Within local impact views, you can configure data breakdowns on CIs, so 
that data on their child CIs is broken down according to a particular 
dimension. For example, if you want to monitor transaction performance in 
specific locations, you can define a breakdown by location to calculate KPIs 
in smaller granularity. 

Breakdowns can only be defined in local impact views. After you define a 
breakdown, you can see it displayed in the following components: 
Hierarchy, Top View, and Topology Map.

For details on how to define breakdowns, see "How to Configure 
Breakdowns" on page 444.

This section also contains the following:

➤ "Example: Application by Location Breakdown" on page 414

➤ "Breakdown Topologies" on page 416

➤ "Breakdown Display in Service Health" on page 417

➤ "Building Blocks of a Breakdown" on page 420
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Example: Application by Location Breakdown
The following image shows two CI hierarchies: the one on the left has no 
breakdown, and the one on the right has a breakdown of Application by 
Location. In these hierarchies, the HR application contains the Add 
Employees business transaction flow, which contains the Set Salary business 
transaction.

When an Application by Location breakdown is defined, each application 
contains group CIs representing the locations where transactions are 
running (London, Paris); these are not actual CIs but are created only as 
containers. The names of these containers are displayed in the UI in 
parentheses, for example (London).

KPIs assigned to the Add Employees (BTF) CI are calculated separately for 
each location. The container CIs (London, Paris) represent the HR 
(application) CI, with data and status only from the relevant location. The 
HR CI is calculated from its newly created child CIs, with worst status rule 
(by default).
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The following images show this CI hierarchy when the application contains 
an additional BTF (Train Employee) and additional BTs (Set Benefits, Assign 
Courses). The image on the left side has no breakdown, while the image on 
the right has a breakdown of Application by Location.
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Breakdown Topologies
The following table shows the effects of each type of breakdown to CI 
topology, based on the root CI where the breakdown is applied. In this table, 
BTF indicates a business transaction flow; BT indicates a business 
transaction, and EUG indicates an end user group. Note that the resulting 
topology may change according to the view definition; if the BTF is not part 
of the view, it will not be shown.

Root CI (where 
breakdown is applied)

Type of breakdown Resulting topology

Application Application by Device Application > Mobile Device > BTF > BT

Application by Location Application > Location > BTF  (if it exists) 
> BT 

BPM Application by 
Location

Application > Location > BTF > BT

BPM Location by 
Application

Location > Application > BTF > BT 

BPM Transaction by 
Location

Application > BTF > BT > Location

Location by Application Location > Application > BTF or CI 
collection (if it exists) > BT 

Location by Transaction Application > BTF or CI collection (if it 
exists) > Location > BT 

RUM Application by End 
User Group

Application > EUG Subnet

RUM Application by Server Application > Node

RUM End User Group by 
Application

EUG > Application

RUM Transaction by End 
User Group

Application > BTF or CI collection (if it 
exists) > BT > EUG

Transaction by Location Application > BTF or CI collection (if it 
exists) > BT > Location
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Breakdown Display in Service Health
Breakdowns are data driven, meaning that after you define a breakdown, 
each container CI is created when a sample arrives that is relevant for that 
container. 

For example, if you define an Application by Location breakdown and you 
have transactions monitored in London and Paris, when a sample from Paris 
comes in to BSM a container named (Paris) is created, and when a sample 
from London comes in, a container named (London) is created.

BTF BPM Transaction by 
Location

Application > BTF > Transaction > 
Location

Location by Transaction Application > BTF or CI collection (if it 
exists) > Location  > BT

RUM Transaction by End 
User Group

Application > BTF or CI collection (if it 
exists) >  BT > EUG

Transaction by Device Application > BTF > Mobile Device > BT

Transaction by Location Application > BTF or CI collection (if it 
exists) >  BT > Location

BT BPM Transaction by 
Location

Application > BTF > BT > Location

Location by Transaction Application > BTF or CI collection (if it 
exists) > Location > BT 

RUM Transaction by End 
User Group

Application > BTF or CI collection (if it 
exists) > BT > EUG

Transaction by Device Application > BTF > BT > Mobile Device

Transaction by Location Application > BTF or CI collection (if it 
exists) > BT > Location

Root CI (where 
breakdown is applied)

Type of breakdown Resulting topology
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The following examples show how data is displayed in Service Health 
without breakdowns, and with breakdowns.

➤ No Breakdown Defined. The following image shows a local impact view 
monitoring two applications, BPM App2 and BPM App3. Each of these 
contains business transaction flows, which contain business transactions. 
In this image, no breakdown is defined.

➤ Breakdown Defined. The following image shows the same view, with two 
different breakdowns defined: 

➤ BPM App3 is configured with a Location by Application breakdown, so 
the CI hierarchy is Location > Application > BTF > BT. 

➤ BPM App2 is configured with a Application by Location breakdown, so 
the CI hierarchy is Application > Location > BTF > BT.
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Any additional BTFs or BTs that are added to this application are contained 
within their respective locations. In this image, each of the container CIs 
created by the breakdown configuration is indicated by a black rectangle.

Note: In the Hierarchy component, when you filter by CI status (using the 
quick or advanced filters), breakdowns are not supported in the filter. Data-
driven container CIs such as locations are not included in the filter results, 
and the filter relates to each CI's status as it would without any breakdown 
configuration. 

For example, if a transaction's status is Critical from London but OK from 
Paris, if the aggregated status from all locations of this CI is Critical, the 
filter returns this CI as Critical without relating to the breakdown 
configuration.
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Building Blocks of a Breakdown
Each breakdown is comprised of the following elements:

 1 Breakdown components. Each breakdown is defined according to a 
structure of x by y. The order of these two elements defines where the 
container CI is located in the CI hierarchy. For example:

➤ In a Transaction by Location breakdown, the CI hierarchy is 
Application > BTF > BT > Location. In this case, you are breaking down 
your business transactions according to their respective locations.

➤ In a Location by Transaction breakdown, the CI hierarchy is 
Application > BTF > Location > BT. In this case, you are breaking down 
your locations according to their respective transactions.

 2 Root CI. A breakdown is defined on a root CI; this means that CIs beneath 
this CI in the view hierarchy are included within the breakdown, if they 
are applicable for the breakdown.

For example, if you define a breakdown of Transaction by Location from a 
root CI of an application, business transactions added to the view within 
the application are included automatically in the breakdown. If you 
define this breakdown with a transaction as the root CI, business 
transactions added to the view within the application are not included in 
the breakdown.

 3 Applicable CIs. Based on their CITs, different CIs can have different 
breakdown configurations applied to them, while some CIs cannot have 
any breakdown applied to them.

When you select a root CI in the CI Indicators tab, the Breakdown tab in 
the CI Data pane shows which breakdown configurations can be applied 
to that CI.

 4 Leaf CIs. Based on internal definitions, each breakdown takes HI sample 
data from a particular CIT. For example, Transaction by Location 
breakdowns always take sample data from business transactions, while 
Application by Location breakdowns can take sample data from business 
transactions, or from applications.
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 5 Breakdown calculation rule. This defines which calculation rule (worst, 
best, or average status) is applied to the child CIs for each breakdown 
root. For example, if you have a transaction running in three locations 
with transaction by location breakdown, if you use the worst status rule 
the status of the transaction is the worst status of all three locations.

 6 Virtual Placement. This refers to whether the virtual CI is located before 
or after the root CI. When two broken CIs share a common parent, you 
cannot have one CI with a breakdown type <A by B> and the other CI 
with <X by Y>, where <X by Y> has a different Virtual Placement than <A 
by B>.

For example, within one BTF, you cannot set breakdowns on one 
transaction as Transaction by Location, and another as Location by 
Transaction.
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PNR (Point of No Return) KPI Calculation

Service Level Management data can be displayed within Service Health 
using the Service Health PNR (Point of No Return) KPI, which monitors how 
well agreement objectives are being met.

Service level agreements regularly include a clause covering unavailability, 
that is, the period of time that a system may be down. For example, if 
availability must be 98.5%, then a system may be unavailable 1.5% of the 
time.

When configuring the Service Health PNR KPI, you define which SLA, 
calendar, tracking period and Service Level Management KPI the Service 
Health PNR KPI is monitoring. The PNR KPI then tracks how long the CI has 
been unavailable during the specified period based on the status of the 
specified SLM KPI, and how much time it can be unavailable before the SLA 
is breached.

PNR Calculation Example
In the following example, a breach threshold is defined in the SLA as 90%, 
and the calculation period is from 7 AM to 5 PM (10 hours). The CI can 
therefore be unavailable for up to one hour total before the SLA is breached. 
The PNR KPI is defined to use the SLM Application Availability KPI.

The Service Health PNR KPI objectives are set at >= 80% (OK), 60% 
(Warning), 40% (Minor), 20% (Major). This means that when the CI is 
unavailable for less than 12 minutes the KPI is OK, when the CI has been 
unavailable for 12 minutes (20% of one hour) the KPI enters Warning, when 
it has been unavailable for 24 minutes (40% of one hour) the KPI enters 
Minor, and so on. When the CI has been unavailable for a total of one hour 
the KPI enters Breached status, since the SLA can no longer be met.
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The following table provides a detailed example of the PNR KPI calculation 
mechanism:

➤ At 8:00 the CI has 100% availability, and the PNR KPI status is OK. 

➤ At 9:00 the CI has 80% availability, meaning it was unavailable for 24 
minutes out of two hours. Since the CI was unavailable for 40% of the 
total time that it can be unavailable (one hour), the PNR KPI enters 
Warning.

➤ At 10:00 the CI has 80% availability, meaning it was unavailable for 36 
minutes out of three hours. The CI has now been unavailable for 60% of 
the total time it can be unavailable (one hour), and the PNR KPI enters 
Minor.

➤ At 14:00 the CI has 88% availability, meaning it was unavailable for 50.4 
minutes out of seven hours. The CI has now been unavailable for 86% of 
the total time it can be unavailable (one hour), and the PNR KPI enters 
Major.

Time
Availability to 
time (%)

Total time 
unavailable

Time until 
breach

PNR KPI 
calculated 
value

Service Health 
PNR KPI status

8:00 100 0 60 100 OK

9:00 80 24 36 60 Warning

10:00 80 36 24 40 Minor

11:00 85 36 24 40 Minor

12:00 88 36 24 40 Minor

13:00 90 36 24 40 Minor

14:00 88 50.4 9.6 16 Critical

15:00 87 62.4 -2.4 -4 Breached

16:00 87 70.2 -10.2 -17 Breached

17:00 87 78 -18 -30 Breached
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➤ At 15:00 the CI has 87% availability, meaning it was unavailable for a 
total of 62.4 minutes. Since the SLA allows the CI to be unavailable for no 
more than one hour, the PNR KPI enters BREACHED, and stays in that 
state until the end of the calculation period.

For details on working with the PNR KPI, see "How to Attach a PNR KPI to a 
CI" on page 448.
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Tasks

How to Configure KPIs and HIs—Overview

This section describes the main tasks used to configure KPIs and HIs (health 
indicators).

This section includes the following options:

➤ "Edit a template of a KPI, HI, or rule in the repositories" on page 426

➤ "Modify KPI or HI assignments" on page 426

➤ "Add KPI or HI instances to CIs" on page 426

➤ "Edit a KPI or HI on a CI or on multiple CIs" on page 427

➤ "Define thresholds for a KPI or HI" on page 427

➤ "Define a selector for an HI" on page 427

➤ "Modify the user mode for a KPI" on page 427

➤ "Edit specific rule parameters" on page 427

➤ "Customize KPI, Trend And History, and Top View status icons" on 
page 428

Note: For an introduction to health indicators, see "Health Indicators and 
KPIs - Overview" on page 115.
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Edit a template of a KPI, HI, or rule in the repositories

Template definitions for KPIs, HIs, and the business rules used to calculate 
these indicators, are defined in the repositories. If you want to globally edit 
a KPI, HI, or business rule, access one of the following:

➤ KPI Repository. For details, see "KPIs Repository page" on page 666.

➤ Indicator Repository. For details, see "Indicator Repository page" on 
page 693. 

➤ Business Rule Repository. For details, see "Business Rules Repository page" 
on page 869. 

Note: Tooltips are configured within the rule repository.

Modify KPI or HI assignments

KPIs, HIs, and business rules, are assigned to CIs using the assignment 
mechanism. When a new CI is added to your monitored system, the 
assignment mechanism assigns the appropriate KPIs and HIs to the CI. 
When you assign a KPI or HI to a CI, or when you attach a CI to another CI, 
the propagation mechanism propagates the appropriate KPIs to the parent 
CIs. 

For details about modifying KPI and HI assignments, see "Indicator 
Assignments and Propagation" on page 557.

Add KPI or HI instances to CIs

You can add KPI or HI instances to one or more CIs, using the CI Indicators 
tab. For example, you may want to add the OT Impact KPI to a number of 
CIs in your view.

You can add a default KPI or HI provided with HP Business Service 
Management, or add a custom KPI or HI that you defined within the 
repositories. For details on adding an indicator to a CI, see "How to Assign 
KPIs and HIs to CIs" on page 428.
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Edit a KPI or HI on a CI or on multiple CIs

You can modify KPI or HI definitions on one or more CIs, using the CI 
Indicators tab. For example, you may want to edit definitions of the 
Application Availability KPI on a specific CI, or across a number of CIs. 

For details on editing a KPI or HI on a CI, see "How to Edit KPI or HI 
Properties" on page 431.

Define thresholds for a KPI or HI

KPIs and HIs are assigned statuses by a comparison between their values, 
and their threshold definitions. For details on how to define thresholds, see 
"How to Define Thresholds for KPIs and HIs" on page 433.

Define a selector for an HI

Within HI definitions, selector expressions filter data samples to target only 
those samples that are relevant for the HI. You can combine selectors 
expressions into groups, to create complex filters. 

For details on how to define selectors, see "How to Define Selectors for HIs" 
on page 435.

Modify the user mode for a KPI

HP Business Service Management provides the option to define Service 
Health KPIs for two different user types (modes): operations and business. 
This option enables the creation of two versions of a single KPI, where each 
KPI version is geared towards the particular viewing requirements of one of 
the user types. 

For details on working with User Modes, see "How to Set Up User Mode 
Functionality" on page 439.

Edit specific rule parameters

Each business rule uses various rule parameters that can be customized, 
either globally in the rule repository, or on a specific instance of a KPI or HI 
using the CI Indicators tab. For details on each of the rule parameters, see 
"List of Calculation Rules in Service Health" on page 740.
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The following are examples of rule parameters that you can customize:

➤ No Data Timeout. HI rules (for example, the Transaction Availability Rule) 
includes the No data timeout rule parameter. This parameter defines the 
number of seconds from the time the last sample was received, until the 
HI is timed out—at which point the HI changes to decay status (gray).

➤ Trend and History Calculation. You can modify the way the trend and 
history statuses are calculated and displayed, by editing the hidden rule 
parameters. For details, see "Hidden Parameters" on page 883.

Customize KPI, Trend And History, and Top View status icons

You can customize the set of KPI, Trend and History, and Top View status 
icons. For details, see "How to Change the KPI Status Icons" on page 441.

How to Assign KPIs and HIs to CIs

This task describes how to assign a KPI or HI (health indicator) to one or 
more CIs. For general information on how indicators work, see "KPI and HI 
Calculation" on page 397.

The default properties of KPIs and HIs are defined within the Repositories. 
For details on the KPI repository, see "KPI Repository Overview" on page 652. 
For details on the Indicator repository, see "Indicator Repository Overview" 
on page 682.

When you assign a KPI or HI to a CI, you can use the default indicator 
properties as they are defined in the repository, or you can modify 
properties for the indicator, as described in the following section.

Note: Attaching an indicator to a CI, and defining the indicator properties, 
must be undertaken with care; these actions can result in KPIs and HIs that 
give an inaccurate performance assessment in Service Health. Read notes 
and limitations before proceeding. For details, see "Notes and Limitations 
for KPIs and HIs" on page 400.
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This section includes the following steps:

➤ "Select CIs in the CI Indicators tab" on page 429

➤ "Add a new KPI or Health Indicator to the selected CI" on page 429

➤ "Define the new KPI or HI" on page 430

➤ "Result" on page 431

 1 Select CIs in the CI Indicators tab

Within the CI Indicators tab, select one or more CIs in the upper pane. 
You can use the keyboard CTRL key to select multiple CIs.

 2 Add a new KPI or Health Indicator to the selected CI

The CI Data pane shows the KPIs and HIs that are assigned to all of the 
selected CIs (for example, if a KPI is assigned to one of the CIs but not to 
another, it will not appear in this pane).

Within the CI Data pane, select the KPIs or Health Indicators tab 
(depending on the type of indicator you want to add), and click the Add 
button.
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 3 Define the new KPI or HI

Define the properties of the new KPI or HI as follows:

➤ KPIs. Within the KPI area, specify the KPI and its business rule, 
calculation method, and related HIs (when relevant). In the KPI 
Properties area, define information required by the rule such as rule 
parameters or API script, as well as the thresholds used to calculate KPI 
status. For details on the UI fields, see "Add KPI/Edit KPI Dialog Box" 
on page 464.

Note: Adding a related HI to a KPI does not assign the HI to the CI 
itself; this means that if the HI is assigned to the CI, this KPI will 
include the HI in its calculation.

➤ Health Indicators. Within the Health Indicator area, select an HI for 
assignment. 

If the HI is event-based and not metric-based, select Health Indicator 
Fed By > Events Only; no further configuration is required. For details 
on the different types of HIs, see "Events, ETIs, and HIs - Overview" on 
page 683.

If the HI is also metric-based, select Health Indicator Fed By > Metrics 
and Events, and specify the HI’s business rule. In the Health Indicator 
Properties area, define information required by the rule such as rule 
parameters or API script, as well as the thresholds used to calculate HI 
status. Use selector definitions to filter the samples relevant for the HI. 
For details on the UI fields, see "Add Health Indicator/Edit Health 
Indicator Dialog Box" on page 470.
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Note: If an HI has a default rule defined in the repository this rule is 
initially selected for the HI; otherwise the first applicable rule in 
alphabetical order is selected. If there is no applicable rule for the HI, no 
rule is selected.

When you add an HI to a CI, its selector is taken by default from the HI 
Assignments, if there is an assignment that matches this HI. If not, you 
are prompted to define the HI’s selector.

 4 Result

The KPI or HI is added to all of the selected CIs that do not already have 
that indicator attached. All instances of the indicator on these CIs will use 
the same defined business rule and properties.

If one of the selected CIs already has the indicator assigned, a dialog box 
enables you to either add the indicator only to those CIs where it was not 
originally assigned, or override the original assignments on all the CIs.

How to Edit KPI or HI Properties

The following task describes how to edit properties for KPIs and HIs (health 
indicators) that are assigned to one or more CIs. Editing KPI and HI 
properties must be undertaken with care; the changes can result in 
Indicators that give an inaccurate performance assessment in Service Health. 
Read notes and limitations before proceeding. For details, see "Notes and 
Limitations for KPIs and HIs" on page 400.

This section includes the following steps:

➤ "Select CIs in the CI Indicators tab" on page 432

➤ "Select a KPI or HI to edit its properties" on page 432

➤ "Edit properties of the selected KPI or HI" on page 432

➤ "Result" on page 432
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 1 Select CIs in the CI Indicators tab

Within the CI Indicators tab, select one or more CIs in the upper pane. 
You can use the keyboard CTRL key to select multiple CIs.

 2 Select a KPI or HI to edit its properties

The CI Data pane shows the KPIs and HIs that are assigned to all of the 
selected CIs (for example, if a KPI is assigned to one of the CIs but not to 
another, it will not appear in this pane).

 a Within the CI Data pane, select the KPIs or Health Indicators tab 
depending on the type of indicator you want to modify. 

 b Select the indicator whose properties you want to modify, and click the 
Edit button.

 3 Edit properties of the selected KPI or HI

You can modify any of the KPI or HI properties.

➤ For details on KPI properties, see "Add KPI/Edit KPI Dialog Box" on 
page 464.

➤ For details on HI properties, see "Add Health Indicator/Edit Health 
Indicator Dialog Box" on page 470.

To remove an indicator from one or more CIs, select the indicator in the 
CI Data pane, and click the Delete button.

When you delete an HI, it is also removed from the Related HIs list of the 
KPIs which are calculated by that HI.

 4 Result

The KPI or HI properties are changed for all of the selected CIs. If one of 
the selected CIs already has the indicator attached using different 
definitions (for example, with a different rule applied), a dialog box 
enables you to either keep the old definitions or to apply the new 
definitions to the CI. For details on the UI fields, see "Modified Values 
Dialog Box" on page 483.
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How to Define Thresholds for KPIs and HIs

The status displayed for a KPI or HI (health indicator) provides an indication 
of how well a business process or system is meeting your business objectives.

In most cases, KPIs and HIs are assigned a status as follows: A business rule 
calculates a measurement for the indicator. This measurement is compared 
with the threshold definitions, and the indicator is assigned a status 
according to how the measurement compares to the thresholds. 

The following task describes how to define thresholds for a KPI or HI 
assigned to one or more CIs. For more details on how thresholds work, see 
"KPI and HI Thresholds" on page 401.

To define thresholds for a KPI or HI:

 1 Within the CI Indicators tab, select one or more CIs in the upper pane. 
You can use the keyboard CTRL key to select multiple CIs.

 2 Within the CI Data pane, select the KPIs or Health Indicators tab 
depending on the type of indicator whose thresholds you want to define.

 3 Open an indicator for editing, and define the thresholds as described in 
"KPI and HI Thresholds" on page 401. 

For KPI user interface details, see "Add KPI/Edit KPI Dialog Box" on 
page 464.

For HI user interface details, see "Add Health Indicator/Edit Health 
Indicator Dialog Box" on page 470.

 4 The KPI or HI thresholds are changed for all of the selected CIs. If one of 
the selected CIs already has different thresholds defined for this indicator, 
a dialog box enables you to either keep the old thresholds or to apply the 
new thresholds to the CI. For details on the UI fields, see "Modified Values 
Dialog Box" on page 483.
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Example:

An HI is assigned to monitor transaction performance on a CI, using the 
Transaction Performance Rule to set its status. For this transaction, the required 
thresholds are as follows:

➤ Acceptable average performance time is under 6000 milliseconds. 

➤ Performance time that exceeds 6000 milliseconds is of concern. 

➤ Performance time of 8000 milliseconds is seriously problematic. 

➤ Performance time of 10000 milliseconds is critical. 

➤ In addition, Warning status is not required for this KPI.

In the Edit Health Indicator window, the threshold levels and operator are set as 
follows:

When a measurement is calculated for the HI from the incoming performance 
data, the measurement is compared with the thresholds assigned to the HI as 
follows:

➤ For a measurement under 6000 milliseconds, status = OK

➤ For a measurement of 6000 milliseconds or more, but under 8000 milliseconds, 
status = Minor

➤ For a measurement of 8000 milliseconds or more, but under 10000 
milliseconds, status = Major

➤ For a measurement of 10000 milliseconds or more, status = Critical
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How to Define Selectors for HIs

When you assign an HI (health indicator) to a CI, you can define selector 
expressions to filter data samples to target only those samples that are 
relevant for the HI. A selector expression requires a Field, an Operator, a 
Type, and a Value, defined in that order. For user interface details, see "Add 
New/Edit Selector Field Dialog Box" on page 479.

You can combine selectors expressions into groups, to create complex filters.

This section includes the following options:

➤ "Define a selector" on page 435

➤ "Define an additional selector expression within a block" on page 437

➤ "Define an alternative expression block" on page 437

➤ "Combine blocks that have internal conditions" on page 438

Define a selector

 1 Within the CI Indicators tab, select one or more CIs in the upper pane. 
You can use the keyboard CTRL key to select multiple CIs.

 2 Within the CI Data pane, select the Health Indicators tab, and open an HI 
for editing.

 3 Within the Add Health Indicator/Edit Health Indicator dialog box, locate 
the Selector area and perform the following actions:

➤ To add a new expression group, click Add Row > Add OR Clause.

➤ To add a selector expression to an existing group, select a row within a 
group and click Add Row > Add Selector Expression.

 4 Define one or more selector expressions to build your selector, as follows:

➤ Enter the required reference property in the Field box and select an 
operator from the Operator list. Enter details regarding the required 
value for the property in the Type and Value box. 

➤ Every selector must include the definition of the sample type required 
for the HI, so when manually defining a selector, at least one selector 
expression must contain this information. 
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For example, for an HI that relates to transaction measurements, the 
selector must catch transaction samples, which are defined by the 
sample type trans_t in the selector. For details on these samples, see 
"Sample: BPM Transaction (trans_t)" in Reports.

Tip: The Field and Value properties are case sensitive and must be entered 
precisely as used in the data samples from the data source, or the selector 
fails. The recommended method is to take the values from the samples 
published on the bus. For details, see "Data Samples" in Reports.

➤ Narrow the filter by using a logical And operator to attach additional 
selector expressions to an expression block. 

➤ Widen the filter by using a logical Or operator to add alternative 
expression blocks (each containing one or more selector expressions).

You can define as many selector expressions and blocks of selector 
expressions as required.
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Define an additional selector expression within a block

To define an additional selector expression within a block, click the Add 
Row button and select Add Selector Expression. For example, you can define 
a filter that looks for transaction samples that contain both profile name X 
and transaction name Y. 

Define an alternative expression block

To define an alternative expression block, click the Add Row button and 
select Add OR Clause. For example, you can define a filter that looks for 
transaction samples that contain either profile name X or transaction name 
Y.
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Combine blocks that have internal conditions

You can also combine blocks which use internal conditions. For example, a 
data sample qualifies for the following selector if the selector expressions a 
and b in block 1 are both true, or if the selector expressions c and d in block 
2 are both true. 
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How to Set Up User Mode Functionality

You can set up user mode functionality in HP Business Service Management 
by defining the mode for users, defining the KPI versions for each mode, 
and attaching the KPI versions to the CIs.

This task includes the following steps:

➤ "Assign a user mode" on page 439

➤ "Define KPI versions for the user modes" on page 440

➤ "Attach KPI versions to CIs" on page 441

 1 Assign a user mode

There are two ways to assign a user mode to a user:

➤ The system administrator, when defining new users in the Admin > 
Platform > Users and Permissions > User Management page, can set 
User Mode to Undefined, Operations User, or Business User. By 
default, all new/existing users are set as Unspecified (meaning that 
they see KPIs for both modes in Service Health).

➤ Users can change their own user mode in the Admin > Personal 
Settings > User Account page. Select the required mode from the User 
mode list.

After changing the mode in the User Account page, you must log out 
of HP Business Service Management and log in again to see the mode 
filtering work.
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 2 Define KPI versions for the user modes

The following steps describe how to define different versions of a KPI to 
use with each user mode. You can assign user modes to a new KPI that 
you define, or to an existing KPI by cloning or overriding the KPI. For 
more information, see "KPIs Repository page" on page 666.

 a Access the Admin > Service Health > Repositories > KPIs page.

 b Define the business user version of the KPI:

➤ Either create a new KPI, clone an existing KPI, or edit an existing KPI 
based on your needs.

➤ Give the KPI an appropriate name; for example, add the suffix _biz 
(as in Availability_biz).

➤ Select Business in the Applicable for User Mode list.

 c Define the operations user version of the KPI:

➤ Either create a new KPI, clone an existing KPI, or edit an existing KPI 
based on your needs.

➤ Give the KPI an appropriate name; for example, add the suffix _ops 
(as in Availability_ops).

➤ Select Operations in the Applicable for User Mode list.

Note: If you edit a KPI, the edited KPI replaces the original KPI 
throughout Service Health, so all CIs that are assigned the original KPI 
(for example, Availability) are automatically updated to the new 
version (for example, Availability_ops).

 d Edit the details for each KPI version, according to your requirements. 
For example, you might want different business rules to apply to each 
version. For more information, see "New KPI/Edit KPI Dialog Box" on 
page 668.

 e To use a different version of a business rule with each KPI version, you 
must define the rule versions in the Business Rule Repository. For 
example, for two versions of the Application Availability KPI, you may 
require two versions of the Transaction Availability Rule, each with 
different default objective values.
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For details on defining business rules, see "How to Customize a 
Business Rule Template in the Repository" on page 724.

 3 Attach KPI versions to CIs

You can manually attach the KPI versions to the CIs to which you want 
them to apply. 

➤ If the original KPI is already attached to CIs (for example, the 
Application Availability KPI is automatically attached to transaction 
CIs), then the edited KPI (for example, Availability_ops) is automatically 
attached to the CIs instead. You can manually attach the second KPI 
version (for example, Availability_biz).

➤ If there are two new KPI versions, one for business and one for 
operations then for every applicable CI you manually attach the two 
versions (and delete the original KPI if it is not required).

To attach the KPI versions to CIs, select Admin > Service Health > CI 
Indicators page, and add the KPI versions to each CI where they are 
required. You can add the KPI to multiple CIs in one operation. For 
details, see "CI Indicators Tab" on page 453.

How to Change the KPI Status Icons

Different icons are used for the KPI status for each range specified in the 
From/To fields in the Parameter Details dialog box. For details, see "New/Edit 
KPI Parameter Dialog Box" on page 678.

If you want to customize the KPI status icons, create a new set of icons and, 
where applicable, add your icons to the appropriate directories and redirect 
the KPI’s status parameters to those icons or replace the default icons with 
your customized icons using the same names.
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Note: The following formats are supported for custom icons: .png, .jpg and 
.gif.

The recommended size for an icon should be 16x16 pixels.

For details on the default icons, see "KPI Status Colors and Definitions" on 
page 45.

This section includes the following options:

➤ "Change the KPI status icons" on page 442

➤ "Change the Trend and History status icons" on page 443

➤ "Change the Top View status icons" on page 443

Change the KPI status icons

You can do one of the following:

➤ Add your icons to the appropriate directory and specify their names in 
each one of the status parameters for the KPIs. For details on the user 
interface, see "New KPI/Edit KPI Dialog Box" on page 668.

➤ Replace the icon or icon set with the customized icons and give them the 
names of the default icons.

To find the location of the icon you want to replace, right-click the icon 
in the appropriate tab in Service Health, select Properties, and view the 
icon’s location in the Address (URL) field.
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Make sure that you replace the icons set in the following directories:

➤ <Gateway root directory>
\AppServer\webapps\site.war\bam\pages\images\gui\indicator

➤ <Gateway root directory>
\AppServer\webapps\site.war\images\gui\indicator

Change the Trend and History status icons

You cannot change the names of the trend and history icons that appear in 
the Top View tab. To customize those icons, you can only replace the default 
images with your customized images.

The directory where the Trend and History Status icons are located is:
<Gateway root directory>\
AppServer\webapps\site.war\static\dash\images\indicator

For details on the Trend and History icons, see "KPI Trend and History 
Calculation" on page 408.

Change the Top View status icons

You cannot change the names of the Top View icons. To customize those 
icons, you can only replace the images with your customized images.

The directory where the icons are located is:
<Gateway root directory>\AppServer\webapps\site.war\
bam\pages\images\icons\dimensionIcons

The location of a specific icon uses the following naming scheme:
dimensionIcons/<kpi_id>/<status_id>.gif where <status_id> is the value 
specified in the From field of the status parameter defined for the KPI. For 
example: the value of the From field of the OK (green) status is 20 therefore 
the icon for the Application Availability KPI is located at: 
dimensionIcons/7/20.gif. For details on the user interface, see "New/Edit KPI 
Parameter Dialog Box" on page 678.

For details on the status icons, see "KPI Icons in Service Health" on page 96.
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How to Configure Breakdowns

Within local impact views, you can configure data breakdowns on CIs, so 
that data on their child CIs is broken down according to a particular 
dimension. For an overview of breakdowns, see "Breakdowns" on page 413.

Tip: If you want to see a breakdown of location by transaction across several 
applications, select all the relevant applications and configure BPM Location 
by Application or Location by Application breakdowns on all of them.

This task includes the following steps:

➤ "Select CIs in the CI Indicators tab" on page 444

➤ "Define a breakdown or display breakdown details in the CI Data pane" 
on page 445

➤ "Filter breakdown elements on a root CI" on page 446

➤ "Modify general breakdown settings (Optional)" on page 447

 1 Select CIs in the CI Indicators tab

Within the CI Indicators tab, select one or more CIs in the upper pane. 
The Breakdown column indicates one of four possible states for each CI 
in a local impact view:

➤ Not Assigned. A breakdown can be defined on this CI.

➤ Assigned. A breakdown has been defined, using this CI as the root CI.

➤ Derived. This CI is included in a defined breakdown (not as the root 
CI).

➤ Not Applicable. No breakdown can be defined on this CI.
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Note: Each CI can only be included in one breakdown per view; once a CI 
is included in a breakdown, it cannot be included in another within that 
view. If you want to create another breakdown using the same CI, you can 
clone the view in View Builder, and create a new breakdown in the new 
view.

Two breakdowns conflict with each other when a CI is defined as 
belonging to two different breakdowns. This occurs when you try to 
define a breakdown on top of a topology that already has at least one CI 
with a breakdown definition of any kind on it. When a conflict occurs, 
the following message is displayed: Breakdown assignment has failed as a 
result of the following conflict (followed by a description of the conflict). 
In this case, decide which of the breakdowns you want to apply.

 2 Define a breakdown or display breakdown details in the CI 
Data pane

Within the CI Data pane, select the Breakdown tab . This enables you to 
perform the following actions:

 a Define a breakdown on a CI. If you have selected one or more CIs 
where no breakdown has been defined, and these CIs can be used as 
root CIs, select a breakdown from the Breakdown Configurations list. 
This contains all the breakdown configurations that can be applied to 
the selected CIs, using these CIs as the breakdown root.

Note that to modify a breakdown, you must select the root CI.

For details on the UI fields, see "CI Indicators Tab" on page 453.

 b Display breakdown details on non-root CIs. If you have selected CIs 
which are included in a breakdown but are not root CIs, the Root CI 
field shows the root CI of the breakdown where they are included, and 
the Breakdown Configurations field shows the breakdown type.

 c Disable a breakdown. If you have selected a root CIs where a 
breakdown has been defined, you can disable the breakdown by 
selecting None from the Breakdown Configurations list.
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 d Define the breakdown calculation rule. For each breakdown root, 
define which calculation rule (worst, best, or average status) is applied 
to the child CIs. For example, if you have a transaction running in 
three locations with transaction by location breakdown, if you use the 
worst status rule the status of the transaction is the worst status of all 
three locations.

Note that you cannot use different rules for two CIs on the same 
hierarchy level. For example, if an application is a breakdown root, 
within that application you cannot calculate one transaction by worst 
status (of its locations), and another transaction by best status. 
However, you can use different rules for different transactions within 
two different applications.

 3 Filter breakdown elements on a root CI

If you have selected a CI which is the root CI of a breakdown, you can 
include or exclude specific CIs in the breakdown, using the Filter > Edit 
button.

Click Edit to open the Edit Breakdown Filter dialog box, and specify 
which CIs to include or exclude from the breakdown. The Available 
Elements list is automatically populated with the elements that can be 
included in the breakdown.

For example, if you specify Transaction by Location, you can include or 
exclude specific locations based on your organizational needs.

For details on the UI fields, see "Edit Breakdown Filter Dialog Box" on 
page 486.
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 4 Modify general breakdown settings (Optional)

You can modify the following breakdown settings:

 a Number of containers. Due to performance considerations, BSM 
supports the creation of 50 different CI containers using breakdowns, 
per instance. For example, if you define Transaction by Location, and 
you have more than 50 locations, only 50 locations are displayed.

You can modify this limit using the following infrastructure setting: 
Admin > Platform > Setup and Maintenance > Infrastructure Settings > 
Applications > Service Health Application, and locate the Maximum 
number of breakdown values entry in the Service Health Application - 
Breakdown table.

 b Container purging. By default, when a breakdown container has been 
in No Data status for one week, it is automatically removed from the 
display until the next time data is received for this container. 

You can modify this period using the following infrastructure setting: 
Admin > Platform > Setup and Maintenance > Infrastructure Settings > 
Applications > Service Health Application, and locate the Breakdown 
values purging period entry in the Service Health Application - 
Breakdown table.
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How to Attach a PNR KPI to a CI

The PNR (Point of No Return) KPI enables you to view how well Service 
Level Management agreement objectives are being met. When the PNR KPI 
is defined for a CI, a bar is displayed in Service Health indicating how much 
longer the CI can be unavailable before the agreement is in breach of 
contract. For details, see "PNR (Point of No Return) KPI Calculation" on 
page 422.

Perform the following procedure to view Service Level Management data in 
an information bar in Service Health.

This task includes the following steps:

➤ "Prerequisites in Service Level Management" on page 448

➤ "Define a PNR KPI in Service Health" on page 449

➤ "Results in Service Health" on page 450

 1 Prerequisites in Service Level Management

Create an agreement within Service Level Management. The SLA must 
include a CI with an attached KPI that can be used to calculate the PNR 
KPI. The rule assigned to the KPI in Service Level Management must be 
enabled to send PNR data to Service Health; the rule must be time-based, 
and it must calculate values using a range of 0-100.

For details on these prerequisites, see "Enabling PNR (Point of No Return) 
Display within Service Health" in Using Service Level Management.
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 2 Define a PNR KPI in Service Health

In Service Health Administration, attach a PNR KPI to the same CI. 
During KPI creation, select the PNR KPI and the Service Health PNR rule.
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 a In the PNR Parameters area:

➤ Select the agreement whose data is to be used for the Service Health 
PNR KPI. 

➤ Select the calendar and tracking period as defined when creating the 
agreement. For details, see "Define SLA Properties Page" in Using 
Service Level Management.

➤ Select the Service Level Management KPI whose data is used to 
calculate the PNR KPI.

 b Add the objectives that Service Health uses to calculate when 
unavailability time approaches breach of contract levels.

 3 Results in Service Health

View the results in Service Health: Applications > Service Health > 360 
View. Choose the view and select the CI. The tooltip shows the following 
PNR-related information:

➤ Status. The status of the PNR KPI.

➤ Business Rule. The Service Health business rule used for PNR KPI 
calculation.

➤ SLA. The SLA which includes this CI.

➤ Tracking Period. The SLA tracking period defined during PNR KPI 
configuration.

➤ Calendars. The SLA calendar defined during PNR KPI configuration.

➤ Calculation  Time. The time of the last SLA calculation.
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➤ PNR Time Left. The amount of time the CI can still be unavailable in 
the calculation period before the agreement is breached. This is a result 
of the following calculation: Maximum unavailability - Unavailability 
to current time = PNR Time left.

➤ Max Unavailability. The total time the CI can be unavailable during the 
calculation period before the agreement is breached, based on the 
specified SLM KPI.

➤ PNR Availability. The current percentage of availability in Service Level 
Management.

➤ Target Availability. The availability breach threshold as defined in the 
SLA.
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Reference

CI Indicators User Interface

This section includes:

 ➤ CI Indicators Tab on page 453

 ➤ CI Data Pane > KPIs Tab on page 457

 ➤ CI Data Pane > Health Indicators Tab on page 459

 ➤ CI Data Pane > CI Properties Tab on page 460

 ➤ CI Data Pane > Breakdown Tab on page 462

 ➤ Add KPI/Edit KPI Dialog Box on page 464

 ➤ Edit Health Indicators in KPI Calculation Dialog Box on page 469

 ➤ Add Health Indicator/Edit Health Indicator Dialog Box on page 470

 ➤ Add New/Edit Selector Field Dialog Box on page 479

 ➤ Selector Expression Operators - Reference on page 480

 ➤ Confirm CI Changes Dialog Box on page 482

 ➤ Modified Values Dialog Box on page 483

 ➤ Edit Context Menus Dialog Box on page 485

 ➤ Edit Breakdown Filter Dialog Box on page 486
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CI Indicators Tab

The CI Indicators tab enables you to attach KPIs, HIs (health indicators), and 
context menus to specific CIs within a view. In addition, this tab enables 
you to define CI breakdowns in local impact views. Select one or more CIs in 
the <View Name> pane, and modify the CI’s settings using the CI Data pane.

<View Name> Pane

The <View Name> pane in the upper part of the tab displays CIs and their 
assigned KPIs. After you select a view, this pane shows the view name as its 
title. The pane displays a hierarchy of the CIs in the view, their CI types, and 
their assigned KPIs. Each row in the table represents a CI in the view 
hierarchy. 

In local impact views, this pane also indicates whether a breakdown has 
been defined, for each CI in the view.

After you select one or more CIs in this pane, the KPIs and HIs that are 
shared by the selected CIs appear in the CI Data pane. You can modify these 
details as required.

To access Select Admin > Service Health > CI Indicators

Important 
information

Select a view in the upper left corner of the tab, then 
configure indicators for the CIs that are in the selected 
view. 

Relevant tasks "How to Configure KPIs and HIs—Overview" on 
page 425

Important 
information

➤ Within the CI hierarchy a CI may appear more than 
once. If you select a CI, all instances of that CI are 
automatically selected.

➤ Virtual CIs (defined in the RTSM as Group By CIs) 
cannot have indicators or context menus assigned 
to them, and cannot have breakdowns defined on 
them. You cannot select virtual CIs in the CI 
Indicators tab.
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User interface elements are described below:

UI Element (A-Z) Description

<Filter Box> At the top of each column there is a box which enables 
you to filter specific elements in the column; for 
example you can select a CIT, or one or more KPIs to be 
displayed. To filter by CI Name, press Enter to activate 
the filter.

When a CI matches a filter, its parent CIs are displayed 
as well. To select the CIs which match a filter (for 
example for a bulk action), click the Select by Filter 
button.

<View List> Select a view from this dropdown list to display 
information on the CIs in this view.

The icons next to the view names indicate the type of 
view; for details see "View Builder Overview" on 
page 380.

Select all. Select all the CIs.

Clear Selection. De-select all the CIs.

Select by Filter. Select the CIs which match the filter 
(defined in the filter box at the top of a column). 

Expand all. Display all the CIs in the hierarchy.

Collapse all. Display only the highest level CIs in the 
hierarchy.

Refresh. Refresh the display.
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Breakdown In local impact views, this column shows one of the 
following regarding each CI:

➤ A breakdown can be defined on this CI (no icon).

➤  A breakdown has been defined, using this CI as 
the root CI.

➤  This CI is included in a defined breakdown (not 
as the root CI).

➤  No breakdown can be defined on this CI; a 
tooltip provides details.

To define a breakdown or display details on a 
breakdown that has been defined, select one or more 
CIs and open the Breakdown tab in the CI Data pane.

Note: If you have selected a view which is not a local 
impact view, the breakdown column is not visible, and 
the breakdown tab in the CI Data pane is disabled.

CI Name The name of the CI.

CI Type The CIT of the CI.

Hide KPIs If KPIs are displayed, click the Hide KPIs button to 
remove the list of KPIs from the display.

KPIs Icons representing each of the KPIs assigned to the CI; 
a tooltip shows the KPI name and its associated 
business rule. (The Legend pane on the lower right side 
of the CI Indicators tab also provides definitions of 
these icons.)

To edit, add, or remove KPIs, select one or more CIs 
and modify its KPI definitions within the CI Data pane.

Show KPIs If KPIs are not displayed, click the Show KPIs button to 
display the list of KPIs assigned to the CIs.

UI Element (A-Z) Description
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Legend Pane

The Legend pane on the bottom right side of the tab provides full names for 
the KPIs displayed in the upper pane.

CI Data Pane

The CI Data pane on the lower left side of the tab displays details regarding 
the CIs that you selected in the upper pane of the CI Indicators tab, and 
enables you to modify CI details. This pane enables you to perform the 
following:

➤ Within the KPIs and Health Indicators tabs, you can edit, add or remove 
KPIs and HIs on these CIs. For user interface details, see "CI Data Pane > 
KPIs Tab" on page 457, and "CI Data Pane > Health Indicators Tab" on 
page 459.

➤ Within the CI Properties tab, you can modify the context menus and CI 
data over time settings for these CIs. For user interface details, see "CI 
Data Pane > CI Properties Tab" on page 460.

➤ Within the Breakdown tab, you can define CI breakdowns in local impact 
views. For user interface details, see "CI Data Pane > Breakdown Tab" on 
page 462. For details on breakdowns, see "How to Configure Breakdowns" 
on page 444.

If more than one CI is selected in the upper pane, the CI Data pane shows 
the information that is shared by all the selected CIs. For example, if two CIs 
are selected in the CIs pane: one CI has Application Availability and 
Application Performance KPIs assigned, and the other CI has only 
Application Availability assigned, the KPIs tab shows the Application 
Availability KPI only.
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CI Data Pane > KPIs Tab

The KPIs tab within the CI Data pane enables you to edit, add or remove 
KPIs on the CIs selected in the <View Name> pane.

User interface elements are described below:

To access Select Admin > Service Health > CI Indicators. In the CI 
Data pane, select the KPIs tab.

Relevant tasks "How to Configure KPIs and HIs—Overview" on 
page 425

UI Element (A-Z) Description

Add KPI. Create a new KPI.

Edit KPI. Edit the details of a selected KPI. 

Delete KPIs. Delete one or more selected KPIs. 

Export to Excel. Export the table to an Excel file.

Export to PDF. Export the table to a PDF file.

Business Rule The business rule used to calculate the measurement 
and status for the KPI. If you have selected multiple CIs 
and these CIs use different rules to calculate this KPI, 
[Mixed Values] is displayed in this field.

For an explanation of the role of the rules, see "About 
Business Rules" on page 399. For information about 
each individual rule, see "List of Calculation Rules in 
Service Health" on page 740.
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Calculated Based On This indicates if the KPI is calculated by:

➤ Health indicators and child KPIs. The KPI is 
calculated by the HIs assigned to the CI, and by the 
KPIs assigned to the child CIs.

➤ Assigned health indicators. The KPI is calculated by 
the HIs assigned to the CI.

➤ KPIs assigned to child CIs. The KPI is calculated by 
the KPIs assigned to the child CIs.

➤ HIs; if none, use child KPIs. The KPI is calculated by 
the HIs assigned to the CI; if there are no HIs 
assigned, the KPI is calculated by the KPIs assigned 
to the child CIs.

If you have selected multiple CIs and these CIs use 
different methods to calculate the KPI, [Mixed Values] 
is displayed in this field.

Domain The domain which contains this KPI. Domains are 
groups of KPIs which monitor similar functions (for 
example Application or Network); this enables you to 
filter KPIs according to these groupings. For details see 
"KPI Domains" on page 411.

KPI Name The name of the KPI assigned to the selected CI. For 
information about each KPI, see "List of Service Health 
KPIs" on page 656.

Related Health 
Indicators

The list of HIs whose values are used in calculating this 
KPI. If multiple CIs are selected, this field can show one 
of the following:

➤ The names of the HIs that are used to calculate this 
KPI on all of the selected CIs. 
Note that if an HI is used for only some of the CIs, it 
is not displayed.

➤ No health indicators. None of the selected CIs use 
HIs to calculate this KPI.

➤ No health indicators in common. None of the 
selected CIs use the same HIs to calculate this KPI.

UI Element (A-Z) Description
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CI Data Pane > Health Indicators Tab

The Health Indicators tab within the CI Data pane enables you to edit, add 
or remove HIs on the CIs selected in the <View Name> pane.

User interface elements are described below:

To access Select Admin > Service Health > CI Indicators. In the CI 
Data pane, select the Health Indicators tab.

Relevant tasks "How to Configure KPIs and HIs—Overview" on 
page 425

UI Element (A-Z) Description

Add Health Indicator. Create a new HI. 

Edit Health Indicator. Edit the details of a selected HI. 

Delete Health Indicators. Delete one or more selected 
HIs. 

Export to Excel. Export the table to an Excel file.

Export to PDF. Export the table to a PDF file.

Business Rule The business rule used to calculate the measurement 
and status for the HI. If you have selected multiple CIs 
and these CIs use different rules to calculate this shared 
HI, [Mixed Values] is displayed in this field.

For an explanation of the role of the rules, see "About 
Business Rules" on page 399. For information about 
each individual rule, see "List of Calculation Rules in 
Service Health" on page 740.

Health Indicator 
Name

The name of the HI assigned to the selected CI.
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CI Data Pane > CI Properties Tab

The CI Properties tab within the CI Data pane enables you to modify the 
context menus and CI data over time settings for the CIs selected in the 
<View Name> pane.

User interface elements are described below:

Related KPIs The list of KPIs which use this HI in their calculations.

Scope This displays one of the following:

➤ Global. The HI exists in the global view and has not 
been overridden in the local impact view. In a global 
view all HIs are global.

➤ Local. The HI was overridden or created in the local 
impact view.

To access Select Admin > Service Health > CI Indicators. In the CI 
Data pane, select the CI Properties tab.

Relevant tasks "How to Configure KPIs and HIs—Overview" on 
page 425

UI Element (A-Z) Description

Add Context Menu. Add a context menu to the 
selected CIs. 

A dialog box enables you to assign context menus; for 
details see "Edit Context Menus Dialog Box" on 
page 485.

Delete Context Menu. Delete one or more selected 
context menus from the selected CIs.

Export to Excel. Export the table to an Excel file.

UI Element (A-Z) Description
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Export to PDF. Export the table to a PDF file.

<Context menu> The name of the context menus assigned to the 
selected CIs. For details, see "List of Context Menus" on 
page 899.

Save KPI data over 
time for the selected 
CIs

Select the option to set HP Business Service 
Management to save KPI data for CIs, as described in 
"Persistent Data and Historical Data" on page 411.

The option is selected by default for logical CIs and for 
CIs that are important for problem isolation, such as 
Business Application, Business Process, Business 
Service, and Host.

If you select this option, status changes are saved by 
default. If you also want to save data on the actual 
measurements for the KPIs, you must change the 
default settings for Service Health in the Repositories, 
as described in "How to Save Measurements Data" on 
page 736.

Saving historical data for long periods of time or for 
many CIs and KPIs should be used with care; using this 
option can require a lot of database disk space and 
affect overall performance. When you no longer 
require data to be saved for a CI, clear the Save KPI 
data over time for the selected CI check box for that 
CI. Alternatively, make sure to define purging by the 
Partition Manager according to your retention policy. 
For details, see "Database Administration" in Platform 
Administration.

Note: The Save KPI data over time option is not 
available in local impact views.

UI Element (A-Z) Description
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CI Data Pane > Breakdown Tab

The Breakdown tab within the CI Data pane enables you to configure 
breakdowns on the CIs selected in the <View Name> pane, in local impact 
views.

To access Select Admin > Service Health > CI Indicators. In the CI 
Data pane, select the Breakdown tab.

Important 
information

The contents of this tab depend on which CIs you have 
selected in the upper pane. If you have selected one or 
more CIs that are already included in a breakdown, this 
tab shows information on the breakdown in which 
they are included. 

If you have selected CIs that are not included in a 
breakdown, but can be used as root CIs, this tab 
enables you to define a breakdown using the selected 
CIs as root CIs.

If you have selected a view which is not a local impact 
view, the Breakdown column is not visible in the upper 
pane, and the Breakdown tab in the CI Data pane is 
disabled.

Relevant tasks "How to Configure Breakdowns" on page 444

See also "Breakdowns" on page 413
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User interface elements are described below:

UI Element (A-Z) Description

Breakdown 
Calculation Rule

This defines which calculation rule (worst, best, or 
average status) is applied to the child CIs for each 
breakdown root. For example, if you have a transaction 
running in three locations with transaction by location 
breakdown, if you use the worst status rule the status of 
the transaction is the worst status of all three locations.

Breakdown 
Configuration

➤ If you have selected CIs that are already included in 
a breakdown, this shows (in read-only mode) the 
type of breakdown in which the selected CIs are 
included.

➤ If you have selected CIs that can be defined as root 
CIs, and are not already included in a breakdown, 
this contains a list of the possible breakdown 
configurations that can be applied to the selected 
CIs. The list of possible breakdowns is based on the 
CITs of the selected CIs.

Select a breakdown to apply it to the selected CIs, 
with these CIs defined as the breakdown root.

Filter This enables you to include or exclude specific 
elements in a breakdown, if the selected CIs are the 
root CIs of a breakdown. For example, if you specify 
Transaction by Location, you can include or exclude 
specific locations based on your organizational needs.

Click Edit to define the breakdown filter; the filter can 
include specific CIs, or exclude specific CIs. For details, 
see "Edit Breakdown Filter Dialog Box" on page 486.

Root CI A breakdown is defined on a root CI; CIs beneath this 
CI in the view hierarchy are included within the 
breakdown, if they are applicable for the breakdown.

➤ If the selected CIs are not included in any 
breakdown, this shows None.

➤ If a breakdown has been defined which includes the 
selected CIs, this shows the root CI of the 
breakdown.
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Add KPI/Edit KPI Dialog Box

This dialog box enables you to assign KPIs to CIs or to edit the properties of 
a CI’s KPIs. 

To access In the CI Indicators tab, select one or more CIs in the 
upper <View Name> pane.

The CI Data pane > KPIs tab displays the KPIs assigned 
to the selected CIs. If you select multiple CIs, the KPIs 
tab displays the KPIs that are shared by all of the 
selected CIs.

➤ To add a KPI to the selected CIs, click the Add KPI 
button in the KPIs tab. 

➤ To edit the properties of a KPI displayed in the KPIs 
tab, select a KPI and click the Edit KPI button.

Important 
information

There can be only one instance of each KPI for a CI. For 
each new KPI, you define the KPI type and business 
rule. Where relevant, you also define additional 
information required by the rule.

You can attach a KPI that exists in the KPI Repository, 
or create a new KPI.

When you attach a KPI to multiple CIs, the KPI is 
added to all CIs that do not already have that KPI 
attached. All instances of the KPI have the same 
defined business rule and properties.

Relevant tasks "How to Configure KPIs and HIs—Overview" on 
page 425

See also ➤ "KPI and HI Calculation" on page 397

➤ "KPI Repository Overview" on page 652
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KPI Area

User interface elements are described below:

UI Element (A-Z) Description

Add or remove HIs from the list of Related Health 
Indicators which are used to calculate the KPI. For 
details, see "Edit Health Indicators in KPI Calculation 
Dialog Box" on page 469.

Note: Adding a related HI to a KPI does not assign the 
HI to the CI itself; this means that if the HI is assigned 
to the CI, this KPI will include the HI in its calculation.

Business Rule After selecting a KPI, the Business Rule list is 
automatically updated to display all business rules that 
are applicable for the selected KPI.

Applicable rules are those that are applicable to the CI 
Type and to the KPI, as defined in the Rule Repository. 
For information about each individual rule, see "List of 
Calculation Rules in Service Health" on page 740.

Select the required rule from the list. The rule is used to 
calculate the measurement and status for the KPI. 

If you have selected multiple CIs and these CIs use 
different rules to calculate this shared KPI, [Mixed 
Values] is displayed.

Note: After selecting a rule, the dialog box is 
automatically updated to display the areas (Business 
Rule Parameters, API Rule Definitions, Objective, and 
so on) that are relevant for the selected rule.
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Calculated Based On Select one of the following calculation methods:

➤ Health indicators. The KPI is calculated by the HIs 
assigned to the CI.

➤ Child KPIs. The KPI is calculated by the KPIs assigned 
to the child CIs.

➤ Health indicators and child KPIs. The KPI is 
calculated by the HIs assigned to the CI, and by the 
KPIs assigned to the child CIs.

➤ HIs; if none, use child KPIs. The KPI is calculated by 
the HIs assigned to the CI; if there are no HIs 
assigned to the CI, the KPI is calculated by the KPIs 
assigned to the child CIs.

Create New KPI Click this link to create a new KPI in the KPI 
Repository; you can then save changes to apply this 
new KPI to the selected CIs.

For details, see "New KPI/Edit KPI Dialog Box" on 
page 668.

KPI Select a KPI from the KPI list. The list contains the 
names of all available KPIs (KPIs that are already 
attached to the CI are not included in the list). For an 
explanation of each individual KPI, see "List of Service 
Health KPIs" on page 656.

Note: When defining a KPI for multiple CIs, the KPI list 
contains all KPI types (except those already assigned to 
the CIs).

Related Health 
Indicators

This shows which HIs will be used to calculate the KPI 
on the selected CIs.

To modify, click the buttons to the right of this field, as 
described in the button descriptions above.

UI Element (A-Z) Description
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KPI Properties Area

After you select a rule, the KPI Properties area displays the areas (Business 
Rule Parameters, PNR Parameters, API Rule Definitions, and Thresholds) 
that are relevant for the selected rule, as described in the following sections.

Business Rule Parameters Area

This area enables you to view and modify rule parameters for the selected 
rule. All parameters have default values.

If required, modify the parameter values by entering a new value in the 
appropriate boxes. The information after each box indicates the type of 
value that can be entered (for example, Any Number, Text, or Boolean).

For information about rule parameters and possible values, refer to the 
relevant rule as described in "List of Calculation Rules in Service Health" on 
page 740.

PNR Parameters Area

This area enables you to define parameters relevant for the PNR KPI. For 
details, see "How to Attach a PNR KPI to a CI" on page 448. 

User interface elements are described below:

UI Element (A-Z) Description

Calendar Select the calendar for which the PNR KPI is calculated.

SLA Select the agreement for which the PNR KPI is 
calculated.

SLM KPI Select the Service Level Management KPI for which the 
PNR KPI is calculated.

Tracking Period Select the tracking period for which the PNR KPI is 
calculated.
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API Rule Definitions Area

This area is displayed when you select an API rule in the Business rule list. 
For details, see "Rules API Overview" on page 948.

User interface elements are described below:

Thresholds Area

This area enables you to define value ranges that are used to determine 
status for the KPI. The measurement for the KPI (calculated by the business 
rule) is compared with the thresholds, and a color status is assigned 
accordingly. 

The thresholds are defined in a unit of measurement appropriate to the type 
of data dealt with by the rule. The unit is indicated after the thresholds 
value box.

This area is displayed when relevant. If required, you can modify the default 
values for the thresholds. For details, see "KPI and HI Thresholds" on 
page 401.

UI Element (A-Z) Description

KPI Calculation Script Enter the KPI calculation script for the rule you are 
creating using the Rules API. The contents of the script 
depends on the rule type, as follows:

➤ API Group and Sibling Rule. See "API Group and 
Sibling Rule" on page 950.

➤ API Sample Rule. See "API Sample Rule" on page 953.

➤ API Duration-Based Rule. See "API Duration-Based 
Sample Rule" on page 955.

Sample Fields Enter the names of the sample fields you want to use in 
the script. Separate between the sample names with a 
comma.

Note: Displayed only when you select the API Sample 
rule or the API Duration-Based rule in the Business rule 
list.
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User interface elements are described below:

Edit Health Indicators in KPI Calculation Dialog Box

This dialog box enables you to add or remove HIs (health indicators) from 
the list of HIs which are used to calculate a KPI, on one or more CIs.

UI Element (A-Z) Description

OK, Warning, Minor, 
Major, Critical

Enter the required threshold value for each status in 
the appropriate box. Ensure that the numbers you 
enter are logically ordered.

Operator Select the required operator. This operator is applied for 
all the thresholds.

To access In the CI Indicators tab, select one or more CIs in the 
upper <View Name> pane. In the CI Data pane > KPIs 
tab, open a KPI for editing, or add a new KPI.

In the Add/Edit KPI dialog box, click the Edit button 
next to the Related Health Indicators field.

Important 
information

➤ The list of Available Health Indicators that can be 
used to calculate the KPI on the selected CIs is based 
on their CI Types. The Indicator Repository defines 
which HIs are applicable to each CI Type. For details, 
see "Indicator Repository Overview" on page 682.

➤ Adding a related HI to a KPI does not assign the HI 
to the CI itself; this means that if the HI is assigned 
to the CI, this KPI will include the HI in its 
calculation.
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User interface elements are described below:

Add Health Indicator/Edit Health Indicator Dialog Box

This dialog box enables you to assign HIs (health indicators) to CIs, or to 
edit the properties of a CI’s HIs. 

UI Element (A-Z) Description

Move all HIs to the Selected Health Indicators list.

Select an HI from the Available Health Indicators list, 
and click to add it to the Selected Health Indicators 
list.

Select an HI from the Selected Health Indicators list, 
and click to remove it.

Remove all HIs from the Selected Health Indicators list.

Available Health 
Indicators

This shows the list of HIs that can be used to calculate 
the KPI on the selected CIs, based on their CI Types.

Selected Health 
Indicators

This shows which HIs will be used to calculate the KPI 
on the selected CIs.

To access In the CI Indicators tab, select one or more CIs in the 
upper <View Name> pane.

The CI Data pane > Health Indicators tab displays the 
HIs assigned to the selected CIs. If you select multiple 
CIs, this tab displays the HIs that are shared by all of 
the selected CIs.

➤ To add an HI to the selected CIs, click the Add 
Health Indicator button in the Health Indicators tab. 

➤ To edit the properties of an HI displayed in the 
Health Indicators tab, select an HI and click the Edit 
Health Indicator button.
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Important 
information

There can be only one instance of each HI for a CI. For 
each new HI, you define the HI type and business rule. 
Where relevant, you also define additional information 
required by the rule.

When you attach an HI to multiple CIs, it is added to 
all CIs that do not already have that HI attached. All 
instances of the HI have the same defined business rule 
and properties.

Relevant tasks "How to Configure KPIs and HIs—Overview" on 
page 425

See also "KPI and HI Calculation" on page 397
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Health Indicator Area

User interface elements are described below:

UI Element (A-Z) Description

Business Rule After selecting an HI, the Business Rule list is 
automatically updated to display all business rules that 
are applicable for the selected HI.

Applicable rules are those that are applicable to the CI 
Type, as defined in the Indicator Repository. For 
information about each individual rule, see "List of 
Calculation Rules in Service Health" on page 740.

Select the required rule from the list. The rule is used to 
calculate the measurement and status for the HI. 

If you have selected multiple CIs and these CIs use 
different rules to calculate this shared HI, [Mixed 
Values] is displayed.

Note: After selecting a rule, the dialog box is 
automatically updated to display the areas (Business 
Rule Parameters, API Rule Definitions, Objective, and 
so on) that are relevant for the selected rule.
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Health Indicator Select an HI from the Health Indicator list. The list 
contains the names of all available HIs based on CI 
Types; the Indicator Repository defines which HIs are 
applicable to each CI Type. For details, see "Indicator 
Repository Overview" on page 682.

HIs that are already attached to the CI are not included 
in the list.

Note: When defining an HI for multiple CIs, this list 
contains the HIs that are applicable for all of the CIs 
(according to their CI Types).

Health Indicator Fed 
By

This shows one of the following:

➤ Events Only. The status of the HI is event-based, 
taken from an ETI. In this case, this dialog box only 
shows the areas that are relevant for defining event-
based HIs.

➤ Metrics and Events. The status of the HI may be 
metric-based (from samples), or event-based (from 
an ETI). In this case, you must also specify the rule 
used to calculate the HI, and any required rule 
parameters.

➤ {Mixed Values}. The HI is assigned to more than one 
CI, and in one CI (or more) it is based on events 
only, and in one CI (or more) it is based on metrics 
and events. In this case, you must also specify the 
rule used to calculate the HI, and any required rule 
parameters.

Select one of these options to define the source of the 
HI’s status.

For details on the types of HIs, see "Events, ETIs, and 
HIs - Overview" on page 683.

UI Element (A-Z) Description
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Health Indicator Properties Area

If your HI is metric-based, after you select a rule the Health Indicator 
Properties area displays the areas (Business Rule Parameters, API Rule 
Definitions, Thresholds, and Selectors) that are relevant for the selected rule, 
as described in the following sections.

Business Rule Parameters Area

This area enables you to view and modify rule parameters for the selected 
rule. All parameters have default values.

If required, modify the parameter values by entering a new value in the 
appropriate boxes. The information after each box indicates the type of 
value that can be entered (for example, Any Number, Text, or Boolean).

For information about rule parameters and possible values, refer to the 
relevant rule in "List of Calculation Rules in Service Health" on page 740.
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API Rule Definitions Area

This area is displayed when you select an API rule in the Business rule list. 
For details, see "Rules API Overview" on page 948.

User interface elements are described below:

Thresholds Area

This area enables you to define value ranges that are used to determine 
status for the HI. The measurement for the HI (calculated by the business 
rule) is compared with the thresholds, and a color status is assigned 
accordingly. 

The thresholds are defined in a unit of measurement appropriate to the type 
of data dealt with by the rule. The unit is indicated after the thresholds 
value box.

This area is displayed when relevant. If required, you can modify the default 
values for the thresholds. For details, see "KPI and HI Thresholds" on 
page 401.

UI Element (A-Z) Description

KPI Calculation Script Enter the KPI calculation script for the rule you are 
creating using the Rules API. The contents of the script 
depends on the rule type, as follows:

➤ API Group and Sibling Rule. See "API Group and 
Sibling Rule" on page 950.

➤ API Sample Rule. See "API Sample Rule" on page 953.

➤ API Duration-Based Rule. See "API Duration-Based 
Sample Rule" on page 955.

Sample Fields Enter the names of the sample fields you want to use in 
the script. Separate between the sample names with a 
comma.

Note: Displayed only when you select the API Sample 
rule or the API Duration-Based rule in the Business rule 
list.
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User interface elements are described below:

Selector Area

This area enables you to define a selector that identifies which data samples 
are relevant for this health indicator on this CI. The selector acts as a filter 
for the incoming data, so that the Service Health engine can map the 
incoming data samples that match the filter, to the HI and CI.

If you select Use Default, the selector is taken from the HI Assignments, if 
there is an assignment that matches this CI and HI. If not, you are prompted 
to define the HI's selector.

For details on selector functionality, see "Selectors for Metric-Based HIs" on 
page 406. For details on each of the selector expression fields, see "Add 
New/Edit Selector Field Dialog Box" on page 479.

UI Element (A-Z) Description

OK, Warning, Minor, 
Major, Critical

Enter the required threshold value for each status in 
the appropriate box. Ensure that the numbers you 
enter are logically ordered.

Operator Select the required operator. This operator is applied for 
all the thresholds.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Add Row. The dropdown list contains two options:

➤ Add Selector Expression. Enables you to define a 
selector expression to add to the selector filter 
currently selected in the Selector table. The added 
selection expression has an AND relationship.

➤ Add OR Clause. Enables you to define a selector 
expression to add to the selector table, as the first 
expression in a new selector filter. The new selector 
filter has an OR relationship with other selector 
filters in the Selector.

Edit. Opens the Edit Selector Field dialog box for the 
currently selected selector expression row, where you 
can edit the expression details.

Delete. Deletes one or more selected selector 
expressions rows. The button deletes a whole selector 
filter if the AND or OR heading for the filter is selected.

Copy. Use to copy one or more selector expression rows, 
or a whole selector filter, to the clipboard. The copied 
expressions are then available to paste within the 
current selector.

Cut. Use to cut one or more selector expression rows 
and paste them elsewhere within the selector. 

Note: The rows continue to appear until you click Paste.

Paste. Pastes the selector expression rows on the 
clipboard to the Selector table. The expressions are 
pasted after the selected row in the table.

If you are pasting a whole selector filter, it is pasted as a 
new filter (with OR relationship).

AND Group heading for a single selector filter in the Selector 
table.
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Copy Selector to 
Clipboard

Copies the entire contents of the Selector table to the 
clipboard, for use in other HI selectors.

Expression Summary When you have defined a selector, this area displays a 
summary of the selector conditions.

Field Name The field that is searched for in the incoming data 
samples, to compare with the selector expression. For 
details on the sample fields, see "Data Samples" in 
Reports.

Operator The relational operator that is used to compare the 
actual value for the referenced field against the value 
defined in the selector expression.

For details on each operator usage, see "Selector 
Expression Operators - Reference" on page 480.

OR Group heading for each selector filter in the Selector 
table, when there are two or more filters.

Paste Selector from 
Clipboard

Pastes the selector on the clipboard to the Selector table.

Note: The pasted selector overwrites any information 
previously in the Selector table. 

Type The data type for the specified value (can be String, 
Double, Integer, Long, Boolean, Float, or Binary).

Use Default Select this check box to use the default selector 
definition. If there is an HI assignment that matches 
this CI and HI, the default from the assignment is used. 
If not, you are prompted to define the HI's selector.

To define a non-default selector, clear this check box.

Value The value that is compared with the actual field value 
in the data samples.

UI Element (A-Z) Description
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Add New/Edit Selector Field Dialog Box

This dialog box enables you to define a selector expression, as part of the 
selector for an HI or an Outage KPI. The selector expression is compared 
against each incoming data sample, generating a result of either TRUE or 
FALSE.

User interface elements are described below:

To access In the Add Health Indicator/Edit Health Indicator 
dialog box, in the Selector Area, click Add Row > Add 
Selector Expression or Add OR Clause (or click the Edit 
button for an existing selector expression).

Relevant tasks "How to Define Selectors for HIs" on page 435

See also "Selectors for Metric-Based HIs" on page 406

UI Element (A-Z) Description

Field Name The field that is searched for in the incoming data 
samples, to compare with the selector expression. For 
details on the sample fields, see "Data Samples" in Reports.

Operator The relational operator, used to compare the value 
defined in the Value box in the selector expression, 
against the actual field value in the data sample. 

For example, if the selected operator is notPrefix, then 
the text entered in the Value box is compared with the 
beginning of the value for the relevant field in each data 
sample. When the prefix value in the sample does not 
match, the selector expression gives a TRUE result. 

Select the required operator from the dropdown list. For 
details on each operator usage, see "Selector Expression 
Operators - Reference" on page 480. 

Type The data type used in the samples for the specified value, 
for example, String, Integer, and so forth.

Value The value that is compared with the actual field value in 
the data sample, to establish if the sample qualifies as 
TRUE for this selector expression.
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Selector Expression Operators - Reference

The following table describes the relational operators used in the selector 
expressions for HIs. The operators are used to compare the value defined in 
the selector expression against the property value in the data sample. 

User interface elements are described below:

To access Operators for selector expressions are defined in the Add 
New Selector Field dialog box or Edit Selector Field 
dialog box.

Relevant tasks "How to Define Selectors for HIs" on page 435

See also "Selectors for Metric-Based HIs" on page 406

UI Element Description

= The value for the specified property in the data sample 
must exactly equal the value defined in the selector 
expression.

! = The value  for the specified property in the data sample 
must not be equal to the value defined in the selector 
expression.

in The value for the specified property in the data sample 
must be one of the values (separated by commas) defined 
in the selector expression. For example, if sample S1 has 
an attribute A1 with the value V1, the following is true:
A1 in V1,V2,V3.

not in The value for the specified property in the data sample 
must not be one of the values (separated by commas) 
defined in the selector expression.

> The value for the specified property in the data sample 
must be greater than the value defined in the selector 
expression.

< The value for the specified property in the data sample 
must be smaller than the value defined in the selector 
expression.
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matches The value for the specified property in the data sample 
must match the value defined in the selector expression. 
This uses the Java Regex language. For details see:

http://java.sun.com/developer/technicalArticles/releases/1.4r
egex/

http://www.regexplanet.com/advanced/java/index.html

doesn’t match The value for the specified property in the data sample 
must be different from the value defined in the selector 
expression. This uses the Java Regex language. For details 
see:

http://java.sun.com/developer/technicalArticles/releases/1.4r
egex/

http://www.regexplanet.com/advanced/java/index.html

>= The value for the specified property in the data sample 
must be more than or equal to the value defined in the 
selector expression.

<= The value for the specified property in the data sample 
must be less than or equal to the value defined in the 
selector expression.

prefix The value for the specified property in the data sample 
must start with the string defined in the selector 
expression.

notPrefix The value for the specified property in the data sample 
must not start with the string defined in the selector 
expression.

suffix The value for the specified property in the data sample 
must end with the string defined in the selector 
expression.

notSuffix The value for the specified property in the data sample 
must not end with the string defined in the selector 
expression.

UI Element Description
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Confirm CI Changes Dialog Box

This dialog box appears if you add a KPI or HI (health indicator) to multiple 
CIs, and this indicator is already assigned to one or more of the CIs. The 
dialog box enables you to add the indicator to the CIs where it was not 
originally assigned, or to override the original assignments on all the CIs. 
Each row in the table represents a CI where the indicator is already assigned.

User interface elements are described below:

To access Select Admin > Service Health > CI Indicators. Select 
multiple CIs using the upper pane, and add a KPI or HI 
using the CI Data pane.

Important 
information

After you click Show Details, the dialog box contains 
the user interface elements described below.

Relevant tasks "How to Configure KPIs and HIs—Overview" on 
page 425

UI Element (A-Z) Description

Export to Excel. Export the table to an Excel file.

Export to PDF. Export the table to a PDF file.

Business Rule The business rule used to calculate the KPI or HI that is 
already assigned to the specified CI.

CI The name of the CI where the indicator is already 
assigned.

CI Type The CI Type (CIT) of the CI where the indicator is 
already assigned.

Hide Details Collapse the dialog box and hide details.

Keep Existing Keep the original indicator assignments, and add the 
indicator only to those CIs where it was not originally 
assigned.
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Modified Values Dialog Box

You can modify KPI or HI (health indicator) settings using the CI Data pane. 
If you select a few CIs in the upper pane and edit an indicator assigned to 
these CIs using the lower pane, this dialog box appears when a field changes 
from [Mixed Values] to a specific value. For example, if a KPI has a Warning 
threshold of 80% on one CI and on another CI it has a threshold of 90%, 
and you modify both to 95%, this dialog box enables you to specify which 
CI to change.

Each row in the table shows a field for a particular CI, and its corresponding 
values.

Note: When you change a KPI’s business rule from [Mixed Values] to a 
specific rule this dialog box does not appear, unless you have changed the 
Calculated Based On or Related Health Indicators field to a specific value.

Override Existing Replace the original indicator assignments on all of the 
selected CIs with the new indicator assignments.

Show Details Expand the dialog box and display details on each of 
the CIs where the indicator is already assigned.

To access Select Admin > Service Health > CI Indicators

Select multiple CIs using the upper pane, and change 
settings of a KPI or HI assigned to these CIs, using the 
CI Data pane.

UI Element (A-Z) Description
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After you click Show Details, the dialog box contains the user interface 
elements described below:

Important 
information

If you click Save, your changes are implemented for all 
the selected CIs. To implement changes for specific CIs 
but not for others, click Show Details.

This is particularly useful when changing settings for a 
large number of CIs at once, if you want to leave one or 
two CIs with their original settings.

Relevant tasks "How to Configure KPIs and HIs—Overview" on 
page 425

UI Element (A-Z) Description

Override all. Override the original settings on all the 
CIs. This selects the Override check boxes on the 
current page; if there are additional pages in the table 
they are not selected.

Override none. Keep the original settings on all the 
CIs. This clears the Override check boxes on the 
current page; if there are additional pages in the table 
they are not cleared.

Show Details. Select a row and click to show details of 
the fields in an expanded window. 

This is useful if you want to view details such as 
selectors or API scripts which generally do not fit 
within a table cell.

Export to Excel. Export the table to an Excel file.

Export to PDF. Export the table to a PDF file.

When the table contains multiple pages, use the page 
scroller to move forwards and backwards through the 
pages.

CI Name The name of the CI where the selected indicator is 
assigned.
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Edit Context Menus Dialog Box

This dialog box enables you to assign context menus to CIs.

User interface elements are described below:

Field Name The name of the field that was modified within the 
indicator definitions.

Hide Details Collapse the dialog box and hide details.

New Value The new value that you have defined for the indicator.

Old Value The original value that was defined for the indicator.

Override Select this box to change the indicator definition from 
the old value to the new value on a specific CI. 

By default all rows are selected; if you de-select this 
box, the old value is used for the CI.

Section The area within the KPI or HI definition where the 
value was modified (for example, Threshold).

Show Details Expand the dialog box and display details, to specify 
which CI to change.

To access Select Admin > Service Health > CI Indicators

Select CIs in the upper pane. In the CI Data pane > CI 
Properties tab, click the Add button.

See also "List of Context Menus" on page 899

UI Element Description

Select a context menu from the Available Context 
Menus list, and click to add it to the Active Context 
Menus list.

Select a context menu from the Active Context Menus 
list and click to remove it.

UI Element (A-Z) Description
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Edit Breakdown Filter Dialog Box

This dialog box enables you to define which elements to include in a 
breakdown, or to exclude from a breakdown.

User interface elements are described below:

Available Context 
Menus

The context menus that can be added to the selected 
CIs.

Active Context 
Menus

The context menus that are assigned to the selected 
CIs.

To access Select Admin > Service Health > CI Indicators. 
Select CIs in the upper pane. In the CI Data pane > 
Breakdown tab, within the Filter area click Edit.

Relevant tasks "How to Configure Breakdowns" on page 444

See also "Breakdowns" on page 413

UI Element (A-Z) Description

Select an element from the Available Elements list, and 
click to add it to the Filtered Elements list.

Select an element from the Filtered Elements list and 
click to remove it.

Available Elements This displays the elements that can be included in the 
breakdown. For example, if your breakdown includes 
locations, this shows all the locations defined in the 
Locations view.

UI Element Description
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Filter Type A filter can either include specific elements, or exclude 
specific elements. Select Included to create a 
breakdown that only contains selected elements, or 
Excluded to create a breakdown that does not include 
selected (excluded) elements.

For example, if you are defining a Transaction by 
Location breakdown and you only want to break down 
transactions from London and New York, select 
Included and move London and New York to the 
Filtered Elements list. To exclude these locations, select 
Excluded.

Filtered Elements This contains the elements that are included or 
excluded in the breakdown, as defined by the filter 
type.

UI Element (A-Z) Description
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16
Custom Image Administration

This chapter includes:

Concepts

➤ Custom Image Administration - Overview on page 490

Tasks

➤ How to Assign a Custom Image to a View on page 491

Reference

➤ Custom Image Page – Administration on page 495
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Concepts

Custom Image Administration - Overview

The Custom Image feature enables you to display a view’s CIs represented by 
real-time status indicators within a custom image that describes the real 
world that your view represents. The graphical representation of a view used 
by your organization can be a logical network diagram, business logic, or 
any other graphic image.

You work with Custom Images in two stages:

 1 Within Service Health Administration, you associate an image with a 
view, and specify where each CI is located in the image.

 2 You can then access the Custom Image application component, and see 
the CI statuses in the view, within your custom image. For more details on 
the Custom Image component, see "Custom Image - Overview" on 
page 214.

When you create a custom image in Service Health Administration, you can:

➤ Use any diagram or picture as an image, provided that the format is 
supported by the browser. Recommended formats are GIF, JPG, or PNG. 
You can resize the image to fit your screen.

➤ Define your custom image to display standard status icons, or CI type 
icons with status colors.

➤ Save your custom image locally to BSM, or use a URL to access an external 
image.

For details on defining a custom image in Service Health Administration, see 
"How to Assign a Custom Image to a View" on page 491. For user interface 
details, see "Custom Image Page – Administration" on page 495.
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Tasks

How to Assign a Custom Image to a View

This section describes how to set up a custom image. For further examples, 
see "How to Display a View in a Custom Image" on page 216.

This task includes the following steps:

➤ "Assign a custom image to a view" on page 491

➤ "Add CIs to the custom image" on page 492

➤ "Display a view’s custom image" on page 494

 1 Assign a custom image to a view

 a Within Service Health Administration, open the Custom Image tab. 
Select a view in the View Selector pane.

 b In the Custom Image pane on the right side, click the Open Image 
button, and select one of the following:

➤ Local. Specify an image saved on your file system.

➤ From URL. Specify an image using a URL. Note that any type of 
image supported by the browser can be loaded from any URL 
(including HTTP protocol and HTTP authentication), but the URL 
must be available at all times to display the custom image.

For user interface details, see "Custom Image Page – Administration" 
on page 495.
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Example:

You want to use a picture of your network to display the status of each 
element in the network:

 2 Add CIs to the custom image

 a Select a CI from the CI tree in the left pane, and drag it to the required 
location in the image.

 b From the Display Type dropdown, select one of the following:

➤ Status icons. Display standard status icons in the Custom Image 
component.

➤ CI type icons. Display CI type icons which use status colors in the 
Custom Image component.

 c Add additional CIs as required. When you finish adding CIs, click Save 
to save the custom image locally, or click Link to URL to save the URL 
of the image.
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Example – Add CIs to Custom Image

You add the appropriate CI to the custom image:
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 3 Display a view’s custom image

After you complete the custom image, you can display it in the Service 
Health application, to view the CI’s status in the appropriate location in 
the diagram.

Example – View a Custom Image

The custom image displayed for the user is as follows:



Chapter 16 • Custom Image Administration

495

Reference

Custom Image Page – Administration

This page enables you to create a map for the selected view including the 
view's CIs represented by real-time status indicators and a background 
custom image. This image is then displayed in the Service Health Custom 
Image component. For details, see "Custom Image Component User 
Interface" on page 218.

User interface elements are described below:

To access Select Admin > Service Health > Custom Image

Important 
information

➤ Do not overlap CI icons. When icons do overlap, 
only the top status indicator is visible in the custom 
image.

➤ After setting a CI icon on the diagram, you can 
move the cursor over it to display the CI name in a 
tooltip.

➤ To select multiple CIs, click and drag your cursor, or 
press the keyboard CTRL key and click the CIs you 
want to select.

Relevant tasks "How to Assign a Custom Image to a View" on page 491

See also "Custom Image - Overview" on page 214

UI Element Description

View pane (left side) Enables to select a view, then select CIs and drag them 
to the image. For details, see "How to Assign a Custom 
Image to a View" on page 491.

Custom Image pane (right side)

Clear. Deletes both the image and the CI icons from 
the custom image associated with the current view.
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Add CI. Select a CI in the left pane, and click Add CI to 
add the selected CI to the custom image. 

The CI icon is displayed in the left top corner of the 
diagram with a blue outline. Drag the CI to the 
required location in the diagram. The CI icon is set at 
that position.

Note: You can also select a CI in the left pane and drag 
it directly to the image.

Select All. Selects all the CIs in the custom image.

You can then drag all the CIs together to new locations, 
or click Delete to delete all the CIs.

Delete CI. Removes one or more selected CIs from the 
custom image.

Fit to Screen. Fits the image within the screen; relative 
proportions of the image are maintained. 

Stretch to Fit Screen. Stretches the image and fills the 
screen; relative proportions of the image are not 
maintained. 

Marks the location of the CI within the custom image.

Display Type Select one of the following options for displaying the 
CI icons:

➤ CI type icons. The custom image displays CI type 
icons (for example  for transactions).

➤ Status icons. The custom image displays standard 
status icons.

Link to URL Click the Link to URL button to save the URL of the 
image, and to save the CI icons within the image. 

The custom image will only display the image if it can 
access the URL. Only one URL or one image is saved 
per view.

UI Element Description



Chapter 16 • Custom Image Administration

497

Open Image Select one of the following options for selecting an 
image to use as a background for the custom image:

➤ Local. Click to browse the local file system and select 
an image.

➤ From URL. Click to open the Enter URL dialog box. 
Enter the URL of the image you want to use, in the 
format: 
<protocol>://<hostname>/<path_to_image>

The protocol can be HTTP or HTTPS.

To use a local machine as the location of the image, 
enter the URL with the following format: 
file:///<path_to_image> 

This results in an image that cannot be displayed for 
a user working outside the local network.

You can also use a file-sharing path as follows: 
\\server\<path_to_image>

When you enter a URL, the Link to URL button is 
enabled.

Save Click the Save button to save the image and the CI 
icons within the image.

Note: 

➤ Only one URL or one image is saved per view.

➤ If you enter a URL and click the Save button, the 
image itself is locally saved.

UI Element Description
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17
Administer CI Status Alerts

This chapter includes:

Concepts

➤ CI Status Alerts Administration Overview on page 500

➤ SNMP Traps on page 501

➤ Downtime on page 502

➤ CI Status Alerts Attached to CIs in Local Impact Views on page 502

Tasks

➤ How to Create a CI Status Alert Scheme and Attach it to a CI on page 503

➤ How to Configure a Notification SNMP Trap on page 508

Reference

➤ SNMP-Specific Codes on page 510

➤ Alerts MIB Varbinds on page 510

➤ CI Status Alerts Administration User Interface on page 512

Troubleshooting CI Status Alerts on page 538
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Concepts

CI Status Alerts Administration Overview

CI Status alerts are triggered by a pre-defined status change for the selected 
CI. The status change is detected by the Business Logic Engine. 

For a detailed introduction to alerts, see "Alerts Overview" in Platform 
Administration.

In the CI Status alert administration, you can create and manage one or 
more alert schemes and attach them to a CI in a view, using the Alert 
Wizard. The decision to send an alert is handled by the rules attached to the 
CI’s KPIs. The alert engine sends alert messages (notifications) to pre-defined 
recipients, and executes the actions, executable files, and SNMP traps 
defined for the alert. For user interface details, see "Create New Alert Wizard" 
on page 516.

You can define the CI Status alert to apply to a specific KPI so that any 
change to the status of the KPI triggers the alert. You can also define the CI 
Status alert to apply to all the KPIs attached to the CI, so that any change to 
the status of one of the KPIs triggers the alert. You can attach more than one 
CI Status alert to a CI or share the same CI Status alert scheme definition 
between several CIs. You can also send the same CI Status alert notification 
to different recipients according to the CI status. 

For user interface details, see "Create New Alert Wizard" on page 516.

For details on how to define recipients, see "Recipient Management" in 
Platform Administration.

You can monitor the triggered alerts using the Configuration Item Status 
Alert report. For user interface details, see "Configuration Item Status Alerts 
Report" on page 309.

You can customize alerts. For details, see "How to Customize Alerts" in 
Platform Administration.
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If you have the Event Management Foundation license, and a CI Status alert 
is triggered in BSM, an event corresponding to the alert is automatically 
forwarded to Operations Management.

If BSM integrates with HP Operations Manager, an event is automatically 
forwarded to HP Operations Manager (OM), when a CI Status alert is 
triggered in BSM. For details, see "HP Operations Manager" in Solutions and 
Integrations.

If BSM integrates with HP Service Manager, an incident is automatically 
forwarded to HP Service Manager when a CI Status alert is triggered in BSM. 
For details, see "Business Service Management Integration with Other 
Applications" and "How to Integrate HP Service Manager  with Business 
Service Management Components" in Solutions and Integrations.

SNMP Traps

You can configure a Simple Network Management Protocol (SNMP) trap and 
attach it to an alert. The SNMP trap includes Object Identifiers (OIDs) and 
their values based on the alert’s data. 

The SNMP trap is sent when the alert criteria is met and the alert is triggered. 

You can then view the alert notice with any SNMP management console. 
For detail on setting SNMP traps, see "How to Configure a Notification 
SNMP Trap" on page 508.

The MIB file, located at 
<HPBSM root directory on the Data_processing Server>\
HPBAC\SNMP_MIBS\CIAlerts.mib, contains the mapping of Object 
Identifiers (OIDs) to alert-related data. The mapping is detailed in "Alerts 
MIB Varbinds" on page 510. 

The alert type and its SNMP-specific code is detailed in "SNMP-Specific 
Codes" on page 510.

To configure SNMP traps, see "How to Configure a Notification SNMP Trap" 
on page 508. The SNMP trap is sent when the alert criteria is met and the 
alert is triggered. You can view the alert notice with any SNMP management 
console in your organization. 
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Downtime 

When you configure a CI Status alert scheme, downtime can affect the CIs 
and skew the CI’s data.

You can configure downtime so that an EUM alert scheme or a CI status 
alert is triggered or not when the CI attached to the alert is in downtime.For 
concept details, see "Alerts and Downtime" in Platform Administration.

For task details, see "How to Set Up an Alert Delivery System" in Platform 
Administration.

CI Status Alerts Attached to CIs in Local Impact Views

You can select a local impact view and create a CI Status alert for a CI in that 
view in the same way you create a CI Status alert for a CI in a global view. 
For details on building a local impact view, see "How to Create or Edit Views 
Using View Builder" on page 384. 

The CI Status alerts assigned to a CI in a local impact view are only attached 
to the CI in that view, they are not attached to the CI in global views. For 
example, if you add alert A to CI A in a global view, and then you want to 
add alerts to CI A in a local impact view, you do not see alert A attached to 
CI A in the local impact view. In the same way, if you add alert B to CI B in a 
local impact view, and you want to add alerts to CI B in a global view, you 
do not see alert B in the global view.

For task details on adding CI Status alerts to a local impact view, see "How to 
Create a CI Status Alert Scheme and Attach it to a CI" on page 503.
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Tasks

How to Create a CI Status Alert Scheme and Attach it to 
a CI

You can create new alert schemes and attach them to any CI. You can attach 
more than one alert scheme to a CI. You can also attach the same alert 
scheme to more than one CI.

An alert attached to a CI in a specific view, is also attached to the CI in any 
view where the CI is included.

This task includes the following steps:

➤ "Prerequisite" on page 504

➤ "Create an alert scheme" on page 504

➤ "Add a CIT’s additional parameters to a CI Status Alert – optional" on 
page 506

➤ "Set up to open incidents in HP Service Manager corresponding to CI 
Status alerts triggered in BSM – optional" on page 507

➤ "Customize the alert features – optional" on page 507

➤ "Schedule the Configuration Item Status Alerts report – optional" on 
page 507

➤ "Results" on page 507
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 1 Prerequisite

Perform the steps described in "How to Set Up an Alert Delivery System" 
in Platform Administration.

 2 Create an alert scheme

Attach an alert scheme to a CI using the Create New Alerts wizard where 
you specify:

➤ The conditions that cause the CI Status alert to be triggered.

➤ The CIs and KPIs to which you want to attach to the alert scheme.

➤ The alert recipients and templates.

➤ The user-defined alert handlers (actions) that are triggered by the alert. 

To access the wizard, select Admin > CI Status > CI Status Alerts, select a 
view in View Selector and a CI in the CI Selector, and click New Alert. For 
details on the Alerts Wizard, see "Create New Alert Wizard" on page 516.

Tip: You can also select a local impact view and create a CI Status alert for 
a CI in that view in the same way you create a CI Status alert for a CI in a 
global view. For concept details, see "CI Status Alerts Attached to CIs in 
Local Impact Views" on page 502. For details on building a local impact 
view, see "How to Create or Edit Views Using View Builder" on page 384.
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While creating the alert or afterwards, you can attach to an alert:

➤ A notification URL. The notification URL is sent when the alert criteria is 
met and the alert is triggered. It passes alert information to external 
systems, such as a customer Web application. 

Example - Create a Notification URL:

➤ An executable file. The executable file is sent when the alert criteria is met 
and the alert is triggered. It writes information in special logs or to insert 
information into external databases. For user interface details, see "Create 
New/Edit Executable File Dialog Box" on page 530.

Example - Create an Executable File:

To include the name of the CI and the current status of the CI in the URL, access 
the Create New/Edit URL dialog box and perform the following steps:

1  Enter the following string in the Enter URL box: http://dogbert.com/myjsp
2  At the end of the string in the Enter URL box, enter: entityname= 

3  Select CI Name in the Field box, and press Insert Field to insert the 
<<CI Name>> variable. The string in the Enter URL box is now: 
http://dogbert.com/myjsp entityname=<<CI Name>>

4  At the end of the string in the Enter URL box, enter:
severity= 

5  Select Current Status in the Field box, and press Insert Field to insert the 
<<Current Status>> variable. 

The string in the Enter URL box is now: http://dogbert.com/myjsp entity 
name <<CI Name>> severity =<<Event Severity>>

To include the name of the CI in the command, access the Create New/Edit 
Executable File dialog box and proceed as follows:

1  Enter the following string in the Enter command box: 
\\servername\myfolder\run.exe -name

2  Select CI Name in the Field box and press Insert Field to insert the 
<<CI Name>> variable. 

The string in the Enter command box is now: 
\\servername\myfolder\run.exe -name <<CI Name>>
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➤ An SNMP trap. The SNMP trap is sent when the alert criteria is met and 
the alert is triggered. You can view the alert notice with any SNMP 
management console in your organization. For concept details, see 
"SNMP Traps" on page 501. For user interface details, see "How to 
Configure a Notification SNMP Trap" on page 508. 

 3 Add a CIT’s additional parameters to a CI Status Alert – 
optional

Note to HP Software-as-a-Service customers: This capability is not 
available for HP Software-as-a-Service customers.

If you create a new CI Type (CIT), you can add the CIT’s additional 
parameters to a CI Status alert. For details, see "Configuration Item Status 
Alert Notifications Report" on page 295.

To add additional parameters to a CIT:

 a Recommended. Save the original package under a different name 
before modifying the original package.

 b Open the <CIT_package>.zip file at the following location:
<uCMDB root directory on the Data_processing Server>\
mamlib\packages or at the location where the CIT package is located.

 c Open the <CIT>.xml file, locate the parameter you want to display, and 
add the following line between the <Attribute-Qualifiers> tags:
<Attribute-Qualifier name="ALERT_NOTIFICATION_ATTRIBUTE"/>
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Example

For example, add the line as follows:

 d Save and re-deploy the package.

 4 Set up to open incidents in HP Service Manager 
corresponding to CI Status alerts triggered in BSM – optional

You can set up to open incidents in HP Service Manager that correspond 
to CI Status alerts triggered in Business Service Management. For task 
details, see "How to Integrate HP Service Manager  with Business Service 
Management Components" in Solutions and Integrations.

 5 Customize the alert features – optional

You can customize some features. For details, see "How to Customize 
Alerts" in Platform Administration. 

 6 Schedule the Configuration Item Status Alerts report – 
optional

You can schedule the Configuration Item Status Alerts report. For details, 
see "How to Schedule a Report" in Reports.

 7 Results

You can view the alert schemes you have created in the Configuration 
Item Alerts page. For details, see "Configuration Item Status Alerts Page 
(Administration)" on page 534. 

You can manage the alert schemes. For details, see "Configuration Item 
Status Alerts Page (Administration)" on page 534.

<Attribute name="database_dbversion" display-name="Version" description="The 
database version" type="string" size="25">

<Attribute>
<Attribute-Qualifiers>

<Attribute-Qualifier name="ALERT_NOTIFICATION_ATTRIBUTE"/>
</Attribute-Qualifiers>

</Attribute>
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You can view a list of the CI Status alerts that were triggered in the 
Configuration Item Status Alerts report and in the Configuration Item 
Status Alert Notifications report. For details, see "How to View the 
Triggered CI Status Alerts and Notifications" on page 287.

How to Configure a Notification SNMP Trap

You can configure an SNMP trap and attach it to an alert. This SNMP trap is 
sent when the alert criteria is met. The alert notice can be viewed with any 
SNMP management console in the organization.

This task includes the following steps:

➤ "Set up the appropriate administrative privileges" on page 508

➤ "Specify the host address of the SNMP trap" on page 509

➤ "Check the mapping of the OIDs to the alert data and configure the Alerts 
MIB – optional" on page 509

 1 Set up the appropriate administrative privileges

You can set the appropriate administrative privileges to create a command 
that can be attached to an alert scheme and run when the alert it is 
attached to is triggered. 

To set the appropriate administrative privileges:

 a Select Admin > Platform > Users and Permissions > User Management.

 b Select the appropriate user in the left column, and click the 
Permissions tab.

 c Select the Monitors context, and under Active user, click Alerts - Run 
executable file.

 d Click the Operations tab, and select the Change option.
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 2 Specify the host address of the SNMP trap

You specify the default host address of the SNMP trap in the Create 
New/Edit SNMP Trap dialog box. For user interface details, see "Create 
New/Edit SNMP Trap Dialog Box" on page 531.

You can also specify a global default host address in the Infrastructure 
Settings. For details, see the Default SNMP Target Address/Default SNMP 
Port in "Modify the alerts triggering defaults" in "How to Customize 
Alerts" in Platform Administration.

 3 Check the mapping of the OIDs to the alert data and 
configure the Alerts MIB – optional

If you enabled alerts through SNMP traps in your alert schemes, it is 
recommended that you configure your SNMP management console to 
read the alerts MIB. This configuration enables you to see a name, rather 
than an Object ID (OID), when working in the management console.

Note: HP Business Service Management uses the AM alerts MIB 5.0 by 
default. 

To configure the alerts MIB in your SNMP management console:

 a Copy the <HPBSM root directory on the Data_processing Server>\
HPBAC\SNMP_MIBS\CIAlerts.mib file from the HP Business Service 
Management Documentation and Utilities DVD to your SNMP 
management console.

 b To view the alerts varbinds, use your SNMP management console’s MIB 
browser. For a list of varbinds and their descriptions, see "Alerts MIB 
Varbinds" on page 510.

 c Using your SNMP management console’s event configuration utility, 
configure the notification content and method for the various alert 
types. For a list of alert types and their corresponding SNMP-specific 
codes, see "SNMP-Specific Codes" on page 510.
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Reference

SNMP-Specific Codes

The SNMP-specific code for a CI Status alert is 1. Its type is: CI Status Alert.

Use this code when configuring CI Status alerts in your SNMP management 
console. For details, see "How to Configure a Notification SNMP Trap" on 
page 508.

Alerts MIB Varbinds

The tables list the varbinds used in the alerts MIB. For task details, see "How 
to Configure a Notification SNMP Trap" on page 508. 

Object Identifier MIB Label Description

1.3.6.1.4.1.5233 HP Company name

1.3.6.1.4.1.5233.6 ciAlerts Subject

1.3.6.1.4.1.5233.6.1 alerted Unique alert ID

1.3.6.1.4.1.5233.6.2 alertName Alert name

1.3.6.1.4.1.5233.6.3 alertDescription Alert description

1.3.6.1.4.1.5233.6.4 alertEventTime Time when the event 
occurred. This is the event 
that triggered the alert.

1.3.6.1.4.1.5233.6.5 alertCIId The ID of the CI whose 
status change triggered the 
alert

1.3.6.1.4.1.5233.6.6 alertCIName The name of the CI whose 
status change triggered the 
alert



Chapter 17 • Administer CI Status Alerts

511

1.3.6.1.4.1.5233.6.7 alertKPIId The ID of the KPI whose 
status change triggered the 
alert. The KPI is attached 
to the CI related to the 
alert.

1.3.6.1.4.1.5233.6.8 alertKPIName The name of the KPI 
whose status change 
triggered the alert. The KPI 
is attached to the CI 
related to the alert.

1.3.6.1.4.1.5233.6.9 detailedDescription The detailed description of 
the alert.

1.3.6.1.4.1.5233.6.10 alertPrevious
Severity

Previous severity of the CI

1.3.6.1.4.1.5233.6.11 alertNextSeverity Current severity of the CI 
(the change from previous 
severity to current severity 
is what triggered the alert).

1.3.6.1.4.1.5233.6.12 alertBACURL The URL of the BSM 
Gateway server.

1.3.6.1.4.1.5233.6.13 actualTime When the triggering 
condition is related to 
time, this is the actual 
time when the CI has 
breached the condition. 
For other condition types, 
this value is N/A.

1.3.6.1.4.1.5233.6.14 conditionDescription The description of the 
condition that triggered 
the alert.

1.3.6.1.4.1.5233.6.15 localImpactView The name of the view 
when the CI that triggered 
the alert is part of the local 
impact view.

Object Identifier MIB Label Description
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CI Status Alerts Administration User Interface

This section describes:

 ➤ CI Selector Pane on page 512

 ➤ Create New Alert Wizard on page 516

 ➤ Create New/Edit Executable File Dialog Box on page 530

 ➤ Create New/Edit SNMP Trap Dialog Box on page 531

 ➤ Create New/Edit URL Dialog Box on page 533

 ➤ Configuration Item Status Alerts Page (Administration) on page 534

 ➤ New Event Generation Dialog Box on page 536

CI Selector Pane

The CI Selector presents the view you selected and the configuration items 
(CIs) contained in that view in a hierarchical tree format according to the 
relationships defined between the CIs.

You can use the CI Selector to select a CI in the view. You can browse 
through the list of CIs in the selected view, or you can search for a CI. 
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Information is presented, in the right-pane, for the selected view and the 
selected CI. The shortcut menu options depend on the selected CI.

To access Appears in the middle pane of the page.

Important 
information

The interaction between the CI Selector pane and the 
information presented in the right pane varies, 
according to the context.

The CI Selector includes the Browse Views and the 
Search CI tabs.

➤ In Browse Views mode, you can browse through the 
view to locate a particular CI. You can also perform 
operations for the CI using a context menu.

➤ In Search CIs mode you can search for one or more 
CIs in the view, by name or by CI type.

Unavailable Views and CIs: The View list in View Selector 
may not display all views in the RTSM, or it may not 
display the contents of a view, because it includes:

➤ Only the views for which you have the necessary 
permissions. To set permissions, select Admin > 
Platform > Users and Permissions, select a user or a 
group and select Permissions. For more information, 
see "How to Assign Permissions" in Platform 
Administration.

➤ Only the views that are assigned to the application. 

➤ Inactive views (appear in red) that cannot be selected. 

➤ Out-of-the-box views for which you do not have a 
license. These views do not contain CIs. For 
information about the out-of-the-box views, see 
"Predefined Folders and Views" in the Modeling 
Guide.

Relevant tasks "How to Create a CI Status Alert Scheme and Attach it to 
a CI" on page 503
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Browse Views Tab

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Refresh. Click to refresh the display.

Clear all. Click to unselect previously selected CIs.

Collapse/Expand. Click to collapse or expand the tree.

<CIs> The CIs contained in the currently selected view.

<view selector> Click on the arrow to display a list of the available views. 
You can also click on the ellipsis (...) button to display 
the Select a view from the tree dialog box where you can 
select the required view.

<Tooltip> Hold the cursor over a CI to display a tooltip with the 
relevant CI type.
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Search CIs Tab

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

<Context sensitive 
menu options>

The CI Selector shortcut menu contains different 
options in each of the pages in which it appears. 

For details, see "Service Health Menu Options" on 
page 98. 

<Search results> After you run the search, the results are listed in the 
lower part of the CI Selector pane. The results are shown 
in two columns:

➤ Name. Contains the name of the CI.

➤ CI Type. Contains the CI type of the CI.

If the CI name is abbreviated, hold the pointer over the 
entry to see the full name. You can sort the search results 
by clicking the appropriate heading.

Name To search for a CI by name, enter the name of the CI for 
which to search.

Search Performs the search.

Type To search for CIs by CI type, click the ellipsis button to 
select a CI from the Select Configuration Item Type 
dialog box.
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Create New Alert Wizard

This wizard enables you to create new alert schemes and attach them to any 
CI. You can attach more than one alert scheme to a CI. You can also attach 
the same alert scheme to more than one CI.

An alert attached to a CI in a view is attached to the CI in any view where 
the CI is included.

To access Select Admin > CI Status > CI Status Alerts, select a view 
and a CI and click New Alert.

Important 
information

➤ If you have an Event Management Foundation 
license, and you create a CI Status alert without 
specifying a recipient or an action for the alert. 
When you complete the definition of such an alert, 
the message: The alert you just defined opens an 
event in Operations Manager i when the 
communication with Operations Manager i is 
enabled is displayed in the Summary page.

➤ Set up specific parameters to enable the 
communication with OM. For details, see "How to 
Configure BSM Alerts to Forward an Event When 
the Alert is Triggered" in Solutions and Integrations. 

Use the Model Explorer pane (on the left) to select the 
CI to which you want to attach the alert. For user 
interface details, see "View Selector" on page 87.

Relevant tasks "How to Create a CI Status Alert Scheme and Attach it 
to a CI" on page 503

Wizard map The Create New Alert Wizard includes:

Welcome Page > General Page > Related Configuration 
Items Page > Templates and Recipients Page > Actions 
Page > Summary Page 
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General Page
This page enables you to define the alert scheme general information 
including the triggering conditions.

User interface elements are described below:

Important 
information

General information about the wizard is available at 
"Create New Alert Wizard" on page 516.

Wizard map The Create New Alert Wizard includes:

Welcome Page > General Page > Related Configuration 
Items Page > Templates and Recipients Page > Actions 
Page > Summary Page 

UI Element (A-Z) Description

Alert Type Select one of the following options:

➤ All KPIs if you want the alert to be triggered by the 
specified status change in any of the KPIs attached 
to any of the selected CIs

➤ Selected KPIs if you want the alert to be triggered by 
the specified status change in the selected KPIs 
attached to any of the selected CIs

You select CIs and KPIs in the next step of the wizard.

Description Enter the alert scheme’s description.

Limitation: The string should be less than 1000 
characters.

Name Enter the name of the alert scheme.

Limitation: The string should be less than 250 
characters.

Notification 
frequency

Select one of the following options:

➤ Send alert for every trigger occurrence to send an 
alert notification every time an alert is triggered.

➤ Send no more than one alert per <time_period> and 
specify the time period and unit to send an alert 
notification every time period. 
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Send alert if Select one of the following options:

➤ Status is equal to or <condition> than <status> for 
<value><time unit> to trigger the alert when the 
status of the CI is equal to or better/worse than the 
selected status (Critical, Major, Minor, Warning, or 
OK) for the specified time period (minutes, hours, or 
days). For detailed examples, see "Examples of Status 
is equal to or <condition> than <status> for 
<value><time unit>" on page 519.

➤ Status worsens (not including "No Data" and 
"Downtime") to trigger the alert when the current 
status of the KPIs is worse than the previous status. 
The No Data and Downtime statuses are not taken 
into consideration. For example, the alert is 
triggered when the status changes from Warning to 
Minor. 

➤ Status improves (not including "No Data" and 
"Downtime") to trigger the alert when the current 
status of the KPIs is better than the previous status. 
The No Data and Downtime statuses are not taken 
into consideration. For example, the alert is 
triggered when the status changes from Warning to 
OK. 

➤ Status value was changed from <status> to <status> 
to set the appropriate conditions for sending an 
alert. Select the appropriate status in the from box, 
and in the to box. The available statuses are: Any 
Status (only available in the from box), Critical, 
Major, Minor, Warning, OK, No Data, Downtime, 
Stop, Info, and Uninitialized. If you select Any 
Status, the alert is triggered when the CI status 
changes from any status to the target status.

UI Element (A-Z) Description
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Examples of Status is equal to or <condition> than <status> for 
<value><time unit>

➤ You specify the following condition: "Send alert if status is equal to or 
worse than Major for 15 minutes" and the following scenarios occur:

CI’s KPI Status changes to What happens

Availability Major for 15 minutes The alert is sent

Availability Critical for 20 minutes The alert is not sent (status is still 
worse than Major for over 15 
minutes). 

Note: Before the alert is triggered 
again, the alert must be reset. To 
reset the alert, the status must 
return to a value within the status 
threshold (better than Major). 
After the alert is reset, it can be 
triggered as before (when the 
status changes to worse or equal 
to Major for 15 minutes).

Performance Critical for 20 minutes The alert is sent (another KPI 
status becomes worse than Major 
for over 15 minutes).

Availability Minor The alert is not sent (status is 
better than Major and counter is 
reset)

Availability Critical for 20 minutes Another alert is sent after 15 
minutes
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➤ You specify the following condition: "Send alert if status is equal to or 
better than Minor for 30 minutes" and "Send no more than one alert per 
60 minutes", and the following scenarios occur:

CI’s KPI Status changes to What happens

Availability OK for 45 minutes The alert is sent

Performance OK for 30 minutes The alert is not sent (it was already 
sent 15 minutes ago)

Availability Minor for 15 minutes The alert is not sent (it was already 
sent for the Availability KPI 15 
minutes ago)

Availability OK for 20 minutes The alert is not sent

Availability No Data for 15 minutes The status of the alert is reset.

Availability OK for 10 minutes The status of the alert is not sent 
as the time interval condition is 
not met (30 minutes)
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Related Configuration Items Page
This page enables you to specify the CIs and KPIs to which you want to 
attach the alert scheme.

Important 
information

➤ General information about the wizard is available at 
"Create New Alert Wizard" on page 516.

➤ If you selected All KPIs in the General page, then, in 
the Related Configuration Items page, select the CIs 
to which you want to attach the alert scheme. The 
alert is triggered by the specified status change in 
any of the KPIs attached to any of the selected CIs.

➤ If you selected Selected KPIs in the General page, 
then, in the Related Configuration Items page, select 
the CIs to which you want to attach the alert 
scheme. You must also select one or more of the KPIs 
that are listed in the KPIs area. The KPIs area lists all 
the types of KPIs that are attached to the selected 
CIs. The alert is triggered by the specified status 
change in the selected KPIs attached to any of the 
selected CIs.

➤ You can assign the same CI Status alert scheme 
definition to several CIs, at the same time, when you 
select more than one CI in the Related 
Configuration Items page. 

Wizard map The Create New Alert Wizard includes:

Welcome Page > General Page > Related 
Configuration Items Page > Templates and Recipients 
Page > Actions Page > Summary Page 
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Moves your selections to the Selected Configuration 
Items list. You can select multiple CIs using the CTRL 
key.

To remove a CI from the Selected Configuration Items 
list, select it in the Selected Configuration Items list 
and click the left arrow button.

 Unselect all. Unselects the CIs you have selected in the 
active view.

<Tree> In the tree of CIs corresponding to the view you 
selected in Model Explorer, select the CIs to which you 
want to attach the alert scheme (you can expand the 
tree if needed), and click the right arrow  button to 
move your selections to the Selected Configuration 
Items list. You can select multiple CIs using the Ctrl 
key.

To remove a CI from the Selected Configuration Items 
list, select it and click the left arrow  button. 

The alert is triggered by any change in any of the KPIs 
attached to the CI to which the alert scheme is 
assigned.

For user interface details, see "View Selector" on 
page 87.

KPIs If you selected Selected KPIs in the General page, select 
the KPIs whose change of status triggers the alert.
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Templates and Recipients Page
This page enables you to define the alert recipients and templates. When an 
alert is triggered, an email, SMS message, or Pager message is sent to a 
predefined recipient. The email, SMS message, or Pager messages have 
predefined templates. 

User interface elements are described below:

Important 
information

General information about the wizard is available at 
"Create New Alert Wizard" on page 516.

The notification method that is used to notify a 
recipient depends of the recipient definition.

You cannot use customized templates for emails, SMS 
messages, or Pager messages with the CI Status alerts.

Wizard map The Create New Alert Wizard includes:

Welcome Page > General Page > Related Configuration 
Items Page > Templates and Recipients Page > Actions 
Page > Summary Page

UI Element (A-Z) Description

Moves your selections to the Selected Recipients list. 
You can select multiple recipients using the CTRL key.

To remove a recipient from the Selected Recipients list, 
select it and click the left arrow button.

Available recipients Select the recipients to whom you want notifications 
sent, and click the right arrow  button to move 
your selections to the Selected recipient list. You can 
select multiple recipients using the Ctrl key. To remove 
a recipient from the Selected recipient list, select it and 
use the left arrow  button. 
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Email message 
template

Select one of the following options:

➤ Short HTML email message, short text email 
message. These messages include the change in 
status only.

➤ Long HTML email message, long text email 
message. These messages include a subject line and 
body.

For examples of HTML or text messages, see "Message 
Examples" on page 289.

For details on modifying the message character set, see 
Email alerts charset / SMS alert charset / Pager alert 
charset in "Modify the alerts triggering defaults" in 
Platform Administration. For details on the structure of 
the email, SMS, and Page message templates, see "Add a 
CIT’s additional parameters to a CI Status Alert – 
optional" on page 506.

Note: The text displayed in email messages can only be 
in English except for the contents of fields inserted by 
the user that can be in any supported and relevant 
language. Those fields can be for example: Alert Name, 
Alert description, KPI name, and so on.

New recipient Click the New Recipient button to define a new 
recipient. For details, see "New or Edit Recipient Dialog 
Box" in Platform Administration.

UI Element (A-Z) Description
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Pager template Pager messages are sent through email to the service 
provider. The pager messages use the same templates as 
the SMS messages.

The email address is: 
<Pager provider access number>@<Pager provider 
email address>. 

Select one of the following options:

➤ Long SMS/Pager message. The message includes the 
change in status and information about the SLA.

➤ Short SMS/Pager message. The message includes 
the change in status only.

For examples of HTML or text messages, see "Message 
Examples" on page 289.

For details on modifying the message character set, see 
Email alerts charset / SMS alert charset / Pager alert 
charset in "Modify the alerts triggering defaults" in 
Platform Administration. For details on the structure of 
the email, SMS, and Page message templates, see "Add a 
CIT’s additional parameters to a CI Status Alert – 
optional" on page 506.

Note: The text displayed in pager messages can only be 
in English except for the contents of fields inserted by 
the user that can be in any supported and relevant 
language. Those fields can be for example: Alert Name, 
Alert description, KPI name, and so on.

Selected recipient Lists the recipients that you have selected.

UI Element (A-Z) Description
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Actions Page
This page enables you to define the user-defined alert handlers (actions) that 
is triggered by the alert.

SMS template SMS messages are sent through email to the service 
provider. The pager messages use the same templates as 
the SMS messages.

The email address is: 
<SMS provider access number>@<SMS provider email 
address> 

Select one of the following options:

➤ Long SMS/Pager message. The message includes the 
change in status and information about the SLA.

➤ Short SMS/Pager message. The message includes 
the change in status only.

For examples of HTML or text messages, see "Message 
Examples" on page 289. The structure of the messages 
is described in "Configuration Item Status Alert 
Notifications Report" on page 295.

For details on modifying the message character set, see 
Email alerts charset / SMS alert charset / Pager alert 
charset in "Modify the alerts triggering defaults" in 
Platform Administration. For details on the structure of 
the email, SMS, and Page message templates, see "Add a 
CIT’s additional parameters to a CI Status Alert – 
optional" on page 506.

Important 
information

General information about the wizard is available at 
"Create New Alert Wizard" on page 516.

Wizard map The Create New Alert Wizard includes:

Welcome Page > General Page > Related Configuration 
Items Page > Templates and Recipients Page > Actions 
Page > Summary Page

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Click to Edit Event/URL/Executable File/SNMP Trap. 
Depending on the element you want to edit, the 
following dialog box opens:

➤ The Event Generation dialog box, to select a 
different template for the event. For details, see 
"New Event Generation Dialog Box" on page 536.

➤ The Edit URL dialog box for the selected URL. For 
details, see "Create New/Edit URL Dialog Box" on 
page 533.

➤ The Edit Executable File dialog box for the selected 
Executable file. For details, see "Create New/Edit 
Executable File Dialog Box" on page 530.

➤ The Edit SNMP Trap dialog box for the selected 
SNMP Trap. For details, see "Create New/Edit SNMP 
Trap Dialog Box" on page 531.

Click to Delete Event/URL/Executable File/SNMP Trap. 
Deletes the selected item.

Executable Files Lists the executable files that are to execute when the 
alert is issued.

New Executable File button. Defines a new executable 
file. The Create Executable File page opens. For details, 
see "Create New/Edit Executable File Dialog Box" on 
page 530.



Chapter 17 • Administer CI Status Alerts

528

Generate Events Lists the events that are created when the alert is 
issued.
New Event Generation button. Enables you to select an 
event template, which is used to generate an event 
when an alert is triggered. For details, see "New Event 
Generation Dialog Box" on page 536.

The event is accessed by HP Operations Manager, 
Operations Manager i, and other applications.

Open Incident in HP Service Manager option. Select 
the option to automatically open an incident for the 
alert in HP Service Manager when the alert is triggered.

Clear the option to disable the feature.

For information about the feature prerequisite steps, 
see "How to Integrate HP Service Manager  with 
Business Service Management Components" in 
Solutions and Integrations.

SNMP Traps Lists the SNMP traps that are to be sent when the alert 
is issued.

New SNMP Trap button. Configures a new SNMP trap. 
The Create New SNMP Trap page opens. For details, see 
"Configuration Item Status Alerts Page 
(Administration)" on page 534.

URLs Lists the URLs that are to open when the alert is issued.

New URL button. Creates a new URL. The Create New 
URL page opens. For details, see "Create New/Edit URL 
Dialog Box" on page 533.

UI Element (A-Z) Description
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Summary Page
This page displays a summary of the alert scheme definition.

User interface elements are described below:

Important 
information

General information about the wizard is available at 
"Create New Alert Wizard" on page 516.

Wizard map The Create New Alert Wizard includes:

Welcome Page > General Page > Related Configuration 
Items Page > Templates and Recipients Page > Actions 
Page > Summary Page 

UI Element (A-Z) Description

Cancel Closes the wizard and returns to the Configuration 
Item Status Alerts page. The alert scheme is not saved.

Finish Closes the wizard and returns to the Configuration 
Item Status Alerts page. The alert scheme is saved.
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Create New/Edit Executable File Dialog Box

This dialog box enables you to create or edit an executable file and embed 
predefined alert parameters in the file. The parameters are used as 
placeholders when the message is formatted and are replaced by real values 
when the alert is triggered.

Note to HP Software-as-a-Service customers: To create an executable file, 
contact HP Software-as-a-Service Support.

To access Click New Executable File or the appropriate  
button in the Executable File area in the Actions page 
of the Alerts wizard.

Important 
information

Only users with administrative privileges can create an 
executable file. The executable file is run when the 
attached alert is triggered. The executable file writes 
information in special logs or inserts information into 
external databases. 

To set the appropriate administrative privileges:

1  Select Admin > Platform > Users and Permissions > 
User Management.

2  Select the appropriate user in the left column, and 
click the Permissions tab.

3  Select the Platform context.

4  Select Run executable file.

5  Click the Operations tab, and select the Change 
option.

Relevant tasks "How to Create a CI Status Alert Scheme and Attach it 
to a CI" on page 503
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User interface elements are described below:

Create New/Edit SNMP Trap Dialog Box

This dialog box enables you to create or edit an SNMP trap to attach to an 
alert. This SNMP trap is sent when the alert criteria is met. The alert notice 
can be viewed with any SNMP management console in the organization.

UI Element (A-Z) Description

Enter command Displays the command and the selected fields. 

The selected field appears between double angle 
brackets.

Field In the list, select the name of the field and click Insert 
Field. For a list of the parameters you can use, see "CI 
Status Alert Attributes" on page 542. 

Insert Field Select the name of a field in the Field box and click the 
Insert Field button to copy the field to the Enter 
command box.

To access Click New SNMP Trap or the appropriate  button in 
the SNMP Trap area in the Actions page of the Alerts 
Wizard.
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User interface elements are described below:

Important 
information

Note: HP Business Service Management uses the CI 
alerts MIB by default and supports SNMP V2. 

To enable alerts through SNMP trap, it is recommended 
that you configure your SNMP management console to 
read the alerts MIB. For details, see "How to Configure a 
Notification SNMP Trap" on page 508. This enables you 
to see names, rather than Object IDs (OIDs), when 
working in the management console. 

The MIB file is located at 
<HPBSM root directory on Data_processing Server>
\HPBAC\SNMP_MIBS\CIAlerts.mib.

Relevant tasks "How to Configure a Notification SNMP Trap" on 
page 508

UI Element (A-Z) Description

Destination host IP Enter the host address.

You can use different formats:

➤ If you work with alerts for profiles, use the following 
format:

➤ <target_host_IP_address>
➤ <target_host_IP_address>[:<port_number>]

➤ If you work with RTSM, use the following format:

➤ <target_host_name|target_host_IP_address>
➤ <target_host_name|target_host_IP_address>

[:<port_number>]

Enter custom 
destination host IP

Select to use the host IP specified in the Destination 
host IP box.

Use general 
destination host IP

Select to use the host IP specified in the Infrastructure 
Settings.

For details on the default host address, see Default 
SNMP Target Address / Default SNMP Port in "How to 
Customize Alerts" in Platform Administration.
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Create New/Edit URL Dialog Box

This dialog box enables you to create or edit a notification URL to attach to 
an alert. The URL is executed when the attached alert is triggered.

To access Click New URL or the appropriate  button in the 
URL area in the Actions page of the Alerts Wizard.

Important 
information

➤ The notification URL is used to pass alert 
information to external systems, such as a customer 
Web application.

➤ You can embed predefined alert parameters in the 
notification URL. The parameters are used as 
placeholders when the message is formatted and are 
replaced by real values when the alert is triggered.

➤ You can modify the default URL that appears in the 
notifications. This URL represents the URL of the 
Data Processing Server. For examples of URLs, see 
"Example - Create a Notification URL" in "How to 
Create a CI Status Alert Scheme and Attach it to a 
CI" on page 503.

Relevant tasks "How to Create a CI Status Alert Scheme and Attach it 
to a CI" on page 503
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User interface elements are described below:

Configuration Item Status Alerts Page (Administration)

This page enables you to manage existing CI Status alerts

UI Element (A-Z) Description

Enter URL Displays the URL and the selected fields. 

The selected field appears between double angle-
brackets.

For examples of URLs, see "Example - Create a 
Notification URL" in "How to Create a CI Status Alert 
Scheme and Attach it to a CI" on page 503.

Field Select the name of a field and click Insert Field.

For a list of the alert parameters, see "CI Status Alert 
Attributes" on page 542.

Insert Field Select the name of a field in the Field box and click the 
Insert Field button to copy the field to the Enter URL 
box.

To access Select Admin > CI Status > CI Status Alert

Important 
information

Note: The left-pane displays the View Selector where 
you can select a view, and the CI Selector pane where 
you can select a CI in the selected view. The alerts listed 
in the right-pane are attached to the selected CI in the 
selected View. For user-interface details, see "CI Selector 
Pane" on page 512.

Relevant tasks "How to Create a CI Status Alert Scheme and Attach it 
to a CI" on page 503
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User interface elements are described below:

UI Element (A-Z) Description

New alert. Opens the Create New Alert wizard where 
you can create a new CI Status alert. For details, see 
"Create New Alert Wizard" on page 516.

Click to clone. Clones the selected alerts. BSM adds a 
copy of the alert scheme to the profile tree, with a new 
name.

Rename and edit the alert scheme as required.

Click to edit. Select an alert and click the button to 
open the Alert Wizard where you can edit the relevant 
alert properties. The Alert Wizard opens. For details, see 
"Create New Alert Wizard" on page 516.

Click to delete. Deletes the selected alerts.

Activate (enable) alert. Activates the selected alert if it 
is disabled.

Note:

➤ If an alert is activated, BSM sends an alert notice 
when the trigger conditions defined in the alert 
occur.

➤ To activate multiple alerts simultaneously, click and 
drag from the first alert to the last alert you want to 
select, and click the button.

Deactivate (disable) alert. Deactivates the selected 
alert.

Note: 

➤ When an alert is deactivated, BSM does not send an 
alert notice when the trigger conditions defined in 
the alert occur.

➤ To deactivate multiple alerts simultaneously, click 
and drag from the first alert to the last alert you 
want to select, and click the button.
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New Event Generation Dialog Box

This dialog box enables you to select an event template, which is used to 
generate an event when an alert is triggered.

Refresh. Click to refresh the display.

Open Template Repository Manager. Opens the 
Template Repository dialog box where you can manage 
a user notification or an event (using the Event 
Template) based on a defined alert triggering 
condition. When the alert is triggered, the event 
template is used to map the alert information to the 
event information. For details, see "Template 
Repository Dialog Box" on page 651.

<Common report 
elements>

See "Common Report and Page Elements" in Reports.

Alert Name The name of the alert scheme.

Condition A description of the condition. 

Recipients The names of the recipients.

Status Indicates if the alert scheme is active (enabled) or 
inactive (disabled).

To access Click the New Event Generation button in the 
Generate Events area, in the Actions page of the Alerts 
Wizard.

Relevant tasks "How to Create a CI Status Alert Scheme and Attach it 
to a CI" on page 503

UI Element (A-Z) Description
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User interface elements are described below:

UI Element Description

<List of templates> Select an event template and click OK.

Note: This list contains the event templates defined in 
the CI Status Template Repository. For details on how 
to create a new template or modify an existing 
template, see "CI Status Template Repository Dialog 
Box" on page 543.
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Troubleshooting CI Status Alerts

This section describes troubleshooting and limitations for CI Status alerts.

Audit Log

This section describes how to troubleshoot CI Status alerts.

Each change you make to a CI Status alerts is logged into the CI Status Alert 
Administration log. 

To access that information click Admin > Platform > Setup and Maintenance 
> Audit Log and select CI Status Alert Administration in the Context list. For 
details about the user interface, see "Audit Log Page" in Platform 
Administration.

Example: The audit log provides information about the date the alert 
definition was modified, the user who made the modification, the type of 
action that was performed followed by the contents of the Definition 
Details area of the alert definition. For details about the Definition Details 
area, see "Create New Alert Wizard" on page 516.
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18
Event Template for CI Status Alerts

This chapter includes:

Concepts

➤ Event Template for CI Status Alerts Overview on page 540

Tasks

➤ How to Configure the CI Status Alert Event Template on page 541

Reference

➤ CI Status Alert Attributes on page 542

➤ CI Status Template Repository Dialog Box on page 543



Chapter 18 • Event Template for CI Status Alerts

540

Concepts

Event Template for CI Status Alerts Overview

The Event Template maps an event triggering condition (for example, the 
triggering condition of a CI Status alert scheme) to an event attributes. The 
attributes are specific to the application (for example, the CI Status alert 
attributes). 

CI Status alerts have a default Event Template. You can create a template by 
modifying the default Event Template. 

When the event trigger condition is met (meaning that the CI Status alert is 
triggered), and if you have configured the CI Status alert to send an event, 
the event attributes are populated by the relevant triggered CI Status alert 
conditions, and create an event corresponding to the alert. The event is then 
available to HP Operations Manager, or Operations Management.

For task details, see "How to Configure the CI Status Alert Event Template" 
on page 541.

For user interface details, see "CI Status Template Repository Dialog Box" on 
page 543.
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Tasks

How to Configure the CI Status Alert Event Template

This task describes how to configure the Event Template so events are 
created when CI Status alerts are triggered.

This task includes the following steps:

➤ "Configure the alerts" on page 541

➤ "Configure an Event Template" on page 541

➤ "Results" on page 541

 1 Configure the alerts

Configure the alert schemes that, when triggered, create the relevant 
events.

For details about creating CI Status alerts, see "How to Create a CI Status 
Alert Scheme and Attach it to a CI" on page 503.

 2 Configure an Event Template

You can modify the default Event Template or you can configure a new 
template that maps an alert’s attributes to the corresponding event 
attributes. You can create several templates for each type of alert. 

For user interface details, see "CI Status Template Repository Dialog Box" 
on page 543.

 3 Results

You can view the events corresponding to the triggered alerts in HPOM, 
or Operations Management.
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Reference

CI Status Alert Attributes

The table lists the attributes you can use in the General tab for CI Status 
alerts:

Attribute Description

Alert Detailed 
Description

A collection of the alert’s parameters that form an 
overall description of the alert. The template for this 
description appears in the default log notification 
template of the alert.

Alert ID The unique ID assigned to the alert scheme.

Example: a148edca593f423aa36c256e687ad58f

Alert Name The alert name specified in the alert scheme.

Alert Summary A short description of the alert as specified in the alert 
scheme definition.

Alert Trigger Time The time when the alert was triggered.

Example: Tue Jan 05 6:07:29 PM 2010 (IST) (+0200)

Alert User Description The description of the alert you provided when you 
created the alert.

BSM DNS The name of the machine on which BSM is installed.

Example: machineName.devlab.ad

CI ID The ID of the CI for which the alert scheme was 
created.

Example: 

cfe0e1157c28513f2c10c008e543c5cb

CI Name The name of the CI for which the alert scheme was 
created.
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CI Status Template Repository Dialog Box

This dialog box enables you to map a CI Status alert’s attributes to an event’s 
attributes. 

CI Type The type of the CI for which the alert scheme was 
created.

Current Status Key The current status key of the CI related to the alert.

Current Status Name The displayed name of the status key of the CI related 
to the alert.

Event Severity The severity of the event corresponding to the CI Status 
Alert. You can set it to correspond exactly to the alert’s 
severity or to another value.

Example: major, or critical.

KPI ID The ID of the KPI whose change of status triggers the CI 
Status alert.

KPI Name The name of the KPI whose change of status triggers 
the CI Status alert.

KPI Value The value of the KPI whose change of status triggers the 
CI Status alert.

Previous Status Key The key of the previous status of the KPI before the 
change that triggered the CI Status alert.

Previous Status Name The name of the status of the KPI before the change 
that triggered the CI Status alert.

To access Within Admin > Service Health > CI Status Alerts, click 
the Open Template Repository Manager button.

Attribute Description
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Templates Area

This area lists the existing templates. It enables you to add new templates, 
duplicate existing templates, edit template names, and delete existing 
templates.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

➤ To modify the existing default template or to create 
a new template, duplicate the existing template and 
edit the duplicated copy. You can then modify the 
new or edited template as the default template.

➤ When an alert is triggered, the values of the event 
template attributes are changed into the relevant 
values of the alert attributes.

Relevant tasks "How to Configure the CI Status Alert Event Template" 
on page 541

See also ➤ "Event Template for CI Status Alerts Overview" on 
page 540

➤ "Attributes Area" on page 550

UI Element (A-Z) Description

New template. Empties the boxes in the currently 
displayed template to enable you to create a new event 
template.

Duplicate selected template. Duplicates the selected 
template.

Rename selected template. Enables you to edit the 
name of the selected template.

Set selected template to be the default template. Sets 
the selected template as the default template.

In the tree of templates, the icon also indicates the 
default template.
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Properties Area

This area enables you to give a name or to change the name of the active 
template.

User interface elements are described below:

Delete selected template. Deletes the selected 
template.

<Template> Lists the existing event templates. 

Default: CI Status Alert Open Default or CI Status Alert 
Close Default

UI Element (A-Z) Description

Discard changes. Resets the values entered in the 
template fields to their original values.

Select This button is displayed only when you create or edit an 
existing alert. It is not displayed when you access the 
alert template from the Template Repository button in 
the CI Status Alerts page. (Administration).

Click Select to enable the creation of an event when the 
CI Status alert is triggered. The event is mapped to the CI 
Status alert using the template you selected.

The template is used to generate events in HP Operations 
Manager. For details, see "Generate Events in HP 
Operations Manager when BSM Alert is Triggered" in 
Solutions and Integrations.

Set the selected 
template to be the 
default template

Select to make the current template the default template.

Template Name The name of the active template.

UI Element (A-Z) Description
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General Tab

This area enables you to define a new Event Template or to edit an existing 
one. 

User interface elements are described below:

Important 
information

Select the relevant attribute in the Attributes area and 
drag it into the relevant box in the General tab. 

You can also select a specific attribute and click ALT+I 
while editing text to insert that attribute in the text.

UI Element (A-Z) Description

Category Used to organize or group events. Out-of-the-box 
categories are provided. 

You can specify your own categories, as part of the event 
creation rules.

Default: CI Alert

Note: Depending on your permissions, you can define 
your own categories. Permissions are configured in 
Admin > Platform > User and Permissions.

CI hint Information about the CI that is related to the event. 
This attribute is used for providing hints to enable the 
event processing to find the correct related CI (RTSM ID 
of the related CI).

Add the attributes using the following format: 
UCMDB: <<CI ID>>:*

Example: 

➤ UCMDB as hint 
"UCMDB:3bcbb67a6233cfdd0e400e7c1e637db5" 

➤ A set of natural identifiers: "oracle:database:987"
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Close key pattern Enables the event that is sent to close all the events 
whose Key attribute matches the Close Key Pattern 
expression. You can use the asterisk (*) wildcard in your 
string.

Add the attributes using the following format: 
<<Alert Name>>: <<Entity ID>>:*

Example: 
host1.hp.com:DB_ess1:ConnectionPoolUtilization:* closes 
all the events whose key starts with 
host1.hp.com:DB_ess1:ConnectionPoolUtilization.

Description Detailed information describing the event.

Add the attributes using the following format: 
Alert Name:<<Alert Name>>
CI Name: <<Entity Name>>
<<Alert User Description>> 

Event Type Indicator Links between the event and the health indicator/KPI so 
information about the health indicator/KPI can be 
updated as a result of submitting the event. 

Add the attributes using the following format: 
<<ETI/HI Name>>[:<<ETI/HI State>>[:ETI Numeric Value]]]

Default: CIAlert:<<Current Status Key>>.

Example:

➤ Health indicator with state and numeric value for a 
Database CI: ConnectionPoolUtilization:High:0.88

➤ Health indicator with state for a Node CI: 
MemoryBottleneck:Active

➤ Event Type Indicator (ETI) without a state (does not 
trigger a health indicator): RebootOccurred

UI Element (A-Z) Description
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Generating source 
hint

Information about the monitoring application and the 
corresponding probe/agent that is responsible for 
creating the event.

Add the attributes using the following format: 
<<BSM>>

Example: BSM:BSMserver1.hp.com, 
OM:omserver32.deu.hp.com:agentId0c9da6d8-3e08-45cd-
9b12-b49a1ca4de20

Host hint Information about the CI of type Node that is hosting 
the CI related to the event.

The host can be identified by RTSM Id, DNS name, IPv4 
Address, IPv6 Address, MAC Address, HP L-Core Core ID.

Example: IPV4:15.15.12.13, DNS:h1.mercury.il; CoreId: 
0c9da6d8-3e08-45cd-9b12-b49a1ca5de20

Key A unique string representing the type of event that 
occurred. Two events have the same key if, and only if, 
the two events represent the same situation in the 
managed environment. Events with the same key are 
treated as duplicates.

Add the attributes using the following format: 
<<Alert Name>>:<<Entity>>:<<Event Severity>>

Example: 
host1:hp.com:DB_ess1:ConnectionPoolUtilitzation:High

UI Element (A-Z) Description
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Log only Assign the value: 

➤ true to send the event to the history event browser as a 
close event. Such an event goes through the complete 
event processing, but has its Life Cycle State set to 
close so it closes itself.

➤ false to send the event if the alert is configured to send 
an event. 

Add the attributes using the following format: 
true or false

Example: Typical examples are events that result in 
resetting a health indicator to a normal or good state, or 
an event signaling that a previous problem no longer 
exists (where the problem was reported in another 
event).

Default value: True. Depending on your permissions, you 
can modify the default.

Severity The severity of the event. It represents the translation of 
the alert CI status into the event severity.

The severity levels can be: Unknown, Normal, Warning, 
Minor, Major, Critical.

This information enables you to map the triggering event 
status to the event severity level.

Add the attributes using the following format: 
<<Event Severity>>

Example: Warning

Subcategory More detailed organization of events that have the same 
category. Used for event standards and external event 
sources that are using subcategories.

Add the attributes using the following format: 
<<CI Type>>

Submit close key 
condition

When you select the option, you must enter a value in 
the Close key pattern box.

UI Element (A-Z) Description
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Attributes Area

Use this area to specify the attributes.

Title Describes the occurrence represented by the event. The 
title should include information about what threshold 
has been crossed (or other trigger conditions), and the 
current values.

Add the attributes using the following format for CI 
Status alerts: 
<<Alert Name>>  
Triggered on CI: <<Entity Name>>  
Trigger condition

Note: Since the text is typically shown within a single 
line in the event browser, it is recommended that the 
most relevant information is at the beginning of the text.

Important 
information

If necessary, select the relevant attribute in the 
Attributes area and drag it to the relevant box in the 
General tab.

You can also select a specific attribute and click ALT+i 
while editing text to insert the selected attribute in the 
text.

For a detailed list of attributes, see "CI Status Alert 
Attributes" on page 542.

UI Element (A-Z) Description
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Custom Attributes Tab

Use this tab to add custom attributes.

When you create or edit a mapping in the Event Template dialog box, you 
can chose an attribute that was configured in Operations Management, or 
you can create a custom attribute. The custom attributes configured in 
Operations Management provide additional features for the events mapped 
using these attributes. For details about the difference between the 
Operations Management custom attributes and the Event Template custom 
attributes, see Using Operations Management.

Important 
information

A custom attribute consists of a key and a value (both 
are strings). The value can be any string and is used by 
the Event Template mapping as any other value.

Limitations: 

➤ Make sure that the name of the custom attribute you 
are defining is unique and does not already exist in 
the list of factory attributes.

➤ If you add to a template a custom attribute with a 
key similar to a constant attribute’s key, the custom 
attribute is ignored. For details about the constant 
attributes, see "Constant Attributes" on page 553.

➤ Duplicate keys are not allowed. You cannot create a 
key that already exists or you cannot use an existing 
key more than once in the same template.

➤ Event Template attributes are changed into the value 
of the relevant attribute of the triggered alert. When 
the attribute does not correspond to existing alert 
attributes (when it is a custom attribute), then the 
value specified in the Custom Attributes tab for the 
relevant attribute is used.
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User interface elements are described below:

UI Element Description

Lists the options available for creating a new Event 
Template. You can select:

➤ New key. To create a new key. A new row opens in the 
Name/Value table.

➤ Known key. Opens a submenu with the known keys as 
options. You can select the relevant key. A new row 
opens in the Name/Value table, with the name of the 
selected key in the Name column. You can then enter 
the value of the key in the corresponding Value 
column. 

Note: The known keys are defined in Operations 
Management. Such keys have additional capabilities. 
Keys defined in the CI Status Template Repository dialog 
box only have a name and are used as strings.

Deletes the selected attributes from the table.

Name and Value Each event can have any number of custom attributes. 
You use custom attributes to provide additional event 
information that is not provided by any of the other 
Event Template attributes or that is contained in any of 
the other attributes. Each custom attribute is a Name-
Value pair, where you enter the name of the attribute in 
the Name field and the value of the attribute in the Value 
field.

This feature may be used when you manage the 
environment of multiple customers using one instance of 
the product. The multiple customers might be handled 
by a custom attribute object. For details about the 
available attributes, see "Attributes Area" on page 550.

Example: Name = "Customer" ; Value = "XYZ Company"
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Constant Attributes

The Event Template uses the constant attributes to represent the fields that 
appear in the General tab (title, category, subcategory, and more). 

Note: Do not use these attribute’s keys as the keys to custom attributes. 

The constant attribute’s keys are:

➤ Category

➤ RelatedCiHint

➤ CloseKeyPattern

➤ TimeCreated

➤ Description

➤ EtiHint

➤ NodeHint

➤ Key

➤ LogOnly

➤ OriginalData

➤ Severity

➤ SubmitCloseKey

➤ SourceCiHint

➤ SubCategory

➤ Title
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Indicator Assignments and Propagation

This chapter includes:

Concepts

➤ Assignment and Propagation Overview on page 558

➤ Assignments on page 558

➤ SiteScope Dynamic HI Assignment on page 562

➤ Propagation Rules on page 563

➤ How Propagation Rules are Implemented on page 566

➤ Validation on page 572

Tasks

➤ How to Define a KPI or HI Assignment on page 574

➤ How to Define a KPI Propagation Rule on page 577

➤ How to Modify a KPI Assignment – Use-Case Scenario on page 579

➤ How to Create a KPI Assignment Using an API Rule and Dynamic Rule 
Parameter – Use-Case Scenario on page 584

Reference

➤ Indicator Assignments User Interface on page 590

Troubleshooting the Assignment Mechanism on page 627
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Concepts

Assignment and Propagation Overview 

When a new CI is added to the Run-time Service Model (RTSM), the 
assignment mechanism is automatically triggered. This mechanism assigns 
the appropriate KPIs, HIs, and context menus to the CI, based on the CI’s CI 
type (CIT).

When a KPI is assigned to a CI, or when a CI is attached to another CI, the 
propagation mechanism propagates the appropriate KPIs to the parent CIs. 
By default, when a KPI is assigned to a CI the KPI is automatically 
propagated to the CI's parents. Propagation rules enable you to define 
exceptions to the default KPI propagation, and to propagate other KPIs, the 
same KPI using a different rule, or no KPIs.

For details about the assignment mechanism, see "Assignments" on 
page 558. For details about the propagation mechanism, see "Propagation 
Rules" on page 563.

Note: To access the Assignments tab in Service Health administration, you 
must have user permissions of Admin or higher.

Assignments

An assignment includes a condition and a task, as follows:

➤ Condition. This describes a CI, or sets conditions on the attributes of a CI.

➤  Task. This describes the context menus, KPIs or HIs, and business rules 
that are assigned to the CIs that match the assignment condition. 

The task is automatically performed  when the condition occurs, and the 
assignment is running.
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For details on creating assignments, see "How to Define a KPI or HI 
Assignment" on page 574. 

This section also includes the following topics:

➤ "Assignment Mechanism" on page 559

➤ "Inheriting and Overriding Assignments" on page 560

➤ "Assignment Types" on page 560

➤ "Synchronizing Assignments" on page 561

➤ "How Assignments Respond to Manual Changes on a CI" on page 561

Assignment Mechanism
The assignment mechanism receives notification from the RTSM about the 
creation of new CIs.

The assignment mechanism is also activated when a specific attribute of the 
CI is updated, and the assignment conditions for that CI are based on the 
updated attribute. 

The assignment mechanism performs the following actions:

➤ Attaches the relevant KPIs or HIs to the CI.

➤ Assigns business rules for the KPIs or HIs.

➤ Assigns thresholds for the KPIs or HIs.

➤ (For KPI assignments only:) Adds the context menus to the CI.

➤ (For HI assignments only:) Assigns selectors for the HI.

For general information on KPI and HI functionality, see "KPI and HI 
Calculation" on page 397. For details on specific KPIs, see "List of Service 
Health KPIs" on page 656.

The assignment mechanism is a BSM service named KPI_ENRICHMENT. The 
service completes the missed assignments as soon as BSM is restarted, after it 
has been stopped. The assignment mechanism is deployed on the Data 
Processing server.
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Inheriting and Overriding Assignments
Assignments on higher level CITs are inherited by their descendant CITs. 
When an assignment is inherited, the name of the source CIT appears in 
parentheses after the assignment name on the child CIT. 

An inherited assignment cannot be deleted on a child CIT. If you override 
an inherited assignment, you can delete the overriding assignment on the 
child CIT. If you delete an assignment on a parent CIT, it is deleted on its 
descendant CITs as well.

When you edit an inherited assignment, the edited assignment appears in 
bold text in the assignments table. You can a restore an overriding 
assignment to its original inherited definitions.

Inherited assignments are not displayed if they are invalid, because these 
assignments are not relevant for the child CIT. An invalid assignment is only 
shown on the CIT where it can be fixed. Once it is no longer invalid, it 
appears on the descendant CITs.

Tip: Each assignment rule defined on an upper level CI type is inherited by 
all child CI types. If you need to define a specific assignment for a child CI 
type, create a new rule with the same condition as an inherited rule, and 
change the HI or KPI configuration accordingly. You can also stop some of 
the running assignment rules, and activate more specific rules for specific CI 
types.

Assignment Types
There are three types of KPI and HI assignments:

➤ Predefined. Out-of-the-box assignments that have not been modified. 
These assignments can be edited but not deleted. If you edit a predefined 
assignment, it is labeled Predefined (Customized).

➤ Predefined (Customized). Out-of-the-box assignments that have been 
edited. These assignments cannot be deleted, but you can restore them to 
their default settings.

➤ Custom. New assignments that you have created.
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Synchronizing Assignments
After making changes to assignments for a CIT, you can synchronize the 
assignments mechanism to run assignments on the CIT as if a new CI was 
just added. You can synchronize KPI assignments, HI assignments, or all 
assignments on the CIT.

When you synchronize all assignments, the assignments mechanism first 
assigns HIs based on the HI assignments, then KPIs based on the KPI 
assignments.

Synchronizing HI assignments can also have an effect on KPIs. For example, 
if an HI is added to a CI based on an HI assignment, a KPI assignment that is 
already running may add a new KPI to the CI based on this new HI.

Synchronizing can also delete KPIs or HIs. For example, if an assignment 
assigns two HIs (H1 and H2), and you modify it to only assign one of them 
(H1) and then synchronize, the assignment will delete the HI (H2) from the 
CI. If a KPI assignment has the deleted HI as its only related HI, the KPI will 
be removed from the CI as well.

Note: Synchronization is resource-intensive, and may impair performance. 
Only perform synchronization when necessary.

How Assignments Respond to Manual Changes on a CI
When an HI is manually attached to a CI using the CI Indicators tab (for 
details, see "How to Assign KPIs and HIs to CIs" on page 428), the 
assignment mechanism  may then add KPIs to the CI based on the KPI 
assignment definitions.

If a KPI or HI is assigned to a CI using the assignment mechanism, and you 
then manually change the KPI or HI, the assignment mechanism no longer 
makes changes to this indicator. For example, if you manually modify an 
assigned KPI, and you then change the business rule used within the KPI 
assignment, this change will not affect the modified KPI. In addition, 
synchronization does not remove a modified indicator, even if the CI no 
longer fills the assignment condition.
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However, if you manually remove an assigned KPI or HI, and then 
synchronize assignments, the KPI or HI will again be assigned to the CI by 
the assignment mechanism.

Tip: If you change a CI so that it no longer fills any assignment conditions, 
its HIs and KPIs are not removed automatically by the assignment 
mechanism. You can delete these indicators manually using the CI 
Indicators tab, or perform synchronization in the Assignments tab on the 
relevant CI Type.

SiteScope Dynamic HI Assignment

Service Health contains a default assignment named SiteScope Dynamic 
Health Indicator Assignment, which assigns HIs to the CIs monitored by 
SiteScope. This assignment dynamically assigns HIs to these CIs based on 
the metrics you have chosen to monitor within SiteScope. If you change the 
definitions of what is monitored on a CI within SiteScope, the assignment 
automatically updates which HIs are assigned to this CI.

You cannot perform the following:

➤ Create another dynamic assignment.

➤ Delete this assignment.

➤ Add HIs to this dynamic assignment, or remove HIs from the assignment.

➤ Modify the condition, selector, or priority defined for an HI in this 
assignment.

You can make the following changes within the dynamic assignment:

➤ Change the HI calculation rule. Note that the new rule is used to calculate 
all of the HIs assigned via this assignment.

➤ Change the rule parameters and rule thresholds (where relevant).

➤ Stop the assignment if necessary.
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Propagation Rules 

By default, when a KPI is assigned to a CI the KPI is automatically 
propagated to the CI's parents. The business rule used to calculate the 
propagated KPI on the CI's parents is the default group rule defined in the 
KPI repository. KPIs are propagated from child CIs to parent CIs; HIs are not 
propagated to parent CIs.

Note: In the context of propagations, the relationship between a CI and its 
parent CI is defined by the CI’s Impact links.

Propagation rules enable you to define exceptions to the default KPI 
propagation. Using propagation rules you can specify that when a KPI is 
assigned to a CI one of the following occurs: 

➤ No KPI is propagated to the CI’s parent CI.

➤ The same KPI is propagated to the parent CI, but with a business rule that 
is not the default group rule.

➤ One or more different KPIs are propagated to the CI’s parent CI.

Each propagation rule is defined per CI type, and includes a condition and a 
task, as follows:

➤ Condition. The condition describes the CIT of the child CI, the CIT of the 
parent CI, and the KPI assigned to the child CI. When these conditions 
are met, the task is then applied. 

➤ Task. The task describes which KPIs and business rules are propagated to 
the parent CI. The task may also include custom thresholds for the 
business rule used to set the status of the KPI.

You can define and view propagation rules using the Propagation Rules tab, 
which is part of the Service Health Administration Assignments tab. For user 
interface details, see "Assignments Tab" on page 590.
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Note: If a parent CI is already assigned a specific KPI, and the propagation is 
defined as propagating the same KPI from the child CI, the KPI is not 
propagated from the child CI.

Some limitations apply when the same KPIs are propagated to the parent CI 
from multiple child CIs. For details, see "Propagation Limitations" on 
page 571.

This section also includes the following topics:

➤ "Default Propagation" on page 564

➤ "When is the Propagation Mechanism Activated" on page 565

➤ "Inheriting Propagation Rules" on page 565

➤ "Recommended Procedure" on page 565

Default Propagation
By default, KPIs are propagated as follows:

➤ Each KPI attached to any child CI of any parent CI is automatically 
propagated to the parent CI.

➤ The KPI is assigned the KPI’s default group business rule and rule 
parameters, as defined in the KPI definition in the KPI repository. For 
details, see Default Group Rule in "New KPI/Edit KPI Dialog Box" on 
page 540.

➤ The thresholds are defined in the business rule repository, if they exist.

➤ The default propagation is not visible in the user interface. You cannot 
modify it.
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Note: Propagation rules respond to changes within the KPI and rule 
repositories. For example, if you have defined a propagation rule using a 
particular KPI, and this KPI is removed from the repository, the propagation 
rule becomes invalid.

When is the Propagation Mechanism Activated
The propagation mechanism is triggered when:

➤ A link between two CIs is added or removed, in the RTSM.

➤ You assign a KPI to a CI or you detach a KPI from a CI in Service Health 
administration.

Inheriting Propagation Rules
Propagation rules on higher level CITs are inherited by their descendant 
CITs. When a propagation rule is inherited, the name of the source CIT 
appears in parentheses after the propagation rule name on the child CIT. 

An inherited propagation rule cannot be deleted on a child CIT. If you delete 
a propagation rule on a parent CIT, it is deleted on its descendant CITs as 
well. 

If there are two rules on a CIT; one inherited from a parent CIT, and one 
assigned to the CIT itself, then the one assigned to the CIT itself will be 
applied. 

Recommended Procedure
You create a set of propagations for a topology, meaning that for each level 
of parent CI in the hierarchy, you must create a set of propagations. A lot of 
the propagations are repetitive so the correct procedure is to:

 1 Create a set of general propagations of Type 1 for a specific parent CI. 

 2 Create a set of more specific propagations of Type 2 for a specific KPI and 
a specific parent CI.



Chapter 19 • Indicator Assignments and Propagation

566

 3 Create a set of more specific propagations of Type 3 for a specific KPI, a 
specific child CI, and a specific parent CI.

 4 Create a set of non-propagations of Type 4 for a specific KPI, a specific 
child CI, and a specific parent CI.

The propagations are then sorted and applied to each parent CI. For details, 
see "How Propagation Rules are Implemented" on page 566.

How Propagation Rules are Implemented 

The matcher of the propagation mechanism considers all the propagation 
definitions and sorts them before applying them. All the customized 
propagations that you define are added to a list of existing propagations that 
is already sorted.

This section includes the following topics:

➤ "Propagation Definitions and Sorting" on page 566

➤ "De-propagation" on page 569

➤ "Propagation Limitations" on page 571

Propagation Definitions and Sorting
A propagation is defined per triplet (parent CI type, child CI type, and KPI 
attached to the child CI type). The matcher sorts the complete list of 
propagations according to the algorithm described below.

 1 Parent sorting:

➤ A comparison triplet parent CI that is equal to the propagation parent 
CI (the number of hierarchy levels is 0 in the model hierarchy) is better 
than a comparison triplet parent CI that is derived – with a larger 
number of hierarchy levels – from the propagation parent CI.

➤ A comparison triplet parent CI that is derived, in the class model, from 
the propagation parent CI with a smaller number of hierarchy levels is 
better than a comparison triplet parent CI that is derived from the 
propagation parent CI, with a larger number of hierarchy levels.
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 2 Child sorting:

The mechanism performs the same type of sorting as the parent CI 
sorting on the child CI. 

 3 KPI sorting:

The sorting is performed on the KPI where the KPI corresponding to the 
triplet KPI is better than Any KPI. 

For each KPI that is propagated from a child CI type to a parent CI type 
(comparison triplet), the matcher scans the list of sorted propagations to 
find the propagation that most closely matches the triplet. A propagation is 
considered a match when:

➤ The parent CI type and the child CI type in the propagation 
correspond exactly to the comparison triplet parent CI or child CI, OR 
the child CI class in the comparison triplet is derived (in the class 
model hierarchy) from the child CI type in the propagation and the 
same for the parent CI type.

AND

➤ The propagation KPI has the same ID number as the comparison 
triplet KPI OR the propagation condition specifies Any KPI.

The first propagation in the sorted list is used. 

Example:

The predefined and customized propagations defined are as follows:

No

Propagation Condition
How does the propagation match the triplet (parent CI=B, 
child CI=A, and KPI=K)?Parent 

CI
Child CI KPI

1 Node Node All The propagation includes the triplet.

2 J Node All The propagation does not include the triplet.

3 D C All CI B is derived from CI E, CI D and CI A is derived from CI C 
in the class model, and the propagation is for all KPIs, so the 
propagation includes the triplet.
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The class model is provided in the picture below. 

The result of the sorting procedure is as follows:

 1 Propagation 6 is at the top of the list as its parent CI type is E (most 
specific), child CI type C (most specific) and KPI type is K (explicit type).

 2 Propagation 5 comes after propagation 6 as its only difference with 6 is its 
generic KPI type.

4 E Node K CI B is derived from CI E and CI A is included in Node in the 
class model, and the propagation is for the K KPI, so the 
propagation includes the triplet.

5 E C All CI B is derived from CI E and CI A is derived from CI C in 
the class model, and the propagation is for all KPIs, so the 
propagation includes the triplet.

6 E C K CI B is derived from CI E and CI A is derived from CI C in 
the class model, and the propagation is for the K KPI, so the 
propagation includes the triplet.

No

Propagation Condition
How does the propagation match the triplet (parent CI=B, 
child CI=A, and KPI=K)?Parent 

CI
Child CI KPI
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 3 Propagation 4 comes after as its child CI type (Node) is more generic than 
propagation 5's child CI type (C).

 4 Propagations 3, 2, and 1 are listed afterwards (in this order), as their 
parent type is less specific (higher in the hierarchy) than type E.

 5 Propagation 1 goes to the bottom of the list as it is the most generic 
propagation.

When the propagation mechanism tries to find the closest matching 
propagation definition to the triplet (parent=CI B, child=CI A and 
KPI=KPI K) propagation 6 is at the top of the list and is therefore selected. 

De-propagation
The de-propagation mechanism is activated:

 1 When a CI is deleted from the impact model.

 2 When a link between two CIs is deleted from the impact model.

 3 When a KPI is deleted from a CI of the impact model.

For details on the impact model, see "Impact Modeling Overview" in the 
Modeling Guide.

There are two cases of de-propagation:

➤ Case A: KPI is deleted.

➤ Case B: CI is deleted OR the link between two CIs is deleted.

In case A, the de-propagation mechanism performs the following steps:

 1 Finds the matching propagation for the deleted KPI according to its triplet 
(child CI, parent CI, and KPI type). For details, see "How Propagation 
Rules are Implemented" on page 566.

The selected propagation includes the set of KPIs that might have been 
previously propagated by the deleted KPI.

 2 Retains from the potential KPIs only the KPIs that are currently attached 
to the parent CI.

 3 Finds the propagations that match the KPIs attached to the child CI and 
its siblings.
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 4 Builds a set of the KPIs that might have been previously propagated by 
the matching propagations from step 3.

 5 Removes the KPIs of step 4 from the set of KPIs of step 2.

 6 The remaining KPIs are deleted from the parent CI.

 7 The de-propagation mechanism is then applied to the next level of the 
impact model topology for each one of the KPIs deleted in step 6.

In case B, the de-propagation mechanism performs the following steps:

 1 Finds all the matching propagations for all of the KPIs attached to all of 
the siblings of the deleted (or detached) CI.

 2 Builds a set of KPIs attached to the parent CI that were not propagated by 
any of the propagations from step 1.

 3 Deletes from the parent CI all of the KPIs from step 2.

 4 Activates the de-propagation mechanism described in case A starting with 
the parent CI and the set of KPIs deleted from it in step 3.
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Propagation Limitations

➤ If you propagate the same KPI A from different child CIs (CI1 and CI2) 
with a different propagation, the propagation that affects the parent CI 
(CI4) regarding KPI A can be either one of the propagations (from CI1 or 
CI2). Because of this uncertainty, it is recommended to avoid specifying 
different propagations that propagate the same KPI but with different 
rules, thresholds, or both.
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➤ According to the previous limitation, if you propagate the same KPI A 
from different child CIs (CI1, CI2, or CI3), the propagation that affects 
the parent CI (CI4) regarding KPI A can be either one of the propagations. 
If you delete one of the CIs (CI2) or one of its KPIs, the configuration of 
KPI A (rule and thresholds) is updated and propagated from either CI1 or 
CI3. The update is not performed if the KPI was customized by the user.

Note: Propagation rules have no retroactive effects; if you make any changes 
to propagation rules, the changes only affect from that point on.

Validation

The validation mechanism checks that each assignment rule is valid. A 
tooltip on the CIT tree shows the number of valid and invalid assignments 
for each CIT. 

The CIT toolbar contains a filter to enable you to focus attention on invalid 
assignments; when you select Invalid Assignments Only, the CIT tree 
expands all the CIT nodes that have invalid assignments.
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If there is a problem with an assignment (for example, if an invalid business 
rule is defined, if an assignment is not unique, or if a referenced property 
does not exist for the CIT in the RTSM), you can open the assignment for 
editing. The dialog box that appears contains details regarding which area in 
the assignment definition is problematic, and should be fixed.
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Tasks

How to Define a KPI or HI Assignment

The following section describes how to configure KPI or HI assignments.

Note: When you stop a default assignment and then restart it, the 
assignment type changes from Predefined to Predefined (Customized). To 
restore the original Predefined type, click Restore to Default.

This task includes the following steps:

➤ "Create an assignment or open an assignment for editing" on page 574

➤ "Configure the assignment condition and task" on page 575

➤ "Override an inherited assignment" on page 576

 1 Create an assignment or open an assignment for editing

To create a new assignment or open an existing assignment for editing, 
select Admin > Service Health > Assignments. Depending on the type of 
assignment you are defining, select the KPI Assignments or Health 
Indicator Assignments tab. For user interface details, see "Assignments 
Tab" on page 590.

Assignments are defined according to CI type (CIT). Select a CIT in the CI 
Types pane, and perform one of the following actions in the Assignments 
for CI type pane:

➤ To create a new assignment on the CIT, click the Add button.

➤ To clone an existing assignment on the CIT, select an assignment and 
click the Duplicate button. The original assignment is still available, 
and the new cloned assignment opens automatically for editing.

➤ To edit an existing assignment on the CIT, select an assignment and 
click the Edit button.
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 2 Configure the assignment condition and task

An assignment definition includes a condition and a task. The condition 
describes specific characteristics of a CI. The task describes the KPIs or HIs 
that are to be assigned automatically to the CI when the condition occurs.

For KPI assignment user interface details, see "Add/Edit KPI Assignments 
for CI Type Dialog Box" on page 603. For HI assignment user interface 
details, see "Add/Edit Health Indicator Assignments for CI Type Dialog 
Box" on page 612. 

 a In the Assignment Settings area, define general assignment 
information.

 b In the Condition area, specify the application which is monitoring the 
CI; this is the value of the CI’s Monitored By attribute within the 
RTSM. This field is mandatory for HI assignments, for all CITs except 
for Monitor CITs (and their descendant CITs). 

Note: You can add a value to the dropdown list of possible Monitored 
By values using the following infrastructure setting: Admin > Platform 
> Infrastructure Settings > Foundations > Sources Configuration > 
Possible Values for Monitored By.

 c (Optional) To add additional conditions based on CI properties, click 
the Add button in the Condition area, and define one or more property 
conditions. All of the property conditions must be true for the 
condition to be met. To edit property conditions, click the field that 
you want to modify, and edit its contents.

 d In the KPI Configurations area (for KPI assignments) or the Health 
Indicator Configurations area (for HI assignments), define the 
following:

➤ For KPI assignments, define the KPIs that you want assigned to the 
CIs when the condition is met. For each KPI, specify its business 
rule, rule thresholds, calculation method, and which HIs it uses in 
its calculation. Note that if the CI has none of the specified HIs 
assigned, the KPI will not be assigned to the CI. For user interface 
details, see "Add/Edit KPI to Assignment Dialog Box" on page 608. 
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➤ For HI assignments, define the HIs that you want assigned to the CIs 
when the condition is met. For each HI, specify its priority, business 
rule, rule thresholds, and the selector that defines which data 
samples are relevant for the HI. For user interface details, see "Add/
Edit Health Indicator to Assignment Dialog Box" on page 616.

 e (Optional) If you are defining a KPI assignment, you can use the 
Context Menus area to define which context menus are assigned to the 
CI when the condition is met. This does not override existing context 
menus, but enables you to define additional ones.

 3 Override an inherited assignment

When an assignment is inherited from a parent CIT, the name of the 
source CIT appears in parentheses after the assignment name on the child 
CIT. When overriding an inherited assignment, note the following:

➤ When you override an inherited assignment, the edited assignment 
appears in bold text in the assignments table. To restore an overriding 
assignment to its original inherited definitions, select the assignment 
and click the Restore From Parent CIT button.

➤ The condition of an inherited assignment cannot be edited. To edit the 
condition, clone the inherited assignment, edit the clone, and delete 
the original inherited assignment.

➤ An inherited assignment cannot be deleted on a child CIT. If you 
override an inherited assignment, you can delete the overriding 
assignment on the child CIT. If you delete an assignment on a parent 
CIT, it is deleted on its descendant CITs as well.
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How to Define a KPI Propagation Rule

The following section describes how to configure a KPI propagation rule.

 1 Create a propagation rule or open a propagation rule for 
editing

To create a new  propagation rule or open an existing propagation rule for 
editing, select Admin > Service Health > Assignments > Propagation 
Rules.

Propagation rules are defined according to CI type (CIT). Select a CIT in 
the CI Types pane to show its defined assignments and propagations. 
Perform one of the following actions in the Assignments for CI type pane:

➤ To create a new propagation rule on the CIT, click the Add button.

➤ To clone an existing propagation rule on the CIT, select a propagation 
rule and click the Duplicate button. The original propagation rule is 
still available, and the new propagation rule opens automatically for 
editing.

➤ To edit an existing propagation rule on the CIT, select a propagation 
rule and click the Edit button.

For user interface details, see "Propagation Rules Page" on page 600.

 2 Configure the propagation rule’s condition and task

A propagation rule definition includes a condition and a task. The 
condition describes specific characteristics of a CI: its CIT, the CIT of its 
parent CI, and the KPI assigned to the CI. The task describes the KPIs and 
business rules that are propagated to the parent CI when the condition 
occurs.

For user interface details, see "Add/Edit Propagation Rule for CI Type 
Dialog Box" on page 622.

 a In the Rule Settings area, define general propagation rule information.

 b In the Condition area, specify the CIT of the parent CI, and the KPIs 
assigned to the child CI. 
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If you select Any KPI, the condition is filled if the CI has any KPIs 
assigned. For example, if you do not want any KPI propagated to the 
parent CI, select this option, and define the task as Do Not Propagate 
the KPI.

 c In the Task area, specify one of the following:

➤ Do not propagate the KPI. Select this option if you do not want the 
KPI propagated from the child CI to the parent CI.

➤ Propagate the KPI using another rule. Select this option if you want 
the KPI propagated, but using a business rule that is not the default 
group rule defined for this KPI. Specify the business rule that you 
want used for the KPI on the parent CI.

➤ Propagate custom KPIs. Select this option if you want different KPIs 
propagated to the parent CI, or if you want to propagate the same 
KPI and rule, but using different rule thresholds. For each KPI, 
specify the business rule that you want used on the parent CI, and 
rule thresholds if relevant. For user interface details, see "Add/Edit 
KPI for Propagation Rule Dialog Box" on page 625. 

Note: Propagation rules have no retroactive effects; if you make any 
changes to propagation rules, the changes only affect from that point on.
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Example:

A Service Health administrator wants to set up custom KPIs to monitor 
availability of her data center’s CIs. She creates two KPIs to show system 
availability for Windows and UNIX data servers, but she does not want 
these KPIs to propagate up to the parent Data Center CI. Instead, she 
wants the Data Center CI to have a different KPI (System Availability), 
with a rule combining the availability of both child CIs.

She therefore specifies a propagation rule on each of the child CIs 
(Windows and UNIX servers). The rule is defined so that when the parent 
CI is Data Center, a custom KPI (System Availability) is propagated, using 
a rule that combined the values of the two KPIs on the child CIs.

How to Modify a KPI Assignment – Use-Case Scenario

John is a Service Health administrator for ACME corporation, which uses 
Real User Monitor to monitor their business transactions.

Each of their business transactions has the Application Availability KPI 
assigned by default. John wants to also assign the OT Impact KPI to the 
business transaction CIs, to calculate the dollar value of unavailable 
transactions over time. He assigns this KPI the Impact Over Time rule, and 
defines the rule so that each minute a transaction is unavailable, the 
financial impact reflects a $600 loss.
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The scenario includes the following steps:

➤ "Open the RUM Business Transaction KPI assignment for editing" on 
page 580

➤ "Add the OT Impact KPI to the RUM Business Transaction KPI 
assignments" on page 581

➤ "Result" on page 582

 1 Open the RUM Business Transaction KPI assignment for 
editing

John accesses Admin > Service Health > Assignments, and selects the 
Business Transaction CIT in the CI Types pane. In the KPI Assignments 
tab, he opens the RUM Business Transaction KPI Assignments for editing.
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 2 Add the OT Impact KPI to the RUM Business Transaction KPI 
assignments

 a In the KPI Configurations area, he clicks New to add a new KPI to the 
assignment.

 b He selects the OT Impact KPI, using the Impact Over Time Rule, 
calculated based on Child KPIs.

 c He defines the Dollar Impact (financial loss in dollars per minute) as 
600. He links this to the Application Availability KPI (whose ID in the 
KPI repository is 7), by typing 7 in the StatusDimension rule 
parameter.

This means that for every minute the Application Availability KPI is 
red, the value of the OT Impact KPI increases by $600.
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 d He defines thresholds for the OT Impact KPI so that when the value of 
the KPI is less than or equal $200, the status of the KPI is OK; when it is 
less than or equal $500 it is Minor, and when it is over $500 it is Major.

 e He then clicks Save to save the KPI assignment. 

 3 Result

The RUM Business Transaction KPI assignment, on the Business 
Transaction CIT, now includes the OT Impact KPI. 
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This KPI is now automatically assigned to all business transactions 
monitored by Real User Monitor. The value of this KPI is $600 for every 
minute a business transaction is not available.
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How to Create a KPI Assignment Using an API Rule and 
Dynamic Rule Parameter – Use-Case Scenario

The following scenario provides a high-level illustration of how you can use 
the Rules API to create a custom rule, and then assign a KPI with this rule to 
various CIs.

In this scenario, you create a KPI assignment so that a KPI will  
automatically be assigned to all hosts and databases monitored by SiteScope. 
The KPI will use a custom API rule, so that whenever the KPI is assigned to a 
host CI the rule performs one action, and when the KPI is assigned to a 
database CI the rule performs another action.

First, within the rule repository you define a rule for a specific CI type, using 
a Rule API script. You then make this rule applicable to a KPI, within the KPI 
repository.

You create a KPI assignment to assign this KPI using the custom rule, within  
the KPI assignment administration. Finally, you define the rule within the 
KPI assignment administration, so that the rule dynamically takes the CI 
type from the CI and performs different actions depending on the CI type 
(host or database).

The scenario includes the following steps:

➤ "Clone the API Group and Sibling business rule and define rule 
parameters" on page 584

➤ "Make the new rule applicable for the Generic KPI" on page 586

➤ "Create a KPI assignment using the new rule" on page 586

➤ "Result" on page 589

 1 Clone the API Group and Sibling business rule and define rule 
parameters

 a Access Admin > Service Health > Repositories > Business Rules; select 
the API Group and Sibling business rule, and click Clone. 

The new rule is named API Group and Sibling Rule (1). Open the rule 
for editing.
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 b In the Advanced Rule Settings area, define the rule as applicable for 
the Configuration Item CI type.

 c In the Rule Parameters area, create a new rule parameter named 
CI_type, of type String. You do not need to modify any other fields.

This rule parameter will be used to define the API script, using the CI 
type taken dynamically from the CI.

 d In the Rule Parameters area, open the parameter KPI Calculation Script 
for editing, and define the script which will be run on the KPI. For 
details on how to define custom rules using the rules API, see "Service 
Health Rules API" on page 947.

The following image illustrates a calculation script which performs one 
action if the CI type is a database, another action if the CI type is a 
host, and a third action for other CITs. 
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 2 Make the new rule applicable for the Generic KPI

 a Access Admin > Service Health > Repositories > KPIs, and open the 
Generic KPI for editing.

 b In the Applicable Rules area, define the new rule API Group and 
Sibling Rule (1) as applicable for the KPI.

 3 Create a KPI assignment using the new rule

 a Access Admin > Service Health > Assignments, and select the 
Infrastructure Element CIT in the CI Types pane. Using the KPI 
Assignments tab, create a new assignment named Host and Database 
Assignment.

 b Within the Condition area, define the assignment condition as 
monitored by SiteScope.

 c Within the KPI Configurations area, click New to add a KPI to the 
assignment.
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 d In the KPI area, select the Generic KPI, using the API Group and Sibling 
Rule (1), calculated based on Child KPIs.
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 e From the CI Type Properties list, drag the property CI Type to the 
CI_type rule parameter, within the Business Rule Parameters area. 

This means that the CI_type rule parameter that is part of the 
calculation script is filled dynamically from the CI information itself: 
for a host CI this parameter gets the value node, and for a database CI 
it gets the value database.
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 4 Result

The Host and Database assignment, on the Infrastructure Element CIT, 
assigns the Generic KPI to all infrastructure element CIs (and their child 
CIs). When this KPI is on a host CI, the API rule performs one action, and 
when it is on a database CI it performs another action.
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Reference

Indicator Assignments User Interface

This section includes:

 ➤ Assignments Tab on page 590

 ➤ Health Indicator Assignments Page on page 592

 ➤ KPI Assignments Page on page 596

 ➤ Propagation Rules Page on page 600

 ➤ Add/Edit KPI Assignments for CI Type Dialog Box on page 603

 ➤ Add/Edit KPI to Assignment Dialog Box on page 608

 ➤ Edit Related Health Indicators Dialog Box on page 611

 ➤ Add/Edit Health Indicator Assignments for CI Type Dialog Box 
on page 612

 ➤ Add/Edit Health Indicator to Assignment Dialog Box on page 616

 ➤ Add/Edit Propagation Rule for CI Type Dialog Box on page 622

 ➤ Add/Edit KPI for Propagation Rule Dialog Box on page 625

Assignments Tab

This tab enables you to create or edit KPI and HI assignments for each CI 
type, and to create or edit non-default KPI propagation rules for each CI 
type. 

To access Select Admin > Service Health > Assignments

Relevant tasks ➤ "How to Define a KPI or HI Assignment" on page 574

➤ "How to Define a KPI Propagation Rule" on page 577

See also "Assignment and Propagation Overview" on page 558
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User interface elements are described below:

UI Element (A-Z) Description

Health Indicator 
Assignments

When a new CI is added to the RTSM, the assignment 
mechanism assigns the appropriate HIs to each CI, 
based on its CI type (CIT).

Click to open the Health Indicator Assignments page, 
to create or edit HI assignments. For details, see "Health 
Indicator Assignments Page" on page 592.

KPI Assignments When a new CI is added to the RTSM, the assignment 
mechanism assigns the appropriate KPIs to each CI, 
based on its CI type (CIT).

Click to open the KPI Assignments page, to create or 
edit KPI assignments. For details, see "KPI Assignments 
Page" on page 596.

Propagation Rules By default, when a KPI is assigned to a CI the KPI is 
automatically propagated to the CI's parents. 
Propagation rules enable you to define exceptions to 
the default KPI propagation, and to propagate other 
KPIs, the same KPI using a different rule, or no KPIs.

Click to open the Propagation Rules page, to create or 
edit KPI propagation rules. For details, see "Propagation 
Rules Page" on page 600.
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Health Indicator Assignments Page

This page enables you to create or edit HI assignments for a CI type. When a 
new CI is added to the RTSM, the assignment mechanism assigns the 
appropriate HIs to each CI, based on its CI type (CIT).

CI Types Pane

This pane displays a hierarchy of CI types; select a CI type to manage its HI 
assignments.

To access Select Admin > Service Health > Assignments > Health 
Indicator Assignments

Relevant tasks "How to Define a KPI or HI Assignment" on page 574

See also ➤ "Assignment and Propagation Overview" on page 558

➤ "Assignments" on page 558
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User interface elements are described below:

UI Element (A-Z) Description

Refresh. Click to refresh the CI Types pane and the 
Assignments pane display.

<CI Type> Each CI type is displayed with its CIT icon.

If a CIT has an assignment or propagation rule defined, 
the CIT icon has a small overlay icon in its lower right 
corner. If there are invalid assignments or propagation 
rules, the overlay icon indicates this. 

In the following image, the BusinessProcess CIT has 
one or more assignments or propagation rules defined, 
while the Business Transaction CIT has an invalid 
assignment or propagation rule.

A tooltip shows the number of KPI assignments, HI 
assignments, and propagation rules for the CIT. The 
tooltip also indicates which category contains any 
invalid definitions.

If you have invalid definitions, you can select the 
relevant tab (KPI Assignments, HI Assignments, or 
Propagation Rules). The user interface will indicate the 
source of the problem, and you can fix it if necessary.

Filter This filter enables you to display all assignments and 
propagation rules (default setting); only valid 
assignments; or only invalid assignments.

When you select Invalid Assignments Only, the CIT tree 
expands all the CIT nodes that have invalid 
assignments.

If you want to resolve invalid assignments, open each 
assignment for editing. The dialog box that appears 
contains details on what needs to be fixed in the 
assignment definitions.
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Health Indicator Assignments Tab

This tab displays details regarding the HI assignments for the CIT selected in 
the CI Types pane. You can use this tab to add, edit, or remove assignments. 
Each line represents one assignment on the selected CIT.

User interface elements are described below:

UI Element (A-Z) Description

Add. Click to create a new HI assignment.

Duplicate. Click to copy a selected HI assignment, and 
open the copy for editing.

Edit. Click to edit the details of a selected HI 
assignment.

Delete. Click to delete one or more selected HI 
assignments.

Assignments that are inherited from parent CITs 
cannot be deleted on the child CIT, but only on the 
parent CIT.

Restore From Parent CIT. Click to restore a selected 
overridden assignment to its original settings. For 
details, see "How to Define a KPI or HI Assignment" on 
page 574.

Restore to Default. Click to restore a selected edited 
assignment, whose Type is Predefined (Customized), to 
its original settings. For details, see "How to Define a 
KPI or HI Assignment" on page 574.

Select all. Select all the HI assignments.

Clear Selection. Clear the selection of HI assignments.
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Start. Click to start running a selected HI assignment 
on existing CIs, and on new CIs.

You can only start an assignment if you have selected it 
on the CIT where it is defined, and not on one of that 
CIT’s descendants.

Stop. Click to stop running a selected HI assignment.

You can only stop an assignment if you have selected it 
on the CIT where it is defined, and not on one of that 
CIT’s descendants.

Click to run HI assignments on the selected CIT. For 
details, see "Assignments" on page 558.

Refresh. Click to refresh the Assignments display.

Change visible columns. Click to select the columns 
you want to display in the table.

Assignment Name The name of the assignment.

Description The description of the assignment.

Health Indicators The HIs that are assigned to CIs of the selected CIT, 
based on the assignment.

Monitored By List of values of the Monitored By attribute within the 
RTSM; the assignment is only applicable if the CI 
contains one of the listed values as its Monitored By 
attribute.

UI Element (A-Z) Description
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KPI Assignments Page

This page enables you to create or edit KPI assignments for each CI type. 
When a new CI is added to the RTSM, the assignment mechanism assigns 
the appropriate KPIs to each CI, based on its CI type (CIT).

CI Types Pane

This pane displays a hierarchy of CI types; select a CI type to manage its KPI 
assignments.

Status The assignment status: 

➤ Running. The assignment has been started and is 
running on the appropriate CIs. 

➤ Stopped. The assignment has been stopped and is 
not running.

Type Indicates one of the following assignment types:

➤ Custom. New assignments.

➤ Predefined. Out-of-the-box assignments that have 
not been modified.

➤ Predefined (Customized). Out-of-the-box 
assignments that have been modified. You can 
restore such an assignment to its original settings 
using the Restore to Default button.

To access Select Admin > Service Health > Assignments > KPI 
Assignments

Relevant tasks "How to Define a KPI or HI Assignment" on page 574

See also ➤ "Assignment and Propagation Overview" on page 558

➤ "Assignments" on page 558

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Refresh. Click to refresh the CI Types pane and the 
Assignments pane display.

<CI Type> Each CI type is displayed with its CIT icon.

If a CIT has an assignment or propagation rule defined, 
the CIT icon has a small overlay icon in its lower right 
corner. If there are invalid assignments or propagation 
rules, the overlay icon indicates this. 

In the following image, the BusinessProcess CIT has 
one or more assignments or propagation rules defined, 
while the Business Transaction CIT has an invalid 
assignment or propagation rule.

A tooltip shows the number of KPI assignments, HI 
assignments, and propagation rules for the CIT. The 
tooltip also indicates which category contains any 
invalid definitions.

If you have invalid definitions, you can select the 
relevant tab (KPI Assignments, HI Assignments, or 
Propagation Rules). The user interface will indicate the 
source of the problem, and you can fix it if necessary.

Filter This filter enables you to display all assignments and 
propagation rules (default setting); only valid 
assignments; or only invalid assignments.

When you select Invalid Assignments Only, the CIT tree 
expands all the CIT nodes that have invalid 
assignments.

If you want to resolve invalid assignments, open each 
assignment for editing. The dialog box that appears 
contains details on what needs to be fixed in the 
assignment definitions.
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KPI Assignments Tab

This tab displays details regarding the KPI assignments for the CIT selected 
in the CI Types pane. You can use this pane to add, edit, or remove 
assignments. Each line represents one assignment on the selected CIT.

User interface elements are described below:

UI Element (A-Z) Description

Add. Click to create a new KPI assignment.

Duplicate. Click to copy a selected KPI assignment, 
and open the copy for editing.

Edit. Click to edit the details of a selected KPI 
assignment.

Delete. Click to delete one or more selected KPI 
assignments.

Assignments that are inherited from parent CITs 
cannot be deleted on the child CIT, but only on the 
parent CIT.

Restore From Parent CIT. Click to restore a selected 
overridden assignment to its original settings. For 
details, see "How to Define a KPI or HI Assignment" on 
page 574.

Restore to Default. Click to restore a selected edited 
assignment, whose Type is Predefined (Customized), to 
its original settings. For details, see "How to Define a 
KPI or HI Assignment" on page 574.

Select all. Select all the KPI assignments.

Clear Selection. Clear the selection of KPI assignments.
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Start. Click to start running a selected KPI assignment 
on existing CIs, and on new CIs.

You can only start an assignment if you have selected it 
on the CIT where it is defined, and not on one of that 
CIT’s descendants.

Stop. Click to stop running a selected KPI assignment.

You can only stop an assignment if you have selected it 
on the CIT where it is defined, and not on one of that 
CIT’s descendants.

Synchronize. Click to run KPI assignments on the 
selected CIT. For details, see "Assignments" on 
page 558.

Refresh. Click to refresh the Assignments display.

Change visible columns. Click to select the columns 
you want to display in the table.

Assignment Name The name of the assignment.

Description The description of the assignment.

KPIs The KPIs that are assigned to CIs of the selected CIT, 
based on the assignment.

Monitored By List of values of the Monitored By attribute within the 
RTSM; the assignment is only applicable if the CI 
contains one of the listed values as its Monitored By 
attribute.

UI Element (A-Z) Description
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Propagation Rules Page

This page enables you to create or edit non-default KPI propagation rules for 
each CI type. By default, when a KPI is assigned to a CI the KPI is 
automatically propagated to the CI's parents. Propagation rules enable you 
to define exceptions to the default KPI propagation, and to propagate other 
KPIs, the same KPI using a different rule, or no KPIs.

CI Types Pane

This pane displays a hierarchy of CI types; select a CI type to manage its KPI 
propagation rules.

Status The assignment status: 

➤ Running. The assignment has been started and is 
running on the appropriate CIs. 

➤ Stopped. The assignment has been stopped and is 
not running.

Type Indicates one of the following assignment types:

➤ Custom. New assignments.

➤ Predefined. Out-of-the-box assignments that have 
not been modified.

➤ Predefined (Customized). Out-of-the-box 
assignments that have been modified. You can 
restore such an assignment to its original settings 
using the Restore to Default button.

To access Select Admin > Service Health > Assignments > 
Propagation Rules

Relevant tasks "How to Define a KPI Propagation Rule" on page 577

See also ➤ "Assignment and Propagation Overview" on page 558

➤ "Propagation Rules" on page 563

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

<CI Type> Each CI type is displayed with its CIT icon.

If a CIT has an assignment or propagation rule defined, 
the CIT icon has a small overlay icon in its lower right 
corner. If there are invalid assignments or propagation 
rules, the overlay icon indicates this. 

In the following image, the BusinessProcess CIT has 
one or more assignments or propagation rules defined, 
while the Business Transaction CIT has an invalid 
assignment or propagation rule.

A tooltip shows the number of KPI assignments, HI 
assignments, and propagation rules for the CIT. The 
tooltip also indicates which category contains any 
invalid definitions.

If you have invalid definitions, you can select the 
relevant tab (KPI Assignments, HI Assignments, or 
Propagation Rules). The user interface will indicate the 
source of the problem, and you can fix it if necessary.

Refresh. Click to refresh the CI Types pane and the 
Assignments pane display.

Filter This filter enables you to display all assignments and 
propagation rules (default setting); only valid 
assignments; or only invalid assignments.

When you select Invalid Assignments Only, the CIT tree 
expands all the CIT nodes that have invalid 
assignments.

If you want to resolve invalid assignments, open each 
assignment for editing. The dialog box that appears 
contains details on what needs to be fixed in the 
assignment definitions.
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Propagations Rule Tab

This pane displays the non-default KPI propagation rules for the CIT 
selected in the CI Types pane. You can use this pane to add, edit, or remove 
propagation rules. Each line represents one propagation rule on the selected 
CIT. 

A propagation rule defines (based on CITs) that if a specified KPI is assigned 
on a CI, the CI’s parent CIs will either be assigned this KPI with a different 
rule, no KPIs, or one or more other KPIs.

User interface elements are described below:

UI Element (A-Z) Description

Add. Click to create a new propagation rule.

Duplicate. Click to copy a selected propagation rule, 
and open the copy for editing.

Edit. Click to edit the details of a selected propagation 
rule.

Delete. Click to delete one or more selected 
propagation rules.

Select all. Select all the propagation rules.

Clear Selection. Clear the selection of propagation 
rules.

Refresh. Click to refresh the Assignments pane display.

Change visible columns. Click to select the columns 
you want to display in the table.

Assigned KPI When this KPI is assigned to the selected CIT, the 
propagation rule is applied to the parent CIT.

Description The description of the propagation rule.
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Add/Edit KPI Assignments for CI Type Dialog Box

This dialog box enables you to add or edit a KPI assignment on a CIT.

Parent CI Type The parent CIT on which the propagation rule is 
applied.

Propagated KPIs This indicates one of the following:

➤ <KPI names>. The listed KPIs are propagated to the 
parent CIT (and not the KPI which is assigned to the 
child CIT).

➤ None. No KPIs are propagated to the parent CIT.

➤ Same KPI with <business rule name>. The KPI that is 
assigned to the child CIT is propagated to the parent 
CIT, but with a different business rule.

Propagation Rule 
Name

The name of the propagation rule.

To access Select Admin > Service Health > Assignments.

In the Assignments tab, select a CIT in the CI Type 
pane. Within the Assignments for CI Type pane, the 
KPI Assignments tab displays the KPI assignments for 
the selected CIT.

➤ To add a KPI assignment to the selected CIT, click 
the Add button. 

➤ To edit a KPI assignment, select the assignment and 
click the Edit button.

Important 
information

When an assignment is inherited from a parent CIT, 
the name of the source CIT appears in parentheses after 
the assignment name. If you edit an inherited 
assignment, the edited assignment is displayed in bold 
text. The condition of an inherited assignment cannot 
be edited; to edit, clone the inherited assignment, edit 
the clone, and delete the original inherited assignment.

Relevant tasks "How to Define a KPI or HI Assignment" on page 574

UI Element (A-Z) Description
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Assignment Settings Area

User interface elements are described below:

Condition Area

The condition defines which characteristics a CI must have so that the KPI 
assignment is relevant for the CI. Each line in the table represent a property 
condition; the assignment is relevant if all the property conditions are filled. 
If no property conditions are defined, the KPIs are assigned to all CIs of the 
CIT with the specified Monitored By attribute.

User interface elements are described below:

UI Element (A-Z) Description

Description (Optional) Enter a description for the assignment.

ID Displays the internal ID of the assignment.

Name Enter a name for the assignment.

UI Element Description

Select all. Select all the property conditions.

Clear Selection. Clear the selection of property 
conditions.

Add. Click to add a new property condition.

Delete. Click to delete a selected property condition.
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Monitored By Specify the value of the Monitored By attribute within 
the RTSM; the assignment is only applicable to a CI if 
the CI contains this value as its Monitored By attribute.

This field is mandatory for all CITs except for Monitor 
CITs (and their descendant CITs).

Note: You can add a value to the dropdown list of 
possible values using the following infrastructure 
setting: Admin > Platform > Infrastructure Settings > 
Foundations > Sources Configuration > Possible Values 
for Monitored By.

Operator Relational operator that the condition uses when 
comparing the actual value for the property against the 
value defined in the condition. The expression gives a 
result of TRUE or FALSE for each CI. For details on the 
possible operators, see "Property Condition Operator" 
on page 607.

Property Name This drop-down list contains all of the attributes of the 
RTSM class for the selected CIT. Select an attribute to 
define the condition, using the Operator and Value 
fields.

Value Enter the required value for the property. This is the 
property value that the condition compares with the 
value in the RTSM class attribute.

UI Element Description
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KPI Configurations Area

This area enables you to define which KPIs will be assigned to the CIs which 
fill the assignment condition.

User interface elements are described below:

UI Element (A-Z) Description

Select all. Select all the KPIs.

Clear Selection. Clear the selection of KPIs.

Add KPI. Click to create a new KPI.

Edit KPI. Click to edit the details of a selected KPI. 

Delete KPIs. Click to delete one or more selected KPIs. 

Business Rule The business rule used to calculate the KPI.

For information about each rule, see "List of 
Calculation Rules in Service Health" on page 740.

Calculated Based On This indicates if the KPI is calculated by:

➤ Health indicators and child KPIs. The KPI is 
calculated by the HIs assigned to the CI, and by the 
KPIs assigned to the child CIs.

➤ Health indicators. The KPI is calculated by the HIs 
assigned to the CI.

➤ HIs; if none, use child KPIs. The KPI is calculated by 
the HIs assigned to the CI; if there are no HIs 
assigned, the KPI is calculated by the KPIs assigned 
to the child CIs.



Chapter 19 • Indicator Assignments and Propagation

607

Context Menus Area

This area enables you to define which context menus are assigned to the CIs 
which fill the assignment condition. For details on the context menus, see 
"List of Context Menus" on page 899.

The list of Available Context Menus contains the context menus that are 
applicable to the CIT. The list of Selected Context Menus shows which  
context menus are assigned to the CIs which fill the condition. You can use 
the arrows to move the context menus between the lists, or drag context 
menus from one list to another.

Note that this does not override existing context menus, but enables you to 
define additional ones.

Property Condition Operator

Use one of the following values:

KPI The name of the KPI assigned to the selected CI. For 
information about each KPI, see "List of Service Health 
KPIs" on page 656.

Related Health 
Indicators

The list of HIs whose values are used in calculating this 
KPI.

The KPI will only be assigned if one (or more) of these 
HIs exists on the CI. If none of the HIs exist on the CI, 
the KPI is not assigned.

Value Description

Equals Returns true when the value of the RTSM class attribute equals 
the value specified in the value attribute of the property 
condition.

Does not equal Returns true when the value of the RTSM class attribute does 
not equal the value specified in the value attribute of the 
property condition.

UI Element (A-Z) Description
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Add/Edit KPI to Assignment Dialog Box

This dialog box enables you to add or edit a KPI within a KPI assignment.

Is like Returns true when the value of the RTSM class attribute 
matches the string in the value attribute of the property 
condition. The string of the value attribute can contain % as a 
wildcard. % may represent 0 or more characters.

Is not like Returns true when the value of the RTSM class attribute does 
not match the string in the value attribute of the property 
condition. The string of the value attribute can contain % as a 
wildcard. % may represent 0 or more characters.

Contains Returns true when the value of the RTSM class attribute equals 
one of the elements that is listed in the value attribute of the 
property condition. The elements in the list should be 
separated with a comma. 

Is contained in Returns true when the value attribute of the property 
condition equals one of the elements listed in the value of the 
RTSM class attribute, when the RTSM attribute type is 
string_list.

Is NULL Checks where the CI attribute was not assigned a value. 
Returns true when the RTSM class attribute is empty.

Is not NULL Checks where the CI attribute was assigned a value. Returns 
true when the RTSM class attribute is not empty.

Is true Returns true when the RTSM class attribute value is true.

Is false Returns true when the RTSM class attribute value is false.

To access In the Add/Edit KPI Assignments for CI Type dialog 
box, in the KPI Configurations area, click Add, or select 
a KPI and click Edit.

Relevant tasks "How to Define a KPI or HI Assignment" on page 574

Value Description
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KPI Area

User interface elements are described below:

UI Element (A-Z) Description

Click to add or remove HIs from the list of Related 
Health Indicators which are used to calculate the KPI. 
For details, see "Edit Related Health Indicators Dialog 
Box" on page 611.

Note: Adding a related HI to a KPI does not assign the 
HI to the CI itself; this means that if the HI is assigned 
to the CI, this KPI will include the HI in its calculation.

Business Rule The business rule used to calculate the KPI.

For information about each rule, see "List of 
Calculation Rules in Service Health" on page 740.

Calculated Based On This indicates if the KPI is calculated by:

➤ Health indicators and child KPIs. The KPI is 
calculated by the HIs assigned to the CI, and by the 
KPIs assigned to the child CIs.

➤ Health indicators. The KPI is calculated by the HIs 
assigned to the CI.

➤ HIs; if none, use child KPIs. The KPI is calculated by 
the HIs assigned to the CI; if there are no HIs 
assigned, the KPI is calculated by the KPIs assigned 
to the child CIs.

KPI The name of the KPI assigned to the selected CIT. For 
information about each KPI, see "List of Service Health 
KPIs" on page 656.

Related Health 
Indicators

The list of HIs whose values are used in calculating this 
KPI.

The KPI will only be assigned if one (or more) of these 
HIs exists on the CI. If none of the HIs exist on the CI, 
the KPI is not assigned.
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CI Type Properties Area

This area contains a list of the attributes of the RTSM class for the selected 
CIT. If you are defining KPI thresholds or you are creating an API rule, you 
can drag attributes from this area to the threshold or API area.

Thresholds Area

This area enables you to modify the default thresholds used for the KPI’s 
business rule; for details, see "KPI and HI Thresholds" on page 401. This area  
only appears if you select a rule that requires thresholds; for example, if you 
select the Worst Status rule this area does not appear.

User interface elements are described below:

UI Element (A-Z) Description

OK, Warning, Minor, 
Major, Critical

Enter the required threshold value for each status in 
the appropriate box. Ensure that the values you enter 
are logically ordered.

You can use RTSM class attributes of type float or 
integer to define threshold values. Drag an attribute 
from the CI Type Properties area to the threshold value 
fields.

Operator Select the required operator. This operator is applied for 
all the thresholds.

You can use RTSM class attributes of type string to 
define operators. Drag an attribute from the CI Type 
Properties area to the operator field.

Threshold Settings Select one of the following:

➤ Default. Use the thresholds that are defined in the 
business rule repository. If you select this option, 
you cannot edit the threshold settings.

➤ Custom. Use non-default thresholds for the business 
rule. Select this option if you want to modify the 
default thresholds.
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API Rule Definitions Area

This area is displayed when you select the API Group and Sibling rule in the 
Business Rule list. Enter the KPI calculation script for the rule you are 
creating; for details, see "API Group and Sibling Rule" on page 950.

Edit Related Health Indicators Dialog Box

This dialog box enables you to add or remove HIs from the list of HIs which 
are used to calculate a KPI.

User interface elements are described below:

To access In the Add/Edit KPI to Assignment dialog box, click the 
button next to the Related Health Indicators field.

Important 
information

The list of applicable HIs, that can be used to calculate 
the KPI on the selected CIT, is based on the Indicator 
Repository definitions. For details, see "Indicator 
Repository Overview" on page 682.

UI Element (A-Z) Description

Select an HI from the Applicable Health Indicators list, 
and click to add it to the Selected Health Indicators 
list.

Select an HI from the Selected Health Indicators list, 
and click to remove it.

Applicable Health 
Indicators

This shows the list of HIs that can be used to calculate 
the KPI, on the selected CIT.

Selected Health 
Indicators

This shows which HIs will be used to calculate the KPI 
on the selected CIT
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Add/Edit Health Indicator Assignments for CI Type 
Dialog Box

This dialog box enables you to add or edit an HI assignment on a CIT.

Assignment Settings Area

User interface elements are described below:

To access Select Admin > Service Health > Assignments.

In the Assignments tab, select a CIT in the CI Type 
pane. 

Within the Assignments for CI Type pane, the Health 
Indicator Assignments tab displays the HI assignments 
for the selected CIT.

➤ To add an HI assignment to the selected CIT, click 
the Add button. 

➤ To edit an HI assignment, select the assignment and 
click the Edit button.

Important 
information

When an assignment is inherited from a parent CIT, 
the name of the source CIT appears in parentheses after 
the assignment name. If you edit an inherited 
assignment, the edited assignment is displayed in bold 
text. The condition of an inherited assignment cannot 
be edited; to edit, clone the inherited assignment, edit 
the clone, and delete the original inherited assignment.

Relevant tasks "How to Define a KPI or HI Assignment" on page 574

UI Element (A-Z) Description

Description (Optional) Enter a description for the assignment.

ID Displays the internal ID of the assignment.

Name Enter a name for the assignment.
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Condition Area

The condition defines which characteristics a CI must have so that the HI 
assignment is relevant for the CI. Each line in the table represent a property 
condition; the assignment is relevant if all the property conditions are filled. 
If no property conditions are defined, the HIs are assigned to all CIs of the 
CIT with the specified Monitored By attribute.

User interface elements are described below:

UI Element (A-Z) Description

Monitored By Specify the value of the Monitored By attribute within 
the RTSM; the assignment is only applicable to a CI if 
the CI contains this value as its Monitored By attribute.

This field is mandatory for all CITs except for Monitor 
CITs (and their descendant CITs).

Note: You can add a value to the dropdown list of 
possible values using the following infrastructure 
setting: Admin > Platform > Infrastructure Settings > 
Foundations > Sources Configuration > Possible Values 
for Monitored By.

Select all. Select all the property conditions.

Clear Selection. Clear the selection of property 
conditions.

Add. Click to add a new property condition.

Delete. Click to delete a selected property condition.

Operator Relational operator that the condition uses when 
comparing the actual value for the property against the 
value defined in the condition. The expression gives a 
result of TRUE or FALSE for each CI. For details on the 
possible operators, see "Property Condition Operator" 
on page 607.
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Health Indicator Configurations Area

This area enables you to define which HIs will be assigned to the CIs which 
fill the assignment condition.

User interface elements are described below:

Property Name This drop-down list contains all of the attributes of the 
RTSM class for the selected CIT. Select an attribute to 
define the condition, using the Operator and Value 
fields.

Value Enter the required value for the property. This is the 
property value that the condition compares with the 
value in the RTSM class attribute.

UI Element (A-Z) Description

Select all. Select all the HIs.

Clear Selection. Clear the selection of HIs.

Add Health Indicator. Click to create a new HI.

Edit Health Indicator. Click to edit the details of a 
selected HI. 

Delete Health Indicator. Click to delete one or more 
selected HIs. 

Business Rule The business rule used to calculate the HI.

For information about each rule, see "List of 
Calculation Rules in Service Health" on page 740.

Health Indicator The name of the HI assigned to the selected CI.

UI Element (A-Z) Description
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Property Condition Operator

Use one of the following values:

Value Description

Equals Returns true when the value of the RTSM class attribute equals 
the value specified in the value attribute of the property 
condition.

Does not equal Returns true when the value of the RTSM class attribute does 
not equal the value specified in the value attribute of the 
property condition.

Is like Returns true when the value of the RTSM class attribute 
matches the string in the value attribute of the property 
condition. The string of the value attribute can contain % as a 
wildcard. % may represent 0 or more characters.

Is not like Returns true when the value of the RTSM class attribute does 
not match the string in the value attribute of the property 
condition. The string of the value attribute can contain % as a 
wildcard. % may represent 0 or more characters.

Contains Returns true when the value of the RTSM class attribute equals 
one of the elements that is listed in the value attribute of the 
property condition. The elements in the list should be 
separated with a comma. 

Is contained in Returns true when the value attribute of the property 
condition equals one of the elements listed in the value of the 
RTSM class attribute, when the RTSM attribute type is 
string_list.

Is NULL Checks where the CI attribute was not assigned a value. 
Returns true when the RTSM class attribute is empty.

Is not NULL Checks where the CI attribute was assigned a value. Returns 
true when the RTSM class attribute is not empty.

Is true Returns true when the RTSM class attribute value is true.

Is false Returns true when the RTSM class attribute value is false.
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Add/Edit Health Indicator to Assignment Dialog Box

This dialog box enables you to add or edit an HI within an HI assignment.

Health Indicator Area

User interface elements are described below:

To access In the Add/Edit Health Indicator Assignments for CI 
Type dialog box, in the Health Indicator 
Configurations area, click Add, or select an HI and click 
Edit.

Relevant tasks "How to Define a KPI or HI Assignment" on page 574

UI Element (A-Z) Description

Business Rule The business rule used to calculate the HI.

For information about each rule, see "List of 
Calculation Rules in Service Health" on page 740.

Health Indicator The name of the HI assigned to the selected CIT.

Priority By default, each HI has a priority of zero (0). If the 
assignment mechanism runs a number of assignments 
on a CI, and more than one assignment assigns the 
same HI, the priority can be used to fine-tune which to 
assign.

For example, if an HI is supposed to be assigned to a CI 
based on two different assignments, and the HI in one 
assignment has a higher priority than in the other, the 
definitions of the higher priority one will be assigned.
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CI Type Properties Area

This area contains a list of the attributes of the RTSM class for the selected 
CIT. If you are defining HI selector or thresholds, or you are creating an API 
rule, you can drag attributes from this area to the API, threshold or selector 
area.

The attributes listed under the heading General Properties are grouped 
according to attribute type (for example binary or string). In addition, when 
defining a selector, the following attributes are available under the heading 
Selector Related Properties: 

➤ CI ID. The ID of the CI in the RTSM.

➤ HI Type ID. The HI’s internal ID in the Indicator Repository.

➤ ETI Name. The name of the ETI related to the HI.

API Rule Definitions Area

This area is displayed when you select an API rule in the Business rule list. 
For details, see "Rules API Overview" on page 948.

User interface elements are described below:

UI Element (A-Z) Description

KPI Calculation Script Enter the KPI calculation script for the rule you are 
creating. The contents of the script depends on the rule 
type, as follows:

➤ API Sample Rule. See "API Sample Rule" on page 953.

➤ API Duration-Based Rule. See "API Duration-Based 
Sample Rule" on page 955.

Sample Fields Enter the names of the sample fields you want to use in 
the script. Separate between the sample names with a 
comma.
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Thresholds Area

This area enables you to modify the default thresholds used for the HI’s 
business rule; for details, see "KPI and HI Thresholds" on page 401. This area 
only appears if you select a rule that requires thresholds; for example, if you 
select a Worst Status rule this area does not appear.

User interface elements are described below:

UI Element (A-Z) Description

OK, Warning, Minor, 
Major, Critical

Enter the required threshold value for each status in 
the appropriate box. Ensure that the values you enter 
are logically ordered.

You can use RTSM class attributes of type float or 
integer to define threshold values. Drag an attribute 
from the CI Type Properties area to the threshold value 
fields.

Operator Select the required operator. This operator is applied for 
all the thresholds.

You can use RTSM class attributes of type string to 
define operators. Drag an attribute from the CI Type 
Properties area to the operator field.

Threshold Settings Select one of the following:

➤ Default. Use the thresholds that are defined in the 
business rule repository. If you select this option, 
you cannot edit the threshold settings.

➤ Custom. Use non-default thresholds for the business 
rule. Select this option if you want to modify the 
default thresholds.
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Selector Area

This area enables you to define the selector for the HI. The selector catches 
data samples from the incoming data that meet the filter criteria. 

For an overview of selectors, see "Selectors for Metric-Based HIs" on 
page 406. For details on defining selectors, see "How to Define Selectors for 
HIs" on page 435.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Selector Toolbar

UI Element Description

Select one of the following:

➤ Add Selector Expression. Add a selector expression  
to an expression group; each selector expression that 
you add narrows the filter.

➤ Add OR Clause. Add an expression group (which can 
contains one or more selector expressions). 

Note.  When the first expression group is added it is 
labeled AND; when additional groups are added all the 
groups are labeled OR.

Delete. Click to delete one or more selected selector 
expressions or groups.

Copy. Select one or more selector rows and click to copy 
the rows to the clipboard.

Cut. Select one or more selector rows and click to cut 
the rows to the clipboard.
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Paste. Click to paste rows from the clipboard to a new 
location. 

If you are pasting a selector group, it is pasted as a new 
group.

If you are pasting a selector expression, there are two 
Paste options:

➤ If you select a row before you click Paste, the 
expression is pasted after the selected row. 

➤ If you do not select a row but just click Paste, a new 
group is created containing the expression.

Copy Selector to 
Clipboard

Copy the entire selector definition to the clipboard.

You can then paste the selector into specific HI 
instances within the CI Indicators tab. For details, see 
"Add Health Indicator/Edit Health Indicator Dialog 
Box" on page 470.

Paste Selector From 
Clipboard

Paste the entire selector definition from the clipboard.

You can copy a selector from an HI definition within 
the CI Indicators tab. For details, see "Add Health 
Indicator/Edit Health Indicator Dialog Box" on 
page 470.

UI Element Description
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Selector Definitions

UI Element Description

Field Name Enter the name of a reference property that the selector 
expression searches for in the incoming data samples. 
For details on the samples, see "Data Samples" in 
Reports.

Operator The relational operator that the selector expression uses 
when comparing the actual value for the property 
against the value defined in the selector. The expression 
gives a result of TRUE or FALSE for each data sample.

Select an option from the list. The option can be:

➤ = or !=. Filters the samples where the value of the 
sample field specified in the Field box equals or is not 
equal to the value specified in the Value box.

➤ > or <. Filters the samples where the value of the 
sample field specified in the Field box is less or more 
than the value specified in the Value box.

➤ in or not In. Use the |!| separator Value box. The value 
specified in the Value box can only be 100 characters 
long.

➤ >= or <=. Filters the samples where the value of the 
sample field specified in the Field box is more or 
equal to or less or equal to the value specified in the 
Value box.

➤ prefix or notPrefix. Filters in the samples where the 
sample field value starts with the string entered in 
the Value box.

➤ suffix or notSuffix. Filters in the samples where the 
sample field value ends with the string entered in the 
Value box.

➤ like or notLike. The expression you enter in the Value 
box should follow the Java standard for regular 
expression. 

Note: It is recommended to use the suffix or notSuffix 
operators instead of the like and notLike operators that 
are performance intensive.
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Add/Edit Propagation Rule for CI Type Dialog Box

This dialog box enables you to add or edit a KPI propagation rule on a CIT.

Type The type of value in the data sample (can be String, 
Double, Integer, Long, Boolean, Float, or Binary).

Value The property value that the expression compares with 
the value in the data sample.

You can use RTSM class attributes to define selector 
values; drag an attribute from the CI Type Properties 
area to the selector value field.

Example: An HI is assigned for a business transaction 
monitored by Business Process Monitor. The selector 
defines which samples will be used to calculate HI 
instances of this type, using the following selector 
definition:
sampleType = trans_t AND u_iTransactionId = <<CI ID>>

The selector determines which samples are valid based 
on the transaction ID, which is the CI ID.

Note: If your assignment contains referenced properties 
(Ref Prop) in the selector, the attribute on the CI should 
not contain any of the following characters: " & ' < > 

Expression Summary When you have defined a selector, this area displays a 
summary of the selector conditions.

To access Select Admin > Service Health > Assignments.

In the Assignments tab, select a CIT in the CI Type 
pane. Within the Assignments for CI Type pane, the 
Propagation Rules tab displays the KPI propagation 
rules for the selected CIT.

➤ To add a propagation rule to the selected CIT, click 
the Add button. 

➤ To edit a propagation rule, select the propagation 
rule and click the Edit button.

UI Element Description
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Rule Settings Area

User interface elements are described below:

Condition Area

The condition defines which characteristics a CI must have so that the KPI 
propagation rule is relevant for the CI. The condition includes the CIT of 
the CI, the CIT of its parent CI, and the KPI assigned to the child CI. When 
these conditions are met, the task is then applied.

User interface elements are described below:

Relevant tasks "How to Define a KPI Propagation Rule" on page 577

UI Element (A-Z) Description

Description (Optional) Enter a description for the propagation rule.

Name Enter a name for the propagation rule.

UI Element (A-Z) Description

KPI assigned to 
source CI type

This drop-down list contains the KPIs that can be 
assigned to the child CI. Select a KPI to define the 
condition.

If you select Any KPI, the condition is filled if the CI 
has any KPIs assigned. 

For example, if you do not want any KPI propagated to 
the parent CI, select this option, and define the task as 
Do Not Propagate the KPI.

Parent CI type This contains a CIT hierarchy. Type the name of a CIT 
or select a CIT from the hierarchy, to define the CIT of 
the parent CI.

Source CI type This is the CI type which you selected in the CI Types 
pane. When the specified KPI is assigned to a CI with 
this CI type, and its parent CI is the specified parent 
CIT, the condition is met.
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Task Area

This area enables you to define which KPIs and business rules are propagated 
to the parent CI, when the condition is met.

User interface elements are described below:

UI Element Description

Do not propagate 
the KPI

Select this option if you do not want the KPI 
propagated to the parent CI.

Propagate the KPI 
using a different rule

Select this option if you want the KPI propagated to the 
parent CI, using a rule that is not the KPI’s default 
group rule. Select a rule from the drop-down list.

The list contains the rules that are applicable for the 
KPI and for the parent CIT. If you selected Any KPI in 
the condition area, the list contains the rules that are 
applicable for the parent CIT.

Propagate custom 
KPIs

Select this option if you want different KPIs propagated 
to the parent CI, or if you want to propagate the same 
KPI and rule, but using different rule thresholds. After 
selecting this option, add one or more KPIs for 
propagation.

If you select this option and do not add any KPIs, no 
KPIs are propagated.

New. Click to add a new KPI for propagation.

Edit. Click to edit the details of a selected KPI. 

Delete. Click to delete one or more selected KPIs. 

Select all. Select all the KPIs.

Clear Selection. Clear the selection of KPIs.
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Add/Edit KPI for Propagation Rule Dialog Box

This dialog box enables you to add or edit a KPI within a KPI propagation 
rule.

KPI Area

User interface elements are described below:

KPI The name of the KPI propagated to the parent CIT. For 
information about each KPI, see "List of Service Health 
KPIs" on page 656.

Business Rule The business rule used to calculate the KPI.

For information about each rule, see "List of 
Calculation Rules in Service Health" on page 740.

To access In the Add/Edit KPI Propagation Rule for CI Type 
dialog box, in the Task area, click New or select a KPI 
and click Edit.

Relevant tasks "How to Define a KPI Propagation Rule" on page 577

UI Element (A-Z) Description

Business Rule The business rule used to calculate the KPI.

For information about each rule, see "List of 
Calculation Rules in Service Health" on page 740.

KPI The name of the KPI propagated to the parent CIT. For 
information about each KPI, see "List of Service Health 
KPIs" on page 656.

UI Element Description
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Thresholds Area

This area enables you to modify the default thresholds used for the KPI’s 
business rule; for details, see "KPI and HI Thresholds" on page 401. This area 
only appears if you select a rule that requires thresholds, such as the 
Percentage Rule.

User interface elements are described below:

API Rule Definitions Area

This area is displayed when you select the API Group and Sibling rule in the 
Business Rule list. 

Enter the KPI calculation script for the rule you are creating; for details, see 
"API Group and Sibling Rule" on page 950.

UI Element (A-Z) Description

OK, Warning, Minor, 
Major, Critical

Enter the required threshold value for each status in 
the appropriate box. Ensure that the values you enter 
are logically ordered.

Operator Select the required operator. This operator is applied for 
all the thresholds.

Threshold Settings Select one of the following:

➤ Default. Use the thresholds that are defined in the 
business rule repository. If you select this option, 
you cannot edit the threshold settings.

➤ Custom. Use non-default thresholds for the business 
rule. Select this option if you want to modify the 
default thresholds.
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Troubleshooting the Assignment Mechanism

If the Assignment Mechanism is not working properly, you can use the 
following System Health monitors to help locate the source of the problem:

➤ KES Availability. Monitors that the Assignment Mechanism is up and 
running for each customer.

➤ KES Content. Monitors that the Assignment Mechanism content is valid.

For details, see "Data Processing Server Monitors" in Platform Administration.
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20
Repositories Overview

This chapter includes:

Concepts

➤ Repositories – Overview on page 632

➤ Customizing Repository Elements on page 634

Tasks

➤ How to Customize a KPI, Rule, or Context Menu Repository Element 
on page 636

➤ How to Create a KPI and Rule – Example on page 637

➤ How to Create a Dynamic URL – Use-Case Scenario on page 641
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Concepts

Repositories – Overview

HP Business Service Management repositories provide definitions for objects 
in the HP Business Service Management system. Many of these definitions 
can be customized as required by your organization.

The Repository page provides a convenient user interface for viewing and 
customizing the definitions contained in the repository XML definition 
files. These files define the templates that are used throughout HP Business 
Service Management to determine how source data is imported and 
handled, and to determine appearance and functionality for the CIs in the 
presentation layer.

This section includes the following:

➤ "Repositories" on page 632

➤ "Permissions" on page 633

➤ "Advanced Users" on page 633

➤ "Repositories in Service Health, SLM, and Operations Management" on 
page 633

Repositories
The Repository page enables you to access the following repositories:

➤ KPIs. Provides template definitions for the key performance indicators 
(KPIs) used in Service Health. For details, see "KPI Repository Overview" 
on page 652.

➤ Indicators. Provides template definitions for the event type indicators 
(ETIs) and health indicators (HIs) used in Service Health, SLM, and 
Operations Management. For details, see "Indicator Repository" on 
page 681.
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➤ Rules. Provides template definitions for the business rules used with the 
KPIs in Service Health, and the tooltips used to display CI information. 
For details, see "Business Rule Repository Overview" on page 711.

The Rules API can be used to create new rules; for details see "Service 
Health Rules API" on page 947.

➤ Context menus. Provides definitions for the context menus used in 
Service Health. For details, see "Context Menu Repository Overview" on 
page 892.

Permissions
To view the repositories you must have the Add permission for Sources 
permission. To set up the permissions, select Admin > Platform > Users and 
Permissions > Permissions Management.

Advanced Users
Advanced users can modify existing repository objects and create new ones. 
This may be necessary when you want to customize the way information is 
presented in Service Health to fit the needs of your organization; or when 
you need to create new objects when integrating data from a new external 
system into Service Health.

Repositories in Service Health, SLM, and Operations 
Management
Some of the repositories are application-specific, while others are shared by 
different applications, as follows:

➤ Context Menus. The context menu repository in Service Health defines 
the menu commands which are used in Service Health only.
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➤ KPIs and Rules. Service Health and Service Level Management use 
different KPIs and rules, and therefore contain two separate, independent 
sets of repositories for KPI and rule templates. Changing KPI or rule 
templates in Service Health has no effect on Service Level Management 
(and vice versa). For details on the Service Level Management repositories, 
see "KPI Repository" and "Business Rule Repository" in Using Service Level 
Management.

➤ Event Type Indicators (ETIs) and Health Indicators (HIs). The indicators 
repository is a shared repository for Service Health, SLM, and Operations 
Management. Any changes you make to ETI and HI template definitions 
in one of these applications will impact the other applications as well. For 
details, see "How the Indicator Repository is Used by BSM" on page 685.

Customizing Repository Elements

Tip: HP Professional Services offers best practice consulting; it is 
recommended that you use this service before making any changes to the 
repositories. For information about how to obtain this service, contact your 
HP Software Support representative.

The following repository elements can be customized:

KPIs, Rules, or Context Menus

Within the KPIs, Rules, or Context Menus repository pages there are three 
types of repository elements:

➤ Predefined. Out-of-the-box elements that have not been modified.

➤ Predefined (Customized). Out-of-the-box elements that have been edited.

➤ Custom. New or cloned repository elements.
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You can customize KPI, Rule, or Context Menu templates in the repository 
page in the following ways:

➤ New Item. Creates a new repository element that is not based on an 
existing element. This element is labeled Custom in the Repository page.

➤ Clone. Creates a new repository element by cloning an existing element. 
The original element is still available, and the new cloned element can be 
modified.

➤ Edit. Edit an existing element. If you edit a predefined element it is 
labeled Predefined (Customized) in the Repository page. If you delete this 
element, the predefined element is automatically restored.

For details, see "How to Customize a KPI, Rule, or Context Menu Repository 
Element" on page 636.

Event Type Indicators or Health Indicators

You can create new ETI and HI templates, or edit existing templates, using 
the Indicators repository. For details, see "How to Create or Edit an ETI or HI 
Template in the Indicator Repository" on page 689.
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Tasks

How to Customize a KPI, Rule, or Context Menu 
Repository Element

This task provides general instructions for creating and editing a KPI, Rule, 
or Context Menu repository element. For scenarios illustrating how to 
customize specific types of elements, see:

➤ KPIs and Business Rules. "How to Create a KPI and Rule – Example" on 
page 637.

➤ Context Menus. "How to Create a Dynamic URL – Use-Case Scenario" on 
page 641.

For details on customizing an event type indicator or health indicator, see 
"How to Create or Edit an ETI or HI Template in the Indicator Repository" on 
page 689.

Note: Changes made to the repositories may adversely affect functionality. 
Only administrators with advanced knowledge of Service Health should 
perform changes. 

To customize a KPI, rule, or context menu repository element:

 1 Open the Admin > Service Health > Repository page and select the KPIs, 
Business Rules, or Context Menus repository.
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 2 Perform one of the following actions:

➤ To create a new element, click the New button.

➤ To clone an existing element, select an element and click Clone. A 
clone of the original element appears in the repository, labeled 
Custom. Select the Custom element, and click the Edit button.

➤ To edit an existing element, select the element and click the Edit 
button.

 3 In the dialog box that appears, define the repository element as described 
in the following sections:

➤ "New KPI/Edit KPI Dialog Box" on page 668

➤ "New Rule/Edit Rule Dialog Box" on page 871

➤ "New Context Menu/Edit Context Menu Dialog Box" on page 935

 4 Click OK to save the changes.

How to Create a KPI and Rule – Example

This example illustrates how to create a KPI with corresponding rule.

This task includes the following steps:

➤ "Create a KPI" on page 637

➤ "Create a rule" on page 639

 1 Create a KPI

Create a clone of the OT Impact KPI.

 a Select Admin > Service Health > Repositories > KPIs to open the KPIs 
page.

 b Select the OT Impact KPI you want to clone.
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 c Click the Clone button. The cloned KPI appears, labeled Custom.

 d Click the Edit button to open the Edit KPI dialog box. For details, see 
"New KPI/Edit KPI Dialog Box" on page 668.

 e Change the name of the KPI to RUM OT Impact, and click Save.
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The result is as follows:

 2 Create a rule

Create a new rule: RUM Impact Over Time. This is a clone of the Impact 
Over Time rule, and uses different criteria to calculate the financial loss of 
downtime.

 a Select Admin > Service Health > Repositories > Business Rules tab 
menu option to open the Business Rules page.

 b Select the Impact Over Time Rule that you want to clone.

 c Click the Clone button. The cloned rule appears in the Custom 
Business Rules area.

 d Click the Edit button to open the Edit Rule dialog box.

 e Change the name of the rule to RUM Impact Over Time.
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 f In the General Rule Settings area, add - for RUM at the end of the 
description to indicate that the rule is for Real User Monitor.

 g In the Rule Parameters area, select the DollarImpactFactor parameter 
and click the Edit button to open the Edit Rule Parameter dialog box.

 h Change 600 to 1000 in the Default Value field, and save the change.

 i In the Tooltip Settings area, add - for RUM at the end of the tooltip 
name.

 j Click Save to save the changes to the rule.
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The result is as follows:

Tip: Because the new rule is a clone of a rule that was applicable to the 
original KPI, the cloned rule is automatically applicable to the cloned KPI. 
If you need to make a rule applicable to a KPI, open the KPI for editing, 
and add the rule to the Selected Rules list. For details, see "New KPI/Edit 
KPI Dialog Box" on page 668.

How to Create a Dynamic URL – Use-Case Scenario

This use-case scenario describes how to create a dynamic URL context menu 
item and add it to a context menu. 

You want to create new context menu options for CIs in Service Health. 
These options launch the NNMi views from Service Health.

This scenario includes the following steps:

➤ "Identify the URLs for your context menus" on page 642

➤ "Create a new context menu" on page 643

➤ "Create a new context menu group (optional)" on page 643

➤ "Create the individual context menu actions" on page 643

➤ "Add the definition for each parameter of the URL" on page 645

➤ "Create the other URLs" on page 646

➤ "Assign the NNMi context menu to the NNMi CIs" on page 647

➤ "Test the context menu" on page 647

➤ "Results" on page 649
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 1 Identify the URLs for your context menus

The URLs you want to access have the following format: 

➤ showForm:
http://unv08nnm:8004/nnm/launch?cmd=showForm&objtype=Node
&nodename=unv08nnm&j_username=admin&j_password=admin. 

➤ showLayer2:
http://unv08nnm:8004/nnm/launch?cmd=showLayer2Neighbors&obj
type=Node&nodename=unv08nnm&j_username=admin&j_password=
admin

➤ showLayer3:
http://unv08nnm:8004/nnm/launch?cmd=showLayer3Neighbors&obj
type=Node&nodename=unv08nnmj_username=admin&j_password=a
dmin

➤ showView:
http://unv08nnm:8004/nnm/launch?cmd=showView&objtype=Node
&j_username=admin&j_password=admin

Unv08nnm is the Network Node Manager server in the Business Service 
Management (BSM) hosted solution.

The first part of the URL – before the question mark – is the static part of 
the dynamic URL used to create the context menu option and the second 
part of the URL consists of parameters used by the dynamic URL. Each 
parameter and its value is separated from the others by an ampersand (&).

To create the context menu item in the Service Health Repositories, you 
can either add a completely new menu item, or clone an existing one that 
is similar to what you need and edit its properties. The new menu option 
(NNMi) is added to the context menus used for the NNMi CIs.
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 2 Create a new context menu

Create a context menu named NNMi. This will be used to attach the 
menu actions to the relevant CIs. For details, see "Assign the NNMi 
context menu to the NNMi CIs" on page 647.

 a Select Admin > Service Health > Repositories > Context Menus to open 
the Context Menus page.

 b In the Context Menus tab, click New Context Menu. The New Context 
Menu dialog box is displayed.

 c Enter a name for the context menu you are creating (for example, 
NNMi).

 3 Create a new context menu group (optional)

Create a context menu group named NNMi. This is optional, and enables 
you to group all the related menu actions together.

 a In the New Context Menu - NNMI dialog box, select New > Group. 
The New Group dialog box is displayed.

 b Enter a name for the context menu group you are creating (for 
example, NNMi).

 4 Create the individual context menu actions

For each one of the URLs above, create an individual context menu 
action. For example, for the showForm URL:

 a In the New Group dialog box, select New Action. The New Action 
dialog box is displayed.

 b Enter the following information:

➤ Name. Enter a name for the context menu you are creating, for 
example, NNMi - showForm.

➤ Pre-processor Class. Select Dashboard generic URL from the list.



Chapter 20 • Repositories Overview

644

➤ Post-processor Class. Select Open Window from the list.

When you select the Pre-processor Class and Post-processor Class 
options, the default parameters for each selection are automatically 
added in the Pre-processor Parameters and Post-processor Parameters 
areas.

 c Delete the following default parameters: filter.selectedVTIds, 
filter.fromDashboard, autoGenerate, and reportID.
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 d Click the Edit button for the URL parameter and in the Pre-processor 
Parameter Details dialog box, enter the following information:

➤ Value. Enter the static part of the URL: 
http://unv08nnm:8004/nnm/launch.

➤ Convert to. Leave empty.

Tip: For static URLs you can enter the complete URL in the Value field.

 5 Add the definition for each parameter of the URL

For each one of the URLs above, add the definition for each parameter of 
the URL. For example, the showForm URL has the following parameters:

http://unv08nnm:8004/nnm/launch?cmd=showForm&objtype=Node&n
odename=unv08nnm&j_username=admin&j_password=admin. 

You must define separately each pre-processor parameter.

In the New Action Details dialog box, enter the information for each 
parameter as listed in the table below and click OK.

cmd=
showForm

objtype=
code

nodename=
unv08nnm

j_username=
admin

j_password=
admin

Key mycmd mysubc
md

mysubsubcm
d

username password

Value showForm Node NODE.PROPS
.display_label

admin admin

Convert 
to

cmd objtype nodename j_username j_password
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NODE.PROPS.display_label returns the name of the CI that you right-
click to use the NNMi context menu action. It searches for the CI 
(NODE) where the cursor is located, and then for the CI Property 
(PROPS) that corresponds to the CI name (data_name). The name of 
the CI that you right-click is then changed into the nodename 
parameter that is used by the URL to access the correct information.

You can also use:

➤ NODE.ID to return the CI ID Symbol in the view.

➤ NODE.CMDB.ID to return the CI CMDB ID.

➤ NODE.PROPS.data_name to return the CI name.

 a In the Post-processor Parameters area:

➤ Click the Edit button for WIN_NAME to open the Post-processor 
Parameter Details dialog box. In the Value box, enter a name for the 
window opened by the menu action, for example, NNMi.

➤ Click the Edit button for SLAVE_WIN to open the Post-processor 
Parameter Details dialog box. Make sure that the value of the 
SLAVE_WIN parameter is 0 to open a new window.

 b Click Save to close the New Action dialog box.

 6 Create the other URLs

In the same way as explained in "Create the individual context menu 
actions" on page 643 and "Add the definition for each parameter of the 
URL" on page 645, create the context menu actions for each URL.

Within the NNMi context menu group, create the following menu 
actions: NNMi - showForm, NNMi - showLayer2, NNMi - showLayer3, and 
NNMi - showView.
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Note: showView menu action does not need a mysubsubcmd parameter. 

 7 Assign the NNMi context menu to the NNMi CIs

In the relevant view, select the NNMi CIs and assign the context menu to 
the CIs.

 a Select Admin > Service Health > CI Indicators.

 b Select the appropriate view to assign the Context Menu to the view’s 
CIs.

 c Select the NNMi CIs in the CI Indicators tab, and click the CI Properties 
tab in the lower pane.

 d Click Add Context Menu in the Context Menus area, and move NNMi 
from the Available Context Menus list to the Active Context Menus 
list.

The NNMi context menu is displayed in the Context Menus area of the 
KPIs page. 

 8 Test the context menu

When you right-click the NNMi CI in the defined view, the display name 
of the CI is passed to the URL you select. 
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Check that the context menu and context menu actions are displayed for 
the appropriate CI in the relevant view and that they open the correct 
URL.

 a Select Applications > Service Health.

 b In one of the Service Health application tabs, open the view where you 
added the context menu, and access the menu commands for the CI. 
The following menu appears:



Chapter 20 • Repositories Overview

649

 9 Results

The URL shows all the neighbors of the selected CI in the NNM map.
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21
KPI Repository

This chapter includes:

Concepts

➤ KPI Repository Overview on page 652

Tasks

➤ How to Customize a KPI Template in the Repository on page 653

Reference

➤ List of Service Health KPIs on page 656

➤ KPIs Repository User Interface on page 665
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Concepts

KPI Repository Overview

KPIs (Key Performance Indicators) provide quantifiable measurements to 
help you monitor real-time business performance, and assess the business 
impact of problems in the system. For more information about KPIs, see "HI 
and KPI Definitions" on page 398.

The Service Health KPI Repository includes templates of all of the KPIs that 
can be used within Service Health. Each KPI template is assigned a default 
business rule, and is defined by an internal ID number. For a list of out-of-
the-box KPIs, see "List of Service Health KPIs" on page 656.

Advanced users can modify the predefined KPI templates and create new KPI 
templates to customize how information is presented. For example, you 
may want to create new KPI templates when integrating data from a new 
external system into Service Health.

Within the KPI Repository, KPIs are categorized as follows: 

➤ Predefined. Out-of-the-box KPIs.

➤ Predefined (Customized). Out-of-the-box KPIs that have been edited.

➤ Custom. New or cloned KPIs.

For instructions on how to edit KPI templates in the repository, see "How to 
Customize a KPI Template in the Repository" on page 653. For details on the 
user interface, see "KPIs Repository page" on page 666.
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Tasks

How to Customize a KPI Template in the Repository

The following section describes how to customize a KPI template in the KPI 
Repository.

For an example illustrating how to customize a KPI template, see "How to 
Create a KPI and Rule – Example" on page 637.

Tip: HP Professional Services offers best practice consulting; it is 
recommended that you use this service before making any changes to the 
repositories. For information about how to obtain this service, contact your 
HP Software Support representative.

This task includes the following steps:

➤ "Create a customized KPI" on page 654

➤ "Edit KPI details" on page 654

➤ "Specify KPI parameter details" on page 654

➤ "Set a KPI and its parameters back to default" on page 655
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 1 Create a customized KPI

To customize a KPI in the KPI Repository, select Admin> Service Health > 
Repositories > KPIs. Open a KPI template for editing using one of the 
following methods:

➤ New KPI. Creates a KPI that is not based on an existing KPI. To create a 
new KPI, click the New KPI button in the KPI Repository page.

➤ Clone KPI. Creates a KPI by cloning an existing KPI. The original KPI is 
still available, and the new cloned KPI can be modified. To clone a KPI, 
select a KPI in the KPI Repository page and click the Clone KPI button. 
The new KPI will be labeled Custom. Select the new KPI and click the 
Edit KPI button to open it for editing.

➤ Edit KPI. Modifies an existing KPI. To edit a KPI, select a KPI in the KPI 
Repository page and click the Edit KPI button. If you edit a predefined 
KPI, it will be labeled Predefined (Customized).

For user interface details, see "KPIs Repository page" on page 666.

 2 Edit KPI details

After you open a KPI template for editing, define the KPI’s settings as 
required. For user interface details, "New KPI/Edit KPI Dialog Box" on 
page 668.

 3 Specify KPI parameter details

In the Parameter Details dialog box, modify existing information or enter 
new information about the predefined KPI parameters. For user interface 
details, see "New/Edit KPI Parameter Dialog Box" on page 678.
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 4 Set a KPI and its parameters back to default

If you have edited a KPI, you might want to return it to its default 
settings. Note that this is only applicable for KPIs whose type is 
Predefined (Customized). There are two ways to restore KPI elements to 
default:

➤ Restore all default settings of a KPI. Within the KPI Repository page, 
select a KPI whose type is Predefined (Customized), and click the 
Restore to Default button. The KPI is returned to its default settings, 
and its type reverts to Predefined.

➤ Restore specific settings of a KPI. Within the KPI Repository page, 
open a predefined (customized) KPI for editing, and click the Restore 
Defaults button. The elements that have been modified are 
automatically selected. Select the elements which you want to restore 
to default, and click Save.

For details on the user interface, see "Restore Defaults Dialog Box" on 
page 679.
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Reference

List of Service Health KPIs

This section provides information about the KPI templates available in the 
KPI repository.

KPI (KPI #) Description

Application 
Availability 

(7)

Measures availability of End User CIs (for example: Applications, BTFs, and 
Business Transactions).

Application 
Performance

(6)

Measures performance on End User CIs (for example: Applications, BTFs, and 
Business Transactions).

Backlog

(600)

Backlog KPI for Business Process Insight Data

Displays the backlog information of the business process, business activity or 
business process monitor, from the Business Process Insight application.

Backlog KPI for TransactionVision Data

Displays information on the number of backlogged (in-process) transactions on 
the target machine, as determined by TransactionVision. 

Business 
Health

(620)

Displays the worst status of the following KPIs monitored by HP Business Process 
Insight, for the process, and its children: Backlog, Business Impact, Business 
Performance, Value, and Volume. (This can be modified in Admin > Platform > 
Setup and Maintenance > Infrastructure Settings Manager > Applications > 
Business Process Insight > List of Business KPIs.)

The Business Health KPI provides a high-level indication of how the business 
process is currently performing; if the KPI indicates a problem, drill down into the 
process to locate the underlying problematic KPI.

Business 
Impact

(602)

Displays the health of the process monitored by the HP Business Process Insight 
application.
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Business 
Performance

(631)

Displays information on the amount of time taken to complete the business 
process, business activity or business process duration monitor.

Delays

(1313)

Displays information on the delayed (late) transactions on the target machine, as 
determined by TransactionVision. A transaction is defined as late when its 
response time exceeds a defined threshold in TransactionVision. 

Duration

(601)

Displays different information depending on the rule associated with the 
Duration KPI. A tooltip indicates which metric is involved.

Efficacy

(630)

The Efficacy KPI is a custom KPI for measuring the efficiency and capacity of a 
business process. You can create a custom API rule for the Process Efficacy health 
indicator, and assign this health indicator to this KPI. For more details, see 
"Service Health Rules API" on page 947.

Exceptions

(1310)

Displays information on transactions that did not follow the expected flow path 
on the target machine, and are therefore classified as exceptions in 
TransactionVision.

Failures

(1312)

Displays information on the failed transactions on the target machine, as 
determined by TransactionVision. A transaction is classified as "failed" when it 
does not match the attribute or pattern defined as failure in TransactionVision. 

Generic

(1500)

Displays information calculated by the Generic Formula rule or by the Summary 
of Values rule.

Legacy 
System

(1)

Displays information relating to SiteScope metrics which are not aligned with 
existing health indicators, as well as data for SiteScope monitors, measurements, 
and groups in the System Monitor view.

For Siebel CIs, this KPI indicates physical problems with this CI or underlying CIs, 
provided by SiteScope physical monitors (for example: CPU monitor, disk space 
monitor, and so forth). SiteScope is the source of the data. 

For SAP CIs, this KPI indicates physical problems with underlying hosts, provided 
by SiteScope physical monitors (for example: CPU monitor, disk space monitor, 
and so on). By default, the System KPI does not appear in the view. If you are 
using a regular SiteScope monitor (which creates the System KPI) and you want to 
display the System KPI in the view, you have to add the System KPI manually to 
the CI.

KPI (KPI #) Description
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Locations

(303)

Deprecated.

The Locations KPI is a bar that includes up to six colored sections. Each colored 
section represents the relative amount of Business Process Steps with the end-user 
experience status (the worst status between Application Performance and 
Application Availability) that corresponds to the color, at that location. The colors 
correspond to the Business Process Monitor Application Performance/Application 
Availability colors.

For example, if there are ten SAP Business Process Steps under the Locations 
container, five with OK end-user experience, two with Minor status, two with 
Critical status, and one with No Data status, the bar displays: 50% green, 20% 
yellow, 20% red, and 10% light blue.

Tooltip: The KPI’s tooltip displays how many locations have each status, and the 
total number of locations. The tooltip’s color represents the worst location status. 
For example:

Network 
Availability

(308)

Displays information relating to availability of network devices.

Network 
Performance

(1077)

Displays information relating to performance measurements of network devices.

Number of 
Open 
Incidents

(2600)

Displays the number of incidents that exist in HP Service Manager, and that 
currently have the initial status and final status defined in the rule parameter and 
are associated with the business service. Tickets can have any status between 
Initial Status and Final Status as long as they had the initial status after the 
integration and that they are not currently closed.

KPI (KPI #) Description
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Operational 
Status

(615)

Displays the worst status of all operational (non-business) KPIs monitored by 
Business Process Insight, for the process, and its children. 

(The business KPIs include Backlog, Business Impact, Business Performance, 
Value, and Volume. This can be modified in Admin > Platform > Setup and 
Maintenance > Infrastructure Settings Manager > Applications > Business Process 
Insight > List of Business KPIs. Their worst status is displayed in the Business 
Health KPI.)

The Operational Status KPI provides a high-level indication of how the 
operational (non-business) KPIs are currently performing; if the KPI indicates a 
problem, drill down into the process activities and any linked system CIs to locate 
the underlying problematic KPI.

OT Impact

(13)

Displays information relating to the financial loss caused to the organization 
when an item is unavailable over time. By default, the calculation is based on the 
Application Availability KPI. 

At the leaf CI level, you should attach the Impact Over Time rule to the OT Impact 
KPI and the Application Availability KPI to the same CI. The Impact Over Time 
rule measures the total time the Application Availability KPI attached to the same 
CI has the red status, and then calculates the financial loss using the rule 
parameter: DollarImpactFactor. This parameter represents the amount of dollars 
lost in an hour if the system is unavailable.At the group level, you should attach 
the Sum of Values rule to the OT impact KPI. The Sum of Values rule calculates the 
sum of all of the values of the OverTime Impact KPI of its children.The OT Impact 
rule calculates financial loss as you add the OT Impact KPI. The calculation has no 
time limitation. 

To restart the calculation you can:

➤ change the rule’s objectives 

➤ delete the OT Impact KPI and add it again

Restarting HP Business Service Management might restart the financial loss 
calculation, but because of Service Health calculation persistency, the last known 
financial value might be recovered instead.

KPI (KPI #) Description
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Performance 
Analytics

(635)

Displays information collected from Service Health Analyzer (SHA), indicating the 
severity of an anomaly on the selected CI (and its child CIs), as follows:

➤ Critical. The CI has an anomaly with BPM or RUM metrics, meaning the 
anomaly has a business impact.

➤ Major. The CI has an anomaly without BPM or RUM metrics, meaning the 
anomaly does not have a business impact.

➤ Normal. There are no open anomalies on the CI.

Other severities are defined by patterns that SHA has identified as an anomaly 
type.

PNR 

(215)

Displays information collected from Service Level Management, regarding how 
much more time a CI can be unavailable before the SLA is in breach of contract, 
based on any SLM KPI.

When configuring a Service Health PNR KPI, you define the SLA, tracking period, 
calendar, and SLM KPI which are used to calculate the Service Health PNR value.

For example, if the SLA defines that availability must be 98.5%, the system may be 
unavailable 1.5% of the time. If the total time monitored is 100 hours, the PNR 
KPI can be set to enter Warning state when the system has been unavailable for 
one hour (or 1% of the total time), and to enter Critical state when the system has 
been unavailable for 1 1/2 hours. At this point the SLA is in breach, and the 
agreement can no longer be met.

For details on how the PNR KPI is calculated, see "PNR (Point of No Return) KPI 
Calculation" on page 422.

RT Impact

(11)

Displays information relating to the financial loss caused to the organization in 
real time; the calculation is based on the Application Availability KPI. 

At the leaf CI level, you should attach the Real Time Impact rule to the RT impact 
KPI and the Application Availability KPI to the same CI. The Real Time Impact 
rule measures the time the Application Availability KPI attached to the same CI 
has the red status, and then calculates the financial loss using the rule parameter: 
DollarImpactFactor. This parameter represents the amount of dollars lost in an 
hour if the system is unavailable. If the Application Availability KPI status is not 
red, then the Real Time Impact value is 0.0$.At the group level, you should attach 
the Sum of Values rule to the RT Impact KPI. The Sum of Values rule calculates the 
sum of all of the values of the Real Time Impact KPI of its children.

When availability status returns to green, the value for this KPI reverts to 0.

KPI (KPI #) Description
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SAP

(305)

Indicates problems related to the SAP infrastructure. The data that is reported by 
this KPI comes from CCMS measurements from SiteScope.

SAP Alert

(306)

SAP Alerts are created by the SAP system for various reasons; for example, an 
incorrect user login, exceeded CCMS thresholds, and so on.

SAP alerts are retrieved from the SAP system by the SiteScope CCMS Alerts 
monitor. They can be displayed in the Service Health using a SAP Alert KPI whose 
color is determined by the SAP system. 

After you have handled the problem that triggered the alert, perform an alert 
completion procedure. This causes the alert to be acknowledged.

Security

(307)

Displays the status of the security in the Operations Manager application. 

This is an optional KPI. It is displayed when you select Create Network and 
Security KPIs in the HP Operations Manager integration definition. For details, see 
"Understanding Node, Tickets, or Node - Running Software Integration Types" in 
Solutions and Integrations.

Siebel

(300)

This KPI’s color is provided by Siebel-specific monitoring information. It separates 
Siebel problems from more general, infrastructure-related problems. It provides 
Siebel-specific data, such as number of tasks, processes, and so. The SiteScope 
Siebel monitor is the source of the data.

Siebel Errors

(301)

Displays the number of tasks that are in error, provided by the SiteScope Number 
of Tasks in Error measurement. The source of the data is the Siebel monitor. This is 
a Siebel-specific KPI.

Siebel 
Sessions

(304)

Displays the number of sessions that are running in a Siebel application server. A 
session is a task that is in running mode and interactive. The value of the number 
of sessions come from a measurement that is provided by the SiteScope Siebel 
monitor.

This KPI does not propagate up in the hierarchy.

SiteScope 
Health

(1003)

A SiteScope Health KPI is attached to each SiteScope Profile CI. It displays the 
availability of the SiteScope. SiteScope periodically (every minute) sends a 
heartbeat to BSM. If the heartbeat is received by BSM, the status of the SiteScope 
Health KPI is green. If the heartbeat is not received, the status of the KPI is blue 
(No data). This indicates that there is no communication between SiteScope and 
BSM. In this case, the status of all the SiteScope monitor and group CIs is also 
blue.

KPI (KPI #) Description
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Software 
Availability

(15)

Displays information relating to availability of software element CIs (for example, 
databases, J2EE servers, and web servers).

Software 
Performance

(1075)

Displays information relating to performance on software element CIs (for 
example, databases, J2EE servers, and web servers).

System 
Availability

(1001)

Displays information relating to availability of system element CIs, such as servers 
and disks.

System 
Performance

(1002)

Displays information relating to performance measurements of monitored system 
element CIs, such as servers and disks.

Throughput 

(400)

For SOA. Displays the number of calls to the item per minute.

KPI (KPI #) Description
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Transactions

(302)

The Transactions KPI is a bar that includes up to six colored sections. Each colored 
section represents the relative amount of Business Process Steps with the end-user 
experience status (the worst status between Application Performance and 
Application Availability) that corresponds to the color. The colors correspond to 
the Business Process Monitor Application Performance/Application Availability 
colors.

For example, if there are ten SAP Business Process Steps under the Transactions 
container, five with OK end-user experience, two with Minor status, two with 
Critical status, and one with No Data status, the bar displays: 50% green, 20% 
yellow, 20% red, and 10% light blue.

The KPI’s tooltip displays a list of how many transactions have each status, and 
the total number of transactions. The tooltip’s color is set according to the worst 
transaction status. For example:

Unassigned 
Events 

(10005)

Displays information relating to the number of unassigned events on the CI, 
which are not handled in the event lifecycle.

Note: When there is new information on a CI, Operations Management 
automatically sends an HI value for this KPI. These HIs are hidden and cannot be 
deleted; a hidden KPI assignment creates this KPI.

To remove this KPI from Service Health display, access Service Health 
Administration > View Builder. Right-click a view in the View Selector, and select 
Properties. In the popup window, deselect the KPI in the Include in View list. This 
configuration is for a specific view.

KPI (KPI #) Description
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Unresolved 
Events 

(10004)

Displays information relating to the number of events on the CI whose status in 
not normal.

Note: When there is new information on a CI, Operations Management 
automatically sends an HI value for this KPI. These HIs are hidden and cannot be 
deleted; a hidden KPI assignment creates this KPI.

To remove this KPI from Service Health display, access Service Health 
Administration > View Builder. Right-click a view in the View Selector, and select 
Properties. In the popup window, deselect the KPI in the Include in View list. This 
configuration is for a specific view.

Value

(1311)

Value KPI for Business Process Insight Data

Displays information on the monetary value of the business process, business 
activity or business process value monitor.

The default rule is Worst Status Rule, which calculates the KPI based on the worst 
status (or value) of the associated health indicators.

Value KPI for TransactionVision Data

Displays information on the monetary value of the transactions on the target 
machine, as determined by TransactionVision.

This KPI uses, by default, the In-process Transaction Value for CIs monitored by 
TV. To see data on completed transactions, change the HI in the KPI assignment for 
the KPI. For details on KPI assignments, see "Indicator Assignments and 
Propagation" on page 557.

Note: This KPI does not include predefined objectives, and so displays 
Informational (blue) status in Service Health. To calculate KPI status, define 
meaningful objectives for the KPI using the Admin > Service Health > CI Indicators 
tab.

Note: This KPI does not include predefined objectives, and so displays 
Informational (blue) status in Service Health. 

To calculate KPI status, define meaningful objectives for the KPI using the Admin 
> Service Health > CI Indicators tab.

KPI (KPI #) Description
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KPIs Repository User Interface

This section includes:

 ➤ KPIs Repository page on page 666

 ➤ New KPI/Edit KPI Dialog Box on page 668

 ➤ New/Edit KPI Parameter Dialog Box on page 678

 ➤ Restore Defaults Dialog Box on page 679

Volume

(1050)

Volume KPI for Business Process Insight Data

Displays the value or count of the number of completed instances for the business 
process, business activity or business process monitor.

The default rule is Worst Status Rule, which calculates the KPI status based on the 
worst status of the associated health indicators.

Volume KPI for Real User Monitor Data

Displays information on traffic volume, such as transaction runs, amount of 
sessions, errors, and events.

Volume KPI for TransactionVision Data

Displays information on the volume of completed transactions on the target 
machine, as determined by TransactionVision.

Note: This KPI does not include predefined objectives, and so displays 
Informational (blue) status in Service Health. 

To calculate KPI status, define meaningful objectives for the KPI using the Admin 
> Service Health > CI Indicators tab.

KPI (KPI #) Description
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KPIs Repository page

This page displays the list of KPI templates available in Service Health. The 
KPI repository enables an advanced user to modify existing KPIs and create 
new ones.

User interface elements are described below:

To access Select Admin > Service Health > Repositories > KPIs

Important 
information

To modify a KPI, select the KPI and click the Edit 
button, or right-click the KPI and access the Edit menu 
command. For details, see "New KPI/Edit KPI Dialog 
Box" on page 668.

For a list of predefined KPIs, their descriptions, and the 
rules attached to the KPIs, see "List of Service Health 
KPIs" on page 656.

Relevant tasks "How to Customize a KPI Template in the Repository" 
on page 653

UI Element (A-Z) Description

New KPI. Click to create a new KPI.

Clone KPI. Select a KPI and click the Clone KPI button 
to create a new KPI using the selected KPI as a 
template.

The original KPI does not change. The new KPI’s type is 
Custom.

Edit KPI. Click to edit the details of a selected KPI.

Delete KPI. Click to delete one or more selected 
Custom KPI.

If you delete a Predefined (Customized) KPI, it is 
restored to default.

Predefined KPIs cannot be deleted.
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Restore to Default. Select an edited KPI whose Type is 
Predefined (Customized), and click to restore it to its 
original settings.

Click to refresh the page.

Click to display help on predefined KPIs.

Export to Excel. Click to export the table to an Excel 
file.

Export to PDF. Click to export the table to a PDF file.

Change visible columns. Opens the Choose Columns 
to Display dialog box, where you select the columns 
you want to display in the table.

By default, the ID column which contains internal KPI 
ID numbers is not displayed.

Default Group Rule This specifies the group rule that is defined by default 
for this KPI. 

Domain The domain which contains this KPI. Domains are 
groups of KPIs which monitor similar functions (for 
example Application or Network); this enables you to 
filter KPIs according to these groupings. For details see 
"KPI Domains" on page 411.

ID The ID number used to identify the KPI in the source 
adapter templates.

UI Element (A-Z) Description
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New KPI/Edit KPI Dialog Box

This dialog box enables you to define KPI details.

Main Settings Area

This area enables you to define the KPI name, default group rule, and which 
rules can be applied to the KPI.

Name The name of the KPI.

Type Indicates one of the following KPI types:

➤ Custom. New or cloned KPIs.

➤ Predefined. Out-of-the-box KPIs that have not been 
modified.

➤ Predefined (Customized). Out-of-the-box KPIs that 
have been edited. You can restore such a KPI to its 
original settings using the Restore to Default 
button.

To access In the KPI Repository page, click the New KPI button, 
or select a KPI and click the Edit KPI button.

Important 
information

A list of the KPIs, their descriptions, and the rules 
attached to the KPIs is available in "List of Service 
Health KPIs" on page 656.

Relevant tasks "How to Customize a KPI Template in the Repository" 
on page 653

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Click this button to move all rules to the Selected Rules 
list.

Select a rule and click to add it to the Selected Rules 
list. Select multiple rules by holding down the CTRL 
key.

Select a rule and click to remove it from the Selected 
Rules list.

Click this button to remove all rules from the Selected 
Rules list.

Applicable Rules Define which rules can be applied for this KPI, using 
the two lists:

➤ Unselected Rules. The list of rules which are not 
applicable to the KPI.

➤ Selected Rules. The list of rule which can be applied 
to the KPI.

Use the arrow buttons to move rules from one list to 
the other.

For details on the rule applicable for each KPI by 
default, see "List of Service Health KPIs" on page 656.

Default Group Rule Select the group rule to be used for the next level up in 
the hierarchy. This list displays all of the available 
group rules for the applicable rule you selected in the 
Applicable Rules list. When a KPI is defined for a CI, it 
is usually added to a parent CI. The parent item uses 
the group rule to calculate the KPI status. For the list of 
rules, see "List of Calculation Rules in Service Health" 
on page 740.

Domain Define the domain to which this KPI is assigned; for 
details see "KPI Domains" on page 411.

Either select an existing domain, or enter a new 
domain name for this KPI.

Name The name of the KPI as it is displayed in the UI.
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Advanced Settings Area

This area enables you to define KPI calculation and display order, trend, and 
user mode.

User interface elements are described below:

UI Element (A-Z) Description

Applicable for User 
Mode

Select the type of user. You can define two versions of a 
single Service Health KPIs for two different user types 
(modes): Operations and Business, where each KPI 
version is geared towards the particular viewing 
requirements of one of the user types. For details, see 
"KPIs for User Modes" on page 412. Select Both if you 
want to have one version of the KPI. If you select 
Operations and Business, it is recommended to modify 
the KPI’s name to reflect the type of user role. For 
example, rename OT Impact: OT Impact - Operations.

Calculation Order Select the KPI position. That number represents the 
position of the KPI in the ordered list used by Service 
Health when it calculates the topology. Service Health 
calculates the higher priority KPIs first, and then the 
lower priority KPIs. 

A KPI is dependent on another KPI when the rule that 
calculates the value of the first KPI uses the results of 
the second KPI’s rule. For example, if the RT Impact KPI 
and the Application Availability KPI are attached to a 
CI, the value of the RT Impact KPI depends on the 
values of the Application Availability KPI. These KPIs 
must therefore be calculated in a specific order.
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Presentation Settings Area

This area enables you to define various aspects of how the KPI result is 
displayed, including formatting method, unit, value prefix and postfix.

The Status and Value fields should be changed following instructions from 
HP Software Support.

Display Order Select the order in which the KPIs are displayed in 
Service Health.

The KPI is Critical if... Define the trend for the KPI, as described in "KPI Trend 
and History Calculation" on page 408. Select:

➤ values are smaller. When the values are small, the 
KPI is critical.

➤ no different. When the values are not different, the 
KPI is critical.

➤ values are bigger. When the values are large, the KPI 
is critical.

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Formatting Method Define the method for formatting the value of the KPI 
(for example: toLowerCase), using the following 
options:

➤ Selection. Select a formatting method from the list 
of available methods (leave blank if not required). 
For details, see "List of Formatting Methods" on 
page 676.

➤ Other. Specify a method that you have defined, 
which is not on the list of available methods. If you 
need to create a new method, contact HP Software 
Support.

Status Represents the key used to access the appropriate KPI 
results map. If you create a new rule whose key is not 
Status, you must enter the new key in the Status box. 
To create a new rule with a different key, contact HP 
Software Support. 

Default Value: Status

Units Enter the type of unit applicable to the rule results 
displayed in the KPI. The default units of measurement 
for objectives are:

➤ <No unit>. For rules that handle volume, where KPI 
measurements represent a simple numerical count; 
for example, the RUM Transaction Monitor Volume 
Rule.

➤ Financial ($). For rules that determine financial loss 
for a CI; for example, the Impact Over Time Rule.

➤ Milliseconds or Seconds. For rules that handle 
performance time data for a transaction or monitor; 
for example, the Transaction Performance Rule.

➤ Percentage (%). For rules that handle availability 
over time data for a transaction like the Transaction 
Availability Rule, and the PNR Rule where the KPI 
measurement represents percentage of time 
remaining for CI unavailability before the SLA is in 
breach of contract.
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KPI Parameters Area

This area enables you to customize tooltip colors, text colors, and status 
icons for KPIs.

To modify a parameter, select the parameter and click the Edit button. For 
details, see "New/Edit KPI Parameter Dialog Box" on page 678.

Note: Fields regarding internal KPI parameters should only be changed 
following instructions from HP Software Support.

User interface elements are described below:

Value Represents the value of the key used to access the 
appropriate KPI results map. This field should be 
changed following instructions from HP Software 
Support.

Value Postfix Enter the row value postfix. This can remain blank if it 
is not required. For example, to indicate that the value 
of the KPI is in Euros, enter EUR.

Value Prefix Enter the row value prefix. This can remain blank if it 
is not required. For example, to indicate that the value 
of the KPI is negative, enter a minus sign (-).

UI Element (A-Z) Description

New KPI Parameter. Click to create a new KPI 
parameter.

Edit KPI Parameter. Click to edit the details of a 
selected KPI parameter.

Delete KPI Parameter. Deletes one or more selected KPI 
parameters.

UI Element (A-Z) Description
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Select all. Select all the KPI parameters.

Clear Selection. Clear the selection of KPI parameters.

Bar Icon The bar icon that is assigned to the KPI.

Key The internal name of the parameter.

For details on the default parameters, see "KPI and HI 
Thresholds" on page 401.

UI Element (A-Z) Description
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Presentation Type Select how you want the KPI to be presented in Service 
Health.

icon, Text, and Resource text formats display data 
using icons or text colored by status.

PNR bar format is used for the PNR KPI; for details see 
"How to Attach a PNR KPI to a CI" on page 448.

Group bar displays:

➤ Transactions KPIs. When one or more of the CI’s 
children have the Business Transaction type, then 
the Transactions KPI is displayed as a GROUPBAR.

➤ Locations KPIs. When one or more of the CI’s 
children has the Locations type, then the Locations 
KPI is displayed as a GROUPBAR. For example:

➤ Business Health KPIs. 

➤ At all CI levels, the groupbar displays the number 
of instances for each one of the Business Process 
Insight statuses without consideration of the 
Weight. At the level above the business process 
CI, an icon represents the status of the worst 
child KPI. The Weight information is displayed in 
the tooltip. The tooltip color matches the color of 
the status. The status is calculated by the rule 
assigned to the KPI. 

➤ Above the business process CI level, the KPI 
displays an icon that shows the worst child status 
of the child CIs level. 

Note: The default type for the Business Health KPI is 
GROUPBAR.

Status Icon The icon assigned to the KPI parameter.

Text Color The color of the text in the tooltip.

Tooltip Color The color of the tooltip’s header and border.

UI Element (A-Z) Description
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List of Formatting Methods
The formatting methods that are available are used to format the result that 
is displayed in Service Health:

Formatting Methods Description

analyzeSiteScopeMessage If, in a message, a long word overlaps the end of the 
line, the word is truncated. The rest of the word and 
the rest of the message are wrapped.

encode Inserts a back slash (\) before special characters.

formatDecimalNumber Returns as a formatted decimal number. The 
number of digits after the decimal point is indicated 
by numAfterDot.

formatDateTime Returns formatted as date and time: DDMMMYYYY 
hh:mm:ss

formatPnrValue Formats the pnr time left in the PNR format.

getHHMMSS Convert a string representing number of seconds to 
the format HH:MM:SS.

getIntValue Returns an int number as string.

getMilliAsSec Returns a millisecond value as seconds by dividing 
the value by 1000.

getMustValue Returns ! if there is a value, otherwise returns 
nothing.

getRemedyETTR Deprecated. Use the EMS integration feature. For 
details, see "Integration Administration Application 
Overview" in Solutions and Integrations.

getRemedyResource Deprecated. Use the EMS integration feature. For 
details, see "Integration Administration Application 
Overview" in Solutions and Integrations.

getResourceString Returns the corresponding resource string to the 
given string.

getStatusString Returns the corresponding resource string to the 
given status string.
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getWeightValue Returns the value if there is a value, otherwise 
returns 1.

ifEndCheck Changes an empty string into a comment line. 
Inserts "--->" at the end of the string.

ifStartCheck Changes an empty string into a comment line. 
Inserts "<!--" at the end of the string.

numberToTime Converts a string that can represent a period of time 
in seconds into a more readable format.

resourceFromKey Used to get the resource of the ticketing sample 
field.

returnDateAsString Returns the given date in milliseconds in the date 
format as it appears in the .resources file.

returnDateAsStringInSec Returns the given date in seconds in to the date 
format as it appears in the .resources file.

returnNumOfDigitAfter
Point 

Formats the given string and returns a string that 
shows only 3 digit after the point.

returnNumOfDigitAfter
Point(digits) 

Formats the given string and returns a decimal 
number. The number of digits after the decimal 
point is specified in (digits).

returnNumOfDigitAfter
PointWithDollar 

Converts the given string into a decimal number 
with 3 digits after the decimal point preceded by a 
dollar sign. 

returnNumOfDigitAfter
PointWithEuro 

Converts the given string into a decimal number 
with 3 digits after the decimal point followed by a 
Euro sign. 

returnWithPercentSign Converts the given string into a decimal number 
with 3 digits after the decimal point followed by a 
percentage sign. 

toLowerCase Returns the lowercase of the given string.

toLowerCase_encode Works in the same way as toLowerCase but adds 
escaping on the return value.

Formatting Methods Description
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New/Edit KPI Parameter Dialog Box

This dialog box enables you to customize tooltip colors, text colors, and 
status icons for KPIs.

User interface elements are described below:

To access In the Edit KPI dialog box > KPI Parameters area, click 
the New button to enter new parameters or click the 
relevant Edit button to modify an existing parameter.

Important 
information

The KPI parameter details vary depending on the 
presentation type (bar, text, or icon), as described in 
the following section.

The Key, From, and To fields should be changed 
following instructions from HP Software Support.

Relevant tasks "How to Customize a KPI Template in the Repository" 
on page 653

UI Element (A-Z) Description

Bar Icon If presentation type is a bar: Select the bar icon that is 
assigned to the KPI when the KPI value is within the 
range specified in the From/To fields, using the 
following options:

➤ Selection. Select a bar from the list of predefined bar 
icons.

➤ Other. Enter the path to a custom bar icon. For 
details, see "How to Change the KPI Status Icons" on 
page 441.

From/To Internal calculation values for the KPI. When the 
calculated value of a KPI is in the range indicated by 
the From and To fields, the tooltip for the KPI is 
assigned the color specified in the Color field, and the 
KPI is assigned the status icon specified in the Icon 
field.

Key Internal name of the KPI parameter.



Chapter 21 • KPI Repository

679

Restore Defaults Dialog Box

This dialog box enables you to restore predefined KPI settings, for KPIs 
whose type is Predefined (Customized).

Status Icon If presentation type is an icon: Select the icon that is 
assigned to the KPI when the KPI value is within the 
range specified in the From/To fields, using the 
following options:

➤ Selection. Select an icon from the list of predefined 
icons.

➤ Other. Enter the path to a custom status icon. For 
details, see "How to Change the KPI Status Icons" on 
page 441.

Text Color If presentation type is text: Select a color for the text in 
the tooltip using the drop-down color palette. 

Tooltip Color Select a color for the tooltip’s header and border using 
the drop-down color palette. 

To access In the Edit KPI dialog box, click the Restore Defaults 
button.

Relevant tasks "How to Customize a KPI Template in the Repository" 
on page 653

UI Element (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

<Modified fields> The KPI definition fields that have been modified are 
automatically selected. 

Select the fields which you want restored to default, 
and click Save.
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➤ How to Create or Edit an ETI or HI Template in the Indicator Repository 
on page 689
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➤ Indicator Repository User Interface on page 692
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Concepts

Indicator Repository Overview

The indicator repository contains templates for the event type indicators 
(ETIs) and health indicators (HIs) associated with each of the CI types (CITs) 
in your system. These templates include the names of the indicators that 
can be assigned to a CI based on its CIT, possible states and statuses for each 
indicator, as well as other details. HI definitions in the repository also 
determine whether an event is displayed in the Event Browser when an HI is 
assigned to a CI, or when its status is updated.

For an introduction to health indicators, see "Health Indicators and KPIs - 
Overview" on page 115.

BSM uses HI status and value to set KPI status and value for your monitored 
CIs. For details, see "KPI and HI Calculation" on page 397.

When an HI is created via the Assignment mechanism, or when it is 
manually assigned to a CI, its definitions are taken from the HI templates in 
the indicator repository.

Advanced users can modify these ETI or HI templates, and add new 
indicator templates to CITs, to customize how this information is calculated 
and presented in BSM.

➤ For an introduction to these indicator types see "Events, ETIs, and HIs - 
Overview" on page 683.

➤ For an overview of how the indicator repository is used to assign ETIs and 
HIs to CIs, and to set an indicator’s status, see "How the Indicator 
Repository is Used by BSM" on page 685.
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Note: The indicator repository contains templates for creating ETIs that can 
be viewed in Operations Manager i, and for creating HIs in Service Health 
and Service Level Management. You can therefore access the indicator 
repository from within Operations Manager i, Service Health, and Service 
Level Management administration. The repository is identical in each of 
these applications.

Because HIs and ETIs can be added to your BSM environment at any time 
using content packs, a complete list of HIs and ETIs is beyond the scope of 
this documentation. To see which HIs and ETIs are defined in your system, 
open the indicator repository as described in the following chapter. This 
chapter presents an overview of these indicators, and describes how to work 
with the indicator repository.

Events, ETIs, and HIs - Overview

The following section provides an overview of events, event type indicators 
(ETIs), and health indicators (HIs). 

For details on how the indicator repository is used to set ETI or HI status, see 
"How the Indicator Repository is Used by BSM" on page 685.

This section includes the following:

➤ "Events" on page 684

➤ "ETIs" on page 684

➤ "HIs" on page 685
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Events
When a significant event occurs in your environment, monitoring tools 
such as Operations Management and NNMi may send an event sample 
containing details about the event to the BSM event subsystem. The event 
subsystem is the part of BSM that handles events, assigns status to events, 
and displays events in the Event Browser.

For example, suppose the CPU load on a server in your environment 
exceeds a predefined threshold of 80%. If this machine is monitored by 
monitoring tools (such as SiteScope), one or more of these tools may send 
an event sample to BSM containing details on the event.

ETIs
Multiple data collectors may send event samples regarding a single event to 
BSM. The event subsystem generalizes these events into a common language 
using ETIs; ETIs are categorizations of events according to the type of 
occurrence (for example, CPU load passing a threshold). 

Each CI type (CIT) has various ETI templates within the indicator repository, 
which define which things on a CI are of interest, and may be monitored by 
BSM.

ETI mapping rules within Operations Manager i map events to ETIs. In the 
above example, when the CPU load threshold is breached on your server, an 
event sample is sent to BSM. Based on the text strings in this event sample, 
it is assigned an ETI of CPU Load. 

For details, refer to "Event Type Indicators" in Using Operations Management.
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HIs
HIs provide fine-grained measurements for the CIs that represent your 
monitored business elements and processes. Some HIs display business 
metrics such as backlog and volume, while others display various 
measurements of performance and availability.

HI status is set by two types of data: event samples (for example, CPU load 
exceeded threshold), and metric samples (for example, response time = 6 
milliseconds). Some data collectors such as SiteScope send event samples to 
BSM, while other such as Real User Monitor send samples containing 
metrics. Status for HIs is set as follows:

➤ Event-based HIs use event data to generate HI status; for example, using 
the indicator repository you can define that if the state of a particular 
event is Major, the corresponding HI status is Warning.

➤ Metric-based HIs apply calculation rules to the metrics sent by the data 
collectors, to create an aggregated HI value. For example, an HI can collect 
response times for a CI over a collection cycle, and calculate average 
response time for the cycle.

Within the indicator repository, you can configure an HI to send an event to 
the Event Browser when its status changes, showing that the HI’s status has 
changed on a CI.

How the Indicator Repository is Used by BSM

When an event occurs in your monitored environment, a monitoring tool 
sends an event sample to the BSM event subsystem. Each event sample 
identifies the CI where the event occurred, and has a name and a state; for 
example, Event name = CPULoad; State = High.

When an event comes to BSM it is associated with a CI. Within the indicator 
repository, if the CIT of this CI does not have a corresponding ETI or HI 
template, the event is considered informational, and no indicator is 
assigned.

If the CIT has a corresponding ETI or HI template defined in the indicator 
repository, and the event’s state is one of the states defined in the repository, 
the event is assigned an ETI or HI with a corresponding status.
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This section includes the following:

➤ "Mapping Events to ETIs and Event-Based HIs" on page 686

➤ "Mapping Events to Metric-Based HIs" on page 687

Note: Definitions for each CIT also include inheritance patterns, so that 
indicator definitions on a parent CIT are also relevant for all its descendant 
CITs.

Mapping Events to ETIs and Event-Based HIs
An event is mapped to an ETI or an event-based HI as follows:

➤ ETI. An event can match an ETI definition either if a text string in the 
event sample has an explicit ETI field, or if ETI mapping rules in 
Operations Manager i define that this event sample is mapped to a 
particular ETI. 

If an event matches an ETI definition but not an HI definition, the event 
is assigned an ETI, and it is displayed in the Event Browser. This has no 
impact on the CI’s status in BSM.

➤ Event-Based HIs. If an event’s ETI also has a corresponding HI definition, 
an HI is assigned to the CI. If the HI already exists on the CI, its status is 
updated. The HI gets a state and status as defined in the HI definition in 
the indicator repository.



Chapter 22 • Indicator Repository

687

Mapping Events to Metric-Based HIs
When an HI is based on an event, the state and status of the HI are taken 
directly from the corresponding ETI. When an HI is based on a metric 
sample, the state and status of the HI are based on business rule calculations 
performed on the sample data.

When working with Service Health or Service Level Management, the 
indicator repository enables you to modify an HI’s default business rule, as 
well as state and status mappings, as follows:

➤ Each HI template in the indicator repository is defined as applicable for 
Service Health, for Service Level Management, or for both applications.

➤ The indicator repository also specifies the default business rule of the HI, 
for the application where the HI is applicable. The rule’s thresholds are 
defined in the business rule repository. 

For details on the Service Health rules, see "List of Calculation Rules in 
Service Health" on page 740. For details on the Service Level Management 
rules, see "List of Service Level Management Business Rules" in Using 
Service Level Management.

➤ The indicator repository provides mapping between the status generated 
by the rule, and the HI’s state. You can assign any text to these states; for 
example you might assign the HI state of Very Low Availability with the 
status level of Warning.

HI definitions in the indicator repository also determine whether an event is 
created within BSM when a metric-based HI is assigned to a CI within 
Service Health, or when the status of an HI changes on a CI.
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Mapping SiteScope Severities to HI States

Metrics in SiteScope can have three possible severities: Error, Warning, and 
Good.

HIs in Service Health can have many states; for example, when measuring 
CPU Load an HI's state might be Bottlenecked or Busy, whereas when 
measuring Memory Load an HI's state might be Paging or Starving for 
Memory.

In addition, each HI can have one of the following status levels: Critical, 
Major, Minor, Warning, Normal, and Unknown.

It is therefore necessary to map the severity of each SiteScope metric to its 
corresponding HI’s state and status, as follows:

SiteScope monitors that have a defined topology and default mapping, also 
have an HI state and status that is assigned to the metric status by default. 
Indicator states are assigned to the metric status according to the closest 
available status that exists in the states, for the indicator associated with the 
metric. 

For example, when measuring percent used on a Memory monitor, the 
metric is mapped to Major status in the Error threshold, since Critical status 
is not available for the Memory Load indicator. When measuring round trip 
time on a Ping monitor, the closest status level in the Warning threshold is 
Major, since the Minor status level does not exist for this indicator state. The 
Good threshold is always mapped to the Normal status level.

Indicator mapping for each monitor is defined within SiteScope in the HP 
Integration Settings pane. For details, refer to the SiteScope Help. For general 
information about metric to HI mapping in BSM, see "Indicator Assignments 
Overview" in Using System Availability Management.
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Tasks

How to Create or Edit an ETI or HI Template in the 
Indicator Repository

The following section describes how to customize an ETI or HI template in 
the indicator repository.

Note: The indicator repository contains templates for creating ETIs that can 
be viewed in Operations Management, and for creating HIs in Service 
Health and Service Level Management. You can therefore access the 
indicator repository from within Operations Management, Service Health, 
and Service Level Management administration. The repository is identical in 
each of these applications.

This task includes the following steps:

➤ "Open an ETI or HI template for editing" on page 689

➤ "Define ETI or HI details" on page 691

➤ "Results" on page 691

 1 Open an ETI or HI template for editing

 a Select Admin> Service Health / Service Level Management > 
Repositories > Indicators. The left side of the page contains a CIT 
hierarchy.

 b Select a CIT from the left pane to display its assigned indicators in the 
Indicators pane. When you select an indicator, its details are displayed 
in the right pane. 
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ETIs and HIs have different icons; the following image shows an 
example of an ETI, and of an HI.

 c Add a new ETI or HI template to the selected CIT, or edit an assigned 
indicator template, as follows:

➤ To add a new indicator template, click the New Indicator button, 
and select one of the dropdown options: Health Indicator or Event 
Type Indicator. 

➤ To edit an indicator template, select an ETI or HI from the Indicators 
pane and click the Edit Indicator button.

➤ To convert an ETI to an HI or an HI to an ETI, select the indicator 
and click the corresponding button: Convert to Health Indicator 
and Edit, or Convert to Event Type Indicator and Edit. 

For example, this is useful if a predefined ETI is indicative of CI 
health within your particular environment (ETI > HI), or if a 
predefined HI is not indicative of CI health in your environment (HI 
> ETI).

Note: Each indicator in a subtree must have a unique name. For example, 
if you create an indicator on the Node CIT, you cannot use the same 
name for another indicator on the Computer CIT.
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 2 Define ETI or HI details

Within the dialog box labeled New/Edit Event Type Indicator/Health 
Indicator, define possible states for the indicator, as well as other indicator 
details, as follows:

➤ ETIs. Each ETI must have at least one state defined. When creating a 
new ETI, one state is automatically created (Normal); you can modify 
this as needed. For ETI user interface details, see "New ETI/Edit ETI 
Dialog Box" on page 696.

➤ HIs. Each HI must have at least two states defined; a state with Normal 
status must be defined as the default state. When creating a new HI, 
two states are automatically created: Normal, and Critical. You can 
modify this as needed.

When defining an HI, specify which application will consume the HI: 
Service Health, Service Level Management, or both. For each 
application consuming the HI, define the default HI calculation rule. 
For HI user interface details, see "New Health Indicator/Edit Health 
Indicator Dialog Box" on page 698.

If you are defining an HI in Service Health, and you want to send an 
event to the Event Browser when the HI’s status changes, select the 
Generate Events check box. The event parameters are defined by 
default; to view or modify the event parameters click Configure 
Events. For user interface details, see "Event Configuration Dialog Box" 
on page 703.

 3 Results

After you save the indicator, it is assigned to the selected CIT (and to its 
child CITs). The indicator details appear in the Details pane.
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Reference

Indicator Repository User Interface

This section includes:

 ➤ Indicator Repository page on page 693

 ➤ New ETI/Edit ETI Dialog Box on page 696

 ➤ New Health Indicator/Edit Health Indicator Dialog Box on page 698

 ➤ New Indicator State/Edit Indicator State Dialog Box on page 702

 ➤ Event Configuration Dialog Box on page 703
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Indicator Repository page

This page displays the ETIs and health indicators (HIs) assigned to each of 
the CITs in your system. The Indicator repository enables an advanced user 
to modify existing indicator definitions, and to create new ones.

CIT Hierarchy

The left area of the Indicator Repository page contains a hierarchy of the 
CITs in your system. Select a CIT to view or modify its assigned ETIs and HIs.

CITs with a grey background have one or more indicators that are assigned 
directly to them; CITs without a grey background either have no indicators, 
or have indicators inherited from higher-level CITs.

To access The indicator repository can be accessed from one of 
the following:

➤ Admin > Service Health > Repositories > Indicators

➤ Admin > Service Level Management > Repositories > 
Indicators

Important 
information

Select a CIT in the left pane to display its assigned ETIs 
and HIs in the Indicators pane.

Select an ETI or HI in the Indicators pane to display its 
details in the Details pane on the right side of the page.

To modify an indicator, select it in the Indicators pane 
and click the Edit Indicator button, or right-click the 
indicator and access the Edit Indicator menu 
command. For user interface details, see "New ETI/Edit 
ETI Dialog Box" on page 696, or "New Health 
Indicator/Edit Health Indicator Dialog Box" on 
page 698.

Relevant tasks "How to Create or Edit an ETI or HI Template in the 
Indicator Repository" on page 689

See also ➤ "Indicator Repository Overview" on page 682

➤ "Events, ETIs, and HIs - Overview" on page 683
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Indicators Pane

This pane displays the ETIs and HIs assigned to the selected CIT.

User interface elements are described below:

UI Element (A-Z) Description

New Indicator. Click to create a new indicator; a 
dropdown menu enables you to define a new HI or a 
new ETI.

Edit Indicator. Click to edit the details of a selected HI 
or ETI. 

Convert to Health Indicator and Edit. Select an ETI, 
then click to convert the ETI to an HI. A dialog box 
opens to define the HI. For user interface details, see 
"New Health Indicator/Edit Health Indicator Dialog 
Box" on page 698.

Convert to Event Type Indicator and Edit. Select an HI, 
then click to convert the HI to an ETI. A dialog box 
opens to define the ETI. For user interface details, see 
"New ETI/Edit ETI Dialog Box" on page 696.

Delete Indicator. Deletes the selected indicator. If you 
delete an indicator on a child CIT that was inherited 
from a parent CIT, you are actually deleting it from the 
parent CIT. As a result, this indicator is no longer 
inherited on the child CITs.

Note: Only user-defined (custom) indicators can be 
deleted.

Restore to Default. Select an edited indicator whose 
Type is Predefined (Customized), and click to restore it 
to its original settings.
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Details Pane

This pane displays details regarding the ETI or HI selected in the Indicators 
pane. The contents of this pane vary depending on the Indicator 
definitions. The following section provides a general description of this 
pane. For details on ETI-related fields, see "New ETI/Edit ETI Dialog Box" on 
page 696. For details on the HI-related fields, see "New Health Indicator/Edit 
Health Indicator Dialog Box" on page 698.

User interface elements are described below:

Refresh. Click to refresh the display.

<ETI or HI> Each line in the pane shows an ETI or HI assigned to 
the selected CIT (this label is defined by the indicator’s 
Display Name field).

Select an indicator to display or modify its definitions. 
For user interface details, see "New ETI/Edit ETI Dialog 
Box" on page 696, or "New Health Indicator/Edit 
Health Indicator Dialog Box" on page 698.

Note: If a CIT inherits an indicator from its parent CIT, 
the name of the parent CIT appears in parentheses 
after the indicator name. For example, the Node CIT is 
the parent of the Computer CIT. If the Node CIT is 
assigned the CPU Load ETI, the Computer CIT will 
contain an ETI labeled CPU Load (Node).

UI Element Description

General area General information regarding the ETI or HI:

➤ Name, type, and description are defined for all 
indicators. 

➤ Application and units are relevant for HIs only.

States area Table showing the possible states for each indicator, 
the status that corresponds to each state, and the icon 
that corresponds to each status.

UI Element (A-Z) Description
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New ETI/Edit ETI Dialog Box

This dialog box enables you to define ETI details.

General Area

User interface elements are described below:

Service Health area If an HI is applicable for the Service Health application, 
this section shows whether the indicator generates 
events, and which rule is used to calculate the 
indicator.

SLM area If an HI is applicable for the Service Level Management 
application, this section displays the rule used to 
calculate the indicator.

ETI Mapping Rules 
area

If an ETI uses mapping rules, they are displayed in this 
section. For details, refer to Using Operations 
Management.

To access In the Indicators Repository page, perform one of the 
following:

➤ Click the New Event Type Indicator button.

➤ Select an ETI and click the Edit Indicator button.

➤ Select an HI and click the Convert to Event Type 
Indicator and Edit button.

Relevant tasks "How to Create or Edit an ETI or HI Template in the 
Indicator Repository" on page 689

UI Element (A-Z) Description

Description Optional text describing the ETI.

Display Name The external name of the ETI, as it is displayed in the 
UI (for example CPU Load).

UI Element Description
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States Area

This area shows the possible ETI states, and the mappings between each 
state and its corresponding status and icon. Each ETI must have at least one 
state defined.

User interface elements are described below:

ID The ETI’s internal unique identifier (this only appears 
when you edit an existing ETI).

Name The internal name of the ETI, as defined in the event 
generating the ETI (for example CPULoad).

Type The indicator type (automatically defined as Event 
Type Indicator.)

UI Element (A-Z) Description

New Indicator State. Click to create a new state for the 
ETI.

Edit Indicator State. Click to edit the details of a 
selected state.

Delete Indicator State. Click to delete one or more 
selected states.

Select all. Select all the ETI states.

Clear Selection. Clear the selection of ETI states.

Display Name The state of the ETI as defined in the event (for 
example, Very high CPU).

UI Element (A-Z) Description
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New Health Indicator/Edit Health Indicator Dialog Box

This dialog box enables you to define HI details.

General Area

User interface elements are described below:

Icon The icon corresponding to the ETI severity. 

Standard icons appear by default; if you want to use 
custom icons, place them in the following directory: 
<Gateway server root directory>\AppServer\ 
webapps\site.war\images\gui\severities

Note: The following formats are supported for custom 
icons: .png, .jpg and .gif.

Severity The severity corresponding to the ETI’s state (for 
example, Warning).

To access In the Indicators Repository page, perform one of the 
following:

➤ Click the New Health Indicator button.

➤ Select an HI and click the Edit Indicator button.

➤ Select an ETI and click the Convert to Health 
Indicator and Edit button.

Relevant tasks "How to Create or Edit an ETI or HI Template in the 
Indicator Repository" on page 689

UI Element (A-Z) Description

Application Specify which application displays this HI: Service 
Health, Service Level Management, or both.

For details, see "How the Indicator Repository is Used 
by BSM" on page 685.

Description Optional text describing the HI.

UI Element (A-Z) Description
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States Area

This area shows the possible HI states, and the mappings between each state 
and its corresponding status and icon. Each HI must have at least two states. 
A state with Normal status must be defined as the default state.

User interface elements are described below:

Display Name The external name of the HI, as displayed in the UI (for 
example CPU Load).

ID The HI’s internal unique identifier (this only appears 
when you edit an existing HI).

Name The internal name of the HI, as defined in the event 
generating the HI (for example CPULoad).

Note: The name cannot contain blank spaces.

Type The indicator type (automatically defined as HI with 
associated ETI).

Units The type of unit applicable to the rule results displayed 
in the HI. Typical units are:

➤ <No unit>. For rules that handle volume, where 
measurements represent a simple numerical count.

➤ Financial ($). For rules that determine financial loss 
for a CI.

➤ Milliseconds or Seconds. For rules that handle 
performance time data for a transaction or monitor.

➤ Percentage (%). For rules that handle availability 
over time data.

UI Element (A-Z) Description

New Indicator State. Click to create a new state for the 
HI.

Edit Indicator State. Click to edit the details of a 
selected state.

UI Element (A-Z) Description
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Delete Indicator State. Click to delete one or more 
selected states.

Select all. Select all the HI states.

Clear Selection. Clear the selection of HI states.

Icon The icon corresponding to the HI status. 

Standard icons appear by default; if you want to use 
custom icons, place them in the following directory: 
<Gateway server root directory>\AppServer\ 
webapps\site.war\images\gui\severities

Note: The following formats are supported for custom 
icons: .png, .jpg and .gif.

State The state or the HI as defined in the event (for 
example, Very high CPU).

This field also indicates which is the default state for 
the HI; each HI must have a default state.

Status The status corresponding to the HI’s state (for example, 
Warning).

UI Element (A-Z) Description
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Service Health Area

This area appears if you select Service Health or both in the Application 
field.

User interface elements are described below:

UI Element (A-Z) Description

Configure Events This button is enabled when you select the Generate 
Events check box. Click to open the Event 
Configuration dialog box, which enables you to define 
the event sent to the Event Browser when the HI’s 
status changes. For details, see "Event Configuration 
Dialog Box" on page 703.

Default Rule Select the rule which is used to calculate the HI’s status.

For descriptions of the default rules available in Service 
Health, see "List of Calculation Rules in Service Health" 
on page 740.

Formatting Method Define the method for formatting the value of the HI 
(when relevant), using the following options:

➤ Selection. Select a formatting method from the list 
of available methods (leave blank if not required). 
For details, see "List of Formatting Methods" on 
page 676.

➤ Other. Specify a method that you have defined, 
which is not on the list of available methods.

Generate Events Select this check box if you want the HI to generate an 
event to the Event Browser whenever its status 
changes.

Status and 
Default State

If you have assigned more than one state to a specific 
status in the State area, you must specify which is the 
default state for the status.

For example, the status Critical might be assigned to 
two different states (in two different state definitions): 
Very High and Very Low. In this case, use the drop-
down menu to select which state is assigned by default 
when the HI’s status is Critical.
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Service Level Management Area

This area appears if you select Service Level Management or both in the 
Application field.

User interface element described below:

New Indicator State/Edit Indicator State Dialog Box

This dialog box enables you to add or modify HI states. Each state is mapped 
to a status.

User interface elements are described below:

UI Element (A-Z) Description

Default Rule Select the rule which is used to calculate the HI’s status.

For descriptions of the default rules, see "List of Service 
Level Management Business Rules" in Using Service Level 
Management.

To access Open the New/Edit Health Indicator dialog box. 
Within the State area, click New to enter a new state, 
or click Edit to modify a state.

Relevant tasks "How to Create or Edit an ETI or HI Template in the 
Indicator Repository" on page 689

UI Element (A-Z) Description

Default Select this check box to define the HI’s default state. 

This is the state that is used by Operations Manager i 
when you restore the HI to default.

Display Name The external name of the state, as it is displayed in the 
UI.
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Event Configuration Dialog Box

This dialog box enables you to modify the definitions of the event sent to 
the Event Browser when the status of a metric-based HI changes in Service 
Health.

Icon The icon corresponding to the state’s status.

Standard icons appear by default; if you want to use 
custom icons, place them in the following directory: 
<Gateway server root directory>\AppServer\ 
webapps\site.war\images\gui\severities

Note: The following formats are supported for custom 
icons: .png, .jpg and .gif.

ID The state’s unique internal identifier (this only appears 
when you edit an existing state).

Name The internal name of the state, as defined in the event 
generating the HI.

Status The HI state’s status (for example, Warning).

To access In the New Health Indicator/Edit Health Indicator 
dialog box, select the Generate Events check box and 
click the Configure Events button.

Important 
information

You can drag attributes from the Attributes area or click 
Ctrl+i while editing text to insert the selected attribute.

When an event is triggered, these attributes are 
changed into the relevant value of the attribute of the 
event.

Relevant tasks "How to Create or Edit an ETI or HI Template in the 
Indicator Repository" on page 689

See also "CI Status Template Repository Dialog Box" on 
page 543

UI Element (A-Z) Description
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General Tab

This tab enables you to edit an existing event template. Select the relevant 
attribute in the Attributes area and drag it into the relevant box in the 
General tab.

UI Element (A-Z) Description

General area

Category Used to organize or group events; by default this is blank.

Description Information describing the event; by default this is blank.

Event Type Indicator Assigns an ETI to the event.

Default: 
<<health_indicator_name>>:<<health_indicator_state>>:<<
health_indicator_value>>

Log only By default this is false; the event is sent to the Event 
Subsystem as a regular event.

Assign true to set the event’s Life Cycle State to close 
from the beginning of its life cycle.

Severity The severity of the event is taken by default from the 
severity of the ETI.

Default: <<eti_severity>>

Subcategory More detailed organization of events that have the same 
category; by default this is blank.

Title Text describing the occurrence represented by the event.

Default: <<ci_name>>:<<health_indicator_display_label>> 
status changed from <<health_indicator_previous_status>> 
to <<health_indicator_new_status>>

Correlation area

Close key pattern Enables the event that is sent, to close all the events 
whose Key attribute matches the Close Key Pattern 
expression. You can use wildcards (*).

Default: <<ci_id>>:<<health_indicator_name>><*>



Chapter 22 • Indicator Repository

705

Custom Attributes Tab

Use this tab to add custom attributes.

Key A unique string representing the type of event that 
occurred. Two events have the same key if, and only if, 
the two events represent the same situation in the 
managed environment. Events with the same key are 
treated as duplicates.

Default: 
<<bsm_server_name>>:<<ci_id>>:<<health_indicator_nam
e>>:<<health_indicator_new_status_value>>

Submit close key 
condition

By default this is selected; you must enter a value in the 
Close key pattern box.

Advanced Parameters area

CI hint Information about the CI that is related to the event.

Default: UCMDB:<<ci_id>>

Generating source 
hint

Information about the monitoring application.

Default: <<bsm_server_name>>

Host hint Information about the CI of type Host that is hosting the 
CI related to the event; by default this is blank.

Important 
information

A custom attribute consists of a key and a value (both 
are strings). The value can be any string and is used by 
the event mapping as any other value.

For details about custom attributes, see Using Operations 
Management.

UI Element (A-Z) Description
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User interface elements are described below:

UI Element Description

Name and Value Each event can have any number of custom attributes. 
Custom attributes can be used to provide additional 
information with the event that is not provided in any of 
the other event attributes or that is contained in any of 
the other attributes. Each custom attribute is a Name-
Value pair, where you enter the name of the attribute in 
the Name field and the value of the attribute in the Value 
field.

Creates a new event template. You can select:

➤ New key. To create a new key. A new row opens in the 
Name/Value table.

➤ Known key. Opens a submenu with the known keys as 
options. You can select the relevant key. A new row 
opens in the Name/Value table, with the name of the 
selected key in the Name column. You can then enter 
the value of the key in the corresponding Value 
column. 

Note: The known keys are defined in Operations 
Manager i. For details, see Using Operations Management.

Deletes the selected attributes from the table.
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Attributes Area

Select the relevant attribute and drag it into the relevant box in the General 
tab or in the Custom Attribute tab.

The event attributes for events triggered by metric-based HIs in Service 
Health are as follows:

Attribute Description

<<bsm_server_
name>>

The name of the Business Service Management server 
where the event is generated.

<<ci_id>> The ID of the CI where the HI is assigned.

<<ci_name>> The name of the CI where the HI is assigned.

<<health_indicator_
display_label>>

The external name of the HI.

<<health_indicator_
name>>

The internal identifier of the HI.

<<health_indicator_
new_status>>

The current status of the HI in Service Health.

<<health_indicator_
new_status_value>>

The current value of the HI’s status in Service Health 
(for example Very Slow).

<<health_indicator_
previous_status>>

The previous status of the HI.

<<eti_severity>> The current severity of the ETI.

<<health_indicator_
state>>

The current state of the HI in Service Health.

<<health_indicator_
value>>

The current value of the HI in Service Health (for 
example 18 ms. response time).
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Business Rule Repository

This chapter includes:

Concepts

➤ Business Rule Repository Overview on page 711

➤ Health Indicator and KPI Calculation Rules on page 713

➤ Sample-Based and Time-Based Sampling on page 715

➤ Understanding the Percentage Rule on page 716

➤ Understanding the Generic Formula Rule on page 720

➤ No Data Timeout for Transaction CIs on page 723

Tasks

➤ How to Customize a Business Rule Template in the Repository 
on page 724

➤ How to Create a Customized Generic Sample Rule – Example on page 729

➤ How to Create a Customized Generic Sum of Values Over Time Rule – 
Example on page 731

➤ How to Use the Generic Two Arguments Rule – Example on page 732

➤ How to Set Up Rules to Display the Last Sample Details on page 734

➤ How to Save Measurements Data on page 736

➤ How to Display Information from a CI Attribute in a Tooltip on page 737

Reference

➤ List of Calculation Rules in Service Health on page 740

➤ List of Rule Parameters on page 845
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➤ List of Tooltip Parameters on page 853

➤ Example of EUM Weighted Average Rule on page 865

➤ Examples of Tooltips on page 867

➤ Business Rules User Interface on page 868

Troubleshooting and Limitations on page 890
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Concepts

Business Rule Repository Overview

A business rule is the basic object that receives events (either samples or 
application messages), deals with processing the data, and holds the process 
results. Some business rules are based on sample data, and are used to 
calculate health indicators (HIs). Other rules calculate key performance 
indicators (KPIs), based on the status or value of HIs and of other KPIs.

The Business Rule Repository page contains templates for the rules available 
throughout Service Health. These rule templates are implemented by Service 
Health, so that when the assignment mechanism assigns a specific HI or KPI 
to a discovered CI, the KPI or HI is calculated based on the rule template in 
the repository. For details, see "Assignment and Propagation Overview" on 
page 558.

Advanced users can modify existing rules and create new rules to customize 
how information is presented. For example, you may want to create new 
rules when integrating data from a new external system into Service Health.

Within the Business Rule Repository, rules are categorized as follows: 

➤ Predefined. Out-of-the-box rules.

➤ Predefined (Customized). Out-of-the-box rules that have been edited.

➤ Custom. New or cloned rules.

For a list of the out-of-the-box rules, see "List of Calculation Rules in Service 
Health" on page 740. For details on editing rules, see "How to Customize a 
Business Rule Template in the Repository" on page 724.

Some rules are for use only by Service Health, and are not available for use in 
custom views.

You can use the Rules API to create new rules; for details see "Service Health 
Rules API" on page 947.
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This section also includes the following topics:

➤ "Rule Parameters" on page 712

➤ "Global Rule Parameters" on page 712

➤ "Tooltips" on page 712

Rule Parameters
Each rule’s parameters are used to define input for the rule. The values used 
for the parameters can be fixed values (defined within the parameter 
definition) or referenced values taken from the samples. 

The rule parameters are defined in the Business Rule Repository, as part of 
each rule definition. For a list of rule parameters, see each rule parameter 
description in "List of Rule Parameters" on page 845.

Global Rule Parameters
You can modify various global parameters for trend and history status in the 
Business Rule Repository, as follows:

➤ You can specify if you want trend, history, or both displayed for CIs.

➤ You can change the window of time used for trend and history 
calculations.

➤ You can specify the calculation type for history status.

For details, see "Global Parameters Dialog Box" on page 880.

Note that the global parameters can be overridden by defining a different 
value for the relevant parameter within a specific rule.

Tooltips
Each indicator on a CI has a Details tooltip to display additional 
information for the CI. Tooltips are assigned to CIs according to the rule 
used for the indicator.
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Each tooltip includes parameters which correspond to the type of 
information displayed in the tooltip. For a list of tooltip parameters and 
their descriptions, see "List of Tooltip Parameters" on page 853.

The order of the parameters in the tooltip definition corresponds to the 
order of the information in the displayed tooltip. For information about 
defining/editing tooltip parameters, see "New/Edit Tooltip Parameter Dialog 
Box" on page 878.

Health Indicator and KPI Calculation Rules

There are two types of business rules. Some rules are used for calculating 
health indicators, and others are used for calculating KPIs, as described in 
the following sections.

This section includes the following topics:

➤ "Health Indicator Calculation Rules" on page 713

➤ "KPI Calculation Rules" on page 713

➤ "The calc_method and hi_list Rule Parameters in KPI Rules" on page 714

Health Indicator Calculation Rules
HI calculation rules calculate a measurement for an HI based on original 
sample data that is caught by the HI selector. BSM receives incoming metrics 
using one of the data collectors such as SiteScope, Business Process Monitor, 
or Real User Monitor. 

The content packs for each of these data collectors defines the assignment, 
which determines which indicators are relevant for each CI type. Based on 
their CI types, each monitored CI has a default set of HIs that include a rule, 
and a predefined selector.

KPI Calculation Rules
KPI calculation rules, also known as group rules, determine KPI status based 
on data received from other KPIs or HIs, rather than from original sample 
data. The received data can come from the KPIs of child CIs, or from other 
KPIs or HIs associated with the same CI.
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The group rules vary in the type of logic they use to arrive at a status result. 
For example:

➤ The rule may select a KPI status held by one of the child CIs, and apply 
that status to the parent, as done by the Worst Status Rule.

➤ The rule may aggregate the received data to calculate a measurement, and 
compare the measurement with defined thresholds, as done by the Sum 
of Values Rule.

➤ The rule may calculate a measurement based on the status of another KPI 
for the CI, and compare the measurement with defined thresholds, as 
done by the Real Time Impact Rule when receiving status from the 
Application Availability KPI.

Each KPI has been assigned a default business rule that is used when you 
attach a new KPI to a CI; the default is generally one of the group rules for 
that KPI. When editing a KPI or attaching a new KPI, you can select a 
different rule from the list of rules that are applicable for that KPI. 

If a KPI is associated with a logical CI then the rule that calculates the status 
and value of this KPI is probably a group rule – it uses the KPIs of other CIs 
to calculate its own status and value (for example: Worst Status rule).

The calc_method and hi_list Rule Parameters in KPI Rules
KPIs are calculated using group rules, based on data received from other KPIs 
or HIs. Group rules must always contain the following rule parameters: 
calc_method and hi_list.

The calc_method parameter defines how the rule calculates the KPI. The 
parameter should be of type Integer, and it can contain values from 0-3, as 
follows:

➤ 0. The KPI is set by HIs and child KPIs; this is the default value for out-of-
the-box group rules.

➤ 1. The KPI is set by HIs only.

➤ 2. The KPI is set by child KPIs.

➤ 3. The KPI is set by HIs; if none exist, use child KPIs.
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The hi_list parameter defines which HIs are used in the KPI calculation. This 
parameter should be of type String; by default this field is empty. If you 
enter HIs in this field make sure you use valid HI names, and separate HIs 
with commas.

If you create a new group rule you must add these rule parameters; the 
parameter names are case sensitive.

Note: In the New/Edit Rule Parameter dialog box, you define whether each 
rule parameter is configurable; this means that the parameter is displayed in 
the Assignments and in the CI Indicators tabs. For details, see "New/Edit 
Rule Parameter or New/Edit Rule Threshold Dialog Box" on page 877. 

Unlike other rule parameters, the hi_list and calc_method parameters are 
not affected by this Configurable flag; they are always configurable if they 
exist.

Sample-Based and Time-Based Sampling

HI rules are time-based or sample-based. The time-based sampling is more 
accurate than the sample-based sampling when samples are not taken 
regularly; for example, SiteScope sampling accelerates when a problem 
occurs. When samples are taken regularly, time-based and sample-based 
sampling provide the same results.

If you have the following sample:

 

The result of the first part of the sampling period is 5. After that the result of 
each sampling period is 2. 
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The sample-based result is calculated as follows: 
(5+8x2)/9= 2.33 
The samplings are as follows: 1 sampling with the value 5 and 8 samplings 
with the value 2. The total number of samplings is 9.

The time-based result is calculated as follows: 
(30x5+30x2)/60=3.5
During 30 seconds the value was 5. During the next 30 seconds the value 
was 2. The total sampling time was 60 seconds.

Note: There is also a time and amount-based calculation method that works 
on the same basis as time-based, but takes into account the amount (value) 
received in the sample as a proportion of the total amount.

Understanding the Percentage Rule

When the Percentage rule is defined as the KPI rule for a parent group, the 
group is assigned a KPI status based on a percentage calculated from the 
child CIs in the group. If required, significant relationships between CIs 
(usually between the parent CI and one of the child CIs) can be weighted 
(Weight option), so that they have more impact on the percentage 
calculation. You can also define dominant status (Must option) for a 
relationship between CIs (usually between the parent CI and one of the 
child CIs), so that a child CI with low status in the dominant relationship 
influences the status of the group.

Note: For all percentage calculation methods, the number of gray child CIs 
(Informational, No data, Stopped, or Downtime statuses) is ignored in the 
final calculation of the parent group score.

The different applications of the Percentage Rule are described in the 
following sections.
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This section includes the following topics:

➤ "Basic Percentage Rule" on page 717

➤ "Weighted Percentage" on page 718

➤ "Dominant Child" on page 719

Basic Percentage Rule 
When using the Percentage Rule, parent group status is based on a 
percentage (the score for the group), calculated from the number of child 
CIs with red, orange, olive, green, or yellow status. Gray statuses are not 
taken into consideration. (Note that if any of the child CIs are weighted, this 
influences the percentage calculation, as described in Weighted Percentage, 
below.)

Each status has a value, as follows:

Each value is multiplied by the number of children in the group that have 
that status, and the results are totaled and divided by the number of 
children in the calculation, to give an average result. For example, in a 
group of four CIs, two with red status and two with yellow status, the 
calculation would be as follows: 

Status Value

red 0

orange 5

yellow 10

olive 15

green 20

2 x 0 (red)
2 x 10 (yellow)
Total = 20/4 (number of red and yellow children) = 5 (average result
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The average result is then divided by 20 (corresponding to the green status 
value) and multiplied by 100, to give the percentage score for the group: 

The score determines the status for the parent group according to thresholds 
defined for the KPI. For details, see "KPI and HI Thresholds" on page 401. 

When you assign the Percentage rule to a KPI, the tooltip for the KPI in 
Service Health displays the percentage score for the group and the 
Percentage rule thresholds.

Weighted Percentage 
By default relationships are not weighted (weight = 1). You can change the 
default weight for a relationship in the weight box, accessed in the Define 
Configuration Item Relationship window (described in "New CI/New 
Related CI Dialog Box" in the Modeling Guide). 

When a child CIs in a group, is in a relationship with a weight greater than 
1, then the percentage calculations described in Basic Percentage Rule, are 
adjusted to take the weight into account. Each CI status value is multiplied 
by the weight assigned to the CI, and the total is divided by the total weight 
values, to give the average result. 

For example, taking the same group that was used for the basic percentage 
example (four CIs, two with red status and two with yellow status), if one of 
the red CIs has a weight of 4 and one of the yellow CIs has a weight of 2, 
then the average result calculation looks like this:

(5/20) x 100 = 25% (score)
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1 x 4 x 0 (red with weight=4)
1 x 1 x 0 (red with weight=1 )
1 x 2 x 10 (yellow with weight=2)
1 x 1 x 10 (yellow with weight=1)
Total = 30/(4+1+2+1) (total weight values for red and yellow children) = 
3.75 (average result)

The percentage score for the group is then calculated in the same way as for 
the basic Percentage Rule: average result is divided by 20 and multiplied by 
100:

Note that CI weights are relevant only when the parent group status is 
calculated using the Percentage Rule.

Tip: You can display the weight information in the KPI tooltip in Top View. 
For details, see "Customize Top View tooltips" on page 158.

Dominant Child 
By default, all CIs are in non-dominant relationships (must is cleared). You 
can change the setting for a relationship to dominant in the Define 
Configuration Item Relationship window (described in "New CI/New 
Related CI Dialog Box" in the Modeling Guide).

When a child CIs in a group is in a dominant relationship, then status is 
calculated for the group by comparing the results from the following two 
status calculation methods:

➤ Service Health determines the lowest status held among all dominant CIs.

➤ Service Health determines group status according to the percentage rule 
calculation (as described in Basic Percentage Rule above).

The worst status from the two calculations becomes the status for the group. 

(3.75/20) x 100 = 18.75% (score)
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When the group status has been taken from the lowest status held by a 
dominant CI, the tooltip for the parent group displays Score: n/a (Using 
dominant child).

Note: 

➤ Dominant CIs are only relevant when the group is using the Percentage 
Rule to calculate status.

➤ When a CI has both dominant and weighted child CIs only the 
dominant CI is taken into consideration when calculating the status of 
the parent CI using the Percentage rule.

Understanding the Generic Formula Rule

This rule can be used to add new business logic behavior to calculate HIs in 
Service Health. You can use the rule to create a set of calculation methods 
(sum, count, average, and so on) that can be applied to every type of sample: 
legacy (SiteScope, Business Process Monitor, and Real User Monitor) and 
Enterprise Management Systems (EMS) samples.

In Service Health, the rule is time-based and the formula calculates a single 
aggregated result of all of the specified data collected during the period 
specified in the duration parameter.
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Note: 

➤ Using the Generic Formula rule might have an impact on performance as 
the rule parses and evaluates string expressions. Using this rule should be 
considered carefully only when no other rule answers the requirements 
and when the application does not include large amounts of monitor 
nodes.

➤ There is no automatic validation to check if the formula supports the 
collected sample structure. There is no automatic validation for the 
correctness or syntax of the formula. If there is a mistake in the formula, 
the status of the HI appears as a gray icon in Service Health. 

For example, use this rule to calculate the average of a sample field over a 
period of time multiplied by 2, or the sum of the values of a sample field 
over the specified period of time, divided by the number of values of 
another field.

Using the Generic Formula Rule
To use the Generic Formula rule, clone it and give the clone a meaningful 
name. You can then customize the cloned rule, attach the rule to an HI, and 
assign the HI to a CI in a view.

To edit the formula, click the Edit button for the Formula parameter, and 
enter the formula that you want the rule to use in the Default Value field. 
For more details, see "New/Edit Rule Parameter or New/Edit Rule Threshold 
Dialog Box" on page 877.

The formula is based on operands, operators, functions, constants, and 
sample field values. The formula must use only fields from the selected 
samples; you must know the name of the variables in the sample on which 
you want to run the formula. The samples for the rule depend on the 
specific HI’s selector, therefore the formula must support the collected 
sample structure.
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The rule takes values from the specified samples during the time period 
specified in the duration parameter, puts those values in the aggregated 
formula, and compares the result with the specified thresholds.

Any valid Service Health sample is valid for this rule.

The formula language is based on the Generic Reporting Engine parser 
language to be consistent with the open formula writing. For more 
information, see "Working with the Generic Reporting Engine API" in 
Reports.

The formula must always be an aggregated formula. It should contain 
aggregation functions and mathematical operators between them. The 
operands can either be constant numbers or aggregation functions.

The formula elements are:

➤ supported operators: *, +, -, /, ( )

➤ supported aggregation functions: sum, min, max, avg, count, stddev, 
sumofsqr

➤ supported manipulation function: if 

The rule calculates a single numeric value based on the samples collected 
during the duration. The value is then evaluated according to the given 
thresholds and the status is set accordingly. 

For an example of how to create a customized Generic Formula rule, see 
"Examples – Generic Formula Rule" on page 726.
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No Data Timeout for Transaction CIs

Rules that calculate HIs contain a No data timeout property in their rule 
parameters. This property defines the number of seconds from the time the 
last sample was received for the HI, until the HI is timed out—at which 
point the HI changes to decay status (gray). 

The default value for the No data timeout property is generally taken from 
the rule definitions as defined in the Business Rule Repository. However, for 
Business Process Monitor transaction CIs, Service Health calculates a No 
data timeout value based on the schedule for running the transaction. The 
calculation takes the schedule interval (defined in End User Management 
Administration) for the business process profile that contains the 
transaction (default value = 15 minutes) and adds an additional 90 seconds. 
For example, for a transaction with a schedule interval of 15 minutes, the 
No data timeout value is 990 seconds. (For details on defining the profile 
schedule, see "Edit Data Collector Settings Dialog Box" in Using End User 
Management.) 

This calculation method means that the timeout value is automatically 
adjusted to align with changes made to the profile schedule interval in End 
User Management Administration, so that the KPI is not incorrectly timed 
out. If there is more than one scheduling scheme in effect, the following 
rules are used for the calculation:

➤ If multiple schedules are defined for a profile running on a Business 
Process Monitor instance, the largest schedule interval is used (all 
schedules are treated equally, whether they apply to the whole week or 
part of the week).

➤ If the profile is assigned to several locations, each with a different 
schedule, the smallest interval from the locations is used (after first 
applying the rule above).
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Tasks

How to Customize a Business Rule Template in the 
Repository

The following section describes how to customize a business rule template 
in the Rule Repository.

Tip: HP Professional Services offers best practice consulting; it is 
recommended that you use this service before making any changes to the 
repositories. For information about how to obtain this service, contact your 
HP Software Support representative.

This section also includes the following:

➤ "Open a rule template for editing" on page 725

➤ "Define a rule’s name, description, or class" on page 725

➤ "Select applicable CI types" on page 725

➤ "Modify rule parameters or thresholds" on page 726

➤ "Modify global rule parameters" on page 727

➤ "Modify tooltip settings" on page 727

➤ "Set a rule and its parameters back to default" on page 729
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 1 Open a rule template for editing

Select Admin> Service Health > Repositories > Business Rules. Open a rule 
template for editing using one of the following:

➤ New Rule. Creates a rule that is not based on an existing rule. The new 
rule will be labeled Custom. To create a new rule, click the New Rule 
button in the Business Rule Repository page.

➤ Clone Rule. Creates a rule by cloning an existing rule. The original rule 
is still available, and the new cloned rule can be modified. To clone a 
rule, select a rule in the Business Rule Repository page and click the 
Clone Rule button. The new rule will be labeled Custom. Select the 
new rule and click the Edit Rule button to open it for editing.

➤ Edit Rule. Modifies an existing rule. To edit a rule, select a rule in the 
Business Rule Repository page and click the Edit Rule button. If you 
edit a predefined rule, it will be labeled Predefined (Customized).

For user interface details, see "New Rule/Edit Rule Dialog Box" on 
page 871.

 2 Define a rule’s name, description, or class

Define a rule’s name or description in the New Rule/Edit Rule dialog box 
> General Rule Settings area.

If you create a new rule which uses a new Java class, define the class in 
this area as well.

 3 Select applicable CI types

In the New Rule/Edit Rule dialog box > Advanced Rule Settings area, you 
can select the CI types for which the rule can be applied.

For example, if you clone a rule and the new rule is applicable for business 
transactions, select the Business Transaction CIT and click the 
corresponding arrow to move it to the Selected CI Types list.
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 4 Modify rule parameters or thresholds

You can modify existing information or enter new information about the 
parameters and thresholds for a specific rule, using the New Rule/Edit 
Rule dialog box > Rule Parameters and Rule Thresholds area. For user 
interface details, see "New/Edit Rule Parameter or New/Edit Rule 
Threshold Dialog Box" on page 877.

Note: If you are creating a customized Generic Sample rule, a Generic 
Sum of Values Over Time rule, or a Generic Two Arguments rule, and the 
name of the time stamp field in the sample is not time_stamp, in the Rule 
Parameters area click Edit for the Time Stamp Field parameter. In the 
Default Value box, enter the name of the sample’s time stamp field. The 
type of the sample’s time stamp field must be time.

Examples – Generic Formula Rule

The following formula calculates the average of the dResponseTime 
sample field value over the specified period of time, multiplied by 2:

Avg(dResponseTime)*2

In the following formula, you want to sum only the response time of the 
successful transactions, therefore only the response time for samples with 
u_iStatus=0 is taken into consideration. u_iStatus=1 when the transaction 
fails, and u_iStatus=0 when the transaction is successful. 

The formula calculates the sum of the values of the dResponseTime 
sample field value over the specified period of time, where the value of 
dResponseTime is set to 0 every time the value of the u_iStatus sample 
field equals 1. This sum is divided by the sum of values calculated as 
follows: the value is equal to 1 when the u_iStatus field value is 0, and the 
value equals 0 when the u_iStatus field value is different from 0. This 
formula calculates the performance of a certain transaction by 
aggregating the response time of all of the successful transaction and 
dividing it by the number of successful transactions:

sum(if(u_iStatus,=,0,dResponseTime,0))/sum(if(u_iStatus,=,0,1,0)
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 5 Modify global rule parameters

To globally edit a parameter for all predefined rules, click the Edit Globals 
button on the Rule Repository page, and modify the appropriate 
parameters. For user interface details, see "Global Parameters Dialog Box" 
on page 880.

Tip: To override global parameter values for an individual rule, add the 
relevant parameter to the rule, and modify its value.

 6 Modify tooltip settings

➤ Basic Settings. You can modify a tooltip’s description or maximum 
length in the New Rule/Edit Rule dialog box > Tooltip Settings area.

➤ Tooltip Parameters. In the New Rule/Edit Rule dialog box > Tooltip 
Parameters area, you can modify existing information or enter new 
information about a tooltip’s parameters. For user interface details, see 
"New/Edit Tooltip Parameter Dialog Box" on page 878.
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Example: Add a Last Sample Time Entry in a Tooltip

To display the last time the sampling was made in a tooltip, the last sample 
information must be available. For details, see "How to Set Up Rules to Display the 
Last Sample Details" on page 734. 

Note: The last sample time is not necessarily the same as the last update time 
because the last sampling might not have any impact on the status. Last Sample 
Time can only be added to the tooltip of monitor rules.

1  Within the Rule Repository, select the rule whose tooltip you want to modify, 
and open it for editing. In the Tooltip Parameters area, click New to open the 
New Tooltip Parameter dialog box.

2  In the Display Label box, enter Last Sample Time. 

3  In the Value Source box, enter NODE.DIM.SAMPLE.time_stamp.

4  in the Formatting Method box, select returnDateAsStringInSec.

The tooltip displays the following information:
728



Chapter 23 • Business Rule Repository
 7 Set a rule and its parameters back to default

If you have modified a predefined rule (for example if you changed the 
applicable CI types), you might want to return the rule and its parameters 
to their defaults.

Note that this is only applicable for rules whose type is Predefined 
(Customized).

 a Within the Business Rule Repository page, open a predefined 
(customized) rule for editing, and click the Restore Defaults button.

For details on the user interface, see "Restore Defaults Dialog Box" on 
page 880.

 b The rule definition fields that have been modified are automatically 
selected. Select the fields which you want to restore to default, and 
click Save.

How to Create a Customized Generic Sample Rule – 
Example

This example shows how to use the Generic Sample rule. In this example, 
the value of a selected value field in the event sample and specific thresholds 
are compared, so the status of the HI is gray when the value of the sample 
field is less than 1 and larger than 5. 

To display the comparison, clone and edit the Generic Sample Rule, and 
assign this rule to an HI on the appropriate CI.

To create a clone of the Generic Sample rule:

 1 Select Admin> Service Health > Repositories > Business Rules. Select the 
Generic Sample Rule and click Clone.

 2 Open the new rule for editing.

 3 In the Name box, enter Value Event rule as the name of the cloned rule.

 4 In the Rule Parameters area, open the Field Name parameter for editing.
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 5 In the Default Value box, specify the name of the sample field (value) on 
which to apply the rule. The field must have a numeric value. Save the 
change.

Note: The units of the thresholds and of the field value must be the same. 
The result is provided with the same unit too.

 6 If required, modify the default thresholds in the Rule Thresholds area 
(values from 1 to 5 are colored, values less than 1 or more than 5 are 
colored gray). Click the Edit button for each threshold parameter and 
enter the threshold value in the Default Value box (critical, 5; major, 4; 
minor, 3; warning, 2; OK, 1). For details, see "New/Edit Rule Parameter or 
New/Edit Rule Threshold Dialog Box" on page 877.

To attach the custom rule to an HI assigned to a CI:

 1 Select Admin> Service Health > CI Indicators.

 2 Select a view.

 3 Select the CI to which you want to attach the HI.

 4 In the CI Data pane, select the Health Indicators tab, and click Add Health 
Indicator.

 5 Select an HI, and in the Business Rule list, select the Value Event rule you 
just created.

 6 In the Business Rules Parameters area, if required, specify the rule 
parameters.

 7 in the Thresholds area, enter the thresholds.

 8 In the Selector area, enter event as the name of the sample in the Value 
box that corresponds to the sampleType Field, and enter the other values 
corresponding to the other reference properties that the selector 
expression searches for in the incoming data samples sent from the data 
source. For details on the event sample, see "Sample: Event (event)" in 
Reports. When done, save your changes.
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How to Create a Customized Generic Sum of Values Over 
Time Rule – Example

You want to add the value of the u_iSumNetTime field in the trans_t sample 
for all the trans_t samples that arrive during the time period specified in the 
duration parameter. To display the value you must clone and edit the 
Generic Sum of Values Over Time rule, and assign the new rule to an HI on 
the appropriate CI.

To create a clone of the Generic Sum of Values Over Time rule:

 1 Select Admin> Service Health > Repositories > Business Rules. Select the 
Generic Sum of Values Over Time Rule and click Clone.

 2 Open the new rule for editing.

 3 In the Name box, enter u_iSumNetTime Sum rule as the new name for the 
cloned rule.

 4 In the Rule Parameters area:

 a Open the Field Name parameter for editing. In the Default Value box, 
specify the name of the field (u_iSumNetTime) on which to apply the 
rule. The field must have a numeric value. Save the change.

Note: The units of the thresholds and of the field value must be the 
same. The result is provided with the same unit too.

 b If required, modify the duration parameter to define the sampling 
duration, in seconds. The default is 15 minutes (900 seconds).

 5 If required, modify thresholds in the Threshold Parameters area. For 
details, see "New/Edit Rule Parameter or New/Edit Rule Threshold Dialog 
Box" on page 877. The units of the thresholds and of the field value must 
be the same. The result is provided with the same unit too.

 6 Save the changes.
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To attach the customized rule to an HI on a CI:

 1 Select Admin> Service Health > CI Indicators.

 2 Select a view.

 3 Select the CI to which you want to attach the HI.

 4 In the CI Data pane, select the Health Indicators tab, and click Add Health 
Indicator.

 5 Select an HI, and in the Business Rule list, select the u_iSumNetTime Sum 
rule you just created.

 6 Save the changes.

How to Use the Generic Two Arguments Rule – Example

You want to display the sum of Sum of component connection times in the 
transaction breakdown and Sum of component DNS times in the transaction 
breakdown sample field values from the trans_t sample. To display the sum 
you must clone and edit the Generic Two Arguments Rule rule, and assign 
the rule to an HI on the appropriate CI.

To create a customized Generic Two Arguments Rule:

 1 Select Admin> Service Health > Repositories > Business Rules. Select the 
Generic Two Arguments Rule and click Clone.

 2 Open the new rule for editing.

 3 In the Name box, enter Sum_Connect_DNS_Time rule as the new name for 
the cloned rule.

 4 In the Rule Parameters area:

 a Open the First Field Name parameter for editing. In the Default Value 
box, specify u_iSumConnectionTime as the name of the first sample field 
on which to apply the rule. The field must have a numeric value. Save 
the change.

 b Open the Second Field Name parameter for editing. In the Default 
Value box, specify u_iSumDnsTime as the name of the second sample 
field on which to apply the rule. The field must have a numeric value. 
Save the change.
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Note: The units of the thresholds and of the field value must be the 
same. The result is provided with the same unit too.

 c If required, modify the duration parameter to define the sampling 
duration, in seconds. The default is 15 minutes (900 seconds).

 d Open the Operator parameter for editing, and in the Default value 
box, specify the operator (+) you want to use. 

 5 Modify thresholds in the Threshold Parameters area as needed. For 
details, see "New/Edit Rule Parameter or New/Edit Rule Threshold Dialog 
Box" on page 877.

Note: The units of the thresholds and of the field value must be the same. 
The result is provided with the same unit too.

 6 Save the changes.

To assign the customized rule to an HI on a CI:

 1 Select Admin> Service Health > CI Indicators.

 2 Select a view.

 3 Select the CI to which you want to attach the HI.

 4 In the CI Data pane, select the Health Indicators tab, and click Add Health 
Indicator.

 5 Select an HI, and in the Business Rule list, select the 
Sum_Connect_DNS_Time rule you just created.

 6 Save the changes.
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How to Set Up Rules to Display the Last Sample Details 

You can set up rules to save details from the last sample received for a CI, so 
that these details can be viewed in the Sample Details window for the CI or 
in tooltips in Service Health. For details on how to display the last sample 
information, see "How to View Sample Details" on page 73.

Note: Storing last sample details may require use of a large amount of 
memory, slowing down Service Health performance.

Last sample details are kept in memory using the saveLastSample property. 
You can use this property to store sample details only for specific CI KPIs, or 
for all KPIs.
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To save the last sample details, you can:

➤ Set the property for an individual business rule. Edit the rule in the 
Business Rule Repository. In the Edit Rule dialog box > Rule Parameters 
area, add the parameter saveLastSample with Type=Boolean and Default 
Value=true.

➤ Set the property for all business rules. Click the Edit Globals button in the 
Business Rule Repository to view the Global Parameters list. Edit the 
saveLastSample parameter to change its value to true (default setting is 
false).

For details on editing global parameters, see "Global Parameters Dialog Box" 
on page 880.
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How to Save Measurements Data

If required, the Save KPI data over time for this CI option (see "CI Indicators 
Tab" on page 453) can be used to save calculated measurements for each of 
the CI KPIs, at 15 minute intervals. 

This is done by activating the saveValuesToPersistency global parameter in 
the Business Rule Repository. You can also change the default interval by 
modifying the value of the saveValuesToPersistencyInterval option. 

For user interface details, see "New/Edit Global Parameter Dialog Box" on 
page 885.

Example:

 1 Access the Service Health Administration > Repositories > Business Rules 
page.

 2 Click Edit Globals.

 3 In the Global Parameters list, select saveValuesToPersistency and click the 
Edit button.

 4 In the displayed Edit Global Parameter window, change the Value 
parameter from false to true.

 5 Click OK.

 6 To change the default interval (900 seconds) for collecting measurements 
data, in the Global Parameters list, select 
saveValuesToPersistencyInterval. Click the Edit button, and modify the 
value.

Note: To avoid overloading the database storage, it is recommended that 
you do not define a shorter default interval value.
736



Chapter 23 • Business Rule Repository
How to Display Information from a CI Attribute in a 
Tooltip

You can edit tooltip definitions of a CI or a calculation rule, so that the 
tooltip displays information contained in a CI’s attribute in the RTSM.

For example, if you have an attribute defined in the RTSM for contact 
information or CI description, you can use the following procedure to 
display this information in the CI’s tooltip.

 1 Access Admin > Platform > Setup and Maintenance > Infrastructure 
Settings > Foundations > RTSM.

 2 In the RTSM General Settings table, edit the Object Root parameter and 
define its value as root.

 3 Log in to BSM again.

 4 Access Admin > RTSM Administration > Modeling > CI Type Manager.

 5 Right-click the Data CIT (below Root), and select Export to XML.

 6 Open the exported file in a text editor, and locate the attribute you want 
displayed in the tooltip. For example, if you want the Description 
attribute displayed, locate the following section:

<Attribute name=""description" type="string" display-name="Description" 
description="Description" size="1000">

<Attribute-Qualifiers>
<Attribute-Qualifier name="BDM_SCOPE"/>

</Attribute-Qualifiers>
</Attribute>

 7 To enable Service Health to display the attribute, add the 
DASH_ATTRIBUTE qualifier:

<Attribute-Qualifiers>
<Attribute-Qualifier name="BDM_SCOPE"/>
<Attribute-Qualifier name="DASH_ATTRIBUTE"/>

</Attribute-Qualifiers>

 8 Save the edited XML, and import the file back to the RTSM.
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 9 Within Service Health Administration, open the Business Rules 
Repository, and proceed as follows:

➤ To add the attribute to CI status tooltips, click Edit Global Tooltips, and 
open the cidata tooltip for editing.

➤ To add the attribute to tooltips of KPIs calculated with a specific rule 
(for example Worst Status rule), open the rule for editing.

 10 In the Tooltip Parameters area, create a new parameter. Use a relevant 
name (for example Description). In Value source, enter 
NODE.PROPS.<attribute name>. For example:

 11 Save your changes. 

If you added the parameter to global CI tooltips, the attribute now 
appears on CI status tooltips:
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If you added the parameter to a business rule’s tooltip, the attribute now 
appears on KPI tooltips which use this rule:
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Reference

List of Calculation Rules in Service Health

Within the Business Rule Repository, each of the out-of-the-box rules is 
assigned to a domain, based on the data for which it is relevant. The 
following section provides details for each of the rules. The rules are divided 
according to their domains.

For details on rule parameters, see "List of Rule Parameters" on page 845. For 
details on tooltip parameters, see "List of Tooltip Parameters" on page 853.

This section includes the following:

➤ "Business Process Insight Calculation Rules" on page 741

➤ "BTM Calculation Rules" on page 764

➤ "Diagnostics Calculation Rules" on page 778

➤ "End User Management Calculation Rules" on page 783

➤ "General Calculation Rules" on page 810

➤ "Integrations Calculation Rules" on page 822

➤ "SAP Calculation Rules" on page 825

➤ "SAP/Siebel Calculation Rules" on page 826

➤ "Service Manager Calculation Rules" on page 828

➤ "Siebel Calculation Rules" on page 829

➤ "SiteScope Calculation Rules" on page 830

➤ "SOA Calculation Rules" on page 839
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Business Process Insight Calculation Rules

Rule (Rule #) Description

BPI Active Status 
Percentage Rule for 
Duration Monitor

(629)

Calculates the percentage of active BPI monitor instances with a status 
equal or better than the status specified in the PassedStatus parameter of 
the rule, relative to the number of backlog instances in the sample; the 
status is derived from the objectives set for the rule.

Example: If PassedStatus is defined as 10 (minor), all instances with status 
10 or more are PassedStatus instances. In the following example, the 
instances that correspond to the criteria are: 1 instance with OK status, 10 
instances with the warning status, and 5 instances with the minor status. 
The rule returns: (1+10+5)/(1+10+5+15+10)=40%.

Rule Parameters: 

"PassedStatus" on page 850

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Score" on page 861

"Status for" on page 862

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

"Min Status" on page 859

Instances Weight Value

critical 10 1 0

major 15 1 5

minor 5 1 10

warning 10 1 15

OK 1 1 20
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BPI Average Active 
Weighted Status Rule 
for Duration Monitor 

(628)

Calculates the average weighted status of active BPI duration monitor 
instances.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Critical instances" on page 855

"Major instances" on page 858

"Minor instances" on page 859

"Warning instances" on page 864

"OK Instances" on page 860

BPI Average Duration 

(3000)

Calculates the average duration for the instances completed in the last 
measurement period for a business process, business activity or duration 
business process monitor.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Value" on page 863

"Count" on page 855

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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BPI Average Weighted 
Status Rule for 
Duration Monitor 

(623)

You can specify status weights using the rule parameters in the rule 
definition. The rule calculates the following value:
sum (instances x  x weight x status) / sum (instances x weight)

The resulting value is a number between 0 and 20 that is translated to the 
closest status and represented by a colored icon.

Example: Information about the number of instances per status is 
provided by Business Process Insight. The weights are the rule parameters. 
The value for each status is calculated by the BPI Average Weighted Status 
rule.

The result of the rule calculation is: 
(20*1*0+15*1*5+5*1*10+10*1*15+1*1*20)/
(20*1+15*1+5*1+10*1+1*1)=5,784 -> 5 is the nearest status which is 
Major.

Rule Parameters: 

"OK weight" on page 849

"Warning Weight" on page 852

"Minor weight" on page 848

"Major weight" on page 848

"Critical weight" on page 846

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Critical instances" on page 855

"Major instances" on page 858

"Minor instances" on page 859

"Warning instances" on page 864

"OK Instances" on page 860

Rule (Rule #) Description

Number of 
Instances

Weight Status

critical 20 1 0

major 15 1 5

minor 5 1 10

warning 10 1 15

OK 1 1 20
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BPI Average Weighted 
Status Rule for Value 
Monitor 

(611)

You can specify status weights using the rule parameters in the rule 
definition. The rule calculates the following value:
sum (instances x weight x status)/
sum (instances x weight)

The resulting value is a number between 0 and 20 that is translated to the 
closest status and represented by a colored icon.

Example: Information about the value of instances per status is provided 
by Business Process Insight. The weights are the rule parameters. The 
value for each status is calculated by the BPI Average Weighted Status 
rule.

The result of the rule calculation is: 
(20*1*0+15*1*5+5*1*10+10*1*15+1*1*20)/(20*1+15*1+5*1+10*1+1*1)=5,
784 -> 5 is the nearest status which is Major.

Rule Parameters: 

"OK weight" on page 849

"Warning Weight" on page 852

"Minor weight" on page 848

"Major weight" on page 848

"Critical weight" on page 846

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Critical instances" on page 855

"Major instances" on page 858

"Minor instances" on page 859

"Warning instances" on page 864

"OK Instances" on page 860

Rule (Rule #) Description

Number of 
Instances

Weight Status

critical 20 1 0

major 15 1 5

minor 5 1 10

warning 10 1 15

OK 1 1 20
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BPI Backlog Count 
Rule 

(604)

Calculates the number of instances that are currently passing through 
one of the following:

➤ One Business Activity (when the Backlog KPI is assigned to a BPI 
Business Activity CI).

➤ A group of BP Activities (when the Backlog KPI is assigned to a Business 
Process Scope CI representing a BPI Value Monitor, a BPI Duration 
Monitor, or a BPI Custom Monitor).

➤ A Business Process (when the Backlog KPI is assigned to a Business 
Process CI).

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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BPI Backlog Value Rule 

(605)

Calculates the value/cost of the instances that are currently passing 
through one of the following:

➤ One Business Activity (when the Backlog KPI is assigned to a BPI 
Business Activity CI).

➤ A group of BP Activities (when the Backlog KPI is assigned to a Business 
Process Scope CI representing a BPI Value Monitor, a BPI Duration 
Monitor, or a BPI Custom Monitor).

➤ A Business Process (when the Backlog KPI is assigned to a Business 
Process CI).

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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BPI Business Impact 
Average Weighted 
Status Count Rule 

(614)

You can specify status weights using the rule parameters in the rule 
definition. The rule calculates the following value:
sum (instances x weight x status)/sum (instances x weight)

The resulting value is a number between 0 and 20 that is translated to the 
closest status and displayed as the color of the tooltip. 

A group bar displays the number of instances per instance status up to the 
Business Process CI level. 

Example: The number of instances per BPI status and the BPI statuses are 
provided by Business Process Insight. The weight information is taken 
from the values of the rule parameters. The value for each status is 
calculated by the rule.

The result of the rule calculation is: 
(3*1*20 + 5*2*10 + 4*1*0)/(3*1+5*2+4*1) = 160/17 = 9.411 which is 
converted into 10 = Minor Service Health status and displayed in the 
tooltip.

The groupbar displays the number of instances with each status (3 
Healthy, 5 At Risk, 4 Blocked).

Rule Parameters: 

"HealthyWeight" on page 847

"AtRiskWeight" on page 845

"BlockedWeight" on page 845

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Blocked backlog" on page 854

"At risk backlog" on page 853

"Healthy backlog" on page 857

Rule (Rule #) Description

Number of 
Instances

Weight Status

Healthy 3 1 20

At Risk 5 2 10

Blocked 4 1 0
747



Chapter 23 • Business Rule Repository
BPI Business Impact 
Average Weighted 
Status Value Rule 

(617)

You can specify status weights using the rule parameters in the rule 
definition. The rule calculates the following value:
sum (instances x weight x status) / sum (instances x weight)

The resulting value is a number between 0 and 20 that is translated to the 
closest status and displayed as the color of the tooltip. 

A group bar displays the sum of values of the instances per status up to 
the Business Process CI level.

Example: The number of instances per BPI status and the BPI statuses are 
provided by Business Process Insight. The weight information is taken 
from the values of the rule parameters. The cost for each status is 
calculated by the rule.

The result of the rule calculation is: 
(1000*1*20 + 1500*2*10 + 700*1*0)/
(1000*1+1500*2+700*1) = 10.63 which is converted into 10 = Minor 
Service Health status.

The groupbar displays the sum of values per status (1000 for instances 
with Healthy status, 1500 for instances with At Risk status, and 700 for 
instances with Blocked status).

Rule Parameters: 

"HealthyWeight" on page 847

"AtRiskWeight" on page 845

"BlockedWeight" on page 845

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Blocked backlog" on page 854

"At risk backlog" on page 853

"Healthy backlog" on page 857

Rule (Rule #) Description

Sum of 
Value

Weight Status

Healthy $1000 1 20

At Risk $1500 2 10

Blocked $700 1 0
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BPI Business Impact 
Status Percentage 
Count Rule 

(615)

The rule calculates the percentage of instances with a status equal or 
better than the status specified in the PassedStatus parameter of the rule, 
relative to the total number of instances in the sample; the status is 
derived from the thresholds set for the rule. 

A group bar displays the sum of values of the instances per status up to 
the Business Process CI level.

Example: If PassedStatus is defined as 20 (OK/Healthy), all instances with 
status 20 or more are PassedStatus instances. In the example, 10 
instances match the criteria. The rule returns: (10)/(10+12+8)=25% which 
is then compared to the thresholds and translated into a status.

Rule Parameters: 

"PassedStatus" on page 850

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Score" on page 861

"Status for" on page 862

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

"Min Status" on page 859

Rule (Rule #) Description

BPI Statuses from 
HP Business Process 
Insight

Number of 
Instances

Healthy (20 OK) 10

At Risk (10 Minor) 12

Blocked (0 Critical) 8
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BPI Business Impact 
Status Percentage 
Value Rule 

(618)

The rule calculates the number of instances with a status equal or better 
than the status specified in the PassedStatus parameter of the rule, 
relative to the total number of instances in the sample; the status is 
derived from the thresholds set for the rule. 

A group bar displays the sum of values per instance status up to the 
Business Process CI level.

Example: If PassedStatus is defined as 20 (OK/Healthy), all instances with 
status 20 or more are PassedStatus instances. The rule returns: 
($1000)/(1000+5000+500)=15% which is then compared to the 
thresholds and translated into a status.

Rule Parameters: 

"PassedStatus" on page 850

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Score" on page 861

"Status for" on page 862

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

"Min Status" on page 859

Rule (Rule #) Description

BPI Statuses from 
HP Business 
Process Insight

Cost

Healthy (20 OK) $1000

At Risk (10 Minor) $5000

Blocked (0 Critical) $500
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BPI Business Impact 
Worst Process 
Instances Count Rule 

(613)

The samples sent by Business Process Insight, includes the number of 
instances for each status (Healthy, At Risk and Blocked), where the 
statuses are calculated by Business Process Insight. 

The rule searches for the worst status in the sample.

Example: If the sample contains instances with status:

➤ Blocked then the rule returns Critical status.

➤ At Risk then the rule returns Minor status.

If the sample contains instances with other statuses, the status returned is 
OK.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Blocked backlog" on page 854

"At risk backlog" on page 853

"Healthy backlog" on page 857

Rule (Rule #) Description
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BPI Business Impact 
Worst Process 
Instances Value Rule 

(616)

The samples sent by Business Process Insight, includes the number of 
instances for each status (Healthy, At Risk and Blocked), where the 
statuses are calculated by Business Process Insight. 

The rule searches for the worst status in the sample.

Example: If the sample contains instances with status:

➤ Blocked and a non-zero value then the rule returns Critical status.

➤ At Risk and a non-zero value then the rule returns Minor status.

If the sample contains instances with other statuses, the status returned is 
OK.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Blocked backlog" on page 854

"At risk backlog" on page 853

"Healthy backlog" on page 857

BPI Maximum 
Duration 

(3002)

Calculates the maximum duration for the instances completed in the last 
measurement period for a business process, business activity or duration 
business process monitor.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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BPI Minimum 
Duration 

(3001)

Calculates the minimum duration for the instances completed in the last 
measurement period for a business process, business activity or duration 
business process monitor.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

BPI Process Average 
Value 

(3003)

Calculates the average value for the instances completed in the last 
measurement period for a business process or business activity.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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BPI Process Maximum 
Value Rule 

(3005)

Calculates the maximum value for the instances completed in the last 
measurement period for a business process or business activity.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

BPI Process Minimum 
Value Rule 

(3004)

Calculates the minimum value for the instances completed in the last 
measurement period for a business process or business activity.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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BPI Scope Average 
Value 

(3007)

Calculates the average value for the instances completed in the last 
measurement period for a value or custom business process monitor.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

BPI Scope Maximum 
Value Rule 

(3010)

Calculates the maximum value for the instances completed in the last 
measurement period for a value or custom business process monitor.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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BPI Scope Minimum 
Value Rule 

(3009)

Calculates the minimum value for the instances completed in the last 
measurement period for a value or custom business process monitor.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

BPI Scope Weighted 
Average Duration 

(3006)

Calculates the weighted average duration for the instances completed in 
the last measurement period for a duration business process monitor.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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BPI Scope Weighted 
Average Value 

(3008)

Calculates the weighted average value for the instances completed in the 
last measurement period for a value or custom business process monitor.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
757



Chapter 23 • Business Rule Repository
BPI Status Percentage 
Rule for Duration 
Monitor 

(624)

The rule calculates the percentage of instances with a status equal or 
better than the status specified in the PassedStatus parameter of the rule, 
relative to the total number of instances in the sample; the status is 
derived from the thresholds set for the rule. 

Example: If PassedStatus is defined as 10 (minor), all instances with status 
10 or more are PassedStatus instances. In the following example, the 
instances that correspond to the criteria are: 1 instance with OK status, 10 
instances with the warning status, and 5 instances with the minor status. 
The rule returns: (1+10+5)/(1+10+5+15+10)=40%.

Rule Parameters: 

"PassedStatus" on page 850

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Score" on page 861

"Status for" on page 862

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

"Min Status" on page 859

Rule (Rule #) Description

Instances Weight Value

critical 10 1 0

major 15 1 5

minor 5 1 10

warning 10 1 15

OK 1 1 20
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BPI Status Percentage 
Rule for Value Monitor 

(612)

The rule calculates the percentage of instances with a status equal or 
better than the status specified in the PassedStatus parameter of the rule, 
relative to the total number of instances in the sample; the status is 
derived from the thresholds set for the rule. 

Example: If PassedStatus is defined as 10 (minor), all instances with status 
10 or more are PassedStatus instances. In the following example, the 
instances that correspond to the criteria are: 1 instance with OK status, 10 
instances with the warning status, and 5 instances with the minor status. 
The rule returns: (1+10+5)/(1+10+5+15+10)=40%.

Rule Parameters: 

"PassedStatus" on page 850

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Score" on page 861

"Status for" on page 862

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

"Min Status" on page 859

Rule (Rule #) Description

Instances Weight Value

critical 10 1 0

major 15 1 5

minor 5 1 10

warning 10 1 15

OK 1 1 20
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BPI Volume Count 
Rule 

(606)

The sample contains the number of completed instances in the most 
recent collection interval.

Calculates the number of the instances in the sample, that completed 
passing through one of the following:

➤ One Business Activity (when the Backlog KPI is assigned to a BPI 
Business Activity CI).

➤ A group of BP Activities (when the Backlog KPI is assigned to a Business 
Process Scope CI representing a BPI Value Monitor, a BPI Duration 
Monitor, or a BPI Custom Monitor).

➤ A Business Process (when the Backlog KPI is assigned to a Business 
Process CI).

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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BPI Volume Value Rule 

(607)

Calculates the value/cost of the instances that are currently passing 
through one of the following:

➤ One Business Activity (when the Backlog KPI is assigned to a BPI 
Business Activity CI).

➤ A group of BP Activities (when the Backlog KPI is assigned to a Business 
Process Scope CI representing a BPI Value Monitor, a BPI Duration 
Monitor, or a BPI Custom Monitor).

➤ A Business Process (when the Backlog KPI is assigned to a Business 
Process CI).

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Count" on page 855

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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BPI Worst Active 
Violated Instances 
Rule for Duration 
Monitor 

(627)

Displays the number of active BPI monitor instances for the worst status 
(Minor, Major, and so on), where the statuses are calculated by Business 
Process Insight.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Critical instances" on page 855

"Major instances" on page 858

"Minor instances" on page 859

"Warning instances" on page 864

"OK Instances" on page 860

BPI Worst Violated 
Instances Rule for 
Duration Monitor 

(622)

The samples sent by Business Process Insight, includes the number of 
instances for each status (Minor, Major, and so on), where the statuses are 
calculated by Business Process Insight. 

The rule searches for the worst status in the sample.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Critical instances" on page 855

"Major instances" on page 858

"Minor instances" on page 859

"Warning instances" on page 864

"OK Instances" on page 860

Rule (Rule #) Description
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BPI Worst Violated 
Instances Rule for 
Value Monitor 

(610)

The samples sent by Business Process Insight, includes the number of 
instances for each status (Minor, Major, and so on), where the statuses are 
calculated by Business Process Insight. 

The rule searches for the worst status in the sample.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Critical instances" on page 855

"Major instances" on page 858

"Minor instances" on page 859

"Warning instances" on page 864

"OK Instances" on page 860

Rule (Rule #) Description
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BTM Calculation Rules

Rule (Rule #) Description

TransactionVision 
Backend Average 
Duration Rule 
(Completed 
Transactions)

(1432)

Calculates status for an HI based on the average backend duration for 
successful, completed transactions in TransactionVision, using the 
sample fields sum_tv_response_time/(tx_count - failed_tx_count).

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Backend Average Response" on 
page 854

"Number of transactions" on 
page 860

"Value For" on page 863

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860
764



Chapter 23 • Business Rule Repository
TransactionVision 
Backend Maximum 
Duration Rule 
(Completed 
Transactions)

(1434)

Assigns status for an HI based on the maximum backend duration for 
successful, completed transactions in TransactionVision, using the 
sample field max_tv_response_time.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Backend Maximum Response" on 
page 854

"Value For" on page 863

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

TransactionVision 
Backend Minimum 
Duration Rule 
(Completed 
Transactions)

(1433)

Assigns status for an HI based on the minimum backend duration for 
successful, completed transactions in TransactionVision, using the 
sample field min_tv_response_time.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Backend Minimum Response" on 
page 854

"Value For" on page 863

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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TransactionVision 
Backlog Rule (In-
Process Transactions)

(1426)

Calculates status for an HI based on the number of backlogged (in-
process) transactions in TransactionVision, using the sample field 
curr_tx_count.

Rule Parameters: 

None

Tooltip Parameters: 

"Backlog count" on page 854

"Business Rule" on page 854

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Value For" on page 863

"Warning" on page 864

TransactionVision 
Delayed Rate Rule 
(Completed 
Transactions)

(1411)

Calculates status for an HI based on late completed transactions divided 
by total completed transactions, using the sample fields 
late_tx_count/tx_count.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Delays Value" on page 855

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Number of transactions" on 
page 860

"OK" on page 860

"Status" on page 862

"Value For" on page 863

"Warning" on page 864

Rule (Rule #) Description
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TransactionVision 
Delayed Rate Rule (In-
Process Transactions)

(1421)

Calculates status for an HI based on late in-process transactions divided 
by total in-process transactions, using the sample fields 
curr_late_tx_count/curr_tx_count.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Delays Value" on page 855

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Number of transactions" on 
page 860

"OK" on page 860

"Status" on page 862

"Value For" on page 863

"Warning" on page 864

TransactionVision 
Delayed Value Rule 
(Completed 
Transactions)

(1412)

Calculates status for an HI based on the financial value of the late 
completed transactions, using the sample field tot_late_tx_value.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Delays Value" on page 855

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Value For" on page 863

"Warning" on page 864

Rule (Rule #) Description
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TransactionVision 
Delayed Value Rule 
(In-Process 
Transactions)

(1422)

Calculates status for an HI based on the financial value of the late in-
process transactions, using the sample field curr_tot_late_tx_value.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Delays Value" on page 855

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Value For" on page 863

"Warning" on page 864

TransactionVision End 
User Average Duration 
Rule (Completed 
Transactions)

(1435)

Calculates status for an HI based on the average end user duration for 
successful, completed transactions in TransactionVision, using the 
sample fields sum_eu_response_time/(tx_count - failed_tx_count).

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"End User Average Response" on 
page 855

"Number of transactions" on 
page 860

"Value For" on page 863

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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TransactionVision End 
User Maximum 
Duration Rule 
(Completed 
Transactions)

(1437)

Assigns status for an HI based on the maximum end user duration for 
successful, completed transactions in TransactionVision, using the 
sample field max_eu_response_time.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"End User Maximum Response" on 
page 855

"Value For" on page 863

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

TransactionVision End 
User Minimum 
Duration Rule 
(Completed 
Transactions)

(1436)

Assigns status for an HI based on the minimum end user duration for 
successful, completed transactions in TransactionVision, using the 
sample field min_eu_response_time.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"End User Minimum Response" on 
page 856

"Value For" on page 863

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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TransactionVision 
End-to-end Average 
Duration Rule 
(Completed 
Transactions)

(1410)

Calculates status for an HI based on the average duration for successful, 
completed transactions in TransactionVision, using the sample fields 
sum_response_time/(tx_count - failed_tx_count).

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"End-to-end Average Response" on 
page 856

"Number of Valid Transactions" on 
page 860

"Value For" on page 863

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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TransactionVision 
End-to-end Maximum 
Duration Rule 
(Completed 
Transactions)

(1431)

Assigns status for an HI based on the maximum duration for successful, 
completed transactions in TransactionVision, using the sample field 
max_response_time.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"End-to-end Maximum Response" on 
page 856

"Value For" on page 863

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

TransactionVision 
End-to-end Minimum 
Duration Rule 
(Completed 
Transactions)

(1430)

Assigns status for an HI based on the minimum duration for successful, 
completed transactions in TransactionVision, using the sample field 
min_response_time.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"End-to-end Minimum Response" on 
page 856

"Value For" on page 863

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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TransactionVision 
Exceptions Rate Rule 
(Completed 
Transactions)

(1414)

Calculates status for an HI based on completed transactions marked as 
exceptions, divided by total completed transactions, using the sample 
fields exp_tx_count/tx_count.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Exceptions Rate" on page 856

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Number of transactions" on 
page 860

"OK" on page 860

"Status" on page 862

"Value For" on page 863

"Warning" on page 864

Rule (Rule #) Description
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TransactionVision 
Exceptions Rate Rule 
(In-Process 
Transactions)

(1424)

Calculates status for an HI based on completed transactions marked as 
exceptions, divided by total in-process transactions, using the sample 
fields curr_exp_tx_count/curr_tx_count.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Exceptions Rate" on page 856

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Number of transactions" on 
page 860

"OK" on page 860

"Status" on page 862

"Value For" on page 863

"Warning" on page 864

TransactionVision 
Exceptions Value Rule 
(Completed 
Transactions)

(1413)

Calculates status for an HI based on the financial value of completed 
transactions marked as exceptions, using the sample field 
tot_exp_tx_value.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Exceptions Value" on page 856

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Value For" on page 863

"Warning" on page 864

Rule (Rule #) Description
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TransactionVision 
Exceptions Value Rule 
(In-Process 
Transactions)

(1423)

Calculates status for an HI based on the financial value of in-process 
transactions marked as exceptions, using the sample field 
curr_tot_exp_tx_value.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Exceptions Value" on page 856

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Value For" on page 863

"Warning" on page 864

TransactionVision 
Failures Rate Rule 
(Completed 
Transactions)

(1418)

Calculates status for an HI based on failed completed transactions divided 
by total completed transactions, using the sample fields 
failed_tx_count/tx_count.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Failures rate" on page 856

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Number of transactions" on 
page 860

"OK" on page 860

"Status" on page 862

"Value For" on page 863

"Warning" on page 864

Rule (Rule #) Description
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TransactionVision 
Failures Rate Rule (In-
Process Transactions)

(1428)

Calculates status for an HI based on failed in-process transactions divided 
by total completed transactions, using the sample fields 
curr_failed_tx_count/curr_tx_count.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Failures rate" on page 856

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Number of transactions" on 
page 860

"OK" on page 860

"Status" on page 862

"Value For" on page 863

"Warning" on page 864

TransactionVision 
Failures Value Rule 
(Completed 
Transactions)

(1419)

Calculates status for an HI based on the financial value of the failed 
completed transactions, using the sample field tot_failed_tx_value.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Value" on page 863

"Value For" on page 863

"Warning" on page 864

Rule (Rule #) Description
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TransactionVision 
Failures Value Rule (In-
Process Transactions)

(1429)

Calculates status for an HI based on the financial value of the failed in-
process transactions, using the sample field curr_tot_failed_tx_value.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Value" on page 863

"Value For" on page 863

"Warning" on page 864

TransactionVision 
Value Rule 
(Completed 
Transactions)

(1415)

Calculates status for an HI based on the financial value of the completed 
transactions, using the sample field tot_tx_value.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Value" on page 863

"Value For" on page 863

"Warning" on page 864

Rule (Rule #) Description
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TransactionVision 
Value Rule (In-Process 
Transactions)

(1425)

Calculates status for an HI based on the financial value of the in-process 
transactions, using the sample field curr_tot_tx_value.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Value" on page 863

"Value For" on page 863

"Warning" on page 864

TransactionVision 
Volume Rule 
(Completed and In-
Process Transactions)

(1416)

Calculates status for an HI based on the financial value of the completed 
and in-process transactions in TransactionVision, using the sample fields 
tx_count + curr_tx_count.

Rule Parameters: 

None

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Transactions volume" on page 863

"Value For" on page 863

"Warning" on page 864

Rule (Rule #) Description
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Diagnostics Calculation Rules

Rule (Rule #) Description

Diagnostics Backend 
Transaction 
Application 
Exceptions Rule 

(50013)

Returns transaction application exceptions, as seen in HP Diagnostics. 
Reports metrics for transactions that have been created in the Transaction 
Management Administration > Monitoring tab.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Application Exceptions" on 
page 853

"Status for" on page 862

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860
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Diagnostics Backend 
Transaction Average 
Response Time Rule 

(50010)

Calculates average transaction response time, as seen in HP Diagnostics. 
Reports metrics for transactions that have been created in the Transaction 
Management Administration > Monitoring tab.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Average Response Time" on 
page 853

"Status for" on page 862

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Diagnostics Backend 
Transaction Count 
Rule 

(50015)

Returns transaction count, as seen in HP Diagnostics. Reports metrics for 
transactions that have been created in the Transaction Management 
Administration > Monitoring tab.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Transaction Count" on page 863

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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Diagnostics Backend 
Transaction Maximum 
Response Time Rule 

(50012)

Calculates maximum transaction response time, as seen in 
HP Diagnostics. Reports metrics for transactions that have been created 
in the Transaction Management Administration > Monitoring tab.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Max Response Time" on page 858

"Status for" on page 862

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Diagnostics Backend 
Transaction Minimum 
Response Time Rule 

(50011)

Calculates minimum transaction response time, as seen in 
HP Diagnostics. Reports metrics for transactions that have been created 
in the Transaction Management Administration > Monitoring tab.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Min Response Time" on page 859

"Status for" on page 862

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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Diagnostics Backend 
Transaction SOAP 
Faults Rule 

(50014)

Returns transaction SOAP faults, as seen in HP Diagnostics. Reports 
metrics for transactions that have been created in the Transaction 
Management Administration > Monitoring tab.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Application Exceptions" on 
page 853

"Status for" on page 862

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Diagnostics Synthetic 
User Backend 
Application 
Exceptions Rule 

(50001)

Returns application exceptions for BPM transactions, as seen by 
HP Diagnostics.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Application Exceptions" on 
page 853

"Status for" on page 862

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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Diagnostics Synthetic 
User Backend Average 
Response Time Rule 

(50000)

Calculates the average response time for BPM transactions, as seen by 
HP Diagnostics

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Average Response Time" on 
page 853

"Status for" on page 862

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Diagnostics Synthetic 
User Backend Max 
Server Request 
Duration Rule 

(50002)

Returns the maximum server request duration for BPM transactions, as 
seen by HP Diagnostics.

Rule Parameters: 

None

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Max Response Time" on page 858

"Status for" on page 862

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"OK" on page 860

Rule (Rule #) Description
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End User Management Calculation Rules

Rule (Rule #) Description

Average Availability of 
Weighted Volume 

(55)

This KPI rule calculates the weighted average availability of child CIs, 
based on the Volume and Application Availability KPIs. The rule 
generates a status for the KPI based on this calculation. The rule can be 
used for a KPI on a CI collection, BTF, or application.

This rule is applicable for Real User Monitor, which uses the Volume KPI.

For example, if the KPI is on an application which has BTs as child CIs, 
the rule looks at the Volume and Application Availability KPIs on the BTs, 
and calculates the weighted average for the application.

If there is no volume on a child CI, its volume is calculated as 1.

If the rule is on an application, and the application also has HIs 
contributing to the Application Availability KPI, the rule calculates the 
weighted average based on the child CIs. The rule then compares that to 
the HIs on the CI, and shows the worst status between the calculated 
value and the values of all contributing HIs.

For an example of weighted average calculation, and details on changing 
weights, see "Example of EUM Weighted Average Rule" on page 865.

Rule Parameters: 

"calc_method" on page 845

"Calculate Volume By KPI" on 
page 845

"hi_list" on page 847

"volumeKPI" on page 852

Tooltip Parameters: 

"Availability" on page 853

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Warning" on page 864
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Average Network of 
Weighted Volume 

(93)

This KPI rule calculates the weighted average network availability of child 
CIs, based on the Volume (number of sessions) and Network KPIs. The 
rule generates a status for the KPI based on this calculation. The rule can 
be used for a KPI on an end user group. This rule is applicable for Real 
User Monitor, which uses the Volume KPI.

For example, if the KPI is on an EUG which has subnets as child CIs, the 
rule looks at the Volume and Network KPIs on the subnets, and calculates 
the weighted average network availability for the end user group. If there 
is no volume on a child CI, its volume is calculated as 1.

If the rule is on an EUG, and the EUG also has HIs contributing to the 
Network KPI, the rule calculates the weighted average based on the child 
CIs. The rule then compares that to the HIs on the CI, and shows the 
worst status between the calculated value and the values of all 
contributing HIs.

For an example of weighted average calculation, and details on changing 
weights, see "Example of EUM Weighted Average Rule" on page 865.

Rule Parameters: 

"calc_method" on page 845

"Calculate Volume By KPI" on 
page 845

"hi_list" on page 847

"volumeKPI" on page 852

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"Network Availability" on page 859

"OK" on page 860

"Status" on page 862

"Warning" on page 864

Rule (Rule #) Description
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Average Performance 
of Weighted Volume 

(65)

This KPI rule calculates the weighted average performance of child CIs, 
based on the Volume and Performance KPIs. The rule generates a status 
for the KPI based on this calculation. The rule is applicable for Real User 
Monitor, which uses the Volume KPI.

The rule can be used for a KPI on an end user group, CI collection, BTF, or 
application. If the rule is used on a transaction it looks at the volume of 
all transaction hits; if it is on an end user group it looks at all sessions or 
connections.

For example, if the KPI is on an application which has BTs as child CIs, 
the rule looks at the Volume and Performance KPIs on the BTs, and 
calculates the weighted average for the application. If there is no volume 
on a child CI, its volume is calculated as 1.

If the rule is on an application and the application also has HIs 
contributing to the Performance KPI, the rule calculates the weighted 
average based on the child CIs, compares that to the HI on the CI, and 
shows the worst of these two statuses.

For an example of weighted average calculation, and details on changing 
weights, see "Example of EUM Weighted Average Rule" on page 865.

Rule Parameters: 

"calc_method" on page 845

"Calculate Volume By KPI" on 
page 845

"hi_list" on page 847

"volumeKPI" on page 852

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Performance" on page 860

"Status" on page 862

"Warning" on page 864

Rule (Rule #) Description
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Average Performance 
of Weighted Volume 
(Available Hits) 

(64)

This rule calculates the weighted average performance status of child CIs, 
based on the Volume (total available hits) and Performance KPIs, using 
available transaction hits only. The rule generates a status for the KPI 
based on this calculation. The rule can be used for a KPI on a CI 
collection, BTF, or application; the rule is applicable for Real User 
Monitor, which uses the Volume KPI.

For example, if the KPI is on an application which has BTs as child CIs, 
the rule looks at the Volume (total available hits) and Performance KPIs 
on the BTs, and calculates the weighted average for the application. If 
there is no volume on a child CI, its volume is calculated as 1.

If the rule is on an application and the application also has HIs 
contributing to the Performance KPI, the rule calculates the weighted 
average of available hits on the child CIs, compares that to the HI on the 
CI, and shows the worst of these two statuses.

Note: If this rule is used for a KPI on a CI collection which contains CI 
collections as child CIs, the child CIs must also have a KPI which uses this 
rule in order for the parent to use the rule.

For an example of weighted average calculation, and details on changing 
weights, see "Example of EUM Weighted Average Rule" on page 865.

Rule Parameters: 

"calc_method" on page 845

"Calculate Volume By KPI" on 
page 845

"hi_list" on page 847

"volumeKPI" on page 852

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Performance" on page 860

"Status" on page 862

"Warning" on page 864

Rule (Rule #) Description
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EUM Sum of Volumes

(4000)

This KPI rule calculates the sum of the volume in the HIs and KPIs on 
which the calculation is based. Its status is always informational or no 
data.

The rule is used on a transaction to measure total transaction hits; it is 
not used on an application.

Rule Parameters: 

"calc_method" on page 845

"hi_list" on page 847

Tooltip Parameters: 

"Business Rule" on page 854

"Max Time" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Total" on page 862

"Warning" on page 864

Real User Application 
Actions Volume Rule 

(3806)

Counts the total number of actions on the application, during the time 
period specified by the duration parameter.

Rule Parameters: 

"Field Name" on page 846

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Number of Actions" on page 859

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

Rule (Rule #) Description
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Real User Application 
Open Sessions Rule 

(3815)

The rule counts the number of sessions open on the application, based on 
the last sample received from Real User Monitor.

Rule Parameters: 

"sample_group_by_fields" on 
page 851

"relevant_samples" on page 850

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Number of Open Sessions" on 
page 860

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

"Major" on page 858

"OK" on page 860

Real User Application 
Sessions Availability 
Rule 

(3822)

Based on the last sample received from Real User Monitor, the rule 
calculates average availability of sessions on the application.

Availability is calculated based on the percentage of sessions with errors 
out of the total number of sessions, using the following sample fields:

(1 – sum (op_se_with_err_count) / sum (active_session_count) ) * 100

If the value is greater than the threshold (98% by default), the status is 
OK; otherwise it is Critical.

Note: This threshold can be changed in Admin > Platform > Setup and 
Maintenance > Infrastructure Settings > Applications > End User/System 
Availability Management > Data > Real User Monitor sessions availability 
threshold (%).

Rule Parameters: 

"sample_group_by_fields" on 
page 851

"relevant_samples" on page 850

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Last update" on page 858

"Availability (%)" on page 853

Rule (Rule #) Description
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Real User Application 
Sessions Performance 
Rule 

(3819)

Based on the last sample received from Real User Monitor, the rule 
calculates average performance of sessions on the application. A session is 
considered to have a performance event if any of its pages or actions had 
a performance event.

Performance is calculated based on the percentage of sessions with 
performance events, out of the total number of sessions, using the 
following sample fields: 

(1 – sum (op_se_with_perf_count) / sum (active_session_count) )*100 

If the value is greater than the threshold (98% by default), the status is 
OK; otherwise it is Critical.

Note: This threshold can be changed in Admin > Platform > Setup and 
Maintenance > Infrastructure Settings > Applications > End User/System 
Availability Management > Data > Real User Monitor sessions 
performance threshold (%).

Rule Parameters: 

"sample_group_by_fields" on 
page 851

"relevant_samples" on page 850

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Last update" on page 858

"Performance (%)" on page 861

Real User Bandwidth 
Rule 

(3818)

Displays the amount of TCP traffic between the application server and 
clients, during the time period specified by the duration parameter. TCP 
traffic is in megabytes, and includes traffic in both directions.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Bandwidth" on page 854

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

Rule (Rule #) Description
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Real User Connections 
Availability Rule 

(3814)

Calculates the average availability of connections monitored by Real User 
Monitor, during the time period specified by the duration parameter.

➤ Availability status is calculated based on the sum of the sample field 
tot_conn_success_color; if the value is > 0 the status is OK, otherwise 
the status is Critical.

➤ Availability value is calculated based on the number of successful and 
unsuccessful connections, using the following sample fields:

Availability = sum (tot_conn) - sum (tot_conn_refused) - sum 
(tot_conn_timeout) / sum (tot_conn) * 100 (to give a percentage).

Rule Parameters: 

"No data timeout" on page 849

"duration" on page 846

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Last update" on page 858

"Availability (%)" on page 853

Real User Connections 
Volume Rule 

(3807)

Counts the total number of connections during the time period specified 
by the duration parameter.

Rule Parameters: 

"Field Name" on page 846

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Number of Connections" on 
page 859

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

Rule (Rule #) Description
790



Chapter 23 • Business Rule Repository
Real User EUG 
Subgroup Latency 
Rule 

(3808)

Displays the average roundtrip time for a packet, between the client and 
the server for an end user group monitored by Real User Monitor, during 
the time period specified by the duration parameter.

Rule Parameters: 

"Latency Color field" on page 848

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Latency" on page 858

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

Real User EUG 
Subgroup Open 
Sessions Rule 

(3816)

The rule counts the number of sessions open on the end-user group 
subgroup, based on the last sample received from Real User Monitor.

Rule Parameters: 

"sample_group_by_fields" on 
page 851

"relevant_samples" on page 850

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Number of Open Sessions" on 
page 860

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

"Major" on page 858

"OK" on page 860

Rule (Rule #) Description
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Real User EUG 
Subgroup Sessions 
Availability Rule 

(3823)

Based on the last sample received from Real User Monitor, the rule 
calculates average availability of sessions on the end-user group 
subgroup.

Availability is calculated based on the percentage of sessions with errors 
out of the total number of sessions, using the following sample fields: 

(1 – sum (op_se_with_err_count) / sum (active_session_count)) * 100

If the value is greater than the threshold (98% by default), the status is 
OK; otherwise it is Critical.

Note: This threshold can be changed in Admin > Platform > Setup and 
Maintenance > Infrastructure Settings > Applications > End User/System 
Availability Management > Data > Real User Monitor sessions 
performance threshold (%).

Rule Parameters: 

"sample_group_by_fields" on 
page 851

"relevant_samples" on page 850

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Last update" on page 858

"Availability (%)" on page 853

Rule (Rule #) Description
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Real User EUG 
Subgroup Sessions 
Performance Rule 

(3820)

Based on the last sample received from Real User Monitor, the rule 
calculates average performance of sessions on the end-user group 
subgroup. A session is considered to have a performance event if any of 
its pages or actions had a performance event.

Performance is calculated based on the percentage of sessions with 
performance events, out of the total number of sessions, using the 
following sample fields: 

(1 – sum (op_se_with_perf_count) / sum (active_session_count))*100 

If the value is greater than the threshold (98% by default), the status is 
OK; otherwise it is Critical. 

Rule Parameters: 

"sample_group_by_fields" on 
page 851

"relevant_samples" on page 850

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Last update" on page 858

"Performance (%)" on page 861

Real User Error Events 
Rule 

(3804)

Counts the total number of error events during the time period specified 
by the duration parameter.

Rule Parameters: 

"Field Name" on page 846

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Number of Error Events" on 
page 859

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

Rule (Rule #) Description
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Real User Information 
Events Rule 

(3803)

Counts the total number of information events during the time period 
specified by the duration parameter.

Rule Parameters: 

"Field Name" on page 846

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Number of Information Events" on 
page 860

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

Real User Location 
Latency Rule 

(3809)

Displays the average roundtrip time for a packet, between the client and 
the server for a location monitored by Real User Monitor, during the time 
period specified by the duration parameter.

Rule Parameters: 

"Latency Color field" on page 848

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Latency" on page 858

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

Real User Location 
Open Sessions Rule 

(3817)

The rule counts the number of sessions open on the location, based on 
the last sample received from Real User Monitor.

Rule Parameters: 

"sample_group_by_fields" on 
page 851

"relevant_samples" on page 850

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Number of Open Sessions" on 
page 860

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

"Major" on page 858

"OK" on page 860

Rule (Rule #) Description
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Real User Location 
Sessions Availability 
Rule 

(3824)

Based on the last sample received from Real User Monitor, the rule 
calculates average availability of sessions on the location.

Availability is calculated based on the percentage of sessions with errors 
out of the total number of sessions, using the following sample fields: 

(1 – sum (op_se_with_err_count) / sum (active_session_count)) * 100

If the value is greater than the threshold (98% by default), the status is 
OK; otherwise it is Critical.

Note: This threshold can be changed in Admin > Platform > Setup and 
Maintenance > Infrastructure Settings > Applications > End User/System 
Availability Management > Data > Real User Monitor sessions availability 
threshold (%).

Rule Parameters: 

"sample_group_by_fields" on 
page 851

"relevant_samples" on page 850

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Last update" on page 858

"Availability (%)" on page 853

Rule (Rule #) Description
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Real User Location 
Sessions Performance 
Rule 

(3821)

Based on the last sample received from Real User Monitor, the rule 
calculates average performance of sessions on the location. A session is 
considered to have a performance event if any of its pages or actions had 
a performance event.

Performance is calculated based on the percentage of sessions with 
performance events, out of the total number of sessions, using the 
following sample fields: 

(1 – sum (op_se_with_perf_count) / sum (active_session_count))*100 

If the value is greater than the threshold (98% by default), the status is 
OK; otherwise it is Critical.

Note: This threshold can be changed in Admin > Platform > Setup and 
Maintenance > Infrastructure Settings > Applications > End User/System 
Availability Management > Data > Real User Monitor sessions 
performance threshold (%).

Rule Parameters: 

"sample_group_by_fields" on 
page 851

"relevant_samples" on page 850

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Last update" on page 858

"Performance (%)" on page 861

Rule (Rule #) Description
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Real User Number of 
Transaction Hits Rule 

(3802)

Counts the total number of times that a transaction monitored by Real 
User Monitor was completed, during the time period specified by the 
duration parameter.

Rule Parameters: 

"Availability Field" on page 845

"Field Name" on page 846

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Number of Transaction Hits" on 
page 860

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

"Major" on page 858

"OK" on page 860

Real User Performance 
Events Rule 

(3805)

Counts the total number of performance events during the time period 
specified by the duration parameter.

Rule Parameters: 

"Field Name" on page 846

"Time Stamp Field" on page 852

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Number of Performance Events" on 
page 860

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

Rule (Rule #) Description
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Real User Transaction 
Availability Rule 

(3812)

Calculates availability of a transaction monitored by Real User Monitor, 
during the time period specified by the duration parameter.

The samples contain information on how many transactions were 
available (passed) and how many were not available (failed).

The rule calculates availability status using the following calculation: 
Number of available transactions - (total number of transactions * 
availability threshold). 

For example, suppose the threshold is 98%. For each available transaction 
the rule calculates: 1 - (1 * 0.98) = 0.02, and for each unavailable 
transaction it calculates: 0 - (1*0.98)  = -0.98. 

These values are then added together for the time period specified in the 
duration parameter. If the result is positive, the health indicator status is 
OK; if the result is negative, its status is Critical.

Rule Parameters: 

"No data timeout" on page 849

"duration" on page 846

Tooltip Parameters:

"Status" on page 862

"Availability (%)" on page 853

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Last update" on page 858

Rule (Rule #) Description
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Real User Transaction 
Performance Rule 

(3813)

Calculates the average performance of a transaction monitored by Real 
User Monitor, during the time period specified by the duration 
parameter.

The samples contain information on how many sessions had acceptable 
response time (OK status) and how many were problematic (Critical 
status).

For an example of weighted average calculation, and details on changing 
weights, see "Example of EUM Weighted Average Rule" on page 865.

Note: Although Real User Monitor sends samples with either OK or 
Critical status (and not Minor), the rule result can be Minor based on the 
average of the statuses in the sample.

Rule Parameters: 

"No data timeout" on page 849

"duration" on page 846

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Last update" on page 858

"Critical samples" on page 855

"Minor samples" on page 859

"OK samples" on page 860

"Average Net Time" on page 853

Real User Transaction 
Server Time Rule 

(3811)

Displays the average server time of a transaction monitored by Real User 
Monitor, during the time period specified by the duration parameter.

Rule Parameters: 

"Sum field" on page 852

"Divide by field" on page 846

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Transaction Server Time" on 
page 863

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

Rule (Rule #) Description
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Real User Transaction 
Total Time Rule 

(3810)

Displays the average total time of a transaction monitored by Real User 
Monitor, during the time period specified by the duration parameter.

Rule Parameters: 

"Sum field" on page 852

"Divide by field" on page 846

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Transaction Total Time" on 
page 863

"Business Rule" on page 854

"Held status since" on page 857

"Calculation duration" on page 854

RUM Application 
Session Statistics 
Monitor Availability 
Rule (pre-9.0) 

(56)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Calculates the result as follows: 100% x (total number of active sessions - 
number of active sessions with availability events)/total number of active 
sessions. If more than one sample is used for the calculation, the sum is 
weighted, where the weight is the total number of sessions (volume).

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

"relevant_samples" on page 850

"sample_group_by_fields" on 
page 851

"volumeKPI" on page 852

Tooltip Parameters: 

"Availability" on page 853

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Warning" on page 864

Rule (Rule #) Description
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RUM Application 
Session Statistics 
Monitor Performance 
Rule (pre-9.0) 

(66)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Calculates the result as follows: 100% x (total number of active sessions - 
number of active sessions with performance events)/total number of 
active sessions. If more than one sample is used for the calculation, the 
sum is weighted, where the weight is the total number of sessions 
(volume).

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

"relevant_samples" on page 850

"sample_group_by_fields" on 
page 851

"volumeKPI" on page 852

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Performance" on page 860

"Status" on page 862

"Warning" on page 864

RUM End User 
Monitor Latency Rule 
(pre-9.0) 

(92)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Calculates the average roundtrip time for a packet, between the end users 
and the server monitored by the Real User Monitor, during the time 
period specified by the duration parameter for the rule. The status is 
calculated based on the defined threshold.

Rule Parameters: 

"duration" on page 846

"first_choice_sample" on page 847

"No data timeout" on page 849

"relevant_samples" on page 850

"sample_group_by_fields" on 
page 851

"volumeKPI" on page 852

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Latency" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Warning" on page 864

Rule (Rule #) Description
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RUM End User 
Monitor Network Rule 
(pre-9.0) 

(91)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Calculates the network availability, based on successful TCP connections. 
Connection resets and timeouts are considered unsuccessful connections.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

"volumeKPI" on page 852

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"Network Availability" on page 859

"OK" on page 860

"Status" on page 862

"Warning" on page 864

RUM End User Session 
Statistics Monitor 
Availability Rule (pre-
9.0) 

(57)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Calculates the result as follows: 100% x (total number of active sessions - 
number of active sessions with availability events)/total number of active 
sessions. If more than one sample is used for the calculation, the sum is 
weighted, where the weight is the total number of sessions (volume).

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

"relevant_samples" on page 850

"sample_group_by_fields" on 
page 851

"volumeKPI" on page 852

Tooltip Parameters: 

"Availability" on page 853

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Warning" on page 864

Rule (Rule #) Description
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RUM End User Session 
Statistics Monitor 
Performance Rule 
(pre-9.0) 

(67)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Calculates the result as follows: 100% x (total number of active sessions - 
number of active sessions with performance events)/total number of 
active sessions. If more than one sample is used for the calculation, the 
sum is weighted, where the weight is the total number of sessions 
(volume).

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

"relevant_samples" on page 850

"sample_group_by_fields" on 
page 851

"volumeKPI" on page 852

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Performance" on page 860

"Status" on page 862

"Warning" on page 864

RUM Location Session 
Statistics Monitor 
Availability Rule (pre-
9.0) 

(58)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Calculates the result as follows: 100% x (total number of active sessions - 
number of active sessions with availability events)/total number of active 
sessions. If more than one sample is used for the calculation, the sum is 
weighted, where the weight is the total number of sessions (volume).

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

"relevant_samples" on page 850

"sample_group_by_fields" on 
page 851

"volumeKPI" on page 852

Tooltip Parameters: 

"Availability" on page 853

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Warning" on page 864

Rule (Rule #) Description
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RUM Location Session 
Statistics Monitor 
Performance Rule 
(pre-9.0) 

(68)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Calculates the result as follows: 100% x (total number of active sessions - 
number of active sessions with performance events)/total number of 
active sessions. If more than one sample is used for the calculation, the 
sum is weighted, where the weight is the total number of sessions 
(volume).

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

"relevant_samples" on page 850

"sample_group_by_fields" on 
page 851

"volumeKPI" on page 852

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Performance" on page 860

"Status" on page 862

"Warning" on page 864

RUM Transaction 
Monitor Availability 
Rule (pre-9.0) 

(51)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Calculates the percentage of available transactions (out of the total 
number of transactions), over the time period specified in the duration 
parameter for the rule. A transaction is considered available when all 
pages accessed by the transaction are available.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

"volumeKPI" on page 852

Tooltip Parameters: 

"Availability" on page 853

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Warning" on page 864

Rule (Rule #) Description
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RUM Transaction 
Monitor Performance 
Rule (pre-9.0) 

(61)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Calculates the percentage of transactions (out of the total number of 
transactions) that do not have pages with a performance problem. A page 
is considered to have a performance problem when page time is over the 
threshold.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

"volumeKPI" on page 852

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Performance" on page 860

"Status" on page 862

"Warning" on page 864

RUM Transaction 
Monitor Volume Rule 
(pre-9.0) 

(71)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Counts the total number of times that a transaction monitored by Real 
User Monitor was completed, during the time period specified by the 
duration parameter for the rule.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Volume" on page 863

"Warning" on page 864

Rule (Rule #) Description
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Synthetic User 
Transaction 
Availability Rule 

(3800)

Calculates availability of Business Process Monitor transactions during 
the time period specified by the duration parameter.

The samples contain information on how many transactions were 
available (passed) and how many were not available (failed).

The rule calculates availability status using the following calculation: 
Number of available transactions - (total number of transactions * 
availability threshold). 

For example, suppose the threshold is 98%. For each available transaction 
the rule calculates: 1 - (1 * 0.98) = 0.02, and for each unavailable 
transaction it calculates: 0 - (1*0.98)  = -0.98. 

These values are then added together for the time period specified in the 
duration parameter. If the result is positive, the health indicator status is 
OK; if the result is negative, its status is Critical.

Rule Parameters: 

"No data timeout" on page 849

"duration" on page 846

Tooltip Parameters:

"Status" on page 862

"Availability (%)" on page 853

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Last update" on page 858

Rule (Rule #) Description
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Synthetic User 
Transaction 
Performance Rule 

(3801)

Calculates the average performance of Business Process Monitor 
transactions, during the time period specified by the duration parameter.

The samples contain information on how many transactions had 
acceptable response times (OK status) and how many were problematic 
(Critical status).

For an example of weighted average calculation, and details on changing 
weights, see "Example of EUM Weighted Average Rule" on page 865.

Rule Parameters: 

"No data timeout" on page 849

"duration" on page 846

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Status for" on page 862

"Last update" on page 858

"Critical samples" on page 855

"Minor samples" on page 859

"OK samples" on page 860

"Average Response Time" on 
page 853

Rule (Rule #) Description
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Transaction 
Availability Rule (pre-
9.0) 

(5)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Calculates how many Business Process Monitor transactions ran 
successfully during the time period specified by the duration parameter.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Average For" on page 853

"Avg. Availability" on page 854

"Business Rule" on page 854

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Transaction" on page 863

"Warning" on page 864

Rule (Rule #) Description
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Transaction 
Performance Rule 
(pre-9.0) 

(13)

Note: This rule uses calculation logic based on BSM pre-9.x versions.

Calculates the average response time of the Business Process Monitor 
transactions that ran during the time period specified by the duration 
parameter.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Average For" on page 853

"Average Response Time" on 
page 853

"Business Rule" on page 854

"Held status since" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Transaction" on page 863

"Warning" on page 864

Rule (Rule #) Description
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General Calculation Rules

Rule (Rule #) Description

API Duration-Based 
Sample Rule 

(501)

Use this to create a customized rule using the Rules API, to calculate 
health indicator values based on values of samples. The calculation is 
based on the samples collected during a defined duration.

For details on how the rule works, see "API Duration-Based Sample Rule" 
on page 955.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

"Sample Fields" on page 850

"KPI Calculation Script" on page 848

"Rule Template Setting Key" on 
page 850

"isGroovyRuleType" on page 848

Tooltip Parameters: 

"Status" on page 862

"Value" on page 863

"Business Rule" on page 854

"Held status since" on page 857

API Group and Sibling 
Rule 

(500)

Use this to create a customized rule using the Rules API, to calculate KPIs 
based on indicator values of sibling KPIs or of child CIs.

For details on how the rule works, see "API Group and Sibling Rule" on 
page 950.

Rule Parameters: 

"KPI Calculation Script" on page 848

"Rule Template Setting Key" on 
page 850

"isGroovyRuleType" on page 848

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857
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API Sample Rule 

(502)

Use this to create a customized rule using the Rules API, to calculate 
health indicator values based on values of samples. The calculation is 
based on a maximum number of samples.

For details on how the rule works, see "API Sample Rule" on page 953.

Rule Parameters: 

"Maximum number of samples" on 
page 848

"Sample Fields" on page 850

"KPI Calculation Script" on page 848

"Rule Template Setting Key" on 
page 850

"isGroovyRuleType" on page 848

Tooltip Parameters:

"Status" on page 862

"Value" on page 863

"Business Rule" on page 854

"Held status since" on page 857

Average of Values 

(31)

Calculates the average of the values of the HIs and KPIs which are used to 
calculate the KPI.

Rule Parameters:

"calc_method" on page 845

"hi_list" on page 847

Tooltip Parameters:

"Status" on page 862

"Value" on page 863

"Business Rule" on page 854

"Total" on page 862

"Max Time" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Rule (Rule #) Description
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Best Status Rule 

(2)

Calculates the KPI’s status based on the highest status of all the HIs and 
KPIs which are used to calculate the KPI.

For example, if at least one child CI has green status, then the parent CI 
also displays green status.

Note: A KPI using this rule will only have a value if it is calculated based 
on one HI or one child KPI. If it is based on more than one HI or child 
KPI, the KPI will only have a status.

Rule Parameters: 

"calc_method" on page 845

"hi_list" on page 847

Tooltip Parameters:

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Invisible Children" on page 858

Generic Formula Rule 

(1510)

Use this rule to add new business logic behavior to Service Health for 
calculating health indicator values.

You can use the rule to create a set of calculation methods (sum, count, 
average, and so on) that can be applied to both legacy samples such as 
SiteScope and Real User Monitor, and Enterprise Management Systems 
(EMS) samples.

For details on how the rule works, see "Understanding the Generic 
Formula Rule" on page 720. 

For an example of a customized Generic Formula rule, see "Examples – 
Generic Formula Rule" on page 726.

Rule Parameters: 

"Formula" on page 847

"duration" on page 846

"Time Stamp Field" on page 852

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Formula" on page 856

"Value" on page 863

"Average" on page 853

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Rule (Rule #) Description
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Generic Health 
Indicator Sub-
component Rule 

(332211)

This rule is for internal use; the rule calculates health indicator status 
when a single HI on a CI is calculated from a number of CI sub-
components.

For example, suppose an HI is monitoring CPU load on a host CI, and 
SiteScope has monitors for a number of CPUs on this CI. The rule 
calculates a status for each of the monitored CPUs (for example OK, OK, 
and Warning), and takes the worst of these (Warning) as the HI’s status 
on the CI.

For details, see "Understanding the Health Indicator Tooltips" on 
page 229.

Rule Parameters: 

"clearNormalStatuses" on page 846

"reportNormalStatusesEvents" on 
page 850

"maxNumOfDisplayedEvents" on 
page 848

Tooltip Parameters: 

None

Generic Sample Rule 

(21)

Use this rule to create a customized rule for calculating health indicator 
values. The rule compares the value of a selected field from a sample to 
the thresholds, and returns the result of the comparison.

To use the Generic Sample Rule, you must first customize the rule, and 
then attach the rule to a health indicator, and then attach the health 
indicator to a CI.

For an example of a customized Generic Sample Rule, see "How to Create 
a Customized Generic Sample Rule – Example" on page 729.

The tooltip of the Generic Sample Rule is empty.

Rule Parameters: 

"No data timeout" on page 849

"Field Name" on page 846

"Time Stamp Field" on page 852

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Rule (Rule #) Description
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Generic Sample Rule 
With Baseline

(332212)

Use this rule to create a customized rule for calculating health indicator 
values. The rule compares the value of a selected field from a sample to 
the baseline values, and returns the result of the comparison.

Using the rule parameters you specify the following sample fields:

➤ The field whose values you want to use in the calculation.

➤ The field whose values are used as the mean in calculating the 
baseline.

➤ The field whose values are used as the standard deviation in 
calculating the baseline.

The thresholds you enter for the rule are the number of standard 
deviations from the mean assigned to each status; for example you can 
define that 1 standard deviation is Warning, and two standard deviations 
is Critical.

Rule Parameters: 

"No data timeout" on page 849

"Field Name" on page 846

"Time Stamp Field" on page 852

"mean_value_field_name" on 
page 848

"std_field_name" on page 851

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Rule (Rule #) Description
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Generic Sum of Values 
Over Time Rule 

(1501)

Use this rule to create a customized rule for calculating health indicator 
values. The rule adds the values of the selected sample field for all of the 
samples that arrive during the time period specified in the duration 
parameter.

To use the Generic Sum of Values Over Time rule, you must first 
customize the rule, and then attach the rule to a health indicator, and 
then attach the health indicator to a CI.

For a detailed example of how to create a customized Generic Sum of 
Values Over Time rule, see "How to Create a Customized Generic Sum of 
Values Over Time Rule – Example" on page 731.

The tooltip for the Generic Sum of Value Over Time Rule is empty.

Rule Parameters: 

"No data timeout" on page 849

"Field Name" on page 846

"Time Stamp Field" on page 852

"duration" on page 846

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Rule (Rule #) Description
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Generic Two 
Arguments Rule 

(1500)

Use this rule to perform a specific calculation for calculating health 
indicator values, based on the values of two specific fields. The 
calculation is performed as follows: calculate a value based on an 
operation (specified by the arithmetic operator) and two fields that are 
the sample's keys, multiply the result by a factor, and then compare the 
result with specified thresholds.

You must create a health indicator, and attach the Generic Two 
Arguments Rule rule to the health indicator.

The tooltip for the Generic Two Arguments Rule is empty.

For an example of a customized Generic Two Arguments rule, see "How to 
Use the Generic Two Arguments Rule – Example" on page 732.

Rule Parameters: 

"No data timeout" on page 849

"First Field Name" on page 847

"Second Field Name" on page 851

"Operator" on page 850

"Time Stamp Field" on page 852

"Factor" on page 846

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Value" on page 863

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Rule (Rule #) Description
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Impact Over Time Rule 

(24)

Calculates the financial loss due to non-availability of the CI over time, 
based on sibling KPIs monitoring availability.
Financial loss for a CI is calculated by multiplying the total hours the CI 
is not available by an hourly $ amount (defined by the 
DollarImpactFactor parameter for the rule).
Note: The granularity of this rule’s calculation is maximum one minute. 
If the status of the Application Availability KPI changes, the rule is 
calculated ad hoc; if it does not change, it is calculated once every 
minute.

Rule Parameters: 

"DollarImpactFactor."

"StatusDimension" on page 851

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

"Description" on page 855

"Business Loss" on page 854

Nevada - Event Based 
Alerts Rule (Internal)

(1600)

This rule is used internally for event-based alerts, to determine whether 
or not the alert trigger notification will be sent.

Rule Parameters: 

None

Tooltip Parameters: 

None

Rule (Rule #) Description
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Percentage Rule 

(17)

Calculates in percentage the weighted average of statuses of the HIs and 
KPIs that are used to calculate the KPI. For details on understanding the 
rule, see "Understanding the Percentage Rule" on page 716.

Rule Parameters: 

"calc_method" on page 845

"hi_list" on page 847

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Score" on page 861

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

"Invisible Calculated Children" on 
page 857

Real Time Impact 

(19)

Calculates financial loss due to non-availability of the CI over the last 
hour, based on sibling KPIs monitoring availability.
Financial loss for a CI is calculated by multiplying the total minutes the 
CI was not available during the last hour, by an hourly $ amount (defined 
by the DollarImpactFactor parameter for the rule), divided by 60.

Note: The granularity of this rule’s calculation is maximum one minute. 
If the status of the Application Availability KPI changes, the rule is 
calculated ad hoc; if it does not change, it is calculated once every 
minute.

Rule Parameters: 

"DollarImpactFactor" on page 846

"StatusDimension" on page 851

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

"Description" on page 855

"Business Loss" on page 854

Rule (Rule #) Description
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Service Health PNR 
Rule 

(352)

Produces status to be presented in Service Health, based on Point of No 
Return (PNR) samples created by the internal SLM PNR. For details, see 
"PNR (Point of No Return) KPI Calculation" on page 422. The KPI status is 
displayed in bar form in Service Health. 

The PNR samples measure unavailability of a CI based on any SLM KPI 
during the period of time that has elapsed, and how much time remains 
before the agreement is in breach of contract.

Rule Parameters: 

"No data timeout" on page 849

The following parameters are for 
internal use, and should not be 
modified:

SLA, TRACKING_PERIOD, 
TIME_INTERVAL and 
SOURCE_KPI_ID.

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"SLA" on page 862

"Tracking Period" on page 863

"Calendar" on page 854

"Calculation Time" on page 854

"PNR Time Left" on page 861

"Max Unavailability" on page 858

"PNR Availability" on page 861

"Target Availability" on page 862

Service Health PNR 
Rule for HI (Internal)

(351)

Internal rule used to calculate PNR based on SLM data.

Rule Parameters: 

"No data timeout" on page 849

The following parameters are for 
internal use, and should not be 
modified:

SLA, TRACKING_PERIOD, 
TIME_INTERVAL and 
SOURCE_KPI_ID.

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"SLA" on page 862

"Tracking Period" on page 863

"Calendar" on page 854

"Calculation Time" on page 854

"PNR Time Left" on page 861

"Max Unavailability" on page 858

"PNR Availability" on page 861

"Target Availability" on page 862

Rule (Rule #) Description
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Service Level 
Management Tracking 
Period Alert (Internal)

(361)

Internal rule which receives samples from SLM, and changes KPI status 
for Tracking Period alerts.

Rule Parameters: 

"No data timeout" on page 849

The tracking period id parameter is 
for internal use, and should not be 
modified.

Tooltip Parameters: 

None

Sum of Values Rule 

(20)

Calculates the sum of the values of the HIs and KPIs which are used to 
calculate the KPI.

For example, if the Impact Over Time rule is used to calculate the 
OT Impact KPI on child CIs, you can use the Sum of Values rule on the 
parent CI to view the sum of the children’s over time impact values.

Rule Parameters: 

"calc_method" on page 845

"hi_list" on page 847

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Total" on page 862

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Sum of Volume 

(74)

Group rule that calculates the sum of the users accessing a page or 
encountering an error on a page.

Rule Parameters: 

"calc_method" on page 845

"hi_list" on page 847

Tooltip Parameters: 

"Business Rule" on page 854

"Held status since" on page 857

"Major" on page 858

"Minor" on page 859

"OK" on page 860

"Status" on page 862

"Volume" on page 863

"Warning" on page 864

Rule (Rule #) Description
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Summary of Values 

(30)

Calculates the sum of the values of the HIs and KPIs which are used to 
calculate the KPI.

Note that this rule uses different units and thresholds than the Sum of 
Values rule.

Rule Parameters: 

"calc_method" on page 845

"hi_list" on page 847

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Total" on page 862

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Worst Status Rule 

(1)

Calculates KPI status based on the lowest status held by any of the HIs 
and KPIs which are used to calculate the KPI. 

For example, if at least one child CI has red status, the parent CI also 
displays red status.

Note: A KPI using this rule will only have a value if it is calculated based 
on one HI or child KPI. If it is based on more than one HI or child KPI, 
the KPI will only have a status.

Rule Parameters: 

"calc_method" on page 845

"hi_list" on page 847

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Invisible Children" on page 858

Rule (Rule #) Description
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Integrations Calculation Rules

Rule (Rule #) Description

EMS Simple Rule 

(0)

Displays the Health Indicator status arriving from the EMS system 
through SiteScope.

Use this rule to display SiteScope status if your EMS monitor is 
measurement-based.

If your EMS monitor is event-based, use the EMS Multiple Events Rule. 
For details, see "SiteScope EMS Multiple Events Rule" on page 824.

Rule Parameters: 

"No data timeout" on page 849

"Number of Problematic Samples" 
on page 849

"Total Number of Samples" on 
page 852

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Description" on page 855

"Severity" on page 862

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858
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HP OpenView Service 
Navigator Rule 

(22)

Calculates the KPI status based on metrics collected from UDX event 
samples or old format HP OpenView samples for an HP OpenView Service 
Navigator measurement CI. 

Status is assigned according to the following values:

Rule Parameters: 

"Time Stamp Field" on page 852

"Number of Problematic Samples" 
on page 849

"Total Number of Samples" on 
page 852

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Description" on page 855

"Severity" on page 862

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

"owned By" on page 860

Rule (Rule #) Description

KPI Status
Value for an 
HP Sample

Value for 
an old 
format HP 
OpenView 
Sample

Uninitialized 0 0

OK 1 10

Warning 2 20

Minor 3 30

Major 4 40

Critical 5 50
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SiteScope EMS 
Multiple Events Rule 

(36)

The rule handles the samples sent to BSM by the EMS system. It 
aggregates all the samples received from a specified CI. The rule saves up 
to 10 events. If there are more than 10 events, the rule discards samples 
with the lowest severity (critical is highest) and then the oldest samples.

If the CI has more than one HI, you must define a SiteScope EMS 
Multiple Events rule for each HI by using the rule parameters to specify 
the sample field you are interested in. Specify information about the field 
in the sample to look at (in the KPI Type field name parameter) and the 
value of that field (in the KPI type parameter). 

The EMS Show Events context menu displays the data retrieved from the 
HP Operations Manager system. For details, see "EMS Show Events" on 
page 901.

Rule Parameters: 

"No data timeout" on page 849

Max tooltip events. The maximum 
number of events to show in the 
tooltip. The maximum is 10.

KPI type field name. The name of 
the field in the sample.

KPI type. The valid value of the 
field in the sample

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"EMS Events" on page 856

"Last update" on page 858

Rule (Rule #) Description
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SAP Calculation Rules

Rule (Rule #) Description

SAP Alerts Rule 

(1111)

Displays the SAP samples from SiteScope as is. The SAP Alerts include the 
name of the alert and its status.

HP Business Service Management displays two types of SAP Alerts: 

➤ Dialog alerts under a Dialog work process

➤ Syslog alerts under a SAP R/3 server. 

The status of an alert is displayed by the color of the SAP alert KPI (red or 
yellow), assigned by the SAP system. For details on the colors, see "KPI 
Status Colors and Definitions" on page 45.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Alert Description" on page 853

"Short Name" on page 862

"Business Rule" on page 854

A number indicating the severity 
of the alert as it appears in the SAP 
system.

"State" on page 862

"Open Time" on page 860

"Held status since" on page 857

"Last update" on page 858
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SAP/Siebel Calculation Rules

Rule (Rule #) Description

Locations Grouped 
Parent Rule 

(1110)

When a SAP System CI or a Siebel Enterprise CI has Locations group child 
CIs, the rule uses the results of the Locations Grouped rule for each child 
CI and calculates and displays the sum of each status. For each result, the 
tooltip displays the amount of children for each status.

Example: If a CI has three child CIs, the Locations Parent Group rule 
summarizes the bars for its children. The rule aggregates the bars 
calculated by the Locations Grouped Rule for all of the children into one 
bar. The tooltip displays for each status how many children have that 
specific status.

Rule Parameters: 

"Time Stamp Field" on page 852

"duration" on page 846

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

Locations Grouped 
Rule 

(1105)

For a Locations group CI with child CIs, the rule selects the worst status 
of Performance and Availability for each child CI, calculates the sum of 
children with each specific status and displays that information in a bar. 
The tooltip displays for each status the sum of all of the CI’s children with 
that status.

Example: The rule calculates the status of the Locations CI by taking for 
each child the worst status of Performance and Availability. It then 
calculates the sum of children with each specific status and displays that 
information in a bar.

Rule Parameters: 

"No data timeout" on page 849

"duration" on page 846

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858
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Transactions Grouped 
Parent Rule 

(1109)

When a SAP System CI or a Siebel Enterprise CI has Transactions group 
child CIs, the rule uses the results of the Transactions Grouped rule for 
each child of the CI and calculates and displays the sum of each status. 
For each result, the tooltip displays how many of the children have a 
critical status, how many have the OK status, and so on.

Example: If the CI has three child CIs, the Transactions Parent Group rule 
summarizes the bars for its children. The rule aggregates the bars 
calculated by the Transactions Grouped rule for all of the children into 
one bar. The tooltip displays for each status how many children have that 
specific status.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

Transactions Grouped 
Rule 

(1103)

For a Transactions group CI with child CIs, the rule selects the worst of 
Performance and Availability for each child CI, calculates the sum of 
children with each specific status and displays the information in a bar. 
The tooltip displays for each status the sum of all of the CI’s children with 
that status.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

Rule (Rule #) Description
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Service Manager Calculation Rules

Rule (Rule #) Description

Number of Open 
Incidents 

(2600)

Returns the total number of incidents whose current state is the state 
specified in the Initial State parameter and whose severity is lower or 
equal to the value specified in the Severity parameter.

Incidents whose current state corresponds to the Final State or whose 
Severity is higher than the value specified in the Severity parameter are 
not included in the calculation.

Rule Parameters: 

"Initial State" on page 847

"Final State" on page 847

"Severity" on page 851

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Number of tickets" on page 860

"Grouping" on page 857

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

"Transaction" on page 863

Sum of Open 
Incidents 

(2601)

Calculates the sum of all the incidents of the children in the group.

Rule Parameters: 

"calc_method" on page 845

"hi_list" on page 847

Tooltip Parameters: 

None
828



Chapter 23 • Business Rule Repository
Siebel Calculation Rules

Rule (Rule #) Description

Number of Running 
Sessions Rule 

(1107)

The rule receives the number of sessions from the SiteScope Number of 
Running Sessions measurement and compares that result with the 
thresholds set for the rule. The result is the number of running sessions 
colored according to the thresholds set for the rule. This rule is used by 
the Application Management for Siebel solution.

Rule Parameters: 

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

"Measurement" on page 859

"Monitor" on page 859

"Historical Worst" on page 857

"Historical Average" on page 857

"Trend" on page 863

Number of Tasks in 
Error Rule 

(1101)

The rule receives the value of SiteScope Number of Tasks in Error 
measurement and compares that result with the thresholds set for the 
rule. The result is the number of tasks in error colored according to the 
thresholds set for the rule. This rule is used by the Application 
Management for Siebel solution.

Rule Parameters: 

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

"Measurement" on page 859

"Monitor" on page 859

"Historical Worst" on page 857

"Historical Average" on page 857

"Trend" on page 863
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SiteScope Calculation Rules

Sessions Custom Data 
Rule 

(1106)

Calculates the number of running sessions for a CI and all its child CIs.

Rule Parameters: 

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

"Measurement" on page 859

"Monitor" on page 859

"Historical Worst" on page 857

"Historical Average" on page 857

"Trend" on page 863

Rule (Rule #) Description

SiteScope Best Status 
Rule 

(3918)

A Health Indicator can receive multiple measurements from multiple 
SiteScope monitors. This rule calculates the best status of all of the 
measurements sent to the Health Indicator.

For example, if at least one measurement has green status, then the 
Health Indicator also displays green status.

Rule Parameters: 

"No data timeout" on page 849

"Tooltip show all measurements" on 
page 852

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Measurement" on page 859

"Last update" on page 858

"Monitor" on page 859

"Host" on page 857

Rule (Rule #) Description
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SiteScope Consecutive 
Worst Status Rule 

(3919)

A Health Indicator can receive multiple measurements from multiple 
SiteScope monitors. This rule calculates the worst status of all the 
measurements sent to the Health Indicator, using two rule parameters:

➤ Number of Consequent Samples defines the number of consecutive 
occurrences that are required in order for a measurement’s status to 
change.
For example, if the parameter is set to 3 and there are three 
consecutive critical measurements, the status of the measurements is 
set to critical.

If the measurement’s status is critical and a single measurement with 
OK status (green) is received, the measurement stays red. The status 
changes to green if two more consecutive OK measurements are 
received.

➤ Strict policy calculation defines if a measurement’s status will change 
only when the full number of consecutive statuses are received (as in 
the previous example), or if a single "better" measurement can change 
the measurement’s status.
For example, if the second option is defined, if the measurement’s 
status is red and an OK measurement is received, the status changes to 
green (since a single "better" measurement is sufficient to change its 
status). However, the measurement’s status will only change back to 
red if there are three consecutive critical measurements.

Rule Parameters: 

"No data timeout" on page 849

"Number of Consequent Samples" 
on page 849

"Strict policy calculation" on 
page 852

"Tooltip show all measurements" on 
page 852

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Measurement" on page 859

"Last update" on page 858

"Monitor" on page 859

"Host" on page 857

Rule (Rule #) Description
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SiteScope 
Measurement Rule 

(3)

Calculates the status based on metrics for a SiteScope measurement CI for 
sampleType: ss_t, monitored by the SiteScope Monitor. The following 
statuses correspond to the following values:

➤ Normal (1)

➤ Minor (2)

➤ Critical (3)

For details on the sample, see "Sample: SiteScope Measurement (ss_t)" in 
Reports.

Rule Parameters: 

"No data timeout" on page 849

"Number of Problematic Samples" 
on page 849

"Total Number of Samples" on 
page 852

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Error Message" on page 856

"Last update" on page 858

"Measurement" on page 859

"Monitor" on page 859

Rule (Rule #) Description
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SiteScope 
Measurement Siebel 
Processes Rule 

(1104)

Calculates the status based on metrics for a SiteScope measurement CI for 
time sampleType: ss_t, monitored by the SiteScope Monitor. The 
following statuses correspond to the following values:

➤ Normal (1)

➤ Minor (2)

➤ Critical (3)

The value displayed corresponds to the number of processes. The color of 
the value is determined by the thresholds on the number of sessions 
(which can be 25, 64, and so on).

For details on the sample, see "Sample: SiteScope Measurement (ss_t)" in 
Reports.

Rule Parameters: 

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

"Measurement" on page 859

"Monitor" on page 859

"Historical Worst" on page 857

"Historical Average" on page 857

"Trend" on page 863

Rule (Rule #) Description
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SiteScope 
Measurement Time-
Based Rule 

(33)

Calculates the status based on metrics for a SiteScope measurement CI for 
time sampleType: ss_t, monitored by the SiteScope Monitor. The 
following statuses correspond to the following values:

➤ Normal (1)

➤ Minor (2)

➤ Critical (3)

For details on the sample, see "Sample: SiteScope Measurement (ss_t)" in 
Reports.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

"Measurement" on page 859

"Monitor" on page 859

"Average For" on page 853

SiteScope 
Measurement with 
Custom Data Rule 

(1100)

Displays the number of tasks that are in error taken from the SiteScope 
samples with sub-samples listing all of the tasks. 

Rule Parameters: 

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

"Measurement" on page 859

"Monitor" on page 859

"Historical Worst" on page 857

"Historical Average" on page 857

"Trend" on page 863

Rule (Rule #) Description
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SiteScope Monitor 
Rule 

(4)

Calculates the status based on metrics for a SiteScope measurement CI for 
time sampleType: ss_monitor_t, monitored by the SiteScope Monitor. The 
following statuses correspond to the following values:

➤ Normal (1)

➤ Minor (2)

➤ Critical (3)

For details on the sample, see "Sample: SiteScope Measurement (ss_t)" in 
Reports.

Rule Parameters: 

"No data timeout" on page 849

"Number of Problematic Samples" 
on page 849

"Total Number of Samples" on 
page 852

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

"Monitor" on page 859

"Host" on page 857

Rule (Rule #) Description
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SiteScope Monitor 
Time-Based Rule 

(34)

Calculates the status based on metrics for a SiteScope measurement CI for 
time sampleType: ss_monitor_t, monitored by the SiteScope Monitor. The 
following statuses correspond to the following values:

➤ Normal (1)

➤ Minor (2)

➤ Critical (3)

For details on the sample, see "Sample: SiteScope Monitor (ss_monitor_t)" 
in Reports.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Average For" on page 853

"Last update" on page 858

"Monitor" on page 859

"Host" on page 857

SiteScope Profile Rule 

(35)

Calculates the status of the SiteScope Availability HI. SiteScope 
periodically (every minute) sends a heartbeat to BSM. If the heartbeat is 
received by BSM, the status of the SiteScope Availability HI is green. If the 
heartbeat is not received, the status of the SiteScope Availability HI is gray 
(No data). This indicates that there is no communication between 
SiteScope and BSM. The statuses of all the SiteScope CIs is also gray. 

Note: The SiteScope Availability HI displays values for the supported 
versions of SiteScope (9.0 and up) and of BSM (7.0 and up).

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Last update" on page 858 

Rule (Rule #) Description
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SiteScope Vertical 
Measurement 
(Deprecated)

(1102)

Deprecated.

Takes samples arriving from the Computer Center Management System 
(CCMS) monitor through SiteScope and displays them, as is, under SAP 
General HI. It also takes samples from Siebel Application Server or Siebel 
Web Server monitors and displays them as is under Siebel HIs.

Rule Parameters: 

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

"Measurement" on page 859

"Historical Worst" on page 857

"Historical Average" on page 857

"Trend" on page 863

"Monitor" on page 859

SiteScope Vertical Rule 
(Deprecated)

(1108)

Deprecated.

Takes samples arriving from the Computer Center Management System 
(CCMS) monitor through SiteScope and displays them as is under the SAP 
General HI. 

Rule Parameters: 

"No data timeout" on page 849

"Number of Problematic Samples" 
on page 849

"Total Number of Samples" on 
page 852

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

"Measurement" on page 859

"Monitor" on page 859

Rule (Rule #) Description
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SiteScope Worst 
Status Rule 

(3917)

A Health Indicator can receive multiple measurements from multiple 
SiteScope monitors. This rule calculates the worst status of all of the 
measurements sent to the Health Indicator.

For example, if at least one measurement has red status, then the Health 
Indicator also displays red status.

Rule Parameters: 

"No data timeout" on page 849

"Tooltip show all measurements" on 
page 852

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Message" on page 859

"Last update" on page 858

"Monitor" on page 859

"Host" on page 857

Rule (Rule #) Description
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SOA Calculation Rules

Rule (Rule #) Description

Real WS Operation 
Percentile 
Performance Rule 

(1302)

Calculates the percentile performance of a Web service operation defined 
as the percentage of calls that did not pass the diagnostics threshold out 
of available calls.

The rule works as follows:

1  Sums the number of available calls into sumOfAvailableCalls. The 
calculation for each sample is: 
calls_count - error_count

2  Sums the number of calls that did not pass the diagnostics threshold 
into sumOfNotOverThresholdCalls. The calculation for each sample is: 
calls_count - error_count - over_threshold_server_time

3  The result is calculated as: 
(sumOfNotOverThresholdCalls x 100) / sumOfAvailableCalls
calls_count, error_count, and over_threshold_server_time are sample 
fields.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

(Status can be defined as OK, 
Warning or Critical.)

"Business Rule" on page 854

"Held status since" on page 857

"Under threshold calls" on page 863

"Average For" on page 853

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857
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Real WS Operation 
Performance Rule 

(1301)

Calculates the performance of a Web service operation defined as the 
average server time (ms) of available calls. The average server time data is 
obtained from diagnostics samples.

The rule works as follows:

1  Sums the number of available calls into sumOfAvailableCalls. The 
calculation for each sample is: 
calls_count - error_count

2  Sums the server time of available calls into sumOfAvailableCallsTime.

3  The result is calculated as: 
sumOfAvailableCallsTime / sumOfAvailableCalls
calls_count, error_count, and avg_server_time are sample fields.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Average Response Time" on 
page 853

"Average For" on page 853

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Rule (Rule #) Description
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Real WS Operation 
Throughput Rule 

(1303)

Calculates the throughput of a Web service operation defined as the total 
number of calls divided by the time frame. The total number of calls is 
obtained from the Diagnostics sample. The time frame is defined in 
minutes, each time the rule is calculated according to the following 
formula: number of samples in the sample container x sample aggregative 
time. The aggregative sample time is 5 minutes.

The rule works as follows:

1  Sums the calls_count filed into sumOfTotalCalls.
sumOfTotalCalls / (sampleContainerSize x 5)

2  The result is calculated as:
calls_count is a sample field.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Calls per minute" on page 854

"Average For" on page 853

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Rule (Rule #) Description
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Synthetic WS 
Operation Percentile 
Performance Rule 

(1307)

Calculates the percentile performance of a Web service operation defined 
as the percentage of calls that did not pass the Business Process Monitor 
threshold out of available calls.

The rule works as follows:

1  Sums the number of available calls into sumOfAvailableCalls. The 
calculation for each sample is: 
calls_count - error_count

2  Sums the number of calls that did not pass the SiteScope threshold 
into sumOfNotOverThresholdCalls. The calculation for each sample is: 
calls_count - error_count - over_threshold_server_time

3  The result is calculated as: 
(sumOfNotOverThresholdCalls x 100) / sumOfAvailableCalls
calls_count, error_count, and over_threshold_client_time are sample 
fields.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Under threshold calls" on page 863

"Average For" on page 853

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Rule (Rule #) Description
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Synthetic WS 
Operation 
Performance Rule 

(1306)

Calculates the performance of a Web service operation defined as the 
average client time (ms) of available calls. The average server time data is 
obtained from Business Process Monitor samples.

The rule works as follows:

1  Sums the number of available calls into sumOfAvailableCalls. The 
calculation for each sample is: 
calls_count - error_count

2  Sums the number of available calls into sumOfAvailableCallsTime. 

3  The result is calculated as: 
sumOfAvailableCallsTime/sumOfAvailableCalls
calls_count, error_count, and avg_server_time are sample fields.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Under threshold calls" on page 863

"Average Response Time" on 
page 853

"Average For" on page 853

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Rule (Rule #) Description
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WS Operation 
Availability Rule 

(1300)

Calculates the availability of a Web service operation defined as the 
percentage of available calls out of total calls.

The rule works as follows:

1  Sums the calls_count field into sumOfTotalCalls.

2  Sums the number of available calls into sumOfAvailableCalls. The 
calculation for each sample is: 
calls_count - error_count

3  The result is calculated as:
(sumOfAvailableCalls x 100) / sumOfTotalCalls
calls_count and error_count are sample fields.

Rule Parameters: 

"duration" on page 846

"No data timeout" on page 849

Tooltip Parameters: 

"Status" on page 862

"Business Rule" on page 854

"Held status since" on page 857

"Avg. Availability" on page 854

"Average For" on page 853

"Last update" on page 858

"Major" on page 858

"Minor" on page 859

"Warning" on page 864

"Informational" on page 857

Rule (Rule #) Description
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List of Rule Parameters

The rule parameters are as follows:

Parameter Description

AtRiskWeight The weight assigned to At Risk instances to 
provide more importance to a specific status. 
You can assign any appropriate number with 
the following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation, or a negative number is 
considered to be 1.

Availability Field Internal parameter for the sample field used 
to calculate availability; do not modify this 
value.

BlockedWeight The weight assigned to Blocked instances to 
provide more importance to a specific status. 
You can assign any appropriate number with 
the following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation, or a negative number is 
considered to be 1.

calc_method For KPI rules, defines which indicators are 
used to calculate the KPI:
0 - HIs and child KPIs
1 - HIs only
2 - Child KPIs
3 - HIs; if none exist, use child KPIs
Default/Mandatory: 0/No

Calculate Volume By KPI Internal parameter showing which KPI the 
rule uses for calculation; do not modify this 
value.
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clearNormalStatuses If true, events with Normal status are not 
included in event-based HI calculation. Note 
that if this is false, the setting of 
reportNormalStatusesEvents is ignored.

Default: true; changing this default increases 
use of memory.

Critical weight The weight assigned to the Critical status. You 
can assign any appropriate number with the 
following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation.

Divide by field The name of the sample field whose sum is 
used together with the Sum field parameter to 
generate a rule calculation result as follows:
Sum of <Sum field> / Sum of <Divide by 
field> = rule result.

DollarImpactFactor The financial loss factor per hour. The 
financial loss factor is used to calculate the 
financial impact of a CI non-availability.

duration Service Health calculates CI status based on 
the samples received during the duration 
period (defined in seconds). For example, if a 
CI has a duration of 5 minutes, status is 
calculated based on the samples received 
during the past 5 minutes.

Default: 15 minutes

Factor The factor used to multiply the result of the 
operation performed on the two fields, before 
comparing the result to the thresholds.

Field Name The name of the sample field with a numeric 
value which is used to calculate the rule 
result.

Parameter Description
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Final State The final status of the incident received in the 
sample. 

Default: Closed.

first_choice_sample The sample type to be used when calculating 
data regarding sessions or connections. 
By default, the following samples are used: 
rum_eu_t, rum_tcp_eu_t, rum_server_t, and 
rum_tcp_server_t.

First Field Name The name of the first field on which to apply 
the rule. The field must have a numeric value.

Formula The formula to be used to calculate the value 
or the status of the KPI to which the Generic 
Formula rule is attached, for the time period 
specified in the duration parameter. 

HealthyWeight The weight assigned to Healthy instances to 
provide more importance to a specific status. 
You can assign any appropriate number with 
the following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation, or a negative number is 
considered to be 1.

hi_list For KPI rules, this is the list of HIs used to 
calculate the KPI. 
Default/Mandatory: (empty list)/No

Initial State The initial status of the incident received in 
the sample. 

Default: Open.

InitStatus Defines a different initial status of a group 
level CI’s KPI until samples are received. The 
default KPI status for rules that do not include 
an InitStatus parameter is No data. 

Parameter Description
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isGroovyRuleType Internal for API rules; do not modify.

KPI Calculation Script For API rules, defines the calculateKPI method 
implementation.
Default/Mandatory: (no default)/Yes

Latency Color field The name of the sample field which contains 
latency data.

logic Specifies the type of calculation the rule 
should perform. The valid values can be a 
subset of: maximum, minimum, average, or 
weighted-average.

Major weight The weight assigned to the Major status. You 
can assign any appropriate number with the 
following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation, or a negative number is 
considered to be 1.

Maximum number of 
samples

The number of most recent samples to be 
included in the API Sample Rule calculation.

maxNumOfDisplayedEv
ents

The maximum number of events that can be 
displayed in an event-based HI tooltip.

Default: 8; raising this default increases use of 
memory.

mean_value_field_name The name of the sample field whose values 
are used as the mean in calculating the 
baseline.

Minor weight The weight assigned to the Minor status. You 
can assign any appropriate number with the 
following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation.

Parameter Description
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No data timeout The timeout period for a KPI. Defines the 
number of seconds from the time the last 
sample was received for the KPI, until the KPI 
is timed out - at which point the KPI changes 
to No data). The default value for this 
property should be changed with caution. 
Note that a different default value may 
actually be used for Business Process Monitor 
transaction CIs.

Number of Consequent 
Samples

The number of consecutive occurrences that 
are required in order for a measurement’s 
status to change. For example, if the 
parameter is set to 3 and there are three 
consecutive critical measurements, the status 
of the measurements is set to critical.

Number of Problematic 
Samples

The number of samples that have the 
required status. A specified number of 
samples (specified in the Total Number of 
Samples parameter) is accumulated. The 
status of the rule changes to a new status only 
when, among the accumulated samples, the 
specified number of samples (specified in the 
Number of Problematic Samples parameter) 
has the new status. For example, Total 
Number of Samples=5, Number of 
Problematic Samples=3; if three samples in 
the accumulated samples have a red status, 
the rule status changes to red.

OK weight The weight assigned to the OK status. You can 
assign any appropriate number with the 
following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation.

Parameter Description
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Operator The operator used to calculate the result of 
the first and second fields. It can be: 
+, -, *, or /.

PassedStatus Status level that is set to serve as the lowest 
limit above which the instances are 
considered for the status calculation.
Example: If PassedStatus is defined as 15 
(Warning), all instances with status 15 or more 
(OK, or Warning) are PassedStatus instances. 
The instances with lower levels (Minor, Major, 
or Warning) are not taken into consideration 
in the status calculation.

relevant_samples Provides information about the sample on 
which the rule’s calculations are based. This 
parameter is used only in RUM Application / 
End User / Locations Session Statistics 
Monitor Availability / Performance / Volume 
rules.

reportNormalStatusesEv
ents

If true, events with Normal status are 
displayed in event-based HI tooltips. Note 
that if the setting of clearNormalStatuses is 
false, the setting of 
reportNormalStatusesEvents is ignored.

Default: false; changing this default increases 
use of memory.

Rule Template Setting 
Key

Internal for API rules; do not modify.

Sample Fields For API rules, defines the list of sample fields 
whose values can be included in the 
calculation.
Default/Mandatory: (no default)/No

Parameter Description
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sample_group_by_fields Provides information about the fields by 
which the samples are grouped. Samples are 
sent for each engine ID, location ID, end-user 
subgroup, and application. When a rule is 
calculated for one of these (for example for 
application), this parameter contains details 
regarding the other three elements. Samples 
are then aggregated based on the intersection 
of application with each of the three elements 
(engine, location, end-user).

Second Field Name The name of the second field on which to 
apply the rule. The field must have a numeric 
value.

Severity The severity of the sample incident that is 
used in the calculations. 
The values are:
5 – very low
4 – low
3 – medium
2 – urgent
1 – critical

StatusDimension Defines the ID of the KPI for which the other 
rule parameters apply when you want to use 
KPIs other than Availability.

std_field_name The name of the sample field whose values 
are used as the standard deviation in 
calculating the baseline.

Parameter Description
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Strict policy calculation Defines if a measurement’s status will change 
only when the full number of consecutive 
statuses are received, or if a single "better" 
measurement can change the measurement’s 
status. For example, if the second option is 
defined, if the measurement’s status is red and 
an OK measurement is received, the status 
changes to green.

Sum field The name of the sample field whose sum is 
used together with the Divide by field 
parameter to generate a rule calculation result 
as follows: 
Sum of <Sum field> / Sum of <Divide by 
field> = rule result.

Time Stamp Field The name of the time stamp field in the 
external source sample, if its name is not 
time_stamp.

Tooltip show all 
measurements

Defines whether the HI tooltip shows values 
of all the measurements that contributed to 
the HIs status (default: false).

Total Number of 
Samples

The total number of samples. See Number of 
Problematic Samples parameter for more 
details.

tracking period id Internal. This parameter must not be 
modified.

volumeKPI The KPI number of the Volume KPI (in EUM). 
Used to calculate rules in EUM group rules.

Warning Weight The weight assigned to the Warning status. 
You can assign any appropriate number with 
the following specific cases:
1 is the default.
0 causes the status to be ignored in the rule 
calculation.

Parameter Description
852



Chapter 23 • Business Rule Repository
List of Tooltip Parameters

The following table lists the tooltip parameters and their descriptions:

Parameter Description

% Available TX The percentage of available transactions.

Affected By The measurements which influenced the HI.

Alert Description The full description of the alert.

Application Exceptions The number of application exceptions 
monitored by HP Diagnostics.

At risk backlog The number of instances with At risk status.

Availability In EUM, the weighted average availability 
based on the total number of users accessing a 
page.

Availability (%) The availability of a Business Process Monitor 
or Real User Monitor transaction.

Average The average status of the CI.

Average Duration The duration of the completed transactions 
minus the duration of the failed transactions 
divided by the total number of transactions.

Average For The time period for which the average 
response time/average availability was 
calculated. This time period is defined in the 
file for the CI.

Average Net Time The average net time (total time minus user 
time) of a transaction monitored by Real User 
Monitor.

Average Response Time The average response time for a transaction.

Average Time The average latency of all of the server requests 
on the Virtual Machine monitored by the 
Probe over the last five minute period.
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Avg. Availability The percentage of successful runs for the 
parent transaction during a time period up to 
the last received update.

Backend Average 
Response

The average backend duration for successful, 
completed transactions.

Backend Maximum 
Response

The maximum backend duration for 
successful, completed transactions.

Backend Minimum 
Response

The minimum backend duration for 
successful, completed transactions.

Backlog count The number of backlogged (in-process) 
transactions.

Bandwidth The number of bytes that represents the traffic 
between the Real User Monitor application 
server and clients.

Blocked backlog The number of instances with Blocked status.

Business Loss The financial loss calculated for the CI.

Business Rule The name of the rule that calculates the KPI 
status or value.

Calculation Logic The value of logic rule parameter. 

Calculation duration Status status is calculated based on the samples 
received during the specified duration.

Calculation Time The last calculation time on the Business Logic 
Engine machine.

Calendar The calendar used for calculating PNR. For 
details, see "Calendars for SLAs" in Using Service 
Level Management.

Calls per minute  The number of calls per minute to the selected 
Web services or Operations.

Parameter Description
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Caused By The name of the KPIs that caused 
unavailability.

CI Name The name of the CI.

Class Type The CI’s CI Type.

Component Availability The availability of the Real User Monitor (for a 
monitor CI) or the status of the monitor with 
the worst status (for a group CI).

Count The number of instances that completed the 
monitored step or group of steps in the most 
recent collection interval for the tooltip.

Critical instances The number of instances with Critical status.

Critical samples The number of samples with Critical status.

Delays Rate The percentage of failed in-process 
transactions out of the total completed 
transactions. Delays ValueThe total value of 
failed in-process transactions.

Delays Value The total value of failed in-process 
transactions. 

Description A description of the CI (the first one represents 
UDX and the second one represents EMS). 
Only the value relevant to the context is 
displayed.

Downtime Until The date and time that downtime is due to 
finish for a CI.

End User Average 
Response

The average end user duration for successful, 
completed transactions.

End User Maximum 
Response

The maximum end user duration for 
successful, completed transactions.

Parameter Description
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End User Minimum 
Response

The minimum end user duration for 
successful, completed transactions.

End-to-end Average 
Response

The average duration for successful, completed 
transactions.

End-to-end Maximum 
Response

The maximum duration for successful, 
completed transactions.

End-to-end Minimum 
Response

The minimum duration for successful, 
completed transactions.

EMS Events The samples description. The samples are 
separated from each other by a horizontal line.

Error Message The error message that appears in the sample.

Exceptions Count The amount of exceptions generated over the 
last five minute period.

Exceptions Rate The percentage of transactions that did not 
follow the expected flow path on the target 
machine, out of the total in-process 
transactions.

Exceptions Value The total value of transactions that did not 
follow the expected flow path on the target 
machine.

Failed TX Count The number of transactions that failed.

Failed TX Impact The financial loss (in $) due to transactions 
that failed.

Failures rate The percentage of failed completed 
transactions out of the total number of 
completed transactions.

Formula The formula that is used to calculate the KPI 
status and value.

Parameter Description
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Grouping List the number of tickets with the specified 
status.

Healthy backlog The number of instances with Healthy status.

Held status since The date and time of the last status (color) 
change of the CI. 

Hidden Child CIs Child CIs not currently displayed.

Historical Average The average status for the CI over a period of 
time.

Historical Worst The worst status for the CI over a period of 
time.

History Type The history calculation type to be used when 
calculating history status. Values can be: 
Worst, Average, or None (no history status 
displayed). The value of the parameter is 
assigned to the HistoryType rule global 
parameter. For details, see "Modify global rule 
parameters" on page 727. If the value is none, 
the historical information is not displayed.

Host The name of the machine associated with the 
monitor.

Informational One of the thresholds used when defining 
status for the CI. The CI changes to 
Informational (green) status when the CI’s 
score is equal to or smaller than this value.

Informational instances The number of instances with status 
Informational.

Invisible Calculated 
Children

All of the child CIs belonging to other views, 
which are connected to this CI but do not 
belong to this view.

Parameter Description
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Invisible Children The number of child CIs of the selected CI, 
that exist in the RTSM, are hidden in the 
current view, and have at least one KPI 
assigned to them. This parameter is displayed 
as: Hidden child CIs (with attached KPIs) in 
the tooltip itself. For details on Invisible 
Children, see "How to Find Visible and Hidden 
Child CIs" on page 78.

Last update The date and time that the last update for the 
CI was received by Service Health.

Late TX Impact The financial loss (in $) due to transactions 
that were late.

Latency The average round trip time for a packet. (The 
time it takes for a packet to go from the client 
to the server and back from the server to the 
client). The latency information is provided by 
the Real User Monitor sample.

Location The location of the CI if a location has been 
specified.

Major One of the thresholds used when defining 
status for the CI. The CI changes to Major 
(orange) status when the CI’s score is equal to 
or smaller than this value.

Major instances The number of instances with Major status.

Major samples The number of samples with Major status.

Max Response Time The maximum response time for a transaction.

Max Time The maximal time an HP Diagnostics 
transaction has run in seconds.

Max Unavailability The maximum time that the item may be 
unavailable, according to the SLA.

Parameter Description
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Maximum The maximum value of the instances that 
passed through the monitored step or group of 
steps, during the last collection interval. 

Measurement The name of the measurement from SiteScope.

Message One or more values returned by the monitor 
the last time it ran, as displayed in SiteScope. 
This may simply be the retrieval time and file 
size or it may include specific parameters for a 
server component.

Min Response Time The minimum response time as provided by 
the Deep Transaction Tracing sample.

Min Status The value of the PassedStatus rule parameter. 

Minimum The minimum duration of the instances that 
passed through the monitored step or group of 
steps, during the last collection interval 

Minor One of the thresholds used when defining 
status for the CI. The CI changes to Minor 
(yellow) status when the CI’s score is equal to 
or smaller than this value.

Minor instances The number of instances with Minor status.

Minor samples The number of samples with Minor status.

Monitor The monitor type that the CI represents.

Network Availability The percentage of successful connections.

Number of Actions The number of actions on the application.

Number of Connections The number of connections monitored by Real 
User Monitor.

Number of Error Events The number of error-type events monitored by 
Real User Monitor.

Parameter Description
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Number of Information 
Events

The number of informational events 
monitored by Real User Monitor.

Number of instances The number of instances that completed the 
monitored step or group of steps.

Number of Open 
Sessions

The number of open sessions on the 
application, EUG subgroup, or location.

Number of 
Performance Events

The number of performance-type events 
monitored by Real User Monitor.

Number of tickets The number of current ticket that have the 
specified initial and final state.

Number of Transaction 
Hits

The number of times a transaction was 
completed successfully.

Number of transactions The total number of successful, completed 
transactions.

Number of Valid 
Transactions

The number of successful, completed 
transactions monitored by TransactionVision.

OK One of the thresholds used when defining 
status for the CI. The CI changes to OK (green) 
status when the CI’s score is equal to or smaller 
than this value.

OK Instances The number of instances with OK status.

OK samples The number of samples with OK status.

Open Time The date and time when the alert was issued.

owned By The owner of the CI in HP OpenView (the first 
one represents UDX and the second one 
represents EMS). Only the value relevant to 
the context is displayed.

Performance The average download time, for a Real User 
Monitor CI.

Parameter Description
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Performance (%) The percentage of Real User Monitor sessions 
without performance events.

Platform Indicates the platform (J2EE or .NET) on which 
the monitored application is running.

PNR Availability The item’s SLA availability percentage the last 
time data was polled.

PNR Time Left The amount of time left for that measurement 
before the SLA is in breach of contract. 

Response Time 
Threshold

The threshold of the response time as provided 
by the Deep Transaction Tracing sample.

Score The percentage of green and yellow child CIs. 
This is a weighted percentage if any of the 
child CIs have a weight > 1 (check this by 
viewing the tooltips for the child CIs).

Note that Service Health is calculating status 
using the refined percentage method if a 
percentage is displayed for Score and the 
group or subgroup status is yellow.

If Service Health is calculating status for the 
group/subgroup using the dominant child 
method, the message n/a (Using dominant 
child) is displayed.

Server Requests Count (BPM Transaction tooltips only.) The amount 
of server requests over the last five minute 
period.

Server Time (BPM Transaction tooltips only.) The average 
time taken for the server to process the 
transaction.

Parameter Description
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Severity The severity of the SiteScope measurement 
(the first one represents UDX and the second 
one represents EMS). Only the value relevant 
to the context is displayed.

Short Name The name of the SAP CCMS measurement 
where the alert occurred.

SLA The name of the SLA attached to this CI

State The SAP state of the alert: Active.

Status CI or indicator status (calculated according to 
one of the status calculation methods).

It may also display:

Not up to date for decayed CIs, indicating that 
the CI has passed its timeout period. (For a 
SiteScope CI, this status is displayed after a 
SiteScope monitor is disabled.)

Stopped when a Business Process profile is 
stopped.

Status Can be defined as OK, Warning or Critical.

Status for The value of the rule’s duration parameter.

Target Availability The percentage of time that the item must be 
available to match the ‘Exceeded’ threshold, 
according to the SLA.

Timeout Count The amount of timeouts that occurred during 
the last five minute period.

Total The total number of hits/transactions for Real 
User Monitor.

Total number of 
incidents

The total number of incidents.

Parameter Description
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Total TX Count The total of the number of transactions that 
failed and the number of late transactions.

Total TX Impact The financial loss (in $) due to transactions 
that failed added to the transactions that were 
late.

Tracking Period The tracking period used to calculate the PNR. 
For details, see "Tracking Periods Dialog Box" 
in Using Service Level Management.

Transaction The name of the parent transaction for the CI.

Transaction Count The number of transactions monitored by 
HP Diagnostics.

Transaction Server Time The average server time of a transaction 
monitored by Real User Monitor.

Transaction Total Time The average total time of a transaction 
monitored by Real User Monitor.

Transactions volume The number of completed transactions.

Trend The trend of the KPI’s status.

Under threshold calls The number of calls that are under the 
threshold defined for the Application 
Availability KPI.

Value The value of the field in the sample.

Value The sum of the values of the fields in the 
sample.

Value For The collection interval for which the HI is 
calculated.

Volume The number of hits in Real User Monitor.

Parameter Description
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Warning One of the thresholds used when defining 
status for the CI. The CI changes to Warning 
(light green) status when the CI’s score is equal 
to or smaller than this value.

Warning instances The number of instances with Warning status.

Warning samples The number of samples with Warning status.

Weighted Average The value of the weighted average duration 
calculated by the rule.

Parameter Description
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Example of EUM Weighted Average Rule 

The following section shows an example of an EUM weighted average rule. 
This example uses the Average Performance of Weighted Volume rule. 
Similar calculation logic is used by the following weighted average rules: 

➤ Average Availability of Weighted Volume 

➤ Average Performance of Weighted Volume

➤ Average Network of Weighted Volume 

➤ Average Performance of Weighted Volume (Available Hits) 

➤ Real User Transaction Performance Rule 

➤ Synthetic User Transaction Performance

Example of the Average Performance of Weighted 
Volume rule
In the following example, the Average Performance of Weighted Volume 
rule is used to calculate the Performance KPI on an application, which has 
three transactions as child CIs (T1, T2, and T3). 

Each of these child CIs has two KPIs assigned: Volume (number of hits), and 
Performance.

The following table shows the statuses of the child CIs:

The rule calculates the weighted average as follows: 

(2*7*1) + (3*5*1) + (1*10*1) / (7+5+10) = 1.77

Child CI Status Volume
Weight 
(default)

T1 Minor (2) 7 1

T2 Critical (3) 5 1

T3 OK (1) 10 1
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The weighted average value (1.77) exceeds the Minor threshold (1.66), so 
the status of the Performance KPI on the application is Minor.

Rule calculation logic
The rule’s calculation logic is as follows:

(Critical value (3) * Number of Critical hits * Weight) + 
(Minor value (2) * Number of Minor hits * Weight) + 
(OK value (1) * Number of OK hits * Weight)

divided by 

(Number of Critical hits * Weight) + 
(Number of Minor hits * Weight) + 
(Number of OK hits * Weight)

Critical threshold = 2.33; Minor threshold = 1.66.

Changing status weights in the Infrastructure Settings
The rule calculates the average status, weighted by the values specified in 
the Reports Status Average Rule - <OK/Minor/Critical> Status weight 
infrastructure settings. If one of those weights is set to 0, the status is not 
included in the calculation of the average. 

By default, the weights are set to 1. To modify the weight of a status, select 
Admin > Platform > Setup and Maintenance > Infrastructure Settings: 

➤ Select Applications.

➤ Select End User/System Availability Manager.

➤ In the Data table, locate the following entries and change to the required 
weight:

➤ Reports Status Average Rule - Critical Status weight

➤ Reports Status Average Rule - Minor Status weight

➤ Reports Status Average Rule - OK Status weight
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Examples of Tooltips 

The following section shows examples of tooltips.

Example of a Number of Open Incidents Tooltip
The tooltip is displayed for an HI whose associated rule is "Number of Open 
Incidents" on page 828.

The tooltip displays the following information:

➤ Status. The status of the CI.

➤ Business Rule. The name of the rule used to calculate the status of the CI.

➤ Held Status Since. The date and time of the last status (color) change of 
the CI. 

➤ Number of Tickets. The number of incidents whose current state is the 
state specified in the Initial State parameter, and whose severity is lower 
or equal to the value specified in the Severity parameter.

➤ Grouping. Lists the number of incidents with the specified status.

➤ OK. The threshold definition for the OK status.
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Example of a SiteScope EMS Rule Tooltip
The tooltip is displayed for an Application, Network, Security, or System KPI 
whose associated rule is "SiteScope EMS Multiple Events Rule" on page 824.

The SiteScope EMS Rule tooltip is displayed for an Application, Network, 
Security, or System KPI whose associated rule is the SiteScope EMS Multiple 
Event rule.

The tooltip displays the following information:

➤ Status. The severity of the event.

➤ Business Rule. The name of the rule that calculates the KPI status or value.

➤ Held status since. The date and time of the last status (color) change of 
the CI.

➤ Ems Events. Messages sent by the HP Operations Manager server.

Business Rules User Interface

This section includes:

 ➤ Business Rules Repository page on page 869

 ➤ New Rule/Edit Rule Dialog Box on page 871

 ➤ New/Edit Rule Parameter or New/Edit Rule Threshold Dialog Box 
on page 877

 ➤ New/Edit Tooltip Parameter Dialog Box on page 878

 ➤ Restore Defaults Dialog Box on page 880
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 ➤ Global Parameters Dialog Box on page 880

 ➤ New/Edit Global Parameter Dialog Box on page 885

 ➤ Global Tooltips Dialog Box on page 886

 ➤ Edit Global Tooltip Dialog Box on page 888

Business Rules Repository page

This page displays the list of predefined and customized rules. These rules 
are available throughout HP Business Service Management to determine 
how source data is imported. The repository enables an advanced user to 
modify existing repository rules and create new ones.

Note: For details on each of the rules, see "List of Calculation Rules in 
Service Health" on page 740.

To access Select Admin > Service Health > Repositories > Business 
Rules

Important 
information

To modify a rule, select the rule and click the Edit 
button, or right-click the rule and access the Edit menu 
command. For details, see "New Rule/Edit Rule Dialog 
Box" on page 871.

In the text box under each of the column titles, you 
can enter text or select options from a drop-down list 
to filter the information displayed. For example, if you 
enter EUM in the text box under the Domain column 
title, the table only shows rules related to End User 
Management.

Relevant tasks "How to Customize a Business Rule Template in the 
Repository" on page 724
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User interface elements are described below:

UI Element (A-Z) Description

New Rule. Click to create a new rule. 

Edit Rule. Click to edit the details of a selected rule. 

Clone Rule. Select a rule and click the Clone Rule 
button to create a new rule, using the selected rule as a 
template. Select multiple rules by holding down the 
CTRL key. 

Delete Rule. Deletes one or more selected custom rules. 

If you delete a Predefined (Customized) Rule, it is 
restored to its Predefined settings.

Predefined rules cannot be deleted. 

Restore to Default. Select an edited rule whose Type is 
Predefined (Customized), and click to restore it to its 
original settings.

Click to refresh the page.

Click to display help on predefined rules.

Edit Globals. Click to edit global rule attributes. For 
details, see "Global Parameters Dialog Box" on 
page 880.

Edit Global Tooltips. Click to edit global tooltips. For 
details, see "Global Tooltips Dialog Box" on page 886.

Export to Excel. Click to export the table to an Excel 
file.

Export to PDF. Click to export the table to a PDF file.
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New Rule/Edit Rule Dialog Box

This dialog box enables you to create or modify rule properties.

Change visible columns. Opens the Choose Columns 
to Display dialog box, where you select the columns 
you want to display in the table.

By default, the Rule ID column which contains internal 
Rule ID numbers is not displayed.

Description The description of the rule.

Domain The domain which uses the rule (for example BPI, 
EUM, and so on). You can type a domain in the text 
box under the Domain column title, to only display 
rules in a specific domain.

Name The name of the rule.

Type Indicates one of the following rule types:

➤ Custom. New or cloned rules.

➤ Predefined. Out-of-the-box rules.

➤ Predefined (Customized). Out-of-the-box rules that 
have been edited. You can restore such a rule to its 
original settings using the Restore to Default 
button.

To access In the Business Rule Repository page, click the New 
Rule button, or select a rule and click the Edit Rule 
button.

Relevant tasks "How to Customize a Business Rule Template in the 
Repository" on page 724

UI Element (A-Z) Description
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General Rule Settings Area

User interface elements are described below:

Advanced Rule Settings Area

This area enables you to select the CI types for which a rule can be applied, 
and to define rule units.

User interface elements are described below:

UI Element (A-Z) Description

Class Name The name of the class the rule belongs to.

If you create a new rule using a new class, edit this field 
to include the full qualified name of the Java class that 
implements the rule, with the full path to the root.

Description The description of the rule.

Domain The domain which uses the rule (for example BPI, or 
EUM). 

You can select one of the default domains from the 
Selection drop-down list, or select Other and type a 
new domain name.

In the Business Rule Repository page, you can filter by 
domain to only see rules that are relevant to you.

Name The name of the rule.

UI Element (A-Z) Description

Select a CIT and click this button to add it to the 
Selected CI Types list.

If you select an upper-level (parent) CIT, the rule will 
be applicable for all of its descendant (child) CITs as 
well.

Select a CIT and click to remove it from the Selected CI 
Types list.
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Rule Parameters Area

This area enables you to modify existing information or enter new 
information about a rule's parameters. 

To modify a parameter, select the parameter and click the Edit button. For 
details, see "New/Edit Rule Parameter or New/Edit Rule Threshold Dialog 
Box" on page 877.

Applicable for CI 
Types

Define the CI types for which the rule is applicable, 
using the two areas:

➤ CI Types. Tree of CI types that contains the CITs to 
which you can make the rule applicable.

➤ Selected CI Types. The CITs for which the rule is 
applicable. When a CIT is selected, all its 
descendants are applicable to the rule as well.

Use the arrow buttons to move CITs from one list to 
the other.

Rule Type Select one of the following options:

➤ Health Indicator. The rule can be used to calculate 
health indicators.

➤ KPI. The rule can be used to calculate KPIs.

➤ Sibling. The rule can be used to calculate both KPIs 
and health indicators.

For details, see "Health Indicator and KPI Calculation 
Rules" on page 713.

Units Enter the type of unit applicable to the rule results. For 
details, see "Units of Measurement for Thresholds" on 
page 406.

UI Element (A-Z) Description
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User interface elements are described below:

Rule Thresholds Area

This area enables you to modify existing information or enter new 
information about a rule's thresholds.

To modify a threshold, select the threshold and click the Edit button. For 
details, see "New/Edit Rule Parameter or New/Edit Rule Threshold Dialog 
Box" on page 877.

UI Element (A-Z) Description

New Rule Parameter. Click to create a new rule 
parameter.

Delete Rule Parameter. Deletes one or more selected 
rule parameters.

Edit Rule Parameter. Click to edit the details of a 
selected rule parameter.

Select all. Selects all the rule parameters.

Clear Selection. Clears the selection of rule parameters.

Configurable If true, the parameter is visible and open for editing in 
the Assignments and CI Indicators tabs. If false, the 
parameter can only be edited in the repository.

Default value The default value of the parameter.

Description The parameter description.

Name The name of the parameter.
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User interface elements are described below:

Tooltip Settings Area

User interface elements are described below:

UI Element (A-Z) Description

New Rule Threshold. Click to create a new rule 
threshold.

Delete Rule Threshold. Deletes one or more selected 
rule thresholds.

Edit Rule Threshold. Click to edit the details of a 
selected rule threshold.

Select all. Selects all the rule thresholds.

Clear Selection. Clears the selection of rule thresholds.

Default value The default value of the threshold.

Description The threshold description.

Name The name of the threshold.

UI Element (A-Z) Description

Description The name of the tooltip.

Max Label Width The maximum width for a tooltip parameter name.

Max Value Width The maximum width for a tooltip parameter value.
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Tooltip Parameters Area

This area enables you to modify existing information or enter new 
information about a rule's tooltip parameters. For a list of tooltips and their 
default parameters, see "Examples of Tooltips" on page 867.

User interface elements are described below:

UI Element (A-Z) Description

New Tooltip Parameter. Click to create a new tooltip 
parameter. For details, see "New/Edit Tooltip Parameter 
Dialog Box" on page 878.

Delete Tooltip Parameter. Deletes one or more selected 
tooltip parameters.

Edit Tooltip Parameter. Click to edit the details of a 
selected tooltip parameter. For details, see "New/Edit 
Tooltip Parameter Dialog Box" on page 878.

Select all. Selects all the tooltip parameters.

Clear Selection. Clears the selection of tooltip 
parameters.

Name The display label of the tooltip parameter (this appears 
exactly as written).

Source The source of the value to display.
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New/Edit Rule Parameter or New/Edit Rule Threshold 
Dialog Box

This dialog box enables you to modify existing information or enter new 
information about a rule’s parameters or thresholds.

User interface elements are described below:

To access In the New Rule or Edit Rule dialog box, in the Rule 
Parameters or Rule Thresholds area; click the New 
button to enter new parameters or thresholds, or click 
the Edit button to modify a parameter or threshold.

Important 
information

➤ For a list of rule parameters and their default values, 
see each rule description in "List of Calculation Rules 
in Service Health" on page 740.

If the CalculationGranularity parameter is not 
changed when there is a heavy calculation load, this 
does not cause wrong results, but note that 
calculations are done on a longer time scale (for 
example, calculation may be done on a history size 
of three hours instead of one hour).

➤ Default threshold values are defined for every rule 
that uses thresholds. For details, see "KPI and HI 
Thresholds" on page 401.

Relevant tasks "How to Customize a Business Rule Template in the 
Repository" on page 724

UI Element (A-Z) Description

Default value The default value of the parameter or threshold in 
Service Health. Note that for some of the rules, the 
default values can be: sampleBased or timeBased and 
indicates if the calculation performed by the rule is 
based on the sample values or is calculated.

Description The parameter or threshold description.

Name The name of the parameter or threshold.
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New/Edit Tooltip Parameter Dialog Box

This dialog box enables you to modify existing information or enter new 
information about a tooltip parameter.

Parameter value is 
configurable

If the check box is checked, the parameter is visible and 
open for editing in the Assignments and CI Indicators 
tabs. If it is unchecked, the parameter can only be 
edited in the repository.

Presentation class The name of the presentation class. For future use.

Type The type of parameter or threshold. Possible values are: 
Boolean (can be false or true), Integer, Long, Double 
(can be a decimal number), or String.

Units The type of unit applicable to the rule parameter or 
threshold (for example, milliseconds for performance 
time data). 

For details, see "Units of Measurement for Thresholds" 
on page 406.

To access In the New Rule or Edit Rule dialog box, in the Tooltip 
Parameters area; click the New button to enter new 
parameters, or click the Edit button to modify a 
parameter.

Important 
information

A list of the parameters and their details is available in 
"List of Tooltip Parameters" on page 853.

Relevant tasks "How to Customize a Business Rule Template in the 
Repository" on page 724

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Formatting Method Define the method for formatting the value of the 
tooltip parameter using the following options:

➤ Selection. Select a formatting method from the list 
of available methods (leave blank if not required). 
For details, see "List of Formatting Methods" on 
page 676.

➤ Other. Specify a method that you have defined, 
which is not on the list of available methods.

Example: toLowerCase

Name The name of the parameter as it is displayed in the 
tooltip.

Value Postfix The text that appears after the value of the tooltip 
parameter. 

Example: %

Value Prefix The text that appears before the value of the tooltip 
parameter. 

Example: Greater than

Value Source The source of the value to display. It can be retrieved 
from the CI using the escaping sequence form - if so, 
the [[%]] string must appear before the escaping 
sequence.

Example: If the CI holds a field named country, type 
[[%]] NODE.PROPS.country. The tooltip displays 
country: <country name>.
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Restore Defaults Dialog Box

This dialog box enables you to restore predefined business rule settings, for 
rules whose type is Predefined (Customized).

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Global Parameters Dialog Box

This dialog box enables you to modify the global parameters shared by all 
the rules. For details, see "List of Global Rule Parameters" on page 882.

To access In the Edit Rule dialog box, click the Restore Default 
button.

Relevant tasks "How to Customize a Business Rule Template in the 
Repository" on page 724

UI Element (A-Z) Description

<Modified fields> The rule definition fields that have been modified are 
displayed. 

Select the fields which you want to restore to default, 
and click Save.

To access In the Business Rule Repository page, click the Edit 
Globals button. 
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

To modify a global parameter, select the parameter and 
click the Edit button, or right-click the parameter and 
access the Edit menu command. For details, see 
"New/Edit Global Parameter Dialog Box" on page 885.

To override a global parameter value for an individual 
rule, add the parameter to the relevant rule, and then 
modify its value.

Relevant tasks "How to Customize a Business Rule Template in the 
Repository" on page 724

UI Element (A-Z) Description

New Global Parameter. Click to create a new global 
parameter.

Delete Global Parameter. Deletes one or more selected 
global parameters.

Edit Global Parameter. Click to edit the details of a 
selected global parameter.

Select all. Selects all the global parameters.

Clear Selection. Clears the selection of global 
parameters.

<Name> The name of the global parameter. For details on each 
of the global parameters, see "List of Global Rule 
Parameters" on page 882.

<Value> The value of the global parameter.
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List of Global Rule Parameters

Display Name
Usual 
Default 
Value

Description

saveLastSample false Defines whether the last sample is presented in 
Service Health when clicking on the status icon. 
For details, see "How to Set Up Rules to Display 
the Last Sample Details" on page 734.

HistoryType Worst Defines the type of history calculation to be 
used when calculating history status. Values 
can be: Worst, Average, or None (no history 
status displayed). For details, see "History 
Calculation" on page 409.

HistorySize 1 hour Defines a time period (in hours) used when 
calculating history and trend status. 

The range is 1 to 6 hours.

For details, see "History Calculation" on 
page 409.

saveValuesToPersis
tency

false Set saveValuesToPersistency to true if you want 
Service Health to save CIs and KPIs value data 
to be displayed in the KPI Over Time with Value 
report. For details, see "KPIs Over Time Report" 
on page 347.

saveValuesToPersis
tencyInterval

900 Defines the periodicity (in minutes) with which 
the value of the KPI is saved to the RTSM (to be 
used in KPI Over Time with Value reports). For 
details, see "KPIs Over Time Report" on 
page 347.

Calculate Trend true Defines whether the trend should be calculated 
(and displayed) or not. For details, see "Trend 
Calculation" on page 410.
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Hidden Parameters

The history and trend statuses use the following hidden parameters. These 
are parameters with default values that are not visible to the user. However, 
if necessary, they can be overridden by defining the parameter in the global 
parameters for the Business Rule Repository. For details on the Trend and 
History statuses, see "KPI Trend and History Calculation" on page 408.

Name
Default 
Value

Description

TrendRate 0.3 Sets the time rate between the long window 
(period of time defined by the HistorySize 
parameter) and a short window.
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CalculationGranularity 20 Sets the time difference, in seconds, between 
recalculating statuses for a view. This 
knowledge is shown in <Data Processing 
Server root directory>
\log\EJBcontainer\TrinityStatistic.log.

This determines how many calculations are 
performed for a CI in a certain period of 
time. During normal functioning, Service 
Health perform the calculation 
approximately every 20 seconds (~180 
calculations/hour) and there is no reason to 
change the default value.

If Service Health has a heavy calculation 
load, causing the calculations to take more 
time (for example, calculations may be done 
on a history size of three hours instead of 
one hour), Service Health might 
automatically adjust the granularity to 
calculate less often. For example, calculation 
may take place every minute or more, 
meaning 60 or less calculations an hour. 

If this calculation rate presents a problem, 
you can define the CalculationGranularity 
parameter above, to override the automatic 
granularity rate; however, this modification 
should be made with great caution, and only 
by advanced users. Contact HP Software 
Support for assistance.

Name
Default 
Value

Description
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New/Edit Global Parameter Dialog Box

This dialog box enables you to define settings of a global parameter.

User interface elements are described below:

To access In the Global Parameter dialog box, click the New 
button, or select a global parameter and click the Edit 
button.

Important 
information

The global parameters are listed in "List of Global Rule 
Parameters" on page 882.

To override the global parameter value for an 
individual rule, add the parameter to the relevant rule, 
and then modify its value.

Relevant tasks "How to Customize a Business Rule Template in the 
Repository" on page 724

UI Element (A-Z) Description

Name The name of the global parameter.

Type The type of parameter; select Boolean, Number, or 
String.

Value The value of the global parameter.
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Global Tooltips Dialog Box

This dialog box enables you to modify general tooltips that can be 
applicable to all relevant rules. For details, see "List of Global Tooltips" on 
page 887.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In the Business Rule Repository page, click the Edit 
Global Tooltips button. 

Important 
information

To modify a global tooltip, select the tooltip and click 
the Edit button, or right-click the tooltip and access the 
Edit menu command. For details, see "Edit Global 
Tooltip Dialog Box" on page 888.

You cannot create a new global tooltip.

Relevant tasks "How to Customize a Business Rule Template in the 
Repository" on page 724

UI Element (A-Z) Description

Edit Global Tooltip. Click to edit the details of a 
selected global tooltip.

Delete Global Tooltip. Select a modified tooltip labeled 
Predefined (Customized), and click Delete to restore 
the tooltip to its out-of-the-box settings.

Clear Selection. Clears the selection of global tooltips.

Description The user-facing name of the global tooltip. For details 
on each of the global tooltips, see "List of Global 
Tooltips" on page 887.
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List of Global Tooltips

Tooltip Name The internal name of the global tooltip. For details on 
each of the global tooltips, see "List of Global Tooltips" 
on page 887.

Type Either Predefined for out-of-the-box tooltips, or 
Predefined (Customized) for tooltips that have been 
edited.

Tooltip Description Tooltip Parameters

CI Data Defines the tooltip used for CI 
information.

➤ CI Name

➤ Class Type

➤ Hidden Child CIs

Downtime Defines the tooltip used for CIs in 
downtime.

➤ Status

➤ Held status since

➤ Downtime Until

➤ Location

➤ Caused By

Event Based HI Defines the tooltip used for event-
based health indicators. This tooltip 
shows event details, when a single 
event impacts a single HI.

See "Event-Based HI 
Tooltip Fields" on 
page 273.

HI Impacted by 
Several Events

Defines the tooltip used for health 
indicators which are influenced by 
several events.

➤ Status

➤ Affected By

History Defines the tooltip used for the 
History KPI. For details, see "KPI Trend 
and History Calculation" on page 408.

Note: The information that is 
displayed depends on the value 
assigned to the HistoryType rule global 
parameter.

➤ History Type

➤ Historical Worst

➤ Historical Average

UI Element (A-Z) Description
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Edit Global Tooltip Dialog Box

This dialog box enables you to define settings of a global tooltip.

No Data Defines the tooltip used for CIs with 
No data status.

➤ Status

➤ Held status since

➤ Warning

➤ Last update

➤ Location

➤ Caused By

➤ Error Message

Stopped Defines the tooltip used for stopped 
CIs.

➤ Status

➤ Held status since

➤ Location

➤ Caused By

Subcomponent 
HI Tooltip

Defines the tooltip used for health 
indicators which are influenced by 
several events, when HI status is OK.

➤ Status

Trend Defines the tooltip used for the Trend 
KPI. For details, see "KPI Trend and 
History Calculation" on page 408.

➤ Trend

To access In the Global Tooltip dialog box, select a global tooltip 
and click the Edit button.

Important 
information

The global tooltips are listed in "List of Global Tooltips" 
on page 887.

Relevant tasks "How to Customize a Business Rule Template in the 
Repository" on page 724

Tooltip Description Tooltip Parameters
888



Chapter 23 • Business Rule Repository
Tooltip Settings Area

User interface elements are described below:

Tooltip Parameters Area

This area enables you to modify existing information or enter new 
information about a global tooltip’s parameters.To modify a tooltip 
parameter, select the parameter and click the Edit button. For details, see 
"New/Edit Tooltip Parameter Dialog Box" on page 878.

User interface elements are described below:

UI Element (A-Z) Description

Description The name of the tooltip.

Max Label Width The maximum width for a tooltip parameter name.

Max Value Width The maximum width for a tooltip parameter value.

UI Element (A-Z) Description

New Tooltip Parameter. Click to create a new tooltip 
parameter.

Delete Tooltip Parameter. Deletes one or more selected 
tooltip parameters.

Edit Tooltip Parameter. Click to edit the details of a 
selected tooltip parameter.

Select all. Selects all the tooltip parameters.

Clear Selection. Clears the selection of tooltip 
parameters.

Name The display label of the tooltip parameter (this appears 
exactly as written).

Source The source of the value to display.
889



Chapter 23 • Business Rule Repository
Troubleshooting and Limitations

This section includes troubleshooting for Service Health calculation rules.

KPI Status is Always No Data

Problem: If your RTSM model contains CIs in a cyclic loop of impact 
relationships (for example, CI1 > CI2 > CI1 and so on), KPI status on the CIs 
in this loop, and on the CIs impacted by them, is always No Data. This 
indicates a modeling problem, since the business logic engine is designed to 
process a-cyclic graphs.

Solution: Within Platform > System Health, the BLE Online Monitor 
contains a measurement called Cyclic Impact Detector, which can show you 
if you have such a loop. For details, see "Data Processing Server Monitors" in 
Platform Administration.

In addition, you can use the following entries in the JMX Console to resolve 
the problem. Enter the following URL:

http://<Data Processing Server>:29800/mbean?objectname=BSM-
Platform%3Aservice%3DCalculation+Adapter

Use the following entries:

➤ getRejectedNodes. Gets a list of nodes (CIs) that meet the above 
description.

➤ getCyclicLinks. Gets the links that form a cyclic loop. To form a valid 
model you can removing these physical links, or re-define the impact 
relationships to meet your modeling requirements, as long as there are no 
impact cycles in the model.
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24
Context Menu Repository

This chapter includes:

Concepts

➤ Context Menu Repository Overview on page 892

Tasks

➤ How to Customize a Context Menu Template in the Repository 
on page 893

➤ Dynamic URL Parameters on page 897

Reference

➤ List of Context Menus on page 899

➤ List of Context Menu Actions on page 903

➤ List of Pre-Processor Classes on page 914

➤ List of Post-Processor Classes on page 920

➤ Context Menu Repository User Interface on page 931
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Concepts

Context Menu Repository Overview

The Context Menu Repository page displays the list of context menus and 
menu actions available throughout Service Health, to determine appearance 
and functionality for the CIs in the presentation layer.

A context menu defines the menu options that are available for a KPI or a CI 
in the Service Health application. The adapter template assigns every 
configuration item type (CIT) a default context menu.

Context menus contain context menu actions, which can be nested within 
groups. Within the Context Menu Repository, menus and actions are 
categorized as follows: 

➤ Predefined. Out-of-the-box menus and actions.

➤ Predefined (Customized). Out-of-the-box menus and actions that have 
been edited.

➤ Custom. New or cloned menus and actions.

Advanced users can modify existing context menus, groups, or actions, and 
create new ones, using the Context Menu Repository. For details about 
creating or editing context menus, see "How to Customize a Context Menu 
Template in the Repository" on page 893.

For a list of default context menus, see "List of Context Menus" on page 899. 
For a list of default context menu actions, see "List of Context Menu 
Actions" on page 903.
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Tasks

How to Customize a Context Menu Template in the 
Repository

The following section describes how to customize a context menu in the 
Context Menu Repository.

For a detailed scenario that includes adding context menu actions to a 
context menu, see "How to Create a Dynamic URL – Use-Case Scenario" on 
page 641 and view the appropriate steps.

This task includes the following steps:

➤ "Create a customized context menu" on page 893

➤ "Edit context menu details" on page 894

➤ "Edit context menu actions" on page 895

➤ "Set a context menu or action back to default" on page 896

 1 Create a customized context menu

To customize a context menu in the Context Menu Repository, select 
Admin> Service Health > Repositories > Context Menus. Open a menu for 
editing using one of the following methods:

➤ New Context Menu. Creates a context menu that is not based on an 
existing menu. To create a new context menu, click the New Context 
Menu button in the Context Menu Repository page.

➤ Clone Context Menu. Creates a context menu by cloning an existing 
menu. The original context menu is still available, and the new cloned 
menu can be modified. To clone a context menu, select a menu in the 
Context Menu Repository page and click the Clone Context Menu 
button. The new menu will be labeled Custom. Select the new menu 
and click the Edit Context Menu button to open it for editing.
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➤ Edit Context Menu. Modifies an existing context menu. To edit a 
context menu, select a menu in the Context Menu Repository page 
and click the Edit Context Menu button. If you edit a predefined 
context menu, it will be labeled Predefined (Customized).

For user interface details, see "Context Menu Repository page" on 
page 931.

 2 Edit context menu details

In the New/Edit Context Menu Details page, you can modify information 
or enter new information for the context menu. 

You can perform the following changes:

➤ Create a new group or a new action and assign it to the context menu.

➤ Add an action that already exists within the repository to the context 
menu.

➤ Edit the name of a context menu or group.

➤ Remove groups or actions from the context menu.

➤ Change the order of groups and actions within the context menu.

For user interface details, see "New Context Menu/Edit Context Menu 
Dialog Box" on page 935.
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Example:

 3 Edit context menu actions

Using the Actions tab, you can modify existing information or enter new 
information about the pre- and post-processor classes and the class 
parameters that define the action.

For user interface details, see "New/Edit Action Dialog Box" on page 939.

You want to add the Expand More Levels menu action to the Business Process 
Insight Top View context menu.

➤ In the Context Menus tab, open the Business Process Insight menu for 
editing. Select the Top View group and click the Add Action button. From 
the list of available actions select Expand more levels, and save your 
changes.

➤ In the CI Indicators tab, add the context menu to one or more CIs, as 
described in "How to Assign KPIs and HIs to CIs" on page 428.

The Business Process Insight Top View context menu now contains the Expand 
more levels menu action.

This enables you to quickly drill down to the related child CIs:
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Note: Do not add new pre- or post-processor parameters, or make changes 
to a pre- or post-processor class, without consulting with HP Software 
Support. Classes are built for specific context menus, and making changes 
to a class may change its behavior.

 4 Set a context menu or action back to default

If you have edited predefined context menus or actions, you might want 
to return them to their default settings. Note that this is only applicable 
for context menus or actions whose type is Predefined (Customized). 
There are two ways to restore context menu elements to default:

➤ Restore all default settings of a context menu or action. Within the 
Context Menu Repository page, select the customized context menu or 
action, and click Restore to Default. The context menu or action is 
returned to its default settings, and its type reverts to Predefined.

➤ Restore specific settings of a menu action. Within the Actions tab, 
open a predefined (customized) action for editing, and click the 
Restore Defaults button. The elements that have been modified are 
automatically selected. Select the elements which you want to restore 
to default, and click Save.
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Dynamic URL Parameters

The parameters for a dynamic URL are: 

Constant Description

NODE.NAME The name of the CI. When the URL is executed, 
NODE.NAME is replaced by the name of the CI from 
which you want to open the URL. The page 
specified in the URL opens and is filtered to display 
only information related to the CI.

NODE.ID The ID number of the CI. When the URL is 
executed, NODE.ID is replaced by the ID number of 
the CI from which you want to open the URL. The 
page specified in the URL opens and is filtered to 
display only information related to the CI.

NODE.STATUS The status of the CI. When the URL is executed, 
NODE.STATUS is replaced by the status of the CI 
from which you want to open the URL. The page 
specified in the URL opens and is filtered to display 
only information related to status. The available 
statuses are:

-4 downtime

-3 stop

-2 no data

-1 uninitialized

0 critical

5 major

10 minor

15 warning

NODE.PARENTID The ID of the parent CI. When the URL is executed, 
NODE.PARENTID is replaced by the ID of the parent 
of the CI from which you want to open the URL. 
The page specified in the URL opens and is filtered 
to display only information related to the parent CI.
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NODE.CHILDIDS The ID number of the CI’s children. When the URL 
is executed, NODE.CHILDIDS is replaced by a list of 
the IDs of the children of the CI from which you 
want to open the URL. The page specified in the 
URL opens and is filtered to display only 
information related to the child CIs.

NODE.NAME The name of the node.

NODE.ID The ID number of the node.

NODE.STATUS To filter by status, use NODE.STATUS.

NODE.PARENTID The ID of the parent CI.

NODE.CHILDIDS The ID number of the child CIs.

Constant Description
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Reference

List of Context Menus

This section provides descriptions of the context menus available in the 
Context Menu Repository. For details about configuring the context menus, 
see "Context Menu Repository User Interface" on page 931.

The context menu actions are described in "List of Context Menu Actions" 
on page 903.

Context Menu Description

BMC Measurement 
Menu

Context menu for measurement CIs originating from a BMC PATROL 
system.

BPI Business Activity 
Menu

This Context menu is available for Business Transaction CIs, from the 
Business Processes view.

BPI Business Process 
Menu

Context menu for Business Process CIs and BPI Monitor CIs.

BPI Scope Menu Context menu for Business Process Scopes (aka Business Process 
Monitors)

BPM Application 
Reports

Group of context menus for reports on an application monitored by 
Business Process Monitor.

BPM BTF Reports Group of context menus for reports on a business transaction flow 
monitored by Business Process Monitor.

BPM Transaction 
Reports

Group of context menus for reports on a transaction monitored by 
Business Process Monitor.

Business Process 
Insight Flow Map Menu

Context menu available from the Process Diagram in the BPI 
application Health page

Business Process 
Insight Scorecard Menu

Context menu available from the Scorecard page in the BPI application

Business Unit Menu Internal.

CI Neighbors Context menu used in RTSM administration.
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CI Properties Context menu used in RTSM administration.

Config File Menu Not in use.

Default Menu Displays the context menu in Service Health.

Delete CI Context menu used in RTSM administration.

Diagnostics BPM Menu Context menu that is used in Service Health in monitoring views, to 
drill from a specific transaction to the Diagnostics transaction screen.

Diagnostics Business 
Transaction Menu

Context menu that is used to drill down from a business transaction CI 
to the Diagnostics Business Transactions view.

Diagnostics Host Menu Context menu that is used to drill down from a host CI to the 
Diagnostics Hosts view.

Diagnostics J2EE 
Application Menu

Deprecated.

Diagnostics Monitor 
Menu

Deprecated.

Diagnostics MQ 
Manager Menu

Context menu that is used to drill down from a WebSphere MQ CI to 
the Diagnostics Queue Managers view.

Diagnostics Oracle 
Menu

Context menu that is used to drill down from an Oracle CI to the 
Diagnostics Oracle Probes view.

Diagnostics Probe 
Group Menu

Context menu that is used to drill down from a Probe Group CI to the 
Diagnostics Probe Group view.

Diagnostics Probe 
Menu (New)

Context menu that is used to drill down from Probe CIs and application 
server CIs such as WebSphere Application Server or .NET AppDomain) 
to the Diagnostics Probes view.

Diagnostics SAP R3 
ABAP Menu

Context menu that is used to drill down from an SAP ABAP Server CI to 
the Diagnostics ABAP SAP Probes view.

Diagnostics SqlServer 
Instance Menu

Context menu that is used to drill down from an SQL Server CI to the 
Diagnostics SQL Server Probes view.

Diagnostics SqlServer 
Menu

Context menu that is used to drill down from an SQL Database CI to the 
Diagnostics SQL Server Probes view.

Context Menu Description
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Diagnostics Synthetic 
Business Transaction 
Menu

Context menu that is used to drill down from a Business Transaction CI 
to the Diagnostics Synthetic Transactions views.

EMS Measurement 
Menu 

Context menu for measurement CIs originating from an Enterprise 
Management Systems (EMS) source.

EMS Show Events Context menu for CIs:

➤ Originating from the Operations Manager source adapter.

➤ Originating from NetScout.

Go to Application 
Summary Report

Drill to Application Summary report filtered on the selected application.

Go to End User 
Summary Report

Go to End User Summary Report filtered on the selected end user

Go to Infrastructure 
Summary Report

Go to Infrastructure Summary Report filtered on the Node/Running 
software

Go to Location 
Summary Report

Go to Location Summary Report filtered on the selected location

Group Menu The default context menu for most of the business configuration item 
types (CITs).

HI Context Menu Context menu for drilling down from an HI in Service Health.

HP SC Menu Context menu for EMS Monitor CIs under Business Service CIs.

Locate CI Context menu after a search operation in IT Universe.

Locate CI in SLA Internal.

Monitored by 
SiteScope Menu

Context menu for drilling down from a CI or HI, to a SiteScope monitor 
which contributes to the CI’s or HI’s status.

Context Menu Description
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Operation Manager Context menu that enables drilling down to the HP Operations 
Manager application.

Limitations:

➤ You must have specified the user name, password, and host machine 
in the EMS integration definition. For details, see "Add Integration 
Dialog Box" in Solutions and Integrations.

➤ This capability is only supported for one HP Operations Manager 
application. If more than one Operations Manager integration exists, 
the drill down feature works only for one of them.

RUM Application 
Reports

Group of context menus for reports on an application monitored by 
Real User Monitor.

RUM BTF Reports Group of context menus for reports on a business transaction flow 
monitored by Real User Monitor.

RUM Transaction 
Reports

Group of context menus for reports on a transaction monitored by Real 
User Monitor.

SAP Alert 
Acknowledgment

Context menu for a SAP Alert CI.

SAP Menu Context menu for a SAP-related CI.

SAP System Menu Context menu for a SAP System CI.

SAP Transaction Menu Context menu for a Transaction CI.

SAP Transport Menu Context menu for a Transport CI.

Service Menu Internal.

Service Mng Menu Internal.

Service Mng Root 
Menu

Internal.

Siebel Database 
Breakdown Diagnostics 
Menu

Context menu for Siebel-specific CIs.

Siebel Diagnostics 
Menu

Context menu for Siebel-specific CIs.

Siebel Menu Context menu for Siebel-specific CIs.

Context Menu Description



Chapter 24 • Context Menu Repository

903

List of Context Menu Actions

This section provides details about the context menu actions available in 
the Context Menu Repository. 

For details about configuring the context menu actions, see "New/Edit 
Action Dialog Box" on page 939.

For a description of pre- and post-processor classes and class parameters, see 
"List of Pre-Processor Classes" on page 914 or "List of Post-Processor Classes" 
on page 920.

Siebel SARM and DBBD 
Diagnostics Menu

Context menu for Siebel-specific CIs.

SiteScope Group Menu Context menu for SiteScope group CIs.

SiteScope 
Measurement Menu

Context menu for measurements CIs originating from SiteScope.

SiteScope Monitor 
Menu

Context menu for SiteScope monitor CIs when there is no measurement 
level for the monitor.

SiteScope Web Service 
Monitor Menu

Context menu for SiteScope Web Service Monitor CIs.

Top View Context menu for CIs in Top View, appended to the CI’s standard 
context menu.

TransactionVision 
Menu

Context menu for Business Transactions that are monitored by TV

VM Context Menu Context menu in Modeling Studio in RTSM Administration.

Web Service Menu Context menu for Web Service CIs.

Web Service Operation 
Menu

Context menu for Web Service Operation CIs.

Context Menu Description
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Note: Do not add new pre- or post-processor parameters, or make changes to 
a pre- or post-processor class, without consulting with HP Software Support. 
Classes are built for specific context menus, and making changes to a class 
may change its behavior.

Context Menu Group 
or Action

Description

Acknowledgement 
Details

Opens the Acknowledgment details window relevant to the CI. For 
details, see "Acknowledgment History and Details Dialog Box" on 
page 332.

Aggregate 
Transaction Topology

Opens the Aggregated Topology report in the Transaction Management 
application.

Any Users Transaction 
Paths View

Drills down to the Transactions - Business Transactions Paths view in the 
HP Diagnostics application.

Any Users 
Transactions View

Drills down to the Transactions - Business Transactions view in the 
HP Diagnostics application.

Application Health 
Tab

Opens the Health page in the Business Process Insight application.

Application Summary Opens the application summary report for the selected CI. For details, 
see "Application Summary Report" in Using End User Management.

BPI Monitors Over 
Time

Opens the BPI Monitors Over Time report relevant for the CI.

BPM Application 
Health

Opens the application health report filtered for synthetic user data, and 
filtered for the parent application. For details, see "Application Health 
Report" in Using End User Management.

BPM Performance 
Analysis

Opens the performance analysis report filtered for synthetic user data, 
and filtered for the selected transaction. For details, see "Performance 
Analysis Report" in Using End User Management.

BPM Triage for 
Application

Opens the triage report filtered for synthetic user data, and filtered for 
the selected application. For details, see "Triage Report" in Using End User 
Management.
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BPM Triage for 
Transaction

Opens the triage report filtered for synthetic user data, and filtered for 
the selected transaction. For details, see "Triage Report" in Using End User 
Management.

Business Process Over 
Time Report

Opens the BPI Monitors Over Time report relevant for the CI.

Change Report Opens the Change report in Service Health. For details, see "CI Change 
Report" in Reports.

CI Impact Report Opens the Related Change Request report in Service Health.

Collaborate If you have set up an integration with HP Enterprise Collaboration, 
opens EP with the selected CI as the context of the conversation. For 
details see "Operations" on page 102.

Complete Alert Activates a URL call to the relevant SAP system and completes the 
selected SAP alert.

Configuration Item 
Status Alerts

Opens the Configuration Item Status Alert report relevant to the CI. For 
details, see "CI Status Alerts Reports" on page 285.

Console Opens the 360° View in the Service Health Application.

Create New Business 
Service

Available in the Service Level Management application. 

It opens the SLA wizard where you can create a new Business Service CI. 
For details, see "New Business or Infrastructure Service/Edit Service 
Dialog Box" in Service Level Management.

Create New SLA from 
Business Service

Available in the Service Level Management application. 

It enables you to create a new SLA for the selected Business Service CI. It 
opens the Create Agreement wizard with the selected Business Service CI 
already attached. For details, see "New SLA/Edit SLA Wizard" in Service 
Level Management.

Custom Image Opens the Custom Image tab in Service Health.

Customer This context menu option is available in the Service Level Management 
application. It displays the customer defined for the selected service.

Delete Opens the Delete Folder dialog box in the Modeling Studio, to enable 
you to delete a folder. For details, see "Modeling Studio User Interface" in 
the Modeling Guide.

Context Menu Group 
or Action

Description
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Delete Business 
Service

This context menu option is available in the Service Level Management 
application. It deleted the selected Business Service CI.

Delete CI Opens a dialog box to confirm that you want to delete the relevant CI in 
IT Universe Manager.

Diagnostics 
Agent/J2EE Server 
Summary View

Drills down to the Probes view in the HP Diagnostics application.

Diagnostics Probe 
Group Summary View

Drills down to the Probe Group Summary view in the HP Diagnostics 
application.

Diagnostics Web 
Service Topology View

Drills down to the Service Topology view in the HP Diagnostics 
application.

Edit Business Service Available in the Service Level Management application.

It opens the SLA wizard where you can edit the selected Business Service 
CI. For details, see "New Business or Infrastructure Service/Edit Service 
Dialog Box" in Using Service Level Management.

End User Summary Moves to the End User Summary Report in End User Management. The 
End User Summary report displays data for specific end-users that were 
configured for the Real User Monitor in System Availability 
Management. For details, see "RUM End User Group Summary Report" in 
Using End User Management.

Errors Opens the Service Health Hierarchy component, filtered for CIs in Error 
status. For details, see "Hierarchy Component Overview" on page 224.

Event Log Report Moves to the Event Log report in End User Management. The Event Log 
report displays a log of the occurrences of a specific event type for a 
selected time frame. For details, see "Event Log" in Using End User 
Management.

Expand More Levels Expands the Top View display to show the default maximum number of 
hierarchy levels for the CI.

Expand to Problem Expands the Top View display to show the source of a problematic CI.

Filters Opens the Hierarchy filter in Service Health.

Context Menu Group 
or Action

Description
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Find Visible and 
Hidden Child CIs

Returns all of the visible and hidden child CIs of the selected CI that 
appear in the RTSM. For details, see "Find Visible and Hidden Child CIs 
Dialog Box" on page 86.

Geographical Map Opens the Geographical Map tab in Service Health. For details about the 
Geographical Map tab, see "Geographical Map Component User 
Interface" on page 205.

Go to Console Opens the Service Health 360° View page.

Go to Service Health 
Analyzer

If you have Service Health Analyzer installed, this opens the Anomaly 
Highlights page in Service Health Analyzer for the selected CI.

Go to SiteScope Displays the relevant SiteScope Web page for this CI in a new SiteScope 
browser window, enabling you to view more detailed SiteScope 
parameters and measurements. See the SiteScope documentation for 
directions on using SiteScope.

Note: By default, Service Health accesses the SiteScope machine using 
the machine host name. If you want access through IP, edit the 
SiteScope context menu action, by changing the value for the 
pre-processor parameter HOST_BY from NAME to IP.

Go to Top View Opens the Service Health Top View tab, with the view's tree centered on 
the selected CI.

Group Load View Deprecated.

HIs Opens the Service Health Health Indicators component, showing the HIs 
related to the selected CI. For details, see "Health Indicator Component 
Overview" on page 228.

Host Summary View Drills down to the Hosts view in the HP Diagnostics application.

HP Service Manager A context menu option available from EMS Monitor CIs under Business 
Service CIs, to open the HP Service Manager application.

Infrastructure 
Summary

Opens the infrastructure summary report filtered for the selected 
application. For details, see "RUM Application Infrastructure Summary 
Report" in Using End User Management.

Invoke Run Books For CIs whose CI type is mapped to an HP Operations Orchestration 
(OO) run book, opens the Related Run Books page in a new window. You 
can then view the mapped run books and invoke them in OO.

Context Menu Group 
or Action

Description
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J2EE Application 
Summary View

Deprecated.

KPIs Over Time Report Opens the KPI Over Time report relevant to the CI. For details, see "KPIs 
Over Time Report" on page 347.

Load View Internal.

Locate CI in SLA Displays the Search pane where you can specify the CI you want to 
locate in SLA. For details about the search feature, see "How to Search for 
CIs in Search Mode" in the Modeling Guide.

Locate CI in View Displays the Search pane where you can specify the CI you want to 
locate. For details about the search feature, see "How to Search for CIs in 
Search Mode" in the Modeling Guide.

Location Summary Opens the location summary report filtered for the selected location. For 
details, see "Location Summary Report" in Using End User Management.

Monitor to 
Operations Health

For future use.

New Folder Opens the New Folder dialog box in the Modeling Studio, to enable you 
to create a new folder. For details, see "Modeling Studio User Interface" in 
the Modeling Guide.

Open in New Window Opens an external application from Top View. 

For details on configuring this menu action, see "How to Access an 
External Application from Top View" on page 159.

Operations Health For future use. 

Oracle Server 
Summary View

Drills down to the Oracle Database - Oracle Probes view in the 
HP Diagnostics application.

Operation Manager Enables you to access the HP Operations Manager application. For 
limitations, see "Operation Manager" on page 902.

Path to Root Moves to the Top View tab with the Show Path to Root option selected 
for the CI in the Service Health application. For details, see "Service 
Health Menu Options" on page 98.

Context Menu Group 
or Action

Description
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Performance Matrix 
for Application

Opens the BPM performance matrix report filtered for the selected 
application. For details, see "BPM Performance Over Time Report" in 
Using End User Management.

Performance Matrix 
for Transaction

Opens the BPM performance matrix report filtered for the selected 
transaction. For details, see "BPM Performance Over Time Report" in 
Using End User Management.

Probe Group 
Summary 

Moves to HP Diagnostics reports. For details, see HP Diagnostics User’s 
Guide.

Probe Summary Moves to HP Diagnostics reports. For details, see HP Diagnostics User’s 
Guide.

Problematic Subtree Moves to the Top View tab with the Expand to Problem option selected 
for the CI in the Service Health application. For details, see "Service 
Health Menu Options" on page 98.

Properties Opens the Properties dialog box relevant to the CI. For details, see 
"Working with CIs" in the Modeling Guide.

Provider This context menu option is available in the Service Level Management 
application. It displays the provider of the selected service.

Rename Folder Opens the Rename Folder dialog box to enable you to rename a folder. 
For details, see "Modeling Studio User Interface" in the Modeling Guide.

Reset Health Indicator Restores the selected HI to its default state and value. For details, see 
"Health Indicator Component Overview" on page 228.

RUM Application 
Health

For future use.

RUM Performance 
Analysis

Opens the performance analysis report filtered for real user data, and 
filtered for the selected transaction. For details, see "Performance 
Analysis Report" in Using End User Management.

RUM Triage for 
Application

Opens the triage report filtered for real user data, and filtered for the 
selected application. For details, see "Triage Report" in Using End User 
Management.

RUM Triage for 
Transaction

Opens the triage report filtered for real user data, and filtered for the 
selected transaction. For details, see "Triage Report" in Using End User 
Management.

Context Menu Group 
or Action

Description
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SAP R3 Summary View Drills down to the SAP - ABAP SAP Probes view in the HP Diagnostics 
application.

SAP Transaction 
Changes Report

Opens the SAP Transaction Changes report that tracks changes made to a 
SAP Transaction CI when a transport was modified. For details, see "SAP 
Transaction Changes Report" in Solutions and Integrations.

SAP Transport 
Changes

Opens the SAP Transport Changes report that track changes made to the 
properties of a SAP Transport CI. For details, see "SAP Transaction 
Changes Report" in Solutions and Integrations.

SAR Compliancy 
Report

For future use.

Service Impact Opens the related Business Impact report in Service Health. For details, 
see "Business Impact Report" on page 92.

Session Analyzer Moves to the Session Analyzer report in End User Management filtered 
on the selected transaction (or child transactions in the case of a 
transaction group entity) and the Past Hour time period. The Session 
Analyzer report displays session data for specific applications that were 
configured for the Real User Monitor in System Availability 
Management. For details, see "RUM Session Analyzer Report" in Using 
End User Management.

Set/Unset 
Acknowledgement 

Internal.

Show Business 
Activity Over Time 
Report

Opens the Business Activity Over Time report in the Business Process 
Insight application.

Show Contributing 
Events

Shows which events contributed to the HI’s status and value.

Show Events Activates a popup window that lists the events. Select the appropriate 
event and click the Show events button to clear the event from 
HP Business Service Management. A clear event is then published on the 
bus.

Context Menu Group 
or Action

Description
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Show Impacting SAP 
Transports 

Available for SAP-related Transaction CIs and for group CIs. 

For Transaction CIs, enables you to display the transports that are 
impacting the selected Transaction CI, with no historical limit to the 
information. 

Groups CIs represent the following CIs: SAP Site, SAP Business Process, 
SAP Business Scenario, SAP J2EE Dispatcher, SAP J2EE Server Process, SAP 
Process Step, SAP Project, SAP Transaction, SAP Transport Change, 
Application Component, SAP R/3 Application Server, SAP System, SAP 
Application Server, SAP J2EE Application Server, SAP R/3 Application 
Server, and SAP Gateway.

Show Impacting SAP 
Transports 
Transactions

Enables you to display the transactions that are impacting the selected 
CI.

Show Processes For future use.

Show Related CIs Opens the Related CIs tab, in IT Universe Manager. For details, see "How 
to Search for CIs in Search Mode" in the Modeling Guide.

Show Running Tasks For future use.

Show SAP Transport 
Impact

Available for SAP-related Transport CIs. 

Enables you to display information for all the transactions in the system 
that impact the selected transport, with no historical limit to the 
information. 

Show Tasks in Error For future use.

Show Top View Opens the Service Health Top View in a popup window, with the view's 
tree centered on the selected CI.

Siebel Cross-
Performance

Opens the SiteScope Cross-Performance report for Siebel-specific entities. 
For details, see "Group Performance Report" in Using System Availability 
Management.

Siebel Database 
Breakdown

For future use.

Siebel SARM For future use.

Context Menu Group 
or Action

Description
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SiteScope Cross-
Performance 

Opens the SiteScope Cross-Performance report relevant to the CI. For 
details, see "Cross-Performance Report" in Using System Availability 
Management.

SiteScope Quick 
Report 

Available for SiteScope Group and SiteScope Monitor CIs.

Opens the SiteScope Quick Report. For details, refer to the SiteScope 
Help.

SiteScope Server 
Centric Report 

Available for Windows Resource Monitor and Unix Resource Monitor CIs 
under specific conditions described in the report description.

Opens the Server-Centric Report. For details, refer to Using SiteScope in 
the SiteScope Help.

SQL Server Instance 
Summary View

Drills down to the SQL Server Database - SQL Server Probes view in the 
HP Diagnostics application.

SQL Server Summary 
View

Drills down to the SQL Server Database - SQL Server Probes view in the 
HP Diagnostics application.

Synthetic Users 
Transactions Layers 
View

Drills down to the Transactions - Synthetic Transactions Layers view in 
the HP Diagnostics application.

Synthetic Users 
Transactions View

Drills down to the Transactions - Synthetic Transactions view in the 
HP Diagnostics application.

Systinet Web Service 
Data

Opens the HP SOA Systinet application for the Web Service. For details, 
see HP SOA Systinet documentation.

Tier Summary Opens the RUM tier summary report filtered for the selected application. 
For details, see "RUM Tier Summary Report" in Using End User 
Management.

Transaction Over Time Opens the Transaction Over Time report relevant for the CI.

Transaction Summary Opens the Transaction Summary report relevant for the CI.

Context Menu Group 
or Action

Description
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Transaction Summary Moves to the Transaction Summary Reports area for that CI in the End 
User Management User Reports application. The Transaction Summary 
report displays data for specific transactions that were configured for the 
Real User Monitor in System Availability Management. For details, see 
"RUM Transaction Summary Report" in Using End User Management.

By default, appears under the Go to Report shortcut menu.

Transaction Tracking Opens the Transaction Tracking report in the Transaction Management 
application.

Trend Moves to the Trend Reports area for that CI in the End User 
Management User Reports application. The Trend Report Wizard 
generates a trend report that provides a graphical representation of 
measurement data over a specific time period. 

This menu command enables you to compare data collected by Business 
Process Monitor only. You can use the User Reports application to 
generate trend reports from other data collectors. For details, see "Trend 
Reports" in Reports.

Triage Moves to the Triage Reports area for that CI in the End User 
Management User Reports application. The Triage report displays 
transaction data for Business Process Monitor, and Real User Monitor 
profiles for the past day. The data is organized by location. For details, 
see "Triage Report" in Using End User Management.

By default, appears under the Go to Report shortcut menu.

Triage Raw Data Opens the Triage Raw Data report. For details about the report, see 
"Triage Raw Data Report" in Using End User Management.

Web Service Health For future use.

WMQ Server 
Summary View

Drills down to the MQ - Queue Managers view in the HP Diagnostics 
application.

Context Menu Group 
or Action

Description
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List of Pre-Processor Classes

Pre-processor classes correspond to specific menus. In addition, a 
pre-processor class specifies the actions performed before accessing the 
database.

Note: Do not add new pre-processor parameters or make changes to a pre-
processor class, without consulting with HP Software Support. 

This section includes the following topics:

➤ "Dashboard Generic URL" on page 914

➤ "Goto Trend Report" on page 916

➤ "Goto SiteScope" on page 917

➤ "ITU Internal (Open Modal Window)" on page 918

➤ "NetScout URL" on page 918

➤ "Prepare Parameters (Dashboard)" on page 918

➤ "RunBookPreprocessor" on page 918

➤ "Show Properties in VT" on page 919

➤ "View Manager (New Folder) Processor" on page 919

Dashboard Generic URL
Builds a generic URL using the following parameters (context menu actions 
might use a subset of the listed parameters):

Parameter Definition

ack.ackID The location of the acknowledgment ID.

ack.closeDialog Internal. This parameter must not be modified.

ack.cmdbObjectID The location of the RTSM object ID.

autoGenerate Internal.



Chapter 24 • Context Menu Repository

915

COMMAND Internal. 

CMDB_NODE_ID Internal. This parameter must not be modified.

CiID Internal. This parameter must not be modified.

DATA_MODEL_SET_
TO_VALUE

Internal.

filter.fromDashboard Used to add a dynamic value to the URL.

filterId The ID of the filter. Internal. This parameter 
must not be modified.

filter.selectedVTIds Used to add a dynamic value to the URL.

filter.timeBarBean.view Internal.

FROM_DASHBOARD Internal.

GRAPH_PROVIDER Internal.

isFullScreen Opens a popup window with the path to root. 
This parameter must not be modified.

LoginBtn Internal. This parameter must not be modified.

LoginName The name of the user used to login the Deep 
Transaction Tracking application.

loginURL The URL of the Deep Transaction Tracking 
application.

NODE_ID Converts to nodeId. 

parentCmdbId Internal.

Password The password used to login to the Deep 
Transaction Tracking application.

pm.CMDBObjectID Internal.

pm.VTObjectID Internal.

popUp Internal. This parameter must not be modified.

Parameter Definition
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Goto Trend Report
Context menu processor that deals with the Trend report drill down 
functions. It uses the following parameters (context menu actions might use 
a subset of the listed parameters).

reportID The ID number of the report.

REPORT_ID Internal.

selectedCI Internal.

selectedTxnClasses Internal.

SELECTED_MEASUREM
ENTS1

Internal.

SELECTED_MEASUREM
ENTS2

Internal.

TX_NAME Internal.

targetNodeIds The ID of the target node.

URL The URL of the new window.

Parameter Description

actionProcessorClass Internal. This parameter must not be modified.

PROFILE_ID Internal. This parameter must not be modified.

URL The URL of the new window.

REQUEST_TYPE Internal. This parameter must not be modified.

NODE_ID Converts to nodeId. 

MEASUREMENT_1_ID_
PREFIX

Internal. Used to control if the report is filtered 
by location or by transaction for Business 
Process Monitor CIs.

Parameter Definition
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Goto SiteScope
Opens the SiteScope Application using the following parameters (context 
menu actions might use a subset of the listed parameters):

MAX_MEASUREMENT_
NUM

Maximum limit of measurements to filter in 
both SiteScope and Business Process Monitor.

actionForward Internal. This parameter must not be modified.

REPORT_NAME Internal. This parameter must not be modified.

DIMENSION_ID_PREFIX Internal. Specifies to which report to drill 
down in the Trend report not from the 
Availability and Response Time of Business 
Process Monitor but for other KPIs, such as 
Download Time or DNS Time.

MEASUREMENT_0_ID_
PREFIX

Internal. Specifies to which report to drill 
down in the Trend report not from the 
Availability and Response Time of Business 
Process Monitor but for other KPIs, such as 
Download Time or DNS Time.

Parameter Description

GROUP_NODE_NAME The CIs group in SiteScope.

HOST_BY The SiteScope host.

PATH The path that includes all of the SiteScope 
groups.

POST_FIX The post fix expression to be added to the all 
URLs.

PROFILE_ID The SiteScope profile to be used when opening 
SiteScope.

ROOT_PATH The root path to SiteScope.

ROOT_POSTFIX The SiteScope root.html document.

Parameter Description
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ITU Internal (Open Modal Window)
ITU represents the View manager tab in the RTSM application. The class 
deals with the View Manager tab. The parameter is: 

NetScout URL
Deals with NetScout URL. The class does not use parameters.

Prepare Parameters (Dashboard)
Prepares parameters, in JavaScript. Those parameters are used by Service 
Health. Context menu actions might use a subset of the listed parameters. 
The parameters are:

RunBookPreprocessor
For CIs whose CI type is mapped to an HP Operations Orchestration (OO) 
run book, opens the Related Run Books page in a new window using the 
following parameters:

Parameter Description

IURL The URL of the HP Business Service 
Management machine.

Parameter Description

NODE_ID  Converts to nodeId. 

nodeType  This parameter must not be modified.

selectFilterID  Dynamic parameter used by the class.

strutsAction  Dynamic parameter used by the class.

viewType  Dynamic parameter used by the class.

Parameter Description

FROM_DASHBOARD Internal. This parameter must not be modified.

CMDB_NODE_ID Internal. This parameter must not be modified.
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Show Properties in VT
When you select the Properties option in the Model Explorer context menu, 
the Properties dialog box of the selected CI is displayed. The parameter is:

View Manager (New Folder) Processor
Deals with the View Manager tab. The parameter is:

SUSPECT_NAME Internal. This parameter must not be modified.

CI_TYPE Internal. This parameter must not be modified.

URL The URL of the new window.

Parameter Description

URL The URL of the new window.

Parameter Description

URL The URL of the new window.

Parameter Description
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List of Post-Processor Classes

Post-processor classes are build to correspond to specific menus. In addition, 
a post-processor class specifies the actions that are performed after accessing 
the database.

Note: Do not add new post-processor parameters or make changes to a post-
processor class, without consulting with HP Software Support. 

This section includes the following topics:

➤ "CallJSOnPagePostProcessor" on page 921

➤ "Edit View (ITU)" on page 921

➤ "General View-manager Context Menu" on page 921

➤ "Goto KPIs Over Time Report" on page 921

➤ "Goto Trend Report" on page 922

➤ "Goto Triage Reports" on page 922

➤ "Goto RUM Event Analysis Reports" on page 922

➤ "Goto RUM Reports" on page 923

➤ "Goto SOA Health Reports" on page 925

➤ "ITU Internal (Open Modal Window)" on page 925

➤ "Locate Search Result Elements in the View Traverse" on page 926

➤ "Open the Properties Page From the View Traverse" on page 926

➤ "Open Window" on page 927

➤ "Show All the Element Neighbors" on page 929

➤ "Switch Application in BAC" on page 929

➤ "Switch Dashboard Tabs" on page 929

➤ "Switch Dashboard Tabs with Parameters" on page 930

➤ "Window" on page 930
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CallJSOnPagePostProcessor
Context menu processor to expand Top View levels. The parameters are:

Edit View (ITU)
Context menu processor that deals with the View Manager tab in the RTSM 
application. The parameter is:

General View-manager Context Menu
Context menu processor that deals with the View Manager tab in the RTSM 
application. Context menu actions might use a subset of the listed 
parameters. The parameters are:

Goto KPIs Over Time Report
Context menu processor that deals with opening the KPIs Over Time report. 
This class does not have parameters.

Parameter Description

JS_CALL_PARAMS Internal. This parameter must not be modified.

JS_METHOD_NAME Internal. This parameter must not be modified.

Parameter Description

PERMISSION_TYPE Internal. This parameter must not be modified.

Parameter Description

HEIGHT The opened window height, in pixels.

RESIZE If set to 1, the window can be resized. If set to 
0, the window cannot be resized.

SCROLL If set to 1, a scrolling tab is added to the 
opened window, if required. If set to 0, no 
scrolling tab is added to the open window.

WIDTH The opened window width, in pixels.
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Goto Trend Report
Context menu processor that deals with the Trend report drill down 
functions. This class does not have parameters.

Goto Triage Reports
Context menu processor that deals with opening the Triage report. Context 
menu actions might use a subset of the listed parameters. The parameters 
are:

Goto RUM Event Analysis Reports
Context menu processor that deals with opening the RUM Event Analysis 
report. Context menu actions might use a subset of the listed parameters. 
The parameters are:

Parameter Description

application_id The ID of the application to be used when 
opening Diagnostics.

filter.selectedProfileId Internal. This parameter must not be modified.

menu_item_id The ID of the menu action.

menu_item_url The location where the parameters are 
calculated. This parameter must not be 
modified.

reportID The ID number of the report.

Parameter Description

autoGenerate Internal parameter of the RUM Event Analysis 
report.

filter.performance Internal. This parameter must not be modified.

filter.selectedApplication Internal. This parameter must not be modified.

filter.timeBarBean.view Internal. This parameter must not be modified.

popUp Internal. This parameter must not be modified.
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Goto RUM Reports
Context menu processor that deals with opening the Real User Monitor 
report. Context menu actions might use a subset of the listed parameters. 
The parameters are:

reportID The ID number of the report.

selectedEventId Internal. This parameter must not be modified.

URL Internal. This parameter must not be modified.

Parameter Description

application_id The ID of the application to be used.

autoGenerate Internal parameter of the Raw Data Over Time 
report.

EUM_DIMENSION_ID The CI type which is filtered in the report (for 
example BTF or transaction).

filter.applicationErrors Internal. This parameter must not be modified.

filter.events Internal. This parameter must not be modified.

filter.httpErrors Internal. This parameter must not be modified.

filter.performance Internal. This parameter must not be modified.

filter.httpErrors Internal. This parameter must not be modified.

filter.selectedApplication Internal. This parameter must not be modified.

filter.selectedApplication
Errors

Internal. This parameter must not be modified.

filter.selectedcmdbidsfro
mOuter
Application

Internal. This parameter must not be modified.

Parameter Description
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filter.server
FilterBean.serverName
WildCard

Internal. This parameter must not be modified.

filter.vttTree
Type4Thecmdbidsfrom
OuterApplication

Internal. This parameter must not be modified.

filter.selectedEvents Internal. This parameter must not be modified.

filter.selectedHttpErrors Internal. This parameter must not be modified.

isContainer Internal. This parameter must not be modified.

IS_POPUP Internal. This parameter must not be modified.

menu_item_id The ID of the menu action.

menu_item_url The location where the parameters are 
calculated. This parameter must not be 
modified.

monitorName Internal. This parameter must not be modified.

problematicCI Internal.

reportID The ID number of the report.

reportType Defines which of the results to take from the 
PNR KPI that relays in the SLM tab.

selectedApplication Internal. This parameter must not be modified.

selectedActionId Internal. This parameter must not be modified.

selectedTab Internal. This parameter must not be modified.

time_view Internal. This parameter must not be modified.

__UIF_FORM Internal. This parameter must not be modified.

__UIF_APPLICATION Internal. This parameter must not be modified.

Parameter Description
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Goto SOA Health Reports
Context menu processor that deals with opening the HP Business Service 
Management for SOA reports. Context menu actions might use a subset of 
the listed parameters. The parameters are:

ITU Internal (Open Modal Window)
Context menu processor that deals with the View Manager tab in the RTSM 
application. Context menu actions might use a subset of the listed 
parameters. The parameters are:

Parameter Description

application_id The ID of the application to be used when 
opening Diagnostics.

autoGenerate Internal parameter of the Raw Data Over Time 
report.

filter.fromDashboard Internal. This parameter must not be modified.

menu_item_id The ID of the menu action.

menu_item_url The location where the parameters are 
calculated. This parameter must not be 
modified.

reportID The ID number of the report.

VT_NODES_
SYMBOL_IDS_KEY

Internal. The symbol ID of the CI, to which 
the context menu action is attached, in the 
view.

filter.selectedCIsType Internal.

Parameter Description

HEIGHT The opened window height, in pixels.

PARAM0 This parameter is for internal use only. This 
parameter must not be modified.
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Locate Search Result Elements in the View Traverse
Context menu processor that deals with the search capability in Model 
Explorer. This class does not have parameters.

Open the Properties Page From the View Traverse
When you select the Properties option in the Model Explorer context menu, 
the Properties dialog box of the selected CI is displayed. Context menu 
actions might use a subset of the listed parameters. The parameters are:

PARAM1 This parameter is for internal use only. This 
parameter must not be modified.

PARAM2 This parameter is for internal use only. This 
parameter must not be modified.

PARAM3 This parameter is for internal use only. This 
parameter must not be modified.

PARAM4 This parameter is for internal use only. This 
parameter must not be modified.

PERMISSION_TYPE Internal. This parameter must not be modified.

RESIZE If set to 1, the window can be resized. If set to 
0, the window cannot be resized.

SCROLL If set to 1, a scrolling tab is added to the 
opened window, if required. If set to 0, no 
scrolling tab is added to the open window.

WIDTH The opened window width, in pixels.

Parameter Description

HEIGHT The opened window height, in pixels.

RESIZE If set to 1, the window can be resized. If set to 
0, the window cannot be resized.

Parameter Description
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Open Window
General post processor to open a request in a new window, rather than in 
the application frame. Context menu actions might use a subset of the listed 
parameters. The parameters are:

SCROLL If set to 1, a scrolling tab is added to the 
opened window, if required. If set to 0, no 
scrolling tab is added to the open window.

SLAVE_WIN If set to 1, it checks that the window closes 
when the application is closed.

WIDTH The opened window width, in pixels.

Parameter Description

ALERTDATE The date when the selected SAP alert occurred.

ALERTTIME The time of the selected SAP alert.

ALINDEX The internal handle for the SAP alert.

ALSYSID The SAP system which the alert came from.

ALUNIQNUM The Id number of the SAP alert, as appears on 
the SAP system.

HEIGHT The opened window height, in pixels.

MSEGNAME Contains the type of the monitor and 
connection parameters (for example: 
SAP_CCMS_calderone_MI6_00).

MSG The name of the SAP alert.

RESIZE If set to 1, the window can be resized. If set to 
0, the window cannot be resized.

Parameter Description
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SapProblemIsolationPostProcessor
Context menu processor that deals with Advanced Analytics in Application 
Management for SAP. The parameters are:

SapConnId Uses the following syntax: <host name>:<user 
name> to connect to a specific SiteScope 
monitor to retrieve the SAP alert. host name is 
the name of the host that contains the R3 
server where the SAP alert originated. user 
name is the name of the user used to access the 
server to which the SiteScope monitor is 
connected.

SCROLL If set to 1, a scrolling tab is added to the 
opened window, if required. If set to 0, no 
scrolling tab is added to the open window.

SLAVE_WIN If set to 1 it checks that the window closes 
when the application is closed.

szTargetHostIP The IP of the SiteScope that sent the sample.

szTargetHostName The name of the SiteScope host that sent the 
sample.

WIDTH The opened window width, in pixels.

WIN_NAME Specifies the window name.

Parameter Description

Base URL The location of the file 
/<HP_BSM_web_application_context_name 
(usually 
topaz)>/jsps/dash/ClearEventContextMenu.jsp

timeInterval The period of time for which the historical 
information is kept for group CIs.

Default: 1 week

Parameter Description
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Show All the Element Neighbors
Context menu processor that deals with Model Explorer. This class does not 
have parameters.

Switch Application in BAC
Context menu processor for drilling down from one application to another. 
This class does not have parameters.

Switch Dashboard Tabs
Context menu processor that switches tabs in the Service Health 
application. The parameter is:

HEIGHT The opened window height, in pixels.

RESIZE If set to 1, the window can be resized. If set to 
0, the window cannot be resized.

SCROLL If set to 1, a scrolling tab is added to the 
opened window, if required. If set to 0, no 
scrolling tab is added to the open window.

SLAVE_WIN If set to 1 it checks that the window closes 
when the application is closed.

WIDTH The opened window width, in pixels.

Parameter Description

TAB_ID The ID of the tab. The tab ID is available in the 
application framework. If you change the tab 
ID, it is recommended to change the name of 
the context menu action to match the name of 
the tab that is opened by this option.

Parameter Description
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Switch Dashboard Tabs with Parameters
Context menu processor that passes internal parameters when switching 
from one tab to another in Service Health. The parameter is:

Window
Context menu processor that deals with opening new windows. Context 
menu actions might use a subset of the listed parameters. The parameters 
are:

Parameter Description

TAB_ID The ID of the tab. The tab ID is available in the 
application framework. If you change the tab 
ID, it is recommended to change the name of 
the context menu action to match the name of 
the tab that is opened by this option.

Parameter Description

HEIGHT The opened window height, in pixels.

RESIZE If set to 1, the window can be resized. If set to 
0, the window cannot be resized.

SCROLL If set to 1, a scrolling tab is added to the 
opened window, if required. If set to 0, no 
scrolling tab is added to the open window.

SLAVE_WIN If set to 1 it checks that the window closes 
when the application is closed.

WIDTH The opened window width, in pixels.

WIN_NAME Specifies the window name.
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Context Menu Repository User Interface

This section includes:

 ➤ Context Menu Repository page on page 931

 ➤ New Context Menu/Edit Context Menu Dialog Box on page 935

 ➤ New/Edit Group Dialog Box on page 937

 ➤ Add Actions Dialog Box on page 938

 ➤ New/Edit Action Dialog Box on page 939

 ➤ Pre-Processor Parameter Details Dialog Box on page 942

 ➤ Post-Processor Parameter Details Dialog Box on page 943

 ➤ Restore Defaults Dialog Box on page 944

Context Menu Repository page

This page displays the list of context menus and menu actions available in 
Service Health.

To access Select Admin > Service Health > Repositories > Context 
Menus

Relevant tasks "How to Customize a Context Menu Template in the 
Repository" on page 893
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Context Menu Tab
This tab enables an advanced user to modify existing context menus and to 
create new ones.

User interface elements are described below:

Important 
information

To modify a context menu, select the context menu in 
the Context Menus tab and click the Edit button, or 
right-click the context menu and access the Edit menu 
command. For details, see "New Context Menu/Edit 
Context Menu Dialog Box" on page 935.

A list of the predefined context menus and their 
descriptions is available in "List of Context Menus" on 
page 899.

UI Element (A-Z) Description

Click the New Context Menu button to create a new 
context menu.

Click the Edit Context Menu button to edit the details 
of a selected context menu.

Click the Clone Context Menu button to create a new 
context menu, using a selected context menu as a 
template.

Click the Delete Context Menu button to delete one or 
more selected custom context menu.

If you delete a Predefined (Customized) context menu, 
it is restored to default.

Restore to Default. Select an edited menu whose Type 
is Predefined (Customized), and click to restore it to its 
original settings.

Click to refresh the page.

Export to Excel. Click to export the table to an Excel 
file.
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Actions Tab
This tab enables an advanced user to modify existing context menu actions, and to 
create new ones.

User interface elements are described below:

Export to PDF. Click to export the table to a PDF file.

Name The name of the context menu.

Type Indicates one of the following context menu types:

➤ Custom. New or cloned context menus.

➤ Predefined. Out-of-the-box context menus that 
have not been modified.

➤ Predefined (Customized). Out-of-the-box context 
menus that have been edited. You can restore such a 
menu to its original settings using the Restore to 
Default button.

Important 
information

To modify a context menu action, select the action in 
the Actions tab and click the Edit button, or right-click 
the action and access the Edit menu command. For 
details, see "New/Edit Action Dialog Box" on page 939.

A list of the predefined context menu actions and their 
descriptions is available in "List of Context Menu 
Actions" on page 903.

UI Element (A-Z) Description

Click the New Action button to create a new context 
menu action.

Click the Edit Action button to edit the details of a 
selected context menu action.

Click the Clone Action button to create a new context 
menu action, using a selected action as a template.

UI Element (A-Z) Description
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Click the Delete Action button to delete one or more 
selected custom context menu actions.

If you delete a Predefined (Customized) action, it is 
restored to default.

Restore to Default. Select an edited action whose Type 
is Predefined (Customized), and click to restore it to its 
original settings.

Click to refresh the page.

Export to Excel. Click to export the table to an Excel 
file.

Export to PDF. Click to export the table to a PDF file.

Name The name of the context menu action.

Type Indicates one of the following context menu action 
types:

➤ Custom. New or cloned context menu actions.

➤ Predefined. Out-of-the-box context menu actions 
that have not been modified.

➤ Predefined (Customized). Out-of-the-box context 
menu actions that have been edited. You can restore 
such an action to its original settings using the 
Restore to Default button.

UI Element (A-Z) Description
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New Context Menu/Edit Context Menu Dialog Box

This dialog box enables you to modify information or enter new information for a 
context menu, its groups, and its actions.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In the Context Menu Repository page, click the New 
Context Menu button, or select a context menu and 
click the Edit Context Menu button.

Important 
information

When creating a new context menu, type the name of 
the context menu in the New Context Menu dialog 
box. After you click Save, the New Context Menu 
dialog box contains the fields described below.

A detailed list of context menus and their details is 
available in "List of Context Menus" on page 899.

Relevant tasks "How to Customize a Context Menu Template in the 
Repository" on page 893

UI Element (A-Z) Description

<Menu entity> Displays a hierarchical view of the context menu. The 
highest level is that of the context menu itself. Context 
menus can contain menu actions and groups; groups 
are containers for menu actions.

The New button contains the following options:

➤ New Action. Create a new menu action (default). For 
details, see "New/Edit Action Dialog Box" on 
page 939.

➤ Group. Create a new group, and add menu actions 
to the group. For details, see "New/Edit Group 
Dialog Box" on page 937.
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Click the Add Action button to add a menu action to 
the context menu. You can add an action that is 
already defined in the Context Menu Repository, or 
create a new action. For details, see "Add Actions 
Dialog Box" on page 938.

A detailed list of actions is available in "List of Context 
Menu Actions" on page 903.

At the context menu level, click the Edit Item button to 
edit the name of the context menu.

At the group level, click the Edit Item button to edit the 
details of the group. For more details, go to "New/Edit 
Group Dialog Box" on page 937.

Note: To edit an action, access the Actions tab. For 
details, refer to the Actions Tab section in "Context 
Menu Repository page" on page 931.

Click the Delete button to delete a group or action. 

Note: Custom context menus can be deleted from the 
Context Menu tab itself.

Click the Move Up button to move a group or action 
higher in the menu hierarchy.

Click the Move Down button to move a group or 
action lower in the menu hierarchy.

Click the Clear Selection button to clear the selection.

UI Element (A-Z) Description
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New/Edit Group Dialog Box

This dialog box enables you to modify existing information or enter new 
information about a menu group.

User interface elements are described below:

To access In the New/Edit Context Menu dialog box, click the 
New Group button, or select an existing group and 
click the Edit Item button.

Relevant tasks "How to Customize a Context Menu Template in the 
Repository" on page 893

UI Element Description

<Group Name area> Select a name for the group using the following 
options:

➤ New group name. Enter a name for the group.

➤ Predefined names. Select one of the predefined 
group names. Note that selecting one of these 
names does not automatically select any actions.

<Add Actions area> Add actions to the group using the following options:

➤ Available Actions. Select one or more actions to add 
to the group, using the CTRL key for multiple 
selection. For details about the available actions, see 
"List of Context Menu Actions" on page 903.

➤ New Action. Click the New Action button to create a 
new action and add it to the group. The new action 
is also added to the Context Menu Repository. For 
details, see "New/Edit Action Dialog Box" on 
page 939.

Note: Actions can be deleted from a group using the 
Edit Context Menu dialog box.
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Add Actions Dialog Box

This dialog box enables you to add menu actions to a context menu or group. You 
can add actions that already exist in the Context Menu Repository, or create a new 
action.

User interface elements are described below:

To access In the New/Edit Context Menu dialog box, click the 
Add Action button.

Relevant tasks "How to Customize a Context Menu Template in the 
Repository" on page 893

UI Element (A-Z) Description

Available Actions Select menu actions that exist in the Context Menu 
Repository to add to the context menu or group. Select 
multiple actions by holding down the CTRL key.

For details about the default actions, see "List of 
Context Menu Actions" on page 903.

New Action Click the New Action button to create a new menu 
action and add it to the context menu or group. The 
new action is also added to the Context Menu 
Repository.

For details, see "New/Edit Action Dialog Box" on 
page 939.
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New/Edit Action Dialog Box
This dialog box enables you to modify information or enter new information for a 
context menu action.

Common Settings

User interface elements are described below:

To access In the Actions tab on the Context Menu Repository 
page, click the New button, or select an action and 
click the Edit button.

Important 
information

Do not add new pre- or post-processor parameters, or 
make changes to a pre- or post-processor class, without 
consulting with HP Software Support. Classes are built 
for specific context menus, and making changes to a 
class may change its behavior.

Relevant tasks "How to Customize a Context Menu Template in the 
Repository" on page 893

UI Element (A-Z) Description

Restore Defaults Enables to restore modified menu action settings to 
their defaults. This is only applicable for Predefined 
(Customized) actions.

For details, see "Restore Defaults Dialog Box" on 
page 944.
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Action Settings Area

User interface elements are described below:

UI Element (A-Z) Description

Context (Optional) You can use this field to categorize actions 
with labels that are meaningful to you; by default this 
field is empty.

If you have a number of actions with the same name, 
you can add an additional label in the Context field. 
This label is appended to the action name, and the 
action is displayed in the repository as <action name> 
(<context>). The context is only displayed in the 
Actions tab, and in the list of actions used when 
creating a context menu.

Name The name of the action. 

Post-Processor Class The name of the post-processor class to be used to 
perform the corresponding action after accessing the 
database, when this menu option is selected. 

The list of parameters used by the post-processor class 
for the current context menu action is provided in the 
Post-Processor Parameters area. For details, see "Post-
Processor Parameters Area" on page 941.

For details about the post-processor classes and their 
parameters, see "List of Post-Processor Classes" on 
page 920.

Pre-Processor Class The name of the pre-processor class to be used to 
perform the corresponding action before accessing the 
database, when this menu option is selected. 

The list of parameters used by the pre-processor class 
for the current context menu action is provided in the 
Pre-Processor Parameters area. For details, see "Pre-
Processor Parameters Area" on page 941.

For details about the pre-processor classes and their 
parameters, see "List of Pre-Processor Classes" on 
page 914.
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Pre-Processor Parameters Area

User interface elements are described below:

Post-Processor Parameters Area

Important 
information

The parameters listed in this area belong to the class 
listed in the Pre-Processor Class field.

For details about the pre-processor classes and their 
parameters, see "List of Pre-Processor Classes" on 
page 914.

UI Element (A-Z) Description

Click to create a new pre-processor parameter. For 
details, see "Pre-Processor Parameter Details Dialog 
Box" on page 942.

Click to edit the details of a selected pre-processor 
parameter. For details, see "Pre-Processor Parameter 
Details Dialog Box" on page 942.

Click to delete one or more selected pre-processor 
parameters.

Click the Select all button to select all the pre-
processor parameters.

Click the Clear Selection button to clear the 
selection.

Important 
information

The parameters listed in this area belong to the class 
listed in the Post-processor Class field.

For details about the post-processor classes and their 
parameters, see "List of Post-Processor Classes" on 
page 920.
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User interface elements are described below:

Pre-Processor Parameter Details Dialog Box

This dialog box enables you to modify existing information or enter new 
information about the pre-processor parameter.

UI Element (A-Z) Description

Click to create a new post-processor parameter. For 
details, see "Post-Processor Parameter Details Dialog 
Box" on page 943.

Click to edit the details of a selected post-processor 
parameter. For details, see "Post-Processor Parameter 
Details Dialog Box" on page 943.

Click delete one or more selected post-processor 
parameters.

Click the Select all button to select all the post-
processor parameters.

Click the Clear Selection button to clear the 
selection.

To access In the New/Edit Action dialog box, click New Pre-
Processor Parameter or click the Edit button for the 
appropriate parameter.

Important 
information

Do not add new pre- or post-processor parameters, or 
make changes to a pre- or post-processor class, without 
consulting with HP Software Support.

For details about the pre-processor classes and their 
parameters, see "List of Pre-Processor Classes" on 
page 914.

Relevant tasks "How to Customize a Context Menu Template in the 
Repository" on page 893
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User interface elements are described below:

Post-Processor Parameter Details Dialog Box

This dialog box enables you to modify existing information or enter new 
information about the post-processor parameter.

UI Element (A-Z) Description

Convert To This key is used if the key is a parameter in the URL. In 
this case, the URL is added with the converted key and 
the value.

Key The parameter’s key. The GenericURLPreprocess 
parameter has certain predefined keys: URL_SUFFIX 
and URL (or a composition of PROTOCOL, HOST, and 
PORT).

Value The parameter’s value. In case of a URL key, it can be a 
certain URL (for example: http://www.hp.com) The value 
can also be retrieved from the CI using an Escaping 
sequence form; for example: NODE-ID to get the CI Id.

To access In the New/Edit Action dialog box, click New Post-
Processor Parameter or click the Edit button for the 
appropriate parameter.

Important 
information

Do not add new post-processor parameters, or make 
changes to a post-processor class, without consulting 
with HP Software Support.

For details about the post-processor classes and their 
parameters, see "List of Post-Processor Classes" on 
page 920.

Relevant tasks "How to Customize a Context Menu Template in the 
Repository" on page 893
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User interface elements are described below:

Restore Defaults Dialog Box

This dialog box enables you to restore predefined settings, for menu actions whose 
type is Predefined (Customized).

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Key The parameter’s key.

Value The parameter’s value. The value can also be retrieved 
from the CI using an Escaping sequence form; for 
example: NODE-ID to get the CI Id.

To access In the Edit Action dialog box, click the Restore 
Defaults button.

Relevant tasks "How to Customize a Context Menu Template in the 
Repository" on page 893

UI Element (A-Z) Description

<Modified fields> The menu action definition fields that have been 
modified are automatically selected. 

Select the fields which you want restored to default, 
and click Save.
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Service Health Rules API

This chapter includes:

Concepts

➤ Rules API Overview on page 948

➤ API Group and Sibling Rule on page 950

➤ API Sample Rule on page 953

➤ API Duration-Based Sample Rule on page 955

➤ Creating Rules with the Rules API on page 957

Tasks

➤ How to Define an API Rule in the CI Indicators Tab on page 959

➤ How to Create a Text File-Based API Rule on page 960

➤ How to Define an API Rule in the Rule Repository on page 964

➤ How to Work with Tooltip Entries on page 966

➤ How to Write to Log Files From the Rules API Code on page 967

➤ How to Include a CI Property in Rules API Calculations on page 968

Reference

➤ Examples - API Group and Sibling Rule on page 969

➤ Examples - API Sample Rule on page 978



Chapter 25 • Service Health Rules API

948

Concepts

Rules API Overview

Note: In BSM versions 9.00 and later, the rules that calculate indicator 
statuses and values based on samples ("API Sample Rule" on page 953 and 
"API Duration-Based Sample Rule" on page 955) are used to calculate metric-
based health indicators (HIs). 

Throughout the Rules API documentation, you will see references to various 
methods used to calculate KPIs. In BSM versions 9.00 and later, when 
calculating sample-based values, these methods are used to calculate metric-
based HIs.

This chapter describes how to use the Rules API to create new business rules. 
Business rules are used to calculate Key Performance Indicators (KPIs). A KPI 
must have an associated business rule that defines how the KPI is calculated. 
The default Service Health rules appear in the section "List of Calculation 
Rules in Service Health" on page 740.

The recommended way to create new rules is with the Rules API. The Rules 
API enables you to create rules using the Groovy scripting language. Users of 
the Rules API should be familiar with Groovy and Java, and with BSM 
administration and applications.

The Rules API classes are documented in Javadoc format in the HP Rules API 
Reference. These files are located in the following folder:
\\<HP Business Service Management Gateway Server root directory>
\AppServer\webapps\site.war\amdocs\eng\doc_lib\Service_Health\Rules_
API\index.html
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This section also includes the following topics:

➤ "Service Health API Rules" on page 949

➤ "Creating API Rules" on page 949

➤ "Tooltips and Log Files" on page 950

Note: Extensive use of rules which use the Rules API will affect performance.

Service Health API Rules
There are three types of Service Health API rules:

➤ Group and Sibling Rule. This rule calculates KPIs based on data received 
from other KPIs, rather than from original sample data. For details, see 
"API Group and Sibling Rule" on page 950.

➤ Sample Rule. This rule calculates KPIs based on original data taken from 
sample fields; the number of samples included in the calculation is 
limited by a maximum number of samples rule parameter. For details, see 
"API Sample Rule" on page 953.

➤ Duration-Based Sample Rule. This rule calculates KPIs based on original 
data taken from sample fields; a duration parameter defines which 
samples are included in the calculation. For details, see "API Duration-
Based Sample Rule" on page 955.

Creating API Rules
Rules can be created using the Rules API in three ways: 

➤ Using the CI Indicators tab to create a rule for a specific KPI.

➤ Using a text file to create a new rule for multiple KPIs.

➤ Using a clone of an API rule in the Rule Repository to create a new rule.

These methods are described in "Creating Rules with the Rules API" on 
page 957.
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Tooltips and Log Files
To display KPI information in tooltips when working with the Rules API, see 
"How to Work with Tooltip Entries" on page 966.

You can write to log files from the Rules API code, as described in "How to 
Write to Log Files From the Rules API Code" on page 967.

API Group and Sibling Rule

An API Group and Sibling Rule calculates KPIs based on data received from 
other indicators, rather than from original sample data. The received data 
can come from the KPIs of child CIs, or from other KPIs or HIs associated 
with the same CI.

Note: If you are creating a sibling rule, make sure that the KPI is calculated 
after its sibling KPIs, as defined by the KPI’s Calculation Order field. For 
details, see "KPIs Repository page" on page 666.

This section includes the following topics:

➤ "Group and Sibling Rule Methods and Fields" on page 950

➤ "Defining a Group and Sibling Rule in the CI Indicators tab or Rule 
Repository" on page 952

➤ "Accessing a Specific Child KPI in the CI Indicators Tab" on page 952

➤ "Defining a Group and Sibling Rule Using a Text File" on page 952

Group and Sibling Rule Methods and Fields
The Group and Sibling rule implements the Rules API Interface 
GroupAndSiblingCalculator, using the following guidelines:

➤ In this interface, the only method is calculateKPI. The method signature 
is:

public void calculateKPI(CI ci, KPI kpi)
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➤ The calculateKPI method includes the parameters ci and kpi, which 
represent the current CI, and the KPI whose value the API rule calculates.

➤ The ci parameter type is CI, and is used as an accessor to KPIs of child 
CIs or sibling KPIs, or HIs on the CI.

➤ The kpi parameter type is KPI, and is used to set calculation results.

In the following illustration, the Calculated KPI is calculated based on the 
sibling or child KPIs, and it is represented by the kpi parameter. 

The CI to which the Calculated KPI is assigned, is represented by the ci 
parameter, and it is an accessor to the other KPIs or HIs.

The Rules API classes are documented in Javadoc format in the HP Rules API 
Reference. These files are located in the following folder:
\\<HP Business Service Management Gateway Server root directory>\
AppServer\webapps\site.war\amdocs\eng\doc_lib\Service_Health\Rules_A
PI\index.html

For detailed examples of Group and Sibling rules, see "Examples - API Group 
and Sibling Rule" on page 969.

API rules can be defined within the Service Health CI Indicators tab or Rule 
Repository, or using a text file template, as described in "Creating Rules with 
the Rules API" on page 957.
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Defining a Group and Sibling Rule in the CI Indicators tab 
or Rule Repository
To define a Group and Sibling rule using the CI Indicators tab or within the 
Rule Repository, enter the calculateKPI method implementation in the KPI 
Calculation Script area.

The parameters ci and kpi of the calculateKPI method are available for use in 
this script.

For detailed instructions, see "How to Define an API Rule in the CI 
Indicators Tab" on page 959 or "How to Define an API Rule in the Rule 
Repository" on page 964.

Accessing a Specific Child KPI in the CI Indicators Tab
When creating a Group rule for a specific KPI in the CI Indicators tab, to 
access a specific child KPI, the API includes a mechanism to simplify the 
code. When defining your KPI Calculation Script, you can enter the format 
"<CI name>"."<KPI name>". 

For an example of this, see Example - Specific Child CI Group Rule in 
"Examples - API Group and Sibling Rule" on page 969.

Defining a Group and Sibling Rule Using a Text File
To define a Group and Sibling rule using a text file, use the 
DashboardGroupAndSiblingTemplate.groovy template as described in "How 
to Create a Text File-Based API Rule" on page 960.

Within the text file, enter the calculateKPI method body.
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API Sample Rule

A Sample rule calculates KPIs based on original data taken from sample 
fields; the number of samples included in the calculation is limited by a 
maximum number of samples parameter.

This section includes the following topics:

➤ "Sample Rule Methods and Fields" on page 953

➤ "Defining a Sample Rule in the CI Indicators tab or Rule Repository" on 
page 954

➤ "Defining a Sample Rule Using a Text File" on page 954

Sample Rule Methods and Fields
The Sample rule implements the Rules API Interface LeafCalculator, using 
the following guidelines:

➤ In this interface, the only method is calculateKPI. The method signature 
is:

public void calculateKPI(CI ci, KPI kpi, List<Sample> samples)

➤ The calculateKPI method includes the parameters ci, kpi, and samples. 
These represent the current CI, the KPI whose value the rule calculates, 
and the samples to be used in the rule calculation based on the Maximum 
number of samples parameter. (If this parameter value is 1, list one 
sample in this field.)

➤ The kpi parameter type is KPI, and is used to set calculation results.

➤ The samples parameter is a List of Sample objects, which hold sample 
field values.

➤ The rule must also set the sampleFields field to define which sample fields 
are held by the Sample object. These values are the values used by the 
rule.

For detailed examples of Sample rules, see "Examples - API Sample Rule" on 
page 978.
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API rules can be defined within the Service Health CI Indicators tab or the 
Rule Repository, or using a text file template, as described in "Creating Rules 
with the Rules API" on page 957.

The Rules API classes are documented in Javadoc format in the HP Rules API 
Reference. These files are located in the following folder:
\\<HP Business Service Management Gateway Server root directory>\
AppServer\webapps\site.war\amdocs\eng\doc_lib\Service_Health\Rules_A
PI\index.html

Defining a Sample Rule in the CI Indicators tab or Rule 
Repository
To define a Sample rule using the CI Indicators tab or within the Rule 
Repository, fill in the fields as follows:

➤ Sample Fields. List the sample fields which are held by the Sample object; 
separate between the sample names with a comma (for example: 
"u_iStatus", "dResponseTime").

➤ KPI Calculation Script. Enter the calculateKPI method implementation; do 
not enter the method signature. The parameters ci, kpi, and samples of 
the calculateKPI method are available for use in this script.

➤ Maximum number of samples. By default only the most recent sample is 
included (default=1). You can use this field to change this setting.

For detailed instructions, see "How to Define an API Rule in the CI 
Indicators Tab" on page 959 or "How to Define an API Rule in the Rule 
Repository" on page 964.

Defining a Sample Rule Using a Text File
To define a Sample rule using a text file template, use the 
DashboardSampleRuleTemplate.groovy template file as described in "How 
to Create a Text File-Based API Rule" on page 960.

Within the text file, enter the calculateKPI method body, and define the 
sampleFields field.



Chapter 25 • Service Health Rules API

955

API Duration-Based Sample Rule

A Duration-Based Sample rule calculates KPIs based on original data taken 
from sample fields; the duration rule parameter defines which samples are 
included in the calculation. For example, if duration is defined as fifteen 
minutes, all samples collected during the last fifteen minutes are included in 
the calculation.

This section includes the following topics:

➤ "Duration-Based Sample Rule Methods and Fields" on page 955

➤ "Defining a Duration-Based Sample Rule in the CI Indicators tab or Rule 
Repository" on page 956

➤ "Defining a Duration-Based Sample Rule Using a Text File" on page 956

Duration-Based Sample Rule Methods and Fields
The Duration-Based Sample rule implements the Rules API Interface 
LeafCalculator, using the following guidelines:

➤ In this interface, the only method is calculateKPI. The method signature 
is:

public void calculateKPI(CI ci, KPI kpi, List<Sample> samples)

➤ The calculateKPI method includes the parameters ci, kpi, and samples. 
These represent the current CI, the KPI whose value the rule calculates, 
and the list of samples to be used in the rule calculation.

➤ The kpi parameter type is KPI, and is used to set calculation results.

➤ The samples parameter is a List of Sample objects, which hold sample 
field values.

➤ The rule must also set the sampleFields field to define which sample fields 
are held by the Sample object. These values are the values used by the 
rule.

For detailed examples of this rule, see "Examples - API Sample Rule" on 
page 978.
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API rules can be defined using the Service Health CI Indicators tab, using a 
text file, or within the Rule Repository, as described in "Creating Rules with 
the Rules API" on page 957.

The Rules API classes are documented in Javadoc format in the HP Rules API 
Reference. These files are located in the following folder:
\\<HP Business Service Management Gateway Server root directory>\
AppServer\webapps\site.war\amdocs\eng\doc_lib\Service_Health\Rules_A
PI\index.html

Defining a Duration-Based Sample Rule in the CI 
Indicators tab or Rule Repository
To defining a Duration-Based Sample rule using the CI Indicators tab or 
within the Rule Repository, fill in the fields as follows:

➤ Sample Fields. List the sample fields which are held by the Sample object; 
separate between the sample names with a comma (for example: 
"u_iStatus", "dResponseTime").

➤ KPI Calculation Script. Enter the method implementation; do not enter 
the method signature. The parameters ci, kpi, and samples of the 
calculateKPI method are available for use in this script.

➤ No data timeout and duration. (Optional) You can define the timeout 
period and duration parameters, as described in "List of Rule Parameters" 
on page 845.

For detailed instructions, see "How to Define an API Rule in the CI 
Indicators Tab" on page 959 or "How to Define an API Rule in the Rule 
Repository" on page 964.

Defining a Duration-Based Sample Rule Using a Text File
To define a Duration-Based Sample rule using a text file template, use the 
DashboardDurationBasedSampleRuleTemplate.groovy template file as 
described in "How to Create a Text File-Based API Rule" on page 960.

Within the text file, enter the calculateKPI method body, and define the 
sampleFields field.



Chapter 25 • Service Health Rules API

957

Creating Rules with the Rules API

There are a number of ways to create rules using the Rules API, as described 
in the following section.

This section includes the following topics:

➤ "Define a rule for a specific KPI using the CI Indicators tab" on page 957

➤ "Create a rule using a text file" on page 957

➤ "Define a rule within the Rule Repository" on page 958

Define a rule for a specific KPI using the CI Indicators tab
Each Service Health KPI has three applicable API rules: API Group and 
Sibling Rule, API Sample Rule, or API Duration-Based Sample Rule. From the 
CI Indicators tab, you can assign one of the API rules to a KPI, and enter a 
calculation script (and other rule details) to define rule logic for that KPI. 

You can then edit the rule details in the CI Indicators tab at any time to 
change the rule logic for the KPI.

For details, see "How to Define an API Rule in the CI Indicators Tab" on 
page 959.

Create a rule using a text file
For each of the three API rules (Group and Sibling Rule, Sample Rule, or 
Duration-Based Sample Rule) there is a corresponding template file, located 
in the <Data Processing server root 
directory>\BLE\rules\groovy\templates directory. You can use one of the 
template files to create a text file defining a new rule. You then add this rule 
to the Rule Repository, and it can be applied like any out-of-the-box rule.

The API code cannot be seen or changed within Service Health, but only 
within the text file. If you make changes to the code within the text file, 
these changes are applied to all instances where the rule has been assigned, 
after you reload Service Health rules.

For details, see "How to Create a Text File-Based API Rule" on page 960.
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Define a rule within the Rule Repository
The Rule Repository contains three API rules: API Group and Sibling Rule, 
API Sample Rule, or API Duration-Based Sample Rule. You can use the Rule 
Repository to clone an API rule and enter a calculation script (and other rule 
details) to define the rule logic. 

After the rule is applied to a KPI, you can edit rule details within the CI 
Indicators tab at any time to change the rule logic for a specific KPI.

For details, see "How to Define an API Rule in the Rule Repository" on 
page 964.
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Tasks

How to Define an API Rule in the CI Indicators Tab

Each KPI has three applicable API rules. Within the CI Indicators tab, assign 
one of the API rules to a KPI, and enter the calculation script (and other rule 
details) to define the rule logic for that KPI.

This task includes the following steps:

➤ "Assign an API rule to a KPI" on page 959

➤ "Define the KPI’s rule logic" on page 959

 1 Assign an API rule to a KPI

To assign an API rule for a specific KPI assigned to a CI, select Admin > 
Service Health > CI Indicators. Select New KPI to assign a new KPI to the 
CI, or Edit KPI to modify an existing KPI. For details on this process, see 
"How to Assign KPIs and HIs to CIs" on page 428.

From the list of applicable business rules, select one of the API rules: API 
Group and Sibling Rule, API Sample Rule, or API Duration-Based Sample 
Rule. For a description of the rule types see "Rules API Overview" on 
page 948.

 2 Define the KPI’s rule logic

Depending on the type of rule you are creating, define the rule methods 
and fields as described in:

➤ "API Group and Sibling Rule" on page 950

➤ "API Sample Rule" on page 953

➤ "API Duration-Based Sample Rule" on page 955
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How to Create a Text File-Based API Rule

There are three rule template files corresponding to the three API rules; each 
template implements the rule’s interface.

Create a text file defining a new rule using one of the templates, and then 
add the new rule to the Business Rule Repository. The rule can then be 
applied like any out-of-the-box rule.

The API code cannot be seen or changed within Service Health, but only 
within the text file. If you make changes to the code within the text file, 
these changes are applied to all instances where the rule has been assigned, 
after you reload Service Health rules.

This task includes the following steps:

➤ "Create a text file for a rule" on page 960

➤ "Add a rule in the rule repository" on page 961

➤ "Add the rule to the KPI’s applicable rules list" on page 963

➤ "Add tooltip parameters to the new tooltip" on page 963

➤ "Reload rules after editing the text file" on page 964

 1 Create a text file for a rule

Based on the type of rule you want to create, copy and rename one of the 
template files located in the <Data Processing server root 
directory>\BLE\rules\groovy\templates directory.

Within your copy of the template, define the rule methods and fields as 
described in:

➤ "API Group and Sibling Rule" on page 950

➤ "API Sample Rule" on page 953

➤ "API Duration-Based Sample Rule" on page 955

Save the file to the <Data Processing server root 
directory>\BLE\rules\groovy\rules directory.

You must now add a rule in the Rule Repository that uses the rule logic in 
the text file. 
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 2 Add a rule in the rule repository

 a Select Admin> Service Health > Repositories > Business Rules > New 
Rule. For details on adding rules, see "How to Customize a Business 
Rule Template in the Repository" on page 724.

 b In the Name field, type the name of the rule you want to create 
(mandatory).

 c In the Class Name field, type groovy: <file name>. Note that the file 
name must be identical (case sensitive) to the file name in the <Data 
Processing server root directory>\BLE\rules\groovy\rules directory.

 d Create Rule parameters depending on your API rule type, as follows:

➤ In the Rule parameters area, click New.

➤ For API Sample rules:

In the Name field type Maximum number of samples. In the Type 
field, select Integer. In the Default Value field, type 1.

Click OK to Save.

➤ For API Duration-Based Sample rules:

In the Name field type duration. In the Type field, select Long. In 
the Default Value field, type 990.

Click OK to Save.

Repeat these steps to add the No Data Timeout rule parameter (Type: 
Long; Default Value = 990).

 e Create Threshold parameters: critical, major, minor, warning, 
informational, and operator. (Skip this step if you are defining a Group 
and Sibling rule that does not have Thresholds, where status is 
calculated by the rule code.)

➤ In the Threshold parameters area, click New.

➤ In the Name field, type critical. In the Type field, select Float.

When defining the operator parameter, select String in the Type 
field.

➤ Click OK to save.
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Repeat the above steps for each of the other Threshold parameters 
(major, minor, warning, informational, and operator). 

The following image shows a Sample rule after the rule parameter has 
been added:
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The following image shows a Duration-Based Sample rule after the rule 
parameters have been added:

 3 Add the rule to the KPI’s applicable rules list

Add the new rule to the list of applicable rules already attached to the 
relevant KPI. For details, see the Main Settings Area > Applicable Rules 
parameter in "New KPI/Edit KPI Dialog Box" on page 668.

 4 Add tooltip parameters to the new tooltip

When a rule is created using this procedure, a corresponding tooltip is 
with no tooltip parameters. For instructions on adding tooltip parameters 
to the new tooltip, see "How to Work with Tooltip Entries" on page 966.
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 5 Reload rules after editing the text file

If you make changes to the text file at any time after the rule is created, 
perform the following steps to apply the changes.

 a In the browser, access JMX port <29810 + workerID> (for example, 
29811 for worker _1).

 b Within BSM-Platform, select the service called MarbleWorker and 
invoke the reloadRules method. This method is applied to all the 
customers served by this worker.

How to Define an API Rule in the Rule Repository

Within the Business Rule Repository, create an API rule that can be applied 
to multiple KPIs. This is done by cloning one of the three API rules, and 
setting default rule values for specific rule parameters. After the rule is 
applied to a KPI, you can edit its script within the CI Indicators tab at any 
time to change the rule logic for the specific KPI.

This task includes the following steps:

➤ "Clone an API rule" on page 964

➤ "Edit rule details" on page 965

➤ "Add the rule to the KPI’s applicable rules list" on page 965

 1 Clone an API rule

Select Admin> Service Health > Repositories > Business Rules. In the 
Business Rule Repository page, clone one of the following rules: API 
Group and Sibling Rule, API Sample Rule, or API Duration-Based Sample 
Rule.

For details on cloning a rule, see "How to Customize a Business Rule 
Template in the Repository" on page 724.
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 2 Edit rule details

 a Open the new rule for editing.

 b In the Name field, rename the cloned rule.

 c Edit the KPI Calculation Script rule parameter. In the Default Value 
field, enter the rule calculation script. The code that you enter is the 
default code for this rule, and appears in the CI Indicators tab for all 
KPIs assigned this rule. (Do not change any other fields.)

 d If you are creating a Sample rule or Duration-Based Sample rule, edit 
the Sample Fields rule parameter. The sample fields that you enter are 
the default sample fields for this rule, and appear in the CI Indicators 
tab for all KPIs assigned this rule. (Do not change any other fields.)

For details on these rule parameters, see the following sections 
(depending on the type of rule you are creating):

➤ "API Group and Sibling Rule" on page 950

➤ "API Sample Rule" on page 953

➤ "API Duration-Based Sample Rule" on page 955

The Rules API classes are documented in Javadoc format in the following 
location HP Rules API Reference. These files are located in the following 
folder:
\\<HP Business Service Management Gateway Server root directory>\
AppServer\webapps\site.war\amdocs\eng\doc_lib\Service_Health\Rules
_API\index.html

 3 Add the rule to the KPI’s applicable rules list

Add the new rule to the list of applicable rules already attached to the 
relevant KPI. For details, see the Applicable Rules parameter in "New 
KPI/Edit KPI Dialog Box" on page 668.
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How to Work with Tooltip Entries

The following section describes how to work with tooltip entries to display 
information calculated by the Rules API.

 1 Select Admin> Service Health > Repositories > Business Rules. In the Rule 
Repository page, add any required tooltip entries for the new rule. The 
following table lists common tooltip entries and their corresponding 
value sources and formatting methods:

For details, see "New/Edit Tooltip Parameter Dialog Box" on page 878.

 2 If you have used the kpi.setTooltip method, you must set a corresponding 
tooltip entry in the Rule Repository as described above. In the Value 
Source field, type the name of the tooltip entry exactly as used in the 
code, and leave the Formatting Method field empty.

For example, if your code contains the method invocation 
kpi.setTooltip("total_sales", value), type NODE.DIM.RESULT.total_sales in 
the Value Source field.

Tooltip Parameter Value Source Formatting Method

Business Rule NODE.DIM.RULE.ID_CUST ruleIDtoString

CI name NODE.PROPS.BamNodeNameKey toLowerCase

Held status since NODE.DIM.RESULT.LastStatusChange returnDateAsString

Status NODE.DIM.RESULT.Status getStatusString

Value NODE.DIM.RESULT.Value returnNumOfDigitAfterPoint
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How to Write to Log Files From the Rules API Code

Within your API rules, you can write to log files from rule methods using a 
logger object. There are five log levels: debug, info, warn, error and fatal. 
Each of these uses a specific logger method.

By default, only log method invocations of error and fatal severity are 
written to the log files. You can modify this within the log configuration 
files.

To write to log files using the Rules API:

 1 Within the rule method, implement one of the following methods (listed 
in ascending order of severity):

➤ logger.debug("<API rule name> : log message");

➤ logger.info("<API rule name> : log message");

➤ logger.warn("<API rule name> : log message");

➤ logger.error("<API rule name> : log message");

➤ logger.fatal("<API rule name> : log message");

Type the name of your API rule inside the log message to identify each log 
message with its source rule.

 2 The Rules API log files are found in the <Data Processing server root 
directory>\HPBSM\log\marble_worker_<worker#>\RulesAPI directory.

Open one of the following files to view the log messages (depending on 
your rule type):

➤ groupAndSiblingRule.log (for API Group and Sibling rules)

➤ sampleRule.log (for API Sample rules)

➤ durationBasedSampleRule.log (for API Duration-Based sample rules)

To modify the severity level written to a log file:

 1 By default, only log method invocations of error and fatal severity are 
written to log files. To modify this setting, open the log configuration file 
located in <Data Processing server root 
directory>HPBSM\conf\core\Tools\log4j\marble_worker\dashboard_ru
les.properties.
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 2 In the line corresponding with your rule type, replace the string 
${loglevel} with the severity level you want logged (either DEBUG, INFO, 
WARN, ERROR, or FATAL). Edit one of the following lines, depending on 
your rule type:

➤ Group and Sibling rules: 
log4j.category.com.mercury.am.rules.dashboard.blDashboardRules.
simplifiedRule.groupAndSiblingRule.DashboardGroupAndSiblingRule 
= ${loglevel},  bam.app.rules.api.group.appender

➤ Sample rules: 
log4j.category.com.mercury.am.rules.dashboard.blDashboardRules.
simplifiedRule.leaf.DashboardSimplifiedSampleBasedRule = 
${loglevel},  bam.app.rules.api.leafsample.appender

➤ Duration-Based Sample rules: 
log4j.category.com.mercury.am.rules.dashboard.blDashboardRules.
simplifiedRule.leaf.DashboardSimplifiedTimeBasedRule = ${loglevel},  
bam.app.rules.api.leafduration.appender

How to Include a CI Property in Rules API Calculations

Within your API rules, you can include CI properties using the CI class 
getPropertyValue method, and the KPI class getCiProperty method. Only CI 
properties with one of the following qualifiers can be accessed with this 
method:

➤ BLE_ATTRIBUTE - SLM and Service Health

➤ BLE_ONLINE_ATTRIBUTE - Service Health only

To add this attribute to a CI class you must export the class, edit the class 
definition, and import it back to the server. When you open the exported 
class for editing, add the following xml to the required attribute:

<Attribute name="<attribute-name>" type="double" display-name="<attribute-
display-name>">

<Attribute-Qualifiers>
<Attribute-Qualifier name="BLE_ATTRIBUTE"/>

</Attribute-Qualifiers>
</Attribute>
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Reference

Examples - API Group and Sibling Rule

This section provides examples of API Group and Sibling Rules. The 
following examples are described:

➤ "Example - Worst Child Rule" on page 970

➤ "Example - Worst Sibling Status Rule" on page 971

➤ "Example - Specific Child CI Group Rule" on page 972

➤ "Example - Sibling Rule Based on Availability and Performance KPIs" on 
page 973

➤ "Example - Group Average Value by CI Type" on page 974

➤ "Example - Worst Health Indicator Rule" on page 975

➤ "Example - Using Groovy Closure" on page 976
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Example - Worst Child Rule
The following rule finds the worst status from all of the KPIs of the 
calculated CI's child CIs, which are of the same type as the calculated KPI, 
based on active statuses only. Active statuses are Critical, Major, Minor, 
Warning, and OK.

public void calculateKPI(CI ci, KPI kpi) {

// Get the calculated KPI's type ID (as defined in the Service Health KPI Repository).
int kpiId = kpi.getType();
// Get a list of all of the KPIs of the calculated CI’s child CIs, which are of the same
// type as the calculated KPI.
List<KPI> childKpiList = ci.getChildrenKPIsByID(kpiId);
// Create a variable to set the status of the calculated KPI, 
// only if an active status is found.
boolean isActiveStatusFound = false;
// Set the current worst status to OK; if a worse status is found this will be updated.
Status worstStatus = Status.OK;
// Go over the list of child KPIs.
childKpiList.each{KPI childKPI->

// Get the child KPI's status. 
Status childKpiStatus = childKPI.status;
// Check if the child KPI's status is an active status.
if(childKpiStatus.isActive()){

// Mark that an active status was found.
isActiveStatusFound = true;
// Check if the child KPI's status is worse than the current worst status.
if(childKpiStatus.isWorse(worstStatus)){

// Update the worst status.
worstStatus = childKpiStatus;

}
}

}
// Check if an active status was found in the child KPI.
if(isActiveStatusFound){

// Set the calculated KPI status.
kpi.setStatus(worstStatus);

}

}
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Example - Worst Sibling Status Rule
The following rule finds the worst status from sibling KPIs, based on active 
statuses only. Active statuses are Critical, Major, Minor, Warning, and OK.

public void calculateKPI(CI ci, KPI kpi) {

// Get a list of all the KPIs for the CI.
List<KPI> ciKpiList = ci.getAllKPIs();
/**
 * Create a variable to set the status of the calculated KPI,
 * only if an active status is found.
 */
boolean isActiveStatusFound = false;
// Set the current worst status to OK; if a worse status is found this will be updated.
Status worstStatus = Status.OK;
// Go over the list of the CI's KPIs.
ciKpiList.each {KPI ciKPI ->

/**
* Check that the CI's KPI is not the calculated KPI.
* This is needed because getAllKPIs method returns all the KPIs for the CI.
*/
if (ciKPI !=  kpi) {

/**
 * The ciKPI represents a sibling KPI of the calculated KPI.
 * Get the sibling KPI's status.
 */
Status siblingKpiStatus = ciKPI.status;
// Update worstStatus if necessary.
if (siblingKpiStatus.isActive()) {

isActiveStatusFound = true;
if (siblingKpiStatus.isWorse(worstStatus)) {

worstStatus = siblingKpiStatus;
 }
}

}
}
// Check if an active status was found in the sibling KPI.
if (isActiveStatusFound) {
    // Set the calculated KPI's status.
    kpi.setStatus(worstStatus);
}

}
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Example - Specific Child CI Group Rule
The following rule calculates KPI status based on the Availability KPI of a 
specific child CI (RTSM ID = "96c2df2b544683c7f79bb382d1d7b3a9"). 

If the child CI’s Availability KPI value is 100, the calculated KPI’s status is set 
to OK. All other values set the KPI’s status to Critical.

Status is set only if the child CI exists, has the Availability KPI, and its 
Availability KPI has value.

public void calculateKPI(CI ci, KPI kpi) {

/**
* Get the Availability KPI for the child CI "tx_10 from virtual_host_3".
* The RTSM ID of "tx_10 from virtual_host_3" is 

"96c2df2b544683c7f79bb382d1d7b3a9".
*
* Note: Within the UI, the following line can be written as
* KPI childKPI = "tx_10 from virtual_host_3"."Availability"
*/
KPI childKPI = ci.getChildKpiByChildId(KpiType.Availability, 

"96c2df2b544683c7f79bb382d1d7b3a9");

// Check if childKPI is not null. It is null if no child CI with this RTSM ID exists, or if 
this CI does not have the Availability KPI.

if (childKPI != null) {

// Check if the child KPI has a value.
if (childKPI.valueExist) {

if (childKPI.value == 100.0) {
kpi.status = Status.OK

}
else {

kpi.status = Status.CRITICAL
}

}
}

}
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Example - Sibling Rule Based on Availability and 
Performance KPIs
The following rule calculates KPI status based on the status of sibling 
Availability and Performance KPIs. 

If these KPIs do not exist or do not have active status, no status is set. 

If these sibling KPIs exist and are both OK, the calculated KPI status is set to 
OK. Otherwise, its status is set to Critical. (Active statuses are Critical, Major, 
Minor, Warning, and OK.)

public void calculateKPI(CI ci, KPI kpi) {

/**
 * Get the sibling KPI of type Availability.
 * If Availability KPI does not exist, null will be returned.
 */
KPI availabilityKPI = ci.getKPI(KpiType.Availability);
// Get the sibling KPI of type Performance.
KPI performanceKPI = ci.getKPI(KpiType.Performance);

if (availabilityKPI != null && performanceKPI != null) {
// Both KPIs exist for this CI. Check if the KPIs status is active.
if (availabilityKPI.status.isActive() && performanceKPI.status.isActive()) {

// Check the KPI's status.
if (availabilityKPI.status == Status.OK &&

performanceKPI.status == Status.OK) {
/**
 * Both statuses are active and both are OK. Set this KPI's status to OK.
 */
kpi.status = Status.OK

}
else {

/**
 * Both statuses are active, and not both are OK.
 * Set this KPI's status to CRITICAL
 */
kpi.status = Status.CRITICAL

}
}

}
}
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Example - Group Average Value by CI Type
The following rule calculates the average status of the KPIs of child CIs, 
which are of the same CI type as the calculated KPI. 

Only child CIs of type "bpm_tx_from_location" are used in the calculation. 
If there are no child CIs of this type, or no child CI KPIs have value, no value 
is set for the KPI.

public void calculateKPI(CI ci, KPI kpi) {

// Get the calculated KPI's type ID (as defined in the Service Health KPI Repository).
int kpiId = kpi.getType();
// Get a list of the KPIs of the child CIs, which are of the same CI type as the 

calculated 
// KPI, whose CI type is  "bpm_tx_from_location".
List<KPI> bpmTxFromLocationChildKpiList = 

ci.getChildrenKPIsByIDAndCiType(kpiId, "bpm_tx_from_location")

// Create a variable to sum the total values from child KPIs. 
// If no child exists or no child has value the variable will remain null.
Double totalChildValue = null;
// Write information to the log file.
logger.debug("DashboardGroupAvgValueByCiTypeRule : number of child CIs with 

type bpm_tx_from_location: " + bpmTxFromLocationChildKpiList.size())
// Go over the list of child KPIs.
bpmTxFromLocationChildKpiList.each {KPI childKPI ->

// Sum values of the child KPIs using the Utils class, which handles null values.
totalChildValue = Utils.sum(totalChildValue, childKPI.value);

}
// Set the calculated KPI's value to the average value, using the Utils class. 
// If totalChildValue is null, null value will be set.
kpi.value = Utils.divide(totalChildValue, bpmTxFromLocationChildKpiList.size());

}
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Example - Worst Health Indicator Rule
The following rule finds the worst status from all of the health indicators 
(HIs) of the calculated CI, based on active statuses only. Active statuses are 
Critical, Major, Minor, Warning, and OK.

public void calculateKPI(CI ci, KPI kpi) {
// Get all health indicators.
List<HI> his = ci.getHIs();

// Create a variable to set the status of the calculated KPI,
// only if an active status is found.
boolean isActiveStatusFound = false;

// Set the current worst status to OK;
// if a worse status is found this will be updated.
Status worstHiStatus = Status.OK;

his.each {HI hi ->
Status hiStatus = hi.getStatus();
// Check if the current HI status is an active status.
if (hiStatus.isActive()) {

// Mark that an active status was found.
isActiveStatusFound = true;

// Check if the child KPI's status is worse than the current worst status.
if (hiStatus.isWorse(worstHiStatus)) {

// Update the worst status.
worstHiStatus = hiStatus;

}
}

}

// Check if an active status was found in the child KPI.
if (isActiveStatusFound) {

// Set the calculated KPI status.
kpi.setStatus(worstHiStatus);

}
}
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Example - Using Groovy Closure
The following rule sets the calculated KPI’s status to Critical, if at least one 
Availability KPI with Major status exists for the calculated CI’s child CIs.

This rule illustrates Groovy Closure. Refer to 
http://groovy.codehaus.org/Closures for more information.

public void calculateKPI(CI ci, KPI kpi) {

/**
 * Use Groovy Closure with the CI class getChildrenKPIs method,
 * to get List of KPIs from the CI`s child CIs, where 
 * 1. KPI type is Availability
 * 2. Status is MAJOR
 
 Closure description:

 { KPI childKPI ->
childKPI.type == KpiType.Availability.getID("DASHBOARD") && childKPI.status 

== Status.MAJOR
 }

 The Closure defines one parameter named childKPI of type KPI.

 Each KPI from the CI`s child CIs will be passed to the Closure by the 
getChildrenKPIs method.

 The Closure body returns a boolean value based on the logical expression result.
 Each KPI that the Closure body will return true for, will be part of the returned List 

 The expression KpiType.Availability.getID("DASHBOARD") returns an int 
representing the Availability KPI ID from the Service Health KPI Repository.

 */
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List<KPI> kpiList = ci.getChildrenKPIs {KPI childKPI ->
childKPI.type == KpiType.Availability.getID("DASHBOARD") && childKPI.status 

== Status.MAJOR
}
// Check if such a KPI exists.
if (kpiList.isEmpty()) {
 // No such KPI exists.

// Write to a log file at debug level.
logger.debug "Closure Rule: no Availability KPI with  MAJOR status exist"

}
else {

//  At least one Availability KPI with MAJOR status exists.
logger.debug("Closure Rule: At least one Availability KPI  with  MAJOR status 

exist")
// Set calculated KPI status to CRITICAL.
kpi.status = Status.CRITICAL;

}
}
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Examples - API Sample Rule

This section provides examples of API Sample Rules. The following examples 
are described:

➤ "Example - Average Availability Rule" on page 978

➤ "Example - Average Performance Rule" on page 979

➤ "Example - Average Performance Rule Using a Rule Parameter Filter" on 
page 980

Example - Average Availability Rule
The following rule calculates average availability of samples, based on the 
u_iStatus sample field.

The rule logic is (available samples / total samples) * 100.

// This rule uses the u_iStatus sample field.
def sampleFields = ["u_iStatus"];

public void calculateKPI(CI ci, KPI kpi, List<Sample> samples) {
// Keep total number of samples for this calculation cycle.
def totalSamples = samples.size();
// Create a variable to count available samples.
def availableSamples = 0;
/**
* Go over the given samples. If a sample's u_iStatus is equal to 0,
* the sample is considered available.
*/
samples.each {Sample currentSample->
if (currentSample.u_iStatus == 0) {

// Increase the count of available samples.
availableSamples++;
}

}
if (totalSamples > 0) {

// Set KPI value, converted to percentage.
kpi.setValue ((availableSamples/totalSamples)*100.0);
}

}
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Example - Average Performance Rule
The following rule calculates average performance in seconds, based on the 
dResponseTime and u_iStatus sample fields. 

Only samples with a u_iStatus value of 0 (available samples) are used in the 
calculation. The rule logic is: sum(dResponseTime) / available samples.

// This rule uses the u_iStatus and dResponseTime sample field.
def sampleFields = ["u_iStatus", "dResponseTime"];

public void calculateKPI(CI ci, KPI kpi, List<Sample> samples) {

// Create a variable to count available samples.
def availableSamples = 0;
// Create a variable to sum response times of available samples.
def totalResponseTime = 0;
/**
 * Go over the given samples. If a sample's u_iStatus is equal to 0,
 * the sample is considered available.
 */
samples.each {Sample currentSample ->

if (currentSample.u_iStatus == 0) {
// Increase the count of available samples.
availableSamples++;
// Add the current sample's dResponseTime value to totalResponseTime.
totalResponseTime += currentSample.dResponseTime

}
}
if (availableSamples > 0) {

// Set KPI value, converted to percentage.
kpi.setValue((totalResponseTime / availableSamples))

}
}
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Example - Average Performance Rule Using a Rule 
Parameter Filter
The following rule calculates average performance in seconds, based on the 
dResponseTime and u_iStatus sample fields. 

Only samples with a u_iStatus value of 0 (available samples) are used in the 
calculation.

The rule uses an optional rule parameter: Response time limit. If this rule 
parameter value has been set in the Service Health Admin, samples with a 
dResponseTime value greater then the rule parameter value are not used in 
the calculation.

Note: A rule parameter with the same name must be set for the rule in the 
Rule Repository. For details, see "New/Edit Rule Parameter or New/Edit Rule 
Threshold Dialog Box" on page 877.

The rule logic is: sum(dResponseTime) / available samples.

/ This rule use the u_iStatus and dResponseTime sample fields.
def sampleFields = ["u_iStatus", "dResponseTime"];

public void calculateKPI(CI ci, KPI kpi, List<Sample> samples) {

// Create a variable to count available samples.
def availableSamples = 0;
// Create a variable to sum response times of available samples.
def totalResponseTime = 0;
/**
 * Get the value of the rule parameter named "Response time limit"
 * from the KPI, as defined for the KPI in Service Health Admin.
 * This rule parameter is optional, so responseTimeLimit can be null.
 */
Long responseTimeLimit = kpi.getRuleParameter("Response time limit")



Chapter 25 • Service Health Rules API

981

/**
 * Go over the given samples. If a sample's u_iStatus is equal to 0,
 * the sample is considered available.
 */
samples.each {Sample currentSample ->

if (currentSample.u_iStatus == 0) {
/**
* Check the value of the rule parameter.
* If it is not null (meaning the user has set a value),
* and the sample's dResponseTime is greater than the
* rule parameter value, the value is not valid.
*/
boolean isSampleValid = true;
if (responseTimeLimit != null) {

// Check if ResponseTime exceeds the rule parameter value.
if (currentSample.dResponseTime > responseTimeLimit) {

// The sample is not valid.
isSampleValid = false;

}
}
if (isSampleValid) {

// Increase the count of available samples.
availableSamples++;
// Add the sample's dResponseTime value to totalResponseTime.
totalResponseTime += currentSample.dResponseTime

}
}

}
if (availableSamples > 0) {

// Set KPI value, converted to percentage.
kpi.setValue((totalResponseTime / availableSamples))

}
}
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26
Service Health External APIs

This chapter includes:

Concepts

➤ Retrieve Indicator Data on page 984

➤ Reset Health Indicator State on page 992

➤ Service Health Database Query API on page 994
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Concepts

Retrieve Indicator Data

The following external API can be used to access KPI over time statuses, KPI 
definitions, and indicator statuses.

This section includes the following topics:

➤ "Get KPI Over Time Statuses" on page 984

➤ "Get KPI Definitions" on page 988

➤ "Get Indicator Statuses" on page 990

The service log file is located under: <Gateway server root 
directory>\log\EJBContainer\serviceHealthExternalAPI.log.

Return values are supported in XML and JSON formats.

Authentication should be done using basic access authentication method. 
For details and examples refer to http://en.wikipedia.org/wiki/
Basic_access_authentication.

Get KPI Over Time Statuses
You can use the following to get KPI over time statuses.

API Syntax

The API uses the following parameters:

➤ customerId. Customer ID (use 1 for non-HP SaaS deployment).

➤ ciId. Mandatory; use comma-separated CI IDs.

➤ startDate. Mandatory; start time for the KPI status (value representing the 
date in seconds since January 1 1970).

http://<Gateway Server>/topaz/servicehealth/customers/<Customer Id>/
kpiOverTime?ciIds=<CI ID>&startDate=<Start Date>&endDate=<End Date>
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➤ endDate. Mandatory; end time for the KPI status (value representing the 
date in seconds since January 1 1970).

➤ view. Optional; retrieve the results in the context of a local impact view 
(default is global view). For details, see "Local Impact Views" on page 49.

➤ kpiId. Optional; use comma separated KPI internal IDs as in the repository 
UI (default is empty for all KPIs). For details, see "List of Service Health 
KPIs" on page 656.

The following is an example of the API and its output:

http://host.devlab.ad/topaz/servicehealth/customers/1/
kpiOverTime?ciIds=0b656ce308022a6739e3e726497fda6a&startDate=1296499370&e
ndDate=1296501466
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<kpiStatuses>
<kpiStatus>

<ciId>0b656ce308022a6739e3e726497fda6a</entityId>
<ciDisplayLabel>ATM 1610</ciDisplayLabel>
<kpiType>6</kpiType>
<kpiDisplayName>Application Performance</kpiDisplayName>
<timeStamp>1296499370</timeStamp>
<status>20</status>
<statusDisplayName>OK</statusDisplayName>
<duration>311</duration>

</kpiStatus>
<kpiStatus>

<ciId>0b656ce308022a6739e3e726497fda6a</entityId>
<ciDisplayLabel>ATM 1610</ciDisplayLabel>
<kpiType>6</kpiType>
<kpiDisplayName>Application Performance</kpiDisplayName> 
<timeStamp>1296499681</timeStamp>
<status>-2</status>
<statusDisplayName>No Data</statusDisplayName>
<duration>1785</duration>

</kpiStatus>
<kpiStatus>

<ciId>0b656ce308022a6739e3e726497fda6a</entityId>
<ciDisplayLabel>ATM 1610</ciDisplayLabel>
<kpiType>6</kpiType>
<kpiDisplayName>Application Performance</kpiDisplayName> 
<timeStamp>1296501466</timeStamp>
<status>20</status>
<statusDisplayName>OK</statusDisplayName>
<duration>13334</duration>

</kpiStatus>
<kpiStatus>

<ciId>0b656ce308022a6739e3e726497fda6a</entityId>
<ciDisplayLabel>ATM 1610</ciDisplayLabel>
<kpiType>7</kpiType>
<kpiDisplayName>Application Availability</kpiDisplayName> 
<timeStamp>1296428400</timeStamp>
<status>0</status>
<statusDisplayName>Critical</statusDisplayName>
<duration>69663</duration>

</kpiStatus>
</kpiStatuses>
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The output fields are as follows:

Return Codes

The API returns the following return codes:

Field Description

ciId CI ID

ciDisplayLabel CI display label

kpiType KPI ID (see "Get KPI Definitions" on page 988)

kpiDisplayName KPI display name

timeStamp
Start time for the KPI status; value representing the date in 
seconds since January 1 1970

status KPI status (see "Get Indicator Statuses" on page 990)

statusDisplayName KPI status display name

duration Duration of the KPI’s status in seconds.

Name
Error 
Code

Description

BAD_REQUEST

400 ➤ Start date is after the end date

➤ Start date is in the future

➤ startDate, endDate or ciIDs are missing

UNAUTHORIZED 401 User has no permission for the selected view

INTERNAL_
SERVER_ERROR

500 ➤ Result size has exceeded the maximum quota

➤ General failure
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Get KPI Definitions
You can use the following to retrieve the KPIs defined in the system. 

API Syntax

The API uses the following parameters:

➤ customerId. Customer ID (use 1 for non-HP SaaS deployment).

➤ kpiIds. Optional; leave empty for all KPIs (default), or enter a KPI internal 
ID as in the repository UI, to select a specific KPI. For details, see "List of 
Service Health KPIs" on page 656.

The following is an example of the API and its output:

http://<Gateway Server>/topaz/servicehealth/customers/<CustomerId>/repositories/
indicators/kpis/<kpiId>

http://host.devlab.ad/topaz/servicehealth/customers/1/repositories/indicators/kpis/

<kpis>
<kpi>

<id>1</id>
<name>Legacy System</name>

</kpi>
<kpi>

<id>1311</id>
<name>Value</name>

</kpi>
<kpi>

<id>1310</id>
<name>Exceptions</name>

</kpi>
</kpis>
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The output fields are as follows:

Return Codes

The API returns the following return codes:

Field Description

id
KPI internal ID as in the repository UI; for details see "List of 
Service Health KPIs" on page 656.

name KPI name

Name
Error 
Code

Description

NOT_FOUND 404 KPI not found

INTERNAL_
SERVER_ERROR

500 General failure
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Get Indicator Statuses
You can use the following to retrieve indicator statuses.

API Syntax

The API uses the following parameters:

➤ customerId. Customer ID (use 1 for non-HP SaaS deployment).

http://<Gateway Server>/topaz/servicehealth/customers/<CustomerId>/repositories/
indicators/statuses
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The following is an example of the API and its output:

http://host.devlab.ad/topaz/servicehealth/customers/1/repositories/indicators/statuses

<targets>
<target>

<id>20</id>
<name>OK</name>
</target>
<target>

<id>15</id>
<name>Warning</name>

</target>
<target>

<id>10</id>
<name>Minor</name>

</target>
<target>

<id>5</id>
<name>Major</name>

</target>
<target>

<id>0</id>
<name>Critical</name>

</target>
<target>

<id>-1</id>
<name>Info</name>

</target>
<target>

<id>-2</id>
<name>No Data</name>

</target>
<target>

<id>-4</id>
<name>Downtime</name>

</target>
</targets> 
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The output fields are as follows:

Return Codes

The API returns the following return codes:

Reset Health Indicator State

In certain event flows, you might have an HI showing that a problem has 
occurred but no event has closed the problem, even though the problem 
was fixed. After dealing  with the problem, you might want to reset the HI’s 
state to Normal (default). For details on resetting HI state within Service 
Health, see "How to Work with the Health Indicator Component" on 
page 252.

The Reset HI State API enables users outside of the BSM user interface to 
reset event-based HIs to their default state, using the HTTP-based REST 
protocol.

You can reset all HIs on a specific CI, or reset a specific HI.

This REST API is case-sensitive, and uses the PUT method.

Field Description

id KPI status internal ID

name KPI status name

Name
Error 
Code

Description

INTERNAL_
SERVER_ERROR

500 General failure
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Note: This API can impact the overall performance of your system; consult 
with HP Professional Services before using the API.

API Syntax

➤ To reset all HIs related to a CI:

➤ To reset a specific HI:

➤ To reset a specific subcomponent of an HI:

HI name refers to the name of the HI as defined in the indicator repository, 
and not to the HI’s display label.

Return Codes and Log File
The API returns the following return codes:

http://<Gateway Server>/topaz/servicehealth/customers/<CustomerId>/cis/<CI ID>/his/
reset

http://<Gateway Server>/topaz/servicehealth/customers/<CustomerId>/cis/<CI ID>/his/
<HI name>/reset

http://<Gateway Server>/topaz/servicehealth/customers/<CustomerId>/cis/<CI ID>/his/
<HI name>/reset?subcomponent=<subcomponent name>

Name
Error 
Code

Description

OK 200 Success

UNAUTHORIZED 401 The user is not authorized for the customer
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The service log file is located under: <Gateway server root 
directory>\log\EJBContainer\serviceHealthExternalAPI.log.

In addition, the service writes to the Audit log on each HI reset.

Service Health Database Query API

You can use the Service Health API to query the database and return a list of 
views in XML format.

Tip: You can use XSLT to convert the XML output into any other format 
(commonly text or HTML). For example, using basic XSLT transformations, 
you can produce HTML reports that are formatted to fit on mobile devices. 
These reports can be served via a mobile portal to display critical Business 
Service Management views on users’ mobile phones.

This section also includes the following topics:

➤ "Query Syntax" on page 995

➤ "Main Parameters Used in the Query" on page 995

➤ "Query Examples" on page 997

NOT_FOUND

404 ➤ CI not found

➤ HI not found

➤ Bad request (syntax error)

INTERNAL_
SERVER_ERROR

500 ➤ RTSM error

➤ Repositories error

➤ Online engine error

Name
Error 
Code

Description
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Query Syntax
The basic syntax of the query is as follows:

Depending on the command parameter defined, additional parameters may 
also be included.

Main Parameters Used in the Query
The following table lists the parameters that must be defined in the query.

http://<Gateway Server>/topaz/bam/BAMOpenApi?customerId=<customer 
ID>&userName=<user name>&password=<password>&command=<command 
parameter>

Parameter Description

customerID
BSM customers should specify 1. 
HP Software-as-a-Service customers should specify 
their unique customer ID.

userName
Specify a user name defined in BSM. The query does 
not encrypt the login credentials.

password
Specify the password for the user name provided. 
The query does not encrypt the login credentials.

command

Specify one of the following values:

getViews – Specify to retrieve all views from the 
Run-time Service Model (RTSM). No other 
parameters are required.

getNodes – Specify to retrieve all child nodes of a 
specified view (you must also specify the view for 
which to retrieve child nodes in the viewName 
parameter); if using this command parameter you 
can also set the following parameters: showTooltip, 
depth, layout, xsltURL, responseContentType
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viewName

If the getNodes command parameter is defined, 
include this parameter in the query and specify the 
view to retrieve. You can set the value to 
ticker_all_views to retrieve all views and their 
nodes.

showTooltip

If the getNodes command parameter is defined, 
you can include this parameter in the query to 
specify whether to display Service Health’s KPI 
tooltip data, either true to display data or false to 
not. The default value is false.

depth

If the getNodes command parameter is defined, 
you can include this parameter in the query to 
specify the number of levels in the view to display. 
The default value is 1.

layout

If the getNodes command parameter is defined, 
you can include this parameter in the query to 
specify the layout for the query results, either 
hierarchical or flat. In flat mode all nodes are 
retrieved in a flat list, and in hierarchical mode 
nodes are retrieved in the same hierarchy as in the 
view. The default value is flat.

xsltURL

If the getNodes command parameter is defined, 
you can include this parameter in the query to 
specify a URL to an .xslt file that transforms the 
.xml-format result of the query.

responseContentType

If the getNodes command parameter is defined, 
and the xsltURL parameter is included in the query, 
you can include this parameter in the query to 
specify the response MIME type.

Parameter Description
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Query Examples
The following query returns a flat list of all views in the Run-time Service 
Model (RTSM):

The following query returns a hierarchical tree showing KPI status and 
tooltip information for the Service Measurements view, to a depth of three 
child nodes.

http://myserver/topaz/bam/
BAMOpenApi?customerId=1&userName=admin&password=admin&command=getVie
ws

http://myserver/topaz/bam/
BAMOpenApi?customerId=1&userName=admin&password=admin&command=getNod
es&viewName=Service%20Measurements&showTooltip=true&depth=3&layout=hierarc
hical
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Siebel Tasks in Error 101
SiteScope 100
SiteScope Quick Report 107
SiteScope Server Centric Report 107
Systinet Web Service Data 108
Trend 108
Triage 108

CI name
modify length

 70
CI Neighbors, context menu 899
CI Properties, context menu 900
CI Selector Pane 512
CI status

alert reports 285
alerts 285, 499
selecting statuses displayed in map 

202
CI Status Alert

overview 286, 500
CI Status alert

local impact view 502
CI Status alerts

attributes 542
downtime 502
event template 539

CIs
acknowledge utility for performance 

problems 127, 135, 138, 140, 142, 
329

assign geographical location 195
history statuses 48, 408

modify maximum number displayed 
CIs 71

Sample Details window 73
saving KPIs measurement data 736
selectors 406
trend statuses 48, 408

clone
KPI 653
rules 711

Collaborate, context menu item 103
Complete Alert, context menu item 109, 905
components

Service Health 33
Config File Menu, context menu 900
Configuration Item Status Alert Notifications 

report 295
Configuration Item Status Alerts

CI menu option 105
Configuration Item Status alerts 285, 499
Configuration Item Status Alerts page 534
Configuration Item Status Alerts report 309
Configuration Item Status Alerts, context 

menu item 905
Configuration Items dialog box 294, 341
configuring Health Indicators 395
configuring KPIs 395
Confirm CI Changes dialog box 482
Console page

modifying KPI over time 254
Console, context menu item 905
context menu

BMC Measurement Menu 899
BPI Business Process Menu 899
Business Process Insight Scorecard 

Menu 899
CI Neighbors 899
CI Properties 900
Config File Menu 900
Default Menu 900
Diagnostics BPM Menu 900
Diagnostics Monitor Menu 900
Diagnostics Probe Group Menu 900
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EMS Measurement Menu 901
EMS Show Events 901
Group Menu 901
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HP SC Menu 901
Locate CI 901
Locate CI in SLA 901
repository 899
SAP Alert Acknowledgment 902
SAP Menu 902
SAP System Menu 902
SAP Transaction Menu 902
SAP Transport Menu 902
Service Menu 902
Service Mng Menu 902
set up 893
Siebel Database Breakdown 

Diagnostics Menu 902
Siebel Diagnostics Menu 902
Siebel Menu 902
Siebel SARM and DBBD Diagnostics 

Menu 903
SiteScope Group Menu 903
Sitescope Measurement Menu 903
Sitescope Monitor Menu 903
SiteScope Web Service Monitor Menu 

903
Top View 903
TransactionVision Menu 903
VT Menu 903
Web Service Menu 903
Web Service Operation Menu 903

context menu actions
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context menu item
Acknowledgement Details 904
Acknowledgment Details 102
Aggregate Transaction Topology 104, 

904
Any Users Transaction Paths View 98, 

904
Any Users Transactions View 98, 904
Application Health Tab 99, 904
Application Summary 104, 904
BPI Monitors Over Time 904
BPM Application Health 104, 904
BPM Performance Analysis 104, 904
BPM Triage for Application 104, 904
BPM Triage for Transaction 104, 905

Business Process Over Time Report 
905

Change report 905
CI Impact Report 104, 905
Collaborate 103
Complete Alert 109, 905
Configuration Item Status Alerts 905
Console 905
Create New Business Service 905
Create New SLA from Business Service 

905
Custom Image 905
Customer 905
Delete 103, 905
Delete Business Service 906
Delete CI 103, 906
Diagnostics Agent/J2EE Server 

Summary View 98, 906
Diagnostics Probe Group Summary 

View 99, 906
Diagnostics Web Service Topology 

View 906
Edit Business Service 906
End User Summary 906
Errors 109, 906
Event Log Report 105, 906
Expand More Levels 906
Expand to Problem 906
Filters 906
Find Visible and Hidden Child CIs 

907
Geographical Map 907
Go to Console 907
Go to Service Health Console 100
Go to Top View 907
Group Load View 907
HIs 110, 907
Host Summary View 99, 907
HP Service Manager 110, 907
Infrastructure Summary 105, 907
Invoke Run Books 907
J2EE Application Summary View 908
KPIs Over Time 908
Load View 908
Locate CI in SLA 908
Locate CI in View 100, 908
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Location Summary Report 105, 108, 
908, 912

Monitor to Operations Health 908
New Folder 103, 908
Open in New Window 908
Operations Health 908
Oracle Server Summary View 99, 908
Performance Matrix for Application 

105, 909
Performance Matrix for Transaction 

106, 909
Probe Group Summary 909
Probe Summary 909
Problematic Subtree 909
Properties 909
Provider 909
Rename Folder 103, 909
Reset Health Indicator 103, 909
RUM Application Health 909
RUM Performance Analysis 106, 909
RUM Triage for Application 106, 909
RUM Triage for Transaction 106, 909
SAP R3 Summary View 99, 910
SAP Transaction Changes Report 910
SAP Transport Changes 910
SAR Compliancy Report 910
Service Impact 112, 910
Session Analyzer 910
Set/Unset Acknowledgement 910
Set/Unset Acknowledgment 103
Show Business Activity Over Time 

Report 112, 910
Show Contributing Events 112, 910
Show Events 910
Show Impacting SAP Transports 107, 

911
Show Impacting SAP Transports 

Transactions 107, 911
Show Path to Root 908
Show Processes 911
Show Related CIs 911
Show Running Tasks 911
Show SAP Transport Impact 107, 911
Show Tasks in Error 911
Show Top View 113, 911
Siebel Cross-Performance 911

Siebel Database Breakdown 911
Siebel SARM 911
SiteScope 907
SiteScope Cross-Performance 912
SiteScope Quick Report 912
SiteScope Server Centric Report 912
SQL Server Instance Summary View 

99, 912
SQL Server Summary View 99, 912
Synthetic Users Transactions Layers 

View 99, 912
Synthetic Users Transactions View 99, 

912
Systinet Web Service Data 912
Transaction Over Time 912
Transaction Summary 108, 912, 913
Transaction Tracking 108, 913
Trend 913
Triage 913
Triage Raw Data 108, 913
Web Service Health 913
WMQ Server Summary View 99, 913

Context Menu Repository page 931
Context Menus

user interface 931
context menus 899
context menus repository 891, 892
Create Edit URL dialog box 533
Create New Alert Wizard 516
Create New Business Service, context menu 

item 905
Create New Executable File dialog box 530
Create New SLA from Business Service, 

context menu item 905
Create New SNMP Trap dialog box 531
Create New URL dialog box 533
custom icons

changing 441
Custom Image

add CIs 492
administration overview 490
creating 491
display a view 216
displaying view 494
Service Health Administration 489
setting up 491
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Custom Image administration
user interface 495

Custom Image component 214
user interface 218

Custom Image, context menu item 905
Customer, context menu item 905
customized 727
customized rule 727

D

Dashboard
general information 115, 327

data over time
saving measurements data 736

Default Menu, context menu 900
Defining Filters dialog box 265
Delays KPI 657
Delete Business Service, context menu item 

906
Delete CI, context menu item 103, 906
Delete, context menu item 103, 905
dependent KPIs 652
Diagnostics

drilling down to HP Diagnostics 339, 
356

Diagnostics Agent/J2EE Server Summary 
View, context menu item 98, 906

Diagnostics Backend Transaction 
Application Exceptions Rule 778

Diagnostics Backend Transaction Average 
Response Time Rule 779

Diagnostics Backend Transaction Count Rule 
779

Diagnostics Backend Transaction Maximum 
Response Time Rule 780

Diagnostics Backend Transaction Minimum 
Response Time Rule 780

Diagnostics Backend Transaction SOAP 
Faults Rule 781

Diagnostics BPM Menu, context menu 900
Diagnostics Monitor Menu, context menu 

900
Diagnostics Probe Group Menu, context 

menu 900

Diagnostics Probe Group Summary View, 
context menu item 99, 906

Diagnostics Synthetic User Backend 
Application Exceptions Rule 781

Diagnostics Synthetic User Backend Average 
Response Time Rule 782

Diagnostics Synthetic User Backend Max 
Server Request Duration Rule 782

Diagnostics Web Service Topology
CI menu option 105

Diagnostics Web Service Topology View, 
context menu item 906

domains, KPI 411
dominant child status calculation method 

719
downtime

CI Status alerts 502
Downtime Sentence, tooltip 887
drill down

Layers View 339, 356
Summary View 339, 356
to HP Diagnostics 339, 356
Transactions View 339, 356

drill down to SiteScope 79
Drilldown to SiteScope 95
Duration

KPI 657
dynamic URL parameters 897

E

Edit Action dialog box 939
Edit Breakdown Filter dialog box 486
Edit Business Service, context menu item 906
Edit Context Menu dialog box 935
Edit Context Menus dialog box 485
Edit ETI dialog box 696
Edit Executable File dialog box 530
Edit Global Parameter dialog box 885
Edit Global Tooltip dialog box 888
Edit Group dialog box 937
Edit Health Indicator Assignments for CI 

Type dialog box 612
Edit Health Indicator dialog box 470, 698
Edit Health Indicator to Assignment dialog 

box 616
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Edit Health Indicators in KPI Calculation 
dialog box 469

Edit Indicator State dialog box 702
Edit KPI Assignments for CI Type dialog box 

603
Edit KPI dialog box 464, 668
Edit KPI for Propagation Rule dialog box 625
Edit KPI Parameter dialog box 678
Edit KPI to Assignment dialog box 608
Edit Propagation Rule for CI Type dialog box 

622
Edit Related Health Indicators dialog box 611
Edit Rule dialog box 871
Edit Rule Parameter dialog box 877
Edit Rule Threshold dialog box 877
Edit Selector Field dialog box 479
Edit SNMP Trap dialog box 531
Edit Tooltip Parameter dialog box 878
Editing Filters dialog box 265
Efficacy, KPI 657
EMS

integration application overview 558
EMS Measurement Menu, context menu 901
EMS Show Events, Context Menu 901
EMS Simple Rule 822
End User Monitoring CIs 403
End User Summary

CI menu option 105
End User Summary context menu item 906
Enterprise Management Systems

overview 558
Errors context menu item 109, 906
ETI

customize 689
EUM Sum of Volumes 787
Event Based HI Tooltip, tooltip 887, 888
event channel 122
Event Configuration dialog box 703
Event Log Report context menu item 105, 

906
event template

CI Status alert 540
CI Status alerts 539

Exceptions, KPI 657
exclude statuses 405

Expand more levels
CI menu option 109

Expand More Levels context menu item 906
Expand to Problem context menu item 906
external portal 29

F

Failures, KPIs 657
favorite filter

hierarchy 240
filter

Hierarchy 239
filters

predefined 264
Filters, context menu item 906
Find Visible and Hidden Child CIs

CI menu option 78, 110
Find Visible and Hidden Child CIs dialog box 

86
Find Visible and Hidden Child CIs, context 

menu item 907
formatting methods

KPIs 676

G

Generic Formula Rule 812
Generic Health Indicator Sub-component 

Rule 813
Generic Sample Rule 813
Generic Sample Rule With Baseline 814
Generic Sum of Values Over Time, rule 815
Generic Two Arguments, rule 816
Generic, KPIs 657
geographical location

CIs 195
geographical map 189

assign to view 196
display technology 195
for Service Health 190
navigating 206
refining 197
using applet 209
view real-time status indicators 194
working with applet 193
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Geographical Map tab 205
Geographical Map, context menu item 907
global parameter list 882
global parameters 727

Business Rules Repository 712
Global Parameters dialog box 880
Global Tooltips dialog box 886
global tooltips list 887
global views 380
Go to Console, context menu item 907
Go to Service Health Analyzer

CI menu option 99
Go to Service Health Console, context menu 

item 100
Go to Top View, context menu item 907
Google Earth 196

display geographical map 198
importing location status 198
indicators by status 200
refresh rate 200
understanding 191
working with 211

gray icon 45
green icon 45
Group Load View, context menu item 907
Group Menu, context menu 901
group rules 713
GroupAndSiblingCalculator interface 950
groups

calculation of status 43
dominant child calculation for status 

719
percentage threshold calculation for 

status 717
weighted percentage calculation for 

status 718

H

Health Indicator
configure 425
customize 689

Health Indicator Assignments Page 592
Health Indicator calculation 398, 399
Health Indicator Component

menu commands 253

reset to default 252
select CIs 245, 252, 254, 255
working with 252

Health Indicator component
overview 228
user interface 271

Health Indicator configuration
overview 397

health indicator tooltip 229, 273
Health Indicators

configuring 395
overview 39
selectors for 406

health indicators
assigning to CI 428
defining selectors 435
defining thresholds 433
editing properties 431

health indicators, calculation 118
health indicators, configuring 125
health indicators, overview 116
health indicators, terminology 117
health indicators, understanding 119
HI assignments 558
hi_list rule parameter 714
hidden child 78
hidden parameters

for business rules 883
Hierarchy

advanced filter 240
display child CIs collapsed 237
displaying KPIs by domains 236
favorite filters 240
filtering CIs 234
managing filters 243
modifying refresh rates 236
modifying the number of levels 237
quick filter 239
selecting a view 234
selecting KPIs to display 235

Hierarchy component
customizing 234
overview 224
user interface 258

HIs context menu item 110, 907
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history icon
calculating status 409

history status 410
history statuses

changing the icons 48, 408
for CIs 48, 408

History, tooltip 887
Host Summary View, context menu item 99, 

907
HP Diagnostics

drilling down 339, 356
HP OpenView Service Navigator Rule 823
HP SC Menu, context menu 901
HP Service Manager context menu item 110, 

907
HP Software Support Web site 21
HP Software Web site 22

I

icon
gray 45
green 45
olive 45
orange 45
red 45
yellow 45

icons
changing color 441
changing icon set 72
changing image 441
customizing 441

Impact Over Time Rule 817
Indicator Repository 681

ETIs and health indicators 683
working with 682, 685

Indicator Repository page 693
indicator size

modifying 201
Infrastructure changes

detection 39
Infrastructure Summary, context menu item 

105, 907
invisible child 78
Invoke Run Books

CI menu option 102

Invoke Run Books, context menu item 907
iPhone 369

J

J2EE Application Summary View, context 
menu item 908

K

Knowledge Base 21
KPI

cloning 652, 653
configure 425
dependent 652
numerical code of KPI status 45
overriding 652
set up 653
status name 45
Trend 652
type 652
value 652

KPI Assignment
management 558

KPI assignment
validation 572

KPI assignments 558
KPI Assignments Page 596
KPI calculation 398, 399
KPI Calculation Script

API Duration-Based Sample rule 956
API Group and Sibling rule 952
API Sample rule 954

KPI configuration
overview 397

KPI domains 411
KPI icons 96
KPI propagation 559, 560, 561

mechanism 566
overview 563
validation 572

KPI propagation rules 558
inheriting 565

KPI Repository 651
working with 652
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for user mode 440

KPIs 655
Application Availability (Service 

Health) 656
Application Performance (Service 

Health) 656
assigning to CI 428
Backlog 656
Business Health 656
Business Impact 656
Business Performance (Service Health) 

657
business rules functionality for 399
configuring 395
creating KPIs example 637
creating KPIs scenario 641
defining thresholds 433
Delays 657
displaying properties 386
Duration 657
editing properties 431
Efficacy 657
Exceptions 657
Failures 657
formatting methods 676
Generic 657
Legacy System 657
Locations 658
Network 658
Network Availability 658
Network Performance 658
Operational Status 659
OT Impact 659
overview 39
parameters back to default 655
Performance Analytics 660
PNR 448
PNR (Service Health) 660
RT Impact 660
SAP 661
SAP Alerts 661
saving measurements data over time 

736
Security 661
Siebel 661

Siebel Errors 661
Siebel Sessions 661
SiteScope Health 661
Software Availability 662
Software Performance 662
status and objectives 401
System Availability 662
System Performance 662
Throughput 662
Transactions 663
Unassigned Events 663
Unresolved Events 664
Value 664
Volume 665

KPIs Component 279
KPIs component

customizing 281
modifying KPI over time 281
modifying refresh rates 281
overview 280

KPIs dialog box 312, 342
KPIs Distribution Over Time report 343

access 339
KPIs Over Time

view 338
KPIs Over Time context menu item 908
KPIs Over Time Report

CI menu option 105
KPIs Over Time reports 347

accessing 338
collecting data 411
drill down to HP Diagnostics 339, 356
save KPI status information 338

KPIs Repository page 666
KPIs Summary report 358

access 339
KPIs Trend report 361

access 339

L

Last Sample
tooltip parameter 734

last sample time 728
Last Update

tooltip parameter 734
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last update 728
layers in Topology Map 170
Layers View

drill down 339, 356
LeafCalculator interface 953, 955
Legacy System, KPI 657
Link to this page 29
Load View, context menu item 908
local impact view

CI Status alert 502
local impact views 381
Locate CI in SLA, context menu 901
Locate CI in SLA, context menu item 908
Locate CI in View, context menu item 100, 

908
Locate CI, context menu 901
location status

importing into Google Earth 198
information 191

Location Summary Report, context menu 
item 105, 108, 908, 912

location tooltip
maximum number of CIs displayed 

203
Locations Grouped Parent, rule 826
Locations Grouped, rule 826
Locations, KPI 658

M

map
indicator size 201
location tooltip 203
statuses to be displayed in 202
time delay 202

map applet 193, 195
customize 203
refresh rate 203

maps
for Service Health 190
Virtual Earth 201, 203

Maximum number of breakdown values 447
menu entity

specifying details 895
message syntax 289
metric channel 122

MIBs 501
missing pages,Service Health 113
mobile console

view Service Health 367
Mobile Device

display 373
mobile device

view data on 371
Modified Values dialog box 483
modifying 410
monitor rules 713
Monitor to Operations Health, context menu 

item 908

N

Neighborhood Map 313
display in layers 318
display links 320
display minimap 319
display minimized or detailed CIs 319
modify number of layers displayed 

320
move CIs 318
overview 314
pan 319
plain mode and layer mode 316
refocus 318
reload CI topology 320
resize 319
user interface 321

Network Availability, KPI 658
Network Performance, KPI 658
Network, KPI 658
Nevada - Event Based Alerts Rule (Internal) 

817
New Action dialog box 939
New Context Menu dialog box 935
New ETI dialog box 696
New Event Generation dialog box 536
New Folder, context menu item 103, 908
New Global Parameter dialog box 885
New Group dialog box 937
New Health Indicator dialog box 698
New Indicator State dialog box 702
New KPI dialog box 668
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New KPI Parameter dialog box 678
New Rule dialog box 871
New Rule Parameter dialog box 877
New Rule Threshold dialog box 877
New Tooltip Parameter dialog box 878
No data timeout

Transaction CIs 723
No Update Sentence, tooltip 888
Number of Open Incidents, rule 828
Number of Running Sessions, rule 829
Number of Tasks in Error, rule 829
numerical code 45

O

objectives
defining 404
units of measurement 406, 672

olive icon 45
online resources 21
Open in New Window context menu item 

908
Operational Status KPI 659
Operations Health context menu item 908
operations user mode 412
Oracle Server Summary View, context menu 

item 99, 908
orange icon 45
OT Impact, KPI 659
override

context menu 894
rules 711

P

Percentage Rule 818
percentage, rule 717, 719

weighted percentage status 
calculation method 718

performance
monitoring 36

Performance Analytics KPI 660
Performance Matrix for Application, context 

menu item 105, 909
Performance Matrix for Transaction, context 

menu item 106, 909

performance problems
monitoring 35

PNR (Point of No Return) calculation 422
PNR (Service Health), KPI 660
PNR KPI 448
portal 29
Post-Processor Parameter Details dialog box 

943
predefined filters 264
predefined rule 727
pre-processor classes 914
Pre-Processor Parameter Details dialog box 

942
Probe Group Summary context menu item 

909
Probe Summary context menu item 909
Problematic Subtree, context menu item 909
Propagation Rules Page 600
Properties

CI menu option 112
Properties, context menu item 909
Provider, context menu item 909

R

Real Time Impact, rule 818
Real User Application Actions Volume Rule 

787
Real User Application Open Sessions Rule 

788
Real User Application Sessions Availability 

Rule 788
Real User Application Sessions Performance 

Rule 789
Real User Bandwidth Rule 789
Real User Connections Availability Rule 790
Real User Connections Volume Rule 790
Real User Error Events Rule 793
Real User EUG Subgroup Latency Rule 791
Real User EUG Subgroup Open Sessions Rule 

791
Real User EUG Subgroup Sessions 

Availability Rule 792
Real User EUG Subgroup Sessions 

Performance Rule 793
Real User Information Events Rule 794
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Real User Location Latency Rule 794
Real User Location Open Sessions Rule 794
Real User Location Sessions Availability Rule 

795
Real User Location Sessions Performance 

Rule 796
Real User Number of Transaction Hits Rule 

797
Real User Performance Events Rule 797
Real User Transaction Availability Rule 798
Real User Transaction Performance Rule 799
Real User Transaction Server Time Rule 799
Real User Transaction Total Time Rule 800
Real WS Operation Percentile Performance 

rule 839
Real WS Operation Performance rule 840
Real WS Operation Throughput rule 841
recipients

process flowchart 541
red icon 45
refresh rate

Google Earth 200
map applet 203
modify Service Health tabs 71

Rename Folder, context menu item 103, 909
reporting

Service Health APIs 983
reports

Business Impact 74
Service Health 335

repositories
context menu 899
customization process 636
customizing 634
overview 632

Repository
Business Rules 709
Business Rules API 947

repository
context menu 891

Reset Health Indicator, context menu item 
103, 909

Restore Defaults dialog box
business rules 880
context menu actions 944
KPIs 679

roles of selector 406
RT Impact, KPI 660
rule 727, 758, 759

predefined 727
rules 729, 896

API Duration-Based Sample 810
API Group and Sibling 810
API Sample 811
Average Availability of Weighted 

Volume 783
Average Network of Weighted 

Volume 784
Average Performance of Weighted 

Volume 785
Average Performance of Weighted 

Volume (Available Hits) 786
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Duration Monitor 741
BPI Average Active Weighted Status 

Rule for Duration Monitor 742
BPI Average Duration Rule 742
BPI Average Weighted Status Rule for 

Duration Monitor 743
BPI Average Weighted Status Rule for 

Value Monitor 744
BPI Backlog Count Rule 745
BPI Backlog Value Rule 746, 761
BPI Business Impact Average 

Weighted Status Count Rule 747
BPI Business Impact Average 

Weighted Status Value Rule 748
BPI Business Impact Status Percentage 

Count Rule 749
BPI Business Impact Status Percentage 

Value Rule 750
BPI Business Impact Worst Process 

Instances Count Rule 751
BPI Business Impact Worst Process 

Instances Value Rule 752
BPI Maximum Duration Rule 752
BPI Minimum Duration Rule 753
BPI Process Average Value Rule 753
BPI Process Maximum Value Rule 754
BPI Process Minimum Value Rule 754
BPI Scope Average Value Rule 755
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BPI Scope Maximum Value Rule 755
BPI Scope Minimum Value Rule 756
BPI Scope Weighted Average Duration 

Rule 756
BPI Scope Weighted Average Value 

Rule 757
BPI Status Percentage Rule for 

Duration Monitor 758
BPI Status Percentage Rule for Value 

Monitor 759
BPI Volume Value Rule 760
BPI Worst Active Violated Instances 

Rule for Duration Monitor 762
BPI Worst Violated Instances Rule for 

Duration Monitor 762
BPI Worst Violated Instances Rule for 

Value Monitor 763
cloning 711
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Transactions) 767
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Diagnostics Backend Transaction 

Application Exceptions Rule 778
Diagnostics Backend Transaction 

Average Response Time Rule 779
Diagnostics Backend Transaction 

Count Rule 779
Diagnostics Backend Transaction 

Maximum Response Time Rule 780
Diagnostics Backend Transaction 

Minimum Response Time Rule 780
Diagnostics Backend Transaction 

SOAP Faults Rule 781
Diagnostics Synthetic User Backend 

Application Exceptions Rule 781
Diagnostics Synthetic User Backend 

Average Response Time Rule 782
Diagnostics Synthetic User Backend 

Max Server Request Duration Rule 
782

editing global parameters 727
EMS Simple Rule 822
EUM Sum of Volumes 787
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Generic Health Indicator 
Sub-component Rule 813

Generic Sample Rule 813
Generic Sample Rule With Baseline 

814
Generic Sum of Values Over Time 815
Generic Two Arguments 816
global parameter list 882
global parameters 727
global tooltips 887
HP OpenView Service Navigator Rule 

823
Impact Over Time Rule 817
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Locations Grouped Parent 826
modify parameters 727
Nevada - Event Based Alerts Rule 

(Internal) 817
Number of Open Incidents 828
Number of Running Sessions 829
Number of Tasks in Error 829
overriding 711
parameters back to default 729, 896
Percentage Rule 818
Real Time Impact 818
Real User Application Actions Volume 

Rule 787
Real User Application Open Sessions 

Rule 788
Real User Application Sessions 

Availability 788
Real User Application Sessions 

Performance 789
Real User Bandwidth 789
Real User Connections Availability 

Rule 790
Real User Connections Volume Rule 

790
Real User Error Events Rule 793
Real User EUG Subgroup Latency Rule 

791
Real User EUG Subgroup Open 

Sessions Rule 791
Real User EUG Subgroup Sessions 

Availability 792
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Real User EUG Subgroup Sessions 
Performance 793

Real User Information Events Rule 
794

Real User Location Latency Rule 794
Real User Location Open Sessions Rule 

794
Real User Location Sessions 

Availability 795
Real User Location Sessions 

Performance 796
Real User Number of Transaction Hits 

Rule 797
Real User Performance Events Rule 

797
Real User Transaction Availability 

Rule 798
Real User Transaction Performance 

Rule 799
Real User Transaction Server Time 

Rule 799
Real User Transaction Total Time Rule 

800
Real WS Operation Percentile 

Performance 839
Real WS Operation Performance 840
Real WS Operation Throughput 841
RUM Application Session Statistics 

Monitor Availability Rule (pre-9.0) 
800

RUM Application Session Statistics 
Monitor Performance Rule 
(pre-9.0) 801

RUM End User Monitor Latency Rule 
(pre-9.0) 801

RUM End User Monitor Network Rule 
(pre-9.0) 802

RUM End User Session Statistics 
Monitor Availability Rule (pre-9.0) 
802

RUM End User Session Statistics 
Monitor Performance Rule 
(pre-9.0) 803

RUM Location Session Statistics 
Monitor Availability Rule (pre-9.0) 
803

RUM Location Session Statistics 
Monitor Performance Rule 
(pre-9.0) 804

RUM Transaction Monitor 
Availability Rule (pre-9.0) 804

RUM Transaction Monitor 
Performance Rule (pre-9.0) 805

RUM Transaction Monitor Volume 
Rule (pre-9.0) 805

SAP Alerts 825
Service Health PNR Rule 819
Service Health PNR Rule for HI 
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Service Level Management Tracking 
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Sessions Custom Data Rule 830
SiteScope Consecutive Multiple 

Measurements Rule 831
Sitescope Measurement Rule 832
Sitescope Measurement Siebel 

Processes Rule 833
Sitescope Measurement Time Based 

Rule 834
Sitescope Measurement with Custom 

Data Rule 834
Sitescope Monitor Rule 835
Sitescope Monitor Time Based Rule 

836
SiteScope Multiple Measurements Best 

Status Rule 830
SiteScope Multiple Measurements 

Worst Status Rule 838
SiteScope Profile 836
SiteScope Vertical 837
SiteScope Vertical Measurement 837
Sum of Open Incidents Rule 828
Sum of Values Rule 820
Sum of Volume 820
Summary of Values 821
Synthetic User Transaction 

Availability Rule 806
Synthetic User Transaction 

Performance Rule 807
Synthetic WS Operation Percentile 

Performance Rule 842
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Synthetic WS Operation Performance 
Rule 843

Transaction Availability Rule (pre-9.0) 
808

Transaction Performance Rule 
(pre-9.0) 809

Transactions Grouped 827
Transactions Grouped Parent 827
TransactionVision Backend Average 

Duration Rule (Completed 
Transactions) 764

TransactionVision Backend 
Maximum Duration Rule 
(Completed Transactions) 765

TransactionVision Backend Minimum 
Duration Rule (Completed 
Transactions) 765

TransactionVision Backlog Rule 
(In-Process Transactions) 766

TransactionVision Delayed Rate Rule 
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TransactionVision Delayed Rate Rule 
(In-Process Transactions) 767

TransactionVision End User Average 
Duration Rule (Completed 
Transactions) 768

TransactionVision End User 
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(Completed Transactions) 769

TransactionVision End User 
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(Completed Transactions) 769

TransactionVision End-to-end 
Average Duration Rule (Completed 
Transactions) 770

TransactionVision End-to-end 
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TransactionVision End-to-end 
Minimum Duration Rule 
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TransactionVision Exceptions Rate 
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TransactionVision Exceptions Rate 
Rule (In-Process Transactions) 773

TransactionVision Exceptions Value 
Rule (Completed Transactions) 773

TransactionVision Exceptions Value 
Rule (In-Process Transactions) 774

TransactionVision Failures Rate Rule 
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